Intended Use
Amira® is intended for research use only. Not for use in diagnostic procedures.

Copyright Information
Copyright (c) 1995-2018 Konrad-Zuse-Zentrum für Informationstechnik Berlin (ZIB), Germany
Copyright (c) 1999-2018 FEI SAS, a part of Thermo Fisher Scientific
All rights reserved.

Trademark Information:
All trademarks are the property of Thermo Fisher Scientific and its subsidiaries unless otherwise specified.
Amira is being jointly developed by Konrad-Zuse-Zentrum für Informationstechnik Berlin (ZIB) and FEI SAS, a part of Thermo Fisher Scientific.

The Amira XLVolume Extension includes user protection under license for Landmark U.S. Patent Numbers 6,765,570.

This manual has been prepared for Thermo Fisher Scientific licensees solely for use in connection with software supplied by Thermo Fisher Scientific and is furnished under a written license agreement. This material may not be used, reproduced or disclosed, in whole or in part, except as permitted in the license agreement or by prior written authorization of Thermo Fisher Scientific. Users are cautioned that Thermo Fisher Scientific reserves the right to make changes without notice to the specifications and materials contained herein and shall not be responsible for any damages (including consequential) caused by reliance on the materials presented, including but not limited to typographical, arithmetic or listing errors.
Contents

Amira User’s Guide

1 Introduction 2
1.1 Overview ......................................................... 3
1.2 Features overview .............................................. 4
   1.2.1 Data import ................................................. 4
   1.2.2 Viewing, navigation, interactivity ....................... 4
   1.2.3 Visualization of 3D Image Data ......................... 5
   1.2.4 Image processing ......................................... 5
   1.2.5 Model reconstruction .................................... 6
   1.2.6 Visualization of 3D models and numerical data ............ 7
   1.2.7 General Data Processing and Data Analysis ............ 9
   1.2.8 MATLAB integration .................................... 9
   1.2.9 High Performance Visualization ......................... 10
   1.2.10 Automation, Customization, Extensibility ............... 10
1.3 Editions and Extensions ....................................... 10
   1.3.1 Editions ................................................. 11
   1.3.2 Optional extensions .................................... 11
   1.3.3 License keywords ....................................... 12
1.4 System Requirements .......................................... 13
   1.4.1 Prioritizing hardware for Amira ......................... 14
   1.4.2 How hardware can help optimizing ...................... 17
1.4.3 Special considerations ........................................... 19
1.5 Installation .......................................................... 22
1.5.1 Standard Installation ............................................. 22
1.5.2 Silent Installation ................................................. 23
1.6 Amira License Manager ............................................ 23
1.6.1 Contents ............................................................ 23
1.6.2 About Amira Licensing Management ....................... 24
1.6.3 License Manager Actions ....................................... 25
1.6.4 Licensing Troubleshooting .................................... 43
1.6.5 Contacting the License Administrator ....................... 47
1.7 First steps in Amira ................................................. 47
1.8 Contact and Support ............................................... 49

2 Getting Started ....................................................... 50
2.1 Start the program ................................................... 50
2.2 Loading Data ....................................................... 52
2.3 Invoking Editors .................................................... 54
2.4 Visualizing Data .................................................... 54
2.5 Interaction with the Viewer ....................................... 57
2.6 Data Import ......................................................... 58

3 Tutorials: Visualizing and Processing 2D and 3D Images .... 60
3.1 How to load image data ............................................ 60
3.1.1 The Amira File Browser ...................................... 61
3.1.2 Reading 3D Image Data from Multiple 2D Slices .......... 61
3.1.3 Setting the Bounding Box .................................... 63
3.1.4 The Stacked Slices file format .............................. 63
3.1.5 Working with Large Disk Data .............................. 64
3.1.6 Working with out-of-core data files (LDA) ................. 66
3.2 Visualizing 3D Images ............................................ 72
3.2.1 Orthogonal Slices .............................................. 73
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.2.2</td>
<td>Simple Data Analysis</td>
<td>73</td>
</tr>
<tr>
<td>3.2.3</td>
<td>Resampling the Data</td>
<td>75</td>
</tr>
<tr>
<td>3.2.4</td>
<td>Displaying an Isosurface</td>
<td>76</td>
</tr>
<tr>
<td>3.2.5</td>
<td>Cropping the Data</td>
<td>76</td>
</tr>
<tr>
<td>3.2.6</td>
<td>Volume Rendering</td>
<td>78</td>
</tr>
<tr>
<td>3.3</td>
<td>Introduction to the Multi-planar Viewer</td>
<td>84</td>
</tr>
<tr>
<td>3.3.1</td>
<td>Exploration of the volume data</td>
<td>84</td>
</tr>
<tr>
<td>3.3.2</td>
<td>Explore two data sets using fusion mode</td>
<td>86</td>
</tr>
<tr>
<td>3.3.3</td>
<td>Manually register two data sets</td>
<td>86</td>
</tr>
<tr>
<td>3.4</td>
<td>Intensity Range Partitioning</td>
<td>88</td>
</tr>
<tr>
<td>3.5</td>
<td>Segmentation of 3D Images</td>
<td>93</td>
</tr>
<tr>
<td>3.5.1</td>
<td>Interactive Image Segmentation</td>
<td>94</td>
</tr>
<tr>
<td>3.5.2</td>
<td>Volume and Statistics Measurement</td>
<td>96</td>
</tr>
<tr>
<td>3.5.3</td>
<td>Threshold Segmentation</td>
<td>96</td>
</tr>
<tr>
<td>3.5.4</td>
<td>Refining Threshold Segmentation Results</td>
<td>97</td>
</tr>
<tr>
<td>3.5.5</td>
<td>More Hints about Segmentation</td>
<td>98</td>
</tr>
<tr>
<td>3.6</td>
<td>Deconvolution for light microscopy</td>
<td>100</td>
</tr>
<tr>
<td>3.6.1</td>
<td>General remarks about image deconvolution</td>
<td>100</td>
</tr>
<tr>
<td>3.6.2</td>
<td>Data acquisition and sampling rates</td>
<td>101</td>
</tr>
<tr>
<td>3.6.3</td>
<td>Standard Deconvolution Tutorial</td>
<td>103</td>
</tr>
<tr>
<td>3.6.4</td>
<td>Blind Deconvolution Tutorial</td>
<td>107</td>
</tr>
<tr>
<td>3.6.5</td>
<td>Bead Extraction Tutorial</td>
<td>110</td>
</tr>
<tr>
<td>3.6.6</td>
<td>Performance issues and multi-processing</td>
<td>116</td>
</tr>
<tr>
<td>3.7</td>
<td>Working with Multi-Channel Images</td>
<td>122</td>
</tr>
<tr>
<td>3.7.1</td>
<td>Loading Multi-Channel Images into Amira</td>
<td>122</td>
</tr>
<tr>
<td>3.7.2</td>
<td>Using OrthoSlice with a MultiChannelField</td>
<td>123</td>
</tr>
<tr>
<td>3.7.3</td>
<td>Using ProjectionView with a MultiChannelField</td>
<td>124</td>
</tr>
<tr>
<td>3.7.4</td>
<td>Using Volume Rendering with a MultiChannelField</td>
<td>124</td>
</tr>
<tr>
<td>3.7.5</td>
<td>Saving a MultiChannelField in a Single Amira Mesh File</td>
<td>124</td>
</tr>
<tr>
<td>3.8</td>
<td>Tracing tube-like structures in electron tomography</td>
<td>129</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>6.1.2 Interpretation as 3D image or 2D image stack</td>
<td>184</td>
<td></td>
</tr>
<tr>
<td>6.1.3 Getting more help</td>
<td>184</td>
<td></td>
</tr>
<tr>
<td>6.1.4 Binarization</td>
<td>185</td>
<td></td>
</tr>
<tr>
<td>6.1.5 More about binary images</td>
<td>186</td>
<td></td>
</tr>
<tr>
<td>6.1.6 More hints about binarization</td>
<td>186</td>
<td></td>
</tr>
<tr>
<td>6.1.7 Separation</td>
<td>187</td>
<td></td>
</tr>
<tr>
<td>6.1.8 Analysis</td>
<td>188</td>
<td></td>
</tr>
<tr>
<td>6.1.9 Interactive selection</td>
<td>190</td>
<td></td>
</tr>
<tr>
<td>6.1.10 Filtering based on measures</td>
<td>191</td>
<td></td>
</tr>
<tr>
<td>6.1.11 Classifying measures with sieves</td>
<td>193</td>
<td></td>
</tr>
<tr>
<td>6.1.12 Label images</td>
<td>194</td>
<td></td>
</tr>
<tr>
<td>6.1.13 Processing data on disk</td>
<td>195</td>
<td></td>
</tr>
<tr>
<td>6.1.14 Scripting</td>
<td>195</td>
<td></td>
</tr>
<tr>
<td>6.1.15 Conclusion</td>
<td>195</td>
<td></td>
</tr>
<tr>
<td>6.2 Cell Analysis Tutorial</td>
<td>196</td>
<td></td>
</tr>
<tr>
<td>6.3 Example 1: Measuring a Catalyst</td>
<td>208</td>
<td></td>
</tr>
<tr>
<td>6.3.1 Object Detection and Masks</td>
<td>209</td>
<td></td>
</tr>
<tr>
<td>6.3.2 More about Region of Interest and Masks</td>
<td>212</td>
<td></td>
</tr>
<tr>
<td>6.3.3 Using Distance Map</td>
<td>213</td>
<td></td>
</tr>
<tr>
<td>6.3.4 More about Distance Maps</td>
<td>215</td>
<td></td>
</tr>
<tr>
<td>6.3.5 Measurement Distribution</td>
<td>216</td>
<td></td>
</tr>
<tr>
<td>6.4 Example 2: Separating, Measuring and Reconstructing</td>
<td>217</td>
<td></td>
</tr>
<tr>
<td>6.4.1 Principle of the Watershed Algorithm</td>
<td>218</td>
<td></td>
</tr>
<tr>
<td>6.4.2 Prior Segmentation</td>
<td>219</td>
<td></td>
</tr>
<tr>
<td>6.4.3 Separation using Watershed step by step</td>
<td>220</td>
<td></td>
</tr>
<tr>
<td>6.4.4 Separation Troubleshooting</td>
<td>225</td>
<td></td>
</tr>
<tr>
<td>6.4.5 Filtering Individual Objects</td>
<td>227</td>
<td></td>
</tr>
<tr>
<td>6.4.6 Geometry Reconstruction</td>
<td>229</td>
<td></td>
</tr>
<tr>
<td>6.5 Example 3: Further Image Analysis - Distribution of Pore Diameters in Foam</td>
<td>230</td>
<td></td>
</tr>
<tr>
<td>6.5.1 First step: pore detection</td>
<td>230</td>
<td></td>
</tr>
</tbody>
</table>
6.5.2 Second step: pore post-processing .................................................. 231
6.5.3 Third step: custom measure group definition to determine the distribution of pore diameters ................................................................. 232
6.5.4 Fourth step: custom measure definition to compute the sphericity of pore ................................................................. 235
6.6 Example 4: Further Image Analysis - Average Thickness of Material in Foam ................................................................. 239
  6.6.1 Porosity Detection ........................................................................ 240
  6.6.2 Detection of the Separation Surfaces ........................................... 241
  6.6.3 Distance Map of the Material ....................................................... 242
  6.6.4 Calculation of the Material Average Thickness ................................ 245
6.7 Watershed Segmentation .................................................................. 245
  6.7.1 Segmenting multiphase using the Watershed Segmentation wizard ................................................................. 246
6.8 More about Image Filtering ................................................................. 256
  6.8.1 Choosing image filters ................................................................. 256
  6.8.2 Tuning image filters .................................................................... 258
  6.8.3 Compositing image filters ............................................................ 261
6.9 More about label measures ................................................................. 266
  6.9.1 The Measures Group Selection dialog ........................................ 266
  6.9.2 Custom measures ....................................................................... 268
  6.9.3 Configurable native measures ..................................................... 268
  6.9.4 About measures group backup ................................................... 270
  6.9.5 Scripting tips .............................................................................. 271
7 Tutorials: Surfaces, meshes, skeletons, modeling geometry from 3D images ................................................................. 272
  7.1 Surface Reconstruction from 3D Images ........................................ 272
    7.1.1 Extracting Surfaces from Segmentation Results .......................... 273
    7.1.2 Simplifying the Surface ............................................................ 273
  7.2 Creating a Tetrahedral Grid from a Triangular Surface ..................... 275
    7.2.1 Simplifying the Surface ............................................................ 275
    7.2.2 Editing the Surface ................................................................. 276
    7.2.3 Generation of a Tetrahedral Grid .............................................. 279
  7.3 Advanced Surface and Grid Generation ......................................... 280

CONTENTS

vi
7.3.1 Getting started: a workflow from 3D images to surfaces and grids . . . . . . . 281
7.3.2 Adjusting segmentation for geometry extraction . . . . . . . . . . . . . . . . 282
7.3.3 Generating surfaces with controlled smoothing . . . . . . . . . . . . . . . . 285
7.3.4 Using the Simplification Editor . . . . . . . . . . . . . . . . . . . . . . . . . 287
7.3.5 Using the Surface Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289
7.3.6 Remeshing and exporting surfaces . . . . . . . . . . . . . . . . . . . . . . . . 292
7.3.7 Generating tetrahedral grid . . . . . . . . . . . . . . . . . . . . . . . . . . . 294
7.3.8 Assigning boundary conditions and exporting data . . . . . . . . . . . . . . . 296

7.4 Visualization and Analysis of 3D Models and Numerical Data with Amira . . . . . 299
7.4.1 Amira features for surfaces . . . . . . . . . . . . . . . . . . . . . . . . . . . 300
7.4.2 Supported grids in Amira XMesh Extension . . . . . . . . . . . . . . . . . . 300
7.4.3 Amira XMesh Extension features for 3D grids . . . . . . . . . . . . . . . . . 301
7.4.4 Scalar fields visualization . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302
7.4.5 Vector fields visualization . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302
7.4.6 Time dependent data visualization . . . . . . . . . . . . . . . . . . . . . . . . 304
7.4.7 Compute modules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 304

7.5 Introduction to the Filament Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . 305
7.5.1 Exploration of the Volume Data . . . . . . . . . . . . . . . . . . . . . . . . . 306
7.5.2 Automatic Extraction of the Dendritic Tree . . . . . . . . . . . . . . . . . . . 307
7.5.3 Filament Tracing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 309
7.5.4 Visualize the Network . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 310
7.5.5 Alternative Way to Extract a Network Using the Segmentation Editor . . . . . 311

7.6 Skeletonization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 311
7.6.1 Getting Started with Skeletonization: The Auto Skeleton Module . . . . . . . 312
7.6.2 Displaying and Exporting Skeletonization Results . . . . . . . . . . . . . . . 314
7.6.3 Skeletonization Step-by-Step . . . . . . . . . . . . . . . . . . . . . . . . . . . 317

8 Registration, Alignment and Data Fusion . . . . . . . . . . . . . . . . . . . . . . . . . 322
8.1 Getting started with spatial data registration using the Transform Editor . . . . . . . 323
8.1.1 Using the Transform Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . 323
8.1.2 Applying Transforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 326
8.1.3 Numerical input, console and script commands ........................................... 330
8.1.4 Transform Manipulators ............................................................................ 332
8.2 Data fusion, comparing and merging data ...................................................... 334
  8.2.1 Color Wash ............................................................................................... 335
  8.2.2 Mapping a 3D volume overlaid on a surface ............................................. 336
  8.2.3 Side-by-side viewers, synchronized views and objects .............................. 338
  8.2.4 More about Data Fusion ........................................................................... 341
8.3 Registration with landmarks, warping surfaces and image ........................... 342
  8.3.1 Displaying Data Sets in Two Viewers ...................................................... 343
  8.3.2 Creating a Landmark Set ......................................................................... 345
  8.3.3 Registration via a Rigid Transformation .................................................. 347
  8.3.4 Warping Two Image Volumes ................................................................... 348
  8.3.5 Retrieving and copying registration transformation using Tcl command ... 349
8.4 Registration of 3D image data sets ................................................................. 350
  8.4.1 Getting started with Register Images module .......................................... 350
  8.4.2 Register Images guidelines ..................................................................... 355
  8.4.3 More about the Register Images module .................................................. 357
8.5 Registration with different imaging modalities .............................................. 362
  8.5.1 Basic Manual Registration ...................................................................... 363
  8.5.2 Automatic Registration .......................................................................... 364
  8.5.3 Image Fusion ............................................................................................ 366
8.6 Alignment of 2D images stacks ...................................................................... 367
  8.6.1 Basic manual alignment .......................................................................... 368
  8.6.2 Automatic alignment ................................................................................ 370
  8.6.3 Alignment via landmarks ......................................................................... 370
  8.6.4 Optimizing the least-squares quality function ......................................... 372
  8.6.5 Resampling the input data into result ...................................................... 373
  8.6.6 2D alignment guidelines, more about Align Slices .................................. 374
8.7 Alignment and pre-processing of FIB/SEM images stacks using the FIB Stack Wizard 376
  8.7.1 Images import, voxel size and foreshortening correction ......................... 378
## Contents

### 8.7 Geometric corrections overview
- 8.7.2 Geometric corrections overview ............................................... 381
- 8.7.3 Getting started with FIB Stack Wizard .................................... 383
- 8.7.4 Selecting what to align using masks ......................................... 390
- 8.7.5 Further processing of FIB Stacks ............................................. 392

### 8.8 Registration of 3D surfaces ................................................. 392
- 8.8.1 Getting started with Align Surfaces module ............................... 392
- 8.8.2 Align Surfaces guidelines ....................................................... 396
- 8.8.3 Alignment of surface subsets ................................................. 398
- 8.8.4 Measure and visualize surface distance ..................................... 400

### 9 Animations and Movies ..................................................... 403
- 9.1 Creating animations ................................................................. 403
  - 9.1.1 Creating a project ............................................................... 404
  - 9.1.2 Animating an Ortho Slice module ........................................... 404
  - 9.1.3 Activating a module in the viewer window ................................ 407
  - 9.1.4 Using a camera rotation ....................................................... 409
  - 9.1.5 Removing one or more events ............................................... 410
  - 9.1.6 Overlaying the inside surfaces with outer surface ..................... 410
  - 9.1.7 Using clipping to add the outer surface gradually ..................... 410
  - 9.1.8 More comments on clipping ................................................ 413
  - 9.1.9 Breaks and function keys .................................................... 414
  - 9.1.10 Loops and Goto ................................................................. 415
  - 9.1.11 Storing and replaying the animation sequence ......................... 417
- 9.2 Creating movie files .............................................................. 417
  - 9.2.1 Attaching Movie Maker to a Camera-Path ................................ 418
  - 9.2.2 Creating a movie from an animated demonstration ..................... 420

### 10 User Interface Components, General Concepts, Start-Up ............... 422
- 10.1 User Interface Components .................................................. 422
  - 10.1.1 File Menu ................................................................. 422
  - 10.1.2 Edit Menu ................................................................. 426
10.1.3 Project Menu ................................................................. 427
10.1.4 View Menu ................................................................. 430
10.1.5 Window Menu .............................................................. 433
10.1.6 Help Menu ................................................................. 435
10.1.7 Standard Toolbar ......................................................... 436
10.1.8 Workrooms Toolbar ...................................................... 436
10.1.9 Project View ............................................................... 436
10.1.10 Properties Area .......................................................... 443
10.1.11 Progress Bar ............................................................. 445
10.1.12 Viewer Window .......................................................... 446
10.1.13 Consoles Panel .......................................................... 453
10.1.14 Online Help ............................................................. 454
10.1.15 Histogram Panel ......................................................... 457
10.1.16 Correlation Panel ....................................................... 463
10.1.17 File Dialog ............................................................... 466
10.1.18 Job Dialog ............................................................... 466
10.1.19 Preferences Dialog ..................................................... 469
10.1.20 Snapshot Dialog ......................................................... 478
10.1.21 System Information Dialog ......................................... 480
10.1.22 Object Popup ............................................................ 481
10.1.23 Create Object Popup ................................................... 488

10.2 General Concepts ............................................................. 489
10.2.1 Class Structure .......................................................... 489
10.2.2 Scalar Field and Vector Fields ....................................... 490
10.2.3 Coordinates and Grids .................................................. 491
10.2.4 Surface Data ............................................................. 492
10.2.5 Vertex Set ............................................................... 492
10.2.6 Transformations .......................................................... 493
10.2.7 Data parameters .......................................................... 493
10.2.8 Shadowing ............................................................... 494
16.1 Data Preprocessing Tutorial ................................................. 613
  16.1.1 Automated registration and averaging ................................ 614
  16.1.2 Common file formats .................................................. 614
  16.1.3 Registration using the MPR viewer ................................ 615
  16.1.4 Averaging multiple images to reduce noise ....................... 617
  16.1.5 Resampling to anatomical data resolution ......................... 617
16.2 Diffusion Tensor Tutorial .................................................. 618
  16.2.1 Loading image data ................................................... 618
  16.2.2 Tensor computation ................................................... 619
  16.2.3 Tensor visualization .................................................. 620
16.3 Fiber Tracking Tutorial ................................................... 623
  16.3.1 Perform fiber tracking ............................................... 624
  16.3.2 Separate Fibers into Fiber Bundles ............................... 626
  16.3.3 Create a label image from a line set ............................. 626

17 Brain Perfusion .............................................................. 628
  17.1 Brain Perfusion ........................................................... 628
  17.2 Brain Perfusion Tutorial ............................................... 629
    17.2.1 Load the perfusion time series .................................. 629
    17.2.2 Create a mask ....................................................... 630
    17.2.3 Extract an arterial and a venous output function ............. 630

Amira XPand Extension User’s Guide ......................................... 636
18 Amira XPand Extension ...................................................... 637
  18.1 Introduction to Amira XPand Extension .............................. 638
    18.1.1 Overview of Amira XPand Extension ............................. 638
    18.1.2 System Requirements ............................................. 640
    18.1.3 Structure of the Amira File Tree ................................ 640
    18.1.4 Quick Start Tutorial ............................................. 642
    18.1.5 Compiling and Debugging ....................................... 644
20.2.3  Mesh Refinement of Groups of Materials .............................. 808
20.2.4  Advanced Mesh Refinement ........................................... 808
20.2.5  Boundary Layer Refinement ........................................... 811
20.2.6  Optimization of Mesh Quality ....................................... 813
20.2.7  Color Mapping of Material Properties ............................. 814
20.2.8  Boundary Conditions and Export to CFD/FEA Solvers .......... 815

20.3  Amira XWind Extension Measurements ............................... 816
   20.3.1  3D measurements ................................................... 817
   20.3.2  Histograms ......................................................... 817
   20.3.3  Data probing ....................................................... 819

20.4  Getting Started with reading and visualizing CAE/CFD data ........ 822
   20.4.1  User interface short overview .................................... 822
   20.4.2  Reading data ....................................................... 824
   20.4.3  Getting started .................................................... 826
   20.4.4  Units and legends ................................................ 827
   20.4.5  Saving your project ................................................ 828
   20.4.6  Tip: Template projects .......................................... 828
   20.4.7  Time animation .................................................... 830

20.5  Amira XWind Extension Models Information and Display .......... 831
   20.5.1  Properties and parameters ....................................... 832
   20.5.2  Colormaps .......................................................... 833
   20.5.3  Viewing the grid .................................................... 835
   20.5.4  Viewing the boundaries .......................................... 836

20.6  Amira XWind Extension Scalar Fields Display ....................... 839
   20.6.1  Scalar field profile on a cross section ....................... 839
   20.6.2  Scalar field isolines ............................................. 840
   20.6.3  Legend and captions .............................................. 841
   20.6.4  Isosurfaces of pressure ......................................... 842

20.7  Amira XWind Extension Vector Fields Display ....................... 845
   20.7.1  Particles animation ................................................ 845
20.7.2 Illuminated streamlines (ISL) ......................................................... 847
20.7.3 Line integral convolution (LIC) ......................................................... 848
20.7.4 Vectors in a plane ................................................................. 849
20.7.5 Stream ribbons ................................................................. 850
20.7.6 Find the 3D critical points ......................................................... 851
20.8 Amira XWind Extension Statistical and Arithmetic Computations .............. 853
  20.8.1 Surface and volume integrals ......................................................... 853
  20.8.2 Arithmetic computation ................................................................. 858
20.9 Amira XWind Extension Vorticity Identification ........................................ 860
  20.9.1 Vorticity-related variables computation .............................................. 860
  20.9.2 Vortex core lines identification ....................................................... 862
  20.9.3 Vortical flow visualization .............................................................. 863
20.10 Amira XWind Extension Measurements .................................................. 866
  20.10.1 3D measurements ................................................................. 866
  20.10.2 Histograms ................................................................. 868
  20.10.3 Data probing ................................................................. 869

Amira XDigitalVolumeCorrelation Extension User’s Guide 873

21 Amira XDigitalVolumeCorrelation Extension .................................................. 874
  21.1 Digital Volume Correlation Analysis ..................................................... 875
    21.1.1 Preparing the Subset-Based Approach ............................................ 875
    21.1.2 Compute a Good Initial Guess using the Subset-Based Approach ....... 877
    21.1.3 Run a Robust FE-Based DVC Technique ............................................ 880
    21.1.4 Visualize and Animate the Results of the Global Approach ............... 884
    21.1.5 Dialog between experience and simulation ......................................... 888
    21.1.6 Additionnal post processing ............................................................ 888
    21.1.7 References ............................................................................. 889
Part I

Amira User’s Guide
Chapter 1

Introduction

Amira is a 3D data visualization, analysis and modelling system. It allows you to visualize scientific data sets from various application areas, e.g. medicine, biology, bio-chemistry, microscopy, biomed, bioengineering. 3D data can be quickly explored, analyzed, compared, and quantified. 3D objects can be represented as image volumes or geometrical surfaces and grids suitable for numerical simulations, notably as triangular surface and volumetric tetrahedral grids. Amira provides methods to generate such grids from voxel data representing an image volume, and it includes a general-purpose interactive 3D viewer.

Amira is a powerful, multifaceted software platform for visualizing, manipulating, and understanding Life Science and bio-medical data coming from all types of sources and modalities. Initially known and widely used as the 3D visualization tool of choice in microscopy and biomed research, Amira has become a more and more sophisticated product, delivering powerful visualization and analysis capabilities in all visualization and simulation fields in Life Science.

- Multi purpose - One platform for visualizing, analyzing and presenting
- Flexible - Option packages to configure Amira to your needs
- Efficient - Takes advantage of the latest graphics cards and processors
- Easy to use - Intuitive user interface and great documentation
- Cost effective - Multiple options and flexible license models
- Handling large data - Very large data sets are easily accessible with specific readers
- Extensible - C++ coding wizard for technical extension and customization
- Support - Direct customer support with high level of interaction
- Innovative - Technology always updated to the latest innovation

Section 1.1 (Overview) provides a short overview of the fundamentals of Amira, i.e., its object-oriented design and the concept of data objects and modules.
Section 1.2 (Features) summarizes key features of Amira, for example direct volume rendering, image processing, and surface simplification.

Section 1.3 (Editions and Extensions) briefly describes optional extensions and editions available for Amira and for what they can be used for.

Section 1.4 (System Requirements) provides system specific information.

Section 1.5 (Amira Installation) gives information on installation process.

Section 1.6 (Amira License Manager) details for entering and managing Amira license passwords.

Section 1.7 (First steps) provides hints about tutorials included in this guide.

Section 1.8 (Contact and Support) provides contact information for your technical support, license administrator, or sales representative.

Note that Amira is intended for research use only. Not for use in diagnostic procedures.

1.1 Overview

Amira is a modular and object-oriented software system. Its basic system components are modules and data objects. Modules are used to visualize data objects or to perform some computational operations on them. The components are represented by little icons in the Project View. Icons are connected by lines indicating processing dependencies between the components, i.e., which modules are to be applied to which data objects. Alternatively, modules and data objects can be displayed in a Project Tree View. Modules from data objects of specific types are created automatically from file input data when reading or as output of module computations. Modules matching an existing data object are created as instances of particular module types via a context-sensitive popup menu. Projects can be created with a minimal amount of user interaction. Parameters of data objects and modules can be modified in Amira’s interaction area.

For some data objects such as surfaces or colormaps, there exist special-purpose interactive editors that allow the user to modify the objects. All Amira components can be controlled via a Tcl command interface. Commands can be read from a script file or issued manually in a separate console window.

The biggest part of the screen is occupied by a 3D graphics window. Additional 3D views can be created if necessary. Amira is based on the latest release of Open Inventor by FEI SAS, a part of Thermo Fisher Scientific. In addition, several modules apply direct OpenGL rendering to achieve special rendering effects or to maximize performance. In total, there are more than 270 data object and module types. They allow the system to be used for a broad range of applications. Scripting can be used for customization and automation. User-defined extensions are facilitated by the Amira developer version.

Overview
1.2 Features overview

Amira provides a large number of data types and modules allowing you to visualize, analyze and model various kinds of 3D data. The Amira framework is ideal to integrate the data from multiple sources into a single environment.

This section summarizes the main features of the Amira software suite. For more complete information, you may browse indexes for data types, file formats and modules see the home page of the online help browser.

Section 1.3 describes the Amira optional editions and extensions.

1.2.1 Data import

Amira can load directly different types of data, including:

- 2D and 3D image and volume data
- Geometric models such as point sets, line sets, surfaces, grids
- Numerical simulation data
- Time series and animations

A large number of file formats are supported in Amira or through specific optional readers. For an introduction to data import, see section 3.1. For more details, see section 2.6.

1.2.2 Viewing, navigation, interactivity

All visualization techniques can be arbitrarily combined to produce a single scene. Moreover, multiple data sets can be visualized simultaneously, either in several viewer windows or in a common one. Thus you can display single or multiple data sets in a single or multiple viewer windows, and navigate freely around or through those objects. Views can be synchronized to facilitate comparisons.

A built-in spatial transform editor makes it easy to register data sets with respect to each other or to deal with different coordinate systems. Automatic alignment and registration of image or geometric data is also possible.

Direct interaction with the 3D scene allows you to quickly control regions of interest, slices, probes and more.

Combinations of data sets, representation and processing features can be defined with minimal user interaction for simple or complex tasks. See section 1.1.
1.2.3 Visualization of 3D Image Data

1.2.3.1 Slicing and Clipping

You can quickly explore 3D images looking at single or multiple orthographic or oblique sections. Data sets can be superimposed on slices, displayed as height fields, or with isolines contouring. You can cut away parts of your data to uncover hidden regions. Curved or cylinder slices are also available.

1.2.3.2 Volume Rendering

One of the most intuitive and most powerful techniques for visualizing 3D image data is *direct volume rendering*. Light emission and light absorption parameters are assigned to each point of the volume. Simulating the transmission of light through the volume makes it possible to display your data from any view direction without constructing intermediate polygonal models. By exploiting modern graphics hardware, Amira is able to perform direct volume rendering in real time, even on very large data when using the Amira XLVolume Extension. Thus volume rendering can instantly highlight relevant features of your data. Volume rendered images can be combined with any type of polygonal display. This improves the usefulness of this technique significantly. Moreover, multiple data sets can be volume rendered simultaneously – a unique feature of Amira. Transfer functions with different characteristics required for direct volume rendering can be either generated automatically or edited interactively using an intuitive colormap editor. Amira volume rendering can use the latest techniques for high quality visualization effects such as lighting or shadows.

1.2.3.3 Isosurfaces

Isosurfaces are most commonly used for analyzing arbitrary scalar fields sampled on discrete grids. Applied to 3D images, the method provides a very quick, yet sometimes sufficient method for reconstructing polygonal surface models. Beside standard algorithms, Amira provides an improved method, which generates significantly fewer triangles with very little computational overhead. In this way, large 3D data sets can be displayed interactively even on smaller desktop graphics computers.

1.2.3.4 Large Volume Data

With the Amira XLVolume Extension, even very large data sets that cannot be fully loaded in memory can be manipulated at interactive speed. Multi-resolution techniques can manage and visualize extremely large amounts of volume data of up to hundreds of gigabytes. You can then, for instance, quickly select a region of interest and extract down-sampled or partial data for further processing.

1.2.4 Image processing

1.2.4.1 Alignment of image slices

The image *Align Slices* enables you to build a consistent stack of images with manual or automatic tools, if, for instance, physical cross sections have been shifted during image acquisition.
1.2.4.2 Image filters

Image features can be enhanced by applying a wide range of filters for controlling contrast, smoothing, noise reduction and feature enhancement. See Section 6.8 More about Image Filtering.

1.2.4.3 Image segmentation

Segmentation means assigning labels to image voxels that identify and separate objects in a 3D image. Amira offers a large set of segmentation tools, ranging from purely manual to fully automatic: brush (painting), lasso (contouring), magic wand (region growing), thresholding, intelligent scissors, contour fitting (snakes), contour interpolation and extrapolation, wrapping, smoothing and de-noising filters, morphological filters for erosion, dilation, opening and closing operations, connected component analysis, images correlation, objects separation and filtering, etc. See section 3.5 for a tutorial about image segmentation with Amira.

1.2.4.4 Image quantification and analysis

Amira provides tools for probing image data, extracting profiles, value or correlation histogram. It can extract information from segmented images such as area, volumes, intensity statistics. Amira XImagePAQ Extension provides an extensive set of tools for image quantification and analysis. See Advanced Image Processing, Segmentation and Analysis examples.

1.2.5 Model reconstruction

1.2.5.1 Surface generation

Once the interesting features in a 3D image volume have been segmented, Amira is able to create a corresponding polygonal surface model. The surface may have non-manifold topology if there are locations where three or more regions join. Even in this case, the polygonal surface model is guaranteed to be topologically correct, i.e., free of self-intersections. Fractional weights that are automatically generated during segmentation allow the system to produce optionally smooth boundary interfaces. This way realistic high-quality models can be obtained, even if the underlying image data are of low resolution or contain severe noise artifacts. Making use of innovative acceleration techniques, surface reconstruction can be performed very quickly. Moreover, the algorithm is robust and fail-safe.

1.2.5.2 Surface Simplification, Editing, Remeshing

Surface simplification is another prominent feature of Amira. It can be used to reduce the number of triangles in an arbitrary surface model according to a user-defined value. Thus, models of finite-element grids, suitable for being processed on low-end machines, can be generated. The underlying simplification algorithm is one of the most elaborate available. It is able to preserve topological correctness, i.e., self-intersections commonly produced by other methods are avoided. In addition, the quality of
the resulting mesh, according to measures common in finite element analysis, can be controlled. For example, triangles with long edges or triangles with bad aspect ratio can be suppressed.

A surface editor is also available for smoothing or refining surface in whole or part, cutting and copying parts of surfaces, defining boundary conditions for further numerical simulation, checking and modifying surface triangles. Surface Path Set can be created interactively - for instance as geodesic contours, edited and used to cut surface patches. Surface path can also be obtained by intersecting surfaces, Amira XMesh Extension also provides a powerful Remesh Surface module that can be used for producing high quality surfaces.

1.2.5.3 Generation of Tetrahedral Grids

Amira allows you not only to generate surface models from your data but also to create true volumetric tetrahedral grids suitable for advanced 3D finite-element simulations. These grids are constructed using a flexible advancing-front algorithm. Again, special care is taken to obtain meshes of high quality, i.e., tetrahedra with bad aspect ratio are avoided. Several different file formats are supported, so that the grid can be exported to many standard simulation packages.

1.2.5.4 Point Clouds/Scattered Data

Amira can also reconstruct surfaces from scattered points (see Delaunay Triangulation and Point Wrap Triangulation modules).

1.2.5.5 Skeletonization

A set of tools is included for reconstructing and analyzing a dendritic, porous or fracture network from 3D image data.

1.2.6 Visualization of 3D models and numerical data

1.2.6.1 Point sets, line sets

Amira can visualize arbitrary functional data given on 3D Point Cloud sets or Line Sets.

1.2.6.2 Polygonal models

A number of drawing styles and coloring schemes help to yield meaningful and informative visualizations of polygonal models, whether generated from image data or imported from CAD or simulation package. Surface and 3D grid meshes can be colored or textured in order to visualize a second independent data set.

Features overview
Another Amira feature comprises the realistic view-dependent way of rendering semi-transparent surfaces. By correlating transparency with local orientation of the surface relative to the viewing direction, complex spatial structures can be understood much more easily.

1.2.6.3 Numerical data post-processing

Amira allows you to analyze numerical data coming from measurements or simulations. Amira supports polygonal surfaces such as triangular meshes, 3D lattices with uniform, rectilinear or curvilinear coordinates, and 3D tetrahedral or hexahedral grids. Most general purpose image visualization techniques and analysis tools can be applied, such as: slice extraction, computation of isolines or isosurfaces, data probing and histograms. In addition, scalar quantities can be visualized with pseudo-colors on the grid itself.

Beside visualization, data representations such as isosurfaces, grid cuts or contour lines can be extracted as first class data objects.

Displacement vectors can be visualized on grids or applied as grid deformation that can be animated. *Amira XWind Extension* provides extensive additional support for numerical data import/export, visualization and analysis.

1.2.6.4 Flow Visualization

Amira provides many advanced tools for vector fields and flow visualization. Vector arrows can be drawn on a slice, within a volume, or upon a surface. The flow structure may be better revealed by representations such as fast Line Integral Convolution on slices or arbitrary surfaces, illuminated and animated streamlines, stream ribbons, stream surfaces, particle animations, synthetic *Vector Probe*...

All of these stream visualization techniques are highly interactive. While seed point distributions can be automatically calculated, you can also select and interactively manipulate seed points and structures, thus supporting the investigation of the flow field and highlighting of different features. Amira can also support six-component complex vector fields and phase visualization, e.g., electromagnetic fields. *Amira XWind Extension* provides extensive support for flow and CFD post-processing.

1.2.6.5 Tensor Data

Amira has support for iconic visualization of tensor field, extraction of eigenvalues, computation of rate of strain tensor, and gradient tensor.

*Amira XWind Extension* can compute many secondary variables from simulation results including various tensor.
1.2.7 General Data Processing and Data Analysis

1.2.7.1 3D registration of multiple data sets

Multiple data sets can be combined to compare images of different objects, or images of an object recorded at different times or with different imaging modalities such as X-ray CT and MRI. In addition, fusion of multi-modal data by arbitrary arithmetic operations can be performed to increase the amount of information and accuracy in the models. Amira allows manual registration through interactive manipulators, automatic rigid or non-rigid registration through landmarks, and automatic registration using iterative optimization algorithms (see Register Images module).

Surfaces can also be registered using rigid or non-rigid transformations, based on landmarks sets warping, alignment of centers or principal axes, or distance minimization algorithms.

1.2.7.2 Operating on 3D data

Many utilities are available for data processing. Here are some important ones. Resampling can reduce or enlarge the resolution of a 3D image or data sets defined on regular grids, and different sampling kernels are supported. Data can be cropped or regions of interest can be defined. Data can be converted to any supported primitive type, from byte to 64-bits floating point numbers. Multi-component data such as multi-channel images or vector data can be composed or decomposed. Standard 3D field operators such as scalar field gradient or vector field curl are available. Surface curvatures and distances between surfaces can also be computed, as scalar or vector information. The powerful Arithmetic module allows the user to perform calculations on data sets with user-defined expression, and can be used to interpolate data between regular grids and polyhedral grids. Data sets can also be created from arithmetic expressions.

1.2.7.3 Measurements, quantification

You can query the exact values of your data sets at arbitrary locations specified interactively by a mouse click, or along user-defined lines and spline curves. Probe points can serve to set interactively isosurfaces. You can plot or export the data for further processing with spreadsheet or plotting applications, with probing, measuring, counting, and other statistical modules quantify densities, distances, areas, volumes, mean value and standard deviation.

Histograms of values can be computed and plotted, possibly restricted to a region of interest.

The Amira XImagePAQ Extension provides an extensive set of intensity and geometrical measurements on image or label data, either for individual labeled particles or as statistics. See Advanced Image Processing, Segmentation and Analysis examples.

1.2.8 MATLAB integration

You can integrate complex calculus using MATLAB software from The Mathworks, Inc. by means of the Calculus MATLAB module. This module provides connection to your MATLAB server from your
Amira session, and executes MATLAB computations directly on your Amira data. It is also possible to import and export MATLAB matrices to and from Amira, and export Amira surfaces to MATLAB surfaces. See section 11.7.1.

1.2.9 High Performance Visualization

Amira makes extensive use of graphics hardware for optimal performance and rendering quality on your system. Moreover, the Amira XScreen Extension allows combining multiple graphics engines for advanced displays and high-performance requirements.

1.2.10 Automation, Customization, Extensibility

Tcl scripting

All Amira components can be controlled via a Tcl command language interface. Tcl scripts are used for saving your work session. Tcl scripts also allow the advanced user to automate or customize tasks with Amira for routine workflows, without the need for C++ programming. Custom Amira modules with user interface can even be created as Tcl scripts. Amira module behaviour and 3D interaction can be customized by using Tcl. Amira can also be used for batch processing. See Chapter 11.5, including a short introduction to the Tcl scripting language.

C++ programming

With the Amira XScreen Extension, Amira can also be extended by programmers. The Amira XPand Extension permits creation of new custom components for Amira such as file readers and writers, computation modules, and even new visualization modules, using the C++ programming language. New modules and new data classes can be defined as subclasses of existing ones. In order to simplify the creation of new custom extensions, a development wizard is included. See the Amira XPand Extension User’s Guide for detailed information.

Template projects

Template projects can be used to ease repetitive tasks on a set of similar data. A template project consists of a backup of an original project that can be replicated on another data of the same type. See Chapter 11.1.1.

1.3 Editions and Extensions

Amira Extensions are additional sets of modules providing solutions for dedicated application areas. Extensions can be added to a standard Amira installation at any time. For each extension a separate license is required.
1.3.1 Editions

Currently, the following editions are available for Amira 6.

**Amira Standard Edition.** Amira is the digital researcher’s workbench providing tools for every step of the digital image processing workflow, e.g. Import/Export, Processing, Analysis, Visualization and Presentation. It enables researcher to extract exactly the information they want from their data to answer their scientific questions. Amira provides a framework for scientists to construct workflows tailored to their data and needs by providing versatile image processing, analysis and visualization tools at the highest industry standard. Amira’s object oriented graphical programming approach makes sophisticated workflow design accessible to any scientist without requiring programming or scripting skills. Amira does over extensibility through its various extensions or scripting and programming interfaces such as Python, MATLAB, Tcl and C++ API. Amira includes natively the following extensions: Amira XSkeleton Extension and Amira XMesh Extension.

**Amira Cell Biology Edition.** Amira Cell Biology Edition is a complete solution for cell biologists. Based on the Amira and through the integration of the Amira XBioFormats Extension, it enables researchers to import almost any file format used in cell biology application including all Meta data. Data can then be processed with advanced segmentation and analysis tools from the Amira XImagePAQ Extension and Amira XTracing Extension. This allows researchers to customize a segmentation/detection workflow to their needs. Segmentation workflow can then be applied to entire time series data and the results tracked using the Amira XObjectTracking Extension, the most powerful and automated tracking solution in the market (powered by u-track 3D, under submission for peer-review from the Danuser Lab).

1.3.2 Optional extensions

**Note:** see section 1.4 System Requirements about system requirements and hardware platform availability.

Currently, the following extensions are available for Amira:

- **Amira XTracing Extension** allows you to trace and quantify filamentous structures in very noisy electron tomograms. It adds a new category Fiber Tracing that gives access to some specific correlation modules, used for enhancing tube-like structures in an image and tracing the centerlines of these structures.

- **Amira XWind Extension** includes dedicated visualization and computation modules, readers and writers for advanced Finite Element Analysis (FEA) or Computer Fluid Dynamics (CFD) data processing, analysis and export. It extends Amira XMesh Extension with advanced support for post-processing of result data coming from solvers, and pre-processing from image data to simulation. It also includes an advanced meshing workroom for creating simulation inputs (tetrahedral mesh with boundary conditions) directly from a label image.

- **Amira XNeuro Extension** extends Amira with modules for the analysis of Diffusion Tensor Images, brain perfusion. The Filament Editor is also part of the Extension.
• **Amira XImagePAQ Extension** includes advanced image processing capabilities as well as image analysis and quantification tools. It is a major evolution of the prior Quantification+ option, including important enhancements, many new features, substantial performance improvements, and all modules of the prior Multi-Component Analysis option.

• **Amira XPand Extension** allows you to develop your own custom modules, file readers, and file writers using the C++ programming language.

• **Amira XMolecular Extension** adds advanced tools for the visualization of molecules. It combines Amira’s strong capabilities for 3D data visualization such as hardware-accelerated volume rendering, with specific tools for molecular visualization and data analysis, such as molecular surfaces, sequence alignment, configuration density computation, and molecule trajectories. Amira XMolecular Extension includes a very powerful molecule editor.

• **Amira XScreen Extension** is designed to enable the use of Amira’s advanced data visualization and analysis features on immersive VR systems and tiled screen configurations. It has built-in support for distributed rendering on cluster systems using application-level distribution. This approach leads to optimal performance with minimal bandwidth requirements. Tracking capabilities allow for a true immersive experience as well as interaction with the visualization. Please refer to the online help for documentation on this extension.

• **Amira XLVolume Extension** manages and visualizes very large amounts of volume data, up to hundreds of gigabytes. The multi-resolution technique used in this extension allows for interactive visualization and navigation through vast amounts of data.

• **Amira XRecipe Extension** allows for the creation of user-defined recipes, for the automation of a complex scenario.

• **Amira XBioFormats Extension** is a multi-reader supported several life sciences image file formats.

• **Amira XObjectTracking Extension** uses the most powerful and automated tracking solution in the market (powered by u-track 3D, under submission for peer-review from the Danuser Lab) to allow you to track time series objects detected through your customized segmentation workflows. Amira XObjectTracking Extension is only available through the Amira Cell Biology Edition.

• **Amira XDigitalVolumeCorrelation Extension** allows for access to several tools and tutorials to compute the displacement and strain map from volume images in reference and deformed states, in order to study the deformation of materials.

### 1.3.3 License keywords

The following table shows the license keyword associated with each of the Amira Extensions.
### System Requirements

Amira runs on:

- Microsoft Windows 7/8/10 (64-bit).
- Linux x86_64 (64-bit). Supported 64-bit architecture is Intel64/AMD64 architecture. Supported Linux distribution is Red Hat Enterprise Linux 6 and Red Hat Enterprise Linux 7. This is the last version to support Red Hat Enterprise Linux 6, next version will support Red Hat Enterprise Linux 7 only.
- Mac OS X Sierra (10.12) and Mac OS X High Sierra (10.13).

Some of the Editions and Extensions are limited to some platforms:

- **Amira XWind Extension**: support of Abaqus reader (.odb format) and STAR-CCM reader are available only on Microsoft Windows and Linux. The meshing workroom is only available on Microsoft Windows platform,
- **Amira XScreen Extension** is supported only on Microsoft Windows and Linux, not Mac OS X,
- **Amira XRecipe Extension** is supported only on Microsoft Windows, not on Linux or Mac OS X.

(*) With cluster configurations, Amira XScreen Extension requires as many licenses as slave rendering nodes in the cluster configuration. Ex: A configuration with a master node driving a cluster of 4 nodes will require 4 Amira XScreen Extension licenses.


<table>
<thead>
<tr>
<th>Amira Extension</th>
<th>License keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amira XTracing Extension</td>
<td>AmiraXTracing</td>
</tr>
<tr>
<td>Amira XPand Extension</td>
<td>AmiraDev</td>
</tr>
<tr>
<td>Amira XMolecular Extension</td>
<td>AmiraMol</td>
</tr>
<tr>
<td>Amira XWind Extension</td>
<td>AmiraXWind</td>
</tr>
<tr>
<td>Amira XScreen Extension</td>
<td>AmiraVR (*)</td>
</tr>
<tr>
<td>Amira XLVolume Extension</td>
<td>AmiraVLD</td>
</tr>
<tr>
<td>Amira XNeuro Extension</td>
<td>AmiraNeuro</td>
</tr>
<tr>
<td>Amira XImagePAQ Extension</td>
<td>AmiraQuant</td>
</tr>
<tr>
<td>Amira XBioFormats Extension</td>
<td>AmiraXBioFormats</td>
</tr>
<tr>
<td>Amira XObjectTracking Extension</td>
<td>AmiraXObjectTracking</td>
</tr>
<tr>
<td>Amira XDigitalVolumeCorrelation</td>
<td>AmiraXVolumeCorrelation</td>
</tr>
</tbody>
</table>

- **Amira XObjectTracking Extension** is supported only on Microsoft Windows, not on Linux or Mac OS X.
- **Amira XDigitalVolumeCorrelation Extension** is supported only on Microsoft Windows and Linux, not Mac OS X.

### 1.4.1 Prioritizing hardware for Amira

#### 1.4.1.1 Introduction

This document is intended to give recommendations about choosing a suitable workstation to run Amira.

The four most important components that need to be considered are the graphics card (GPU), the CPU, the RAM and the hard drive.

The performance of direct volume rendering of large volumetric data or large triangulated surface visualization extracted from the data depends heavily on the GPU capability. The performance of image processing algorithms depends heavily on the performance of the CPU. The ability to quickly load or save large data depends heavily on the hard drive performance. And, of course, the amount of available memory in the system will be the main limitation on the size of the data that can be loaded and processed.

Because the hardware requirements will widely vary according to the size of your data and your workflow, we strongly suggest that you take advantage of our supported evaluation version to try working with one of your typical data sets.

In this document, the term Amira refers to Amira and all Amira extensions.

#### 1.4.1.2 Graphics Cards

The single most important determinant of Amira performance for visualization is the graphics card. Amira should run on any graphics system (this includes GPU and its driver) that provides a complete implementation of OpenGL 2.1 or higher (certain features may not be available depending on the OpenGL version and extensions supported). However, graphics board and driver bugs are not unusual.

The amount of GPU memory needed depends on the size of the data. We recommend a minimum of 1 GB on the card. Some visualization modules may require having graphics memory large enough to hold the actual data.

High-end graphics cards have 16 to 32 GB of memory. Optimal performance volumetric visualization at full resolution requires that data fit in graphics memory (some volume rendering modules of Amira are able to go around this limitation).

Amira will not benefit from multiple graphics boards for the purpose of visualization on a single monitor. However, some of the image processing algorithms rely on CUDA for computation, and while the computation can run on the single CUDA-enabled graphics board, this computation can also...
run on a second CUDA-enabled graphics card installed on the system. A multiple graphics board configuration can be useful to drive many screens or in immersive environments.

When comparing graphics boards, there are many different criteria and performance numbers to consider. Some are more important than others, and some are more important for certain kinds of rendering. Thus, it’s important to consider your specific visualization requirements. Integrated graphics boards are not recommended for graphics-intensive applications such as Amira except for basic visualization.

Wikipedia articles on NVIDIA GeForce/Quadro and AMD Radeon/FirePro cards will detail specific performance metrics:

- Memory size: This is very important for volume visualization (both volume rendering and slices) to maximize image quality and performance because volume data is stored in the GPU’s texture memory for rendering. It is also important for geometry rendering if the geometry is very large (large number of triangles).
- Memory interface / Bandwidth: This is important for volume rendering because large amounts of texture data need to be moved from the system to the GPU during rendering. The PCI Express 3 buses are the fastest interfaces available today.
- Number of cores (also known as stream processors): This is very important for volume rendering because every high-quality rendering feature you enable requires additional code to be executed on the GPU during rendering.
- Triangles per second: This is very important for geometry rendering (surfaces, meshes).
- Texels per second / Fill rate: This is very important for volume visualization (especially for volume rendering), because a large number of textures will be rendered and pixels will be "filled” multiple times to blend the final image.

### Professional graphics boards

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Family</th>
<th>Series</th>
</tr>
</thead>
<tbody>
<tr>
<td>NVIDIA</td>
<td>Quadro</td>
<td>Maxwell, Kepler, Pascal</td>
</tr>
<tr>
<td>AMD</td>
<td>FirePro</td>
<td>W, V</td>
</tr>
</tbody>
</table>

All driver bugs are submitted to the vendors. A fix may be expected in a future driver release.

### Standard graphics boards

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Family</th>
<th>Series</th>
</tr>
</thead>
<tbody>
<tr>
<td>NVIDIA</td>
<td>GeForce</td>
<td>Maxwell, Kepler, Pascal</td>
</tr>
<tr>
<td>AMD</td>
<td>Radeon</td>
<td>since GCN 1.1</td>
</tr>
<tr>
<td>Intel</td>
<td>HD Graphics</td>
<td>Broadwell, Skylake</td>
</tr>
</tbody>
</table>

Due to vendor support policies, on standard graphics boards we are not able to commit to providing a fix for bugs caused by the driver.

- **A professional graphics boards** will benefit from the professional support offered by the vendors (driver bug fixes).
- Always use a recent driver version for your graphics board.

*System Requirements*
• With an NVIDIA Quadro board we recommend to use the driver profile ”3D App - Visual Simulation”. In case of rendering or performance issues you may want to experiment with different ”3D App” profiles.
• Turning off the Vertical sync feature improves frame rate.
• Visit http://en.wikipedia.org/wiki/List_of_AMD_graphics_processing_units for a complete list of AMD boards and comparisons.
• Some visualization modules like Volume Rendering may not support Intel graphic cards.

1.4.1.3 System Memory

System memory is the second most important determinant for Amira users who need to process large data.

You may need much more memory than the actual size of the data you want to load within Amira. Some processing may require several times the memory required by the original data set. If you want to load, for instance, a 4 GB data set in memory and apply a non-local means filter to the original data and then compute a distance map, you may need up to 16 or 20 GB of additional memory for the intermediate results of your processing. Commonly you will need 2 or 3 times the memory footprint of the data being processed for basic operations. For more complex workflows you may need up to 6 or 8 times amount of memory, so 32 GB may be required for a 4 GB dataset.

Also notice that size of the data on disk may be much smaller than memory needed to load the data as the file format may have compressed the data (for instance, loading a stack of JPEG files).

Amira’s Large Data Access (LDA) technology will enable you to work with data sizes exceeding your system’s physical memory. LDA is an excellent way to stretch the performance, but it is not a direct substitute for having more physical memory. The best performance and optimal resolution will be achieved by using Amira’s LDA technology in combination with a large amount of system memory. LDA provides a very convenient way to quickly load and browse your whole dataset. Note that LDA data will not work with most compute modules, which require the full resolution data to be loaded in memory.

Amira XImagePAQ provides another loading option to support for 2D and 3D image processing from disk to disk, without requiring loading the entire data into memory; modules then operate per data slab. This enables processing and quantification of large image data even with limited hardware memory. Since processing of each slab requires loading data and saving results from/to the hard drive, it dramatically increases processing time. Thus, processing data fully loaded in memory is always preferred for best performance.
1.4.1.4 Hard Drives

When working with large files, reading data from the disk can slow down your productivity. A standard hard drive (HDD) (e.g., 7200rpm SATA disk) can only stream data to your application at a sustained rate of about 60 MB/second. That is the theoretical limit; your actual experience is likely to be closer to 40 MB/second. When you want to read a 1 GB file from the disk, you will likely have to wait 25 seconds. For a 10 GB file, the wait is 250 seconds, over 4 minutes. LDA technology will greatly reduce wait time for data visualization, but disk access will still be a limiting factor when you want to read data files at full resolution for data processing. Compared to traditional HDDs, solid state drives (SSD) can improve read and write speeds.

For best performance, the recommended solution is to configure multiple hard drives (3 or more HDD or SSD) in RAID5 mode; note that RAID configurations may require substantially more system administration. For performance only, RAID 0 could be used, but be warned of risk of data loss upon hard-drive failure. If you want performance and data redundancy then RAID 5 is recommended.

Reading data across the network, for example from a file server, will normally be much slower than reading from a local disk. The performance of your network depends on the network technology (100 Mb, 1 Gb, etc.), the amount of other traffic on the network, and number/size of other requests to the file server. Remember, you are (usually) sharing the network and server and will not get the theoretical bandwidth. LDA technology may also facilitate visualization of volume data through the network, but if data loading is a bottleneck for your workflow, we recommend making a local copy of your data.

1.4.1.5 CPU

While Amira mostly relies on GPU performance for visualization, many modules are computational intensive and their performance will be strongly affected by CPU performance.

More and more modules inside Amira are multi-threaded and thus can take advantage of multiple CPUs or multiple CPU cores available on your system. This is the case for most of the quantification modules provided with Amira XImagePAQ (with some limitations on Mac platform, see Mac OS X Limitation section), and also various computation modules.

Fast CPU clock, number of cores, and memory cache are the three most important factors affecting Amira performance. While most multi-threaded modules will scale up nicely according to the number of cores, the scaling bottleneck may come from memory access. From experience, up to 8 cores show almost linear scalability while more than 8 cores do not show much gain in performance. A larger memory cache improves performance.

1.4.2 How hardware can help optimizing

Here is a summary of hardware characteristics to consider for optimizing particular tasks.

Visualizing large data (LDA):

- Fast hard drive,
- System memory,
- GPU Memory,
- Memory to GPU/CPU bandwidth.

Basic volume rendering:
- GPU fill rate (texels per second)

Advanced volume rendering (Volume Rendering module):
- Heavy use of pixel shaders,
- GPU clock frequency, number of GPU cores.

Large geometry rendering such as large surfaces from Isosurface or Generate Surface, large point clusters, large numerical simulation meshes, ...:
- GPU clock frequency, number of triangles per second.

Image processing and quantification (Amira XImagePAQ):
- Multiple CPU cores (for many modules, including most image processing modules),
- CPU clock frequency.

Anisotropic Diffusion, Non-Local Means Filter (high-performance smoothing and noise reduction image filters):
- GPU speed, number of GPU cores (stream processors), CUDA-compatible (NVIDIA).

Other compute modules, display module data extraction:
- CPU clock frequency,
- Multiple CPU cores (for a number of multi-threaded modules, such as Generate Surface, Register Images, Resample, Arithmetic).

Multi-display systems with Amira XScreen Extension: tiled displays, immersive displays, virtual reality:
- Multi-GPU systems such as PC clusters, etc.

GPU computing using custom module programmed using Amira XPand Extension and GPU API:
- GPU clock frequency, number of GPU cores (stream processors),
- Multi-GPU systems such as NVIDIA Tesla,
- CUDA support.
1.4.3 Special considerations

1.4.3.1 Firewall

An internet access is necessary to activate Amira. Your firewall may prevent the connection to the license server.
For more information, please refer to licensing troubleshooting (firewall problem).

1.4.3.2 Linux

Amira is only available for Intel64/AMD64 systems.
The official Linux distribution for Amira is Red Hat Enterprise Linux 6 64-bit. Nevertheless, Amira is likely to work on some other 64-bit Linux distributions if the required version of system libraries can be found, but technical support of those platforms will be limited. Here is a non-exhaustive list of these 64-bit Linux distributions:

- Red Hat Enterprise Linux 6.x, the official Linux distribution on which Amira has been fully tested.
- Red Hat Enterprise Linux 7.x, using some of the additional libraries from the $AMIRA_ROOT/lib/compat-LinuxAMD64 directory.
- CentOS 6 and Scientific Linux 6.
- CentOS 7, using some of the additional libraries from the $AMIRA_ROOT/lib/compat-LinuxAMD64 directory.

The folder $AMIRA_ROOT/lib/compat-LinuxAMD64 contains the most commonly missing dependencies (libjpeg.so.62, libgfortran.so.1, libXm.so.4, libstdc++.so.6). If your Linux distribution misses one of those files or has different versions installed, copy that file into the $AMIRA_ROOT/lib/arch-LinuxAMD64-Optimize directory. You can also install them using the software manager/tool of your linux distribution. For instance, you can install some of them on Ubuntu distribution using the following command:

```
sudo apt-get install libjpeg62 libstdc++6 libmotif4
```

Notes:

- After a standard installation of Linux, hardware acceleration is not necessarily activated, although X-Windows and Amira may work fine. To enable OpenGL hardware acceleration specific drivers may have to be installed. This can drastically increase rendering performance. Sometimes it is necessary to disable the stencil buffers (by starting Amira with the option -no_stencils) to get acceleration.

- On some distributions, some parts of the user interface, the segmentation editor for example, may not display correctly. This is a known Qt issue. You can work around this by disabling the composite option in the extension section of your Xorg.conf configuration file:
• To work properly on Linux systems where SELinux is enabled, Amira requires the modification of the security context of some Amira shared object files so they can be relocated in memory. The user (maybe root) that installs Amira has to run the following command from a shell console in order to set the right security context:

```bash
chcon -v -t texrel_shlib_t "${AMIRA_ROOT}"/lib/arch-Linux*-*/lib*.so
```

• Even if Amira should work with any desktop (like KDE), it has been validated only with GNOME.

### 1.4.3.3 Mac OS X

In order to run CUDA enabled modules, Mac OS X requires the most recent CUDA driver for Mac to be installed. It can be found at the following URL: [http://www.nvidia.com/object/mac-driver-archive.html](http://www.nvidia.com/object/mac-driver-archive.html) and must be installed manually. If this driver is not installed, modules of Amira using GPU compute capabilities will not be able to run properly.

### 1.4.3.4 XPand

To add custom extensions to Amira with Amira XPand Extension on Windows, you will need Microsoft Visual Studio 2013 Update 4. The compiler you need depends on the version of Amira you have. You can obtain the version information by typing `app uname` into the Amira console. It is important to install Visual Studio prior to run Amira in debug mode.

To add custom extensions to Amira with Amira XPand Extension on Linux, you will need gcc 4.4.x on RHEL 6. This is the last version to support gcc 4.4.x, next version will support only gcc 4.8.x. Use the following command to determine the version of the GNU compiler:

```bash
gcc --version
```

To add custom extensions to Amira with Amira XPand Extension on Mac OS X, you will need at least XCode 7.

### 1.4.3.5 MATLAB

To use the *Calculus MATLAB* module that establishes a connection to MATLAB (MathWorks, Inc.), follow these installation instructions:
Windows

If you did not register during installation, enter the following command on the Windows command line: `matlab /regserver`.

In addition, add `MATLAB_INSTALLATION_PATH/bin` and `MATLAB_INSTALLATION_PATH/bin/win64` in your PATH environment variable to allow Amira to find MATLAB libraries.

Linux

The `LD_LIBRARY_PATH` environment variable should be set to `MATLAB_INSTALLATION_PATH/bin/glnxa64` on Linux 64-bit.

The PATH environment variable should be also set to `MATLAB_INSTALLATION_PATH/bin`. If you still have trouble starting Calculus MATLAB after setting the environment variable, it might be because the GNU Standard C++ Library (libstdc++) installed on your platform is older than the one required by MATLAB. You can check MATLAB’s embedded libstdc++ version in `MATLAB_INSTALLATION_PATH/sys/os/glnxa64` on Linux 64-bit.

If needed, add this path to `LD_LIBRARY_PATH`.

Mac OS X

The `LD_LIBRARY_PATH` environment variable should be set and the PATH variable must be updated with the MATLAB binaries directory. For example, for MATLAB2017a:

```bash
export LD_LIBRARY_PATH=/Applications/MATLAB_R2017a.app/bin/maci64:
$LD_LIBRARY_PATH
export PATH=/Applications/MATLAB_R2017a.app/bin:$PATH
```

This will set the environment variables for the current terminal session. Amira must be run from this terminal session to enable access to MATLAB libraries. To set these variables for a global environment, please refer to the Mac developer zone.

MATLAB can be used on OSX 10.12 and 10.13 only after deactivation of System Integrity Protection: Deactivation of System Integrity Protection (http://www.imore.com/el-capitan-system-integrity-protection-helps-keep-malware-away):

System Requirements
1. Click the Apple menu
2. Select Restart...
3. Hold down command-R to boot into the Recovery System
4. Click the Utilities menu and select Terminal
5. Type ”csrutil disable” and press return
6. Close the Terminal app
7. Click the Apple menu and select Restart...

1.4.3.6 Dell Backup and Recovery Application

We have detected some incompatibility issues with former versions (< 1.9) of Dell Backup and Recovery Application which can make Amira crash when opening files with the file dialog. Please update your Dell Backup and Recovery Application to 1.9.2.8 or higher if you encounter this issue.

1.5 Installation

1.5.1 Standard Installation

Depending on your operating system, follow these instructions.

1.5.1.1 Windows

Once downloaded, double-click on Amira installer and follow the instructions. Note that administrator rights are required.

In the Select Components section, you can specify the installation type that suits you.

- Typical installation installs the standard component of the software.
- Developer installation (Amira XPand Extension license is needed) will add developer files and binaries files for debugging.
- Custom installation lets you choose which component to install.

After selecting the installation type, continue to follow the instructions to install Amira.

1.5.1.2 Linux

When download is finished, go to the directory where Amira installer is and open a terminal. Then, enter:
sudo ./Amira-XXX-Linux64-gccYY.bin
where XXX denotes the product version of Amira and YY the compiler version.
Select Next and press Enter.
In the section *Select Destination Folder*, you can choose where you want to install Amira. In the section *Select Components* you can select which components you want to install by double-clicking on it.

- The component *Main / Runtime files* installs Amira.
- The component *Developer files (XPand extension)* will install developer files and binaries files for debugging (Amira XPand Extension license is needed).

Finally, select Next and press Enter to continue Amira installation.

### 1.5.1.3 Mac OSX

After downloading the application, check that your Security and Privacy settings allow installing Amira. Then, double-click on Amira installer and follow the instructions.

In the *Installation Type* section, you can specify which components you want to install. Default settings only install Amira application on your system. If you check *Amira Developer Kit*, you will also install developer files (Amira XPand Extension license is needed). After selecting the installation type, click *Next* to continue Amira installation.

### 1.5.2 Silent Installation

Amira allows silent installation through command line on Windows. Amira will be installed with default parameters.

Follow these steps to launch the silent installation:

- Open a Windows command prompt (This procedure will not work in a Unix shell).
- Navigate to the Amira installer.
- Then, enter:
  ```
  Amira-XXX-Windows64-VCYY.exe /VERYSILENT /SUPRESSMSGBOXES /NORESTART /NOCANCEL /DIR=installPath
  ```
  where **XXX** denotes the product version of Amira and **YY** the compiler version.
- Installation starts without feedback.

### 1.6 Amira License Manager

#### 1.6.1 Contents

- About Amira licensing management
1.6.2 About Amira Licensing Management

The Thermo Fisher Scientific software license you have acquired defines your rights to use Amira and some of its modules (extensions) with a specific level of functionality, for a certain version, on designated equipment, and for a specific number of simultaneous users. The license may additionally be restricted to a specific period of time or to specific use cases.

Your Thermo Fisher Scientific software license is protected by a license key. Each time the Amira application is launched, it checks for a valid license key. If a valid license key is found, the application runs. Otherwise, you are requested to get a valid license key.

Amira has separate license keys for all Amira editions and extensions.

1.6.2.1 Node-locked Versus Floating Licenses

There are two main types of licenses: *node-locked licenses* and *floating licenses*.

*Node-locked licensing* allows the software to run on a single, identified computer only.

If you have purchased Amira *floating licenses*, one or several concurrent users can run Amira sessions at the same time from their computers located on your local network. The number of concurrent users is given by the number of Amira tokens purchased. In this case, you must install FlexNet Publisher license server manager on a local server. Then, on each end user’s computer, you will need to specify the location of this local licensing server (see *FNP license server mode*).
1.6.2.2 Time-limited Versus Perpetual Licenses

Licenses can be *time-limited* or *perpetual*. Time-limited licenses are valid until a given date, which is shown in the product splash screen at start up or in the About dialog (accessible via the Help > About menu). After this date, Amira will stop working. This is usually the case for trial licenses, Beta, or for renewable rented licenses (i.e., yearly subscriptions).

1.6.3 License Manager Actions

When you launch Amira for the first time, a dialog appears, to indicate that no valid license has been found on your computer. You have the choice of activating or evaluating the product (see Figure 1.1). Select the *Activate* option, to open the Activation Wizard. Three modes of configuration (see Figure 1.2) are available:

- *Use online local activation codes*: to activate one or several node-locked licenses on a computer with an Internet connection
- *Use offline local activation codes*: to activate one or several node-locked licenses on a computer with no Internet connection
- *Use FNP license server*: to specify a license server to activate one or several Amira (editions and/or extensions) licenses

![Figure 1.1: License Manager - No Valid License Found](image)

*Note:* Other actions may be available depending on the configuration mode.

1.6.3.1 Online Local Activation Mode

When you work in local activation mode, Amira allows you to manage your licenses. Different actions are available on depending on the status of your licenses.
Note: An Internet connection is required for all following actions. If you do not have any Internet connection, please refer to the 1.6.3.2 documentation.

Activate a Node-Locked License

When you purchase one or more Amira (editions and/or extensions) licenses, you should receive an email from fei@flexnetoperations.com containing a set of activation codes for each purchased product or option.

- Launch Amira and select Activate.
- On the first page of the Activation Wizard, select Use local activation codes and click on Next.
- In the Activate Licenses page, simply copy and paste your activation codes into the provided text field and press Activate.

The Activate button is enabled when the activation codes into the provided text field respect this format:

```
<EntitlementId> [HostId] <ProductName>_<ProductVersion>.
```

HostId is optional.

A connection to the online activation server will start immediately.
When activation is complete, the product is ready to be used and the license manager displays information related to the activation.
An activation code is a string similar to the following:

#License: Amira (Amira- 1 year time-limited node-locked application license (including maintenance service) - Multiple platforms support) - Expiration date: 12/13/2014:
BL5F-7773-A9F1-F79B Amira_6.7

Figure 1.3: License Manager - Node-Locked Activation Wizard

Add New Node-Locked License after Activation

Once Amira is activated, you can add other node-locked license to activate new extensions or editions. To do so:

- Select Help > License Manager
- Click on the Activate Additional Extensions or Editions button (see Figure 1.4)
- The license manager wizard is opened and displays the page Activate Licenses (see Figure 1.3). Simply copy and paste your activation codes into the provided text field and press Activate.

The Activate button is enabled when the activation codes into the provided text field respect this format:

\(<\text{EntitlementId}> [\text{HostId}] \text{ <ProductName>_<ProductVersion>}.\)
HostId is optional.

Transferring all Node-Locked Licenses to a New Computer

After activating a node-locked license on a computer, you may wish to move it to a new one. To do
so, you first need to de-activate the first license by returning the associated activation code and then activate it again on the new computer.

To do so:

- Open the Help > License Manager (see Figure 1.4)
- Click on the Deactivate Extensions or Editions button. A dialog will open (see Figure 1.16), allowing you to select the licenses you want to deactivate.
- When you click on the Deactivate button (see Figure 1.5, the selected licenses are returned to the server and can be activated on any other system.

**Upgrading to a New Amira Version**

When a new version of Amira is released, a dialog is displayed if the activation process was used for a previous version after installing and launching the new Amira version. It offers several choices, including an Upgrade Local Licenses option (see Figure 1.6).

If the licensed modules are under maintenance, they will be immediately available for use after the upgrade process.

**Note:** The previous version can still be used on the same computer even after upgrading to the new version.
Reactivating a License

When you use a renewable license (i.e., through a subscription agreement), Amira will stop working when the license expiration date is reached. When you launch a new session of Amira, an error dialog is displayed with several choices, including a Reactivate option.
As soon as you have renewed your subscription, you can re-activate your node-locked license to allow Amira to run again for a new period of time.

**Activate Demo Amira licenses**

The Demo licenses are node-locked and time-limited.

- Launch Amira and select the *Evaluate* option.
- On the first page of the Activation Wizard, select *Use local activation codes* and click on *Next*.
- On the *Activate Demo Licenses* page, simply copy and paste your activation codes into the provided text field and press *Activate*.

The *Activate* button is enabled when the format of activation code into the provided text field respect this format:

```
<EntitlementId> [ <HostId> ] <ProductName>_ <ProductVersion>.
```

HostId is optional.

A connection to the online activation server will start immediately. When activation is complete, the product is ready to be used.

**Activate Beta Amira Licenses**

The Beta licenses are only node-locked and time-limited.

When you launch a Beta version for the first time, or if your Beta licenses are expired, the Activation Wizard is opened at the *Configure Beta Version Licensing* page.
• Select *Use local activation codes* and click on *Next*

• On the *Activate Beta Licenses* page, simply copy and paste your activation codes into the provided text field and press *Activate*
The *Activate* button is enabled when the format of activation code into the provided text field respect this format:

```
<EntitlementId> [HostId] <ProductName>_<ProductVersion>.
```

HostId is optional.

A connection to the online activation server will start immediately. When finished, the product is ready to be used.

![Figure 1.10: License Manager - Beta Activation Wizard - Configure Beta Version Licensing](image1)

![Figure 1.11: License Manager - Beta Activation Wizard - Activate Beta Licenses](image2)
1.6.3.2 Offline Local Activation Mode

In offline activation mode, you will be able to perform the same actions described in 1.6.3.1, but without any Internet connection.

**Note:** Access to a computer with an internet connection will be required.

Activate a Node-Locked License

When you purchase one or more Amira licenses (i.e., editions and/or extensions), you should receive an email from fei@flexnetoperations.com containing a set of activation codes for each purchased product or option.

- Launch Amira and select **Activate**.
- On the first page of the Activation Wizard, select **Use offline activation codes** and click **Next**.
- In the **Activate Licenses** page, copy and paste your activation codes into the provided text field and specify a path to an XML file (i.e., a file with extension .xml) that will contain your offline activation request.
- Then, click **Next** (see Figure 1.12).

The **Next** button is enabled when the path of XML request file is specified. The format of activation code uses the following template:

```
<EntitlementId> [HostId] <ProductName>_ProductVersion>
```

HostId is optional.

The next page (see Figure 1.13) explains the remaining steps to perform before completing the offline activation request:

1. Transfer your XML request file to a computer with an Internet connection.
2. Open vsg3d.flexnetoperations.com/control/vsgs/offlineActivation in a web browser.
3. Specify the path to your XML request file in the provided file field.
4. Click **Process**. An activation.xml XML response file will be downloaded.
5. Transfer activation.xml to the computer without Internet access.
6. Click **Next** to import the activation.xml file and resume your activation request (see Figure 1.14).

When activation is complete, the product is ready to be used and the license manager displays information related to the activation.

Add New Node-Locked License After Activation
Once Amira is activated, you can add other node-locked license to activate new extensions or editions. To do so:

- Select Help > License Manager and click **Activate Additional Extensions or Editions** (see Figure 1.15).
The license manager wizard is opened and displays the page *Activate Licenses* (see Figure 1.12). Copy and paste your activation codes into the provided text field and specify a path to an XML file that will contain your offline activation request.

Then click **Next** and follow the displayed instructions (listed also in the 1.6.3.2 section).

The **Next** button is enabled when the path of XML request file is specified. The format of activation code uses the following template:

\[
\text{<EntitlementId> [<HostId>]} \text{ <ProductName>_<ProductVersion>.} \\
\text{HostId is optional.}
\]

### Transferring all Node-Locked Licenses to a New Computer

After activating a node-locked license on a computer, you may wish to move it to a new one. To do so, you first need to deactivate the first license by returning the associated activation code and then activate it again on the new computer.

To do so:

- Open the *Help > License Manager* (see Figure 1.15)
- Click *Deactivate Extensions or Editions*.
- A dialog will open (see Figure 1.16): select the licenses you want to deactivate and the path to the XML file that will contain your offline deactivation request.
- After clicking **Next**, the dialog displaying the offline instructions (listed also in the 1.6.3.2 sec-
tion) will be displayed.

- Once the import of the deactivation request has been performed, the selected licenses are returned to the server and can be activated on any other system.

### Upgrading to a New Amira Version

When a new version of Amira is released, a dialog is displayed if the activation process was used for a previous version after installing and launching the new Amira version. It offers several choices, including an **Upgrade Local Licenses** option.

After clicking **Upgrade Local Licenses**, a dialog will open (see Figure 1.18), allowing you to select the licenses you want to upgrade and the path to the XML file that will contain your offline upgrade request. Click **Next** to display the offline instructions dialog (also listed in the 1.6.3.2 section). Once the import of the upgrade request has been performed (and if the licensed modules are under maintenance), the selected licenses will be upgraded and the new version of Amira can be used immediately.

**Note:** The previous version can still be used on the same computer even after upgrading to the new version.

### Reactivating a License

When you use a renewable license (i.e., through a subscription agreement), Amira will stop working
when the license expiration date is reached. When you launch a new session of Amira, an error dialog will appear with several choices including a **Reactivate Local Licenses** option.

Click **Reactivate Local Licenses** to open the License Manager dialog box (see Figure 1.19) and select the licenses you want to activate plus the path to the XML file that will contain your offline reactivation request (see Figure 1.20). Click **Next** to display the offline instructions dialog (also listed
in the 1.6.3.2 section). Once the import of the reactivation request has been performed (and if you have renewed your subscription), the selected licenses will be reactivated and the new version of Amira can be used immediately for a new period of time.

Activate Demo Amira Licenses

The *Demo Licenses* are node-locked and time-limited.
Launch Amira and select the **Evaluate** option.

On the first page of the Activation Wizard, select **Use offline activation codes** and click **Next** (see Figure 1.21).

On the **Activate Demo Licenses** page, copy and paste your activation codes into the provided text field and specify a path to an XML file that will contain your offline activation request (see Figure 1.6.3.2).

The **Next** button is enabled when the path of XML request file is specified. The format of activation code uses the following template:

```
<EntitlementId> [HostId] <ProductName>_<ProductVersion>
```

HostId is optional.

Click **Next** to display the offline instructions dialog (also listed in the 1.6.3.2 section).

Once the import of the activation request has been performed, the product is ready to be used.

**Activate Beta Amira Licenses**

The Beta licenses are only node-locked and time-limited.
When you launch a Beta version for the first time or if your Beta licenses are expired, the Activation Wizard will open on the **Configure Beta Version Licensing** page.

- You must select **Use offline activation codes** and click **Next** (see Figure 1.23).
• On the *Activate Beta Licenses* page, simply copy and paste your activation codes into the provided text field and specify a path to an XML file that will contain your offline activation request (see Figure 1.6.3.2)

The **Next** button is enabled when the path of XML request file is specified. The format of activation code uses the following template:

\[
\text{<EntitlementId>} \ [\text{<HostId>}] \ <\text{ProductName}>\_<\text{ProductVersion}>.
\]

HostId is optional.

• Click **Next** to display the offline instructions dialog (also listed in the 1.6.3.2 section).

Once the import of the activation request has been performed, the product is ready to be used.

---

**Figure 1.23**: License Manager - Beta Activation Wizard - Configure Beta Version Licensing Offline

### 1.6.3.3 FNP License Server Mode

Amira floating or concurrent licenses are handled by FlexNet Publisher tool. Do the following to manage Amira floating licenses:

1. **Install** FlexNet Publisher license server manager on a local server of your LAN
2. **Activate** your Amira licenses on this license server
3. **Configure** each Amira instance on local computers to use this license server
FNP License Server Manager Installation and Management

Refer to the following website to install a FlexNet license server and manage floating licenses, including activation, upgrade, reactivation, and return:
www.fei-software-center.com/flexnet-server-doc/

Configure Amira to Use Licenses from FNP License Server

At Amira startup, select the Activate option and then Use FNP license server on the first page of the Activation Wizard.
You will need to specify the name of the FNP license server. Optionally, you can specify a port number with a separator ”:” (ServerName:<PortNumber>). Using a specific port number depends on the way the server is configured. In such a case, please contact your server license administrator for more information about the FNP license server configuration and the potential need to indicate a specific port number.
A connection to the FNP license server will start immediately. When done, the product is ready to be used.

Note: It is possible to test the connection to the specified server using the Test button.
1.6.3.4 Actions Independent of Activation Mode (Local, Server or Offline)

Reconfigure

You can change your configuration mode at any time, but this action requires that you restart the application.
To do so (in local activation mode), select Help > License Manager and click on the Reconfigure Licensing button.

Show Available Extensions

When Amira is running, you can see the activated licenses on your computer.
Select Help > Show Available Extensions.

Note: One activation code can activate several licenses.

1.6.4 Licensing Troubleshooting

1.6.4.1 Deactivating Amira

When using Amira activation codes, please deactivate them before any of the following operations:

- Uninstalling Amira
- Reinstalling or replacing the operating system
• Replacing the hard drive
• Disposing of the system

Otherwise, you will not be able to reactivate them on another system since they will still be active on the original system, and it will be difficult or impossible for you to deactivate them for a transfer.

To deactivate Amira, please read the following instructions according to your licensing mode: online
or offline.

1.6.4.2 Firewall Problem

If you have an Internet connection and encounter the error “Unable to connect to server https” when trying to activate a license, it originates from your firewall configuration. You need to configure your firewall to allow the connection to the online activation server:

- Server: vsg3d.flexnetoperations.com
- IP: 64.14.29.85
- Port: 443 (https)

1.6.4.3 Licensing Events Log

If an error occurs during Amira activation, you can find more details in the licensing events log. However, most likely you will need to send it to the technical support team for analysis (Help > Online Support menu).

The log file is saved in the user application data directory:

- Windows path: C:\Users\<your_login_name>\AppData\Roaming\Thermo Fisher Scientific\licensingAmira.log
- Linux and Mac OS X path: /home/<your_login_name>/.config/Thermo Fisher Scientific/licensingAmira.log

This log file details all activation actions and licensing information only when an error occurs.

1.6.4.4 License Lookup Log

If the VSG_LICENSE_DEBUG environment variable is set to a file name, licensing debug output is written to the specified file when Amira is launched. You can open and read this debug file yourself. However, most likely you will need to send it to the technical support team for analysis (Help > Online Support menu).

Below are instructions for setting this environment variable on Windows and on Linux and Mac OS X systems.

Note: For using a license debug filename as indicated below, you need sufficient privileges to write into the Amira installation directory. Otherwise, set VSG_LICENSE_DEBUG to a path where you can write files. For example, /home/<your_login_name>/debug.txt, or C:\Temp\debug.txt.
You can set the environment variable via the Control Panel for Windows or you can set it in a command prompt on all platforms.

**Windows - Control Panel**

1. Go to the Control Panel via the Windows Start menu.
2. In the Control Panel, select the System application.
3. Click the Advanced tab.
4. Click the Environment variables button.
5. In either the User or System variables, click **New**.
6. For the Variable name, enter `VSG_LICENSE_DEBUG`.
7. For the Variable value, enter `debug.txt` (without the quotes).
8. Click **OK** to close the dialog boxes
9. Run Amira from the Start menu. When the License Manager dialog is displayed, dismiss it.
10. Then look for a file named `debug.txt` in the top level of the Amira installation directory. Send the file to **tech support** for analysis.

**Windows - Command Prompt**

1. On Windows you can get to a command prompt via the Windows Start menu as follows: 
   Start > Programs > Accessories > Command Prompt
2. In the command prompt window, type:
   ```
   set VSG_LICENSE_DEBUG=debug.txt
   ```
3. Change the current directory to where your Amira executable is. For example:
   ```
   cd C:\Program Files\Amira6\bin\arch-Win64VC12-Optimize
   ```
4. Run Amira as follows:
   ```
   Amira.exe
   ```
5. When the License Manager dialog displays, dismiss it.
6. Look for the file `debug.txt` in the current directory. Send the file to **tech support** for analysis.

**Linux and Mac OS X - Terminal**

1. On Linux and Mac OS X systems, the exact command to use for setting environment variables depends on the kind of shell you are using. Here are examples for a few commonly used shells.
   Bash shell:
   ```
   export VSG_LICENSE_DEBUG=debug.txt
   ```
   C shell:
setenv VSG_LICENSE_DEBUG debug.txt

2. In the window in which you set the environment variable, change to the Amira installation directory. For example:
   cd /opt/Amira6

3. Run Amira as follows:
   bin/start

4. When the License Manager dialog is displayed, dismiss it.
5. Look for the file debug.txt in the current directory. Send the file to tech support for analysis.

1.6.4.5 Return or Upgrade Impossible with Node-Locked Licenses

The License Manager uses the Unique Machine Number (UMN) to validate the identity of the machine that initiated the request. The Unique Machine Number value is retrieved from your system hardware information, or from hypervisor-controlled information for virtual machines. If your system hardware is modified since the original activation, the UMN of your machine can be changed and the License Manager will consider your machine to be a different machine. Consequently, the following error message may appear:

"Trying to return a fulfillment issued to a different machine."

If this error message occurs, contact Technical Support for assistance. Section 1.8 (Contact and Support).

1.6.5 Contacting the License Administrator

You can contact the license administrator using this address: fei-sw-license@fei.com
You can find more information here: Section 1.8 (Contact and Support).

1.7 First steps in Amira

For a quick introduction to Amira, you can visit our YouTube channel, and watch introductory videos such as Amira Getting Started in addition to the tutorials below.

This chapter contains step-by-step tutorials illustrating the use of Amira. The tutorials are almost independent of each other, so after reading the basics in the Getting Started section it is possible to follow each tutorial without knowing the others. If you go through all tutorials you will get a good survey of Amira’s basic features. In particular, these topics will be covered:

- **Getting started** - the basics of Amira
- **Reading images** - how to read images
- **Visualizing 3D images** - slices, isosurfaces, volume rendering
- **Image segmentation** - segmentation of 3D image data
• **Processing an image stack in 2D** - how to use the Image Stack Processing workroom
• **Surface reconstruction** - surface reconstruction from 3D images
• **Grid generation** - creating a tetrahedral grid from a triangular surface
• **Advanced surface and grid generation** - meshing and numerical simulation
• **Visualization and analysis of 3D models and numerical data** - analysis and presentation of numerical data
• **Warping** - how to work with landmark sets
• **3D image registration** - how to register 3D image data sets
• **Alignment of 2D physical cross-sections** - how to reconstruct a 3D model
• **Vector fields** - stream lines and other techniques
• **Filament Editor** - filament tracing for neurons and vessels images
• **Skeletonization** - how to analyse the network or tree-like structures in 3D image data
• **The Animation Director** - creating animations with the Animation Director
• **Creating movie files** - using the MovieMaker module
• **Using MATLAB** - how to use the CalculusMatlab module
• **Python Tutorial** - Using Tools from the Python Eco-System within Amira
• **Multi-planar Viewer** - visualize and register multiple volumes
• **Tracing filamentous structures in electron tomography** - how to extract microtubule centerlines from electron tomograms
• **Processing of Time Series Data** - how to create and apply a segmentation workflow to an entire time series.
• **Object Tracking** - how to use the object tracking tools in Amira.
• **Meshing Workroom Tutorial** - meshing workroom for numerical simulation
• **Digital Volume Correlation Analysis** - perform a DVC analysis and visualize the corresponding displacement and strain fields
• **Recipes** - recipes creation, customizable workflow automation
• **Pore Space Analysis** - analyze and characterize a pore space

In all tutorials the steps to be performed by the user are marked by a dot. If you only want to get a quick idea how to work with Amira you may skip the explanations between successive steps and just follow the instructions. But in order to get a deeper understanding, you should refer to the text.

Note: If you want to visualize your own data, please first refer to the *Data Import* section. This section contains some general hints on how to import data sets into Amira.
1.8 Contact and Support

For purchasing an Amira Software license and for support, visit our web sites or contact one of the following addresses.

**Online:**

For technical support:
fei-sw-support@fei.com

For requesting license keys, please contact:
fei-sw-license@fei.com

For contacting your sales representative:
http://www.fei.com/contact-fei-sales/

Amira web site:
http://www.thermofisher.com/amira-avizo

**Phone numbers and addresses:**

License key requests:

Phone: +33 556 13 37 78
Fax: +33 556 13 02 10
Email: fei-sw-license@fei.com

FEI SAS, a part of Thermo Fisher Scientific
3, Impasse Rudolf Diesel, Bat A - BP 50227
F-33708 Merignac Cedex
France
Phone: +33 (0) 556 13 37 77
Fax: +33 (0) 556 13 02 10
Email: fei-sw-info@fei.com

Hotline requests
Phone: +33 556 13 37 71
Fax: +33 556 13 02 10
Email: fei-sw-support@fei.com
Chapter 2

Getting Started

In this section, you will learn how to

1. start the program.
2. load a demo data set into the system
3. invoke editors for editing the data
4. connect visualization modules to the data
5. interact with the 3D viewer.

The following text has the form of a short step-by-step tutorial. Each step builds on the steps described before. We recommend that you read the text online and carry out the instructions directly on the computer. Instructions are indicated by a dot so you can execute them quickly without reading the explanations between the instructions.

2.1 Start the program

- On a Windows system, select the Amira icon from the start menu.
- On a Unix system, start Amira by launching the script `bin/start`.
- On a Mac OS X system, select the Amira icon from the Application menu.

When Amira is running, a window like the one shown in Figure 2.1 appears on the screen. This Start page is divided into several major regions:

1. **Recent Data**: allows opening data using **Open Data** button and displays all data recently opened (at first start, this section is empty).
2. **Recent Project**: allows opening project using **Open Project** button and displays all project
recently opened (at first start, this section is empty).

3. **Create New Project**: allows creating a new project using Blank Project button.

4. **Help**: contains some links to help of Amira.

5. **News**: contains some news on Amira.

6. **Follow us**: contains some links to follow Amira community.

7. **Workrooms toolbar**: provides quick access to some important workrooms. See [specific documentation of workroom toolbar](#).

When switching to **Project** workroom, a window like the one shown in Figure 2.2 appears on the screen. The user interface is divided into three major regions.

1. The Project View will contain small icons representing data objects and modules.
2. The Properties Area displays interface elements (ports) associated with Amira objects.
3. The 3D viewer window displays visualization results, e.g., slices or isosurfaces.

You can also activate the help browser by pressing F1, selecting **User’s Guide** from the **Help** menu, or by typing `help` in the console window.
2.2 Loading Data

Usually, the first thing you will do after starting Amira is to load a data set. Let’s see how this can be done:

- Choose Open Data... from the File menu.

After selecting this menu item, the file dialog appears (see Figure 2.3). By default, the dialog displays the contents of the directory defined in the environment variable AMIRA_DATADIR. If no such variable exists, the contents of Amira’s demo data directory are displayed. You can quickly switch to other directories, e.g., to the current working directory, using the directory list located in the upper part of the dialog window.

At the top of the Project View is an Open Data button which is a shortcut to the File/Open Data dialog. You may use it for opening data files in the tutorials that follow. However, the tutorials will instruct you to use the File/Open Data command.

Amira is able to determine many file formats automatically, either by analyzing the file header or the file name suffix. The format of a particular file will be printed in the file dialog right beside the file name.

Now, we would like to load a scalar field from one of the demo data directories contained in the Amira distribution.

- Change to the directory data/tutorials, select the file chocolate-bar.am and press OK.

The data will be loaded into the system. Depending on its size this may take a few seconds. The file is stored in Amira’s native Amira format. The file chocolate-bar.am contains 3D image data of...
Data sets can be loaded into Amira using the file browser. In most cases, the file format can be determined automatically. This is done by either analyzing the file header or the file name suffix.

A chocolate bar. The data represents a series of parallel 2D image slices across a 3D volume. Once it has been loaded, the data set appears as a green icon in the Project View. In the following, we call this data set “chocolate-bar data set”.

- Click on the green data icon with the left mouse button to select it.

This causes some information about the data record to be displayed in the Properties Area (Figure 2.4). In our case, we can read off the dimensions of the data set, the primitive data type, the coordinate type, as well as the voxel size. To deselect the icon, click on an empty area in the Project View window. You may also pick the icon with the left mouse button and drag it around in the Project View.

Data objects are represented by green icons in the Project View. Once an icon has been selected information about the data set such as its size or its coordinate type is displayed in the Properties Area.
Clicking on an object typically causes additional buttons to be displayed in the button area at the top of the Project View. These buttons are convenience buttons allowing easy one-click access to the modules most frequently used by the selected object. The tutorials, however, will have you access modules via the menu interface to help familiarize you with the organization of modules within Amira.

### 2.3 Invoking Editors

After selecting an object, in addition to the textual information, some buttons appear in the Properties Area, to the far right of the data object’s name. These buttons represent *editors* which can be used to interactively manipulate the data object in some way. For example, all data objects provide a *data parameter editor*. This editor can be used to edit arbitrary attributes associated with the data set, e.g., filename, original size, or bounding box. Another example is the *Transform Editor* which can be used to translate or rotate the data in world coordinates. However, at this point we don’t want to go into details. We just want to learn how to create and delete an editor:

- Invoke one of the editors by clicking on an editor icon.
- Close the editor by clicking again on the editor icon.

Further information about particular editors is provided in the user’s reference manual.

### 2.4 Visualizing Data

Data objects like the chocolate bar data can be visualized by attaching *display modules* to them. Each icon in the Project View provides a popup menu from which matching modules, i.e., modules that can operate on this specific kind of data, can be selected. To activate the popup menu

- Right-click on the green data icon. Choose the entry called *Bounding Box*.

After you release the mouse button, a new *Bounding Box* module is created and is automatically connected to the data object. The *Bounding Box* object is represented by a yellow icon in the Project View and the connection is indicated by a gray line connecting the icons. At the same time, the graphics output generated by the *BoundingBox* module becomes visible in the 3D viewer. Since the output is not very interesting, in this case we will connect a second display module to the data set:

- Choose the entry called *Ortho Slice* from the popup menu of the chocolate bar data set.
In order to attach a module to a data set, click on the green icon using the right mouse button. A popup menu appears containing all modules which can be used to process this particular type of data.

Now a 2D slice through the chocolate bar is shown in the viewer window. Initially, a slice oriented perpendicular to the z-direction and centered inside the image volume is displayed. Slices are numbered 0, 1, 2, and so on. The slice number as well as the orientation are parameters of the Ortho Slice module. In order to change these parameters, you must select the module. As for the green data icon, this is done by clicking on the Ortho Slice icon with the left mouse button. By the way, in contrast to the Bounding Box, the Ortho Slice icon is orange, indicating that this module can be used for clipping.

- Select the Ortho Slice module.

Now you should see various buttons and sliders in the Properties Area, ordered in rows. Each row represents a port allowing you to adjust one particular control parameter. Usually, the name of a port is printed at the beginning of a row. For example, the port labeled Slice Number allows you to change the slice number via a slider.

- Select different slices using the Slice Number port.

By default, Ortho Slice displays slices with xy orientation, i.e., perpendicular to the z-direction. However, the module can also extract slices from the image volume perpendicular to x- and y-direction.
Figure 2.6: Visualization results are displayed in the 3D viewer window. Parameters or ports of a module are displayed in the Properties Area after you select the module.
2.5 Interaction with the Viewer

The 3D viewer lets you look at the model from different positions. If you click on the *Trackball* button in the viewer toolbar, moving the mouse inside the viewer window with the left mouse button pressed lets you rotate the object. If you click on the *Translate* or the *Zoom* buttons, you can translate or zoom the object. (For zoom, move the mouse up and down.)

Alternatively, with the middle mouse button pressed, you can translate the object. For zooming, press both the left and the middle mouse buttons at the same time and move the mouse up or down.

Notice that the mouse cursor has the shape of a little hand inside the viewer window. This indicates that the viewer is in viewing mode. By pressing the *ESC* key you can switch the viewer into interaction mode. In this mode, interaction with the geometry displayed in the viewer is possible by mouse operations. For example, when using *Ortho Slice* you can change the slice number by clicking on the slice and dragging it.

- Select different buttons of the *Orientation* port of the *Ortho Slice* module.
- Rotate the object in a more general position.
- Disable the *adjust view* toggle in the *Options* port.
- Change the orientation using the *Orientation* port again.
- Choose different slices using the *Slice Number* port or directly in the viewer with the interaction mode described above.

Each display module has a *viewer toggle* by which you can switch off the display without removing the module. This button is just to the right of the colored bar where the module name is shown, as illustrated below.

- Deactivate and activate the display of the *Ortho Slice* or *Bounding Box* module using the *viewer toggle*.

If you want to remove a module permanently, select it and choose *Remove Object* from the *Project View* menu. Choose *Remove All* from the same menu to remove all modules.

- Remove the *Bounding Box* module by selecting its icon and choosing *Remove Object* from the *Project View* menu.
- Remove all remaining modules by choosing *Remove All Objects* from the same menu.

Now the Project View should be empty again. You may continue with the next tutorial.
Figure 2.7: The Ortho Slice module is able to extract arbitrary orthogonal slices from a regular 3D scalar field or image volume.

## 2.6 Data Import

Usually, one of the first things Amira users want to know is how to import their own data into the system. This section contains some advice intended to ease this task.

In the simplest case, your data is already present in a standard file format supported by Amira. To import such files, simply use Open Data in the File menu or use the "Open Data..." green button in the project view. A list of all supported formats can be found in the index section of the user’s guide. Usually, the system recognizes the format of a file automatically by analyzing the file header or the filename suffix. If a supported format is detected, the file browser indicates the format name.

Often, 3D image volumes are stored slice by slice using standard 2D image formats such as TIFF or JPEG. In case of medical images, slices are commonly stored in ACR-NEMA or DICOM format. If you select multiple 2D slices simultaneously in the file browser, all slices will automatically be combined into a single 3D data set. Simultaneous selection is most easily achieved by first clicking the first slice and then shift-clicking the last one.

If your data is not already present in a standard file format supported by Amira, you will have to
write your own converter or export filter. For many data objects such as 3D images, regular fields, or tetrahedral grids, Amira’s native Amira format is most appropriate. Using this format you can even represent point sets or line segments for which there is hardly any other standard format. The Amira format documentation explains the file syntax in detail and contains examples of how to encode different data objects. One important Amira data type, triangular non-manifold surfaces, cannot be represented in a Amira file but has its own file format called HxSurface format.

Alternatively, with Amira XPand Extension, a C++ programmer can extend Amira in order to integrate a custom reader or writer.

Finally, in case of images or regular fields with uniform coordinates, you may also read binary raw data. Note that for raw data the dimensions and the bounding box of the data volume must be entered manually in a dialog box which pops up after you have selected the file in the file browser.
Chapter 3

Tutorials: Visualizing and Processing 2D and 3D Images

Amira provides extensive support for importing, visualizing, and processing 2D and 3D images. For an overview of related features, please refer to the section 1.2. The tutorials in this chapter introduce the following topics:

- Reading images - how to read images
- Visualizing 3D images - slices, isosurfaces, volume rendering
- Introduction to the Multi-planar Viewer - visualize one or two data set at the same time using a Multi Planar Reconstruction
- Intensity Range Partitioning - segmentation of 3D image data
- Image segmentation - segmentation of 3D image data
- Deconvolution for light microscopy - powerful algorithms for improving the quality of microscopic images
- Working with Multi-Channel Images - visualize multi-channel image data
- Image Stack Processing - creating 2D workflows for processing image stacks
- Tracing filamentous structures in electron tomography - how to extract centerlines of tube-like structures from electron tomograms

3.1 How to load image data

Loading image data is one of the most basic operations in Amira. Other than with 2D images, there are not many standardized file formats containing 3D images. This tutorial guides you by means of examples on how to load the different kinds of 3D images into Amira. In particular this tutorial covers
the following topics:

1. Using the File/Open Data... browser and setting the file format.
2. Reading 3D image data from multiple 2D slices.
3. Setting the bounding box or voxel size of 3D images.
4. The Stacked Slices file format.
5. Working with Large Disk Data.

3.1.1 The Amira File Browser

Image data is loaded in Amira with the File/Open Data... dialog. All file formats supported by Amira are recognized automatically either by a data header or by the file name suffix. What follows is only of concern in these cases:

- The automatic file format detection fails.
- 3D image data is stored in several 2D files.
- The data is larger than the available main memory.

Setting the file format

In most cases the format of a file is determined automatically, either by checking the file header or by comparing the file name suffix with a list of known suffixes. In the load dialog, the file format is displayed in a separate column in detail view.

Example:

- Files containing the string Amira in the first line are considered Amira files.
- Files with the suffix .stl are considered STL files.

If automatic file format detection fails, e.g., because some non-standard suffix has been used, the format may be set manually using the File/Open Data As... dialog.

3.1.2 Reading 3D Image Data from Multiple 2D Slices

A common way to store 3D image data is to write a separate 2D image file for each slice. The 2D images may be written in TIFF, BMP, JPEG, or any other supported image file format. In order to load such data in Amira, all 2D slices must be selected simultaneously in the file browser. This can be done by clicking the first file and shift-clicking the last one.

- Open the File/Open Data... dialog.
- Browse to the $AMIRA_ROOT/data/teddybear/ directory.
- Select the first file teddybear000.jpg
Figure 3.1: The *Format* option of the file browser

Figure 3.2: Loading multiple 2D images

*How to load image data*
3.1.3 Setting the Bounding Box

When loading a series of bitmap images, usually the physical dimensions of the images are not known to Amira. Therefore, an Image Read Parameters dialog appears that prompts you for entering the physical extent of the Bounding Box. Alternatively, the size of a single voxel can be set. In Amira, the bounding box of an object is the smallest rectangular, axis-aligned volume in 3D space that encompasses the object. Note that in Amira, the bounding box of a uniform data set extends from the center of the first voxel to the center of the last one. For example, if you have 256 voxels and you know the voxel size to be 1 mm, the bounding box should be set to 0 - 255 (or to some shifted range).

- Enter 1 in the first, second, and third text field of the Voxel Size port.
- Click OK.

This method will always create a data set with uniform coordinates, i.e., uniform slice distance. In case of variable slice distances, the StackedSlices format should be used.

3.1.4 The Stacked Slices file format

Especially with histological serial sections, it often happens that slices are lost during preparation. To handle such cases, Amira provides a special data type corresponding to a file format, called Stacked Slices. This file format allows a stack of individual image files to be read with optional z- values for each slice. The slice distance is not required to be constant. The images must be one-channel or RGBA images in an image format supported by Amira (e.g., TIFF). The reader operates on an ASCII
description file, which can be written with any editor. Here is an example of a description file:

```
# Amira Stacked Slices
# Directory where image files reside
pathname C:/data/pictures
# Pixel size in x- and y-direction
pixelsize 0.1 0.1
# Image list with z-positions
picture1.tif 10.0
picture7.tif 30.0
picture13.tif 60.0
colstars.jpg 330.0
end
```

Some remarks on the syntax:

- `# Amira Stacked Slices` is an optional header that allows Amira to automatically determine the file format.
- `pathname` is optional and can be included if the pictures are not in the same directory as the description file. A space separates the tag ”pathname” from the actual pathname.
- On Windows systems, `pathname` should still be specified with `/` and not `\`.
- `pixelsize` is optional, too. The statement specifies the pixel size in x- and y-directions. The bounding box of the resulting 3D image is set from 0 to `pixelsize*(number_of_pixels-1)`.
- `picture1.tif 10.0` is the name of the slice and its z-value, separated by a space character.
- `end` indicates the end of the description file.
- Comments are indicated by a hash-mark character (`#`).

### 3.1.5 Working with Large Disk Data

Sometimes image data are so large that they do not fit into the main memory of the computer. Since the Amira visualization modules rely on the fact that data are in physical memory, this would mean that such data cannot be displayed in Amira. To overcome this, a special purpose module is provided that leaves most of the data on disk and retrieves only a user-specified subvolume. This subvolume can then be visualized with the standard visualization modules in Amira.

- Use the **File/Open Data As...** dialog and go to `$AMIRA_ROOT/data/grain/`
- Select the `grain.am` and press the **Open** button.
- Select **Amira as Large Disk Data** as format and confirm your choice with **OK**.

The data will be displayed in the Project View as a regular green data icon. The info line indicates that
it belongs to the data class \textit{HxRawAsExternalData}.

- Right-mouse click, attach an \textit{Extract Subvolume} module.
- Select the \textit{Extract Subvolume} module in the Project View and press the \textit{Max width}, \textit{Max height} and \textit{Max depth} buttons.
- Check \textit{Subsample} and enter 2 2 2 into the \textit{Subsample} fields and press the \textit{Apply} button.

This retrieves a down-sampled version of the data. Disconnect the \textit{grain.view} data icon from the \textit{Extract Subvolume} module by selecting NO SOURCE in the Master port of \textit{grain.view}, and use it as an overview (e.g., with \textit{Ortho Slice}). Selecting NO SOURCE in the DATA port of \textit{Extract Subvolume} doesn’t disconnect \textit{grain.view} from \textit{Extract Subvolume}

- Selecting the \textit{Extract Subvolume} module in the Project View and deselect the \textit{subsample} check box.
- Use the dragger box in the viewer to resize the subvolume.
- Press the \textit{Apply} button.
- Attach an \textit{Isosurface} module to the \textit{grain2.view} (set threshold set to 100).
- Press \textit{Apply}.

Otherwise, the Isosurface is not displayed.

\textbf{Tip:} To browse the data, check the \textit{auto-refresh} check box for the \textit{Extract Subvolume} and Isosurface modules. Now each time the blue subvolume dragger is repositioned, the visualization is updated automatically.

Loading \textit{Amira}, \textit{StackedSlices}, and \textit{Raw ”as Large Disk Data”} is a convenient and fast way of exploring data that exceed the size of system memory. However, especially with \textit{StackedSlices}, it is not always the most efficient way of doing this. Amira can store the image data in a special format that facilitates the random retrieval of data from disk.

- Choose from the \textit{File} menu \textit{Convert to Large Data Format}.
- Click \textit{Browse} from the \textit{Input} port.
- Click \textit{Add}, go to $\text{AMIRA\_ROOT/data/grain/}$ and select \textit{grain.am}, then click \textit{OK}.
- Click \textit{Browse} from the \textit{Output} port.
- Go to a temporary folder and enter a file name of your choice.
- Press the \textit{Apply} button.

Although you will most likely not notice any difference with the small image data used in this tutorial, this method for retrieving large data significantly accelerates the \textit{Apply} operation.

\textit{How to load image data}
3.1.6 Working with out-of-core data files (LDA)

The out-of-core management tools allow you load and visualize data sets larger than the amount of RAM installed on your system, as well as convert these data sets into LDA (Large Data Access) files. These LDA files can be used to visualize very large data (hundreds of gigabytes), such as seismic or microscopy data, using a limited amount of memory. It is possible to convert original data of the following types: Amira, RawData, and StackedSlices (stacks of SGI, TIFF, GIF, JPEG, BMP, PNG, JPEG2000, PGX, PNM, and RAS raster files). LDA data allows subvolume extraction to display parts of the volume, or multi-resolution access to have a full subsampled view or accurate refined local views.

Note: in standard, Amira can support up to 8GB size LDA data. Above 8GB, you will need the Amira XLVolume Extension.

In particular, the following topics will be discussed in this tutorial:
1. Adjusting the size threshold to allow conversion
2. Loading the out-of-core data
3. Raw data parameters
4. Out-of-core conversion
5. Displaying an ortho slice, a slice, and a 3D volume

Please follow the instructions below. Each step builds on the step before.

### 3.1.6.1 Tune the Size Threshold to Enable Conversion

In the Edit menu, select the Preferences item. This opens the Amira Preferences dialog. Please select the LDA tab (see Figure 3.6). Using the slider or text field, set the threshold to 10MB. When you load a file of file size greater than this threshold, the out-of-core data dialog will be displayed.

**Note:** To see the images as laid out in this tutorial, you should also use the Layout tab of the Edit/Preferences menu, and toggle on show viewer in top-level window.

### 3.1.6.2 Load the Out-of-core Data

Please open the file grain.raw using the File/Open Data... menu (see Figure 3.7). The file is located in $AMIRA_ROOT/data/tutorials/outofcore/ in the Amira install directory. Its size is 16MB, above the defined threshold.

The Out-Of-Core data dialog is displayed. Three loading options are displayed (see Figure 3.8):

- **Convert to Large Data Access (LDA) format:** convert the file to an LDA file, and then load it.
- **PRO:** This builds a multiresolution file allowing full interactive view or local full resolution viewing.
- **CON:** This can be time consuming, with an initial pass and then the true conversion pass.
Figure 3.6: Amira Preferences, LDA settings

Figure 3.7: Open the out-of-core data file
• **Read as External Disk Data**: read data blocks from disk, allowing almost continuous disk access.
  - **PRO**: No need to generate an extra file.
  - **CON**: Continuous access to disk. Slow with data sets larger than 4GB.

• **Read complete volume into memory**: load full data into memory and then access to memory only.
  - **PRO**: Adapted for average sized data.
  - **CON**: Requires as much RAM as your data set size.

Please select “Convert to Large Data Access (LDA) format”. Then, on the next dialog (Destination file), specify the LDA destination file. grain.lda in a temporary folder for instance (see Figure 3.9).

**Note**: A .lda file can be loaded then, without any conversion required.

Another option allows you to perform conversion in batch mode so you can run other processes while the conversion is done in the background.

### 3.1.6.3 Raw Data Parameters

As the input data is raw, please fill in the raw data parameters dialog with information as on the following figure (see Figure 3.10):

Data type is ”8-bit unsigned”, dimension 256*256*256.
Figure 3.9: Choose LDA destination file

Figure 3.10: Raw data parameters panel

How to load image data
3.1.6.4 Out-of-core Conversion

During conversion, the out-of-core conversion progress is showed in the progress bar (see Figure 3.11). This process is done in two steps. First of all, an initial step, and then the conversion step at about 4MB/s (on a P4 2.6GHz, no SATA disk). You can cancel the process if you wish.

![Warning: preprocessing can be time-consuming before conversion starts.]

Figure 3.11: Out-of-core conversion progress dialog

The converted file is now in the Project View ready to be used and connected to other modules.

3.1.6.5 Display an Ortho Slice, a Slice, and a 3D Volume

Right-click on the data icon in the Project View. In the Display submenu, choose the Ortho Slice module. Repeat these steps for a Slice and a Volume Rendering. You can also display the bounding box of the full volume.

In order to view this scene with the same settings, after converting grain.raw into grain.lda (lda file required, with the right name) please load the project grain.hx (in the same directory $AMIRA_ROOT/data/tutorials/outofcore).
3.2 Visualizing 3D Images

This section provides a step-by-step introduction to the visualization of regular scalar fields, e.g., 3D image data. Amira is able to visualize more complex data sets, such as scalar fields defined on curvilinear or tetrahedral grids. Nevertheless, in this section we consider the simplest case, namely scalar fields with regular structure. Each step builds on the step before. In particular, the following topics will be discussed:

1. orthogonal slices
2. simple threshold segmentation
3. resampling the data
4. displaying an isosurface
5. cropping the data
6. volume rendering

We start by loading the data you already know from Section 2 (Getting Started): a 3D image data set of a part of a 235 x 175 x 295 CT scan of a chocolate bar.

- Load the file `chocolate-bar.am` located in subdirectory `data/tutorials`.

### 3.2.1 Orthogonal Slices

The fastest and in many cases most ”standard” way of visualizing 3D image data is by extracting orthogonal slices from the 3D data set. Amira allows you to display multiple slices with different orientations simultaneously within a single viewer.

- Connect a Bounding Box module to the data (use right mouse on `chocolate-bar.am`).
- Connect an Ortho Slice module to the data.
- Connect a second and third Ortho Slice module to the data.
- Select Ortho Slice 2 and press xz in the Orientation port.
- Similarly, for Ortho Slice 3, choose yz orientation.
- Rotate the object in the viewer to a more general position.
- Change the slice numbers of the three Ortho Slice modules in the respective ports or directly in the viewer as described in the section Getting Started.

In addition to the Ortho Slice module, which allows you to extract slices orthogonal to the coordinate axes, Amira also provides a module for slicing in arbitrary orientations. This more general module is called Slice. You might want to try it by selecting it from the Display submenu of the chocolate bar data popup menu.

### 3.2.2 Simple Data Analysis

The values of the Colormap port of the Ortho Slice module determine which scalar values are mapped to black or white, respectively. If you choose a range of e.g., 30...100, any value smaller or equal to 30 will become black, and all pixels with an associated value of more then 100 will become white. Try modifying the range. This port provides a simple way of determining a threshold, which later can be used for segmentation, e.g., to separate background pixels from other structures. This can be most easily done by making the minimum and maximum values coincide.

- Remove two of the Ortho Slice modules.
- Select the remaining Ortho Slice module.
• Make sure that the Mapping Type is set to Colormap.
• Change the minimum and maximum values of the Colormap port until these values are the same and a suitable segmentation result is obtained. For this data, a value of 410 for the min and 411 for the max should be a good threshold value.

A more powerful way of quantitatively examining intensity values of a data set is to use a data probing module Point Probe or Line Probe. However, we will not discuss these modules in this introductory tutorial.
Figure 3.14: By adjusting the data window of the Ortho Slice module a suitable value for threshold segmentation can be found. Intensity values smaller than the min value will be mapped to black, intensity values bigger than the max value will be mapped to white.

3.2.3 Resampling the Data

Now we are going to compute and display an Isosurface. Before doing so, we will resample the data. The resampling process will produce a data set with a coarser resolution. Although this is not necessary for the isosurface tool to work, it decreases computation time and improves rendering performance. In addition, you will get acquainted with another type of module. The Resample module is a computational module. Computational modules are represented by red icons. Typically you must press the green Apply button at the bottom of the Properties Area to start the computation. After you press this button, they produce a new data object containing the result.

- Connect a Resample module to the data and select it.
- Enter values for a coarser resolution, e.g., x=64, y=64, z=64.
- Press the Apply button.
A new green data icon representing the output of the resample computation named *chocolate-bar:Resampled* is created. You can treat this new data set like the original chocolate bar data. In the popup menu of the resampled chocolate bar you will find exactly the same attachable modules and you can save, export and load it like the original data.

You may want to compare the resampled data set with the original one using the *Ortho Slice* module. You can simply pick the black line indicating the data connection and drag it to a different data source. Whenever the mouse pointer is over a valid source, the connection line appears highlighted in gray.

### 3.2.4 Displaying an Isosurface

For 3D image data sets, isosurfaces are useful for providing an impression of the 3D shape of an object. An isosurface encloses all parts of a volume that are brighter than some user-defined threshold.

- Turn off the viewer toggle of the *Ortho Slice* module.
- Connect an *Isosurface* module to the resampled data record and select it.
- Adjust the threshold port to 450 or a similar value.
- Press the *Apply* button.

### 3.2.5 Cropping the Data

Cropping the data is useful if you are interested in only a part of the field. A crop editor is provided for this purpose. Its use is described below:

- Remove the resampled data *chocolate-bar:Resampled*.
- Activate the display of the *Ortho Slice* module.
- Select the *chocolate-bar.am* data icon.
- Click on the Crop Editor button in the Properties Area.

A new window pops up. There are two ways to crop the data set. You can either type the desired ranges of x, y, and z coordinates into the crop editor’s window or put the viewer into interaction mode and adjust the crop box using the green handles directly in the viewer window.

- Put the viewer into interaction mode.
- With the left mouse button, pick one of the green handles attached to the crop volume. Drag and transform the volume until the part of the data you are interested in is included.
- Press *OK* in the crop editor’s dialog window.

The new dimensions of the data set are given in the Properties Area. If you want to work with this cropped data record in a later sessions, you should save it by choosing *Save Data As ...* or *Export Data As ...* from the *File* menu.
As you already might have noticed, the crop editor also allows you to rescale the bounding box of the data set. By changing the bounding box alone, no voxels will be cropped. You may also use the crop editor to enlarge the data set, e.g., by entering negative values for the Min index fields. In this case, the first slice of the data set will be duplicated as many times as necessary. Also, the bounding box will be updated automatically.

Figure 3.15: Chocolate bar data set visualized in 3D using an isosurface.
3.2.6 Volume Rendering

Volume Rendering is a visualization technique that gives a 3D impression of the whole data set without segmentation. The underlying model is based on the emission and absorption of light that pertains to every voxel of the view volume. The algorithm simulates the casting of light rays through the volume from pre-set sources. It determines how much light reaches each voxel on the ray and is emitted or absorbed by the voxel. Then it computes what can be seen from the current viewing point as implied by the current placement of the volume relative to the viewing plane, simulating the casting of sight rays through the volume from the viewing point.

3.2.6.1 Using Volume Rendering module

- Remove all objects in the Project View other than the chocolate-bar.am data record.
- Select the data icon and read off the range of data values printed in the "Data info" line (min-max: 0...1910).
- Connect a Volume Rendering module to the data.
- Load the chocolate colormap located in AMIRA_ROOT/data/colormaps/volrenChocolate.am.
- Change the colormap of Volume Rendering module: in the Colormap port, click on "Edit" and select "volrenChocolate.am". (if you don’t have loaded the colormap, you can still select it by clicking on "Edit > Options > Load colormap...").

Figure 3.16: The crop editor works on uniform scalar fields. It allows you to crop a data set, to enlarge it by replicating boundary voxels, or to modify its coordinates, i.e., to scale or shift its bounding box.
• Set the range in the *Colormap* port of the *Volume Rendering* to 410..1910.
• Select the *Volume Rendering Settings* and change the lighting to *none*.

By default, emission-absorption volume rendering is shown. The amount of light being emitted and absorbed by a voxel is taken from the color and alpha values of the colormap connected to the *Volume Rendering* module. In our example the colormap is less opaque for smaller values. You may try to set the lower bound of the colormap to 0 or 900 in order to get a better feeling for the influence of the *transfer function*.

![Volume Rendering Model](image)

*Figure 3.17:* The *Volume Rendering* module can be used to generate volume renderings based on an emission-absorption model.

• Make sure *Volume Rendering Settings* is selected.
• Set *lighting* to *Specular*.
3.2.6.2 Using Volren module

The module Volren is the latest addition to volume rendering in Amira and takes full advantage of the capabilities of modern graphics boards.

The Volren module provides several visualization techniques: shaded and classical texture-based volume rendering (VRT), maximum intensity projection (MIP), and digitally reconstructed radiograph (DRR). The standard VRT and its shaded version enable a direct 3D visualization with flexible color and transparency colormaps with virtual lighting effects for better rendering of complex spatial structures and enhancing fine detail. The MIP rendering allows the visualization of the highest or lowest intensity in a data volume along the current line of sight. The DRR simulates a radiograph display from arbitrary views using the loaded volume data. Furthermore, the Volren module enables you to render segmented regions at the same time with different colormaps. A LabelField can be attached to the Volren and each material of the label list can be rendered separately. In order to optimize the
Figure 3.19: The Volren module can be used to generate maximum intensity projections as well as volume renderings based on an emission-absorption model.

performance, the image volumes are represented at lower resolution when the rendering is done interactively. For relatively large image volumes, you can also switch to a constant “Low Resolution” mode (see below). Volren is built for use with popular graphics accelerator technology such as the NVIDIA Quadro FX graphics boards.

- Remove all objects in the Project View other than the chocolate-bar.am data record.
- Connect a Volren module to the data.
- Select the data icon and read off the range of data values printed on the first info line (410...1910).
- Select the Volren module and enter the range in the Colormap port.
Notes and Limitations

- On Mac OS X, the current Volren Display does not support the Antialiasing viewer mode. Therefore, and until this support is implemented, the Volren display is disabled while Antialiasing is activated. It is recommended to deactivate Antialiasing while using Volren. However, deactivating and reactivating the Antialiasing mode enable the Volren display but some rendering issues may occur.
- On some systems, a significant slowdown can occur if the data set is larger than the available texture memory (which is typically 4 - 16 MB). In this case, select the option LowRes only (see below).
- When two or more Volren modules are used to render intersecting volumes (multivolume rendering), some rendering inaccuracies may occur. In case of multivolume rendering, the supported combinations of modes are one MIP together with one MIP or one VRT with one VRT (see below Mode). Other modes and combinations may lead to incorrect visual results.
- The Apply button is enabled only when the rendering must be recomputed.

3.2.6.3 Comparisons between Volren, Voltex and Volume Rendering modules

The Volume Rendering module has been developed to take advantage of modern graphics hardware. Rendering may fail on old generation graphics hardware. In some cases this can be solved by updating the graphics driver. Otherwise the Volren or the Voltex module can be tried alternatively. Comparisons between the three modules are given into Figure 3.20.
<table>
<thead>
<tr>
<th>Features</th>
<th>Voltex module (deprecated)</th>
<th>Volren module</th>
<th>Volume Rendering module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mouse Picking</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Isosurface Rendering</td>
<td>No</td>
<td>No</td>
<td>Yes (separate module)</td>
</tr>
<tr>
<td>Voxelized Rendering</td>
<td>No</td>
<td>No</td>
<td>Yes (separate module)</td>
</tr>
<tr>
<td>DDR Rendering</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>MIP Rendering</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Lighting and Shade effects</td>
<td>No</td>
<td>Yes Diffuse, Specular</td>
<td>Yes Diffuse, Specular, Enhanced, Edge, Boundary, Ambient, Deferred, High Quality</td>
</tr>
<tr>
<td>User-defined light coefficients</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Light angle control</td>
<td>No</td>
<td>Yes Port Shading: User-defined</td>
<td>Yes Menu View / Light to create custom light and deactivate headlight</td>
</tr>
<tr>
<td>Cast shadows</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Multi-Channel Field input</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Color Field input (RGBA)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Label field secondary input and per-label colormap</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Label colormap support (cycling, no interpolation)</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Multi-Volume support</td>
<td>Limited</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for data larger than graphics memory</td>
<td>Yes Very limited bricking with uniform resolution</td>
<td>Yes Full resolution when still, Low resolution during interaction</td>
<td>Yes Progressive adaptive resolution, limited by memory threshold</td>
</tr>
<tr>
<td>Support for data larger than the main memory (RAM)</td>
<td>No</td>
<td>No</td>
<td>Yes converting data into LDA format</td>
</tr>
<tr>
<td>LDA format support</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>ROI Box: Region of Interest</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Custom ROI</td>
<td>No</td>
<td>Yes Corner Cut: exclusion corner</td>
<td>Yes ROI Box for Volume Rendering: exclusion box, fence, cross, sub-volume</td>
</tr>
<tr>
<td>Hardware Support</td>
<td>Old graphics boards</td>
<td>Modern graphics boards with updated driver (e.g. NVIDIA Quadro)</td>
<td>Modern graphics boards with updated driver (e.g. NVIDIA Quadro), Requires support for advanced shaders Requires high-level OpenGL features that may be unavailable or buggy on specific graphic cards, consider using Voltex as an alternative</td>
</tr>
</tbody>
</table>

Figure 3.20: Comparisons between Volren, Volume Rendering and Voltex modules
3.3 Introduction to the Multi-planar Viewer

The *Multi-planar Viewer* can be used to visualize one or two data sets at the same time using a Multi Planar Reconstruction (MPR) and a 3D viewer. Additionally, the image volumes can be registered automatically or manually using specific graphical interfaces.

In this tutorial, we will try to illustrate how to:

1. Explore the volume data, including an associated label image
2. Explore two data sets in fusion mode
3. Register two data sets

Before we begin our work we need to define the terms *Primary* and *Overlay* in the context of the *Multi-planar Viewer*:

1. **Primary** - Reference data set, this data set will be considered our principal data set to which a secondary data set could be eventually compared or registered. In the context of PET/CT fusion the CT data set would be used as reference data set as it provides the best anatomical reference.
2. **Overlay** - Secondary data set, which could be compared or registered to the Primary.

### 3.3.1 Exploration of the volume data

To activate the *Multi-planar Viewer* select its icon in the workroom toolbar. On a first glance the *Multi-planar Viewer* looks similar to the *Segmentation Editor*: three slice views, a 3D viewer and a material list. In order to start exploring, load the `lobus.am` data set located in the tutorial directory `data/tutorial/lobus.am`:

- **3D Volume Rendering** Select the *3D Rotate* icon (it should have been selected by default as you start the *Multi-planar Viewer*) in the toolbar. Now rotate the object in the 3D viewer.
- **Volume Rendering Modes** Try to visualize the volume using *VRT* or *MIP* techniques and their optional rendering modes. To do so, switch between the radio buttons in the *3D Settings* panel.
- **3D MPR** Click the icon in the *3D Settings* panel to activate MPR in the 3D viewer. You should see now the volume rendered in 3D and the three MPR slices.
- **Window Level** Select the *Adjust Window/Level* icon, click into one of the 2D viewers, hold the mouse button pressed, and drag the mouse cursor left/right to change the contrast (window width), or up/down to change the brightness (window center). Note how the bars in the graphical user interface (GUI) change according to the pointer movements. Click in the 3D viewer and do the same.
- **Browse Slices** The browsing tool allows using the mouse to navigate through an image stack in the 2D viewer. Select the *Browse Slices* icon, click in a 2D viewer, hold the mouse button pressed, and drag the mouse cursor up/down to scroll forward or backward through the image stack. If you are working with a wheel mouse you can use the wheel to access the *Browse Slices*
functionality. Simply click once the viewer to activate it and roll the mouse wheel to scroll through the image stack.

- **Thick Slice** The thickness of the slice can be set by sliding the *Thickness* slider. When displaying a thick slice, data values are computed as the average, the minimum or the *MIP* of the values of the included slices, according to the selected option.

- **Label field** Load the associated label image (*lobus.label.am*) from the tutorial directory and select the checkbox of the *Label Data* port. Visualize the materials in 3D with constant color, hide or fade them. Note that the port *Label Data* refers to the *Primary* data set; to be activated the loaded label field has to have the same size as the *Primary*.

- **Extend viewers** Double-click one viewer to extend it, double-click to set the configuration back to 4-window layout again.

Note that clicking the right button in the viewers activates the context menu, which provides a quicker way to access tools and settings.
3.3.2 Explore two data sets using fusion mode

The process of image fusion consists of combining relevant information from two or more images into a single image using different color mappings. The Image Fusion became very relevant especially in medical science, where different imaging modalities can be obtained from the same patient. Typically, the multi-modal imaging includes magnetic resonance (MR), computed tomography (CT), and positron emission tomography (PET/SPECT). Image fusion can be very useful in microscopy imaging for alignment and registration of multi-channel, 3D, and 4D data sets.

When only one data set is available in the Project View, the Overlay Data port is not available. Load the lobus2.am data set (data/tutorial/lobus2.am) from the tutorial directory and the checkbox of the port will become active. Select the Overlay checkbox and lobus2.am will be shown in the available viewers. Change the minimum and maximum values of the Overlay colormap. To do so, select the 3D viewer to activate it, slide the colormap bar to the left and the right or change the upper and lower limits. You can do the same for the 2D viewers as well.

Select again the Adjust Window/Level icon, keep the mouse button pressed and move the pointer: the window level changes only for the Primary data set. When Primary and Overlay images are loaded together, the Primary is the main object in the Multi-planar Viewer. The activated tools refer always to the Primary or to Primary and Overlay together, never to the Overlay individually.

You should be familiar now with the 2D and 3D visualization options. Therefore, experiment with changing the colormaps or the blend of Primary and Overlay data sets.

To better explore internal structures of the two volumes you can use the 3D cropping and clipping tools offered by the Multi-planar Viewer.

- Set the 3D visualization mode to VRT with specular light effect.
- Click the Crop Corner icon. Browse the slides in 2D and rotate the volume in 3D to better see the cutting region.

The Crop Corner tool is very similar to the Corner Cut module available in the Project View. You can set the cutting boundaries directly by moving them in the 2D viewers. Experiment with the other cutting tools.

3.3.3 Manually register two data sets

You might have noticed that as soon as lobus2.am was loaded, the icon Registration Tool was activated. The registration tools work only when two data sets are loaded in the Multi-planar Viewer. Click now the Registration Tool icon and you will see an arrow-cross in the center of the 2D viewers of the Overlay (we assume that the Overlay is to be registered to the Primary). Move the pointer along the cross: the shape of the pointer changes: Arrow-cross - translate Turning arrow - rotate Arrowhead - scale the image volume

You can also digitally transform the volume by using the Transform editor options button in the Registration toolbox at the bottom of the user interface. This editor corresponds to the user interface of the
Figure 3.22: The Multi-planar Viewer with the Manual Registration tool activated.
"Absolute" tab of the Transform Editor dialog. More information is available in its help file.

- Activate the Registration tool by clicking its icon.
- Try to manually align lobus2.am to lobus.am.
- Use the Transform Editor options in the Registration toolbox to digitally refine the registration.

Once the two volumes are roughly aligned, use the Auto registration options in the Registration toolbox to refine the results. You can get more information about automatic registration by reading the Registration, Alignment and Data Fusion tutorials.

### 3.4 Intensity Range Partitioning

This tutorial requires an Amira XImagePAQ Extension license.

The intensity values encoded in grayscale images usually represent some key attribute about the objects. For example, in X-ray CT images the intensity values are linked to mass density. Amira’s Intensity Range Partitioning tools allow you to assign some meaning to the different ranges of intensities in images.

For example, in a CT scan of a rock sample, different intensity ranges may represent:

- surrounding air, pores (void space),
- water,
- clay,
- mineral.

Whereas, in CT scans of industrial parts, intensities may differentiate materials such as:

- surrounding air, pores (void space),
- cast aluminum components,
- cast steel components,
- inclusions.

Amira’s Intensity Range Partitioning tools let you define ranges so that visualization and computation modules can take advantage of this pre-defined identification. Intensity Range Partitioning is used at several locations in Amira. For example, it allows adjusting the range depicted by a port to a particular range (which most of the time represents a material). It also greatly simplifies visualization setup. It is possible because the Intensity Range Partitioning contains an ”exterior” property which can be set to any range. Then, it’s easy to define the ”usable” range to be everything not in the ”exterior” ranges.

In this tutorial, you will learn how to define and use Intensity Range Partitioning and how it affects visualisation using, as an example, the Volume Rendering representation of a CT scan of an chocolate bar part already used in previous tutorials.
• Let’s start from scratch and create a new Project (choose New Project in the File menu).
• Select the entry Preferences in the Amira Edit menu, and make sure that Intensity Range Partitioning options are set according to the defaults shown on Figure 3.23: automatic guess of two material densities in the loaded image data (i.e., void and solid ranges/regions in the intensities scale).

![Figure 3.23: Amira Preferences panel](image)

• Load the file `chocolate-bar.am` located in subdirectory `data/tutorials` of Amira installation directory.
• Attach a Volume Rendering to the data: right-click on the green data icon appeared in the Project View, click on Volume Rendering and press on Create, see Figure 3.24

![Figure 3.24: Volume Rendering network](image)

![Figure 3.25: Viewing the chocolate bar with default Intensity Range Partitioning](image)

As outlined in section 3.2 (Visualizing 3D images), the Volume Rendering module displays the intensities of input data voxels with color and opacity depending on the colormap port. With colormaps like the default (`volrenWhite.am`), the voxels with intensity values below the lower bounds (less than the minimum) of the colormap port are fully transparent, see Figure 3.25. Changing this minimum is an easy way to filter out parts of the 3D volume image that are void or low density materials. Here the colormap bounds have been set according to Intensity Range Partitioning presets on data as explained below.
• Select the Volume Rendering module in the Project View and view its colormap port in the Properties panel (see Figure 3.26).

• Change the minimum boundary in the colormap port: the Volume Rendering is adjusted accordingly. **Tip:** Use the virtual slider to change value continuously: hold down the Shift key while you click and drag the mouse in the numerical text field.

![Volume Rendering Properties panel](image)

**Figure 3.26:** Volume Rendering Properties panel

Intensity Range Partitioning intends to provide presets matching to some intensity ranges. This ranges can be easily selected to display a given data set. Amira can automatically guess thresholds separating different densities of phases or materials by analysing the intensity distribution histogram of the input data. In the example above, Amira identified an optimal threshold separating void and solid.

• Select the data object chocolate-bar.am in the Project View and look at the data info in the Properties panel (see Figure 3.27).

![Intensity Range Partitioning in data info](image)

**Figure 3.27:** Intensity Range Partitioning in data info

You can see: the actual min-max of data intensities, the data window defining intensity boundaries for exterior to be hidden and used by the colormap port of the Volume Rendering, and the number of ranges that have been defined for this data.

• Invoke the **Intensity Range Partitioning editor** by clicking its toggle button (with an histogram ruler symbol) beside data title in the Properties panel as shown below. You can see the defined ranges for the data set (see Figure 3.28).

• Press the **Show range distribution button** to display the data histogram, separated here in two regions/ranges as shown in Figure 3.29.

![Histogram](image)

As you can see, separations between phases/materials are found at local minima of the histogram. **Tip:** Other tools are available for automatic threshold determination. See **Auto Thresholding** module.
Note: Intensity Range Partitioning is helpful for making visualizations more easily. For ideal quality images with respect to the features of interest, that can be enough for quantitative analysis. For accurate identification of different phases/materials, in particular with noise, inhomogeneous background or artifacts, *image filtering and segmentation* tools may be needed. See the next chapters for more about image segmentation.

The chocolate bar used in this example is actually made of at least two materials of significantly different density and X-ray absorption: chocolate and toffee inserts.

Modify the Intensity Range Partitioning as follows:

- Set the Number of ranges to 3, and press Detect. You can see a new slider port and an updated histogram with a new region/range as shown on Figure 3.30.
- Change names in Ranges port: Exterior Toffee Chocolate
- Set Toffee as an *Exterior range*: it will be excluded from the *data window* defined above and used as default bounds by display modules. The first range named *Exterior* was set by default as an exterior range.
- Press the *Apply* button at the bottom of the Properties panel. *data info* and editor should be updated as shown in Figure 3.31.
- Now you can close the editor by clicking again on the Intensity Range Partitioning editor toggle button.
- Remove the *Volume Rendering* module from the current project: select the *Volume Rendering Settings* module; press the delete key or drag the icon to the trash can in the Project View.
- Attach a *Volume Rendering* module to the data once again: the toffee part is hidden now, leaving

![Figure 3.28: Intensity Range Partitioning editor](image)

![Figure 3.29: Intensity Range Partitioning Histogram](image)
only higher density steel visible, as shown in Figure 3.32.

- In the colormap port of the Volume Rendering module, you can press the Edit button or right-click in a color shaded area to choose a specific range in menu: entire data min-max, data window excluding exterior ranges, or specific range defined (see Figure 3.33). For instance, choosing Toffee will get the entire block back.

![Figure 3.30: Histogram with 3 intensity ranges](image1)

![Figure 3.31: Modifying Intensity Range Partitioning](image2)

More hints:

- In the Preferences, you can disable Intensity Range Partitioning, if you wish, to get the behavior of the previous Amira’s version and use the default range for data min-max (or Data Window if defined as data parameter).
- You can use the Preferences to set a number of phases/materials to be detected in your data. Keep in mind that detection relies on the shape of the image histogram. Amira can automatically guess
the number of ranges that may be detected, but you may prefer to override this if Amira fails to find the expected ranges.

- All modules using colormaps or range slider ports such as Isosurface can take advantage of Intensity Range Partitioning.
- **Tip:** The data window and ranges are defined as persistent data parameters when you save your data to an Amira format (see Section 10.2.7 Data parameters).

### 3.5 Segmentation of 3D Images

By following this step-by-step tutorial, you will learn how to interactively create a segmentation of a 3D image. A segmentation assigns a label to each pixel of the image, which describes the region or material associated with the pixel (e.g., bone or kidney). The segmentation is stored in a separate data object called a *Label Field*. A segmentation is the prerequisite for surface model generation and accurate quantification such as volume measurement.

The *Segmentation Editor* is a workroom that provides a dedicated user interface for interactive segmentation tasks. While segmenting your data, you can switch between segmentation and other workrooms at any time by clicking the appropriate tab in the *Workroom Toolbar*.

The segmentation process can be automatic, semi-automatic, or interactive depending on the input...
images and desired results.

This tutorial introduces each approach and comprises of the following steps:

1. Creation of an empty \textit{Label Field}.
2. Interactive editing of the labels in the \textit{Image Segmentation Editor}.
3. Measuring the volume of the segmented structures.
4. An alternative segmentation method called Threshold segmentation.
5. Further hints on segmentation.

### 3.5.1 Interactive Image Segmentation

1. Load the file \textit{lobus.am} from the directory \textit{data/tutorials}.
2. Right-click the green icon and select \textbf{Edit New Label Field} from the \textit{Image Segmentation} section.

This will automatically launch the Segmentation workroom thereby replacing the Project View and Properties panels on the left and the 3D viewer on the right. At the same time and not currently visible, a new data object will be added to the Project View that will hold the segmentation results. This is the data object to be saved. By default, the \textit{Segmentation Editor} operates in single-viewer mode.

In this mode, one (XY) slice of the image is shown. You can change the orientation of the slice by either selecting another orientation from the \textit{Segmentation/Orientation} menu or by clicking \textbf{Single-viewer} in the viewer toolbar multiple times to cycle through the different 2D views (XY, XZ, and YZ) and a 3D view. Alternatively, two- or four-viewer layouts are possible. In two-viewer layouts (horizontally stacked or side-by-side) a slice viewer is combined with a 3D viewer while in four-viewer layout the three-slice viewer with XY, XZ, and YZ orientations are shown together with one 3D viewer. The tools of the \textit{Segmentation Editor} are displayed in the panel where the Project View and Properties Area are normally displayed.

1. Switch to the four-viewer layout by clicking \textbf{Four viewers} in the viewer toolbar.
2. In the XY view, use the slider on the bottom to scroll through the slices. Go to slice 20 and you will see two large structures and one smaller structure on the top.
3. If necessary, click - associated with the \textit{Zoom Tool} in the upper-right corner of the viewer to get a view of the entire slice.
4. Click the brush icon in the the \textit{Tools} area of the \textit{Segmentation Editor}'s main panel.
5. Mark the rightmost structure with the mouse. You can adjust the brush size with the size slider if desired. Hold down \textbf{CTRL} to deselect incorrect pixels, if necessary.
6. When finished, select \textbf{Inside} in the \textit{Materials} list. Then click + in the \textit{Selection} group.

The pixels selected previously are now assigned to material \textit{Inside}. Right-click \textit{Inside} in the \textit{Materials} list to select a different draw style (e.g., dotted).

\textit{Segmentation of 3D Images}
1. Click the Materials list and select New Material from the right-button menu.
2. Mark the structure in the middle using the brush, select the new material in the Materials list, and assign the pixels to that structure (see Figure 3.34).
3. Go to slice 21 and practice by segmenting the same two structures.

**Tip:** If you prefer to work with one large view rather than four small views, click Single Viewer in the viewer toolbar. To cycle through each of the four views, click Single Viewer repeatedly. To return to four-viewer mode, click Four Viewers.

If the changes from slice-to-slice are small, use interpolation.

1. Go to slice 22 and mark the right-hand structure using the brush. Go to slice 31 and mark the same structure.
2. Select from the menu bar: Selection/Interpolate.
3. Scroll through the dataset. You will see that the slices 23 to 30 are now also selected.
4. To assign the selected pixels of all slices to the material Inside, select it in the Materials list, then click + in the Selection group.
5. Repeat the procedure between slice 32 and 50.
6. Repeat the procedure for the middle structure.

**Tips:**

- While segmenting, it is recommended that you frequently save the segmentation results. To do so, switch to the Project View by clicking Project in the Workroom Toolbar. Then select the icon of label image and select Save Data or Save Data As... from the Amira File menu. Click Segmentation in the Workroom Toolbar to return to the Segmentation Editor workroom.
- The Brush Tool is probably the most basic segmentation tool. It can be noted that the editor provides additional tools and functions that are described on the Segmentation Editor help pages.
• There are useful keyboard short cuts, including + (-) to add (remove) a selection to (from) a material, SPACE and BACKSPACE to change the slice number, and d to change the material draw style.

• You might want to give materials more meaningful names or different colors. To do so, double-click the material name and enter a new name, or double-click the color button left of the name and select a different color in the Color Dialog.

3.5.2 Volume and Statistics Measurement

Once a structure is segmented, you can easily measure its volume:

1. In the main menu, select Segmentation / Material Statistics ....

A table appears in a dialog box listing the volume of each material.

The same statistics are available in the Tables panel of the Project workroom.

1. Activate the Project View by clicking Project on the workroom toolbar.
2. Right-click the icon of the label image and select Measure and Analyze/Material Statistics ....
3. Click Apply under Material Statistics to create a new object lobus.MaterialStatistics in the Project View.
4. Select this object and click Show.

A new panel in the application window shows a similar table. The *.MaterialStatistics object can be saved to text (*.txt), to comma separated values file (*.csv), or to Micrsosoft XML Spreadsheet (*.xml).

Note: If Units Management (see Edit/Preferences/Units) is turned off, the physical units of the values in the volume column are implicit and the voxel size scales objects only within this implicit physical unit. No physical units are shown in the column headers. In the case of lobus.am, the voxel size is in µm. Thus, the numbers given in the Volume column have to be read as µm³. If Units Management is turned on, the physical units specified as Display units are shown in the column header.

Beside the basic measurements available in the Material Statistics ... menu, the Amira XImagePAQ Extension includes a much more comprehensive set of measurement for segmented features. See tutorials from the chapter 6.1 Getting Started with Advanced Image Processing and Quantitative Analysis and Cell Analysis.

3.5.3 Threshold Segmentation

This section describes an alternative way of segmentation that may require less manual interaction, but typically requires the higher quality images. Besides optimizing the image acquisition process, this can be achieved also by filtering the image before performing the segmentation. Under favorable
The first step is to separate the object from the background. This is done by classifying the voxels into foreground and background voxels on the basis of their intensities or voxel values.

1. Clear the Project View area by selecting Project/Remove All Objects from the main menu.
2. Load the lopus.am data record from the directory data/tutorials.
3. Attach a Image Segmentation / Multi-Thresholding module to the data icon and select it.
4. Type 85 into the text field of port Exterior-Inside. You may also determine some other threshold that separates exterior and interior as described in the tutorial on Image Data Visualization.
5. Click Apply.

With this procedure, each voxel value lower than the threshold is assigned to Exterior and each voxel value greater than or equal to the threshold is assigned to Inside. However, this may cause voxels to be labeled that are not part of the object but have voxel values above the threshold. Set the remove couch option to suppress it, which assures that only the largest coherent area will be labeled as the foreground (Inside) and all other voxels are assigned to the background (Exterior).

Clicking Apply creates a new data object lopus.labels. This data object is a Label Field, has the same dimensions as lopus.am, and contains an Inside or Exterior label for each voxel according to the segmentation result.

3.5.4 Refining Threshold Segmentation Results

You can visualize and interactively edit Label Field by using Amira’s Segmentation Editor. Use the Segmentation Editor to smooth the data to remove noise on the surface of the object.

1. Select the lopus.Labels icon and click Segmentation Editor in the Properties Area.

This automatically activates the Segmentation Editor workroom.

1. In the XY view, use the slider on the bottom to select slice 39 (see Figure 3.35).
2. Select a suitable magnification by clicking the + or - buttons of the Zoom Tool (last tool in the Tools area).

The image segmentation editor shows the image data to be segmented (lopus.am) as well as greyish contours representing the borders between Inside and Exterior regions as contained in the lopus.Labels data object. As you can see, the borders are not smooth and there are small islands bordered by cyan contours. This is what we want to improve now.

1. Select Remove Islands... from the Segmentation menu. In response, a dialog box will appear.
2. In the dialog box, select the all slices mode. Then click Highlight all islands to highlight all islands smaller or equal to 15 voxels.
3. Click Apply to merge all islands with the material they are embedded in.
4. To further clean up the image, select Smooth Labels... from the Segmentation menu. Another dialog box will appear.
5. Select the 3D volume mode and click Apply to execute the smoothing operation.
6. To examine the results of the filter operations, browse through the label image slice-by-slice. In addition to the slice slider, you may also use the cursor-up and cursor-down keys for this.
7. Return to the Project View using the workroom toolbar.

### 3.5.5 More Hints about Segmentation

Amira includes different tools that can create a label image.

1. **Image Segmentation / Multi-Thresholding.** This module automatically creates a label image by thresholding. See also Selection/Threshold menu in Segmentation Editor.
2. **Image Segmentation / Edit New Label Field.** The Segmentation Editor provides automatic, semi-automatic, and interactive tools.
3. **Compute / Connected Components.** This module searches for connected regions.
4. **Image Segmentation / Correlation Histogram.** This module can create a label image from correlated regions in two images sets, typically after registration.
5. **Image Segmentation / Interactive Thresholding** and other tools from Amira. This extension offers advanced tools for quantification, including object separation and labelling. See Advanced Image Processing, Segmentation, and Analysis tutorials.

Prior to segmentation, think about improving image quality and reducing noise in the dataset with:
• **Volume Edit** module

• **Visualizing and Processing 2D and 3D Images** tutorials, which provide further filters and tools.

Here are some hints about the **Segmentation Editor**.

• Combine different tools. Remember to toggle 2D / 3D as appropriate.
• Adjust the **Display Control** settings.
• Use Segmentation filters **Smooth labels / Fill holes / Remove islands**.
• Use **Selection/Invert (‘I’ key)** and combine selections into materials (replace/add/subtract).
• Use interpolate between slices (menu **Selection/Interpolate**).
• Use of four viewers can make the segmentation process easier.
• You can remove erroneous parts from the selection view in all viewers, including the 3D viewer.
• Remember to lock materials to prevent erroneous transfer of previously selected materials.
• Locked material can be used as a mask. This is useful for 3D operations to prevent selection in areas you do not want to add to your material. This process can also be used, so that the magic wand tool only works between specified slices.
• If you want to select a number of materials, hold down **SHIFT** and select the material you want from the **Material** list. If you have the **Show in 3D** check box selected, then you will also get a 3D selection.
• If you want to copy the same selection to a neighboring slice, hold **SHIFT** and press the up / down arrow.
• The state of the current selection is displayed using a label in the **Selection** area. This label can display three different messages: **No selection, Active selection**, and **Hidden selection**. The last two states indicate whether an in-plane selection is shown in one of the 2D viewers, or located in a different slice.
• The **Masking** feature allows the user to control the masking by setting its range, and its visibility in 2D/3D viewers, and to enable/disable it in some tools. This **Masking** feature is optional for the **Brush** and **Lasso** tools, and is used in the workflows for the **Magic Wand**, **Threshold**, and **TopHat** tools.
• The **TopHat** tool can be very useful in combination to threshold to segment low contrast or thin features over a non-uniform background.
• The **Segmentation Editor** has other useful **keyboard shortcuts**.

An advanced Segmentation using the **Watershed** tool can be found in the **Watershed Segmentation** tutorial.
3.6 Deconvolution for light microscopy

The deconvolution modules of the Amira provide powerful algorithms for improving the quality of microscopic images recorded by 3D widefield and confocal microscopes. Two different methods are supported, namely a so-called non-blind and a blind deconvolution method, both based on iterative maximum-likelihood image restoration. In the first case, a measured or computed point spread function (PSF) is required. In the second case, the PSF is estimated along with the data itself.

The deconvolution documentation is organized as follows:

- General remarks about image deconvolution
- Data acquisition and sampling rates
- Standard deconvolution tutorial
- Blind deconvolution tutorial
- Bead extraction tutorial
- Performance issues and multi-processing

The following modules are provided:

- Extract Point Spread Function - obtain a PSF from a bead measurement
- Convolution - convolve two 3D images
- Correct Z Drop - corrects attenuation in z-direction
- Correct Background and Flat-Field - background and flatfield correction
- Deconvolution - the actual deconvolution front-end
- Fourier Transform - computes FFT and power spectrum
- Generate Point Spread Function - calculates a theoretical PSF

Examples:

- Confocal data set
- Widefield data set

3.6.1 General remarks about image deconvolution

Deconvolution is a technique for removing out-of-focus light in a series of images recorded via optical sectioning microscopy. Intended to investigate 3D biological objects, optical sectioning microscopy works by creating multiple images (optical sections) of a fluorescing object, each with a different focus plane. However, besides the in-focus structures, the images usually also contain out-of-focus light from other parts of the object, causing haze and severe axial blur. This is even the case for a confocal laser scanning microscope, where most of the out-of-focus light is removed from the image by a pinhole system. Mathematically, the image produced by any microscopic system can be described
as the convolution of the ideal unblurred image of the specimen and the microscope's so-called point spread function (PSF), i.e., the image of an ideal point light source. With the inverse of this process, called deconvolution, a deblurred image of the specimen can be obtained, provided the point spread function is known, or at least can be estimated.

The Amira deconvolution modules mainly provide two variants of a powerful iterative maximum-likelihood image restoration algorithm, namely a non-blind one and a blind one. The difference between them is that in the first case a measured or computed point spread function is used, while in the second case, the PSF is estimated along with the data itself. Maximum-likelihood image restoration can be considered as the de-facto standard for deconvolution of 3D optical sections. Although computationally quite expensive, the method is able to significantly enhance image quality. At the same time, it is very robust and insensitive with respect to noise artifacts. However, it should be noted that, although rejecting most of the out-of-focus light, by no means all of it is rejected. Therefore, some noticeable haze remains in the images. Also, the images retain a substantial axial smearing in the z-direction, which cannot be removed by any deconvolution algorithm.

At first sight, one may wonder why both a non-blind and a blind deconvolution algorithm are provided; blind deconvolution seems to be more general because the PSF is calculated automatically. One answer is that blind deconvolution is computationally even more expensive than non-blind iterative maximum-likelihood image restoration. The other answer is that in a blind deconvolution algorithm, a meaningful estimate of the PSF can only be computed if severe constraints are imposed. For example, a trivial solution of the blind deconvolution problem would be an image that is identical to the input image and a PSF with the shape of an ideal delta peak. Obviously, this solution isn’t useful at all. Therefore, if for example confocal data is to be deconvolved, the algorithm fits the actual PSF in such a way that it looks like a possible measured PSF of a confocal microscope. More precisely, the fit is constrained to be in agreement with the experimental parameters (the refractive index of the medium, the numerical aperture of the objective, and the voxel sizes). Sometimes this can lead to wrong results, for example when the confocal pinhole aperture of the microscope wasn’t stopped down sufficiently during confocal image acquisition, in which case the microscope actually didn’t behave like a true confocal microscope. As a matter of fact, you should try the approach that provides the best results for your own image data, blind deconvolution or non-blind deconvolution with either a measured or an automatically computed PSF.

### 3.6.2 Data acquisition and sampling rates

In order to obtain best quality when deconvolving microscopic images, some fundamental guidelines should be obeyed during image acquisition. Good results may be obtained even if some of these guidelines are not followed exactly, but in general the chances to get satisfactory results improve if they are. Below we discuss the most important recommendations.

**Adjusting the Scanned Image Volume**

The region of interest should be centered in the middle of the image volume, as the optics of the microscope usually has the least aberrations in this region and it helps to avoid possible boundary
artifacts, which can arise during the deconvolution procedure. Especially for widefield data, it is important to record a sufficiently large (preferably empty) region below and above the actual sample. Ideally, this region should be as large as the sample itself. For example, if the sample covers 100 micrometers in the z-direction, the scanned image volume should range from 50 micrometers below the sample to 50 micrometers above it.

Choosing the Right Sampling Rate

The sampling rate is determined by the pixel sizes in the x and y directions as well as the distance between two subsequent optical sections, both measured in micrometers. Generally speaking, image deconvolution works best if the data is apparently oversampled, i.e., if the pixel or optical section spacing is smaller than required. The maximal required sampling distance (Nyquist sampling, described in R. Heintzmann. Band-limit and appropriate sampling in microscopy, chapter 3, Vol. III, in: Cell Biology: A Laboratory Handbook, Julio E. Celis (ed.), Elsevier Academic Press, 29-36, 2006) to avoid ambiguities in the data can be obtained from considerations in Fourier-space yielding

\[ d_{xy} = \frac{\lambda}{4NA}, \]

where \( \lambda \) denotes the wavelength and \( NA \) is the numerical aperture of the microscope. Similar considerations yield for the maximal distance between adjacent image planes:

\[ d_z = \frac{\lambda}{2n(1 - \cos(\alpha))}, \]

where \( n \) denotes the refractive index of the object medium and \( \alpha \) the aperture half angle as determined by \( NA = n \sin(\alpha) \).

For a confocal microscope, both the in-plane sampling distance and the axial sampling distance need to be, in theory, approximately 2 times smaller. However, this requirement is far too strict for most practical cases and even in the widefield case, approximately fulfilling the above requirements is often sufficient.

The total number of optical sections is obtained by dividing the height of the image volume by the sampling distance \( d_z \). It should be mentioned that deconvolution also works if the sampling distances are not matched rigorously, but matching them improves the chances to get good results. In general, oversampling the object is less harmful than undersampling it, with one exception: In the case of confocal data, the sampling distance \( d_{xy} \) should not be much smaller than indicated, if the blind deconvolution algorithm or the non-blind deconvolution algorithm together with a theoretically computed confocal PSF are used. Otherwise, the unconstrained Maximum Likelihood algorithm and the predominant noise in the data might lead to unsatisfactory results.

Black Level and Saturation

Before grabbing images from the microscope’s camera, the light level should be adjusted in such a way that saturated pixels, either black or white ones, are avoided. Saturated pixels are pixels that are
clamped to either black or white because their actual intensity values are outside the range of representable intensities. In any case, saturation means a loss of information and thus prevents proper post-processing or deconvolution. At the same time, a high background level should be avoided because it decreases the dynamic range of the imaging system and the deconvolution works worse. This means that empty regions not showing any fluorescence should appear almost black. A background level close to zero is especially important when bead measurements are performed in order to extract an experimental point spread function. Details are discussed in a separate tutorial about bead extraction.

### 3.6.3 Standard Deconvolution Tutorial

This tutorial explains how 3D image data sets can be deconvolved in Amira. It is assumed that the reader is already familiar with the basic concepts of Amira itself. If this is not the case, it is strongly recommended to work through the standard Amira tutorials first. In this section, the following topics are covered:

1. Prerequisites for deconvolution
2. Resampling a measured PSF
3. Deconvolving an image data set
4. Calculating a theoretical PSF

As an example we are going to use a confocal test data set (*polytrichum.am*) provided with the Amira deconvolution modules. The data file is located in the directory `AMIRA_ROOT/data/deconv`.

- Load the data set *polytrichum.am*.
- Visualize it, for example, using a *Image Ortho Projections* module.

The data set shows four chloroplasts in a spore of the moss polytrichum commune.

#### Prerequisites for Deconvolution

Besides the image data itself, for the standard non-blind deconvolution algorithm a so-called *point spread function* (PSF) is also required. The PSF is the image of a single point source, or as a close approximation, the image of a single fluorescing sub-resolution sphere. PSF images can either be computed from theory (see below) or they can be obtained from measurements. In the latter case, tiny so-called *beads* are recorded under the same conditions as the actual object. This means that the same objective lens, the same dye and wavelength, and the same immersion medium are used. Typically, the images of multiple beads are averaged to obtain an estimate of a single PSF. Amira provides a module called *Extract Point Spread Function* facilitating this process. The use of this module is discussed in a separate tutorial about bead extraction. At this point, let us simply load a measured PSF from a file.

- Load the data set *polytrichum-psf.am*.
- Use the *Image Ortho Projections* module to visualize it.
The PSF appears as a bright spot located in the middle of the image volume (Figure 3.36). It is important that the PSF is exactly centered. Otherwise, the deconvolved data set will be shifted with respect to the original image. Also, it is important that the PSF fades out to black at the boundaries. If this is not the case, the black level of the PSF image needs to be adjusted using the Arithmetic module. Finally, neither the PSF nor the image to be deconvolved should exhibit intensity attenuation artifacts, i.e., image slices with decreased average intensity due to excessive light absorption in other slices. If such artifacts are present, they can be removed using the Correct Z Drop module.

![Figure 3.36: Maximum intensity projection of polytrichum-psf.am](image)

**Figure 3.36: Maximum intensity projection of polytrichum-psf.am**

**Resampling a Measured PSF**

Next, select both the PSF and the image data. You’ll notice that the voxel sizes of both objects are not the same. It is recommended to adjust different voxel sizes of PSF and image data prior to deconvolution using the Resample module. The deconvolution module itself also accounts for different voxel sizes, but it does so by using point sampling with trilinear interpolation. This is OK as long as the voxel size of the PSF is larger than that of the image data. However, in our case the voxel size of the PSF is smaller than that of the image data, i.e., the resolution of the PSF higher. Using the Resample module provides slightly more accurate results here, since all samples will be filtered correctly using a Lanczos kernel.

- Connect a Resample module to polytrichum-psf.am.
- Connect the Reference port of the Resample module to the image data set polytrichum.am
• In the Mode port of the Resample module, choose voxel size (see Figure 3.37).
• Resample the PSF by pressing the Apply button.

The voxel size option means that the PSF will be resampled on a grid with exactly the same voxel size as the image data set, which is connected to the Reference port. While the original PSF had a resolution of 12 x 12 x 30 voxels, the resampled one only has 12 x 12 x 16 voxels. However, the extent of a single voxel in z-direction is bigger now.

![Image](image.png)

Figure 3.37: Maximum intensity projection of polytrichum-psf.am

Deconvolving an Image Data Set

After a suitable PSF has been obtained, we are ready for deconvolving the image data set. This can be done by attaching a Deconvolution module to the image data.

• Connect a Deconvolution module to polytrichum.am.
• Connect the PSF Kernel port of the Deconvolution module to the resampled PSF polytrichum-psf.Resampled. The PSF Kernel port is in the Microscope section of the module’s properties.

Once the deconvolution module is connected to its two input objects, some additional parameters need to be adjusted (for a detailed discussion of these parameters see also the Deconvolution reference documentation of the Deconvolution module itself). Figure 3.38 shows the project view. The settings for the deconvolution module are:
**Border width:** For deconvolution the image data has to be enlarged by a guardband region. Otherwise, boundary artifacts can occur, i.e., information from one side of the data can be passed to the other. There is no need to make the border bigger than the size of the PSF. However, if the data set is dark at the boundaries, a smaller border width is sufficient. In our case, let us choose the border values 0, 0, and 8 in the x, y, and z direction.

**Iterations:** The number of iterations of the deconvolution algorithm. Let us choose a value of 20 here.

**Initial estimate:** Specifies the initial estimate of the deconvolution algorithm. If constr is chosen, a constant image is used initially. This is the most robust choice, yielding good results even if the input data is very noisy. We keep this option here.

**Overrelaxation:** Overrelaxation is a technique to speed up the convergence of the iterative deconvolution process. In most cases the best compromise between speed and quality is fixed overrelaxation. Therefore, we keep this choice also.

**Method:** Selects between standard (non-blind) and blind deconvolution. Let us specify the standard option here.

![Figure 3.38: Deconvolution module attached to polytrichum.am.](image)

The actual deconvolution process is started by pressing the **Apply** button. Please press this button now. The deconvolution should take about 10 seconds on a modern computer. During the deconvolution, the progress bar informs you about the status of the operation. Also, after every iteration, a message is printed in the Amira console window indicating the amount of change of the data. If the change seems to be small enough, you can terminate the deconvolution procedure by pressing the **Stop** button. However, note that the stop button is evaluated only once between two consecutive iterations.

When deconvolution is finished, a new data set called **polytrichum.deconv** appears in the Project View. You might take a look at the deconvolved data by moving the **Image Ortho Projections** connection line from **polytrichum.am** to **polytrichum.deconv**.

### Calculating a Theoretical PSF

Sometimes bead measurements are difficult to perform, so that an experimental PSF cannot easily be obtained. In such cases, a theoretical PSF can be used instead. Amira provides the module **Generate Point Spread Function**, allowing you to calculate theoretical PSFs. The module can be created by selecting **Images And Fields / Generate Point Spread Function** from the **Project >Create Object...** menu of the Amira main window.

Once the module is created, some parameters have to be entered again. The **resolution** and the **voxel**
size can be most easily specified by connecting the Data port of the PSGGen module to the image data set to be convolved. In our case, please connect this port to polytrichum.am.

In order to generate a PSF, you also need to know the numerical aperture of the microscope objective, the wavelength of the emitted light (to be entered in micrometers!), and the refractive index of the immersion medium. In our test example, these values are NA=1.4, lambda=0.58, and n=1.516 (oil medium). Also, change the microscopic mode from widefield to confocal.

After you press the Apply button, the computed PSF appears as an icon labeled PSF in the Project View. You can compare the theoretical PSF with the measured one using the Ortho Slice module. You'll notice that the measured PSF appears to be slightly wider. This is a common observation in many experiments.

![Generate Point Spread Function](image)

Figure 3.39: The Generate Point Spread Function module calculates theoretical PSFs.

Once you have computed a theoretical PSF, you can perform non-blind deconvolution as described above. However, for convenience the Deconvolution module is also able to compute a theoretical PSF by itself. You can check this by disconnecting the Kernel port of the Deconvolution module. If no input is present at this port, additional input fields are shown, allowing you to enter the same parameters (numerical aperture, wavelength, refractive index, and microscopic mode) as in PSFGen. After these parameters have been entered, the deconvolution process again can be started by pressing the Apply button.

Note that any previous result connected to the Deconvolution module will be overwritten when starting the deconvolution process again. Therefore, be sure to disconnect a previous result if you want to compare deconvolution with different input PSFs.

### 3.6.4 Blind Deconvolution Tutorial

This tutorial explains how blind deconvolution can be performed in Amira. At the same time it describes how deconvolution jobs can be processed using the Amira job queue. Like in the previous tutorial, it is assumed that the reader is already familiar with the basic concepts of Amira itself. If not, we recommend to work through the standard Amira tutorials first.
A Blind Deconvolution Example

Let us start by loading a raw image data set first.

- Load the file `alphalobe.am` from the directory `data/deconv`.
- Visualize the data set by attaching a *Image Ortho Projections* module to it.

The data set has been recorded using a standard fluorescence microscope under so-called *widefield* conditions. It shows a neuron from the alpha-lobe of the honeybee brain. Compared to the confocal data set used in the standard deconvolution tutorial, `alphalobe.am` is much bigger. It has a resolution of 248 x 248 x 256 voxels with a uniform voxel size of 1 micrometer. In the xy-plane of the projection view the structure of the neuron can be clearly identified. However, the contrast of the image is quite poor because there is a significant amount of out-of-focus light or haze present. With Amira’s blind deconvolution algorithm we can enhance the image data without needing to know an explicit PSF in advance.

- Attach a *Deconvolution* module to `alphalobe.am`.

![Figure 3.40: Alphalobe Deconvolution](image)

Adjust the Deconvolution parameters like this:

*Parameters:*

- Border Width: $x = 8 \ y = 8 \ z = 10$
- Iterations: 25
- Initial Estimate: input data
- Method: blind

*Microscope:*

*Deconvolution for light microscopy*
The individual parameters have the following meaning:

**Border width:** The same as for standard non-blind deconvolution, the image data must be enlarged by a guardband region. Otherwise, boundary artifacts can occur, i.e., information from one side of the data can be passed to the other. For this data set we specify a small guardband region of 8 voxels in the x- and y-direction. In the z-direction we add 10 slices as border region. The resulting size of the data array on which the computation is performed is 256 x 256 x 266.

Note that for dimensions with a power of two ($2^8$), the Fast Fourier Transforms, the computationally most expensive part of the deconvolution algorithm, can be executed somewhat faster.

**Iterations:** We choose a value of 25 here. Depending on the data, usually at least 10 iterations are required. With overrelaxation being enabled (see below), results usually don’t improve much after 40 iterations.

**Initial estimate:** Specifies the initial estimate of the deconvolution algorithm. Since there is not much noise present in the original alphalobe images, it is safe to chose input data here. This causes the algorithm to converge even faster.

**Overrelaxation:** Overrelaxation is a technique to speed up the convergence of the iterative deconvolution process. We enable overrelaxation by chosing the fixed toggle.

**Regularization:** We chose none here in order to do no regularization.

**Method:** We chose blind here in order to select the blind deconvolution algorithm.

**PSF Parameters:** For alphalobe.am, the numerical aperture is 0.5, the wavelength is 0.58 micrometers, and the refractive index is 1.0 (air). These parameters are required in order to apply certain constraints to the estimated point spread function. They are also used in order to compute an initial PSF. The convergence is sensitive to the initial parameters. If a data set would be connected to the Kernel port of the deconvolution module, this data set would be used as the initial PSF with the given PSF parameters still acting as constraints. For example, you could provide a measured PSF and let it be fitted to the actual data by the deconvolution algorithm.

**Microscopic mode:** alphalobe.am is a widefield data set, so select this option here.

### Submitting a Deconvolution Job

After all parameters have been entered, the deconvolution process can be started. This computation can take some time. Especially, if you want to deconvolve multiple data sets at once, it is inconvenient to do this in an interactive session. Therefore, multiple deconvolution jobs can be submitted to the Amira job queue and then, for example, processed overnight. This works as follows:

- Press the Setup... button of the Batch Job port. A dialog as shown in Figure 3.41 pops up.
- In the dialog choose a file name under which you want to save the deconvolved data set, e.g., C:/Temp/alphalobe-deconv.am.
• Modify the text field, so that check point files are written after every 5 iterations.

![Deconvolution Batch Job dialog](image)

Figure 3.41: Dialog for submitting a deconvolution job.

Check point files are used to store intermediate results. With the above settings, the deconvolved data is written into a file after every 5 iterations. Check point files are named like the final result, but a consecutive number is inserted just before the file name suffix. For example, if the result file name is `C:/Temp/alphalobe-deconv.am`, the check point files are named `C:/Temp/alphalobe-deconv-0005.am`, `C:/Temp/alphalobe-deconv-0010.am` and so on. Now we are ready to actually submit the batch job.

- Press the **Submit** button of the deconvolution dialog. After a few seconds the Amira batch job dialog appears, compare Figure 3.42.
- Select the deconvolution job and press the **Start** button.

You now have to wait about 20 minutes until the deconvolution job is finished. Once the job queue has been started, you can quit Amira. The batch jobs will be continued automatically. If Amira is still running when the deconvolution job exits, then the result will be loaded automatically in Amira. Otherwise, you have to restart Amira and load the deconvolved data set manually.

### 3.6.5 Bead Extraction Tutorial

Non-blind deconvolution is a powerful and robust method for enhancing the quality of 3D microscopic images. However, the method requires that the image of the point spread function (PSF) responsible for image blurring is provided. As stated in the *standard deconvolution tutorial*, the PSF can either be calculated theoretically or it can be obtained from a bead measurement. Amira provides a special-purpose module called *Extract Point Spread Function* which facilitates the extraction of PSF images from one or multiple bead measurements. In this tutorial, the use of the module shall be explained. The following topics are covered:

1. Bead measurements
2. Projection Settings View and Projection Settings View Cursor
3. Resampling and averaging the beads
Figure 3.42: The Amira job dialog showing a pending deconvolution job.
Bead Measurements

The PSF is the image of a single point source recorded under the same conditions as the actual specimen. It can be approximated by the image of a fluorescing sub-resolution microsphere, a so-called bead. Performing good bead measurements requires some practice and expertise. In order to obtain good results, the following hints should be obeyed:

1. Use appropriate beads. It is important that the bead size be smaller than approximately 1/2 full width at half maximum (FWHM) of the PSF. Good sources for obtaining beads suitable for PSF measurements are Molecular Probes (http://www.probes.com/) or Polysciences (http://www.polysciences.com/).

2. The beads must be solid. Besides solid beads, there are also beads with the shape of a spherical shell, allowing to check the focus plane of a microscope. Such beads cannot be used as a source for PSF generation in the current version of Amira.

3. Don’t record clusters of multiple beads. Sometimes multiple beads may glue together, appearing as a single big bright spot. Computing a PSF from such a spot obviously leads to wrong results.

4. Note that beads are not resistant to a variety of embedding media. In particular, beads will be destroyed in xylene-based embedding media such as Permount (Fisher Scientific) and methyl salicylate (frequently used to clear up the tissue). As a substitute, you might use immersion oil instead, which has a refractive index similar to methyl salicylate, for example.

5. Sample and beads should always be imaged as close to the coverslip as possible. When it is not possible to attach the sample to the coverslip, the beads should also be imaged in a comparable depth, embedded in the same mounting medium. Imaging the beads with better quality than the sample will yield a slightly blurred deconvolution result. However, when the PSF used for deconvolution is too wide, artifacts can arise during deconvolution.

The objective lens should always be selected according to the mounting medium, i.e., if the sample is attached to the slide and embedded in a buffer of refractive index close to water, a severe loss of image quality can be expected when using an oil-immersion objective without a correction collar. Deconvolution of properly imaged data will always be superior to deconvolution of data suffering from aberrations.

6. Problems occur if the mounting medium remains liquid. In that case, the sample distribution may not be permanent. If your specimen is to be embedded in water, you can try to immerse the beads in an agarose gel of moderate concentration instead. Attaching the small beads to the coverslip (for example by letting them dry) is often also sufficient for immobilization.

An example of an image data set containing multiple beads is provided in the file beads.am in the directory AMIRA_ROOT/data/deconv.

- Load the data set beads.am.
- Visualize the data using a Image Ortho Projections module.
Projection View and Projection Settings View Cursor

The bead data set contains five different beads which can be clearly seen in the three orthogonal planes of the Image Ortho Projections module. In order to obtain a single PSF, we first want to select several ”good” beads. These beads are then resampled and averaged, thus yielding the final PSF. A bead can be considered as ”good” if it is clearly visible and if it is not superimposed by other beads (even when defocused),

Selecting ”good” beads is an interactive process. It is most easily accomplished using the Projection Cursor module. This module allows you to select a point in 3D space by clicking on one of the three planes of the Image Ortho Projections module. The third coordinate is automatically set by looking for the voxel with the highest intensity. Points selected with the Cursor module can be stored in a Landmarks data object.

Figure 3.43: Individual beads can be interactively identified using a Projection Cursor module.

- Attach a Projection Cursor module to the Image Ortho Projections module.
- Click on any bead on one of the three planes.
• Store the current cursor position in a Landmarks object by pressing the Add button.
• Select and add some other beads too.

The landmarks do not need to be located exactly at the center of a bead. The exact center positions can be fitted automatically later on.

You can remove incorrect bead positions from the landmark set by invoking the landmark set editor. In order to activate the editor, select the landmark set object and press Landmark Editor button. If you want to add additional bead positions to an existing landmark set object, make sure that the master port of the landmark set object is connected to the Cursor module. Otherwise, a new landmark set object will be created.

Resampling and Averaging the Beads

Now we are ready to extract and average the individual beads. This is done by means of the Extract Point Spread Function module.

• Connect an Extract Point Spread Function module to the Landmarks object.
• Make sure that the Data port of Extract Point Spread Function is connected to the bead data set beads.am. If the landmarks are still connected to the beads via the Projection Cursor and Image Ortho Projections modules, the connection is established automatically.

The Extract Point Spread Function module provides two buttons called Adjust centers and Estimate size, which should be invoked in a preprocessing step before the beads are actually extracted.

The first button (Adjust centers) modifies the landmark positions so that they are precisely located in the center of gravity of the individual beads.

The second button (Estimate size) computes an estimate for the number of voxels of the PSF image to be generated. This button is only active if no PSF image is connected as a result to BeadExtract. If there is a result object, the resolution and voxel sizes of the result are used and the port becomes insensitive.

Any of the actions of the two preprocessing buttons can be undone using the Undo button. This can be necessary for example if two beads are too close so that no correct center position could be computed. In general, overlaps between neighboring beads should be avoided. Small overlaps might be tolerated because during resampling intensities are weighted according to the influence of surrounding beads.

• Perform the preprocessing steps Adjust centers and Estimate size.
• Compute a resampled and averaged PSF by pressing the Apply button.

The data type of the resulting PSF will be float, irrespective of the data type of the input image. The individual beads will be weighted on a per-voxel basis and added to the result. No normalization will be performed afterwards. You may investigate the resulting PSF image using any of the standard visualization modules. In Figure 3.45 a volume rendering of the resulting PSF is shown.
In some cases, you may want to average multiple beads recorded in different input data sets. This can be easily achieved by creating a *Landmarks* object for each input data set. For the first input data set, extract the beads as described above. For the other input data set, also use the *Extract Point Spread Function* module. However, make sure that the PSF obtained from the first input data set is connected as a result object to *BeadExtract* before pressing the *Apply* button. In order to use an existing PSF as a result object, connect the *Master* port of the PSF to *Extract Point Spread Function* (once this is done the *Resolution* and *Voxel size* ports of *Extract Point Spread Function* become insensitive, see above). If an existing result is used, new beads simply will be added into the existing data set. Therefore, data sets should be scaled in intensity according to their quality prior to bead extraction and summation to obtain a suitable weighting of the individual extracted beads in the final result.
3.6.6 Performance issues and multi-processing

Iterative maximum-likelihood deconvolution essentially is the most powerful and most robust technique for the restoration of 3D optical sections. However, it is also computationally very demanding. It can take several minutes (sometime even hours) to process large 3D data sets. This is not due to an improper implementation, but due to the algorithm itself. Both the blind and the non-blind variant of the method rely heavily on fast Fourier-transforms in order to efficiently compute convolutions. If you want to improve performance, try to adjust the size of your data volumes so that the number of voxels plus the border width is a power of two. Sometimes it is worth it to enlarge the border width a little bit in order to get a power of two. Although the algorithm works with data of any size, powers of two can be transformed somewhat faster.

Figure 3.45: The final PSF visualized using a Volume Render module.

Deconvolution for light microscopy 116
Another issue is memory consumption. Internally, several copies of the data set need to be allocated by the deconvolution algorithm. These copies should all fit into memory at the same time (a specific variant of the algorithm suitable for working under low memory conditions will be provided in a later version). Besides the input data itself, the following number of working arrays are required by the different methods:

- 3 working arrays for the non-blind algorithm with no or with fixed overrelaxation
- 5 working arrays for the non-blind algorithm with optimized overrelaxation
- 5 working arrays for the blind algorithm

The number of voxels of a working array is the product of the number of voxels of the input data set plus the border with along each spatial dimension. The primitive data type of a working array is a 4-byte floating point number. For example, if the number of voxels of the input data set plus the border width is 256 x 256 x 256 (as for the alphalobe.am data set in the blind deconvolution tutorial), each working array will be about 64 MB, irrespective of the primitive data type of the input data set. Therefore, at least 192 MB (3x4x256x256x256 bytes) are required for non-blind deconvolution with fixed overrelaxation, and 320 MB (5x4x256x256x256 bytes) for blind deconvolution. Keep this in mind when configuring the computer on which to perform deconvolution! However, also note that for most platforms it usually doesn’t make sense to have more than 1.5 GB of main memory. For more memory, a 64-bit operating system is required.

Finally, it should be mentioned that the deconvolution algorithm can make use of a multi-processor CPU board. Although you do not get twice the performance on a dual-processor PC, a speed-up of almost 1.5 can be achieved. By default, Amira uses as many processors as there are on the computer. If for some reason you want to use less processors, you can set the environment variable AMIRA\_DECONV\_NUM\_THREADS to the number of processors you actually want to use simultaneously.

**Example 1: Confocal Data**

The original data set is provided under AMIRA\_ROOT/data/deconv/polytrichum.am. The images below were created using the Image Ortho Projections module.

The properties of the data set are as follows:

- Numerical aperture 1.4
- Wavelength of the emitted light 0.58 micrometers
- Refractive index 1.516 (oil)
Example 2: Widefield Data

The original data set is provided under AMIRA_ROOT/data/deconv/alphalobe.am. The images below were created using the Image Ortho Projections module.

The properties of the data set are as follows:

- Numerical aperture 0.5
- Wavelength of the emitted light 0.58 micrometers
- Refractive index 1.0 (air)
Figure 3.47: polytrichum.am after deconvolution.
Figure 3.48: XY-maximum intensity projection of *alphalobe.am* before deconvolution.
Figure 3.49: XY-maximum intensity projection of *alphalobe.am* after deconvolution.
3.7 Working with Multi-Channel Images

This is a step-by-step tutorial on how to visualize multi-channel image data. You should be familiar with the basic concepts of Amira to follow this tutorial. In particular, you should be able to load files, to interact with the 3D viewer, and to connect display modules to data modules. All these issues are discussed in the getting started section.

We are going to load a set of multi-channel images into the workspace, attach a `MultiChannelField` group object to the data, and visualize it with several display modules. The steps are:

1. Load data into Amira.
2. Create a `MultiChannelField` and attach channels to it.
3. Use `OrthoSlice` with a `MultiChannelField`.
4. Use `ProjectionView` with a `MultiChannelField`.
5. Use `Volume Rendering` with a `MultiChannelField`.

3.7.1 Loading Multi-Channel Images into Amira

The data we will be working with in this tutorial are confocal stacks of the prothoracic ganglion of the locust *Locusta migratoria*. They were kindly provided by Dr. Paul Stevenson, University of Leipzig, Germany. Two different channels were recorded and stored as separate files. Amira supports a number of proprietary multi-channel formats of several microscope manufacturers (e.g., Leica and Zeiss). In such formats, all channels are stored in a single file. Therefore, the first steps described in this tutorial, namely grouping the channels manually, can often be omitted.

- Load channel 1 data by selecting the file
  AMIRA_ROOT/data/multichannel/channel1.info
- Load channel 2 data by selecting the file
  AMIRA_ROOT/data/multichannel/channel2.info
- Create a `MultiChannelField` object by selecting `MultiChannelField` from the Create menu of the Amira main window.

A dark green icon is displayed in the Project View. After you select the object, an info port is displayed saying "no channels connected".

- Connect channel1.info to the `MultiChannelField` by selecting "Channel1" from the `MultiChannelField`'s connection menu (right mouse click in the small white field on the left side of the icon) and click on the channel1.info icon.
- Repeat the above procedure with channel2.info
When the *MultiChannelField* is selected, you will note that two entries, *channel 1* and *channel 2*, appear in the module’s control panel. Each entry has two range text fields and a colormap area. The range text fields work very much like those in *OrthoSlice*. Press the right mouse button over the colormap area to bring up a context menu that will allow you to connect a colormap, edit the colormap, and so forth. If constant color is selected, double-clicking in the colormap area opens a color dialog that lets you freely define the color of each channel.

Now, perhaps, it is a good idea to activate the pins corresponding to Channel 1 and Channel 2 in the Properties Area. This will keep the control elements of the *MultiChannelField* module permanent in the Properties Area.

### 3.7.2 Using OrthoSlice with a MultiChannelField

- Connect an *OrthoSlice* module to the MultiChannelField by right-clicking on the icon and selecting OrthoSlice from the context menu.

When selecting the *OrthoSlice* module, you will see that there are two additional check boxes in its control panel corresponding to the two channels. Clicking these check boxes lets you selectively switch on/off each channel. First, we adjust the intensity mapping of each channel separately.

- Switch off channel 2 by deselecting its check box.
- Enter 23 and 200 in the min and max range fields of channel 1.

As a result, weak stainings – potentially unspecific staining – disappear and those structures that exhibit good staining become even more intense.
• Click off channel 1 and click on channel two.
• Enter the values 8 and 200 in the min and max text fields of channel 2. Move through the slices to see the results.

3.7.3 Using ProjectionView with a MultiChannelField

• Switch off the OrthoSlice by clicking on the viewer toggle off its icon (orange rectangle).
• Connect a ProjectionView module to the MultiChannelField by right clicking on the icon and selecting ProjectionView from the Display submenu.

As with the OrthoSlice, two new check boxes are shown in the module’s control panel which can be used to display channels separately or simultaneously. In this way, you may efficiently adjust the color and intensity of each channel before displaying them simultaneously.

3.7.4 Using Volume Rendering with a MultiChannelField

• Switch off the ProjectionView by clicking on the viewer toggle off its icon (orange rectangle).
• Connect a Volume Rendering module to the MultiChannelField by right-clicking on the icon and selecting Volume Rendering from the Display submenu.

Here also, two channel check boxes are available. Furthermore, the familiar colormap field is missing. Instead, there is a slider labeled Gamma. Now the color of each channel is determined by the color settings in the MultiChannelField object. The Gamma slider controls the steepness of the alpha value (opacity) mapping used for volume rendering.

3.7.5 Saving a MultiChannelField in a Single Amira Mesh File

When the MultiChannelField icon is selected in the Project View, choose Save Data As from the File menu, enter a filename, and click OK. The data will be stored in Amira Mesh format so that each time...
Figure 3.52: Multi channel data visualized using the *OrthoSlice* module.
Figure 3.53: Multi channel data visualized using the ProjectionView module.
Figure 3.54: Multi channel data visualized using the Volume Rendering module.
you load the data the two channel stacks and the MultiChannelField group object will be restored.
3.8 Tracing tube-like structures in electron tomography

This tutorial requires the Amira XTracing Extension. It explains how to extract centerlines of tube-like structures from electron tomograms. It is organized in three steps:

1. How to compute the normalized cross correlation.
2. How to trace centerlines.
3. How to derive statistics from the tracing results.

The specific parameters used here are suitable for extracting microtubules in plastic-embedded samples from electron tomograms as described in [1]. The workflow has also been successfully applied to actin filaments as described in [2]. To apply the workflow to your data, you might need to adapt these parameters, as explained in more detail below.

The tutorial assumes that you are familiar with the basic concepts of Amira. In particular, you should know how to load files, how to interact with the viewer, and how to connect modules to data objects. All these topics are covered in Chapter 2 - Getting started of the Amira User’s Guide. Note that the modules presented in this tutorial require an NVIDIA graphics card supporting CUDA Compute Capability 1.3 or higher. To find your graphics card CUDA Compute Capability, see NVIDIA’s list of CUDA GPUs (http://developer.nvidia.com/cuda-gpus/).

3.8.1 Computing normalized cross correlation

The module Cylinder Correlation can be used to enhance tube-like structures in tomogram data, which is the first step before tracing the centerlines of these structures. The module computes the cross correlation of an image with a hollow or solid cylinder. To apply the module to an example data set, proceed as follows (you may load data/tutorials/microtubules/templatematching.hx to get started; but you still need to set the parameters):

- Load AMIRA_ROOT/data/tutorials/microtubules/MicrotubuleExample.am into the Amira workspace. A green data icon appears in the Project View.
- Attach a Cylinder Correlation module (in category Fiber Tracing) to the data.
- Toggle on the Advanced option available at the top right of the parameters panel.
- Deploy the Compute Device port and Choose the CUDA device in the dedicated port. The CUDA memory port is automatically updated (see paragraph GPU computation).

In the Template Setup port, set the following parameters:

- Cylinder Length: 600
- Angular Sampling: 5
- Mask Cylinder Radius: 125
- Outer Cylinder Radius: 100
- Inner Cylinder Radius: 55
- Contrast: Dark on bright
- Toggle On the Missing Wedge Correction port and leave default parameters for Tilt Axis and Title Angles ports.

Once all parameters have been configured, press Apply. For the example project, the computation of the correlation field takes several minutes. Note that this time consumption is not representative of what it would be for the whole dataset as time consumption is not a linear function of the dataset size. The algorithm requires to internally add a fixed size border to the dataset, which has an effect on time consumption for small datasets but has a negligible effect on big datasets. Depending on the graphics card and the size of the input image data, the computation of the full image data might take up to several hours. For example, on a GeForce 8800 GT with 1GB video memory the computation of an image of size 2000 x 2000 x 200 takes approximately 20 h. For testing the algorithm, consider cropping the input image data using the Crop Editor.

As a result, two new objects MicrotubuleExample.CorrelationField and MicrotubuleExample.OrientationField will be connected to the Cylinder Correlation module. The MicrotubuleExample.CorrelationField data object stores the maximum cross correlation, and the MicrotubuleExample.OrientationField stores the orientation of the cylinder corresponding to this correlation. From these two fields, tube-like structures can be extracted as described in the next section.

But first, the parameters of Cylinder Correlation are explained in more detail.

### 3.8.1.1 GPU computation

The cross correlation is computed on the GPU. Because GPU memory is limited, the port CUDA memory allows you to limit the amount of GPU memory used for the computation. The preset value is estimated automatically depending on the memory available on the chosen CUDA Device. If you run other processes that consume GPU memory, computing the cross correlation might fail due to lack of memory. In this case, you should set a reasonable limit. In practice, 80% of the free memory should work.

Computing the cross correlation is time consuming. To minimize computation time, consider resampling the image data to the lowest possible resolution yielding satisfactory results. For microtubules (plastic-embedded), a voxel size of 25 Angstrom turned out to be sufficient in practice. A higher resolution did not increase quality substantially. The right voxel size is, however, data-dependent. If you plan to process many data sets of similar characteristic, it is usually worth investing some time to determine the lowest reasonable resolution. Also consider cropping the image data to remove empty space. However, do not crop them too tightly (see discussion of limitations below).
3.8.1.2 Cylinder Template

To create a cylinder template that matches the tube-like structures, specify the length and the radius of the cylinder. The values can be based on a-priori information about the structures, or on measurements taken from the image data. The measurement tool (i.e., Measurement in the viewer toolbar) is often useful to determine reasonable lengths and radii. Note that parameters are specified as radii; diameters need to be divided by two. In the following sections, we use actin filaments and microtubules as examples.

- **Radius:** For structures like actin filaments, a solid cylinder template is appropriate. Specify only the *Outer Cylinder Radius* and set the *Inner Cylinder Radius* to 0. Since actin filaments have a diameter of 140 Angstrom, an *Outer Cylinder Radius* of 70 Angstrom should be fine. For structures like microtubules, a hollow cylinder template works better. Since microtubules have a diameter of 250 Angstrom, the *Outer cylinder radius* should be approximately 130 Angstrom. However, based on the measurements on the image data (see Figure 3.55), we decided to set the *Outer Cylinder Radius* to 100 Angstrom, the *Inner Cylinder Radius* to 55 Angstrom, and the *Mask cylinder radius* to 125 Angstrom for the example tomogram. Acquisition artifacts like shrinking might be the reason that the microtubules appear to have a slightly different size in the image.

- **Length:** The *Cylinder Length* defines the template length in physical units. A longer template is more robust to noise, but a longer template at the same time reduces the sensitivity to curved structures and to the ends of structures. A longer template also requires to stay away further from the image boundary (see discussion of limitations below). A reasonable compromise depends on image quality and the structures to be extracted. For actin filaments, a cylinder length of 420 Angstrom is a good empirical compromise. For microtubules, a cylinder length of 600 Angstrom worked in practice. The trade-off might be different for other structures.

- **Contrast:** The contrast specifies the contrast of the signal to be detected. Microtubules, for example, are darker than the surrounding image, so select *Dark on bright*.

The cylinder template can be generated in the *Visual Cylinder* section of the module. This allows you to set values for the parameters *Cylinder Length*, *Mask Cylinder Radius*, and *Outer Cylinder Radius* interactively in the 3D viewer. By enabling the cylinder template, a slice appears that can be rotated or translated to be aligned with a structure of interest. Once a good slice orientation has been found, two consecutive middle-clicks onto the slice create a cylinder by defining its length and location. The outer diameter can now be adjusted using the corresponding port. See *Cylinder Correlation* documentation for more details and see Figure 3.56 for an illustration.

3.8.1.3 Missing wedge

Electron tomograms suffer from the missing wedge artifact, because the specimen cannot be rotated completely around the tilt axis. The cylinder template can be adjusted to better handle this artifact. Set *Correct missing wedge* accordingly. Select *no* for image data that are acquired in a different way and
Figure 3.55: Length measurements to determine Cylinder Correlation parameters for microtubules. Indicated are length measurements that help to determine the parameters. Note that parameters are specified as radius, so diameters need to be divided by two. From top to bottom: Mask length, twice the Inner cylinder radius, twice the Outer Cylinder Radius, and twice the Mask Cylinder Radius.
Figure 3.56: Visual Cylinder utilization of the Cylinder Correlation module to extract microtubules with a diameter of 200 Angstrom in image data with a voxel size of 11.78 Angstrom.
do not suffer from a missing wedge. Select \textit{x-axis} or \textit{y-axis} for single-tilt tomograms, or \textit{dual tilt} for dual tilt tomograms.

The Fourier power spectrum may help to determine or verify the tilt axis. See Figure 3.57 for a typical spectrum of a single-tilt tomogram. The wedged structure that is aligned with the tilt axis is clearly visible. See Figure 3.58 for a typical spectrum for a dual-tilt tomogram. Here, only a pyramid along the \textit{z}-axis is missing. The Fourier power spectrum of an image volume can be computed with the module \textit{Fourier Transform} available in the \textit{Deconv} category of the right-mouse-click menu (select mode \textit{power spectrum} before applying the module). To limit computation time, it is usually sufficient to apply the module to a small image sub-volume only.

\subsubsection{3.8.1.4 Standard Deviation}

Image regions with low-standard deviation may be irrelevant. The port \textit{Standard deviation} can be used to suppress such regions. A threshold of 15 worked for electron tomograms of microtubules. To determine a reasonable threshold, a standard deviation field can be generated by toggling \textit{generate field}. The default is to keep all correlation values unless the standard deviation is 0. Usually, this works well.
Figure 3.58: Volume rendering of a typical Fourier power spectrum of a dual-tilt tomogram. The electron beam is transmitted along the z-axis (blue). The two tilt axes are parallel to the x-axis (red) and the y-axis (green).
3.8.1.5 Limitations

**Boundary:** The correlation field may contain artifacts close to the boundary (within half the cylinder size). The reason is that the cross correlation is computed in Fourier space using the Discrete Fourier transformation (DFT) with periodic boundary conditions. The practical implication is that a template that is close to the boundary senses structures close to the opposing boundary of the image. Sharp edges in the image signal, like rapid foreground to background transition, also may create undesired effects. A general recommendation is:

- To acquire image data such that the relevant structures are far enough away from the image boundary.
- To keep enough of the original image data when cropping so that the relevant part of the correlation field is away from the image boundary; but ideally have reasonable image signal up to the boundary (no sharp transitions to black).
- Either crop the resulting correlation field to the part that is far enough away from the boundary (and cut the orientation field to the same size) before running **Trace Correlation Lines**, or clean up the resulting lines if they look unreasonable close to the boundary.

**Template size:** The template is sampled onto a cubic grid, which must fit into the image volume. For a large *Cylinder length*, the template may be too large for the image volume. In particular, if the image volume has few z-slices, this might be a limitation. To successfully apply **Cylinder Correlation**, reduce the *Cylinder length* until the template fits. If this does not yield satisfactory results, consider increasing the volume by adding empty z-slices using the **Crop Editor**. Keeping the template small is a good idea, in general, since the computation time increases with template size.

3.8.2 Tracing the centerlines

The module **Trace Correlation Lines** traces centerlines of tube-like structures based on the **Microtubule-Example.CorrelationField** and the **MicrotubuleExample.OrientationField**, which were computed in the previous step.

- Attach a **Trace Correlation Lines** module to **MicrotubuleExample.CorrelationField** (in category **Fiber Tracing***).
- Right-click on the white square of the **Trace Correlation Lines** icon. From the context menu choose **Orientation Field**. Then click on the **MicrotubuleExample.OrientationField** icon to connect it with the **Trace Correlation Lines** module.

In the **Trace Parameters** port, set the following parameters:

- **Minimum Seed Correlation:** 68
- **Minimum Continuation Quality:** 45
- **Direction Coefficient:** 0.3
Figure 3.59: Histogram of correlation values with reasonable range for Min seed correlation (max of range) and Min continuation quality (min of range).

In the Search Cone port:

- Length: 500
- Angle: 37
- Minimum Step Size (%): 10

In the Line Parameters port:

- Minimum Distance: 140
- Minimum Length: 0

Trace Correlation Lines traces lines that start at points whose correlation value is greater than the value of Min seed correlation. It is useful to inspect the correlation field to determine an initial value to try and then refine the choice. If too few lines are extracted, consider lowering the value. If too many lines are extracted, consider increasing the value. The initial values should be chosen such that all points with a greater correlation value are clearly useful seed points. It can be done in various ways such as using an Ortho Slice (see Figure 3.59 and Figure 3.60). Alternatively, use an Isosurface and adjust its Threshold such that the isosurface contains only parts that are clearly useful as seed points. Then use this threshold as Min seed correlation.

The Min continuation quality can be determined in a similar way (see Figure 3.59). It controls where line tracing stop. If lines are unexpectedly short, try a smaller value. If lines are too long, try a larger value.

The purpose of Min line distance is to avoid that a second false line is accidentally traced close to another line, which might happen if correlation values are not clearly separated. To determine a reasonable distance value, use the measurement tools (Measurement in the viewer toolbar).

Another data-specific parameter is the Direction coefficient. If the tube-like structures are more or less straight, a smaller value is appropriate. If the data also contains curved lines, a larger value might be appropriate.

You might also have to adjust all other parameters that are in physical units to the right scale for the relevant structures in your data. See the module’s documentation for details.
Figure 3.60: Slice through correlation values with the same data range as indicated in the histogram in the previous figure.
Once all parameters have been configured, press Apply. For the example network, the extraction of the centerlines takes only a few seconds. For a larger data set, you should expect the computation to take several minutes.

The result of the module Trace Correlation Lines is of type Spatial Graph. To display this object, right click on the result’s icon in the Project View and choose Spatial Graph View (in category Display) from the context menu. For further information on the data structure, click on the icon in the Project View and then click the help icon in the Properties Area.

### 3.8.3 Computing basic statistics for tracing results

By default, a spatial graph generated by the Trace Correlation Lines module automatically add statistics like the length and the orientation of each centerline stored as attributes. It can be then displayed by using the Spatial Graph View module (see Figure 3.62). To get the same statistics in a tabbed spreadsheet you may use the Spatial Graph Statistics module (see Figure 3.61).

- Attach a Spatial Graph Statistics module to the generated Spatial Graph. To do so, right-click on the green data object CorrelationLines. From the context menu, choose Measure And Analyze. Then click on the entry SpatialGraphStatistics.
- In the Properties Area of the SpatialGraphStatistics, press the Apply button. A MicrotubuleExample.statistics spreadsheet, as shown in Figure 3.61, is generated and displayed in the Project View.
- Select the MicrotubuleExample.statistics spreadsheet and then click the Show button. A new dialog will be displayed that presents the results in a table.
- Select Segment Statistics table to get statistics for each segment.

The Label Spatial Graph module can be used to create attributes based on a LabelField. As shown in Figure 3.63, one corner of the tomogram was manually marked in the segmentation editor. The Label Spatial Graph module was then applied to create a segment attribute that indicates whether a segment is completely inside the region named Corner, or completely outside, or is crossing the boundary. Segments that are completely inside the region are colored in white, segments that are completely outside are colored in gray, crossing segments in pink.

- Create some labels using the Segmentation Editor
- Attach a Label Spatial Graph module to the generated SpatialGraph. To do so, right-click on the green data object CorrelationLines. From the context menu choose Compute. Then click on the entry Label Spatial Graph.
- Right-click on the white square of the Label Spatial Graph icon. From the context menu choose Label Data. Then click on the MicrotubuleExample.Labels icon to connect it with the Label Spatial Graph module.
Figure 3.61: Output spreadsheet of the Spatial Graph Statistics module.

Figure 3.62: Display centerline orientations using the Spatial Graph View module.

Tracing tube-like structures in electron tomography
Figure 3.63: Region-based attribute using the *Label Spatial Graph* module.
References


Chapter 4

Creating 2D workflows for processing image stacks

The following tutorials require an Amira XImagePAQ Extension license.

An image stack is a series of 2D images (1 to N) that can be stacked to generate a volume data set. Any 3D image can be interpreted as an image stack.

The Image Stack Processing module allows the creation and execution of image processing recipes (a recipe automates the execution of a series of modules to reapply it on any compatible data), to process an image stack in 2D (each image of the stack is processed individually).

The Image Stack Processing editing workroom features an interactive and dynamic edition environment, giving constant feedback about the recipe being built. Any step of the recipe can be accessed and modified, with immediate feedback about the impact of each change on the final output. It is an optimized 2D setup to enhance and segment data in Amira software.

Note for Amira XRecipe Extension users: The main differences between an Image Stack Processing (ISP) recipe and a general recipe (see Amira XRecipe Extension) are summarized here:

<table>
<thead>
<tr>
<th></th>
<th>ISP recipe</th>
<th>General recipe</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Used for</strong></td>
<td>Automating an image processing workflow on an image stack</td>
<td>Automating a general workflow</td>
</tr>
<tr>
<td><strong>Input/output of a recipe step</strong></td>
<td>Image data type only</td>
<td>Any data type</td>
</tr>
<tr>
<td><strong>Editing</strong></td>
<td>Unlimited</td>
<td>Limited</td>
</tr>
<tr>
<td><strong>Processing</strong></td>
<td>2D</td>
<td>3D and/or 2D</td>
</tr>
</tbody>
</table>

Note: An image processing stack module pointing to an ISP recipe can be a step of a recipe, not the other way around.

The Image Stack Processing workspace gives access to a catalog of tools dedicated to image process-
ing. The editing of a recipe is always done in 2D (on a slice), with two viewers, which by default display the data of a given recipe step, before (left) and after (right) the processing of that step. The viewers can be set up to display a step input, a step output, the workflow input or the workflow output (see viewers).

![Figure 4.1: Left is input to Thresholding, right is output of Thresholding](image)

The Image Stack Processing extension can also be used in a batch mode from a command line (see How to batch process). This mode is useful for online processing (live image processing during acquisition). An Image Stack Processing recipe is always applied on a slice. If the input data is 3D, then it will be interpreted as a stack of 2D slices. The recipe will be applied slice by slice. You can use the mechanism to process a large stack of slices, from an input directory to an output directory with a maximum of one slice in memory at a time (How to batch process a stack of large images with the Image Stack Processing module)

To learn more about the tools available in the extension, refer to the following links:

- Image Stack Processing module
- Image Stack Processing tutorial
- How to batch process a stack of large images

### 4.1 Image Stack Processing Workroom Tutorial

The Image Stack Processing workroom is a very intuitive and optimized 2D setup to enhance and segment data in Amira. It allows you to build an ISP recipe dedicated for image processing of 2D data. It gives access to a catalog of tools dedicated to image processing:

- Preprocessing (denoising, contrast enhancement, background correction, and so on)
- Segmentation (thresholding, feature selection, and so on)

The following tutorial explains how to use the Image Stack Processing workroom and build an ISP recipe.

The tutorial is separated into the following parts:
1. Main rules of the workroom
2. Access the workroom
3. Use the viewers
4. Add and modify steps
5. Change a reference
6. Insert steps
7. Inspect a different slice of the data
8. Save the ISP recipe
9. Export multiple outputs
10. Remove/replace steps and manage error
11. Add external inputs to the workflow
12. Export workflow parameters for easy access from the Image Stack Processing module
13. Quit the workroom
14. Use the ISP recipe from the project room

Note: In this whole document, Image Stack Processing will be abbreviated into ISP.

4.1.1 Main rules of the workroom

This section lists the rules that one need to know to work in the ISP workroom:

1. The ”reference” data is the main input of the workroom. An ISP workflow always starts from the reference data. It corresponds to the starting point of a linear workflow. In Figure 4.2 is displayed a linear workflow and its ISP equivalent.

![Figure 4.2: Linear workflow in pool and Image Stack Processing workroom](image)

However, the reference of a workflow can be changed within the room at any time to start a new linear workflow, from the data which are available and listed in the workroom (see Change a reference). An example in Figure 4.3

2. The ISP workroom is modal. It prevents you from returning to another workroom and changing the reference data that the workroom is set up with. You must explicitly close the room (Quit...
Figure 4.3: Changing the reference of a workflow

1. Before returning to a different room.

3. The primary data (main connection) of a selected tool automatically connects to the preceding output. If you need to connect to a different output, then a reference step must be added (see Changing reference).

4. The workroom only manipulates image data.

5. Only modules computing an output (no in-place editing) and preserving dimensions (output has same dimension as input) are available.

6. Tools inserted into an existing workflow are always inserted below the selected step.

7. To add data external to the workflow, the data must be of same size in X, Y, and Z dimensions as the initial reference so that changing slice number is coherent in all data.

8. The data listed in the combo box of a secondary data input of a tool refers to the output of the steps listed in the Workflow panel, and are preceded by their step number.

Figure 4.4: Output of the steps preceded by their step number

9. If any error occurs during the computation of a given slice, then the processed slice will be filled with null values.

4.1.2 Access the workroom

This section explains how to open the ISP workroom from the main project workroom. This is the first step in the tutorial.

From the main Amira project workroom, open the following data:

- AMIRA_ROOT/data/tutorials/chocolate-bar.am
Right-click on the `chocolate-bar.am` data module displayed in the pool and select *Image Stack Processing* from the *Object Popup* under the *Image Processing* directory.

Select the module and in the *Properties* panel, click *Create workflow of Action* port.

The ISP workroom opens with the reference data being displayed on the left and right viewers (see Figure 4.5).

![Reference data displayed in viewers](image)

**Figure 4.5**: Reference data displayed in viewers

### 4.1.3 Use the viewers

This section explains how to manipulate the viewers available in the ISP workroom. For the tutorial, you will view the chocolate bar.

The ISP workroom is set up with two viewers in a horizontal layout. By default, the left viewer displays the selected step input, and the right viewer displays the selected step output. The cameras of the two viewers are always synchronized. You can translate (using middle mouse button, or left button if in translate mode (`*`)), or zoom (using mouse wheel, or left button if in zoom mode (`*`)).

The viewer mode can be changed with the view combo box:

![View combo box](image)

**Figure 4.6**: Viewer mode

Any view can be set up with:

- The step input (default of left viewer)
- The step output (default of right viewer)
- The workflow input
- The workflow output
By default, when the output of a step is a binary or a label image, it is automatically blended with the last grayscale image of the stack (see Figure 4.7).

![Figure 4.7: Binary data blended on top of the grayscale](image)

Evaluate the value of a pixel under the mouse with the quick probe tool. You can create snapshots of the views using the snapshot tool (note that the “capture all viewers” check box will allow you to create a snapshot of only one or both viewers).

### 4.1.4 Add and modify steps

This section explains how to add tools in a workflow and see their effects on the data. For the tutorial, you will create a mask of the nougat phase. The mechanism of adding a tool is as simple as selecting the tool in the Tool Browser. This action will add the tool in the workflow panel and automatically apply it on the output of the preceding step with its default parameter. You can then test the parametrization and see the effect on the data.

First deactivate label blending by setting Label Blending switches to off in each viewer.

Convert the 16-bit data to 8-bit. This step is necessary for some filters to run.

In the module browser window, either go to the convert directory and select the Convert Image Type module, or type its name in the quick search shortcut.

![Figure 4.8: Quick search shortcut](image)

Once selected, a step is added in the workflow.

It is automatically selected, and the module properties are displayed in the Properties panel.
At the same time, the module is automatically applied to the last output step (the original reference data in this case). Its result is displayed in the right viewer.

![Image with changes applied](image.png)

**Figure 4.11:** Image type conversion

Change the scale port to 0.1. The right viewer is updated with the changes.

![Image with scaled changes](image.png)

**Figure 4.12:** Image type conversion with scaling of 0.1

Add the following tools to the workflow in order to build a mask for the nougat phase:
• A *Thresholding* to roughly select nougat. Intensity range is set to 51-98.

![Thresholding to select the nougat](image)

**Figure 4.13**: Thresholding to select the nougat

• An *Erosion* to erode selection and reduce noise around the chocolate bar. Type is set to disc, and size to 1.

![Erosion with Disc of size 1](image)

**Figure 4.14**: Erosion with Disc of size 1

• A *Remove Small Spots* to remove small spots. This will eliminate caramel residuals. Size is set to 200.

![Removing small spots of size 200](image)

**Figure 4.15**: Removing small spots of size 200

• A *Dilation* to overdilate selection. This will fill holes and smooth boundaries. Size is set to 12.

• Another *Erosion* to erode selection to have net-zero erosion/dilation on nougat selection (go back to original data shape without holes). Size is set to 9.
Our mask is now ready. We will use it to segment the porosity within the nougat phase.

**Note:** The ISP workroom supports insertion of *Python Script Object* module, on condition that it respects the following requirements:

- The module takes images as input, and create images with the same size and bounding box;
- It should not modify its inputs;
- The step output that precedes *Python Script Object* in the workflow is always connected to the *data* port. As a consequence, the *data* port is always the primary input.
- The image type of the *data* port shall always be defined in the *Python Script Object*, using `valid_types` member of `self.data`.
- Click on *Apply* button shall be checked in the *Python Script Object* before starting computation.
- The computation should not require any GUI interaction.

There is no warranty if the script has any other behavior.

When *Python Script Object* module is used in the workflow, neither Pack&Go export nor pinned ports are supported.
4.1.5 Change a reference

This section explains how to change a reference within the workflow. For the tutorial, you will capture porosity within nougat phase, and label it.

Now that we have a mask for the nougat phase, we can use our initial thresholding capturing the porosity within the nougat.

Because the general rule (see Main rules of the workroom) is that the primary data (main connection) of a selected tool automatically connects to the preceding output, we need to change the last output to step 3. Click + button next to Insert a reference change step in the Workflow panel.

![Insert a reference change step: +](image)

**Figure 4.18**: Change reference button

This inserts a new step.

![Reference Change: NO SOURCE](image)

**Figure 4.19**: Change reference step

The step is preceded with the error icon (warning) because it is not yet set so it can create an output. You need to select a data set directly from the workflow panel.

The available list represents the data created during the workflow. Each data set is preceded with a number corresponding to the step the output comes from.

![Reference Change: 3_Thresholding](image)

**Figure 4.20**: Selecting a data

In this case, select: 3_Thresholding.

Once the reference port is set, the error icon disappears.

Continue with the workflow in a new branch starting from the output of the module.

- Invert the selection to select pores (bubbles) with an Invert module.
- Mask out anything outside the nougat phase with a Mask module our the initial created mask.

In this last added step, we can see that our mask is too large. The workflow could benefit from some improvements. In ISP, it is easy to tweak and test variations within a workflow.
First, set up the viewers so we see the effect of a particular step on the final workflow output:

- Set the left view combo box to *Step Output*.
- Set the right view combo box *Workflow Output*.

Select the *Erosion* step (7) by clicking on it in the workflow panel and position your cursor in the size port of the *Properties* panel. Use the mouse wheel to increase the value incrementally. The border
slowly disappears until only the pores remain in the workflow output (final value is 13).

![Figure 4.24: Modifying Erosion step](image)

Go back to the mask step by clicking on it in the workflow panel. Set the left view combo box to Step Input. Add a Labeling module to label the pores.

![Figure 4.25: Labeling the pores](image)

Try inserting a Marker-Based Watershed after the labeling module. An error appears because a grayscale image is needed as primary input. You must change the reference to grayscale first and then connect a label data as secondary input.

### 4.1.6 Insert steps

In this section you will modify the workflow by inserting steps. For the tutorial, you will clean up porosity and create inverted nougat mask.

The workflow above classifies pores within the nougat phase individually. Some very small pores could be considered noise, because they were included in the threshold to remove noisy data. You can try improving the workflow by inserting a noise removal module before thresholding. Since insertion of tools within an existing workflow is always done below the selected step (see rules), select step 2 and insert a Median Filter before the thresholding as follows:

- Delete previously created Marker-Based Watershed step.
• Select step 2.
• Go to the module browser and type median in the quick search toolbar. Select *Median Filter*.
• A new median filtering step is inserted below the *Convert Image Type* step and before the *Thresholding* step.

By setting the left view as step output and the right view as workflow output, you can see the effect of the noise removal on the pore selection in the final data. Try lowering iterations to 1 and changing the type port to disk. Now only the major pores remain in the selection.

![Figure 4.26: Left is step output, right is workflow output](image)

Set the viewers back to default:

• Set the left view combo box to Step input.
• Set the right view combo box to Step output.

To go on with the workflow we also need an inverted mask of the nougat phase to capture the caramel phase and ensure no overlap between the 2 phases.

We select step 8 (*Erosion*) and invert the selection by inserting an *Invert* step just before changing the reference (see Figure 4.27).

![Figure 4.27: Inverting the selection](image)
4.1.7 Inspect a different slice of the data

In this section, you will change the slice the workflow uses as input to inspect other parts of the stack and check if the workflow needs improvement. For the tutorial, you will create a mask of the caramel phase.

- Select step 13 (Labeling)
- Create a new reference step: Clicking + button next to Insert a reference change step in the Workflow panel, and set it to step 2.
- Add a Non-Local Means Filter to reduce noise while retaining particle edge contrast to ease caramel selection. Set Mode to GPU Standard and Local Neighborhood to 2.

![Figure 4.28: Non-local means filtering](image)

- Enhance overall contrast to facilitate caramel selection with a Normalize Grayscale. Set Range Mode to other. Input range is set to 100-160 and output range to 0-150.

![Figure 4.29: Grayscale normalization](image)

- Roughly select pixels belonging to caramel with a Thresholding module, set intensity range to 54-98.
- Dilate the selection to join disconnected features and smooth boundaries with a Dilation module. Set the type to Disc and set Size to 3.

At this stage the selection looks good on the current slice, but it might suffer from artifacts on a different slice.
To further inspect the workflow, and check if it is valid on every slice of the stacked data, you can change the slice on which the workflow is applied.

Move the *Preview workflow on image* slider of the Workflow panel to slice 135.

![Figure 4.32: Changing slice number](image)

You see the following display with a spot that still remains after dilation.

![Figure 4.33: Workflow result at slice 135](image)
Remove this artifact by inserting a *Remove Small Holes* module with a size of 200.

![Image: Figure 4.34: Removing small holes with size 200](image)

*Erode* the selection with a size of 7.

![Image: Figure 4.35: Erosion of the selection](image)

Continue checking the workflow. Select slice 283. There are some remaining spots here as well.

![Image: Figure 4.36: Result on slice 283](image)

Add a *Remove Small Spots* module with size set to 200.

Add a *Dilation* module to re-dilate the caramel selection for net-zero erosion/dilation (go back to original shape without artifacts removed with morphological steps). Size 6 with a *Disc* type.

Subtract the nougat selection from the caramel to ensure no overlap between the two.
We add a Mask module where the binary image is step 9 (Invert) which we prepared in the Insert steps section (see Figure 4.39).

The caramel phase is now selected in addition to the nougat phase.

To finalize the workflow, we sum up each classified chocolate phase (pores, nougat, and caramel) within the same label by adding an image arithmetic step with the following inputs and formulae:

The finalized segmented chocolate looks like Figure 4.41.
4.1.8 Save the ISP recipe

At this stage it is good to save the Workflow being edited.

From the Workflow window, click Save As and then save the Workflow on disk. The file extension is .hxisp.

The Save button allows overwriting the current .hxisp file if a file is already specified. The Save button is disabled if there is nothing new to save.

4.1.9 Export multiple outputs

For the tutorial, you will export multiple outputs of the candy bar data.

By default, only the last step of the ISP workflow is exported as final output from the ISP module.

It is represented by the following output icon: 🗂️.

To export additional outputs such as the caramel and nougat phase, click the output icon.

When the ISP module is executed from the main project workroom (apply is clicked), the module outputs the last step of the ISP recipe and the data which are selected as additional outputs in the workroom (as described above).
4.1.10 Remove/replace steps and manage errors

In ISP, any step can be removed. As an example, you can replace the *Dilation* followed by an *Erosion* with a *Selective Closing*:

- Select step 7 and click the delete icon. The workflow is automatically recalculated to take the changes into account.
- Select the *Erosion* step (now step 7), and then click the delete icon.
- In this case, the Workflow panel detects an error and highlights it using the error icon in step 10 (more information available in the console window). The mask step was using the output of the step we just deleted. The disconnection in the stack is highlighted by the unavailable steps:

  ![Unavailable steps in workflow](image)

- The workroom does not delete every step. There is still a chance to fix it by simply reediting the workflow.
• Select step 6 (now Remove Small Spots) and type ”selective“ in the quick search toolbar of the module browser.
• Select Selective Closing from the list.
• Set the number of iterations to 5 and threshold to 3.
• Click the mask step where the error appears, and then set the Selective Closing output as a binary image.

The workflow is now fixed.

Another reason why the workflow might be wrong is that the primary data of a module expects a data type different from the previous output (for example binary is expected when previous output is grayscale).

As an example you may try to remove the first Thresholding step. Most of the workflow will then be made unavailable.

### 4.1.11 Add external inputs to the workflow

For the tutorial, you will add an extra input to ISP.

The default behavior of the ISP workroom is to have access only to the data built from the reference data the room was opened with.

However it is possible to add data external to the workflow, under the condition that the data has the same dimension in X, Y, and Z as the input reference data.

As an example, let’s use the inverted nougat mask data we originally loaded at first (called chocolate-bar.nougat.invert.am). Here is how we would include it as an extra input to ISP:

• Look in the External Input field at the bottom of the workflow panel.

![Figure 4.45: List of external inputs](image)

The list is populated with external data compatible with the current workflow.

• Select the external data to add to the workflow: chocolate-bar.nougat.invert.am
• Click Add button.
• A message lets you know that the data is now available.
• In the last Mask step, select the new data from the Properties panel.

When going back to the main project workroom, an additional input is now available in the ISP module.
For the purpose of the tutorial we now remove this extra step to have only one main input:

- In the last Mask step, select back the result of Invert step as binary image.
- Click Clean.

- A message lets you know that an input has been removed
- In Mask module Input Binary Image list, the chocolate-bar.nougat_invert isn’t available anymore.
4.1.12 Export workflow parameters for easy access from the ISP module

For the tutorial, you will select and export specific parameters from the ISP workroom, to make them available from the ISP module in the project workroom.

Since the ISP recipe can be used on any input data from the project workroom using the ISP module, it is sometimes practical to have specific parameters of the workflow readily available directly from the module. You can then fine tune the recipe when applied on a different data set than the one which you used to create it. Any parameter can be exported using the pin icon from the Properties panel. When the icon is pinned down, the parameter will be available directly from the ISP module in the project workroom.

Click on the Thresholding step and click on the pin icon of the Intensity Range parameter:

![Figure 4.50: Pin the Thresholding port](image)

Go back to the project workroom (see quit the workroom) and select the Image Stack Processing module. Look at the Properties panel. The Intensity Range is now available and can be changed:

![Figure 4.51: Thresholding port now available in ISP Module](image)

4.1.13 Quit the workroom

To switch back to the project workroom, click Quit . Make sure the .hxisp file is saved before accepting.

4.1.14 Use the ISP recipe from the project room

In this section, you will apply a saved workflow to a 3D data (processed as a stack of images) from the project room, using the ISP module. For the tutorial, you will apply the workflow that you created to the full data set.

At this stage, the Image Stack Processing module attached to the chocolate-bar data should point to the .hxisp file you have saved on disk.
To process the data with the workflow, click *Apply* in the *Properties* panel once the ISP module has been selected in the pool.

The module outputs the following label:

![Workflow result](image)

**Figure 4.52**: Workflow result

Now that the workflow is ready as an ISP recipe, it can be applied on any data. The user may test it on a different data by changing the inputs of the *Image Stack Processing* module.

The workflow described in this tutorial can be found at the following location: 
$\text{AMIRA_ROOT/share/isp/Chocolate_Bar_Segmentation_tutorial.hxisp}$

To load it, simply click the *Browse* button of the ISP module and select the recipe.

You can now click on *Edit workflow* to see the details of the recipe.

### 4.2 Batch process a stack of large images

The *Image Stack Processing* Extension can be used to process a large data directly from disk to disk (out of core processing). The process is as follows:

- Load a few slices to test and create a recipe with.
- Run Amira from a command line to apply the recipe slice by slice from disk to disk.

The memory usage during processing will be low and stable.

The following section describes how to batch process a stack of (large) images:

- Load the following image: $\text{AMIRA_ROOT/data/teddybear/teddybear002.jpg}$
- Attach an *Image Stack Processing* module to the data.

*Batch process a stack of large images*
• Click *Create workflow*.
• Build a dummy recipe for later processing of each image stored in the input directory:
  • Add a *Median Filter* step (default parameter).
  • Add an *Erosion* with size = 1.
• Save the recipe in the following directory: `<temporary_directory>/dummy.hxisp`

Now that the ISP recipe example is built with a single image, we will read each slice of the teddybear dataset from disk, process it, and output the result directly on disk:

• Copy `AMIRA_ROOT/data/teddybear/` input data directory into the directory of your choice. The batch processing script will write the outputs into the input directory, so you need to have write permission.
• Open a DOS command window.
• From the window, go to the directory where the Amira executable is stored (`AMIRA_ROOT/bin/arch-Win64VC12-Optimize`) and type the following command:
  ```
  Amira.exe -nogui -tclargs "'<your_data_directory>/teddybear'
  '<temporary_directory>/dummy.hxisp' jpg {load
  -unit mm -jpg +box 0 127 0 127 0 1 +mode 100}"
  ../../share/isp/disk2disk
  isp.hx
  ```

The command populates the teddybear directory with an output directory containing the processed slices.

The command works as follow:
```c
Amira.exe inputDirectoryName hxispFileName extensionOfFilesToLookFor LoadCommand scriptPath
```

If you do not know the *LoadCommand*, then you can load the data in Amira and look for it in the data parameter editor under the *LoadCmd* section.

*Batch process a stack of large images* 166
Chapter 5

Creating recipes to automate workflow execution

*Recipes are only available on Microsoft Windows platform.*

Amira allows for the creation of user-defined *recipes* to automate the execution of a series of modules. Amira recipes facilitate the application of high-level workflows such as filtering, segmentation, and the extraction of user-defined statistics from an image. Recipes integrate your knowledge and make it available for other users as *push button* solutions.

A dedicated workroom is available to create, edit, and execute recipes. The workroom can be launched by selecting the *Recipes* icon located on the *Workroom Toolbar*. The workroom consists of three panels: an instance of the common 3D Viewer, a dedicated *Recipes* panel presenting the sequence of steps in a list, and the *Properties* panel showing the module properties of the current step. The main interaction area is the *Recipes* panel, which let’s you edit and execute your recipes (see Figure 5.1). Once a recipe has been selected from the dropdown menu in the *Recipes* panel, it can be played back and edited. Amira will load all recipes found in the standard recipe folder of your home directory. By default, this folder is located at %APPDATA%/Thermo Fisher Scientific/Recipes. You can click **Load Recipe** to load additional recipes, and click **Save Recipe** to save the recipes on disk to share them with other users.
You can click **Edit Recipe** to change the recipe name and add some documentation to it (see figure 5.2).
Then, this documentation is displayed in the Recipe Panel.

Recipes can be executed at once or with breakpoints in which case the execution of the recipe will pause at user-defined steps (see Figure 5.4). By default, the recipe configures the modules as you save them. Breakpoints allow you to change the properties of a module used in the recipe during runtime. In this way, a recipe can be executed several times by only changing one parameter to evaluate the sensitivity of that parameter. For example, you can change a threshold to evaluate if porosity is sensitive to the segmentation parameter.

**Note**: Modules that require user interaction (e.g., paint) will automatically force a breakpoint.
For each step, you can turn on/off saving the results to disk and exporting them in the *Project* workroom. If the export to the *Project* workroom is off, the data will be removed from memory as soon as it is no longer needed. This action allows you to reduce the memory consumption. **Note:** Your results will be saved to disk only if *Production Mode* is turned on.

**Figure 5.4:** Recipe Step Actions

When a recipe has been played back, hovering with the mouse over a step displays a preview thumbnail of the result image (see Figure 5.5).
At each step, it is possible to take a snapshot of its result and save it in the application data directory. By default, the display module defined in Edit > Preferences > Auto Display is used. However, you can add an explicit snapshot step with a breakpoint to change it. When executing the recipe, it will pause at this step and allow you to customize the display module in the Properties panel (see Figure 5.6).
The Amira XRecipe Extension documentation is organized into the following sections:

- Creating and editing recipes
- Using breakpoints, recomputing another region, and processing full data
- Recipes in a TCL command
- Recipes Limitations

5.1 Creating and Editing Recipes

Using a simple example, this section shows you how to create and edit a recipe. In this example, the chocolate bar data set from Amira’s tutorial directory is analyzed with respect to air bubbles inside the candy matrix. We begin by setting up a processing workflow:

- Load AMIRA_ROOT/data/tutorials/chocolate-bar.am
- Attach an Image Processing > Smoothing And Denoising > Median Filter. Select Interpretation 3D, set Iterations to 1 in its Properties, and click Apply.
- Attach an Image Segmentation > Binarization > Auto Thresholding module to chocolate-bar.filtered object and click Apply.
- Attach an Image Processing > Separating and Filling > Fill Holes module to chocolate-bar.labels data, select 3D option, and then click *Apply*.
- Attach a Compute > Arithmetic module to chocolate-bar.filled data, connect its *InputB* port to chocolate-bar.labels. In the *Expression* field, enter A-B and then click *Apply*.
- Attach a Measure And Analyze > Individual Measures > Label Analysis module to Result data (result from previous Arithmetic module), connect its *Intensity Image* port to chocolate-bar.am, and then click *Apply*.
- Attach an Ortho Slice to chocolate-bar.label to visualize the result.

Your Project View should now look similar to Figure 5.7.

![Figure 5.7: Bubble Analysis Workflow](image)

- Attach a Create Recipe module to Result.label (result from previous Label Analysis module), and click *Apply*. Amira will switch automatically to the Recipes workroom (see Figure 5.8).
Test this recipe and apply it to the raw data again:

- Switch to the Project workroom by selecting its icon in the Workroom Toolbar.
- Go to Project > Remove All Objects from the main menu.
- Load AMIRA_ROOT/data/tutorials/chocolate-bar.am
- Switch to the Recipes workroom by clicking its tab in the Workroom Toolbar.
- Make sure that chocolate-bar.am is shown in the Input dropdown box of the Recipes panel
- Play the recipe on the chocolate-bar.am. The recipe will compute statistics as shown in Figure 5.9.
When you are satisfied with your recipe, save the recipe to be used again and shared.

- In the Recipes panel, click Save Recipe.
- Use the File Browser to navigate to the directory where you want to save your recipe. By default, recipes are stored in %APPDATA%/Thermo Fisher Scientific/Recipes, but you may save them to any other location.

## 5.2 Recipe from multi-outputs

A recipe can be created from several output data. To create such recipes, select the data in the object pool, right-click on one of them, then create a Create Recipe module from the Object Popup.

The number of inputs of the created recipe depends on how have been created the selected data, by comparing their history logs, merging them and/or concatenating them.

To note that, although all types of object in the object pool can be selected, a recipe can only be created by right-clicking on a data, excluding the camera path and the colormap type ones. All selected modules, as well as the camera path and colormap type data, are not taken into account in the creation of the recipe.
5.3 Using Breakpoints

Breakpoints can be used to halt the recipe at a particular step to let you manually change one or more parameters. In this tutorial, you will change the Measure Group in the Label Analysis module.

- Start Amira.
- Load AMIRA_ROOT/data/tutorials/chocolate-bar.am
- Attach a Volume Rendering to chocolate-bar.am
- Attach an Extract Subvolume module to chocolate-bar.am data and extract a small portion of the image (see Figure 5.10 and Figure 5.11).
- Load AMIRA_ROOT/data/tutorials/recipes/Bubble-Analysis.hxrecipe from the Recipes panel.
- Set the recipe input to the extracted image (i.e., chocolate-bar.view) and set a breakpoint at the Label Analysis step (see Figure 5.12).
• Run the recipe until it reaches the breakpoint. At this stage, it is not possible to change the input data or to quit the Recipes workroom. Only the properties of the tool are available for change. In port Measures, select Standard Shape Analysis. Click Play to continue (see Figure 5.13).

The recipe described in this tutorial can also be loaded directly from
5.4 Recipes in a TCL Command

When recipes have been saved on disk, they can be replayed from a TCL script. The following TCL commands are available:

- Set a recipe: `theRecipesController setCurrentMacro recipeName`
- Set an input to the recipe: `theRecipesController setInput numInput currentInput`
- Play the recipe: `theRecipesController playMacroNoPause`
- Get the last result of the recipes: `theRecipesController getLastResult`
- Enable/disable production mode: `theRecipesController setProductionMode value [0: off | 1: on]`

5.5 Recipe Limitations

There are some known limitations to the recipe mechanism:

- Step Deletion
  - You can only delete the first step or last step of a recipe except snapshot steps that you can always delete.
  - If a recipe’s last step has more than one input, then the step cannot be deleted. Deleting the step would imply having more than one recipe result as the deleted step inputs would become the new outputs. For now, the recipe mechanism can only handle one final recipe result.
  - If only one step remains in the recipe, it cannot be deleted.
    Example: A step with a module like Or Image cannot be deleted if it is the last step.
  - Input steps cannot be deleted.

- Step Insertion
  - For now, only snapshot steps can be inserted in a recipe.

- Default Display
  - The Ortho Views module cannot be used since there is only one instance of this module.

- Clean of recipe intermediate data
When an intermediate result of a recipe has a connection to a previous intermediate result, this last result must be explicitly exported to the Project workroom to not be removed by recipe cleaning process.

*Example:* This issue can appear when doing consecutively a *Generate Surface* step (generates a surface data) and then a *Surface Normals* step (generates a vector field data from the surface). The vector field data will imperatively have a connection to the surface data as it cannot exist without it. However the current recipe mechanism cannot detect such dependencies between data. So, the surface data may be removed by the automatic recipe cleaning process whereas it is still needed in a next step via the vector field. To avoid this kind of issue, in this example, the *Generate Surface* step result must be explicitly exported to the Project workroom, ensuring it to not being removed by the recipe cleaning process.
Chapter 6

Tutorials: Advanced Image Processing, Segmentation and Analysis

The following tutorials require an Amira XImagePAQ Extension license.

- **Getting Started with Advanced Image Processing and Quantitative Analysis** - the basics for using Amira for image processing and analysis
- **Cell Analysis Tutorial** - measure and quantify multiple objects such as cells, vesicles, or puncta (biomedical imaging)
- Examples:
  - **Measuring a Catalyst** - Masking and Distance Map
  - **Separating, Measuring and Reconstructing** - Watershed Separation
  - **Distribution of Pore Diameters in Foam** - Custom Measurement
  - **Average Thickness of Material in Foam** - Separation Thickness
- **Watershed Segmentation** - advanced Segmentation
- **More about Image Filtering** - reduce image noise or artifacts or enhance features of interest
- **More about label measures** - manage several groups of measures
- **Image Stack Processing** - visualizing and processing an Image stack in 2D
6.1 Getting Started with Advanced Image Processing and Quantitative Analysis

In this step-by-step tutorial, you will learn the basics for using Amira XImagePAQ Extension for image processing and analysis. The example used below can be easily extended to other applications and follows a typical workflow of image analysis:

1. Image enhancement
2. Features extraction
3. Data measures and analysis

This section has the following parts:

- Processing grayscale images
- 3D versus 2D stack interpretation
- Binarization of grayscale images
- Separation
- Analysis and measures
- Interactive selection
- Measure filters
- Sieves
- Label images
- Processing images in memory (in-core) and on disk (out-of-core)
- Scripting

You should be familiar with the basic concepts of Amira to follow this tutorial. In particular, you should be able to load files, to interact with the 3D viewer, and to connect modules to data modules. All these issues are discussed in Amira chapter 2 - Getting started. For routine use of Amira XImagePAQ Extension you may benefit from familiarity with Amira image filtering and segmentation (see chapter 3 - Images and volumes visualization and processing).

6.1.1 Processing images

First of all, you have to:

- Load in Amira the 3D microtomography volume `data/images/foam/foam.am` from the AMIRA_ROOT directory. The data object appears in the Project View.
- If Auto-Display is disabled, attach an Ortho Slice module to visualize the data. To do so, right-click on the green data icon. In the object popup, choose the category entry called Display, then double-click on the entry Ortho Slice (or click on Create). You can also use the search field and
type the first letters of Ortho Slice, then selecting the module in the list will automatically create it in the Project View.

- Attach two other Ortho Slice modules. In the Properties panel of the second Ortho Slice, select the $xz$ orientation and the $yz$ orientation in the Properties panel of the third Ortho Slice. See the resulting display on Figure 6.1.

![Figure 6.1: Initial data](image)

Loading the project data/tutorials/image-processing-advanced/GettingStartedBasics-1-LoadData.hx will complete the steps above.

Improving image quality is often necessary to obtain the best results with image analysis. The next step illustrates how to process images in Amira XImagePAQ Extension with an image filter commonly used for smoothing or noise reduction. You can learn more about image filters in tutorial section 6.8 - More about image filtering.

- Attach a Median Filter module to the data. (Use the search field and type the first letters of Median Filter, then select the module in the list.)
- Select 3D in the Interpretation port of Median Filter.
- Press on the Apply button.

Once computed, the result is stored in a new image object foam.filtered (see Figure 6.2).

- Attach the three Ortho Slice to the resulting image. To do so, change the Data of each slice in the Properties panel. See the resulting display on Figure 6.3.

Loading the project data/tutorials/image-processing-advanced/GettingStartedBasics-2-ImageProcessing.hx will complete the steps above.
6.1.2 Interpretation as 3D image or 2D image stack

Sometimes it can be useful to interpret the input data of an image processing algorithm as a 3D volume, or as a sequence of 2D planes. For instance, a number of image filters and image processing algorithms can be performed either on each XY-slice of the volume using a 2D kernel or on the whole volume using a 3D kernel. In some cases, it may be preferred to use 2D algorithm, either for performance or for more appropriate effect depending on the data and the desired outcome.

In many Amira XImagePAQ Extension modules, an interpretation port shows the state of the current module (i.e, XY planes or 3D). If the state of the port is XY planes, it means that the module will perform on each XY-slice. If the state of the port is 3D, it means that the module will perform on the entire three-dimensional image at once.

In some cases, the interpretation port cannot be changed (it is grayed), for instance, when processing can only be applied in XY planes.

6.1.3 Getting more help

Press the question mark button in the Properties panel of a module to display the module help. This help may be contextual depending on interpretation mode, or type of processing selected in the module.
6.1.4 Binarization

Binarization means transforming a grayscale image into a binary image (i.e., a label image with only interior and exterior materials). Threshold binarization is used when the relevant information in the grayscale image corresponds to a specific gray level interval. Thresholding is a simple segmentation method - more sophisticated automatic, semi-automatic or manual segmentation tools are also available in Amira. Threshold binarization can be done with the Interactive Thresholding module which prompts you to set the levels with a visual feedback.

- Attach an Interactive Thresholding module to the filtered data.

You can interactively modify the threshold values with immediate 2D or 3D visual feedback. The selected pixels appear in blue in the displayed image.

- In the Properties panel of the module, you can set the Intensity range port to the range 0-30 for instance.
- Check and uncheck the 3D option in the Preview Type port to get a 2D only or 3D preview (see Figure 6.4).
- Press the Apply button to start the module.

The output binary image named foam.thresholded is generated in the Project View (see Figure 6.5).

In the output binary image, all pixels with an initial gray level value lying between the two bounds are set to 1, all the other pixels are set to 0.

The Interactive Thresholding module has created a binary image. For binary images, the Amira XImagePAQ Extension displays the voxels of intensity 1 with a blue color. If you attach an Ortho Slice to the resulting image, an appropriate colormap is selected by default.
• Hide the Interactive Thresholding preview by switching off the orange visibility button in the module icon in the Project View or next to the module name in the Properties panel.
• Connect the first Ortho Slice to the thresholded data. See the resulting display on Figure 6.6.

Loading the project data/tutorials/image-processing-advanced/GettingStartedBasics-3-Binarization.hx will complete the steps above.

6.1.5 More about binary images

In a binary image, all pixels that meet some set of conditions (here the condition is pixel intensity within the two bounds set on Interactive Thresholding) are set to a value of 1 (the pixels of interest), and all other pixels are set to 0 (the background). There is no particular type for binary images in Amira XImagePAQ Extension binary images are simply label images with only one label (8/16/32-bit per voxel with value 1; exterior with value 0). However, some of Amira XImagePAQ Extension modules may explicitly require binary image as input data.

6.1.6 More hints about binarization

(This section is optional and is not required reading for completing the subsequent tutorials.)
Extensive tools are available in Amira XImagePAQ Extension for effective data binarization and segmentation of images. The process can be automated in many cases, possibly by combining a number of steps, sometimes requiring user input. In some cases, it may be necessary or easier to proceed to semi-automatic or manual segmentation: in particular, the Segmentation Editor is designed for that purpose (note that the Segmentation Editor only supports 8-bit label images). Also keep in mind that improving image acquisition might be much easier than analyzing bad images.

Here are some of the Amira XImagePAQ Extension modules that can facilitate automated binarization:

- **Auto Thresholding** automatically computes a threshold. You can choose the criterion best suited to your data, generally factorisation.
- **Interactive Top-Hat** is a powerful tool for segmenting areas with non uniform backgrounds, when simple thresholding fails to capture wanted features without unwanted noise. A top-hat transform can be seen as a “local thresholding”. Top-hat results are often combined with threshold results using logical operation OR Image.
- **Hysteresis Thresholding** is used to achieve intermediate binarization between low and high thresholds defining a safe retained area and a rejected area. You may use, for instance, Interactive Thresholding interface to interactively choose the thresholds before using Hysteresis Thresholding. See also the Canny Edge Detector module.
- Many image filters like gradient or Laplacian can be used to help binarization, e.g., for Edge Detection.
- Filtering regions based on measures, as shown later in this tutorial, can also be a powerful technique for segmentation.

After binarization, it may be necessary to separate some objects, as shown in the next section.

### 6.1.7 Separation

In the example data set, some of the pores in the foam appear to be touching, but ideally, should be separated for proper analysis. Thresholding cannot avoid this type of output when the acquisition data is too coarse or noisy, because the gray levels of the considered objects are not uniform enough across the volume, or because the resolution is too low to distinguish some objects’ boundaries. You can use the Separate Objects module to separate connected particles.

- Attach a Separate Objects module to the thresholded data.
- Set the Marker Extent port value to 1 instead of the default value 4. This is a contrast factor that controls the size of seeds marking objects to be separated. Increasing this value can merge some markers and therefore decrease the number of separated objects.
- Then press the Apply button. A foam.separate data is generated in the Project View.
- Attach the first Ortho Slice to the new data. See the resulting display on Figure 6.7.

The principle of the Separate Objects module is to compute watershed lines on a distance map. The
Separate Objects module is a high-level combination of the watershed, distance map and H-Maxima. It can be used as a simple and straightforward separation tool, satisfying in many cases. You may notice, however, that some separation may be missing or unwanted, in particular with non-convex shapes (considering also 3D). For more details and advanced separation, see Example 2: Separating, Measuring, and Reconstructing Individual Objects - Pores in Foam.

![Figure 6.7](image)

Figure 6.7: The particles are now separated

Loading the project data/tutorials/image-processing-advanced/GettingStartedBasics-4-Separation hx will complete the steps above.

### 6.1.8 Analysis

You can then use an analyze module to get the volume, surface area, mean value, number of voxels, etc., individually for each separated particle. This analysis on the stack of images is undertaken by using the Label Analysis module to extract statistical and numerical information, including the measure of objects.

- Attach a Label Analysis module to the separated data.
- Set foam.am as Intensity Image in the dedicated port of the module.
- Press the Apply button.

A new label image data object foam.label is created in the Project View, and the Tables panel is displayed, showing a spreadsheet-style table of results: the analysis foam.Label-Analysis, also created in the Project View (see Figures 6.8 and 6.9).

The toolbar offers the possibility to:

- copy parts of the table
- export the spreadsheet in several formats
• sort columns in ascending or descending order
• plot the histogram corresponding to a measurement (see below)
• do label seek (see below section 6.1.9 - Interactive selection).

The basic measures (as selected in the Measures port of the module) are displayed in the Tables panel as shown below (Volume3d, Area3D, etc.).

• Select the Volume3d column in the lower spreadsheet.
• Press on the histogram button of the toolbar (see Figure 6.10).

Figure 6.8: Analysis network

Figure 6.9: Analysis spreadsheets

Figure 6.10: Analysis Panel toolbar: the histogram button
A window opens, displaying the Volume3d histogram as shown on Figure 6.11.

![Volume3d histogram](image)

**Figure 6.11**: Volume3d histogram

In the *Measures* port, *basic* is a group of measures that contains the most commonly used measures: Volume3d, Area3d, BaryCenterX, BaryCenterY, BaryCenterZ and Mean. It is possible to define new groups of measures, composed of pre-defined measures but also of user-defined measures. To learn more on the subject, please refer to the dedicated tutorial in chapter 6.5 - Further Image Analysis.

**Note**: By default, if the unit management of Amira is not enabled, the results are given in the same units as the voxel size was specified in. You can enable the unit management of Amira to display data and measurements with units. Please refer to chapter 10.2.9 - Units in Amira for all the details on how to use the unit management in Amira.

Loading the project data/tutorials/image-processing-advanced/GettingStartedBasics-5-Analysis.hx will complete the steps above.

### 6.1.9 Interactive selection

Amira XImagePAQ Extension allows you to link the images in the 3D viewer to their corresponding rows in the analysis panel in order to locate individual objects with corresponding measures.

![Analysis Panel toolbar: the label seek button](image)

**Figure 6.12**: Analysis Panel toolbar: the label seek button

- Click on the label seek button of the analysis panel toolbar (see Figure 6.12). A new *Ortho Slice* is automatically attached to the separated image and displayed in the 3D viewer, as well as a point dragger (see Figure 6.13).
Select a cell of the analysis lower table. The point dragger will move to the corresponding object location in the 3D view. If the histogram of one of the analysis measures is displayed, a vertical line appears that displays the position and value of the selected row, as shown on Figure 6.14.

In the viewer window, you can move the dragger using the rectangular handles, then upon button release, the analysis table will highlight the corresponding object row. In order to move the dragger, you must set the viewer into interaction mode (press the ESC key). Then move the mouse over one of the dragger’s crosshairs and press the left mouse button. The color of the picked crosshair changes. The movement of the dragger is restricted to the corresponding plane.

You can also click with the middle mouse button over a pickable object in the scene displayed in the 3D viewer, for instance, over a particular pore on a displayed slice: the dragger will move to the picked point and the corresponding spreadsheet row will also be highlighted.

![Figure 6.13: Point dragger (brown lines crossing) in the 3D viewer corresponding to row 82](image)

### 6.1.10 Filtering based on measures

You can filter particles displayed in your 3D viewer. For example, you can decide to visualize only particles which \( \text{Volume3d} \) belongs to a specified range.

- Attach an *Analysis Filter* to `foam.Label-Analysis`.
- Connect the *Image* port to `foam.label`.
- Create a new filter by entering `Volume3d >= 30000` in the *Filter* port. To insert `Volume3d` in the formula you can type it or double-click on it in the list displayed below the formula field.
- Press on the *Apply* button.

This creates a new analysis with fewer objects.
You can verify that fewer objects have been created by connecting the Ortho Slice to the new label image `foam.label-filtering`, as shown on Figure 6.16.

**Tip:** Filtering driven by measures can be a powerful tool for data segmentation. It allows you to select or eliminate regions based, for instance, on size, shape factor, orientation, or combinations of several criteria.

Loading the project `data/tutorials/image-processing-advanced/GettingStartedBasics-6-FilterAnalysis.hx` will complete the steps above.
6.1.11 Classifying measures with sieves

You can define a set of value ranges, that can then be used for displaying a histogram using this distribution, or for creating a new label image showing the classification.

- Attach a Sieve Analysis module to foam.Label-Analysis.
- Connect the Data port to foam.label.
- Add a value by changing the Number of values to 4.
- Modify the suggested values by editing them or by moving the corresponding marker in the histogram. You can also press on the Detect button to get regular intervals.
- Press the Apply button. A new label image foam.Sieved has been created.
- Display the label image using a Volume Rendering module, as shown on Figure 6.18.

Figure 6.16: Filtering result

Figure 6.17: Sieve Analysis workflow
6.1.12 Label images

- Hide the *Volume Rendering*
- Attach the first *Ortho Slice* to the label image `foam.label`.

In the *label* image created along with the result spreadsheet, each particle has been identified and assigned a unique index. This label data is stored in this case as a 16-bit label image. Such images are displayed by default using a cyclic colormap so that particles in close proximity are more likely to be shown in a different color, as shown on Figure 6.19.
**Note:** Amira label images coming from the *Segmentation Editor* and *Multi-Thresholding* modules are 8-bit per voxel label images.

### 6.1.13 Processing data on disk

In some cases, you may decide to work with Visilog (.im6) data format in order to be able to “keep data on disk” when opening data files, instead of loading data fully in memory. That way, some Amira XImagePAQ Extension modules can, for instance, load and process image data slice by slice (out-of-core), avoiding the need to load the full data in memory (in-core). This allows processing of data that is much larger than the available memory on your system, at the expense of processing time.

By default, module outputs will be created in the same way as the module inputs. As a consequence, in order to process data fully on disk (input and output), you need to choose to *Stay on disk* when opening the input data.

In addition to Visilog format files, you can use *Stay on disk* with other data formats such as .lda. You can also load uncompressed Amira files, Raw files as *Large Disk Data*.

### 6.1.14 Scripting

A complete processing sequence can be put in a script in order to automate analysis for routine tasks. For details about scripting with Amira XImagePAQ Extension see the chapter 6.4 - Example 3: Separating, Measuring and Reconstructing.

### 6.1.15 Conclusion

This tutorial has introduced you to:

- Amira XImagePAQ Extension interface modules and help menu,
- grayscale image processing modules,
- binary image processing modules,
- label images for storing indexed (segmented) images,
- 3D versus 2D stack processing modules,
- in-core versus out-of-core processing,
- how to compute measurements analysis,
- using filters to pare down segmented data,
- using sieves to interpret your measurements,
- scripting.

These concepts can be extended in countless ways to tackle new challenges. Try to relate your image processing problems back to this simple workflow:
• image processing to make data easier to binarize,
• binarization by tools like thresholding or top-hat (and sometimes combining two techniques),
• labeling to index all of the disconnected objects,
• measuring key properties for all indexed objects,
• analysis of measured data by visual inspection as well as filtering or sieving.

This introduction has highlighted how Amira XImagePAQ Extension can be used to perform sophisticated segmentation and analysis of 3D data, but there are many more processing operations and measurements in addition to those presented here.

Amira XImagePAQ Extension gives you this extensive toolkit so that you can map the appropriate tools to any processing challenge that confronts you.

6.2 Cell Analysis Tutorial

In biomedical imaging it is sometimes required to measure and quantify multiple objects such as cells, vesicles, or puncta. This tutorial shows how to utilize the Amira XImagePAQ Extension extension modules to perform an automatic segmentation of the objects, separate clustering items, and extract quantitative information, including that of their shape. It will cover the following topics:

• Create a binary segmentation of the objects (cell bodies)
• Separate clustering cells and label them individually
• Get number, size, and position of the cells
• Measure cell density
• Extract shape parameters from the cells
• Filter a label image according to shape parameters, reconstruct and visualize the filtered label image as surface model

6.2.0.1 Visualizing the data and creating a binary image

• Load data/tutorials/multicomp/cellbodies.am into the AMIRA_ROOT directory.
• If Auto-Display is disabled, attach an Ortho Slice module to the cellbodies.am object. Browse through the slices using the Slice Number port or use the interact mode in the viewer.

We see a number of bright spheroid structures embedded in a dark background. These bright structures are cell bodies (somata) of neurons from the rat cortex. The neurons have been stained with a selective fluorescent dye and imaged with a confocal microscope. The data are kindly provided by Marcel Oberlaender and Bernd Sakmann, Max Planck Florida Institute.

As a first step we need a binary segmentation of the image into foreground (cell bodies) and background voxels. Typically this is done by thresholding. The disadvantage of a simple threshold, however, is that if the threshold gray value is selected too low, unwanted background signal gets assigned
Figure 6.20: Confocal image stack of rat cortex cell somata visualized with Ortho Slice
Figure 6.21: Binary segmentation of the image stack. The label field is shown over the gray image using module Color Wash to the foreground. On the other hand, if the threshold is selected too high, one might miss faintly stained cells. We tackle this problem with a module that uses two threshold values, one for detecting the bright regions and a second one that grows those regions until the lower threshold is reached.

- Connect a Hysteresis Thresholding module to cellbodies.am.
- Enter 70 and 112 into the Thresholds (Low/High) text fields. Click Apply.
- Add a Color Wash to Ortho Slice. In Color Wash select Fusion Method: Weighted Sum, connect port Data to cellbodies.binary and set Weight Factor port to 0.7.

Using module Color Wash with Ortho Slice allows one to quickly review what has been segmented. You may blend between the gray values and the labels by moving the Alpha slider of Color Wash module. When browsing the slices we note that some cell bodies have small unsegmented regions inside. To fill those holes we will use the following sequence of operations:

- Connect Dilation to cellbodies.binary. Set Size[px] to 1, click Apply.
- Connect Fill Holes to cellbodies.dilated. Set Interpretation to 3D, click Apply.
- Connect Erosion to cellbodies.filled. Set Size[px] to 1, click Apply.

The sequence of morphological operations Dilation (Grow) - Filling - Erosion (Shrink) is useful to close and fill incompletely labeled objects. If necessary, the number of dilations (grow) can be in-
creased in which case the number of erosions (shrink) has to be increased by the same amount. Use the Size[px] ports in modules Dilation and Erosion for that purpose.

6.2.0.2 Separating cell clusters and labeling

We note that in cases where cells are densely packed some of them have been segmented into a single blob. Also, we cannot distinguish between individual cells since they all belong to the same material. Thus, as a next step, we need to separate clustering cell bodies and label them individually. Here we show how this could be accomplished using a watershed transform on the distance map of the binary labelled image.

For the watershed transform to work an image with ”troughs”, ”crests”, and ”saddles” in the intensity domain is needed. We can achieve this by calculating an inverted distance map of the labels object. In a distance map the value of each voxel denotes the closest distance to the region border. Inverting such a map yields an image where border voxels have high intensities thus forming a ”crest” whereas center voxels become increasingly darker and therefore constitute the ”troughs”.

• Connect a Distance Map module to the cellbodies.eroded object, enable the float option in port Chamfer Weights and click Apply.
• Attach Arithmetic to cellbodies.DistField object, enter $-A + 6.82$ into the Expr. text field and click Apply.

Subtracting all voxel values from the maximum (as inferred from the Info port of the distance transform) inverts the data with a minimum at zero.

• Attach Hierarchical Watershed to the result of the Arithmetic module. Enter in port Input threshold a value of 0.5 and a value of 1.75 in port Minimal depth. Click Apply.
• In order to view the result re-connect the Data connection port of Color Wash with the output of module Hierarchical Watershed with the Result.regions icon, change the colormap in port Colormap to labels256.am.

Finding good values for Input Threshold and Minimal Depth typically requires some experimentation. The first computation using a particular value of the Threshold will take some time depending on the complexity of the image. Subsequent re-computations with different values of port Minimal depth then are much faster. When playing around with those values you will note that with increasing Minimal depth, increasing numbers of neighboring cells fuse into single regions. Decreasing Minimal depth, in contrast, tends to over-segment objects. The values of 0.5 (threshold) and 1.8 (depth) are a good compromise for this data set. (load project)

6.2.0.3 Extracting quantitative measures from the labeled image

Getting number, size, and positions of the cell bodies

The first part of the analysis aims to get number, size, and positions of the cell bodies.
Figure 6.22: Labelling segmentation of the image stack. The label field is shown over the gray image using module Color Wash.
• Connect Material Statistics to object Result.regions, connect the Field connection port of that object with cellbodies.am and click Apply.

• Select the newly created object Result.MaterialStatistics and click the Show button.

Measuring cell density
With the locations of our objects calculated we could ask: What is the local density of cells? Module Point Cloud Density can measure the local density elements in a point cloud. However, this requires that the positions of the cells be represented as vertices of a Point Cloud object.

• Connect a Spreadsheet to Point Cloud module with the spreadsheet object and click Apply.

• To visualize point cloud object connect a Point Cloud View module to it. Configure the labels256.am colormap in port Colormap, turn on the plates option and set Sphere scale to -0.5.

Now that we have the point cloud object, we can calculate its density, that is, how many cells are there per unit volume.

• Connect a Point Cloud Density module to the *.Cloud object. Click Apply.

• Visualize the resulting point cloud object by reconnecting module Point Cloud View with the *.Density object. Select physics.icol in port Colormap and in the Color drop-down menu choose the Density [d] item.

(load project)

Plotting a histogram of staining intensity
What is the distribution of mean staining intensity in the cells? To answer that question we use the output of the Material Statistics module.

• Right-click the *.MaterialStatistics object and select from Histogram.

• In the Properties of Histogram make the following settings: Data Channel: Mean, uncheck logarithmic of port Plot options, Max Num Bins: 60. Finally, press the Reset button in port Range to update the range for the histogram.

• Click Apply.

Extracting shape information from labeled regions and their visualization
While Material Statistics provided us with basic information on the cells, the following analysis aims to gain information on the shape of the objects. The Amira XImagePAQ Extension extension provides a powerful label analysis module that allows extracting the parameters of an ellipsoid for each region. Those parameters as well as derived measures such as elongation, flatness, and anisotropy for each object will be written into a spreadsheet object.

At this point it is recommended to clear the Amira Project View (Project/Remove All Objects) and load the project data/tutorials/multicomp/ShapeAnalysis-start.hx. The remainder of this tutorial assumes
Figure 6.23: The positions of the cell bodies are represented by spheres and the coloring indicates the local density of cell bodies.

Figure 6.24: The histogram shows the distribution of mean staining intensity of the cell bodies.
that you did so. Of course, it is also possible to proceed with your current results. In that case, however, names of data objects as mentioned in the text can be different.

- Connect Label Analysis with `cellbodies.labeledRegions.am`.
- In port Measures select the Standard Shape Analysis item and click Apply.
- Right-click the output (`*.Label-Analysis`) object and select the Spreadsheet to Point Cloud entry.
- In Spreadsheet to Point Cloud module, check the Bounding Boxes option in port Output, select the Fill Bounding Boxes button in port Tensor and set port Value to EigenVal1. Click Apply.
- Right-click `cellbodies.labeledRegions.Cloud` and choose the Tensor View module. In Tensor View, uncheck the option FA in port Scale by value. Set `physics.icol` colormap with range 0..1. Click Apply.
- In order to visualize the bounding boxes attach a Line Set View module to the `cellbodies.labeledRegions.BoundingBoxes` object.

(load project)

**Filtering labeled regions according to label measures parameters**

- Reload project data/tutorials/multicomp/ShapeAnalysis-start.hx
- Connect a Label Analysis module to `cellbodies.labeledRegions.am`.
- In port Measures select the Standard Shape Analysis item and and click Apply.
- Connect a Analysis Filter module to the `*.Label-Analysis` object.
- In the Properties of Analysis Filter type `Volume3d >= 300` into the expression field of port Filter.
- Click Apply to create two new data sets, `*.Analysis-Filter` being the spreadsheet containing only the items conforming to the expression, and `*.label-filtering` being the corresponding label field.

In this way we extracted all objects larger than 300 (cubic microns) from the original label field.

In the analysis above, the results might be biased by the fact that many items have not been imaged completely because they extend to the outside of the image volume. To tackle this, we would like to remove all objects in the volume intersecting the bounding box. To do so, we extend our expression by another condition. We start with typing `&&` (logical AND) into the expression text field. We scroll down in the list of measures to spot the BorderVoxelCount item and double-click it. Finally we type `BorderVoxelCount < 10` into the field so that the complete expression now reads `Volume3D > 300 && BorderVoxelCount < 10`. **Tip:** In order to speed-up writing the expression you can double-click an item in the list of measures on left. Also, to find a proper numerical value you may drag the red line in the plot window with the left-mouse click. A double-click on the line prints the current value at the cursor position of the expression field.

How do the filtered objects look like and where are they located within the volume? To answer that we create surface model from the filtered label field.

- Right-click the `cellbodies.labeledRegions.label-filtering` icon and select Generate Surface and
Figure 6.25: Visualization of the result of *Standard Shape Analysis*. Ellipsoidal representations of the labeled regions are being visualized with *Tensor View*. Bounding boxes aligned with the main axes of the ellipsoids depict the spatial extent of each region.
**Figure 6.26**: User interface of module *Analysis Filter*. The module provides a text field that allows entering a filter expression. Available measures are listed in the box on the left hand side that, when selected, display a histogram of the measure in the plot window on the right. The red line in the plot can be dragged along the plot’s ordinate with the corresponding *Count* value being shown in the *value* field. Double-clicking the red line prints the current value at the current cursor position.
click Apply.

- Connect a Surface View with `cellbodies.labeldRegions.surf` object.

**Automating the display update for different filter expressions**

In order to quickly view different filter expressions, the project can be configured to automatically update when a filter expression has been changed.

- Select *Analysis Filter* in the Project view and check *auto-refresh* at the bottom of the Properties area
- Select *Generate Surface* in the Project view and check *auto-refresh* at the bottom of the Properties area

Now each time the filter expression is changed, a re-computation of the surface model will be triggered. This allows you to quickly review filter settings.

(load project)
Figure 6.27: Surface reconstruction of the filtered label field.
6.3 Example 1: Measuring a Catalyst

This tutorial illustrates more techniques using Amira XImagePAQ Extension:

1. Using masks to isolate object of interest.
2. Using distance map.

To follow this tutorial, you should have read the first tutorial chapter 6.1 - Getting Started with Advanced Image Processing and Quantitative Analysis and be familiar with basic manipulation of Amira. Display module visibility can be managed in the usual way with Amira by clicking on the orange square button in the icon visible in Project View, or beside the module title in the Properties panel. See chapter 10.1.9 about Project Views.

The 3D image used in this example is acquired by microtomography: an almost spherical support contains catalyst and pores. The catalyst appears with dark levels in the image (low intensity voxels). The pores and background appear with bright levels (high intensity voxels). Intermediate gray levels correspond to the support.

The goal of this example is to get a distribution of distances between the catalyst voxels and the background (exterior). Here, a difficulty is the exterior intensity is close or identical to the intensity within the pores, which prevents the use of simple thresholding to isolate exterior. Moreover, some pores are connected with exterior, which prevents the use of "flood fill" approaches like magic wand of the Segmentation Editor, or the Reconstruction from Markers module.

Note: in this tutorial, you will find hints on how to manage an arbitrary region of interest. Another common example of a similar problem is to isolate the pore space of a rock core sample from core exterior, in order to compute rock porosity, for instance.

The process is split in several steps/sections that describe a step-by-step measurement workflow:
6.3.1 Object Detection and Masks

- Start by loading `data/tutorials/image-processing-advanced/Catalyst.am` from the `AMIRA_ROOT` directory.
- If Auto-Display is disabled, attach an Ortho Slice module to the Catalyst.am image icon in the Project View to display this image.

Loading the project `data/tutorials/image-processing-advanced/CatalystDistribution-1-LoadData.hx` will complete this tutorial step (see Figure 6.29).

![Initial Image](image)

**Figure 6.29:** The initial image

Now, you can start with the first step used in this example for detection of the object: *thresholding*, then *closing* in order to “fill” the object and prepare a mask. The next section will give more hints on possible ways to create masks and arbitrary region of interest for your data.

**Thresholding**

- Attach an Interactive Thresholding module to the Catalyst.am module.

*Example 1: Measuring a Catalyst*
For searching an appropriate threshold, you can directly change the \textit{Intensity Range} port. According to the \textit{Preview Type} port, the 2D or 3D preview is interactively rendered. Remember to check through the whole volume by changing the \textit{Preview Slice Number} and \textit{Preview Orientation} ports. Other Amira modules can also be helpful for this task (see Section 3.2 Visualizing 3D Images). Here, thresholding the image between 0 and 225 gives a binary image where:

- intensity level = 1 \rightarrow support or catalyst (material),
- intensity level = 0 \rightarrow pore or exterior background.

![Figure 6.30: The project view](image)

Applying the \textit{Interactive Thresholding} module will create a binary image (image label with only interior and exterior materials) as described below:

- Select the \textit{Interactive Thresholding} module in the Project view, then change the \textit{Intensity Range} values to the range 0-225 by using the slider handles or the text areas of this port.
- Change the \textit{Preview Slice Number} port to 45 by dragging the slider of this port.
- Press the \textit{Apply} button to start processing.
- Check 3D in the \textit{Preview Type} port to get a 3D preview and uncheck 3D to undo this preview.
- Attach the \textit{Ortho Slice} currently linked to \texttt{Catalyst.am} to the resulting image, by click on and dragging the link of Ortho Slice to \texttt{Catalyst.thresholded}; an appropriate colormap will be selected by default.
- Hide the \textit{Interactive Thresholding} preview by clicking on the orange square of this module in the Project view.

Loading the project \texttt{CatalystDistribution-2-InteractiveThresholding.hx} will complete this tutorial step (see Figure 6.31).

\textbf{Morphological: Closing object}

In order to detect the object shapes, you can apply morphological modules now. The mathematical morphology modules are transforms based on shape and size criteria.

The morphological \textit{Closing} module applied on a binary image gives another binary image where:

- small holes inside objects are filled,
- objects boundaries are smoothed,
- close objects are connected.

\textit{Example 1: Measuring a Catalyst}
The Closing module actually makes a dilation of the binarized regions, followed by an erosion: intuitively, the dilation fills holes and reconnects separated regions, then the erosion restores original exterior shape.

Here are the steps to fill the pores of the object:

- Attach a Closing module to Catalyst.thresholded.
- In order to fill any holes inside the object, you absolutely have to set the Size port to 6 (size of the structuring element). Such specific values may be found with a few trials and by checking through the whole volume by sliding an Ortho Slice for instance.
- Then push the Apply button to create the resulting binary image.
- Attach the already existing Ortho Slice to Catalyst.closing.

Loading the project CatalystDistribution-3-Closing.hx will complete this tutorial step (see Figure Example 1: Measuring a Catalyst
Note: The artifact you may notice on the right side of the image above is due to the dilation too close to image border. To prevent this, the background border around the object should be larger than the size of closing. That could be easily solved by using the image Crop Editor: in this example, you could set, for instance, Adjust to 10, then uncheck Replicate for Add mode and set Pixel value to background intensity (i.e., 0); then pressing the Enlarge button would add a 10-voxel border. However, you can ignore this enlargement step in this tutorial.

6.3.2 More about Region of Interest and Masks

It is often necessary or useful to restrict measures or processing to a subset of the data.

If the subset is an axis-aligned box, you can use the following tools:

- Many modules support a Region Of Interest (ROI) input. You can attach a ROI Box module to your data, then connect the ROI input of the display or compute module to the ROI Box module.
- The image Crop Editor can cut or extend your data.
- The Extract Subvolume module copies a portion of your data in memory, possibly sub-sampled.

If you need an arbitrary mask or region of interest - for instance a cylindrical ROI, you can use the following tools:

Example 1: Measuring a Catalyst
A number of modules sorted into *Image Processing/Image Morphology* from the popup menu of every binary image can be used to create or combine masks like the one shown above. Other examples include *Convex Hull* (applies slice by slice), *Fill Holes, Reconstruction from Markers*.

- The *Volume Edit* module is used to modify a volume with interactive tools like cylinder. It may also be used by script.
- The *Segmentation Editor* has a number of useful tools that can be used to quickly create masks, like brush, shaped lasso, *Selection/Interpolate*.

### 6.3.3 Using Distance Map

The second step is to compute a distance map of the catalyst. The next section gives more hints about distance maps.

Applying the distance map algorithm on a binary image gives a gray level image where each voxel intensity represents the minimal distance in voxels from the object boundary. For a given voxel intensity of the object distance map:

- Intensity level $= 0$ -> background
- Intensity level $= 1$ -> object envelope
- Others low level intensity -> part of the object close to the object envelope
- Others high level intensity -> part of the object far from the object envelope

Now, you can create this distance map as follows:

- Attach a new *Chamfer Distance Map* module to *Catalyst.closing*.
- Set the *Interpretation* to 3D and click on *Apply*.
- Attach a new *Ortho Slice* to the result (*Catalyst.distmap*) to see the object’s distance map.

Loading the project CatalystDistribution-4-DistanceMap.hx will complete this tutorial step (see Figure 6.34).

**Masking**

- Apply a *Interactive Thresholding* module to the initial image *Catalyst.am*.
- Set *threshold* between 0 and 100 and click on *Apply*.

This gives a binary image (*Catalyst2.thresholded*) where:

- Intensity level $= 1$ -> catalyst,
- Intensity level $= 0$ -> support, pore or background.

Loading the project CatalystDistribution-5-InteractiveThresholding.hx will complete this tutorial step (see Figure 6.35).
Masking will be used to compute the restricted distance map of the catalyst. The mask operation takes a gray level image for first input, a binary image for second input (mask image), and provides a gray level image for output where:

- each black voxel of the mask image is set to 0 in the output image,
- each blue voxel of the mask image is set to the initial level from the gray image.

Masking the distance map image by the catalyst image gives a gray image where:

- each non null intensity represents a voxel of the catalyst,
- the intensity value is equal to the distance in voxels from the object envelope.

You can create a such mask as follows:

- Apply a Mask module: the first input is Catalyst.distmap (the distance map image), and the second input is the catalyst binary image obtained previously Catalyst2.thresholded.
- Attach a new Ortho Slice to the result to see the object’s distance map. To get a better rendering, you can map the colormap range of the Ortho Slice to the full range (min-max) of Catalyst.masked: set 0...93 as min-max in the Colormap port.
Loading the project CatalystDistribution-6-Masking.hx will complete this tutorial step (see Figure 6.36).

6.3.4 More about Distance Maps

Distance maps (also called distance transforms) are powerful tools for a number of image processing techniques. The computed distance may be a discrete approximation (chamfer map) for faster computation. Amira provides several versions of distance map that you may check for your specific purpose. Most of available distance modules are available in the subsection *Image Processing* of the module

*Example 1: Measuring a Catalyst*
popup menu:

- Chessboard Distance Map (2D/3D chessboard),
- 2D/3D Chamfer Distance Map (chessboard and diagonal),
- Geodesic Distance Map (based on mask to hide particular parts),
- 2D/3D Closest Boundary Points,
- As a special case, Propagation Distance and related modules in Image Processing/Image Morphology group,
- Distance Map, using either chamfer or euclidian distances,
- Image Processing/Distance Maps/Distance Map on Disk Data that can operate only legacy LDD disk data.
- Propagation Distance (browsed-voxel distance) is referenced into the subsection Image Processing/Image Morphology of the module popup menu.

### 6.3.5 Measurement Distribution

You calculated a chamfer map measuring distances based on voxel units. For consistent results, you have to consider the voxel calibration: multiplying the distance image by the voxel size converts the
image intensities into the metric system (micrometers).

The module group *Image Processing/Arithmetics Operations* is available for operations between two images or between an image and a constant.

**Tip:** the *Arithmetic* module also provides a flexible way to perform calculations with images.

You can get the distribution of the distances now:

- Use the *Multiply by Value* on *Catalyst.masked* as first input (*Input Image 1* port). Set the *Value* port to 5 (assuming a voxel size of 5 micrometers).
- Click on Apply to get *Catalyst.mult* as result.
- Retrieve the maximum value with the *Info* port displayed in the Properties panel when selecting the image icon in the Project View.
- Attach an *Histogram* module on *Catalyst.mult* to compute and plot for each gray level i, the number of voxels at intensity i. The number of points per each level will be graphed as a histogram. Set the *Range* port to \{3,400\} and the *Max Num Bins* port to 80. Uncheck *logarithmic* in the *Options* port and click on *Apply* to display the histogram window. Using the File menu, you can take a snapshot of the histogram or save the histogram data to a csv file.
- Applying an *Histogram* module on the catalyst distance map generates a graph showing the number of catalyst voxels located at a given distance from the object envelope.

Loading the project *CatalystDistribution-7-Histogram.hx* will complete this tutorial step (see Figure 6.37).

![Figure 6.37: Distribution of the distances](image)

### 6.4 Example 2: Separating, Measuring and Reconstructing

This tutorial gives more details about object separation and extraction of geometric information:

1. *Principle of the Watershed Algorithm, an essential tool for image processing*
2. Prior Segmentation
4. Separation Troubleshooting
5. Filtering Individual Objects
6. Geometry Reconstruction

To follow this tutorial, you should have read the first tutorial chapter 6.1 - Getting Started with Advanced Image Processing and Quantitative Analysis and be familiar with basic manipulation of Amira.

The 3D image used in this example was generated using data from several slices of foam.

The aim of the example is to isolate and quantify these bubbles, in a more detailed way than the *Getting Started* example, for better controlling on the results. Separation is essential in a number of cases for compensating too low image resolution, noise, or intensity variations across the image.

![Figure 6.38: Foam image](image)

### 6.4.1 Principle of the Watershed Algorithm

The watershed algorithm is a powerful method that has many applications in image processing, for instance, for automated objects segmentation or separation.

This algorithm simulates the flooding from a set of labeled regions in a 2D or 3D image. It expands the regions according to a priority map, until the regions reach at the watershed lines. The process can be seen as progressive immersion in a landscape.

This algorithm depends on two inputs:

1. A label image containing labeled marker regions that are used as seed areas for the flooding. There will be at the end of the process as many separated object as markers labeled differently.
These are like rivers for which one want to retrieve the catchment area.

2. A gray image playing the role of the landscape height field or altitude map that controls the flood progression and finally the location of watershed separations. These separations are located on the crest lines between valleys of our landscape.

Different applications can be achieved by carefully choosing both inputs: markers and priority map. An example is the Separate Objects module used for separating foam pores in the Getting Started tutorial. It first computes a distance map (see the chapter 6.3 - Measuring a Catalyst tutorial for more about distance maps). This distance map provides the priority map input for a watershed process. Maxima regions of the distance maps - the most inner areas of the pores - provide the markers input used for the watershed. The process is described in details in the next section.

### 6.4.2 Prior Segmentation

First, you need to segment the data, in order to get a binary image of the pores.

- Start by loading in Amira the image stack data/images/foam/foam.am from the AMIRA_ROOT directory.
- You might want to perform some kind of noise reduction on your data. You could typically apply a filter such as Median Filter with 3D Interpretation; the median filter is a non linear digital filtering technique, often used to preserve edges while removing noise. Such noise reduction is a typical pre-processing step to improve the results of later processing like segmentation or edge detection.
  Nevertheless, you can skip this stage in this example and start creating a binary image by thresholding.
- Attach an Interactive Thresholding module to the foam.am object in the project view.
- By using the cursors of the Intensity Range port slider, set the low and high threshold levels to 0 and 38 and click on Apply. In the preview, you can see that the resolution and intensity distributions in the image do not allow you to directly segment separated pores: some pores
remain connected, whatever threshold is chosen, unless too much noise is left in pores.

- Attach an Ortho Slice to `foam.thresholded` to visualize the result.

Loading the project WatershedSeparation-1-Thresholding.hx will complete this tutorial step (see Figure 6.40).

![Figure 6.40: Binary image](image)

By dragging the cursor of the Slice Number port, you may notice some artifact holes (e.g., in slices 4, 5, 6), mostly related to higher intensity rings crossing the pores that appear on the gray image. Attach an Ortho Slice to the gray image and set Mapping type to histogram to highlight these. Hide or remove the previous Ortho Slice.

Rather than doing upstream correction of gray image or even acquisition, it may be more effective in some case to correct the binary image, for instance filling holes.

Optionally, it is recommended to fill holes within objects to separate because the separation method based on distance map can be sensitive to these artifact holes.

- You can attach a Fill Holes module to `foam.thresholded`.
- Set Interpretation to 3D and click on Apply to get `foam.filled` as result.

### 6.4.3 Separation using Watershed step by step

Starting from binary-image, you can proceed to pores separation now. You will compute a distance map, create markers from maxima regions of the distance map, then apply the fast watershed algorithm.

- Attach a Chamfer Distance Map module to the binary-image object (`foam.thresholded`).
- Set Interpretation to 3D and click on Apply to get foam.distmap as result.
- Attach an Ortho Slice to control the result. Each voxel within a pore receives a value corresponding to its distance to the black background (the foam).

Loading the project WatershedSeparation-2-DistanceMap.hx will complete this tutorial step (see Figure 6.41).

![Figure 6.41: Chamfer distance map](image)

- Attach a H-Maxima module. Leave the Contrast port to default value (4) and click on Apply.
- Attach an Ortho Slice to foam.hMaxima and set the Transparency type to Alpha.

Loading the project WatershedSeparation-3-MergedMaxima.hx will complete this tutorial step (see Figure 6.42).

This module creates a binary image containing the regional maxima of the input distance map image, which are ”merged” within the contrast variation given as parameter. Since distance map is used as input, the result is the set of most inner regions within objects.

The watershed algorithm requires a unique label for each region finally separated. Two regions with the same value in input image would be merged.

- Attach a Labeling module to foam.hMaxima and click on Apply.
- Attach an Ortho Slice to foam.labels and set the Transparency type to Alpha.

Loading the project WatershedSeparation-4-Markers.hx will complete this tutorial step (see Figure Example 2: Separating, Measuring and Reconstructing
The distance map also needs to be inverted, as the watershed algorithm will expand the markers towards increasing values of the input priority map (i.e., landscape altitude).

- Apply a \textit{NOT} module to \texttt{foam.distmap}.
- Attach an \textit{Ortho Slice} to \texttt{foam.not}.

Loading the project \texttt{WatershedSeparation-5-ReversedDistanceMap.hx} will complete this tutorial step (see Figure 6.45).

You can compute the image of watershed separation lines now.

- Attach a \textit{Marker-Based Watershed} module to the reversed-distance data object (\texttt{foam.not}). Set \texttt{foam.labels} as the \textit{Input Label Image}, and the \textit{Type} to \textit{Watershed}. Press Apply.
• Attach an Ortho Slice to the result to see watershed lines. Set Alpha or Binary as the Transparency type to overlay lines onto gray image.
• Attach an Ortho Slice to foam.am. Set the Colormap minimum to 0.

Loading the project WatershedSeparation-6-SeparationLines.hx will complete this tutorial step (see Figure 6.46).

Example 2: Separating, Measuring and Reconstructing
To complete the separation, you can subtract separation lines from the binary image of pores:

- Apply an AND NOT Image module to `foam.thresholded` as first input and `foam.watershed` as second input.
- Attach an Ortho Slice to see the result `foam.sub`.

Loading the project WatershedSeparation-7-SeparatedPores.hx will complete this tutorial step (see Figure 6.47).
6.4.4 Separation Troubleshooting

You may see in the result unseparated pores, or on the contrary, unwanted separations of pores. Because it is based on the geometrical distance criterion, the separation will work best for convex, almost spherical objects. Here are some guidelines for improving separation:

- If you look to markers image on a particular slice, markers may seem missing in some pores just because they lay somewhere else in 3D.
- In some case, however, a marker can be really missing because two objects are considered merged from the standpoint of distance map regional maxima, then a separation will also be missing. You can try lowering the contrast factor of H-Maxima (or Separate Objects) to make markers smaller and more separated.

Example 2: Separating, Measuring and Reconstructing
- If a separation is missing, it means that a marker is missing.
- Separation ‘lines’ may look too thick or wrong, just because the slice you are looking at is somewhat tangent to a separation face.
- Unwanted separation may occur if the object shape is non-convex: this leads multiple local maxima, therefore separated object. Small concavity in an object can lead to a separation across it. A solution may be to increase the contrast factor of H-Maxima in order to make markers larger and merged.
- A separation based on distance map may follow the shortest path, i.e., straight line instead of the desired shape. This is because the watershed is driven by the distance: the separation is driven by geometrical criterion.
- *Chamfer Distance Map* is a discrete chamfer map. You could use instead a more accurate euclidean distance map (see *Distance Map* or other distance map types referenced into *Image Processing/Distance Maps* from the object popup); however, this has little impact in most cases.

As a main guideline, there will be as many separated objects as markers. If results are not satisfying, there can be two cases:

- The number of objects is not satisfying: in this case, you must work on markers.
- The lines of separation are not satisfying: you must work on the priority map, the ‘landscape height field’.

For markers, the *Separate Objects* solution is to work on the distance map. In this case, you take into account the geometry (most inner regions), but markers may be obtained by other ways. Sometimes it may be interesting to use the grayscale image (intensity) if the centers of grains are darker or lighter. If the objects are fairly homogeneous, you must stick with geometric information. One may need to adjust the contrast factor setting of H-Maxima. Basically, the H-Maxima parameter corresponds to the minimum depth of between two maxima. With geographic analogy: the difference in height between the collar and a summit so that you keep the two distinct peaks.

It can be easier to make trials on a cropped data set showing object(s) that should not be split and tune settings in order to make sure that only one marker is inside each object. One possibility for improvement is to do a H-Maxima and then mask the result with a threshold image of the distance map. This avoids keeping markers for small connected parts, since you keep only markers corresponding to a maximum of distance map with a minimal value for distance.

Once satisfied with markers, corresponding to the number of objects, you can also improve the lines of separation. Once again, the process described above (*Separate Objects*) relies on the geometry, you can also use as a function of depth - either directly grayscale intensity or the gradient of intensity. It may be a little difficult to combine geometrical information and intensity information. In some cases, you can get by with a combination of the distance function and a function of intensity, for example, with the *Blend with Image, Blend with Value* or *Arithmetic* module, somehow simulating the complex way the human eye can combine both informations. Note that the watershed seeks for lines peak separations, therefore local maxima - as for distance map, you may need to use the negative of function to bring to this case.

*Example 2: Separating, Measuring and Reconstructing*
An additional powerful technique to improve separation is to filter the separations added by watershed method, based on some criteria:

- isolate the added separations: get the difference between original and separated image using the AND NOT Image module for instance,
- label these separations with the Labeling module,
- use the Label Analysis module to do some measurement in each separation, for instance, the maximum of distance map value within a separation region could indicate whether a separation goes too deep inside an object.

You will find more example applications of watershed in the next tutorials, using different methods to create the markers and the priority map.

### 6.4.5 Filtering Individual Objects

You can measure individual objects that have been separated.

First, you need to convert the binary image of separated pores to a label image with each pore uniquely identified:

- Apply a Labeling module to the separated-pores image (foam.sub).
- You can attach a Voxelized Rendering module to see the labeled image.

Loading the project WatershedSeparation-8-SegmentedPores.hx will complete this tutorial step (see Figure 6.49).

![Figure 6.49: Segmented pores](image)

Secondly, you want to filter unwanted small objects, and finally, measure the volumes of individual

*Example 2: Separating, Measuring and Reconstructing*
pores.
In order to remove small objects, you can use measures and measure filters as described in the *Getting Started* tutorial. This involves two steps:

- Attach a *Filter by Measure* module to the label image.
- Set `foam.am` as *Input Intensity Image*.
- Select *Volume3d* in the huge list of available measure of the *Measure* port.
- Set the *Number of Objects* port to 15 to keep only the 15 biggest volumes. Press *Apply*.
- A *Voxelized Rendering* or *Boundary Rendering* module can be used to see the biggest volumes.
- You can also use a *Label Analysis* module to display and manage specific measurement in the Tables panel.

In one of the next tutorials (chapter 6.5 - Further Image Analysis), you will find more example applications of measurement and advanced analysis.

Loading the project WatershedSeparation-9-FilteredPores.hx will complete this tutorial step (see Figure 6.50).

![Segmented and filtered pores](image_url)

*Figure 6.50: Segmented and filtered pores*
6.4.6 Geometry Reconstruction

Finally, you can reconstruct the geometry of the bubbles:

- Attach a Generate Surface module to the result label image (foam3.labels), uncheck Adjust Coords in the Border port, and press Apply to generate foam3.surf.
- Display the resulting surface by attaching a Surface View module.

Loading the project WatershedSeparation-10-Reconstruction.hx will complete this tutorial step (see Figure 6.51).

![Figure 6.51: Surface reconstruction of filtered pores](image)

As the result image already contains integer values for material labels, it can be used directly for surface reconstruction. Other image types may require conversion to Amira label data (for instance by using the Convert Image Type module). Notice that the Generate Surface module can work with more than 256 labels.

Displaying the resulting surface with a Surface View module may be very slow due to the large number of surface polygons. In this case, a prior simplification of the surface is recommended for faster display.

Example 2: Separating, Measuring and Reconstructing 229
on your hardware.

Amira also allows you to export the surfaces to various file formats, or to generate and export a tetrahedral model suitable, for instance, for finite element simulation with some external solver.

A demo script corresponding to this whole tutorial can be found in:
data/tutorials/image-processing-advanced/PorositySurfaceReconstruction.hx
It uses a script object located in data/tutorials/image-processing-advanced for automating the processing. It matches the workflow described on the figure 6.48.
Once the script is loaded, you can optionally change several port values and click on the Apply button of the Action port to start the processing.

6.5 Example 3: Further Image Analysis - Distribution of Pore Diameters in Foam

This example shows how to compute the distribution of pore diameters in a foam sample and how to define a custom measure to compute the sphericity of pores.
To follow this tutorial, you should have read the chapter 6.1 - Getting Started with Advanced Image Processing and Quantitative Analysis and be familiar with basic manipulation of Amira.

This section is divided in the following steps:

- pore detection,
- pore post-processing,
- custom measure group definition to determine the distribution of pore diameters,
- custom measure definition to compute the sphericity of pore.

The image used in this example is acquired by microtomography. It represents foam that consists of material and pores. Pores appear with dark levels in the image (low intensity voxels). Material appears with luminous levels (high intensity voxels).

- Start by loading data/tutorials/image-processing-advanced/FoamPoro.am from the AMIRA_ROOT directory.
- If Auto-Display is disabled, connect an Ortho Slice to visualize the data in the 3D viewer as shown on Figure 6.52.

6.5.1 First step: pore detection

- Connect an Interactive Thresholding to the data.
- Use the Threshold port to threshold the image between 0 and 50.
As shown on Figure 6.53, thresholding the image between 0 and 50 gives a binary image where: intensity level 1 = porosity, intensity level 0 = support (material).

6.5.2 Second step: pore post-processing

The morphological Opening operator applied on a binary image gives another binary image where: small objects are removed, objects boundaries are smoothed, some objects may be disconnected.

- Connect an Opening module to the binary image.
- Set the Size [px] port to 1.
- Press Apply.
- Connect the Ortho Slice to the output FoamPoro.opening.
Applying morphological opening on the previously computed pores binary image gives a filtered image where noise and artifacts are reduced, as shown on Figure 6.54.

The Separate Objects module detects surfaces that separate agglomerated particles. These surfaces are subtracted from the initial image, see Figure 6.55.

- Connect a Separate Objects module to the filtered binary image.
- Set the Marker Extent to 1.
- Press Apply.
- Connect the Ortho Slice to the output FoamPoro.separate (see Figure 6.56).

### 6.5.3 Third step: custom measure group definition to determine the distribution of pore diameters

The Amira XImagePAQ Extension Label Analysis module allows computation of a set of measures for each particle of a 3D image. Once the individual analysis is performed, a histogram of a given measure
may be plotted in order to produce a representation of the measure distribution.

- Connect a Label Analysis module to the separated binary image.
- Set FoamPor*.am as Intensity Image.

In the Measures port of the module, basic is a group of pre-selected native measures. It might

---

*Example 3: Further Image Analysis - Distribution of Pore Diameters in Foam*
happen that you don’t need all the measures of the basic measure group, or you would like to bundle a different set of measures in the analysis table. For these cases, you can create your own measure group.

For a given particle, the equivalent diameter measure computes the diameter of the spherical particle of same volume. So the equivalent diameter is given by the following formula:

\[ EqDiameter = \sqrt[3]{\frac{6 \times Volume_{3d}}{\pi}} \]

- Press on the configuration button of the Measures port (the button with 3 dots). A panel opens for the selection of measure groups (see Figure 6.57).
- Create a new measure group by pressing the dedicated button next to the measure group selector (1).
- In the popup window, name the new group diameter and press OK.

**Example 3: Further Image Analysis - Distribution of Pore Diameters in Foam**
• Select EqDiameter in the native measures list (2) and use the arrow button to add it to the group (3).
• Press OK.

![Figure 6.57: Selection of measure groups](image)

The new *diameter* group, containing only the equivalent diameter measure, is now selected in the *Measures* port of the *Label Analysis* module.

• Press the *Apply* button.

A new *label* image data object *FoamPoro.label* is created in the Project View, and the Tables panel is displayed, showing a spreadsheet-style table of results: the analysis *FoamPoro.Label-Analysis*, also created in the Project View (see Figures 6.59 and 6.60).

• Select the EqDiameter column in the lower spreadsheet.
• Press on the histogram button of the toolbar.

A window opens, displaying the EqDiameter histogram, as shown on Figure 6.61.

Loading the project data/tutorials/image-processing-advanced/CustomerMeasurements-1-EquivalentDiameter.hx will complete the steps above.

### 6.5.4 Fourth step: custom measure definition to compute the sphericity of pore

Amira XImagePAQ Extension provides a set of pre-defined native measures but it is also possible to save user-defined custom measures.
• Select the *Label Analysis* module.
• In the Properties panel, press on the configuration button of the *Measures* port (the button with 3 dots).
• Choose the *diameter* group if it is not yet selected.
Create a custom measure by pressing the dedicated button (see Figure 6.62). Name it *Sphericity* and press OK.

The Measure Edition panel opens.

The sphericity is a measure of how spherical an object is and is expressed as:

$$\Psi = \frac{\pi^{1/3} (6V)^{2/3}}{A}$$

where $V$ is the volume of a particle and $A$ is its surface area.

*Example 3: Further Image Analysis - Distribution of Pore Diameters in Foam*
It is the ratio of the surface area of a sphere (with the same volume as the given particle) to the surface area of the particle. The sphericity of a sphere is 1 and, by the isoperimetric inequality, any particle which is not a sphere will have sphericity less than 1. Here are several examples of object sphericity:

<table>
<thead>
<tr>
<th>Object</th>
<th>Volume</th>
<th>Area</th>
<th>Sphericity</th>
</tr>
</thead>
<tbody>
<tr>
<td>cone : ( h = 2\sqrt{2}r )</td>
<td>( \frac{2\sqrt{2}}{3}\pi r^3 )</td>
<td>( 4\pi r^2 )</td>
<td>( \approx 0.794 )</td>
</tr>
<tr>
<td>cylinder : ( h = 2r )</td>
<td>( 2\pi r^3 )</td>
<td>( 6\pi r^2 )</td>
<td>( \approx 0.874 )</td>
</tr>
<tr>
<td>torus : ( R = r )</td>
<td>( 2\pi^2 r^3 )</td>
<td>( 4\pi^2 r^2 )</td>
<td>( \approx 0.894 )</td>
</tr>
<tr>
<td>sphere</td>
<td>( \frac{4}{3}\pi r^3 )</td>
<td>( 4\pi r^2 )</td>
<td>1</td>
</tr>
<tr>
<td>icosahedron : 20 faces</td>
<td>( \frac{5}{12}(3 + \sqrt{5})s^3 )</td>
<td>( 5\sqrt{3}s^2 )</td>
<td>( \approx 0.939 )</td>
</tr>
<tr>
<td>dodecahedron : 12 faces</td>
<td>( \frac{1}{4}(15 + 7\sqrt{5})s^3 )</td>
<td>( 3\sqrt{25 + 10\sqrt{5}}s^2 )</td>
<td>( \approx 0.910 )</td>
</tr>
<tr>
<td>octohedron : 8 faces</td>
<td>( \frac{1}{2}\sqrt{2}s^3 )</td>
<td>( 2\sqrt{3}s^2 )</td>
<td>( \approx 0.846 )</td>
</tr>
<tr>
<td>cube : 6 faces</td>
<td>( s^3 )</td>
<td>( 6s^2 )</td>
<td>( \approx 0.806 )</td>
</tr>
<tr>
<td>tetrahedron : 4 faces</td>
<td>( \frac{\sqrt{2}}{12}s^3 )</td>
<td>( \sqrt{3}s^2 )</td>
<td>( \approx 0.671 )</td>
</tr>
</tbody>
</table>

This can be expressed, with respect to Amira XImagePAQ Extension measures, as:

\[
(\pi^{(1/3)}(6\times \text{Volume}^{3d})^{(2/3)})/\text{Area}^{3d}
\]

- Enter the sphericity formula in the dedicated field of the panel (see Figure 6.63).
- Press Close.
- Select Sphericity in the custom measures list and use the arrow button to add it to the diameter group.
- Press OK.

![Figure 6.63: Measure edition](image)

- Press the Apply button of the Label Analysis module.

---

Example 3: Further Image Analysis - Distribution of Pore Diameters in Foam
The Analysis panel is updated and displays the EqDiameter and Sphericity measures.

**Tip:** Using a custom group to select only the needed measures can help to speed up the analysis process.

**Note 1:** User-defined data such as custom measure groups or custom measures are persistent at the end of work session as local settings, so they can be retrieved when you restart Amira. These custom data are also saved in project scripts.

**Note 2:** It is important to mention that the sphericity computed could be superior to 1 for small pores (i.e., composed of few voxels). This is due to that the Area 3D measure is computed with chordal approximations (which gives generally a better approximation of the area) whereas it is not the case for the Volume 3D measure which does not use any approximation.

Amira XImagePAQ Extension offers powerful ways to define custom measures. See the *measure editor* part for further details.

Loading the project data/tutorials/image-processing-advanced/CustomerMeasurements-2-Sphericity.hx will complete the steps above.

### 6.6 Example 4: Further Image Analysis - Average Thickness of Material in Foam

This tutorial shows how to compute the thickness of material in a foam sample.

To follow this tutorial, you should have read the first tutorial chapter 6.1 - Getting Started with Advanced Image Processing and Quantitative Analysis and be familiar with basic manipulation of Amira.

At the end of this tutorial, you will find a link to a corresponding demo script.

Start by loading data/tutorials/image-processing-advanced/FoamPoro.am, an image acquired by microtomography and stored into the AMIRA_ROOT directory.

It represents foam that consists of material and pores. Pores appear with dark levels in the image (low intensity voxels). Material appears with luminous levels (high intensity voxels).

The algorithm may be divided into 4 steps:

- **Porosity Detection**
- **Detection of the Separation Surfaces**
- **Distance Map of the Material**
- **Calculation of the Material Average Thickness**
6.6.1 Porosity Detection

Reproduce the first steps of the previous tutorial: use thresholding, morphological opening and separating modules on the initial image to get a binary image of the filtered and separated pores.

Loading the project PorosityThickness-1-SeparationObjects.hx will complete this tutorial step (see Figure 6.65).

Figure 6.65: Binary image of porosity
6.6.2 Detection of the Separation Surfaces

The goal of this step is to detect surfaces that cross the material at an equidistance from two pores. The Influence Zones module:

- takes a binary image as input,
- gives a binary image as output where:
  - each blue voxel of the output image is closer to the object located at the center of the zone in the input image,
  - each black voxel is equidistant from at least two closer objects.

Apply the Influence Zones module on the binary image of porosity FoamPoro.separate. Loading the project PorosityThickness-2-InfluenceZones.hx will complete this tutorial step (see Figure 6.66).

The NOT module inverts the levels of a binary image. Applying NOT on an skeleton by influence zone (SKIZ) gives a binary image where:

- each black voxel of the output image is closer to the object located at the center of the zone in the input image,
- each blue voxel is equidistant from at least two closer objects.

So the Influence Zones and NOT combination provides a binary image of surfaces that separate pores through the material.

Example 4: Further Image Analysis - Average Thickness of Material in Foam

241
Apply the NOT module to FoamPoro.zones.
Loading the project PorosityThickness-3-SeparationSurfaces.hx will complete this tutorial step (see Figure 6.67).

![Figure 6.67: Separation surfaces image](image)

6.6.3 Distance Map of the Material

Apply NOT on the binary image of porosity FoamPoro.separate. This gives a binary image where:

- each black voxel of the output image represents a background or porosity voxel,
- each blue voxel represents a material voxel.

The Chamfer Distance Map module applied on a binary image gives a gray level image where each voxel intensity represents the minimal distance in voxels from the object boundary. For a given voxel intensity:

- intensity level = 0 corresponds to the pores or background
- intensity level = 1 corresponds to the material envelope
- other low level intensities correspond to the part of material close to the material envelope
- other high level intensities correspond to the part of material far from the material envelope

Apply a Chamfer Distance Map module with 3D Interpretation on the material binary image

*Example 4: Further Image Analysis - Average Thickness of Material in Foam*
FoamPoro2.not.

Loading the project PorosityThickness-4-DistanceMap.hx will complete this tutorial step (see Figure 6.69).

The Mask module:

- takes a gray level image as the first input,
- takes a binary image as the second input (mask image),
- provides a gray level image as the output where:
  - each black voxel of the mask image is set to 0 in the output image,
  - each blue voxel of the mask image is set to the initial level from the gray image.

Apply a Mask module to the distance map image FoamPoro2.distmap and set the Input Binary Image to the separation surfaces image FoamPoro.not.

Masking the distance map image by the separation surfaces image gives a gray image where:

- each non null intensity represents a voxel of a separation surface,
- the intensity value is equal to the half distance in voxels between the two closest objects.

Loading the project PorosityThickness-5-Mask.hx will complete this tutorial step (see Figure 6.70).

Example 4: Further Image Analysis - Average Thickness of Material in Foam
Figure 6.69: Distance map of material

Figure 6.70: Distance map of the separation surfaces

Example 4: Further Image Analysis - Average Thickness of Material in Foam
6.6.4 Calculation of the Material Average Thickness

The average thickness of the material is given by the following formula:

\[
\mu(Thk) = 2 \times \frac{V_{size} \times \Sigma_i}{NbVoxSep}
\]

where:

- \(V_{size}\) = voxel dimension in micrometers
- \(\Sigma_i\) = sum of the voxel intensities in the distance map image of the separation surfaces
- \(NbVoxSep\) = number of voxels in the binary separation surfaces image

The Volume Fraction module with 3D Interpretation gives on the column "Label Voxel Count" the number of labeled voxels for each label in a 3D image. A binary image has only one label so "Label Voxel Count" returns \(NbVoxSep\).

The Intensity Integral module with 3D Interpretation gives on the column "Volume" the sum of the voxels intensities in a 3D image i.e., \(\Sigma_i\).

Loading the project PorosityThickness-6-Thickness.hx will complete this tutorial step.

6.7 Watershed Segmentation

Due to artifacts associated with image acquisition and reconstruction, the commonly used segmentation method by simple thresholding may give inaccurate and even often wrong results, especially in phase transition regions.

- Correct or unique threshold cannot be easily or accurately determined with edges blurred by noise and partial volume effect. Partial volume effect is caused by resolution limits in image acquisition, which blurs the transition between phases and features, i.e., voxels do not map single homogeneous physical volumes.
- When segmenting more than two phases, a transition between high and low intensity phases may introduce artifacts with unwanted intermediate "coating" phase.
- Variations in illumination or intensity across image may lead to different thresholds on different regions.

The watershed technique provides an effective solution for these issues in many cases. See documentation about watershed principle.

In this tutorial, you will learn how to use watershed for segmentation using the Watershed Segmentation wizard (Segmentation of multi-material or multiple phases)

To follow this tutorial, you should have completed tutorial on Image Processing and Analysis and be familiar with basic manipulation.
6.7.1 Segmenting multiphase using the Watershed Segmentation wizard

For this tutorial, we will use the data set chocolate-bar.am.

- Open data/tutorials/chocolate-bar.am.

Auto-Thresholding

This dataset contains regions with mousse, caramel, chocolate and air.

One could try first segmenting 3 phases (air, mousse filling, chocolate) using for instance Multi-Thresholding, or the Segmentation Editor. We will try using Auto Thresholding: this module analyses the image histogram to guess 1 or 2 threshold(s) separating voxels classes statistically. This module provides a quick way to segment images automatically.

- Attach Auto Thresholding to chocolate-bar.am.
- Set the module configuration Type to Auto Segment 3 Phases. The Criterion port should be set to factorisation (also known as Otsu method).
- Press Apply to create a label image.
- Attach an Ortho Slice to the label image.

![Figure 6.71: Automatically segmenting the image with Auto Thresholding.](image)

A mousse layer (light blue) seems to surround the chocolate topping (dark blue): the mousse between the exterior and the chocolate is actually an artifact due to partial volume effect (see Figure 6.71 and Watershed Segmentation 246)
Figure 6.72). Adjusting the thresholds will not solve that issue. As illustrated in figure 6.73, the image gradient gives useful hints on actual boundaries. Instead of using direct intensity thresholding, a more robust method is shown in the next section that takes advantage of the image gradient.

Figure 6.72: A simple thresholding selects unwanted "coating" voxels in the transition from high to low intensities due to partial volume effect, as shown by this intensity profile using a Line Probe module.
Watershed Segmentation Wizard

We will use the Watershed Segmentation wizard module to solve this. This wizard is a script module that will simply guide you step by step through the following segmentation process:

1. Define "conservative" thresholds defining initial seed markers for air, mousse and chocolate,
2. Calculate image gradient magnitude mapping material edges "sharpness",
3. Mark sharp edges between air and steel to prevent "coating effect" by masking the seed markers,
4. Complete watershed expansion of the seed markers towards objects edges.

- Remove Auto Thresholding module and its result data, leaving only chocolate-bar.am in the Project View.
• Attach *Watershed Segmentation* wizard module to `chocolate-bar.am`.

The wizard module being selected in the Project View, you can see in the Properties panel the module’s ports showing the current step with possible options and parameters (see Figure 6.74). You can go back and correct previous actions at any step.

![Watershed Segmentation wizard at step 1.](image)

**Figure 6.74**: The *Watershed Segmentation* wizard at step 1.

**Tip**: The wizard keeps intermediate data for going back in the steps. For large data that might exceed available memory, you may want to show and remove intermediate when going to next step (use object menu ”show”). Unrolling the steps will then no longer be possible.

- At any time you can move the slice or change its orientation. The current view is XY slice number 147.
- At first step, you need to input the number of separate materials or phases to segment: let the number of phases to 3 for air (exterior), caramel and chocolate.
- Press the *Apply* button (in the port *Action*).

The next step is intended to allow attaching optionally a pre-computed gradient image (port *Gradient*)

- Simply press *Apply* to trigger computation of gradient magnitude for the images.

At the next step ”Threshold Gradient Magnitude”, you can use a slider to adjust a threshold to mark sharp edges based on gradient obtained at previous step.

- Uncheck auto checkbox in order to show *Gradient Threshold* port
You can set the Gradient Threshold value to 707 for masking the air-chocolate transition areas.

At this point, you may verify proper marking by changing the slice number or orientation.

You may select the module MainOrthoSlice and adjust the colormap range of the edges area or transparency for better seeing the edge areas (see Figure 6.75).

Then select again the Watershed Segmentation module (see Figure 6.76).

Press Apply in Action port of Watershed Segmentation.

The three next steps ”Threshold Phase...” allow you to define marker labels for each material.

First, you need to set a marker range for air (phase 0). We do not attempt fitting accurately to the object.
edge at this point, but rather safely avoid areas when the actual material transition might occur. The holes in the mousse should be marked in the phase 0. Otherwise, they will be included in the mousse area.

- You can use 0-435 as range (see Figure 6.77).
- Press Apply to complete this step.

![Watershed Segmentation wizard at step 4.](image)

**Figure 6.77:** The Watershed Segmentation wizard at step 4.

In the next step, you can set the range for phase 1 (mousse).

- You can use 629-674 as range here. Again, the goal is to mark inner areas of the given material. (see Figure 6.78). If you select a lesser lower range, areas between the air and the chocolate will be selected, and it will result in the same artifact than the one introduced in Figure 6.71.
- Press Apply to complete this step.
Finally, in the next step, you can set the range for phase 2 (chocolate).

- You can use 1041-1910 as range here (see Figure 6.79). The mousse area should be avoided as much as possible.
- Press Apply to complete this step.

Figure 6.78: The Watershed Segmentation wizard at step 5.

Figure 6.79: The Watershed Segmentation wizard at step 6.
In the next step, you can trigger watershed computation and get the final label image result.

- Simply press *Apply* to trigger computation (see Figure 6.80).
- You may verify the result by changing slice number or orientation, and possibly go back to previous steps to modify some parameter.
- You can then remove the *Watershed Segmentation* module, which will clean up also the ancillary display modules.

![Watershed Segmentation wizard completed](image)

**Figure 6.80**: The *Watershed Segmentation* wizard completed.

You may want to get rid of the air phase that has been segmented as label 1 by the wizard. To do this, you can simply use the *Subtract Value* module with value 1, or the more general *Arithmetic* module with expression ”A-1” (see Figure 6.81).
More segmentation hints

The watershed technique shown above can be used in many different workflows to achieve more demanding or specific segmentation depending on desired result.

For instance, in the chocolate-bar dataset, one may slightly distinguish a 4th phase made of caramel. The image noise prevents to directly mark the proper region by thresholding. However applying first a smoothing filter such as Non-Local Means Filter can help further segmentation. A simple trial using the Watershed Segmentation wizard (4 phases, gradient threshold 100, phase marker thresholds 0-435, 630-750, 800-1210, 1250-1459) leads to the result on figure 6.82.

Figure 6.81: Remove the air phase using Arithmetic module.
Figure 6.82: Example of Watershed Segmentation wizard use after Non-Local Means filter.

If not satisfying, the segmentation editor can be used to correct or refine the segmentation in a few steps. It is possible to use the segmentation editor to define interactively marker regions, then apply the watershed algorithm (Marker-Based Watershed module) based on image gradient (Image Gradient module).

As another example, small pores could be separately segmented, for instance using the Interactive Top-Hat module, and combined with previous segmentation using the Segmentation Editor or Arithmetic module.

An example result is data/tutorials/chocolate-bar-labels-4-phases.am (See Figure 6.83).
6.8 More about Image Filtering

It is often necessary to reduce image noise or artifacts and enhance features of interest before segmentation. Digital image filters are tools used to enhance image or highlight image features. These tools can be based on sophisticated algorithms and may have variable effects and performance depending on input image and control parameters, which may require experimentation in order to achieve the desired results.

In this tutorial, you will learn how to:

1. Distinguish the different types of image filters available in Amira, and the main filters typically used.
2. Use image filters effectively to tune parameters and compare results.
3. Compose application of several image filters.

To follow this tutorial, you should have read the first tutorial chapter 6.1 - Getting Started with Image Processing and Analysis and be familiar with basic manipulation of Amira. In particular, in the Getting started tutorial, you can see how to apply an image filter and the complete quantification workflow afterwards.

6.8.1 Choosing image filters

For convenience, image filters are sorted in categories according to their main function. You can browse filter categories in the explorer panels of the object popup, within the top category Image Processing. You can also use the search tool of the object popup to quickly retrieve a filter by name. In the sections below the different categories are briefly described, and a selection of image filters is suggested along with some tips.
6.8.1.1 Smoothing

This is the most important category for preparing data for image segmentation. These filters help smooth noisy images. Some users call these “denoising” filters. They can effectively reduce noise, but may require careful use to not alter information contained in the image, especially for quantification purposes. The most commonly used smoothing filters in Amira are:

- **Median Filter** - a basic filter preserving edges. Very effective on salt-and-pepper noise (scatter dots).
- **Bilateral Filter** - filter balancing smoothing and edge preserving (in particular sharp angles). It requires an Amira XImagePAQ Extension license.
- **Non-Local Means** (GPU accelerated). This filter is extremely effective on noisy data while preserving edges (best with white noise). It is generally the first choice for noisy images. However, it can be very time consuming. Reducing the search window will decrease computation time, but it may also reduce the smoothing efficiency (depending on the noise distribution). Edge enhancement should preferably not be applied before this filter.
- **Edge-Preserving Smoothing** - a diffusion filter preserving edge
- **Anisotropic Diffusion** - a GPU accelerated diffusion filter. It requires an Amira XImagePAQ Extension license.
- **Curvature-Driven Diffusion** - a diffusion filter that may better preserve thin structures. It requires an Amira XImagePAQ Extension license.

Tip: Make sure that the filter parameters such as contrast thresholds for edge preserving diffusion are set according to your data range. Default ranges are usually intended for 8-bit data, and need to be dramatically increased for higher dynamics of 16-bit images.

6.8.1.2 Sharpening

These filters help reinforce the contrast at edges and make details appear sharper. Commonly used sharpening filters are:

- **Unsharp masking**
- **Delineate** - also acts as smoothing filter. It requires an Amira XImagePAQ Extension license.

6.8.1.3 Edge detection

These filters highlight boundaries between different materials or phases. They can be used, for instance, to directly extract feature contours and edges, or in watershed-based segmentation.

Here are the most commonly used modules in that category:

- **Sobel Filter** - quick basic edge detection, that can be used as approximation of gradient magnitude
• **Image Gradient** - comprehensive module supporting quick approximation (Canny) or noise reducing gradient (Canny Deriche, Gaussian, Sobel, Prewitt)

6.8.1.4 **Frequency domain**

These filters operate by transformation in frequency domain.

• **FFT** - Fourier transform, basis module for many image filtering techniques

• **Deconvolution** - specific module for deconvolution of 3D light microscopy images

6.8.1.5 **Grayscale transforms**

Modules in that category are not strictly speaking image filters. Filters mentioned above usually operate on pixels by examining a neighborhood of intensity values around each pixel. Grayscale transforms independently act on pixels, i.e., without considering neighboring pixel values. The following modules can be useful to correct globally image grayscale or shading:

• **Shading Correction, Shading Correction Wizard, Correct Z Drop, Background Detection Correction** - these modules can help to compensate non-uniform background in images

• **Match Contrast** - adjust image dynamics according to a reference. It requires an Amira XImagePAQ Extension license.

6.8.2 **Tuning image filters**

It is always a good practice to first adjust a processing workflow on a limited subset of the data. Image filters do not make an exception, especially since it is very useful to adjust interactively parameters with visual feedback. Here are some methods that can help to adjust the image filters faster:

• **Crop Editor** - remove useless parts of your data

• **Extract Subvolume** - extract a subset for trials

• **Slice** - apply some image filters on the displayed slice

• Image filters 2D/3D interpretation port - 2D processing (per slice) is generally significantly faster and may give similar results

• Image filters kernel size, number iterations, window size - filter performance is often dependant on such parameter

• **Filter Sandbox** - preview filter effect on an image region. It requires an Amira XImagePAQ Extension license.

Here is how to use the Filter Sandbox module. The Filter Sandbox can be very helpful to choose a filter and adjust its parameters. Note however that this convenience script module proposes only a selection of the most commonly used filters, among the filters available in Amira XImagePAQ Extension.
Start a new project (Ctrl+N) and open `data/tutorials/chocolate-bar.am`.

Attach a Filter Sandbox module. You can find it in the right-click object popup, in Image Processing category, or typing in the search field some letters of Filter Sandbox.

An Ortho Slice is displayed in the 3D viewer, with an overlaid preview box surrounded by a dragger with blue tabs.

![Figure 6.84: Starting Filter Sandbox](image)

- In the properties panel, set the Filter port to Median. You can see that the filter is applied in the preview area.
- You may pick and drag or resize the preview box (first press the ESC key to set the 3D viewer in interaction mode). Keeping a small size at first may save time when trying filters.
- You can change filter parameters such as filter size. Note that when setting interpretation to 3D, the filter is applied to a 3D slab with a depth depending on parameters. 3D filtering can be significantly slower, even on a limited preview area.
- You can temporarily hide preview (port Show) to see original vs. filtered.
- Still using the port Show, you can display histograms calculated on original and filtered preview area, in order to see how the filter helps to better separate peaks. You can right-click in the
histogram plot to switch plot scaling between linear and logarithmic. A statistics summary is displayed in the Properties panel.

- Change Preview type to Interactive Thresholding: you can then adjust a threshold and verify the impact of the filter on such a threshold segmentation.
- Pressing the Apply button will apply the filter to the whole input image and create or update a result image.

Figure 6.85: Using Filter Sandbox in Interactive Thresholding mode
For information about how to compare results of image filters, see also the tutorial chapter 8.2 Data fusion, comparing and merging data, in particular the example showing how to synchronize views and display modules.

### 6.8.3 Compositing image filters

Sometimes the best results may be derived by applying two or more filters sequentially. The Slice module allows the user to optionally apply a sequence of filters (2D) to the displayed slice: this can provide an easy way to try individual filters or filter combinations. Most of the image filters are not commutative so you should be careful to note your order of operations.

Another way to enhance your images is to make a composition of several filters. You may simply attach in a chain image filter modules to intermediate results. Tip: checking auto-refresh toggle will update the results upon change in inputs or any module port.

In some cases, a more complex combination may be useful. Some filters are known for detecting or preserving edges, other ones are used for smoothing or denoising. Filters may be contradictory and may not always be simply applied sequentially.

You will see below how to make step by step a filter composition that allows you to:

- preserve edges (limited edge smoothing),
- smooth uniform yet noisy areas

The following example illustrates possible techniques for filter combination, however it is not intended to show the preferred solution in a specific realistic case, nor a general solution. In general, filters such as Bilateral or Non-Local Means can achieve a good job at smoothing while preserving edges and should still be tried first.

The process is split in several steps:

- **Strong Smoothing using Median Filter**
- **Slight filter on the edges using Bilateral filter** (it requires an Amira XImagePAQ Extension license)
- **Edge detection and masking using Sobel filter**
- **Compositing filters with mask**

#### 6.8.3.1 Strong Smoothing using Median Filter

- Load AMIRA_ROOT/data/tutorials/image-processing-advanced/Catalyst.am.
- Attach a Median Filter module to the Catalyst.am.
- Set Interpretation to 3D and press Apply.
- Attach an Ortho Slice module to Catalyst.filtered.
Figure 6.86: The initial image

Loading the project data/tutorials/image-processing-advanced/FilterCompositing-1-MedianFilter.hx will complete this tutorial step (see Figure 6.87).
Noise has been reduced in uniform areas of the image but edges are then very blurred.

6.8.3.2 Slight Filter on the Edge using Bilateral Filter

- Attach a Bilateral Filter module to the Catalyst.am.
- Set Interpretation to 3D, Kernel sizes to 3 and press Apply.
- Attach an Ortho Slice module to Catalyst2.filtered.

Loading the project data/tutorials/image-processing-advanced/FilterCompositing-2-BilateralFilter.hx will complete this tutorial step (see Figure 6.88).
Some noise has been removed from edges and edges are clearly preserved. Nevertheless, remaining noise is visible mainly on uniform areas of the image.

6.8.3.3 Edge Detection and Masking using Sobel Filter

- Attach a Sobel Filter module to the Catalyst.am.
- Set Filter to 3D and press Apply.

More about Image Filtering
Attach an *Ortho Slice* module to *Catalyst-filtered*.

Loading the project data/tutorials/image-processing-advanced/FilterCompositing-3-SobelFilter.hx will complete this tutorial step (see Figure 6.89).

This filter highlights edges: edge areas are white, uniform areas are black and noisy areas are gray.

### 6.8.3.4 Compositing Filters with Mask

Now, you will use an *Arithmetic* module to basically compose the filtered image using the bilateral-filtered image (B) for the edge areas and the median-filtered image (C) for the uniform areas. Both images are blended linearly using the normalized Sobel-filtered image (A) as follows:

\[ B \ast A + C \ast (1.0 - A) \]

(A) should be a normalized float image with a range from 0 to 1.

- Attach an *Convert Image Type* module to *Catalyst-filtered.am*.
- As *Catalyst-filtered.am* type is 8-bit unsigned byte image with 0-255 as range, set *output type* to *32-bit float* and *Scaling: scale* so that output range is 0...1 (use 0.00392157,
almost equal to 1/256). You could alternatively change A by A/256 in expression below.

- Press Apply to create Catalyst-filtered.to-float
- Attach an Arithmetic module to the Catalyst-filtered.to-float.
- Set Input B to Catalyst.filtered (result of Median Filter), Input C to Catalyst2.filtered (result of Bilateral Filter).
- Set Expr to $B*A + C*(1-A)$ and press Apply.
- Attach an Ortho Slice module to Result.
- Set Colormap range to 0-255.

Loading the project data/tutorials/image-processing-advanced/FilterCompositing-4-Arithmetic.hx will complete this tutorial step (see Figure 6.90).

This composition takes advantages of both median and bilateral filters: edges are preserved and uniform parts are smoothed. You can improve this kind of compositing by:

- filtering the initial image to remove the circular acquisition artifacts,
- applying a shading correction and/or histogram equalization,
• using some other filters,
• filtering the mask,
• tuning the compositing formula,
• adding a series of arithmetic operations based on new masks.

Figure 6.89: Sobel filter
6.9 More about label measures

6.9.1 The Measures Group Selection dialog

This dialog gives you the ability to manage several groups of measures. Those groups of measures can be modified independently. They are automatically stored in the user settings so that modifications are persistent when restarting the application. You can select any measure from the list of measures provided with the application. More details about each measure can be found in the list of available measures. Custom measures can also be created from the existing ones.
Managing the measure groups

The top part of the dialog displays the list of all measure groups and a set of tools. The list can be used to browse the measure groups and select a group.

When the dialog is opened from a module such as Label Analysis, the group selected in the measure selection port is directly displayed in the dialog. On the other side, when the dialog is validated, the measure selection port is updated with the measure group selected in the dialog.

With the measure group tools, you can:

- create a new empty group,
- save a group loaded from a project file or a script (groups created from GUI are automatically saved),
- copy an existing group into a new one,
- rename an existing group,
- remove an existing group.

The following default groups are not editable. However each one can be copied with a new name and then this copy can be edited.

- *basic* group, used for 3D images, contains the measures Volume3d, Area3d, BaryCenterX/Y/Z and Mean.
- *basic2D* group, used for 2D images, contains the measures Area, BaryCenterX/Y and Mean.
- *Standard Shape Analysis* group contains standard shape parameters measures.

Selecting measures

Left panels list the user and native measures. The right panel lists the measures selected in the current group. To add a measure to the selection group or remove it, just double-click on it in the list. To
add or remove several measures at once, select them and use the central buttons [>] and [<]. The <Delete> key shortcut is also available to remove the selected measures.

### 6.9.2 Custom measures

Custom measures can be created by combining existing measures in a mathematical formula. To create a new measure, click on the icon above the list of the custom measures. After prompting for a new measure name, this will open the Measure Editor.

Once created, new custom measures are listed in the custom measures list. Some tool buttons are available next to each custom measure to:

- re-edit the measure formula
- remove it from the list
- save it, if the custom measure has been loaded from a project file or a script (custom measures created from GUI are automatically saved)

**The Measure editor**

All the custom measures are listed in the top drop-down menu. The formula area is updated according to the selected measure. The selected measure can be copied, renamed or deleted with the tool button next to the custom measure list. Note that a custom measure should be explicitly removed from all measure groups before being deleted.

The main part of the dialog deals with the editing of the selected measure. The first parameter is the unit dimension of the result values generated by this measure. This unit dimension will be combined with the unit of the analysed label image to determine the exact unit of the output result values. If the measure dimension is *Area* and the coordinate unit of the input image is *cm*, the unit of the output values will be *cm*².

The second parameter is the measure’s mathematical formula. The formula syntax supports a set of basic operators and mathematical functions to be used with the existing measures. The supported operators are listed on the left of the formula area. Available functions and measures are listed below the formula area. As a shortcut, you can double-click or drag-and-drop keywords from the bottom list into the formula area.

*Note:* The working unit should be used in the formula. For more information about how working unit is set, see *Automatically determine or manually set the working coordinate units*.

The formula definition is checked on-the-fly, and colorized according to its validity: green if the formula is correct, red otherwise.

### 6.9.3 Configurable native measures

Some measures can be configured with additional parameters. Those measures are identified in the list of the native measures with the [...] tool button. Click on this tool button to open the Label Measures
Attributes Editor. There are five kinds of attributes that can be edited through this editor:

- **Feret angles**, for **Feret 2D measures** which perform measurements on a XY plane along a given numbers of diameters of each cell. Angles are uniformly sampled on the range [0,180]. By default, there are 10 angles every 18 degrees.
- **Feret 3D angles**, for **Feret 3D measures**, which perform measurements in a 3D space around each cell. By default, 31 3D samples are used.
- **Co-occurrence directions**, for measures based on the computation of a co-occurrence matrix, to classify a given direction (dx,dy) in pixels pairs by their gray level. The co-occurrence matrix components are given by the following formula:

\[ M(i,j) = \text{number}\left(\{x,y\}/I(x,y) = i \cap I(x+dx,y+dy) = j\right) \]

where \(I(x,y)\) is the image gray level at coordinates \((x,y)\). This equation means that for a given pair \((i,j)\), \(M(i,j)\) contains the number of pixels verifying \(I(x,y) = i\) and \(I(x+dx,y+dy) = j\). This matrix is symmetric and normalized such as:

\[ \forall (i,j), M(i,j) = M(j,i) \text{ and } \sum_{i,j=1}^{N} M(i,j) = 1 \text{ with } N \text{ the number of gray levels of the image} \]

These operations allow being independent to the image size and to hold properties on a direction and its symmetry.
- **Histogram parameters**, for measures based on the computation of the gray level histogram of each label. Configurable attributes are in the range of gray values to consider and the size of the
bins to generate. By default, those settings are computed automatically.

- **Quantile values**, for configurable HistoQuantile measures. See also *Quantile of an histogram*.
- **Breadth 3D sampling**, for the Breadth 3D measures that search for the biggest orthogonal **Feret diameter** to the major axis found with **Feret 3D**. The **Breadth 3D** value defines the sampling that will be used on each orthogonal plane after **Feret 3D** has been used. The sampling of **Feret 3D** should be set to the desired value before using this measure.

**IMPORTANT**: Attribute values are common between measures. This means that when you edit the number of Feret angles for the measure **FeretShape** for example, all other measures based on the Feret angles will use this new value.

Note that only the attributes supported by the edited measure are enabled in the dialog.

### 6.9.4 About measures group backup

When you save your project, all the information required to redo the analysis are stored in the project file. This includes the measure group selected for the analysis, and the formula of the custom measures. Then, when this project is loaded on another computer, those new definitions of measure group and custom measures are loaded in the new environment. Yet, the local storage of those new definitions on the new machine is optional, and a new *Save* button will appear near these unsaved items. There is no need to save the new items, they are fully functional and can be used until the application is closed. Note that if a custom measure or group is already defined on the machine but with different values, the definitions from the project are renamed to avoid any conflict.

*More about label measures*
6.9.5 Scripting tips

To define custom measures inside a script, you can use the `labelMeasure create` Tcl command. This command is a simple alternative to the syntax used in the project file. Indeed the project files use a more elaborate mechanism to avoid conflicts and duplications when loading several custom measures from a project, but are not adapted to scripting.

The `labelMeasure create` Tcl command handles conflicts in a simpler way: If the measure name is already used, a new name is generated, and this name is returned as the result of the command. The returned name should be used in dependent measure formulas. Using the hard-coded name may replace the dependency by a wrong one. Example:

```tcl
labelMeasure create mymeasure length "Volume/Area"
lableMeasure create mymeasure2 length "mymeasure+1"
LabelAnalysis measures setState mygrp mymeasure mymeasure2
```

This is fine in the console, but it may cause hidden dependencies issues when used in scripts where a measure named "mymeasure" already exists. In scripts, prefer:

```tcl
set msr [ labelMeasure create mymeasure length "Volume/Area" ]
set msr2 [ labelMeasure create mymeasure2 length "$msr+1" ]
LabelAnalysis measures setState mygrp $msr $msr2
```

More about label measures
Chapter 7

Tutorials: Surfaces, meshes, skeletons, modeling geometry from 3D images

Amira allows the user to create geometric models derived from various types of data: surfaces from point sets, surfaces from 3D images, tetrahedral grid from surfaces, center line spatial graphs from 3D images. For an overview of related features, please refer to the Features overview section. The tutorials in this chapter introduce the following topics:

- Surface reconstruction - surface reconstruction from 3D images
- Grid generation - creating a tetrahedral grid from a triangular surface
- Advanced Surface and Grid Generation - extracting a geometric model from 3D images
- Visualization and Analysis of 3D Models and Numerical Data
- Introduction to the Filament Editor - extracting complex three-dimensional networks of filamentous structures
- Skeletonization - analysis of network or tree-like structures in 3D images

7.1 Surface Reconstruction from 3D Images

By following this step-by-step tutorial, you will learn how to generate a triangular surface grid for an object embedded in a voxel data set. A surface grid allows for producing a 3D view of the object’s surface and can be used for numerical simulations.

The generation process consists of these steps:

1. Extracting surfaces from segmentation results
2. Simplifying the surface
As a prerequisite for the following steps, you need a label image, which holds the result of a previous image segmentation. Please load the provided lopus.labels.am data set from the data/tutorials directory.

### 7.1.1 Extracting Surfaces from Segmentation Results

Now we let Amira construct a triangular surface of the segmented object.

- Connect a Generate Surface module to the lopus.labels.am data.
- Press the Apply button.

The option Border ensures that the created surface be closed. A new data object lopus.labels.surf is generated. Again, it is represented by a green icon in the Project View.

### 7.1.2 Simplifying the Surface

Usually the number of triangles created by the Generate Surface module is far too large for subsequent operations. Thus, the number of triangles must be reduced in a surface simplification step. In Amira a Surface Simplification Editor is provided for this purpose.

- Select the surface lopus.labels.surf.
- Click on the Simplifier button (triangle mesh icon) in the Properties Area.
- Set the desired number of faces to 3500 in the Simplify port.
- Turn on the fast toggle in the Options port. This option disables some time-consuming intersection tests.
- Push the Simplify now button in the Action port.

The number of triangles is reduced to about 3500 now. The progress bar tells you how much of the simplification task has already been done.

To examine the simplified surface, attach a Surface View module to the lopus.labels.surf data object. The Surface View module maintains an internal buffer and displays all triangles stored in this buffer. By default, the buffer shows all triangles forming the boundary to the exterior. If you change the selection at the Materials port, the newly selected triangles are highlighted, i.e., they are displayed using a red wireframe representation. The Add and Remove buttons cause the highlighted triangles to be added to or removed from the buffer, respectively. You may easily visualize a subset of all triangles using a 3D selection box or by drawing contours in the 3D viewer. Press the Clear button of the Buffer port to see the display shown in Figure 7.1.
Figure 7.1: Surface representation of optical lobe as triangular grid
7.2 Creating a Tetrahedral Grid from a Triangular Surface

To use the features described in this section an Amira XMesh Extension license is required.

By following this step-by-step tutorial, you will learn how to generate a volumetric tetrahedral grid from a triangular surface as created in the previous tutorial. A tetrahedral grid is the basis for producing various views of inner parts of the object, e.g., cuts through it, and is frequently used for numerical simulations.

The generation process consists of these steps:

1. Simplifying the surface
2. Editing the surface
3. Generating a tetrahedral grid (Amira XMesh Extension license required)

As a prerequisite for the following steps, you need a triangular surface, which is usually the result of a previous surface reconstruction. Load the supplied lobus.surf data set from the data/tutorials directory.

7.2.1 Simplifying the Surface

Usually the number of triangles created by the Generate Surface module is far too large for subsequent operations, e.g., for a numerical simulation. Thus, the number of triangles should be reduced in a surface simplification step. In Amira a Surface Simplification Editor is provided for this purpose. There may be different goals for the simplification:

- In computer graphics, one wants to prescribe just the number of faces, because this determines the rendering speed.
- For a numerical simulation, one often wants to specify the maximum edge length occurring in the grid model.

This tutorial shows how the maximum edge length can be controlled during simplification.

- Select the surface lobus.surf.
- Click on the Simplifier (triangle mesh icon) in the Properties Area.
- Set the desired number of faces to 1000 and the desired maximal distance (i.e., edge length) to 10 in the Simplify port.
- Leave the fast toggle turned off in the Options port. This will cause intersection tests to be performed during simplification, which will considerably reduce the probability that the simplified surface contains self intersections.
- Press the Simplify now button in the Action port.

Simplification terminates when either of the limits given by the number of faces or the maximum distance is reached. The progress bar tells you how much of the simplification task has already been
done. In this example the maximum distance will be the limiting factor, and the resulting surface will contain about 6000 faces.

Besides the maximum edge length, the minimum edge length occurring in the surface should also be controlled, because the ratio of maximum and minimum edge length will influence the quality of the resulting tetrahedral grid. This ratio should not be much larger than 10. If edges that are too short occur in the simplified surface, they can be removed as follows.

- Set the desired minimum distance to 2 in the Simplify port.
- Observe the number of faces as shown at the Surface port, and press the Contract edges button in port Action. All edges shorter than 2 will be contracted. In this example about 30 small edges will be detected. You will observe that the number of faces slightly decreases.

7.2.2 Editing the Surface

As a second step of preparation for tetrahedral grid generation, invoke the Surface Editor.

- Select the surface lobus.surf.
- Leave the Surface Simplification Editor (Simplifier) by again clicking on the triangle mesh icon.
- Enter the Surface Editor by clicking on the Surface Editor button in the Properties Area.

Figure 7.2: Surface representation of optical lobar as triangular grid
Automatically, a *Surface View* module will be attached to the *lobus.surf* surface. For details about that module see, its description.

When the *Surface Editor* is invoked, the *Surface* menu is added to Amira’s menu bar and a new toolbar is placed just below Amira’s viewer toolbar. The *Surface/Tests* menu contains 8 specific tests which are useful for preparing a tetrahedral grid generation. Each of the tests creates a buffer of triangles which can be cycled through using the back and forward buttons.

- Select *Intersection test* from the *Surface/Tests* menu. The total number of intersecting triangles is printed in the console window. Intersections shouldn’t occur too often if toggle *fast* was switched off during surface simplification. In case they occur, the first of the intersecting triangles and its neighbors are shown in the viewer window.

- You can manually repair intersections using four basic operations: *Edge Flip*, *Edge Collapse*, *Edge Bisection*, and *Vertex Translation*. See the description of the *Surface Editor* for details.

- After repairing, invoke the intersection test again by selecting it from the *Surface/Tests* menu or by pressing the *Compute* button.

- When the intersection test has been successfully passed, select the *Orientation test* from the *Surface/Tests* menu. After surface simplification, the orientation of a small number of triangles may be inconsistent, resulting in a partial overlap of the materials bounded by the triangles. In case of such incorrect orientations, which should occur quite rarely, there is an automatic repair. If this fails, the detected triangles will be shown, and you can use the above mentioned manual operations for repair. **Note:** There are two prerequisites for the orientation test: the surface must be free of intersections, and the outer triangles of the surface must be assigned to material *Exterior*. If the surface does not contain such a material or if the assignment to *Exterior* is not correct, the test will falsely report orientation errors.

A successful pass of the intersection and orientation test is mandatory for tetrahedral grid generation. These tests are automatically performed at the beginning of grid generation. So you can directly enter the *Generate Tetra Grid* module (see below) and try to create a grid. If one of the tests fails, an error message will be issued in the console window. You can then go back to the *Surface Editor* and start editing.

The remaining three tests analyze the surface mesh with respect to different quality measures. These tests only need to be performed if the tetrahedral quality of the volumetric grid plays an important role, e.g., if the grid will be used for a numerical simulation.

- Select *Aspect ratio* from the *Surface/Tests* menu. This computes the ratio of the radii of the circumcircle and the incircle for each triangle. The triangle with the worst (i.e., largest) value
is shown first, and the actual value is printed in the console window. The largest aspect ratio should be below 20 (better below 10). Fortunately there is an automatic tool for improving the aspect ratio included in the Surface Editor.

- Select Flip edges from the Surface/Edit menu. A small dialog window appears. In the Radius Ratio area, set the value of the "Try to flip a triangle..." field to 10. Select mode operate on whole surface. Press the Flip button. All triangles with an aspect ratio larger than 10 will be inspected; if the aspect ratio can be improved via an edge flip, this will be done automatically. The console window will tell you the total number of bad triangles and how many of them could be repaired. Press the Close button to leave the Flip edges tool.

- Select again Aspect ratio from the Surface/Tests menu. Only a small number of triangles with large aspect ratio should remain after applying the Flip edges tool.

- Select Dihedral angle from the Surface/Tests menu. For each pair of adjacent triangles, the angle between them at their common edge will be computed. The triangle pair including the worst (i.e., smallest) angle is shown in the viewer, and the actual value is printed in the console window. The smallest dihedral angle should be larger than 5 degrees (better larger than 10).

- For a manual repair of a small dihedral angle, proceed as follows: select the third points of both triangles (i.e., the points opposite to the common edge) and move them away from each other. For moving vertices, you must enter Vertex Translation mode by clicking on the first icon from the right on the top of the viewer window or by pressing the "t" key. If the viewer is in viewing mode, switch it into interaction mode by pressing the ESC key or by clicking on the arrow icon (the first icon from the top) on the right of the viewer window. Click on the vertex to be moved. At the picked vertex, a point dragger will be shown. Pick and translate the dragger for moving the vertex.

- In some cases, an edge flip might also improve the situation. Enter Edge Flip mode by clicking on the third icon from the right on the top of the viewer window or by pressing the "f" key. Switch the viewer into interaction mode. Click on the edge to be flipped.

- Select Tetra quality from the Surface/Tests menu. For each surface triangle, the aspect ratio of the tetrahedron, which would probably be created for that triangle, will be calculated. The aspect ratio for a tetrahedron is defined as the ratio of the radii of the circumsphere and the inscribed sphere. The triangle with the worst (i.e., largest) value is shown in the viewer, and the actual value is printed in the console window. The largest tetrahedral aspect ratio should be below 50 (better below 25). If all small dihedral angles have already been repaired, the tetra quality test will mainly detect configurations where the normal distance between two triangles is small compared to their edge lengths. Again, the vertex translation and the edge flip operation are best suited for a manual repair of large tetrahedron aspect ratios.

- Leave the Surface Editor by again clicking on the Surface Editor button in the Properties Area.

**Hint:** In order to see the entire surface again, select the Surface View icon, then press its Clear button and press the Add button, then press the ViewAll button in the viewer toolbar.
7.2.3 Generation of a Tetrahedral Grid

The last step is the generation of a volumetric tetrahedral grid from the surface. This means that the volume enclosed by the surface is filled with tetrahedra.

Because the computation of the tetrahedral grid may be time consuming, it can be performed as a batch job. You can then continue working with Amira while the job is running. However, for demonstration purposes, we want to compute the grid right inside Amira.

- Connect a Generate Tetra Grid module to the lobus.surf surface by choosing Compute / Generate Tetra Grid from the popup menu over the lobus.surf icon.
- Leave toggle improve grid switched on and toggle save grid switched off at the Options port. The improve grid option will invoke an automatic post-processing of the generated grid, which improves tetrahedral quality by some iterations that move inner vertices and flip inner edges and faces. See the description of the Grid Editor for details.
  If toggle save grid is selected, an additional port Grid appears, where you can enter a filename. The resulting tetrahedral grid will be stored automatically under that name. If you want to run grid generation as a batch job, you must select the save grid option.
- Press the Meshsize button of the Action port. An editor window will appear. It allows you to define a desired mesh size, i.e., mean length of the inner edges to be created, for each region. For this you must enter the bundle of that region, and select parameter MeshSize. Then you can change the value in the text field at the lower border of the editor. There are some predefined region names in Amira for which a default mesh size will be automatically set. Make sure that the default values are suitable for your application. If you are not sure about a suitable value, set the desired mesh size to 0. In this case, the mean edge length of the surface triangles will be used.
- Press the Run now button at port Action. A popup dialog might appear asking you whether you really want to start the grid generation. Click Continue in order to proceed.

Once grid generation is running, the progress bar informs you about the number of tetrahedra which already have been created. In some situations, grid generation may fail, for example, if the input surface intersects itself. Then an error message will occur at the Console Window. In this case, go back to the Surface Editor to interactively fix any intersections.

After the tetrahedral grid has been successfully created, two new icons called lobus.grid and report will be put in the Project View. You can select the first icon in order to see how many tetrahedra the created grid contains. If grid generation takes too long, you may also load the pre-computed grid lobus.grid from the data/tutorials directory. The second icon added to the Project View is a spreadsheet containing information about tetrahedral grid quality.

As the very last step, you may want to have a look at the fruits of your work:

- Hide the Surface View module by switching off its visibility toggle or removing it from the Project View.
• Attach a Tetra Grid View module to the lobus.labels.grid.
• Select the Tetra Grid View icon
• Select outlined in the port Draw Style

The Tetra Grid View module maintains an internal buffer and displays all tetrahedra stored in this buffer. By default the buffer contains all tetrahedra. You may easily visualize a subset of all tetrahedra using a 3D selection box or by drawing contours in the 3D viewer.

Similar to the Surface Editor, there is a Grid Editor which can be invoked by selecting the tetrahedral grid lobus.grid and clicking on the Grid Editor (first icon from the left in the title bar) in the Properties Area. The editor allows for selecting tetrahedra with respect to different quality measures, e.g., aspect ratio, dihedral angles at tetrahedron edges, solid angles at tetrahedron vertices, and edge length. The editor contains several modifiers that can be applied for improving mesh quality.

7.3 Advanced Surface and Grid Generation

Extracting a geometric model from 3D images can be used for:
Visualization of the boundaries of relevant features.
Measurements based on extracted geometry.
Numerical simulation of physical properties.

Amira XMesh Extension is used for geometry modeling from 3D images in a wide range of areas: industrial inspection and reverse engineering, digital rock physics, characterization of materials and design such as fuel cells, concrete, catalysts, metals, composites, carbon nanotubes, etc.

In this tutorial, you will learn how to:

- Extract 3D surfaces and grids with image-driven accuracy and consistency for single or multi-materials.
- Simplify and refine meshing for manageable mesh size and controlled mesh quality.
- Assign boundary conditions for simulation and export the resulting data.

This section has the following parts:

- Getting started: a workflow from 3D images to surfaces and grids
- Adjusting segmentation for geometry extraction
- Generating surfaces with controlled smoothing
- Using the Simplification Editor
- Using the Surface Editor
- Remeshing and exporting surfaces
- Generating tetrahedral grid
- Assigning boundary conditions and exporting data

You may skip the last two steps if you are only interested in surface extraction and not in grid generation.

You should be familiar with the basic concepts of Amira to follow this tutorial. In particular, you should be able to load files, to interact with the 3D viewer, and to connect modules to data modules. All these issues are discussed in Amira chapter 2 - Getting started.

To apply this tutorial to your data, the image filtering and segmentation steps may be critical: you will find important information about this in Amira XImagePAQ Extension tutorials.

Amira XMesh Extension actually provides support for different numerical simulation approaches: FEA/CFD solvers as illustrated in this tutorial, but also pre-processing for Pore Network Modeling (see chapter 7.6 - Amira Skeletonization User’s Guide).

### 7.3.1 Getting started: a workflow from 3D images to surfaces and grids

Whether you want to extract a surface for visualization or to build a grid mesh suitable for simulation, you need to start by providing a 3D volume defining the different features, materials or phases. This
mask can be built using different segmentation techniques in Amira, using Segmentation Editor tools or segmentation modules, which provide from manual to fully automated algorithms to identify a particular part or material in the 3D data.

In Amira, the segmentation process results in what is called a label image, each label identifying a particular material or phase in the data (see Figure 7.5). This process can be particularly important to capture accurately the required boundaries.

This tutorial assumes that the segmentation process has already been performed, as presented for instance in tutorial chapter 6.7 - Advanced Segmentation.

![Figure 7.5: Filter and segmentation](image)

**Note:** Two label images are available for this tutorial:

- SandPack128.labels.am is the data set from which are obtained all the pictures in this tutorial,
- SandPack50.labels.am is a smaller data set, extracted from the previous one, that you can use to complete the tutorial steps in a shorter time.

In order to build a 3D mesh made of 3D elements or cells, you need first to build 3D surfaces representing the boundaries of the volumes you want to mesh. In order to do this, you can use the Generate Surface module onto the label image. However, you may first want to clean up the label image by removing unwanted or useless features and by smoothing noise and voxel aliasing, in order to get an accurate, yet not unnecessarily complex surface.

### 7.3.2 Adjusting segmentation for geometry extraction

Some pre-processing can be done on the label image before going through the mesh generation process.

- With Open Data in File menu, load SandPack128.labels.am from the data/sandpack subdirectory in the Amira installation directory. Remove the Ortho Slice that was created at data loading.
- In the label image property area, invoke the Segmentation Editor in order to access the tools necessary to clean up the labels (see Figure 7.6).
The Label Filters tools, available in the Segmentation menu of the menu bar, provide means to modify the current labeling.

There may be small islands in the label image, that are not meaningful for the material visualization or for the simulation to come.

- In the viewer, use the cursor to move the XY slice to position 107.

Looking at this slice, you can observe a small island that needs to be cleaned in order to generate a suitable surface. If you move the slider back and forth, you will see that the island is part of a small bubble and not of a large material. The Segmentation Editor provides a tool to detect and remove automatically such disconnected regions.

- In the Segmentation menu, select Remove islands... (see Figure 7.7).
- Select the 3D volume option in order to remove the small bubbles.
- Press on Highlight all islands to get a preview of the bubbles that will be removed using the Apply button. You can see a preview of all islands to be removed in the top-left 3D viewer colored in red.
- Press Apply. The islands are then removed (see Figure 7.8).

Notice that if you select Current slice or All slices, the size is defined as the area of contour in a 2D slice and you may remove thin material that may have a large and meaningful volume, possibly connected in 3D.

In order to correct contour roughness due to voxel aliasing, the Smooth labels tool can be used. This smoothing process can be iterated until the desired level of smoothness is reached. Smoothing slightly changes the labeling, but also assigns probability weights to voxels that can be used later on by Generate Surface for generating smoother surfaces.

- In the Segmentation menu, select Smooth labels... (see Figure 7.9).
- Select the 3D volume mode.
- Press Apply.
- Switch back to Project View.
Figure 7.7: Islands filter dialog.

Figure 7.8: Removing islands

Figure 7.9: Smooth labels dialog

**Note:** Smoothing can alternatively be performed during the surface generation in the *Generate Surface* module as discussed in the next section.

**Tip:** The smoothing and islands removing tools will work along one direction unless ”3D volume” option is selected in the tool’s dialog box. The direction will then be the one corresponding to the currently selected view in the 3 orthogonal views of the *Segmentation Editor*. In some cases, you may want to repeat the smoothing or removing islands process in all of the 3 directions, instead of applying the tools to ”3D volume” at once.
Tip: The *Segmentation Editor* is especially appropriate for fine control of the segmentation with visual feedback. For some workflows, you can also consider filtering the label image by using modules such *Label Analysis* and *Analysis Filter, Filter by Measure*, or *Axis Connectivity* (binary label image).

### 7.3.3 Generating surfaces with controlled smoothing

*Generate Surface* creates a 3D Amira surface representing the boundaries of each material or phase. The *Generate Surface* module allows for generating a surface after applying or not smoothing operations. Depending on the shapes or features to be meshed, you may not want to apply smoothing or you may want to apply lighter smoothing, or simply use smoothing weights coming from the *Smooth label* tool of the *Segmentation Editor* (see Figure 7.10). All these options are available in the *Smoothing Type* port.

![Figure 7.10: Results of the different kind of smoothing on a segmented grain: None (top left), Existing Weights (top right), Constrained Smoothing (low left) and Unconstrained Smoothing (low right).](image)

**Note:** If you have a thin material, a strong smoothing can actually delete the material. Look at the *Generate Surface* documentation for a full description of all parameters.

- Connect a *Generate Surface* module to the label image (see Figure 7.11).
- Check that the *Smoothing Type* is set to *Existing Weights*. This option is only available if the label image contains probability weights information, which was created when applying smoothing in the *Segmentation Editor* in the previous steps.
- In the *Border* port, check the *Fit To Edges* option. This will cause the resulting surface to sharply fit to the edges of its bounding box.
- Press *Apply*.
- Attach a *Surface View* display module to the resulting surface (see Figure 7.12).
You now have a 3D surface object that consists of three patches corresponding to the number of materials identified in the label image (including the Exterior). The number of triangles resulting from the Generate Surface module may be very large and not suitable for visualization or simulation. The triangles generated through this first step may also not be suitable for simulation, considering the triangles aspect ratio for instance.

For the purpose of meshing the 3D volume from the generated surface, some quality checks for the surface are available with the Generate Tetra Grid module. This is useful to see if some improvements are required to perform the grid generation instead of directly running a grid generation that would fail or result in a bad quality grid.

- Connect a Generate Tetra Grid module to the surface (see Figure 7.13).
- Press on the Check button in port Action.

A report opens in the Tables panel, containing quality information about the two materials patches. You can observe that the largest triangle aspect ratio is highly critical, i.e., superior to 30.

You can correct this by remeshing the surface so you have simulation quality triangles. First you will
Simplify the number of triangles through a decimation or surface simplification process.

### 7.3.4 Using the Simplification Editor

The *Simplification Editor* is available in the Property window of the surface object to be simplified (see Figure 7.14).

![Simplification Editor button](image1)

**Note:** The *Simplification Editor* will do in-place simplification, so the exact initial surface will be lost. As a consequence it is recommended to duplicate the surface prior to simplification. A shortcut for this is to select the surface data object in the project view and press Ctrl-D. You may also want to use later on the shortcut F2 to rename a surface data for better reflecting its content.

- Open the *Simplification Editor*.

Look at the *Simplification Editor* documentation for a full description of all parameters. Default parameters will simplify the surface and generate large triangles in flat areas while generating smaller ones in areas of high curvature, so details are preserved. This is suitable to speed up visualization of a large surface, or to export a lightweight triangular surface file (see Figure 7.15).

For simulation purpose, most of the time, one wants balanced triangles, so instead of using the default option of decimating to a given number of faces, you can use the `max dist` field in the *Simplify* port to tell the editor what edge maximum length you are trying to achieve.

- Set the `max dist` to 2.
- Press *Simplify now* (see Figure 7.16).
- Close the *Simplification Editor*. 

![Generate Tetra Grid module](image2)
**Tip:** A good estimate of \( \text{max dist} \) can be to initialize this port to roughly 1\% of the minimum dimension of the volume. You can use Local Axes to display the actual dimension of your volume.

**Note:** The resulting number of triangles should be targeted to be around twice the number of triangles targeted for simulation because in a next step (the remeshing step), this number will be reduced by
half. So if a suitable surface for simulation is containing around 100,000 triangles, you need after this simplification step to have a surface twice as complex so around 200,000 triangles.

Notice that a too aggressive simplification can result in intersecting triangles.

At this point, you can perform quality checks again thanks to the Generate Tetra Grid module.

Now you have a simplified surface and you can use the Surface Editor to check for possible surface anomalies (such as intersections or bad aspect ratio) and to enhance triangle meshing.

### 7.3.5 Using the Surface Editor

The Surface Editor is available in the Property window of the surface object to be checked or cleaned (see Figure 7.17).

**Note:** Like the Simplification Editor, the Surface Editor will do in-place editing and the exact initial surface will be lost. While a number of surface editing operations can be undone, it is a safe practice to duplicate the initial surface prior to editing it (select surface data object in the project view and press Ctrl-D).

- Open the Surface Editor.

When the Surface Editor is activated, a tool bar and a new menu Surface are available (see Figure 7.18).
• Open the Surface menu and in the Tests submenu, select Intersection test. You can alternatively pick the Intersection test in Selector tool of the tool bar (see Figure 7.19).

![Figure 7.19: Surface Editor intersection testing submenu.](image)

The result of the test is displayed on top of the 3D viewer. In the current case, there is no intersection, so you can skip to the next test. However, be aware that intersections can be fixed automatically using the Fix intersections... tool in the Edit submenu (see Figure 7.20) or manually by using the Surface Editor tools in tool bar.

![Figure 7.20: Intersection test result and intersections fixing submenu.](image)

• In the Tests submenu, select Aspect ratio.

The triangle with the highest aspect ratio is displayed in the 3D viewer and the value of the aspect ratio is given in the top left corner (see Figure 7.21). It is possible to observe the next highest aspect ratio triangle by pressing on the right-pointing arrow in the Surface editor tool bar.

• In the Edit submenu, select Prepare Generate Tetra Grid....

• Keep the default values for lower bound and attempted tetrahedron quality and press Fix.
Close the dialog when finished.

Prepare Generate Tetra Grid combines the Flip edges..., Fix small dihedral angles..., and Fix tetra quality... tools.

If you run the Aspect ratio test again on the surface, you notice that the highest triangle aspect ratio has a much more acceptable value (below 30).

At this point, you can perform quality checks again thanks to the Generate Tetra Grid module and see also that all tests results are more acceptable.

If the surface you are editing happens to have intersections or too high triangle aspect ratio or any other issue revealed by some test on it, you may need to interact with the surface to correct it. To do so, you have to use the Tests menu and to select the test corresponding to your issue. The first problematic triangle, will be displayed, highlighted in red, among its neighbors.

For example, on the surface considered for this tutorial, the triangle with the highest aspect ratio can be improved:

- If not already done, run the Aspect ratio test.
- Switch to interaction mode (press [Esc]).
- Select the Translate Vertices button in the Surface Editor toolbar (or press T key) (see Figure

Figure 7.21: Testing the aspect ratio of triangles. A triangle with bad aspect ratio is highlighted.
Click on the vertices of the triangle you want to move and use the dragger to move it (see Figure 7.23). You can pick the square part or rod part of the dragger to translate along a plane or an axis, which can be swapped by pressing once or twice the Ctrl key. Press Ctrl-Z to undo.

Another way to improve the quality of triangles is to collapse one edge of the triangle using the Contract Edges tool:

- Run the Aspect ratio test to get the next bad triangle.
- Switch to interaction mode (press [Esc]).
- Select the Contract Edges button in the Surface Editor toolbar (or press shortcut O key) (see Figure 7.24).
- Click on the edge of the triangle you want to remove (see Figure 7.25).

At this step, you may want to re-run the Prepare Generate Tetra Grid tool.
You can ask now Amira to remesh the surface using Remesh Surface module.

7.3.6 Remeshing and exporting surfaces

- Connect a Remesh Surface module to the surface.
In the *Desired Size* port of the module, it is possible to set the targeted number of triangles as a percentage of the original surface number of triangles.

- Keep the percentage value of 50% in the *Desired Size* port.

If the surface is quite simple, the rest of the default parameters can be used, but if the surface is not so simple, for example if it includes multiple patches, tuning the parameters in advanced mode will be useful.

Smoothness is an important parameter in the advanced options. This parameter allows for controlling how sharp you want to keep angles between triangles. This is important if you want to keep sharp edges, for instance, in your surface (see Figure 7.26).

- Set the *smoothness* parameter of port *Error Thresholds* to 0.6.

As the current surface includes multiple patches with a lot of common interfaces, in order to minimize intersections near contours, between the generated triangles, the process should be split in two remeshing steps.
- Check the *fix contours* check box in the *Contour Options* port.
- Press *Apply* to run the remesher a first time.

At this step, there are no intersections, but the contours have shorter edge lengths than the rest of the mesh. This might be undesired. The next step will adjust the edge length of the contours.

- Connect a second *Remesh Surface* module to the newly generated surface.
- Set percentage in the *Desired size* port to 100%.
- Set the *smoothness* parameter of port *Error Thresholds* to 0.6.
- Remove the check of the *fix contours* option if it is checked and check the *only around contour* option in the *Zone Options* (Deploy Zone port).
- Run the remesher (see Figure 7.27).

![Figure 7.27: From left to right: initial surface, fix contours remeshing, remeshing around contours only.](image)

The triangle based surface can then be exported to various formats including STL, using *Export Data As...* in *File* menu.

At this point, you may want to go through the *Surface Editor* process again to finalize cleaning of the surface, check for intersections and check for aspect ratio.

### 7.3.7 Generating tetrahedral grid

- Attach a *Generate Tetra Grid* module to the remeshed surface.
- Press on the *Run now* button.
- Press *Continue* in the computational time warning dialog.

The module is generating a report showing some information about the quality of the mesh (see Figure 7.28). The generated tetrahedral grid can be visualized with a *Tetra Grid View* display module.

By default, all tetrahedra are generated according to the size of the triangles they are going to be "attached" to onto the surface.
Press on the *Meshsize* button in the *Generate Tetra Grid* module.

If you look at the Meshsize parameters for the two phases (pore space is *Material1* and grains is *Material2*), the value is set to the default value 0, which will trigger automatic sizing of tetrahedra according to triangles size (see Figure 7.29). You can change this mesh size parameter per material, so the grid generator will try to generate tetrahedra with this edge size while going away from the surface interface (see Figure 7.30). The edge size on the surface interface will always be the size of the edges of the shared triangles.

**Note:** If you want to change the size of the tetrahedra on the surface, you can use the *Surface Editor before the grid generation* in order to refine or simplify a particular surface patch. You can, for instance, select a material in the *Surface Editor* (that will be highlighted in red) and then refine this patch using the *Refine faces* command in the *Edit* submenu of the *Surface Editor* menu (see Figure 7.31).
7.3.8 Assigning boundary conditions and exporting data

You can use the Surface Editor to assign boundary conditions to different patches of the surface, before you actually export the 3D grid. You may want to define inlet and outlet for a flow simulation as well as walls.

- Select the remeshed surface you used to generate the tetrahedral grid.
- Open the Surface Editor.
- Switch to interaction mode (press [Esc]).
• Press on the *Magic Wand* tool.

The *Magic Wand* tool can be used in order to select a patch of coplanar triangles. You have to define the crease angle, which is the criteria used to define coplanarity of triangles and will be used by the *Magic Wand* to select neighboring triangles.

  • Set the *Degrees* parameter to a value small enough, such as 10 (see Figure 7.32).
  • Select a patch by picking any triangle from this particular patch.

![Image: Using the Magic Wand to select a patch of coplanar triangles.]

**Figure 7.32:** Using the *Magic Wand* to select a patch of coplanar triangles.

You can then assign a particular boundary condition to this patch.

  • Open the *Surface* menu, select the *Set boundary ids...* in the *Edit* submenu.
  • In the right column, select the type of boundary condition you want to assign to the patch and then press on *Set*.
  • Repeat the operation as many times as needed to have no face left undefined (see Figure 7.33).

Using the *Selector* tool from the *Surface Editor*, you can also select different patches on the whole surface and assign, for instance, a Wall boundary condition to all of the grain walls.

The *Surface View* module can be customized to display the surface colored by material but also by type of boundary conditions.

*Advanced Surface and Grid Generation*
- Quit the Surface Editor.
- In the Selection Mode port of the Surface View module, select BoundaryID.
- In the Colors port, select boundary ids (see Figure 7.34).

Once boundary conditions have been assigned to the surface, you can re-assign them to the 3D grid that was generated previously, so that if saved, these boundary conditions will be exported to the simulation solver.

- Connect an Assign Boundary Conditions module to the grid (see Figure 7.35).
- In the Surface port, select the remeshed surface on which you just assigned boundary ids.
- Press Apply.

A new grid is created, with boundary conditions assigned. It is suitable for simulation and can be
exported to FEA/CFD software using the File / Export Data As... menu (see Figure 7.36). FEA/CFD software format export is available with Amira XWind Extension.

You can then use Amira XWind Extension to post-process results of simulation back from the solver (see chapter 20 - Amira XWind Extension User’s Guide).

7.4 Visualization and Analysis of 3D Models and Numerical Data with Amira

The Amira suite provides advanced support for:

- 3D mesh generation for numerical simulation applications such as flow, stress, or thermal analysis,
- Export of surfaces or 3D meshes to numerical solvers,
- Post-processing of result data coming from solvers,
- Powerful visualization and analysis of scalar, vector, and tensor fields, coming from either simulation or measurements.

Amira enables workflows such as:

- Exploration, analysis and comparison of data coming from simulation or measurements,
- Modeling from 3D images for Finite Element Analysis (FEA), Computational Fluid Dynamics (CFD), Computer Aided Design (CAD), Rapid Prototyping,
- High quality presentation and communication, from movie generation to remote collaboration, immersive displays or virtual reality (requires Amira XScreen Extension).

Amira provides a first level of support summarized in the following sections:

- **Features for surfaces**
- **Supported grids**
- **Features for 3D grids**
- **Scalar fields visualization**
- **Vector fields visualization**
- **Time dependent data visualization**
- **Basic compute modules and tensors**

For convenience, in Amira, the Amira XMesh Extension gathers modules providing basic support for visualization of FEA and CFD data. For a complete overview of features that can complement analysis and presentation of numerical data, please refer to Features overview section.

The on-line version of this chapter contains tutorials for the following topics using Amira:

- **Air flow around an airfoil** - streamlines and other techniques,
- **Study of a helicopter combustion chamber** - scalar and vector visualization, probing, volume rendering,
- **Flow around a square cylinder** - time dependent data post-processing.

### 7.4.1 Amira features for surfaces

Amira supports visualization of triangular surfaces with attached numerical data (Surface View). Surfaces can be directly imported, or generated from 3D image labels (Generate Surface) or point clouds (Delaunay Triangulation and Point Wrap Triangulation). It is possible to simplify, smooth and edit surfaces, compute surface curvature and surface distances, align and warp surfaces, export surfaces and much more.

Amira XMesh Extension provides additional features such as surface registration (Align Surfaces), quality control (Triangle Quality), processing and visualization of vector data over surfaces (Displace Vertex, Magnitude, Vectors Slice, Stream LIC Surface, Line Streaks), data interpolation (Interpolate) and 3D grid generation (Generate Tetra Grid).

### 7.4.2 Supported grids in Amira XMesh Extension

Amira supports a wide range of 3D meshes. Display and compute modules may be dedicated to a specific kind of grid. This is specified in the module help.

In Amira you can work on:
• Regular grids,
• Unstructured tetrahedral grids,
• Unstructured hexahedral grids.

Regular grids include four types of grids:

• Uniform grids, the simplest form of regular grids because all grid cells are axis-aligned and of equal size;
• Stacked grids, that are composed of a stack of uniform 2D slices with variable slice distance;
• Rectilinear grids, where the grid cells are aligned to the axes, with distance between cells that may vary in each direction;
• Curvilinear grids, each node of which has its position stored as a 3D vector and is numbered one after another.

For more details, please refer to section 18.5.2.2 for regular coordinate types.

Section 18.5.3 for tetrahedral grids and section 18.5.4 for hexahedral grids contain information on these grid properties and on their coordinates or data storage systems.

7.4.3 Amira XMesh Extension features for 3D grids

7.4.3.1 Grid visualization

Several display modules exist for the visualization of a grid and of its components, such as the mesh, the faces, the boundaries or the nodes. It is also possible to visualize only a part of the grid, depending on the region of interest chosen or on one (or several) material(s) chosen among the different materials the set under study is made of. To that end, the modules Tetra Grid View for tetrahedral grids and Hexa Grid View for hexahedral grids provide the user with various powerful display features.

Boundary faces of a tetrahedral grid can be displayed with the previously mentioned modules or with Grid Boundary and the boundary conditions can be displayed with Boundary Conditions.

Cross sections are available for tetrahedral grids using Grid Cut.

7.4.3.2 Grid conversion, transformation and generation

The compute modules Lattice to Hexa Grid, Tetra Grid to Hexa Grid and Hexa Grid to Tetra Grid convert a grid of one type to another type. Conversion of data might be performed at the same time.

Several tools for grid generation and transformation exist for tetrahedral grids, such as Generate Tetra Grid (generation of a tetrahedral grid from a 3D triangulated surface), Merge Tetra (combination of grids) and Align Surfaces (to align triangulated surfaces). You will find an example of grid generation in the tutorial section 7.2 Creating a Tetrahedral Grid from a Triangular Surface.
7.4.3.3 Grid quality

The quality of a mesh is critical for the accuracy of the computation that are done on the grid. Therefore, quality measurement tools such as Tetra Quality for tetrahedral grids and Hexa Quality for hexahedral grids are very useful. Triangulated surfaces can be tested with Triangle Quality.

![Image](image.png)

**Figure 7.37:** Chocolate bar grid representation colored with respect to the diameter ratio of the tetrahedral cells.

7.4.4 Scalar fields visualization

The volumetric visualization tools discussed in section 7.4.3 can also be used to visualize scalar fields on the whole volume since most of these modules have a pseudo-coloring functionality.

*Field Cut* for tetrahedral grids has the same pseudo-coloring capability for visualizing cross sections of a 3D scalar field.

Isosurfaces (e.g., *Isosurface* for tetrahedra) are powerful display tools to aid in the understanding of physical phenomena and they are available for every kind of grid supported by Amira XMesh Extension.

7.4.5 Vector fields visualization

The most intuitive way to display a vector field is to plot the vectors as arrows. With the *Vectors Slice* module, you can plot vector fields defined on any grid type supported by Amira XMesh Extension on a plane cut of the domain.

A volumetric representation is available for vector fields defined on tetrahedral grids with the *Tetra Vectors* module.
The Particle Plot module represents vector fields (for all kind of grids supported by Amira XMash Extension) by particles (cones) pointing in the direction of the local flow. The particle plot can also be animated to show the flow motion.

Drawing the pathlines of particles is a good way to represent and understand the behavior of a flow, for example, for turbulent flows with many recirculations. To do so, you can use the Stream Ribbons module or the Illuminated Streamlines module. The choice of the seed points can be done in different ways, for example, using the Seed Surface module.

Finally, the Stream LIC Surface module visualizes a vector field defined on an arbitrary 3D triangular surface using a line integral convolution (LIC) algorithm which generates a surface texture that reveals the directional structure of the vector field. A similar 2D algorithm is implemented by the Stream LIC Slice module.

Please refer to tutorial Air flow around an airfoil, especially for Line Integral Convolution and Illumi-
7.4.6 Time dependent data visualization

The visualization features previously mentioned can be efficiently combined with the Time Series Control module from Amira. After loading data via the Open Time Series Data... option in File menu, one can connect display or compute modules to the data and use Time Series Control to obtain and play an animation sequence of, e.g., a flow behavior in time.

This technique is especially appropriate for the Particle Pathlines display module. Combined with the Time Series Control, it represents a vector field by a set of particles that move in time according to the vector direction and velocity.

Please refer to the Flow around a square cylinder tutorial for suggestions on other Amira XMESH Extension modules to use for time dependent data visualization. This tutorial is available in the online documentation.

7.4.7 Compute modules

Amira XMESH Extension contains some computational tools, that can be useful in the field of flow and stress analysis for example.
7.4.7.1 Basic computational tools

Coloring a 3D vector field representation or a flow cross section such as a Stream LIC Slice with respect to the magnitude of the vectors is a very common representation in physics, very often used for the velocity vector field. To compute the magnitude, the Magnitude module can be used on any type of grid supported by Amira XMesh Extension.

Divergence is an operator used in many physics equations. The Divergence module computes the divergence of vector fields defined on uniform grids. The same is true for the gradient of scalar fields or Jacobian matrix of vector fields and can be calculated with the Gradient module, on regular grids.

The Lambda 2 module returns a scalar field that is of interest for the CFD study of turbulent flows as the points where $\lambda_2$ is negative mark a vortex core.

7.4.7.2 Tensor data

Tensor generation is possible on a regular grid:

- Gradient, as presented before, computes the Jacobian matrix of a vector field;
- Rate of Strain Tensor computes the rate of strain tensor for a displacement vector field.

Amira XMesh Extension provides some computational and visualization support for symmetric second order tensors.

The Extract Eigenvalues module computes the eigenvalues of a symmetric second order tensor. Eigenvector to Color creates a color representation of the eigenvectors.

Finally, Tensor View displays symmetric second order tensors using tensor glyphs.

7.5 Introduction to the Filament Editor

This section provides a step-by-step introduction to the Filament Editor. The Filament Editor is a special purpose workroom in Amira that is designed to extract complex three-dimensional networks of filamentous structures from image data and post-process data by editing and annotating the network with label scalar data. In this tutorial, we want to demonstrate the principles of the Editor by extracting the dendritic fiber network of an invertebrate neuron. The dataset we will be working with depicts a neuron from the honeybee brain imaged with a confocal microscope and was kindly provided by Prof. R. Menzel, Free University of Berlin.

The following topics will be discussed in this section:

- Exploring the volume data
- Automatic extraction of the network
- Interactive tracing
- Labeling and visualizing the network
To access the Filament Editor, click the icon in the Workrooms Toolbar. We will begin our work by loading the 3D image dataset.

1. Load the file neuron.am located in the data/tutorials/neuron subdirectory

7.5.1 Exploration of the Volume Data

Once the image data has been loaded, the left-hand panel of the viewer shows a 2D slice of the volume, while the right-hand panel of the viewer shows the 3D objects. To have a clear idea of how the neuron spreads out in space, we will explore the volume through slicing, windowing, and rendering of the gray values.

Window Level:

1. Select the Window Level icon.
2. Click the 2D viewer.
3. Click the mouse button and hold.
4. Drag the mouse cursor left/right to change the window width, or up/down to change the window center.
5. Set the window level around 30–80.
6. Click 3D to visualize the selected voxels using a shaded volume rendering.

Browse Slice:
The browsing tool allows using the mouse to navigate through an image stack in the 2D viewer (or MPR viewer).

1. Select Browse Slice.
2. Click the 2D viewer.
3. Click the mouse button and hold.
4. Drag the mouse cursor up/down to scroll forward or backward through the image stack. If you are working with a wheel mouse you can use the wheel instead of Browse Slice.
5. Click the viewer and scroll the mouse wheel to scroll through the image stack.

Image Thickness:
The thickness of the slice can be set by sliding the Image Thickness slider. When displaying a thick slice, data values are computed as maximum intensity of the values of the original slices.

1. Set Image thickness to 25.
2. Click 3D Thickslice to visualize the thick slice in the 3D viewer.
7.5.2 Automatic Extraction of the Dendritic Tree

In a first step, you may want to automatically extract what will serve as a draft version of the neuron’s skeleton. This can be achieved with the Filament Editor’s Auto Skeleton tool.

1. Set the Window Level to 37 137.
2. Click 3D Volume Rendering beside the Window Level slider. The 3D viewer shows a shaded volume rendering of the neuron’s main branches and gives a rough estimate of what the automatic tracing procedure will consider as part of a neuron.
3. Select the Trace tab in the Tool Box and click Run of the Auto Skeleton frame. After a few seconds you will see green lines and blue points in the 2D viewer. In the 3D viewer, gray spheres are displayed together with the preview rendering. If you do not see them, click View All or the space bar to center the 3D viewer on them.
4. Adjust the Alpha slider, which appeared when you activated the 3D rendering. You can see the generated graph through the rendering.

The Auto Skeleton tool traces connected regions according to a user-defined window level and converts the centerline of those regions into graphs composed of points, segments, and nodes that are the elements of the data class Spatial Graph. The result of the skeletonization is, therefore, a Spatial Graph object that is being visualized in the 3D viewer as balls and lines as well as blue points connected by green lines in the 2D viewer.

Depending on the quality of the data and on the selected window level, the result of skeletonization will typically show several disconnected elements and loops within the networks. Disconnected elements will break the single neuron into several subgraphs. Loops, on the other hand, are parts of a graph where segments connect onto itself. In some biological objects (e.g., neurons loops) this must not occur. To identify graphs and loops, the Filament Editor offers the following dedicated tools:
1. Click **Identify Graphs** in the *Edit* panel to automatically detect and label all graphs (i.e., all connected components) in the Spatial Graph object. This creates a new label group in the *Label Editor* named *Identified Graphs* under which all identified graphs are listed as *Graph0, Graph1, ..., GraphN*.

2. To visually identify them, click on one of the items in the *Identified Graphs* list. The selected item is highlighted with red in both viewers.

3. Under *Identified Graphs*, select *Graph2* and press **SHIFT** while selecting *Graph25*, then remove them by clicking **Delete selected nodes, edges and points** in the toolbar.

4. Click **Identify Graphs** again. Now, you should have only two graphs.

5. Scale the nodes by moving the *Node Scaling Factor* slider in the *View* tab of the *Tool Box* (see details below).

At this point, we have only two graphs: *Graph0* is the large tree, while *Graph1* is just three segments and four nodes. Switch back to the *Edit* tab in the *Tool Box*.

1. Select *Graph1* in the Label Editor under *Identified Graphs*.

2. Activate **Select a single node, edge or point** in the toolbar and press **CTRL** while clicking on the closest node of *Graph0* in the 3D viewer.

3. Select **Connect selected nodes, edges and points** in the toolbar to connect the graph.

4. Click **Identify Graphs** again. At this point, you should have only one graph.

5. Click **Identify Loops** to get another label group *Identified Loops*.

6. Under *Identified Loops*, select *Loop2* and remove it by clicking **Delete selected nodes, edges and points**. Note that a segment is defined by two nodes. Therefore, when you remove a node the associated segment will also be removed. Hence the *Identified Loops* contains the looping segments, but not the nodes connecting them. However, this may produce isolated points that can be removed by **Delete selected nodes, edges and points**.

It should perhaps be noted that the *Auto Skeleton* tool is also available as a compute module in the *Object Popup* by selecting *Image Processing / Skeletonization / Auto Skeleton*. Also, there is a rich set of tools available in the *Segmentation Editor* to perform the threshold segmentation necessary for the skeletonization process. Finally, in the case of a strict tree topology it may be advantageous to restrict the search to a tree. In this use case, you may want to use the *Centerline Tree* module to extract a graph with guaranteed tree topology.

Before closing this subsection, we should save the *Spatial Graph* data object we have created, it will be useful in further steps of this tutorial.

1. Switch back to the Project View, save the object called *neuron.Smt.SptGraph* in a directory of your choice, and then remove it from the Project Graph View.

2. Switch again to the *Filament Editor* to prepare the next step.
7.5.3 Filament Tracing

The Interactive Tracer tool enables you to trace the filaments directly on the gray values using an innovative tracing algorithm developed by us. The user sets the starting and ending points of a segment, and the Interactive Tracer finds the shortest line connecting the two points with respect to the user-defined data window. Now, we can use the Interactive Tracer to retrace the neuron segments.

To clearly understand how to use the tracer, we will try to retrace a small part of the neuron tree we extracted in the previous paragraph.

1. Click New at the Graph Data port to create a new Spatial Graph data object.
2. Click in the 2D viewer. Using the Browse Slices tool or the mouse wheel, slice through the volume until you reach the root of the neuron.
3. Set the Image thickness slider to 10 for a better visualization.
4. Activate the Interactive Tracer by clicking Trace Filament in the toolbar and make sure that the Thick structures option is selected in the Trace tab.

Note that the Interactive Tracer is always active while Trace Filament is highlighted and it can be triggered only if the 2D viewer is active.

If you now move the mouse over the 2D slice, the cursor will have a cross shape whenever it is over black regions and turns into a crosshair (i.e., cross within circle) when it is over voxels that are within the window level. The crosshair shape indicates that it is possible to set tracing key points. As you will see later, when the pointer is over a traced segment (e.g., green line) a small P appears in the crosshair. This indicates that a click would select the nearest point as a key point. Likewise, an N is shown in the cursor whenever the cursor is over a node and a click will select this node as a key point. Furthermore, the cursor turns red when the trace tool is in Append mode, meaning that the next click will trigger a tracing action between the previously selected and the current key point.
1. Start the tracing by clicking on a gray value of the tree root.
2. Slice ahead and set further points until you reach the first bifurcation, then click on it.
3. Deactivate the Interactive Tracer (e.g., by clicking the Select a single node, edge or point tool or by clicking again its icon).

If you click Identify Graphs, you will see only one graph. You can also access some statistical information by clicking Graph Info in the Edit tab. This opens a spreadsheet window containing a list of all segments in the graph. The spreadsheet is interactive (i.e., if you click on a line, the corresponding segment will be highlighted in the viewer).

Repeat the actions to trace the first branching sections from the root.

7.5.4 Visualize the Network

The Spatial Graph data object is able not only to store the spatial structure (i.e., the geometry of the network), but also to associate it with scalar and label data.

Labels can also be used to tag or annotate sub-graphs according to their topology. In this example, we want to tag the three main branches of the Topology as Central, Left, and Right of a neuron tree.

If you already extracted the graph as described in the second subsection, you should now load the file you previously saved, otherwise you should go two steps back and read the subsection Automatic Extraction of the Dendritic Tree.

1. Right-click Label Editor and select Add graph label group / Empty label group.
2. Right-click on the created label and rename it Topology.
3. Right-click on the Topology label and select Add label. Repeat this action to add three labels.
4. Select and right-click on each of the created labels and rename them Central, Right, and Left.
5. Select Draw a line to select nodes, edges and points and select-lasso the right-hand branch. You can use the Draw a line to select nodes, edges and points tool in combination with the Alt + Right-click to deselect-lasso or with CTRL to add elements.
6. Right-click on label Right and select Assign selection.
7. Repeat the last two items to label Central and Left branches. Note that this is just an exercise, and it does not matter if you are exact when selecting the Center, Right, or Left segments. Now, select the View tab in the Tool Box.
8. Scale the nodes using the Node scaling factor slider.
9. Colorize the nodes according to the label by selecting Topology in Node Coloring.
10. Repeat the last item for the segments.
11. Click the color button of Right label and select a new color.

For an advanced network visualization, you can switch to the Project View. If you do so, you may attach a Spatial Graph View module to the Spatial Graph object you previously created.
7.5.5 Alternative Way to Extract a Network Using the Segmentation Editor

From the Filament Editor, switch to the Segmentation Editor by clicking Segmentation Editor in the Workrooms Toolbar. For an in-depth treatment of the Segmentation Editor, refer to the associated documentation and tutorial. For the tutorial try the following steps:

1. If the label neuron.labels is not available, create this new label image by clicking New in the Label field port located in the upper section of the user interface.
2. Create a new material by clicking Add under the Material List in the Materials port.
3. Right-click the new material in the Material List, select Rename Material, and enter neuron.
4. In the Tools tool box at the bottom section of the user interface, select Threshold Tool.
5. In the Threshold Tool area, set the threshold to 100–255, select the All Slices option and click Select Masked Voxels.
6. In the selection, click + to assign the selected region to neuron material.
7. Switch back to the Filament Editor and select neuron.labels from the Image Data pulldown menu.
8. Skeletonize the label image by clicking Run in the Auto Skeleton tool.

7.6 Skeletonization

Amira gathers a set of powerful tools for the segmentation and analysis of filamentous structures in 3D images. Examples for such data are blood vessels or dendritic branches of neurons.

The first step of skeletonization consists in creating a label or binary image from the gray valued 3D image. Amira offers a rich set of tools, including the Segmentation Editor as well as advanced image processing tools available in Amira XImagePAQ Extension. Using dedicated skeletonization
tools, the label image will be *thinned* to a 1-voxel thickness skeleton and subsequently turned into a *Spatial Graph* object holding the geometrical information of the centerlines of the filaments for further analysis.

In this chapter, you will learn how to:

- Use the *Auto Skeleton* module
- Display and export results of skeletonization
- Achieve skeletonization step-by-step for detailed control

To follow this tutorial you should be familiar with the basic concepts of Amira. In particular, you should be able to load files, interact with the 3D viewer, and connect display modules to data modules. All these topics are discussed in the Chapter 2 - Getting Started. For actual use of skeletonization with your data, you may also need to be familiar with image filtering and segmentation (see Chapter 3 - Images and Volumes Visualization and Processing in Amira). Further related tools can also be found in the Amira XImagePAQ Extension.

### 7.6.1 Getting Started with Skeletonization: The Auto Skeleton Module

The *Auto Skeleton* module extracts the center line of filamentous structures from image data. The module works on segmented images (label images) as well as on grayscale images, in which case the image is segmented instantly with a user-defined threshold value. The module basically wraps up a couple of single compute modules that have to be executed in sequence. It first calculates a distance map of the segmented image (*Distance Map for Skeleton*), and then performs a thinning of the label image so that finally a string of connected voxels remains (*Thinner*).

In this tutorial, we will extract the skeleton of a network of capillary blood vessels in the rat brain acquired with confocal microscopy.

- If the *Project View* is not empty, press *CTRL+N* to start a new empty project.
- Select *File / Open Data...* from the main menu and load the file *data/tutorials/skeleton/1ta.am* from the Amira root directory.
- Remove any default display module attached to the data and attach a *Bounding Box* module instead.
- Attach an *Auto Skeleton* module to the dataset by selecting *Image Processing->Skeletonization->Auto Skeleton* in the module finder.
- Set port *Preview* of *Auto Skeleton* to *ON* to get a 3D volume rendering in the main viewer.
- Adjust port *Threshold* of *Auto Skeleton* so that that the vessels are clearly visible. A good value for the threshold is *75*. Leave the other ports with their default settings.
- Click *Apply* to start the processing.

Figure 7.43 shows the result of these steps.
The Auto Skeleton module automatically converts the voxel skeleton to a Spatial Graph object. A Spatial Graph consists of nodes and segments where nodes are the branching points and endpoints, and segments are the curved lines connecting the nodes. The three-dimensional course of a segment is given by a sequence of points in 3D space. A set of nodes connected by segments is called a graph. A Spatial Graph data object can store several graphs. Furthermore, Spatial Graph objects can hold scalar values such as the thickness.

The Spatial Graph is created by Auto Skeleton with a Trace Lines module. Lines may appear jagged, because they connect centers of voxels. By default, Auto Skeleton smoothes the graph lines with a Smooth Line Set module. The smoothing extent can be adjusted with port Coefficients: smooth or disabled by deslecting Options: Smoothing. With selecting Options: Create SpatialView, a Spatial Graph View module is created to display the new created Spatial Graph.

As an estimate of the local thickness, the closest distance to the label boundary (boundary distance
map) is stored at every point in the Spatial Graph. The attribute is named thickness and constitutes the radius of the circular cross-section of the filament at a given point of the centerline.

**Note:** The thickness attribute is computed by Auto Skeleton as a discrete chamfer distance multiplied by $\frac{1}{3}$ of the voxel size in X, with a minimum of half voxel size. This may be used as an estimate of the local thickness. Optionally, a distance map data object can define a parameter ChamferMapScaleFactor used to adjust the thickness attribute (see details in Eval on Lines).

**Tip:** It may be useful to resample the data to an isotropic voxel size, before using the Auto Skeleton module (Resample). This optional step may improve the result of the distance map and skeletonization process, and may lead to a smoother spatial graph. Depending on the initial voxel aspect ratio, this may, however, increase the data size significantly.

**Note:** From time-to-time you may notice some star-shaped sets of connected segments in the spatial graph. This may happen, for example, when the segmentation resulted in a background boundary surrounding a very small area like a solid region hanging fully surrounded by void. This may be the sign of too much noise in the data that would require cleanup processing, such as a Gaussian filter, median filter, or more advanced filters of Amira XImagePAQ Extension. Such solid islands in segmentation may also be eliminated by using the segmentation editor or morphological tools.

**Tip:** In the case of a strict tree topology, it may be advantageous to restrict the search to a tree. In this case, you may want to use the module Centerline Tree to extract a graph with guaranteed tree topology. Note that Centerline Tree cannot be used directly with the gray image because it requires binary label image as input.

### 7.6.2 Displaying and Exporting Skeletonization Results

#### 7.6.2.1 Visualizing Skeleton Thickness

It is possible to modify the graph visualization by changing options in the Spatial Graph View module. For example, it is easy to show the segments as tubes whose diameter depends on the thickness attribute of the Spatial Graph object. This is achieved by selecting Segment Style: Tubes and selecting in port Tube ScaleFactor: Thickness. Note, however, that tube rendering may be slow depending on the complexity of the spatial graph and the graphics hardware used. In this tutorial, the segments will be displayed with a color depending on their thickness.

1. Select Spatial Graph View module.
2. Set Node port to OFF.
3. Uncheck Lines option in Segment Style port and check Tubes instead.
4. Change Tube Scale port from Constant to thickness.
5. Change Tube Scale Factor port to 1.4.
6. Change Segment Coloring port from Constant to thickness.
7. In port Segment Colormap, use Edit to select Adjust range.
Figure 7.44 shows the result of these steps.

Figure 7.44: Visualization of the Spatial Graph View Result and Associated Project View

7.6.2.2 Editing and Exporting the Spatial Graph

The Spatial Graph can be edited in the Filament Editor workroom. A comprehensive tutorial for this workroom can be found here.

Besides saving the Spatial Graph as AmiraMesh file (*.am) or AmiraMesh ASCII (*.am), you can export the data including connectivity and thickness information to various third-party formats. Duke-Southampton’s SWC format is widely used as a format to exchange neuronal morphology similar to Neuron’s HOC format.

Select the data module and choose File/Export Data As... in the main menu bar or module finder.
7.6.2.3 Spatial Graph Statistics

You can get some statistics directly from the Spatial Graph data:

1. Select the \texttt{Ita.Smt.SptGraph.am} data object.
2. Attach a Spatial Graph Statistics module to the dataset by selecting \textit{Measure And Analyze -> Spatial Graph Statistics} in the data context menu.
3. Click \textbf{Apply}.
4. A new data object will appear in the Project View: \texttt{Ita.Smt.SptGraph.statistics}. Select it and click \textbf{Show} in the Properties. (see Figure 7.6.2.3).

![Figure 7.45: Spreadsheet Containing the Results of Spatial Graph Statistics](image)

\textbf{Note:} Spatial Graph statistics can be saved in several file formats (CSV, XML, TXT).

7.6.2.4 Intermediate Data

The Auto Skeleton module can expose several intermediate data objects in the Project View. These intermediate data can be useful for checking, exporting, or as a starting point for specific processing.

1. Delete data objects \texttt{Ita.Smt.SptGraph.am} and \texttt{Ita.Smt.statistics}.
2. Select Auto Skeleton module.
3. In the Properties panel, unfold group \textit{Output Options} and check \textit{Distance Map} option in \textit{Create Objects} port.
4. Click \textbf{Apply} to process skeletonization again.
5. Attach an Ortho Slice to the data object \texttt{Ita.DistField}. The result may look like Figure 7.46.

Note that the distance map \texttt{Ita.DistField}, created by Auto Skeleton with a Distance Map for Skeleton module, is extended with a 15 voxel border as required by the Thinner module in this version when attached to data in memory.
7.6.3 Skeletonization Step-by-Step

In this section, we will perform a step-by-step skeletonization. This will allow advanced users to choose different distance map settings, or to control the sensitivity of the Thinner module to generate branch points. Let us start by creating a label image. Any of Amira’s segmentation methods can be used:

1. Remove all objects from the Project View (you can right-click in the Project View, then select Remove All Objects).
2. Choose File / Open Data... from the main menu
3. Load the file data/tutorials/skeleton/1ta.am from the Amira root directory
4. Attach a **Multi-Thresholding** module to the dataset by selecting *Image Segmentation* - > *Multi-Thresholding* in the module finder.

5. Adjust the *Exterior-Inside* slider of **Multi-Thresholding** to 75.

6. Click **Apply** to create label image *Ita.Labels*.

The next step of the skeletonization process is creating a distance map of the label image. The **Auto Skeleton** module internally uses a **Distance Map for Skeleton** module, which in turn internally creates a **Distance Map** module with default settings for the Chamfer distance. In addition, **Distance Map for Skeleton** adds to the data a background border that is required by the **Thinner** module.

Here we will do this step-by-step using the **Distance Map** module. Other distance maps such as those provided by Amira XImagePAQ Extension could be used in a similar way.

1. Attach a **Distance Map** module to *Ita.labels* by selecting *Image Processing* - > *Distance Maps* - > *Distance Map* in the module finder.
2. Set port *Type* to *Euclid* and port *Region* to *Both (unsigned)*.
3. Click **Apply** to create the distance map.
4. Attach an **Ortho Slice** module to the distance map, see Figure 7.47.
Euclidean distance may be more accurate, yet is much slower to compute than the Chamfer distance. The accuracy of the Chamfer distance map is sufficient for most applications. In particular, it makes little difference with the data used in this tutorial.

The result of the Distance Map module is a scalar field with floating point values. However, the Thinner module generates positive short integers as distance map integers. Also, an additional 15 voxels border must be added for the current implementation of Thinner.

1. Attach a Convert Image Type module to *Ita.DistField* by selecting Convert->Convert Image Type in the module finder.
2. Set Output Type: to 16-bit unsigned.
3. In port Scaling, set scale to 993. The scaling used here has no other importance than preserving significant digits of input data for driving the Thinner algorithm. It still fits in a positive short integer. The actual thickness value can be retrieved later on from the original distance map.
4. Click Apply to create a distance map data using positive short integers.
5. Select the result *Ita.to-ushort* in the Project View panel.
6. Click Crop Editor in the Properties Area.

*Skeletonization*
7. In the *Crop Editor* dialog, deselect *Add mode: Replicate* and set *Adjust* to 15.

8. Click **Enlarge** to extend the image with a border of 15 voxels.

9. Click **OK** of the dialog to close the editor.

We will now have to **thin** the label image (remove voxels from the label border), so that only the center voxels remain. We will do this with module *Image Processing-* > *Skeletonization-* > *Thinner.*

**Note:** The thinning algorithm automatically detects dead end branches of the skeleton (i.e., terminal segments of the resulting *Spatial Graph*). A parameter is used to distinguish them from random protrusions on the surface of the considered regions to avoid spurious branches. Its default value is 2 (i.e., terminal segments with a length smaller than 2 voxels are considered noise and removed). Setting this to a high value (e.g., 10) yields less terminal segments in the skeleton. The drawback, however, is a) that you also might miss real terminal segments, and b) that those detected are 10 voxels shorter.

1. Attach a **Thinner** module to the label object by selecting *Image Processing-* > *Skeletonization-* > *Thinner* in the module finder menu of *Ita.Labels.*

2. Connect the *Distmap* input port of the **Thinner** module to *Ita.to-ushort.* Here, you may check *Extended Options* to configure port *len of ends* to another value than the default 2.

3. Click **Apply** to create a thinned image data.

Next, we will convert the thinned image to a spatial graph and display it in the viewer.

1. Attach a **Trace Lines** module to *Ita.thinned* by selecting *Image Processing-* > *Skeletonization-* > *Trace Lines* in the module finder menu.

2. Deselect **point cloud** in port **Options** port as we will not need the point cloud.

3. Click **Apply** to create a *Spatial Graph* object.

4. Attach an **Eval on Lines** module to *Ita.Spatial-Graph* by selecting *Compute-* > *Eval on Lines* in the data context menu.

5. Connect the **Field** input port of **Eval on Lines** module to *Ita.DistField* containing the original float distance field. **Eval on Lines** samples the attached scalar field at the positions of the points of the *Spatial Graph* and stores the values as point attribute *thickness.* Different to the behavior of most computational modules, **Eval on Lines** will not output a modified data object, but will modify the input data itself.

6. Click **Apply** of **Eval on Lines.** The **Eval on Lines** module does not create a new data icon.

7. Attach **Spatial Graph Statistics** and **Spatial Graph View** to *Spatial Graph* to display a 3D graph and statistics (Figure 7.48) as shown in the Getting Started chapter.

8. In order to get a better visualization, you can click on the **Spatial Graph View**, toggle off **Node**, in **Segment** put the **Segment Style** port only with **Tubes**, specify *thickness* in **Segment Coloring** port. In the port **Segment Colormap** click on **Edit** and **Adjust range.** Then in the port **Tube Scale** change to *thickness.*
Figure 7.48: Visualization of the Skeleton as a Spatial Graph and the Associated Project View
Chapter 8

Registration, Alignment and Data Fusion

Spatial registration is about aligning or overlaying two or more data sets into the same coordinate system. In registration, typically one of the data sets is taken as the reference, and the other one is transformed - moved and possibly rescaled - until both data sets match. Registered data can be produced by different sensors, at different times, from different object regions, or from different specimens or models. Image registration methods can be manual, automatic, or semi-automatic. Closely related to registration is the task of data fusion, i.e., the simultaneous visualization of registered data sets, or combination into derivative data.

A variety of tools related to registration can be used in Amira depending on your purpose and on your data - geometric surfaces, 2D image stacks, or 3D volumes. Registration with Amira is used in a wide range of applications, including:

- Industrial inspection of products with respect to reference models and nominal/actual analysis and reverse engineering,
- Multi-modality image acquisitions such as CT/ MRI (Computed Tomography, Magnetic Resonance Imaging),
- FIB-SEM/µ-CT (Focused Ion Beam-Scanning Electron Microscope, micro-tomography),
- Correlative microscopy,
- 3D image reconstruction from 2D cross sections,
- Imaging of physical experiments or processes - e.g., samples subjected to heat, flooding, compression,
- 3D montage assembly - merging 3D volumes with small overlap.

The following tutorials and examples provide the basics for typical registration tasks.
• Getting started with spatial data registration using the Transform Editor
• Data fusion, comparing and merging data
• Registration with landmarks, warping surfaces and images
• Registration of 3D image data sets
• Registration with different imaging modalities
• Alignment of 2D images stacks
• Alignment and pre-processing of FIB/SEM images stacks using the FIB Stack Wizard
• Registration of 3D surfaces

You should be familiar with the basic concepts of Amira to follow these tutorials. In particular, you should be able to load files, to interact with the 3D viewer, and to connect modules to data modules. All of these topics are discussed in Amira chapter 2 - Getting started. The tutorial section 8.1.1 Using the Transform Editor is recommended as a starting point in most cases. You can then jump to the topic for your specific task. In particular, the 2D Slice Alignment tutorial may be read independently.

These tutorials cover common use cases. For specific requirements or applications that differ from these use cases, you may contact the Thermo Fisher Scientific Hotline for further discussion.

8.1 Getting started with spatial data registration using the Transform Editor

In this section, you will learn how to: change the spatial position of data objects interactively using various manipulators; how to specify numerically a geometric transformation as a combination of translation, rotation, and scaling; how to copy/paste geometric transformations; how to apply geometric transformations to data in order to change actual data coordinates or voxel image axis alignment; and where to find related tools.

This section has the following parts:

• Using the Transform Editor
• Applying Transforms
• Numerical input, console and script commands
• Transform Manipulators

8.1.1 Using the Transform Editor

Spatial data visualized within Amira are placed in a virtual three-dimensional world. That world has a unique coordinate system. Every spatial object in Amira can be arbitrarily translated relative to the world origin; likewise it can be rotated with respect to the global axes, and it can be independently scaled (enlarged or shrunk).
Select View / Global Axes to display the global coordinate axes. Global axes are centered at the origin of the world coordinates. By default, the x-, y-, and z-axes are drawn in red, green, and blue, respectively. You can also use the viewer’s compass to see 3D space orientation. Select Edit / Preferences / Layout to change Compass settings.

![Figure 8.1: 3D axes and compass](image)

Every spatial data object in Amira has an associated 3D bounding box as well as an optional geometric transformation, which can be defined as a combination of translation, rotation, and scaling (internally represented as a 4x4 homogeneous affine transformation matrix).

Rotating a scene within the viewer in "trackball" mode (hand mouse cursor) does not alter the object position or orientation relative to world coordinates. Rather, it changes the point of view of the camera around the whole scene. In order to change the geometric transformation of an object, i.e., translate, rotate or scale it with respect to other objects or to world coordinates, a Transform Editor is available for every spatial data object.

In the following example, we use the Transform Editor to manipulate surface data objects. This example would also apply to images, 3D volumes, or regular scalar fields, using modules such as Ortho Slice for display.

- Start a new Amira Project (menu File / New Project, or press Ctrl-N).
- With menu File / Open Data, load the chocolate-bar.simplified surface from the data/tutorials subdirectory in the Amira installation directory.
- Attach a Surface View module to chocolate-bar.simplified data set (i.e., choose Surface View entry from the popup menu of the data set).
- Duplicate the data object. For this, you can select chocolate-bar.simplified and press Ctrl-D or right-click and use data menu Object / Duplicate Object. The result is chocolate-bar2.simplified.
• Attach a *Surface View* module to the copy `chocolate-bar2.simplified`. You can still only see one engine shape in the viewer for now since the two data sets are overlaid.

• Select `chocolate-bar2.simplified` in the Project View.

• In the *Properties Area*, invoke the *Transform Editor* by clicking on the dragger box button. A manipulator appears around the engine surface in the viewer window: it allows you to change the transformation in 3D. The white square on the left of the data object icon in the Project View is changed to blue, indicating that an editor is active.

![Figure 8.2: Invoking the Transform Editor](image)

• Make sure to switch the viewer to interaction mode: press the arrow button in the upper left corner of the viewer, or toggle between viewing mode and interaction mode using the ESC key.

• Then click and drag a side face of the manipulator: one of the two surfaces that are currently displayed is translated along the face plane. The data object label is then displayed in italics to indicate that the data or its attached information has been modified. A manipulator has several dragger gadgets for controlling the transformation in various ways. Details of how to interact with the manipulator draggers can be found at the end of this *Transform Editor* tutorial.

![Figure 8.3: An active Transform Manipulator](image)

In the *Properties Area*, the active *Transform Editor* adds several button ports to the data object.
• The Manipulator port lets you choose among several interactive manipulators, or select a Dialog to input numerical values. These are described later in this tutorial.

• The Reset button list lets you restore the independent components of a transformation, e.g., canceling the rotation part. Using the Action port, it is possible to Undo/Redo the last transformation change.

• You can copy/paste a transformation from one data set to another. For instance:
  • Press the Copy button in the Transform Editor’s Action port of chocolate-bar2.simplified.
  • At this point, you can optionally deactivate the Transform Editor by clicking on its dragger box button.
  • Select the first loaded data set, chocolate-bar.simplified, and activate its Transform Editor.
  • Press the Paste button in the Action port of chocolate-bar.simplified: both data sets are again overlaid in the same location, the latest position of chocolate-bar2.simplified.

In order to copy transformation from one data set to another, you could alternatively use the module Copy Transformation from the object menu Geometry Transforms. The Geometry Transforms menu contains most of the tools related to registration, alignment, and transforms.

The Apply Transform button that you may have noticed in the dialog, commits the transformation. This topic is explained in more detail in the next section.

To facilitate visual control during interactive transformations, you may create an additional viewer, adjust the camera for convenient interaction, and control transformation in the other viewer.

8.1.2 Applying Transforms

At this point, there is an important concept to know about geometric transformations in Amira. The geometric transformation associated with a data object is taken into account by display modules and some other modules. However, it does not modify the original coordinates of data unless explicitly requested. That is to say, how the object is positioned in the 3D world is updated with transformations,
but the coordinates stored in the data object are not updated. For instance, the bounding box of a 3D volume or the point coordinates of a triangulated surface - sometimes referred to as data "local coordinates" - as stored in memory remain unchanged by the geometric transformation. This geometric transformation simply "presents", when needed, the transformed world coordinates to the attached modules.

It is necessary, in some cases, to actually apply the transformation in order to change the data’s initial local coordinates into world coordinates. For instance:

1. Before exporting data to non-Amira file formats. When saving data to Amira format and a few other formats, the geometric transform is stored at the same time in the file and can therefore be restored when reloading the data. However, be careful when saving or exporting transformed data sets. Most file formats do not allow you to store geometric transformations. In this case, you must apply the current transformation to the data prior to saving it. Nevertheless, when saving a project, the project file stores transformations for the referred data.

2. When some data processing or manipulation does not support geometry transformation, it requires transformed data coordinates. For instance, the lattice of a transformed volume image or regular scalar field may need to be aligned with global axes or with respect to another lattice. This is useful to perform certain lattice-aligned operations as illustrated below.

Here is a first example showing how to apply a transformation to the surface data that you already used in a previous section:

- If needed, load the supplied chocolate-bar.simplified surface data file from the data/tutorials directory; attach a Surface View module to chocolate-bar.simplified; and display the global axes with menu View / Global Axes.
- Attach a Local Axes module to the data object from the popup menu Annotate.
- Use the Transform Editor to transform the surface chocolate-bar.simplified with at least some rotation. For instance, pick and drag one of the green spherical knobs of the transformer manipulator.
- Press the Apply Transform button of the Transform Editor. Note that this operation cannot be undone. In case of vertex set objects like surfaces, the transformation is applied to all vertices. Old coordinates are replaced by new ones, and the transformation matrix is reset to identity afterwards, i.e., there is no longer any transformation set for the modified surface. After a transformation has been applied to a data set, the transformation can no longer be easily unset.
Applying transformation to image

Let’s now see how to apply a transformation to a volume data. As in the example above, this will
make the volume data appear to stay at the same location, although without any transformation set. The Transform Editor’s Apply Transform button is not available for images, regular volumes, or scalar fields. You must instead use the Resample Transformed Image module as in the following example:

- Load the image stack file chocolate-bar.am located in subdirectory data/tutorials.
- Attach modules Ortho Slice, Bounding Box, and Annotate / Local Axes to the data object chocolate-bar.am; display the global axes with menu View / Global Axes.
- Use the Transform Editor to move chocolate-bar.am with at least some rotation. When done you may deactivate the Transform Editor.
- Attach a compute module Resample Transformed Image to chocolate-bar.am from the object menu Geometry Transforms.
- In the Properties Area, set the Mode port of Resample Transform Image to “extended” in order to make sure that the result will contain all the source data.
- Press the green Apply button at the bottom of the Properties Area. The compute module produces a new data object chocolate-bar.transformed added in the Project View. The input data chocolate-bar.am remains unchanged.
- To visualize the result, you can attach to it a Bounding Box, Local Axes, and Ortho Slice modules. The result volume and attached Ortho Slice are now aligned along global axes. The input volume data has been resampled over a lattice with new bounding box coordinates.

Figure 8.7: Before applying transform to image
The *Resample Transformed Image* module can be used for sampling a volume data onto a reference lattice connected as input. Another useful feature of this module is to reorient volume data along a given plane by sampling the data on a lattice parallel to this plane. The plane can be set using a *Slice* or *Surface Cross Section* module, by arbitrary rotations, by picking three points, or by a point set to be fitted.

Applying transformations can also be performed by using the Tcl command `applyTransform` in the Amira console or in a script. Tcl commands relating to transformations are introduced in the next section.

### 8.1.3 Numerical input, console and script commands

*(This section is optional and is not required reading for completing the subsequent registration tutorials.)*

For inputting a precise spatial transformation, it is often necessary to access the numerical values of the transformation. The *Transform Editor* also lets you check or enter transformations numerically.

- The *Dialog...* button of the *Transform Editor* pops up the *Transform Editor* dialog.
Advanced users can alternatively retrieve the numerical values of a transformation, by using the Tcl command `getTransform` in Amira console (see *spatial data* reference for more details on available commands). The transformation is then printed in the console as the list of matrix values. For instance:

```
>"chocolate-bar.simplified" getTransform
0.257115 -0.306418 0 0 0.306418 0.257115 0 0 0 0 0.4 0 -4.30079 23.5849 -6.7025 1
```

Similarly, a transformation which matrix is known can be set by:

```
>"chocolate-bar2.simplified" setTransform 0.257115 -0.306418 0 0 0.306418 0.257115 0 0 0 0 0.4 0 -4.30079 23.5849 -6.7025 1
```

This provides another way to copy/paste transformation between objects. It can be done using a single command as follows:

```
>eval "chocolate-bar2.simplified" setTransform ["chocolate-bar.simplified" getTransform]
```

The components of the transformation can be obtained in human-readable form in the *Transform Editor* dialog, or by using the `getTransform` command with the option `-d`:

```
>"chocolate-bar.simplified" getTransform -d
translation: -12 0 -18
rotation: 0 0 -1 50
scaleFactor: 0.4 0.4 0.4
scaleOrientation: 0 0 1
center: 20.0481 23.4785 18.8292
```
As explained in the previous section, the transformation is at first set transiently and can be stored by saving the project, but is not a property of the object. To make the transformation permanent, enter:

```plaintext
<data> applyTransform
```

and then save the data object. A module is also available for this purpose: Geometry Transforms/Resample Transformed Image. For instance, type in the Amira console:

```plaintext
"chocolate-bar.am" applyTransform
```

The `chocolate-bar.am` data is changed to a resampled volume and the transient transformation is reset to zero. In order to provide more flexibility on the resolution of the output grid and the type of resampling, use the module Resample Transformed Image introduced in a previous section.

### 8.1.4 Transform Manipulators

*(This section is optional and is not required reading for completing the subsequent registration tutorials.)*

Many manipulators are available in the Transform Editor. Interaction with the different manipulators is detailed hereafter.

- The default manipulator is the Transformer. It allows translations, rotations, and scaling. It is the most general manipulator for doing an approximate registration.

![Transformer](image)

**Figure 8.10:** Transformer: Click-drag a corner cube to scale (hold Shift key to constrain direction, hold Ctrl key to fix opposite corner or face). Click-drag any face to translate (hold Shift key to constrain direction, hold Ctrl key for perpendicular translation). Click-drag a green ball to rotate one way (hold Shift key for free rotation, hold Ctrl key to change center).

- The Jack manipulator is convenient for translations along an axis and uniform scaling.
Figure 8.11: Jack: Click-drag rectangle or cylinder rod to translate. Press Ctrl key to change axis. Click-drag cubes to scale. Click-drag axial lines to rotate.

- The TransformBox is a simplified version of the Transformer that allows translation, rotation and uniform scaling.

Figure 8.12: TransformBox: Click-drag any small cube to scale. Click-drag any face to translate. Hold Shift to constrain axis. Click-drag any box edge to rotate.

- The Trackball and Centerball allow rotation.

Figure 8.13: Trackball: Click-drag stripes to rotate. Click-drag anywhere to rotate freely. Hold Ctrl key to scale. Hold Shift key for user axis and stripe.
Figure 8.14: Centerball: Click-drag circles to rotate. Click-drag anywhere to rotate freely. Click-drag green arrows to translate rotation center (Hold Shift key to constrain translation axis).

- The HandleBox allows translation, uniform scaling and anisotropic scaling. It is the most suitable manipulator for anisotropic scaling operations.

Figure 8.15: HandleBox: Click-drag any face to translate (Hold Shift key to constrain translation axis). Click-drag a small cube to scale.

- The TabBox allows translation and anisotropic scaling by box resize. It is used by modules such as Extract Subvolume or ROI Box (Region Of Interest).

Figure 8.16: TabBox: Click-drag any face to translate. Click-drag green vertex to modify the bounding box.

8.2 Data fusion, comparing and merging data

For getting started with 3D image fusion, please read first the Introduction to the Multi-planar Viewer. This tutorial below details advanced usage of image registration.
The task of image fusion is the simultaneous visualization and analysis of two data sets. This tutorial introduces some of the basic tools and techniques available in Amira to that end, typically used with registered or aligned data sets. Amira makes it easy to manipulate multiple data in single viewer or in multiple views, as well as to combine different data sets in the same visualization.

This section has the following parts:

- Color Wash
- Mapping a 3D volume overlaid on a surface
- Side-by-side viewers, synchronized views and objects
- More about Data Fusion

### 8.2.1 Color Wash

The Color Wash module, attached to an Ortho Slice, helps you to visualize two arbitrary images or volumes in combination. The representation of one data set is overlaid with another data set, taking into account their locations in space. The rendering of the Ortho Slice is modulated so that it also encodes the second data set.

- Load the image stack file chocolate-bar.am located in subdirectory data / tutorials/.
- Load the file chocolate-bar.labels.am from directory data / tutorials. The data set chocolate-bar.labels.am contains labeling of different regions, obtained by a segmentation of the grayscale image.
- Attach an Ortho Slice module to chocolate-bar.am.
- Attach a Color Wash module to the Ortho Slice module: right-click on Ortho Slice icon in the Project View and select Color Wash in the popup menu.
- Select the yellow icon of the Color Wash module.
- Connect the Data input port of the Color Wash module to the second data object, chocolate-bar.labels.am. To do this, you can set the port Data in the Properties Panel.
- You can change the Colormap port of Color Wash module to adjust the range. The Weight Factor port allows adjustment of the blending between the two data sets. You can also try other Fusion Method such as Magic Lens, useful for checking data alignment.
- Activate the Transform Editor of chocolate-bar.am and move the data set. You can also change the Ortho Slice orientation or slice number to control the image in a different plane.
- Note that the Color Wash data doesn’t need to be the same size or resolution as the Ortho Slice data - data can be unrelated as far as they overlap spatially. For instance, load the image stack file coreSample.am located in subdirectory data / core / and attach it as Color Wash data instead of chocolate-bar.labels.am.
8.2.2 Mapping a 3D volume overlaid on a surface

The Surface View module, used to display surface data, can also display a surface “immersed” in a volume data set (3D scalar field), mapping the volume values as colors over the surface.

- Load the image stack file chocolate-bar.am located in subdirectory data/tutorials/.
- Load the supplied chocolate-bar.simplified surface data file from the data/tutorials
directory.

- Attach a Surface View module to chocolate-bar.simplified data set (i.e., choose Surface View entry from the popup menu of the data set)
- Connect Surface View’s Colorfield input port to chocolate-bar.am data object. The surface is now colored according to chocolate-bar.am data and colormap port.
- Choose, for instance, the colormap physics.icol. Then right-click on the colorbar and choose Adjust range to chocolate-bar.am
- Use the Transform Editor to move chocolate-bar.am relative to the surface.
- Change the colorfield mapping type. With ”Per-vertex” mode, the colors are probed at the vertices and interpolated inside the surface triangles, leading to a fast but less precise rendering. Colorfield mapping precision is then limited by vertices density of the surface. The ”Per-voxel” mode accurately maps the data texture onto the surface at the expense of memory consumption and lower performance. It may be useful then to simplify the surface by using the Surface Simplification Editor.
8.2.3 Side-by-side viewers, synchronized views and objects

It is often convenient to visualize different data sets side by side in a synchronized way.

- Load the files `chocolate-bar.am` from and `chocolate-bar.labels.am` from directory `data/tutorials`. The data set `chocolate-bar.labels.am` contains labeling of different regions, obtained by a segmentation of the grayscale image.
- Attach an *Ortho Slice* module to `chocolate-bar.am` and to `chocolate-bar.labels.am`.

*Figure 8.18: Surface View colorfield mapping: per-vertex vs per-voxel*
• Right-click on the *Colormap* port of module *Ortho Slice 2* attached to `chocolate-bar.labels.am` to select colormap `labels.am`.

![Figure 8.20: View of the Colormap port with the labels.am connected](image)

For now only one *Ortho Slice* is visible since the data sets overlap.

• In the viewer toolbar, toggle on the Two-Viewers (vertical) button, and make sure that the viewer button ”Link Object Visibility” is off.

![Figure 8.21: View of the Viewer toolbar](image)

• Toggle the visibility of *Ortho Slices* to make `chocolate-bar.am` visible, for instance, only in the left viewer and `chocolate-bar.labels.am` visible only in the right viewer.

![Figure 8.22: Visibility of the two Ortho Slice modules](image)
• Right-click in the left viewer to open its popup menu then select “Link camera to...”, then click inside the right viewer to select it.

![Figure 8.23: Link Camera to... option](image)

• Select the Ortho Slice module. In the Properties Area activate the Connection Editor (as shown in picture below). Then, click on the chain-link icon that appeared beside the Slice Number port of the Ortho Slice module, and drag onto the Ortho Slice 2 module in the Project View. The Slice Number ports are now interconnected: changing one will change the other instantaneously.

![Figure 8.24: Interconnecting ports: (1) activate Connection Editor, (2) drag chain-link from one port to a module or port to be connected](image)

You can then at any time Unlink the viewers in the viewer’s popup menu (right-click in viewer). You can also disconnect the ports by right-clicking on the link-chain icon of one of the interconnected ports and selecting “disconnect” in the popup menu. This technique can be useful to compare a data set before and after processing, as shown in the following example:

• Load chocolate-bar.am, attach to chocolate-bar.am an image filter module Gaussian Filter. In the Properties Area, set the Gaussian Filter to 3D interpretation, and Kernel Type to Standard, then press Apply.
• Attach an Ortho Slice to the result data chocolate-bar.filtered, then proceed as above to set up linked viewers.

![Figure 8.25: Comparing before and after processing](image)

**Figure 8.25:** Comparing before and after processing

**Note:** See also modules *Image Processing / Filter Sandbox* and *Slice* to display on-the-fly effects of image filters.

### 8.2.4 More about Data Fusion

Amira offers many ways to compare or merge surface or scalar field data. Here are some further hints.

• You can superimpose surfaces using transparency. Here are some useful settings to tradeoff quality and performance. Best results can be achieved with the default options *fancy alpha*
and sorting in the Draw Style port of Surface View. You may want, however, to deactivate one of these options for better performance. You can also change the transparency mode in the main menu View / Transparency for different quality/performance tradeoffs. The Sorted Layers options - supported by modern graphics hardware - may give best results to prevent artifacts with complex transparent objects. See Surface View and View Menu for more details.

- For comparing surfaces, see also Measure And Analyze / Surface Distance, Measure And Analyze / Shortest Edge Distance, Compute / Interpolate, Compute / Vertex Difference, Compute / Arithmetic (for comparing data attached to surface, or mapping distance map image on surface).
- Landmarks and warping can be used for comparing data. See the related tutorial.
- You can superimpose image data using Color Wash with Ortho Slice, Ortho Views, Height Map Slice (height field + color field), Volume Rendering, Isosurface, etc.
- For comparing images, see also the modules Compare Image, Correlation Histogram, Arithmetic, Subtract Image, AND NOT Image, Blend with Image.
- Here is an example for computing difference between images using the Arithmetic:
  - Connect the Arithmetic module (Compute submenu) to one data set (Input A). Connect the second data set as Input B.
  - Type “a-b” or “abs(a-b)” in Expr field. Press Apply. The result as same dimension as Input A.

- The powerful module Compute / Arithmetic can attach to surface, grid, or image, and can be used to interpolate and map values from one data set to another or to a regular grid.
- The Merge module is available for blending images that can be arbitrarily overlapping.
- Measure / Correlation Histogram can be used for creating a label image from correlated regions in two images sets, typically after registration.
- Multi-Channel Field can group multiple grayscale images of same size for convenient display with Ortho Slice or Volume Rendering. Multi-channel objects are created automatically when reading some file formats containing multi-channel information. Alternatively, channels can be manually attached to a multi-channel object created via the Project > Create Object... menu (category Images And Fields).

8.3 Registration with landmarks, warping surfaces and image

This is an advanced tutorial. You should be able to load files, interact with the 3D viewer, and be familiar with the 2-viewer layout and the viewer toggles.

We will transform two 3D objects into each other by first setting landmarks on their surfaces and then defining a mapping between the landmark sets. As a result we shall see a rigid transformation and a warping which deforms one of the objects to match it with the other. The steps are:

1. Displaying data sets in two viewers.
2. Creating a landmark set.
3. Alignment via a rigid transformation.
4. Warping two image volumes.

### 8.3.1 Displaying Data Sets in Two Viewers

The data we will be working with in this tutorial are of the same kind you have already seen before: Two optical lobes of a drosophila’s brain.

- Load the two lobes `lobus.am` and `lobus2.am` located in AMIRA_ROOT/data/tutorials directory.
- Attach an Isosurface module to each data. Set the Threshold value to 96 for `lobus.am` and 92 for `lobus2.am`. Click on Apply.
- Change the color of `lobus2.am`’s Isosurface: In port Colormap of the Isosurface module, click on ”Edit”, then ”Option / Edit Color...”. Choose a blue color, then click on ”OK”.

In the viewer the two lobes are now visualized by the isosurfaces, the first in yellow and the second in blue. As we can see, the lobes are oriented differently. We want to look at each lobe in its own viewer.

- Choose 2 Viewers horizontal from the View Layout menu.

You can see the two lobes in both viewers.

- Visualize the first lobe (blue) in the upper viewer and the second lobe (yellow) in the lower viewer. This is done by deactivating the lower viewer toggle (orange buttons in the icons) of the Isosurface module and by activating the lower viewer toggle and deactivating the upper viewer toggle in the Isosurface2 module.
Registration with landmarks, warping surfaces and image
8.3.2 Creating a Landmark Set

Now, let us create a landmark set object.

- Right-click on the Project View, click on Create object... and select ”Points and Lines / Landmark (2 sets)” in order to create an empty landmark object. A new green icon will show up in the Project View. Since we are going to match two objects by means of corresponding landmarks we had to select the landmark objects containing 2 sets of landmarks (Landmarks (2 sets)).
- Select object Landmarks-2-sets.
- Launch the Landmark Editor by clicking on the Landmark Editor button in the Properties Area.

When starting the editor, a Landmark View module is automatically created and connected to the Landmarks-2-set data object. As indicated on the info line, two empty landmark sets are available now. We use the editor to define some markers in both objects. For the following, it is useful to push-pin the three ports on the landmark editor. In order to do so, select the gray push-pin toggles to the left of the port labels.

- Right-click on the Landmarks-2-set object and add a second Landmark View module to it.
- Select the first Landmark View module and choose Point Set: Point Set 1.
• Shift-select the second *Landmark View* module and choose *Point Set: Point Set 2*.

• Set the viewer toggles of the two *Landmark View* modules in the same manner as described for the *Isosurface* modules previously. *Landmark View* should be visible in the upper viewer and *Landmark View 2* in the lower viewer.

![Image of landmark settings](image.png)

**Figure 8.27**: The image shows how the viewer toggles and *Point Set* ports should be set.

Before starting to set landmarks it is helpful to rotate the two lobes in their viewers such that they are approximately aligned. This will make it easier to locate corresponding features in the two objects and to select reasonable positions for landmarks.

• Rotate the two lobes to align them roughly.

Now, we are ready to define and set corresponding landmarks. Select the *Landmarks* object if necessary and choose the option

*Edit mode: Add.*

To set corresponding landmarks make sure to activate the *Interact* mode by clicking on the arrow-icon in the toolbar of the main viewer and then simply click first with the left mouse button anywhere on the surface in the first viewer and click on the surface in the second viewer subsequently. The landmarks are visualized as small spheres, the first landmark in yellow and the corresponding landmark in blue. Make sure to always set the first (yellow) landmark on the first (blue) surface and the second (blue) landmark on the second (yellow) surface!

If you want to change the position of an existing landmark set
and select the respective landmark (blue or yellow) by clicking on it with the left mouse button. Then just click at the desired position.

You can also delete existing landmarks by setting

**Edit mode: Remove**

and clicking on the respective landmark. Both corresponding landmarks (blue and yellow) will be removed, no matter which one was selected.

You should now be able to create several landmarks. You may want to change the view of the objects to set landmarks on the back. In this case, you have problems defining landmarks, you may use an existing set of landmarks by loading the file lobus.landmarks.am from the directory data/tutorials. Once landmarks have been created, the next step is to transform the two objects into each other.

### 8.3.3 Registration via a Rigid Transformation

To register one object to the other, connect a *Landmark Image Warp* module to the *Landmarks-2-sets* object by clicking with the right mouse button on the *Landmarks-2-sets* icon in the Project View and selecting *Compute / Landmark Image Warp*.

We want to perform an alignment of the second lobe to the first. Therefore, the *Landmark Image Warp* module must be connected to the image data of the second lobe (use the right mouse button in the white square of the *Landmark Image Warp* icon).

The *Landmark Image Warp* module is able to perform several transformations. We start with a purely rigid transformation to match the corresponding landmarks as well as possible by performing only rotations and translations of the first object. To do that choose

**Method: Rigid**

in the *Landmark Image Warp* module and make sure that *Direction* is set to

**Direction: 2 → 1.**

Then press *Apply* to start the computation. The module creates a new data object named *lobus.Warped*. To visualize the result, connect the isosurface that was initially connected to the data of the first lobe to the result, select it and press the *Apply* button.

In order to compare the result with the second lobe, adjust the viewer toggle off its *Isosurface* module to display it in the second viewer. You should see that the result of the transformation fits the second object quite well.
8.3.4 Warping Two Image Volumes

Using the rigid transformation the object will not be deformed. To perform a deformation and obtain a better fit we can use another transformation method of the *Landmark Image Warp* module. Select the latter and choose

*Method: Bookstein* and press the *Apply* button.

To visualize the result, the isosurface has to be recomputed. Having done that, you can see both the deformed and the second lobe in the second viewer. To merely see the resulting deformation, switch off the viewer toggle off the second lobe’s *Isosurface* module.

You may also attach another isosurface to the first lobe to directly compare the original lobe with the deformed one. Only a little deformation will be seen because the two original objects were rather similar. Using more different data sets results in larger deformations.
Figure 8.28: Result of landmark-based elastic warping using the Bookstein method.

Note: The same technique can be used to register and wrap surfaces.

- The Surface View module can be used instead of Isosurface to display the surfaces data;
- The same Landmarks (2 sets) is used to define markers;
- Use Landmark Surface Warp to register or wrap the surfaces.

Note: On Mac, after performing the landmark alignment, the warped surface is clipped by the bounding box of the original data. The bounding box can be extended with the Crop Editor or the Arithmetic module before warping.

8.3.5 Retrieving and copying registration transformation using Tcl command

It can be useful to set the computed rigid or linear transformation without creating a transformed copy of a data set.

You can retrieve the transformation by using Tcl commands in the console or in a script. In the Amira console, type:

```
> "Landmarks-2-sets" computeRigidTransform
```
This computes a rigid transformation that moves the points of the first set as close as possible onto the points of the second set (the sum of the squared distances between corresponding points is minimized). The result is returned as a 4x4 transformation matrix, which, for example, can be used to transform some other data object using the setTransform command. For instance, type:

```
>eval "lobus.am" setTransform
["Landmarks-2-sets" computeRigidTransform]
```

By default, computeRigidTransform transforms the 1st landmark set into the 2nd one. You can specify which sets and order to use in the command. The command computeLinearTransform is available to compute transformations with scaling. See reference Data Type: Landmarks for more detail.

### 8.4 Registration of 3D image data sets

For getting started with 3D image registration, please read first the Introduction to the Multi-planar Viewer. This tutorial below details advanced usage of image registration.

The Transform Editor and Landmarks tools introduced in previous tutorials can be used for image registration. This section focuses on automatic optimized registration based on image comparison. In this tutorial, you will learn how to register 3D images, wholly or partially overlapping, obtained with the same or different acquisition modality.

This section has the following parts:

- Getting started with Register Images module
- Register Images guidelines
- More about the Register Images module

To follow this tutorial, you should know how to load files, interact with the 3D viewer, use modules and Transform Editor basics.

#### 8.4.1 Getting started with Register Images module

The Register Images module is mainly used to refine that process. It provides automatic registration via optimization of a quality function of the matching between a transformed model image and a reference image.

For success and best efficiency with the automatic registration optimization, the two 3D data volumes should already be positioned fairly close to their optimized alignment. Otherwise, processing could
take too much time because of the larger parameter space to be searched, despite the optimized hi-
erarchical algorithm used in Register Images. Therefore, the method for image registration generally proceeds in two steps:

1. Pre-alignment with manual or automatic approximate registration.
2. Automatic refined registration.

The following example shows step by step how to quickly register two 3D images of the same object.

- Load the image stack file chocolate-bar.am located in subdirectory data / tutorials.
- Load the label image chocolate-bar.labels.am located in subdirectory data / tutorials. This file contains labeling of different regions, obtained by a segmentation process.

Let’s now set up some convenient visualization for the data. You could simply attach Ortho Slices and Bounding Box modules to each data object.

- Attach 3 Ortho Slices to chocolate-bar.am, with different orientation (xy, xz and yz).
- Attach a Colorwash module to each Ortho Slice. Set the Data input to chocolate-bar.labels.am, and the Fusion Method to Weighted Sum.
- Activate the Transform Editor for chocolate-bar.labels.am and arbitrarily change the position and orientation for this image as shown in figure below. You can then deactivate the Transform Editor, and attach a Bounding Box module to chocolate-bar.labels.am.
- Attach a module Geometry Transforms / Register Images to chocolate-bar.labels.am, which is, therefore, considered as the model to be transformed.
- Attach the Reference input port of Register Images to chocolate-bar.am.
- Make sure that the Register Images module is selected in the Project View in order to display its control ports in the Properties Area.
You are now ready to experiment with registration following the steps below. The *Register Images* ports *Metric*, *Transform*, and *Advanced* options basically control the matching quality measure used, the degrees of freedom for the transform, and other advanced options. They will be detailed later. Let’s focus for now on the *Action* port, exposing two pre-alignment methods and the actual optimized registration.

![Figure 8.30: Register Images ports](image)
• Press first the Align Centers button. The centers of gravity of both data sets are computed considering voxel values as weights. The model’s transform is then changed to a translation aligning both centers of gravity. The two images then become close, yet you can notice some remaining shift: this is due to the gravity centers not being located at the same relative position in both data sets.

![Figure 8.31: After Align centers](image)

• Then press the Align principal axes button. The centers of gravity and moment of inertia of both data sets are computed, again taking voxel values as mass density. The corresponding principal axes are used to change the model transform. The best of 24 possible alignments of the principal axes is determined according to the image-matching quality measure (Metric port). The two images are then nearly matching again, but there is some orientation drift, in addition to translation shift: the principal axes of both data sets do not align exactly because of the different spatial distributions of voxel intensities.
• Last, press the Apply button. This starts the actual iterative registration optimization, which may take a few seconds depending on your hardware. You can then see a best-fit matching of the label image segmentation to the grayscale image.

Depending on the data sets characteristics and location, orientation, scale, you might be able to perform a successful refined registration directly by clicking on the Apply button, without pre-alignment. However, the registration may happen to fail to find the optimal position as illustrated below.

• Activate the Transform Editor for chocolate-bar-labels.am, and then change both its orientation by 90 degrees and its scaling by a factor of 2 (by Dialog, or by dragging green spherical knobs and white cubic knobs).
Then select the Register Images Module. In the Properties Panel, check Iso- in the Transform port, to enable search of scaling in addition to Rigid transform.

Press the Apply button. The registration clearly fails (with extended parameters left to default values). The position was not close enough in order to guarantee the expected optimal solution. The search stopped as it could not find a way to improve further.

Press the Align principal axes button, then the Apply button. The registration succeeds.

8.4.2 Register Images guidelines

Before using the Apply button, it is often necessary to first move the data sets closer together by some other means, pre-aligning, for instance, by using the Transform Editor, by setting an approxi-
mate transform with parameters known in advance, or by using Landmarks as described in a previous tutorial.

The easiest way for fully automatic registration, applicable in many cases, is simply to pre-align the data sets using Align Centers and/or Align principal axes before applying the registration. This may not always work, though, depending on the data sets, which can then require special handling.

1. When differences between the model and reference data set are such that the voxels moment of inertia can’t match enough anymore. E.g., some added components, particles or parts changed the model’s principal axis significantly.

2. When the model and the reference have some symmetry in voxel intensity distributions that makes the moment of inertia ambiguous. E.g., a cylindrical core sample without significant mass asymmetry.

Here are further guidelines for using the Register Images module. More details are given in a later section of this tutorial.

1. Make sure your data sets have identifiable references for pre-alignment, or keep track of information about the approximate location of the model relative to the reference. In some cases, especially if you want fully automated registration, you may need to consider adding physical markers, radio-opaque paint, or fiduciaries to your samples before acquiring images.

2. Use as few degrees of freedom as possible, if only to shorten computation. That is, prefer to set the Transform port to Rigid rather than Rigid+Iso, etc. You can also restrict the registration search to a 2D plane if appropriate (see below advanced options). Whenever possible, set the correct voxel sizes for reference and models (see Crop Editor), then set the Transform port to ”Rigid” instead of searching also for an isotropic scaling.

3. You can select a range of voxel intensities to be considered in registration (see advanced options in a later section). Register Images provides robust image matching metrics with respect to different modalities and voxel intensity ranges. However, it can be very useful to ignore the high and/or low intensity voxels of data set components that would otherwise affect the registration.

4. You may need to tune metrics and advanced parameters, depending, for instance, on the data set modality, voxel intensity distribution, dimensions, and aspect ratio. More on this available in a later section.

5. Use reduced data when necessary. Register Images uses an efficient hierarchical algorithm. However, in some cases, you can accelerate processing by subsampling the input data without losing significant precision. Also, you can reserve registration for the most relevant subset or derivative of your data set, e.g., cropped, resampled, filtered, masked or segmented, instead of processing the full original data. You can then copy the transformation from such registered ”proxy” model to the original data. As a special example, the next section shows how to register
8.4.3 More about the Register Images module

This section gives more details about the key options and advanced parameters that may be useful to set when using the Register Images module:

1. Degrees of freedom
2. Image comparison metrics
3. Optimization control

Let’s first outline how the iterative optimization of image registration works. The algorithm considers a model data set to be transformed, and a reference data set to which the model is registered.

1. The first step is to resample internally both data sets, using an adjustable resampling rate.
2. A measure of similarity between images is calculated depending on the selected metric.
3. The model transformation is modified with a variable incremental step, depending on the degrees of freedom and the optimization strategy trying to maximize similarity.
4. The process is repeated then hierarchically to higher resolutions.

Degrees of freedom

The number of transformation parameters can be selected. Four different transformations are available:

- Rigid transformation: translation and rotation
- Isotropic scaling
- Anisotropic scaling
- Shearing
2D constrained registration

In addition, you can restrict the search to transformations within the same plane. For this, switch to advanced mode and toggle the Register 2D mode.

Note that if the model or reference input is a 2D image (1 slice only in z direction), the Register port is automatically set to 2D, which constrains the search space to one plane.

You can work around this by resampling the 2D slice on a slab with at least 2 voxels depth as dimension, keeping the bounding box size to 1 voxel. Then a 3D degree of rotational freedom can be applied. This can be done with the Crop Editor, as follows: Note the bounding box extent in z direction, set Image crop max z index to 1 or more, leaving the Add mode: replicate option enabled. Make sure that the bounding box extent is set to the same extent as before (i.e., the voxel size in z direction).

Similarity metrics

The Metric port specifies the similarity measure between the two data sets.
• (Normalized) Mutual Information uses model and reference histograms to compute an energy/entropy. The goal is to minimize the entropy, so as to maximize the mutual information between the two data sets. This is the most generic and robust metric. It is recommended (especially the normalized version) when images come from different modalities (e.g., CT/MRI, ECT/XCT). Also note that the histogram range can then be specified to define the relevant voxel values to be considered for registration. You can use this to ignore high or low intensity voxels.
- **Euclidean Distance**: computes the distance between the gray values of the two images. It is well suited for data sets with similar histograms (or similar signal response). For instance, images acquired using the same modality and intensity calibrations, or overlapping parts of the same image.
- **Correlation**: computes a correlation value between the model and the reference, suited for data sets whose histograms (or signal response) are similar via a linear transformation, i.e., images acquired using the same modality but possibly not the same Intensity Range Partitioning.
- **Label Difference**, for labeled images, measures difference between two connected labels.

**Optimizer control**

You may need to adjust optimization parameters in order to balance improved accuracy, search robustness, and processing time.
- **Optimizer Step**: set the initial and final value for the step width applied in the optimization. The greater the initial value, the larger will be the transformation tested. The smaller the final value, the finer will be the transformation tested. Default values are based on the data bounding box and voxel size (see reference help for detail). If the pre-alignment is precise enough, you can reduce the initial value closer to the voxel size. When the bounding box aspect ratio is rather flat and images tend to flee away during registration, you may need to reduce the initial step in order to keep the images overlapping longer.

- **Coarsest Resampling**: set the coarsest level of resolution. Data sets will be resampled many times until the coarsest resampling rate is reached. For the coarsest search, these values can be increased.

- **Ignore finest resolution**: if this box is checked (default), the highest level of resolution will be left out. Often, full resolution is not needed to register images, which can dramatically save processing time.

Two different optimization strategies are applied, depending on the resampling level. At the finest level, the **Quasi Newton** optimizer is applied. In the other levels, the optimizer can be chosen between:

- The **Extensive Direction** or **Best Neighbor**, well suited for coarse resolution levels;
- **Quasi Newton** or **Line Search**, suited for finest resolution, or when information overlap is reduced due, for instance, to flat aspect ratio;
- **Conjugated Gradient**.
Figure 8.42: Resampling with a coarsest resampling rate of (8, 8, 8)

**Getting similarity measure with Tcl in console or script**

At the end of a registration, a distance factor can be retrieved by Tcl command in the console or in a script, providing a similarity measure:

>`"Register Images"` `getLastImageDistance`

0.300090

This allows creation of custom search scripts for specific purposes.

### 8.5 Registration with different imaging modalities

In medical imaging a frequent task has become the registration of images from a subject taken with different imaging modalities, where the term *modalities* here refers to imaging techniques such as Computed Tomography (CT), Magnetic Resonance Tomography (MRT) and Positron Emission Tomography (PET). The challenge in inter-modality registration lies in the fact that e.g. in CT images “bright” regions are not necessarily bright regions in MRT images of the same subject.

In registration, typically one of the data sets is taken as the *reference*, and the other one is transformed until both data sets match. Amira’s *Register Images* module provides an affine registration, i.e., it determines an optimal transformation with respect to translation, rotation, anisotrope scaling, and shearing.

Closely related to registration is the task of *image fusion*, i.e., the simultaneous visualization of two registered image data sets.

This tutorial shows how a registration can be performed and how to visualize the results. The following issues will be discussed:

1. Basic manual registration using the *Transform Editor*
2. Automatic registration
3. Image fusion

8.5.1 Basic Manual Registration

In this tutorial, we want to register a CT and an MRT data set of a patient, showing the pelvic region. The images are located in the Amira data directory in the subdirectory *registration*.

- Load the files `data/registration/CT-data.am` and `data/registration/MRT-data.am` into Amira.
- Attach an *Ortho Slice* module to each of the data sets.
- Select *Coronal* (or *xz*) at the *Orientation* port of the *Ortho Slice* module connected to the MRT data.
- Select a camera position for the 3D viewer where you can see both the axial slices of the CT data and the coronal slices of the MRT data.
- Select slice 31 at the *Slice Number* port of the *Ortho Slice* module connected to the CT data.

Now one OrthoSlice module should show an axial slice through the hip joints. Move the coronal slice through the MRT data. You will observe that the two data sets are not correctly aligned.

![Figure 8.43: The CT and MRT data displayed by 2 Ortho Slices](image-url)
Select the green icon of the MRT data set. Invoke the Transform Editor by pressing the Transform Editor button in the Properties Area. The Transform Editor enables you to specify an affine transformation, including translation, rotation, and scaling. This transformation will be applied to the corresponding 3D data set. You can edit the transformation interactively in the 3D viewer using different Open Inventor draggers. You can also enter transformations numerically.

- Press the Dialog button. A dialog window will pop up.
- Enter \(-2\) at the third text field of the Translation port of the dialog window. This means a translation of \(-2\) cm in the z direction.
- Enter \(5\) at the first text field at the Rotation port. This means a rotation of \(5\) degrees. The axis of rotation is defined at the next ports, here it is the z-axis.
- Press the Close button of the dialog window. Leave the Transform Editor by pressing again the Transform Editor button.

Inspect some coronal slices through the MRT data set. Now there is a better alignment of the CT and MRT data, but it’s still not perfect.

![Figure 8.44: Alignment after the manual registration](image)

### 8.5.2 Automatic Registration

The Registration module provides an automatic registration via optimization of a quality function. For registration of data sets from different imaging modalities, the Normalized Mutual Information is the best suited quality function. In short, it favors an alignment which ”maps similar gray value structures to similar gray value structures”. A hierarchical strategy is applied, starting at a coarse resampling of the data sets, and proceeding to finer resolutions later on.

- Attach an Registration module to the MRT data set by choosing Geometric Transform/Register Images from the popup menu over the MRT-data.am icon.
- Connect the second input port Reference of module Registration to the CT data set. For this click with the right mouse button on the white square at the left hand side of the module’s icon.
• Select toggle *Extended options*. More ports of the *Registration* module will become visible.

The first three ports of the *Registration* module define the optimization strategy. The default settings mean that an *Extensive Direction* optimizer is used for the coarse levels and a *Quasi Newton* optimizer for the finest two levels of the resampling hierarchy. At the *Coarsest Resampling* port you can select the resampling rate for the coarsest resolution level. The default resampling rate is smaller in the *z* direction because the reference data set has a finer resolution in the *x* and *y* direction (0.17 cm) than in the *z* direction (0.5 cm). For the default settings (8,8,3), the resampling hierarchy will consist of four levels: (8,8,3), (4,4,2), (2,2,1), and the original resolution, (1,1,1).

The *Normalized Mutual Information* is calculated from gray value histograms. The selected histogram ranges should enclose the essential information of each data set. Normally you can choose the same range as for visualization via an *OrthoSlice* module.

• Set \(-200\) and \(200\) at the two text fields of the *Histogram range reference* port.

At the *Transform* port you can specify the type of affine transformation. The default settings mean that only rigid body motions will be applied, i.e., translations and rotations.

Option *Ignore finest resolution* means that optimization is done on all but the finest level of the resampling hierarchy. This will slightly reduce the accuracy, but save a large amount of computing time.

Automatic registration may take some time depending on the resolution of the images and the quality of the pre-alignment. You can interrupt automatic registration at any time using the stop button. Interruption may take some seconds. The progress bar shows the current hierarchy level and the progress at that level.

• Start automatic registration by pressing the *Apply* button.

![Figure 8.45: Result of Register Images alignment](image-url)
8.5.3 Image Fusion

The task of image fusion is the simultaneous visualization of two data sets. To that end Amira offers for all types of slicing modules (Ortho Slice and Oblique Slice) the Colorwash module. Using Colorwash, the images from one data set can be overlaid over that of another taking into account their orientation in space.

- Remove the Ortho Slice module connected to the MRT data set.
- Select the green icon of the MRT data set.
- Select a Colorwash module from the popup menu over the icon of the OrthoSlice module connected to the CT data set.
- Select the yellow icon of the Colorwash module.
- Select the physics.icol colormap at port Colormap.
- Set 70 as the upper bound for the colormap range.
- Select the icon of the OrthoSlice module.
- Inspect axial slices with slice numbers between 15 and 45.

You will observe a good alignment of the pelvic bone from both data sets. The soft tissue contours are not perfectly aligned because there was some soft tissue deformation between both scans. This cannot be described by a rigid transformation.

In image fusion it is sometimes necessary to observe all three orthogonal directions simultaneously. For that the Standard View module can be used for image fusion. The Standard View module opens a separate window with four viewers, three of them showing the three orthogonal slices of the image data and a fourth being a new instance of the 3D viewer.

- Attach a Standard View module to the CT data set. Amira’s Viewer window will now be split into four parts showing three orthogonal slices through the CT data, and the 3D Viewer in the upper left part.
• Connect the second input port Overlay Data of the Standard View module to the MRT data set. For this, click with the right mouse button on the white square at the left hand side of the module’s icon.

• Select slice numbers 179, 149, and 31 at ports Slice x, Slice y, and Slice z, respectively. The three orthogonal slices will show the hip joints now.

• Increase the zoom-factor by clicking twice on button > at the Zoom port.

• Select checkerboard at the Overlay mode port.

• Vary the size of the checkerboard tiles by moving the slider at the Pattern size port. In this way you can again check the alignment of the CT and MRT data sets.

![Figure 8.47: Standard View in Checkerboard mode](image)

The bone contours around the hip joints show a good match. Note that bone is represented by white (i.e. high intensity) voxels in the CT data, but may occur as both white and black voxels in the MRT data. In the axial slice you can observe larger deviations of the outer body contour between the CT and MRT data.

8.6 Alignment of 2D images stacks

Many microscopy techniques require the specimen to be physically cut or captured into slices and then images are taken from each cross section separately. Often the images will be misaligned relative to each other. The images have to be aligned in order to turn the initial image stack into a correct 3-dimensional model of the specimen.

Beside the general registration module Register Images described in a previous tutorial, Amira provides the Align Slices module for alignment of serial sections. Align Slices can be used, for instance, with histological slices, or milled or polished material surface layers, images at different focal planes, captured with cameras, light, confocal or electron microscopes, etc.
Note that we do not address here the specific case of alignment of projection images collected by variable tilt tomography, which is a prerequisite to tomographic reconstruction. While Amira algorithms could be used for such alignment to some extent, this is beyond the scope of this tutorial.

*Align Slices* is used for aligning 2D slices of a 3D image stack. The module *Register Images*, which can be also used to register 3D or 2D images, is described in a separate section. Alignment with *Align Slices* module can be manual, automatic, or semi-automatic. The following topics will be discussed:

- Basic manual alignment
- Automatic alignment
- Alignment via landmarks
- Optimizing the quality function
- Resampling the input data
- Other alignment options and guidelines

### 8.6.1 Basic manual alignment

In this tutorial, we want to align 10 microscopic cross sections of a leaf showing a stomatal pore. The images are located in the *data* directory in the subdirectory *align*. Each slice is stored as a separate JPEG image. The file *leaf.info* defines a 3D image stack consisting of the 10 individual slices. It is a simple ASCII file as described in the stacked slices file format section.

Note that this example data set is a stack of color images (RGBA). See also the section "More about align slices" at the end of this tutorial for issues to be considered when using grayscale images.

- Load the file *data/align/leaf.info*.
- Create an *Align Slices* module by choosing *Geometry Transforms / Align Slices* from the popup menu over the *leaf.info* icon.
- Press the *Edit* button of *Align Slices*.

![Figure 8.48: Setting up Align Slices](image-url)
The slice aligner window opens in place of the 3D viewer, allowing you to interactively align the slices of the 3D image stack. To facilitate this task, usually two consecutive slices are displayed simultaneously. One of the two slices is editable, i.e., it can be translated and rotated using the mouse. By default, the upper slice is editable. This is indicated in the tool bar of the align window (the upper slice button is selected).

![Figure 8.49: Align Slices menu and toolbar](image)

- If necessary, press the zoom out button to allow the entire slice to be visible in the viewer.

![Figure 8.50: Zoom out button](image)

- Translate the upper slice by moving the mouse with the left mouse button pressed down.
- Rotate the upper slice by moving the mouse with the left mouse button and the Ctrl key pressed down. Alternatively, slices can be rotated using the middle mouse button.
- Make the lower slice editable by selecting the lower slice tool button. Translate and rotate the lower slice.
- Hold down key number 1. While this key is hold down, only the lower slice is displayed.
- Hold down key number 2. While this key is hold down, only the upper slice is displayed.
- Pressing key number 1 and 2 also changes the editable slice. Note how the slice tool buttons change their state.

Other pairs of slices can be selected using the slider in the upper left part of the align window. Note that the number displayed in the text field at the right side of the slider always refers to the editable slice. The next, or the previous pair of slices, can also be selected using the space bar or the backspace key, respectively. The cursors keys are used to translate the current slice by one pixel in each direction.

- Browse through all slices using the space bar and the backspace key. Translate and rotate some slices in an arbitrary way.
- Translate all slices at once by moving the mouse with the left mouse button and the Shift key pressed down.
- Rotate all slices simultaneously by moving the mouse with the left mouse button and the Shift and Ctrl key pressed down. Moving all slices simultaneously can be useful in order to move the

Alignment of 2D images stacks 369
region of interest into the center of the image.

8.6.2 Automatic alignment

Besides manual alignment, four automatic alignment options are supported: alignment using a gravity centers and principal axes transformation, automatic optimization of a quality function, edge detection-based alignment, and alignment via best fit of user-defined landmarks. The principal axes method and the edge detection method are only suitable for images showing an object that is clearly separated from the background. The optimization method requires that the images are already roughly aligned.

Depending on acquisition modality and quality, slices can have moderate drift that can be corrected easily automatically. In some cases, one has to correct a few abnormal slices to enable automatic alignment. A general workflow could be outlined in two steps:

1. Pre-alignment with manual or automatic method
2. Automatic alignment optimization

Often such a pre-alignment can be achieved using the landmarks method.

8.6.3 Alignment via landmarks

Alignment via landmarks first requires you to interactively define the positions of the landmarks. This can be done in landmark edit mode.

- Activate landmark edit mode by pressing the landmark alignment mode button.

![Figure 8.51: Landmark alignment mode button](image)

In landmark edit mode only one slice is displayed instead of two. Two default landmarks are defined in every slice.

- Once you have activated the landmark edit mode (arrow mouse cursor), click on one of the default landmarks. The landmark gets selected and is drawn with a red border.
- Click somewhere into the image in order to reposition the selected landmark.
- Click somewhere into the image while no landmark is selected. This causes the next landmark to be selected automatically.
- Click at the same position again in order to reposition the next landmark.
The double click method makes it very easy to define landmark positions. Of course, additional landmarks can be defined as well. Landmarks can also be deleted, but the minimum number of landmarks is two.

- Choose Add from the Landmarks menu.
- Click anywhere into the image in order to specify the position of the new landmark.
- Select the yellow landmark by clicking on it.
- Choose Remove from the Landmarks menu in order to delete the selected landmark again.

Two landmarks should be visible now, a red one, and a yellow one. Next, let us move these landmarks to some reasonable positions so that we can perform an alignment.

- Select slice number 0.
- Place the landmarks as shown in the Figure 8.52. Make use of the double-click method.
- In all other slices, place the landmarks at the same positions.

![Figure 8.52: Setting landmarks with Align Slices](image)

Once all landmarks have been set, we can align the slices. It is possible to align only the current pair of slices, or to align all slices at once. Note that all alignment actions, as well as landmark movements,
can be undone by pressing Ctrl-Z.

- Switch back to transform mode by pressing the manual alignment button. Two slices should be displayed again.
- Align the current pair of slices by pressing the align current slice pair button.
- Align all slices by pressing the corresponding button.
- Move and rotate the whole object into the center of the image using the mouse with the Shift key hold down.

![Image](image.png)

**Figure 8.53**: (1) Manual alignment button; (2) Align current slice pair; (3) Align all slices

In most slices the alignment now should be quite good. However, looking at the pairs 3-4 and 4-5 (displayed in the lower left corner of the align window) you’ll notice that there is something wrong. In fact, slice number 4 has been accidentally inverted when taking the microscopic images. Fortunately, this error can be compensated for in Amira.

- Select slice pair 3-4 and make sure that the upper slice, i.e., slice number 4, is editable.
- Invert the upper slice by pressing the mirror editable slice button.
- Realign the current pair of slices by pressing the corresponding button.
- Select slice pair 4-5 and realign this pair of slices as well.

![Image](image.png)

**Figure 8.54**: (1) Mirror editable slice button; (2) Align current slice pair

Alternatively, you could have aligned all slices from scratch by pressing the first button from the right.

### 8.6.4 Optimizing the least-squares quality function

Once all slices are roughly aligned we can further improve the alignment using the automatic optimization method. The quality of the current alignment is displayed in the status bar of the align window. This is a number between 0 and 100, where 100 indicates a perfect match. The quality function is computed from the squared gray value differences of the two slices. The optimization method tries to maximize the quality function. Since only local maxima are found, it is required that the slices be reasonably well aligned in advance.
• Click on the slice in the viewer. The quality of the alignment is displayed in the status bar at the bottom of the window. Remember the current quality measure.
• Activate the optimization mode by pressing the least-squares alignment mode button. Remember the current quality measure.
• Align the current pair of slices by pressing the corresponding button. Observe how the quality is improved.

Figure 8.55: (1) Least-squares alignment button; (2) Align current slice pair

Automatic alignment is an iterative process. It may take quite a long time depending on the resolution of the images and on the quality of the pre-alignment. You can interrupt automatic alignment at any time using the Stop button.

• Automatically align all slices by pressing the first button from the right.

8.6.5 Resampling the input data into result
If you are satisfied with the alignment, you can resample the input data set in order to create a new aligned 3D image suitable for further visualization or processing. This is done using the Resample button of the Align Slices module.

• Press the Resample button of the Align Slices module. The images are resampled using an accurate interpolation method. Note that the Align Slices’ port Resample Method lets you alternatively choose a fast preview mode.
• Before visualizing the result, you could open an extra viewer (menu View / Layout / Extra Viewer). For now, simply press the Close button of Align Slices module in the Properties Area to close the slice aligner window and display again the main viewer window. When closing the Align Slices edit mode, you can confirm to save the modified transformation information into the data parameter section of the input object (next section shows how this can be used).
• Attach an Ortho Slice module to the resulting object leaf.align and verify how the slices are aligned.

By default, the dimensions of the resampled image result are the same as the dimensions of the input image. When Align Slices editor is active, you can choose menu Align / Options and select Output tab, then you can define a different output size, including automatic fit for all slices. See Align Slices help for more details.
8.6.6 2D alignment guidelines, more about Align Slices

Completing alignment

Sometimes you may want to improve an alignment later on. In this case, it is a bad idea to align the resampled data set resulting from initial alignment, since this would require a second resampling operation, cumulating interpolation errors. Instead, you could write the transformation data into the original image object and store this object in Amira format. After reloading the Amira file, you can attach a new Align Slices module and continue with the stored transformations.

- Make sure that the slice aligner window was closed as described in previous steps, so that the slice transformations are recorded in the data parameters of the input object leaf.info. Note that you can Choose Save transformation from the Options menu of the slice aligner at any time while you are modifying slice alignment.
- Delete the Align Slices module.
- Save leaf.info in Amira format. For this use menu File / Save Data As, then make sure an Amira native format is selected.
- Reload the saved object leaf.am.
- Attach a new Align Slices module to leaf.am and click the Edit button. You can verify that the original alignment is restored.

Using a reference image alignment

In some cases, you might want to reapply the same alignment to a separate image stack with the same dimensions, such as an additional acquisition channel or a segmented image (label image). For instance, you might want to correct the alignment after image segmentation has been performed independently. In order to avoid segmenting the newly resampled image from scratch, you can apply the same transformations to the label image using a reference image.

- Delete any existing Align Slices module.
- Load the file data / align / leaf-unaligned.labels into Amira.
- Attach a new Align Slices module to the label image.

The guard cells of the stomatal pore are marked in the label image. Segmentation has been performed before the images were aligned. Now we want to apply the same transformation defined for the image data to the labels.

- Connect port Reference of Align Slices to leaf.am. This is done by activating the popup menu over the small rectangular area at the left side of the Align Slices icon. Observe how the transformations are applied to the label image.
- Export an aligned label image by pressing the Resample button.

Note about color image segmentation: The image volume used in this tutorial is an RGBA color field. You can use Interactive Thresholding for color image segmentation. However, other tools such as the
Segmentation Editor only support grayscale images. Therefore, you must convert the color field into a scalar field using Convert Image Type or into separate channels using Channel Works before you can invoke such segmentation tools for the resampled labels.

**Grayscale images**

When attaching Align Slices module to grayscale image, a Intensity Range port is available to select the range of intensity used for display and for computing alignment. It is important to make sure that the selected range contains the intensity values you want to be considered in alignment. By default, the data window is determined automatically by image histogram (see tutorial section 3.4 on Intensity Range Partitioning for more information).

**Selecting data used for alignment**

In some cases, automatic alignment can be distorted by anomalies that cannot be tracked consistently across all slices, such as bright spots or artifacts appearing on individual slices. Here are some hints to solve this:

- When using grayscale image input, selecting an appropriate data window is a way to filter out unwanted high or low pixel values.
- Align Slices can use a label image connected to its Mask input port to restrict the region considered for automatic alignment. You can easily produce such a mask by using, for instance, the Segmentation Editor or the Volume Edit module.
- In complex cases, you could perform alignment based on any subset or derivative of initial image stack (e.g., cropped, filtered, or segmented), and then reapply the alignment to the original data.

**Tuning alignment options**

Here are some guidelines for tuning automatic alignment. For accessing Align Slices options, select the menu Align / Options when Align Slices edit mode is active.

- If alignment of a full stack fails, you may save time by trying to identify the first slices that fail and improving alignment for those slices at first.
- In the General tab, uncheck the Allow Rotation checkbox to disable rotation in the alignment.
- In the Least Squares tab, you can increase the Max number of iterations (e.g., to 5000) if the alignment process stops before correct match.
- In the Least Squares tab, you can reduce the Resample size scale factor if a slice ’flees’ out of the canvas. This may happen if there is not enough information or overlapping for meaningful quality measure at the coarse resolution that is used to speed up the first steps of the process.
- You can fix the reference slice used for alignment across the whole stack with menu Options / Fix Reference. This could be used in combination with an input Mask image to select a limited image area as a fixed reference.

**More about alignment data parameters**

The slice alignment transformations are stored in a data parameter bundle AlignTransform and there-
fore can be written into the file header of the aligned stack. Such data parameters can be viewed with the Data Parameter Editor.

For example,

```
slice044 6 4 -16.3025 -1
```

indicates that slice 44 was translated 6 voxels in X, 4 voxels in Y, and rotated -16.3025 degrees about Z. The -1 means that the slice was not mirrored (If 1, it would mean that the slice has been mirrored).

![Data Parameter Editor](image.png)

**Figure 8.56**: Alignment data parameters

## 8.7 Alignment and pre-processing of FIB/SEM images stacks using the FIB Stack Wizard

The capture of image stacks using FIB/SEM devices (Focused Ion Beam / Scanning Electron Microscope) may require alignment and other pre-processing such as foreshortening, shear, and shading correction. A script module FIB Stack Wizard is available to assist this workflow.

FIB/SEM is a powerful technique for imaging samples in 3D at the nanometer scale, optionally with compositional information. A FIB/SEM DualBeam device combines a Focused Ion Beam for milling serial cross sections in the sample, and a Scanning Electron Microscope for imaging the milled 2D
sections. A variety of detectors (SE, low kV BSE, EDX, EBSD, etc.) can be used for analyzing the sample’s materials and structure.

After such a FIB serial sectioning acquisition, a 3D model can be reconstructed from the 2D images. Depending on the input data and purpose, some pre-processing including alignment and other steps may be required, in particular to ensure the accuracy of the 3D model for further quantitative analysis. The angle between the ion beam and the electron beam is typically 52 degrees. Because of angle between milled surface and imaging axis is not 90 degrees, the raw captured images shows a geometrical

Figure 8.57: FIB/SEM principle: overviews, SEM views, serial sections

Alignment and pre-processing of FIB/SEM images stacks using the FIB Stack Wizard 377
artifact compared to real sections:

- Apparent vertical shift upward that grows with each image in the stack
- Foreshortening: vertical size (y axis relative to capture) appears compressed.

You may get images already corrected for these effects, but in some cases it may be necessary to compensate them with downward shift, i.e., stack shearing and stretching.

Another unwanted artifact is lateral drift that may occur, especially during long acquisitions, yet even shorter ones can show some jittering drift between images, due to environment vibration, for instance.

In addition to geometrical artifacts, some further image processing may be needed to correct for noise or non-uniform illumination (sometimes described as shadowing).

Amira provides a number of tools for processing and analyzing FIB/SEM image, including a convenience script module that steers you along the most common processing steps: the FIB Stack Wizard.

In this tutorial, you will learn in particular how to use the FIB Stack Wizard and other Amira tools for:

- Importing and calibrating voxel size
- Geometry correction and cropping
- Shading correction
- Image filters

Advanced users familiar with scripting may look at the FIB Stack Wizard as an example of a workflow-driven script module.

### 8.7.1 Images import, voxel size and foreshortening correction

The data set used in this tutorial is derived from images of a sample of molybdenum disilicide (MoSi2), a material used in furnace heating elements, by courtesy of C. Kong, University of New South Wales, Australia. The original images (2048x1768 x 300 slices) have been modified for the purposes of this tutorial.
With menu *File / Open Data*, load the data file `MoSi2-shear-corrected.am` located in subdirectory `data / fib` in Amira installation directory. This image stack was saved as a native Amira data file. About loading stacks of image files, see the tutorial section 3.1 (How to load image data).

You can attach one or two *Ortho Slice* modules to `MoSi2-shear-corrected.am` to examine the data, or use the *Ortho Views* module to set up 4-view display.

The full data set extent is 64 micrometers in width and 36 micrometers in depth, i.e., for the resampled images about 0.125\(\mu m\) pixel size (X-Y field-of-view) and 0.486\(\mu m\) slice thickness (Z voxel size).
Depending on the input file format, you can specify the pixel size and slice thickness as ‘voxel size’ when loading the data if information could not be retrieved from the file. You can always check and adjust it afterwards by using the Crop Editor.

- Activate the Crop Editor for MoSi2-shear-corrected.am to see the bounding box extent and corresponding voxel size in the dialog box. You can then deactivate the Crop Editor.

![Crop Editor dialog box](image)

**Figure 8.60**: Bounding box and voxel size

**Non uniform slice thickness**

If variation of slice thickness matters for your application, you can import images using the Amira Stacked Slice file format, which defines the depth for each individual slice. This is described in the tutorial section 3.1 (How to load image data). A number of Amira tools can be directly applied to such
data with irregular, so-called "stacked slice" coordinates. You may also turn the images into a uniform scalar field using Arithmetic or Resample modules (use a uniform lattice as reference input for the Resample module).

**Foreshortening**

Depending on how the data was collected, you may have to correct the foreshortening effect seen in introduction. If you entered the field-of-view for the Y-axis, then there will be no need to make this correction. If you entered the same voxel size for x and y, and the instrument did not already apply a stretching correction, then you may want to correct by entering the corrected voxel height directly into the Crop Editor. To apply the foreshortening correction in the Crop Editor, multiply the voxel height by a correction factor, depending on the angle between FIB and SEM columns. For instance, for a 52 degrees angle: 

\[
\frac{1}{\sin(52^\circ)} = \frac{1}{\cos(90^\circ - 52^\circ)} \approx 1.269.
\]

The file MoSi2-shear-corrected.am was already corrected for foreshortening.

**Measurement units**

Note: Indicating "nm" as Display units in the Preferences will output measurements in nm. To learn about unit management in Amira, see the section 10.2.9 (Units in Amira) in Amira User’s Guide.

### 8.7.2 Geometric corrections overview

**Upward shift / shearing**

Beside the voxel size, the collected images may need further kinds of geometry correction.

In raw images as seen from the SEM viewing angle, the sections appear shifted, while the surrounding background or trench stays aligned horizontally across the series. Obviously the 3D structures inside the sections looks "sheared" on an YZ slice and need to be corrected.

![Figure 8.61: Sheared image stack](image)

Raw image stack display showing vertical shift of the serial sections. A clipping oblique Slice is used to highlight the sample slope.
We’ll see later in this tutorial how to address this case using data set MoSi2-sheared.am. The data set MoSi2-shear-corrected.am was already corrected for electron beam angle as you can see below. The sample sections are aligned horizontally, while the surrounding trench looks sheared in turn since it is fixed relative to the microscope raw images.

![Shear-corrected image stack](image)

**Figure 8.62:** Shear-corrected image stack

**Drift correction**

Images corrected for viewpoint angle may still need correction from drift as show below, mostly visible in XZ slices of MoSi2-shear-corrected.am.

![XZ and YZ slices with jittering effect](image)

**Figure 8.63:** XZ and YZ slices with jittering effect

**Cropping**

Cropping is necessary to remove unwanted areas in the 3D reconstruction, such as the trench surrounding area, or textual information that may be located at the bottom of the images.
8.7.3 Getting started with FIB Stack Wizard

The FIB Stack Wizard, accessible from the menu Geometry Transforms / FIB Stack Wizard, can be used for alignment/shearing correction as well as for shading correction. The wizard module guides you step by step along the process. Data will be duplicated since the wizard allows you to go backward in the steps to correct specific actions. The following steps are proposed by the FIB Stack wizard:

1. Initial cropping before alignment
2. Automatic alignment
3. Crop after alignment
4. Shearing correction
5. Shading correction

- You can now remove any remaining Ortho Slice or other display modules in the project: the FIB Stack Wizard automatically sets up an Ortho Slice display.
- Attach the module FIB Stack Wizard to MoSi2-shear-corrected.am.

An Ortho Slice with a tight Color Wash module is attached to the data set, and a Crop Editor dialog is displayed.
Once the FIB Stack Wizard is selected in the Project View, its control ports are displayed in the Properties Area.

A Mask input connection port lets you attach a label image serving as a mask during alignment. This will be detailed later.

- You can use the Slice Number port to change the displayed slice along current axis.
- You can change the Slice Orientation.

The Info port indicates the current processing step. Buttons are available to proceed to next step, possibly skip it, or go back to previous step.

**Step 1: Crop before alignment**
This step lets you crop the input data before applying the alignment. For now you will select a region contained within the serial sections.

- Drag the green corners of the tab box in the viewer, or index values in the Crop Editor dialog.
- You can use the Slice number and orientation ports to control the selected region.
- Be sure to slice all the way from the front of the stack to the back of the stack to verify that you are not cropping out desired regions. You may also change temporarily the Slice orientation.

![Crop before alignment with FIB Stack Wizard](image)

Figure 8.65: Crop before alignment with FIB Stack Wizard

- Once set, press on the Apply button in order to go to the next step.

**Step 2: Alignment**

In this step, the wizard will use automatically the Align Slices module. The wizard exposes the fol-
lowing alignment options:

- **Gravity centers**: Align gravity centers and principal axes.
- **Least-squares**: Least squares algorithm based on gray values.
- **Enable rotations** options: enables rotations during slice alignment. If this options is disabled, only translations will be computed.

- For this example our case let’s keep the default values: least squares alignment method without rotation.

**Important note**: when processing grayscale images, the visible gray values for display and for alignment can be restricted to a *data window* defined for the data set. Only the values between the two bounds of the data window are used by the gray value-based alignment algorithm. You can check if an appropriate data window is defined in the data information displayed in the *Properties Area*. For editing the data window, see the *Intensity Range Partitioning editor* and tutorial section 3.4 on Intensity Range Partitioning.

![Figure 8.66: MoSi2-pre-corrected Data window](image)

- Press on the *Apply* button in order to go to the next step. The *Align Slices* editor window is displayed showing the alignment progression. You can see how slices are aligned relative to each other. Depending on the distribution and the orientation of shapes across the slice stack, some smooth drift may occur.

**Step 3: Crop after alignment**

Slices of the input data are now aligned relative to each other. The jittering drift effect has mostly disappeared.

- Change slice number to browse slices. You can see black uncovered area as slices have been translated.
- You can select a new crop region to exclude these black areas.
• Once set, press on the *Apply* button in order to go to the next step.

**Step 4: Shearing correction**

This step may be needed when dealing with raw microscope images without shift correction, or when alignment should be performed with a mask corresponding to a fixed part (e.g., landmark) in the images. This will be detailed later.
• For now, alignment has been performed, so click on the *Skip* button in order to go to the next step.

**Step 5: Shading correction**

This step can help to compensate for non-uniform illumination, for instance, to facilitate future image segmentation. The voxel values are normalized by an estimated background. You can specify a range of intensities for voxels to be considered for estimating background. The number of electrons detected can be altered by the surrounding materials, in particular when trench is not large enough or when redeposition causes mass to accumulate that reduces electron detection.

• Change the Low mask threshold value. You can see the non-uniform distribution of background intensity. See the figure 8.68 below to adjust values.

• Change both thresholds to cover as much as possible the area to be approximated for background, excluding as much as possible the dark or bright features that could alter the background estimate. See the figure 8.68 below to adjust values.

• The *shading correction* parameter is a factor applied to the voxel values normalized according to the estimated background.

Figure 8.68: Shading correction with FIB Stack Wizard

- You can click on the Back button in order to go to previous steps and modify some processing parameters.
- Remove the FIB Stack Wizard in order to delete intermediate modules and data objects.
8.7.4 Selecting what to align using masks

Three methods can actually be used to choose what to align:

1. Cropping the data set.
2. Changing the data window using the Intensity Range Partitioning editor (or Align Slices data window port).
3. Specifying a 3D mask.

With previous steps, you could achieve quickly reasonable results, with limited image drift. However, in some cases, you may need to select more precisely the image information to be considered for alignment.

1. The overall image structure may induce drift, in particular if there are few large or oriented structures. Subsets of images might better drive the alignment.
2. You may want to take advantage of fixed markers or fiducials. If the volume and resolution you wish to capture allow for it, you can keep such markers in the field of view for the purpose of accurate alignment.
3. You may have raw images with uncorrected upward shift. For best results you should normally apply first a shearing before aligning the sections area so that images are roughly axis aligned. You can use the AmiraShear module for this. Alternatively, you could instead align images based on the fixed area surrounding the sections.

- Load MoSi2-sheared.am located in data/fib
- Attach FIB Stack Wizard
- Press Apply to keep all volume at Crop step

![Figure 8.69: FIB Stack Wizard at step 1](image)
We now need to create a mask to be used as input by the *FIB Stack Wizard*. For this one could use the *Segmentation Editor* or any other tools creating a label image. Using the *Volume Edit* module is convenient here.

- Attach `MoSi2-sheared.am` to *Compute / Volume Operations / Volume Edit*.
- In the *Properties Area* leave the *Tool* port of *Volume Editor* set to *Draw*.
- Click on the *Outside* button of the *Cut* port: you can then encircle with a lasso a region in the 3D viewer. You can hold Alt key to draw straight lines. The drawn contour defines an extruded volume along the view axis. Make sure to use the viewer’s orthographic camera mode in order to make the contour extrusion parallel to the Z axis. (for this press the *Perspective/Orthographic* button in the viewer’s toolbar).
- Pressing the *Create Mask* button will then create a label image corresponding to that region.

![Volume Edit screenshot](image)

**Figure 8.70**: Creating mask for MoSi2

- Attach the result mask `MoSi2-sheared.mask` as *Mask* input for the *FIB Stack Wizard*.
- Press the *Apply* button to trigger alignment. The *Align Slices* editor window shows the image masked by the region you defined.
- Press *Apply* to keep all volume at *Crop* step.
- Apply *Shear* step with -38 degrees (i.e., 52 - 90).
- Proceed to *Shading correction* as above.
8.7.5 Further processing of FIB Stacks

More image processing may be required to further improve FIB/SEM images, for compensating for instance noise or curtaining effects. Filtering can be applied either before or more usually after alignment such as processing by FIB Stack Wizard. In particular if you want to apply image filters in 3D mode, images should be properly aligned.

See section 6.8 for hints about image filtering. In particular, the Non-Local Means image filter is usually effective with FIB/SEM image. See also Filter Sandbox for trying conveniently image filters.

8.8 Registration of 3D surfaces

The Transform Editor and Landmarks tools introduced in previous tutorials may be used for surface registration. This section focuses on automatic optimized registration based on surface distance minimization. In this tutorial, you will learn how to register 3D triangulated surfaces that are wholly or partially overlapping.

This section has the following parts:

- Getting started with Align Surfaces module
- Align Surfaces guidelines
- Alignment of surface subsets
- Measure and visualize surface distance

8.8.1 Getting started with Align Surfaces module

Align Surfaces is the main tool used for surface registration. The module Align Principal Axis can also be useful for alignment constrained along certain axes.

The Align Surfaces module allows the automatic alignment of a triangulated surface with respect to a reference surface. It computes either a rigid transformation or an affine transformation.

The following example shows step by step how to register two surfaces. We start with similar first steps used in the Transform Editor tutorial.

- Start a new Amira Project
- Load chocolate-bar.simplified surface file from the data/tutorials directory,
- Duplicate the chocolate-bar.simplified data object (Ctrl-D).
- Attach two Surface View modules to chocolate-bar.simplified and chocolate-bar2.simplified. Both surfaces are shown overlapping for now.
- Activate the Transform Editor for chocolate-bar2.simplified, and change position and rotation of chocolate-bar2.simplified.
• Press the *Apply Transform* button in the *Transform Editor* to modify the vertex coordinates according to the transformation. You can confirm the transformation when asked.

![Transform Editor](image)

*Figure 8.71: Surface transformed*

In order to introduce some differences between the surfaces before experimenting with alignment, we will use the *Surface Simplification Editor*. This tool reduces the number of triangles by edge collapsing and vertex shifting to approximate the original surface. This operation can also be very useful to reduce the computation time for alignment, especially for large surfaces.

*Registration of 3D surfaces* 393
• Select `chocolate-bar2.simplified` in the Project View. Then in the Properties Area, activate the Simplification Editor.

• In the port Simplify, set the desired number of faces to 10000. You can check fast toggle for quicker computation.

• Press the Simplify now button in the Action port.

![Figure 8.72: Simplification Editor](image)

• Attach the Geometry Transforms / Align Surfaces module to `chocolate-bar2.simplified`, i.e., the surface to be transformed.

• Then connect the Reference surface port to `chocolate-bar.simplified`. Leave the default parameters for now.

![Figure 8.73: Align Surfaces project](image)

Let’s focus for now on the Align port, exposing two pre-alignment methods and the actual optimized registration.

Registration of 3D surfaces
Press the *Centers* button in the *Align* port.

You can see that the surfaces are now centered. However, the model orientation does not match the reference orientation.

---

Now press the *Principal Axes* button in the *Align* port.

The model and reference are now almost aligned. You can still notice some discrepancy.

- Press the *Surfaces* button in the *Align* port. This starts the iterative alignment optimization.

After a few steps, the surfaces are aligned as well as possible.
8.8.2 Align Surfaces guidelines

The Align Surfaces module based on an Iterative Closest Point algorithm, repeating the following steps:

1. Associate corresponding points in the two surfaces by nearest neighbor criteria.
2. Estimate and apply a transformation minimizing the root mean square distance between the points of the model surface and the corresponding points on the reference surface.

Despite optimized search for nearest neighbors, this can be time consuming especially for large surfaces. The center of mass and principal axes can be aligned quickly.
Like for image registration, in order to limit computation time and risk for mismatch, it is recom-
mended to perform the surface alignment in two steps.

1. Pre-alignment with manual or automatic approximate registration
2. Automatic refined registration

Pre-alignment could be done using the Transform Editor or Landmarks. For automatic alignment, you can more simply attempt in order:

1. Centers
2. Principal Axes
3. Surfaces

Here are some additional hints.

**Alignment of the centers of mass.**

To align the centers of mass, all vertices of the triangulated surface are assigned the same mass. Therefore, the calculated centers may depend on distribution of vertices along the surface. In some case, it may be helpful to remesh surfaces, using either the *Surface Simplification Editor* or the *Remesh Surface* module.

**Alignment of the principal axes.**

The moments of inertia and principal axes are calculated, again with the same mass assigned to all vertices of the triangulated surfaces. Since there can be different matching orientations for the three principal axes, each combination is checked and the final solution is the one with the minimum root mean square distance between surface vertices. Usually this gives good results as a starting point for refined registration. However, in some cases, the distribution of surface vertices can be such that a wrong orientation is selected.

**Surfaces distance minimization - iterative refined registration.**

You can reduce the search in a number of ways to accelerate processing if needed:

1. Degrees of freedom should be left to minimum required.
2. You may not need to register the full surfaces.
   - You can select the Region of interest in the reference surface (ROI port) corresponding to the model, or to an extracted subset of the model
   - You can extract the parts of the surfaces most relevant for registration - this can be done using *Surface View* and *Extract Surface* modules.
   - You can simplify surfaces or Remesh surfaces.
   - You can the copy the transformation obtained to the full data set.
3. Make sure that the *use correspondence* option is set if the input surfaces have exactly matching vertices, stored in the same order. Registration is then dramatically faster. If the surfaces acci-
dently have the same number of points and if these vertices are not matching, then make sure that the option is disabled.

### 8.8.3 Alignment of surface subsets

In this an example, we will consider two partially overlapping triangulated surfaces. These surfaces have been extracted separately, using an Isosurface module, from the two independent volumes used in Image Registration tutorial. The surfaces cannot overlap exactly due to differences in volumes sampling, but we will search now the best registration.

- Load `chocolate-bar.part1.simplified.surf` and `chocolate-bar.part2.simplified.surf` in `data/registration` directory
- Attach Surface View modules to `chocolate-bar.part1.simplified.surf` and `chocolate-bar.part2.simplified.surf`.
- Register approximately the two surfaces with a rigid transformation by using the Transform Editor or as shown in tutorial about Landmarks registration.

![Figure 8.78: Approximate registration](image)

- Attach an ROI box to `chocolate-bar.part1.simplified.surf`. The Region Of Interest must delimit the common region between the two data sets. It should not be much larger.
• Attach the module *Geometry Transforms / Align Surfaces* to *chocolate-bar.part2.simplified.surf*. Set the reference surface to *chocolate-bar.part1.simplified.surf*, and the ROI to the created *ROI box*. Select *rigid + uniform scale* transformation, and set the *max iter* port to 100.

![Figure 8.79: Region of Interest (ROI Box)](image)

**Figure 8.79: Region of Interest (ROI Box)**

• Click on the *Surfaces* button in the *Align* port. At most 100 iterations will be computed for the alignment. If the relative RMS is smaller then 0.001, the algorithm will end too. You can press the *Stop* button to interrupt the registration. You can repeat this step if the alignment is not accurate enough: the relative RMS should be reduced.

![Figure 8.80: Align Surfaces project](image)

**Figure 8.80: Align Surfaces project**
Once you obtained an optimized registration, you can optionally check the surface distance using a \textit{Surface Distance} module.

### 8.8.4 Measure and visualize surface distance

In the following steps, you will compute and display the map of distance between the two surfaces. The \textit{Measure / Surface Distance} module computes several different distance measures between two triangulated surfaces based on closest points.

- You can remove the \textit{Align Surfaces} module.
- Apply the refined transformation to \texttt{chocolate-bar.part2.simplified.surf} (\textit{Transform Editor / Apply Transform} button).
- Attach the \textit{Measure and Analyze / Surface Distance} module to \texttt{chocolate-bar.part2.simplified.surf}. Set \textit{Surface2} port to \texttt{chocolate-bar.part1.simplified.surf}.
- Also attach the \textit{ROI} port for specifying the relevant Region Of Interest, already used in previous steps for the registration.
- Select \textit{Distance} output and press \textit{Apply}. This will create a scalar field attached to the surface.
- Set the colorfield of \textit{Surface View 2} (displaying \texttt{chocolate-bar.part2.simplified.surf}) to the computed distance. Choose \texttt{physics.icol} as colormap, and \textit{adjust range} to [0, 0.01].
Figure 8.82: Distance between the surfaces - Viewer and network

Figure 8.83: Distance between the surfaces - Surface View and Surface Distance
The computed distance statistics and distance field may depend on the distribution of vertices over the two surfaces. You may want to choose the two-sided Direction for a symmetric distance calculation. You could also remesh the surfaces using the Surface Simplification Editor or the Remesh Surface module to redistribute vertices uniformly.

A Surface Thickness module and a Shortest Edge Distance module are also available.

Note: For checking surface distance from objects in a 3D volume, one could compute a 3D distance map from the segmented 3D image (using Image Processing / Distance Maps / Distance Map), then use the result as a color field with Surface View, as shown in Data fusion tutorial, or use Compute / Surface Scalar Field to attach the distance measures to the surface.
Chapter 9

Animations and Movies

The tutorials in this chapter introduce the following topics:

- Creating animations - creating animations using the Animation Director
- Creating movie files - using the Movie Maker module

9.1 Creating animations

In this tutorial, you will learn how to use the Animation Director module for creating an animated sequence of operations within Amira. In our example, we will visualize a polygon model using effects such as transparency, camera rotation, and clipping to make the visualization more meaningful and attractive.

The tutorial covers the following topics:

- creating an initial project for the demo
- animating an Ortho Slice module
- activating additional modules during the demo
- using a camera rotation or path
- removing events that are already defined
- overlaying the inside surfaces with outer surface
- using clipping to add the outer surface gradually
- advanced clipping issues
- inserting breaks and defining demo segments
- using function keys for jumping between demo segments
- defining partial loops within the demo sequence
• storing and replaying a demo sequence

Once you have learned how to define an animated demo sequence, you can further learn how to record the demonstration into a movie file in Section 9.2.

9.1.1 Creating a project

First, we need an Amira project that contains all the data and modules for the visualization and animation we want to do. In our example, we pick the chocolate bar scan data set chocolate-bar. Start by loading data/tutorials/chocolate-bar.am from the AMIRA_ROOT directory. By right-clicking on the green data icon and selecting from the data set’s popup menu, attach a Bounding Box module to the data. Use the mouse to navigate around the model in the 3D viewer.

![Data chocolate-bar.am with a Bounding Box and an Ortho Slice](image)

Figure 9.1: Data chocolate-bar.am with a Bounding Box and an Ortho Slice

9.1.2 Animating an Ortho Slice module

Let us move the Ortho Slice plane up and down to show what the data looks like. Note that the Ortho Slice module has a port called Slice Number. If you change the value of that slider, you see the plane move in the viewer.
Now let us animate this slider using the Animation Director module as our first exercise. From the toolbar, click on the Animation Director button.

A new widget becomes visible hosting the Animation Director user interface.

![Animation Director user interface](image1.png)

**Figure 9.2:** Animation Director user interface

Like the other widgets, this widget is also dockable and you can place it at a convenient position within the Amira user interface. After activating the Animation Director by clicking on the related button in the toolbar, all ports of the currently available modules that can be animated are extended by an additional button representing a stopwatch.

![Extended ports in the module’s properties](image2.png)

**Figure 9.3:** Extended ports in the module’s properties

Before we start animating the Ortho Slice position, let’s first have a quick look at some GUI elements of the Animation Director widget (shown below in figure: event and keyframe in timeline).

As you can see, the user interface is divided into a left and a right panel. On the left panel, you can control the timeline that is displayed on the right panel. The timeline has a main time slider. The name of the current animation can be changed by writing directly into the current animation name field. For example, we can name it “CandyAnimation”.

*Creating animations*
We can now animate the Ortho Slice position. We do this by clicking on the stopwatch button of the Slice Number port in order to schedule the start event:

![Extended Slice Number port](image)

**Figure 9.4:** Extended Slice Number port

Clicking on the stopwatch button creates a new keyframe in the Animation Director timeline and the event is listed in the left panel of the user interface. If you hold the mouse cursor above the small orange diamond symbol in the timeline panel, this will activate a small input field where you can adjust the time and the accompanying value for the port with which it is associated. In order to adjust the schedule, you can simply drag the diamond icon to the desired position on the timeline.

![Event and keyframe in timeline](image)

**Figure 9.5:** Event and keyframe in timeline

With this operation, we have defined the beginning of the animation of the slice position. Next we want to define the time where the animation should end. To do this, we drag the master time slider to the desired time on the timeline, e.g., to 00:04.000, which means 4 seconds. As a next step, we set the slice position of the Ortho Slice module by either setting the Slice Number port in the properties of the module or by positioning the slice interactively in the viewer window. Using either method, set the value of the Slice Number port should be set to 294. After you click the stopwatch button again, the keyframe is created in the timeline:

You can test your first animation by positioning the master time slider back to 00:00, either by clicking on the Jump To Start button or by entering the desired time into the Current Time control.
Finally, start the animation by clicking on the Play Forward button or by pressing [F4]. To stop the animation click on the Stop button or press [F3].

Note: The animation time is not a real physical time. The time that has been specified is the time that Amira will try to respect, if possible. If an animated property needs a specific amount of time to be processed (computation, viewer redraw, etc.), Amira will not skip it and will wait until the animation step has finished before continuing. This implies that, for instance, an animation with a time range of 30 seconds won’t run for exactly 30 seconds, but will run 30 seconds or longer.

As an exercise, adjust the master time slider to the time 00:12, set the position of the Slice Number of the Ortho Slice to the value 0, and click the stopwatch button again. This will create another keyframe in the timeline. Restart the animation again as described above. The slice should first move from slice number 147 up to 294 during 4 seconds and then decrease down to the value 0 within the next 8 seconds.

Note: As described above, you can edit the time and the value of single keyframes by hovering the mouse cursor above the keyframe icon and by clicking in its user interface after it has been become visible (hover dialog box). Alternatively, you can modify the time of the keyframe by dragging it on the timeline. In order to change the value of the associated port, you can position the master time slider on the time of the keyframe and then adjust the value of the port by using the user interface in the properties area of the module. In order to shift all keyframes of a port forwards or backwards on the timeline, position the mouse cursor between two subsequent keyframes. You will notice a connecting bar in dark gray and that all keyframes of this sequence are selected (indicated by orange colored diamonds).

You can now shift all selected keyframes forwards or backwards by dragging the dark gray bar.

9.1.3 Activating a module in the viewer window

Next, let us add a visualization of the internal structure in the data set after we have moved the Ortho Slice. Load the data set data/tutorials/chocolate-bar.surf in addition to the current project. Attach a Surface View module to it. Click on the yellow Surface View module to see its user interface. Select
Chocolate and All in the Materials port and press the Remove button in the buffer port. This will visualize the inside surfaces of the model.

If you want to switch the surface visualization on and off manually, you would use the viewer toggle (orange rectangle) of the Surface View module. If you want to include this action in your animation sequence, you need to do the following:

- Click on the Surface View module to select it.
• Adjust the master time slider of the Animation Director to, e.g., 00:12.
• Click on the top most stopwatch icon in the properties area of the Surface View module.
• Select Visibility in Viewer 0 from the drop-down menu.

To test the newly added event, set the master time slider of the Animation Director back to the beginning by using one of the methods described above. As you have may noticed, another event has been automatically added at time 00:00 to consider the surface model as invisible by default. Start the animation. As before, the slice moves back and forth. When the master time slider reaches 00:12, the surface model is switched on.

Note: You can change the time when the Surface View becomes visible by simply dragging the appropriate keyframe diamond on the timeline.

9.1.4 Using a camera rotation

To look at the 3D model from all sides, let’s add a camera rotation to our demo sequence. From the Project / Create Object... menu, select Animations And Scripts / Camera Orbit. Try the rotation by playing the time slider in the Camera Orbit module. If you do not like the axis of rotation, reset the time slider to 0, navigate to a good starting view in the viewer window, and click on recompute in the Camera Orbit module. Note that the values of the Camera Orbit time slider range from 0 to 360.

Once you are satisfied with the camera rotation, add it to the timeline:

• Set the master time slider to the time where the camera rotation should begin, e.g., 00:10.
• Select Camera Orbit module.
• Click on the stopwatch button next to the Time port of the Camera Orbit module and click on Time: Value.
• Set the master time slider to the time where the camera rotation should end, e.g., 00:14.
• Adjust the Time port of the Camera Orbit module to its maximum (360).
• Click on the stopwatch button of the Time port again.

Now play the demo to see the result. After moving the slice and switching on the surface model, the view is rotated so that the surface can be seen from all sides.
9.1.5 Removing one or more events

You can remove events by hovering the mouse cursor over the desired keyframe. When the keyframe user interface becomes visible, you can click on the trashcan 🗑️ to remove the keyframe.

To remove all keyframes that are associated with a module’s port, you can click on the trashcan 🗑️ that is located in the same line as the port name on the left panel.

9.1.6 Overlaying the inside surfaces with outer surface

Now we want to show the outer surface overlaid over the inside model.

- Attach a second Surface View module to the chocolate-bar.surf data set. Since Exterior and All are selected as the default materials, this brings up the exterior surface.
- Click on the second Surface View module. It should be called Surface View 2.
- Select transparent from the Draw Style port.
- Inside the Buffer port, select Chocolate and All in the Materials port and click Add.
- It will be helpful to show the inside surfaces underneath the exterior surface, so jump to time step 00:14 or later in the Animation Director module.
- Adjust the grade of transparency using the BaseTrans slider in Surface View 2 (for instance 0.7).
- Smooth out the outer surface by clicking on more options in the Draw Style port and selecting Vertex normals.

Like we did with the inside surfaces model, we can switch on the outer surface model at some point in the animation sequence:

- Set the master time slider to the time where our surface should become visible, e.g., 00:14.
- Click on the top most stopwatch icon in the properties area of the Surface View 2 module.
- Select Visibility in Viewer 0 from the drop-down menu.

Again, check out the results by playing the animation sequence.

9.1.7 Using clipping to add the outer surface gradually

Instead of just switching the outer surface on at one point, we can make it appear gradually over the inside surfaces from top to bottom. In order to do so, we use the Ortho Slice plane to clip the outer model, and then move the Ortho Slice plane down.

- Move the master time slider to the time that you selected to make the Surface View 2 module visible (e.g., 00:14).
- Click on the Surface View 2 module.
- Click on the top most stopwatch icon in the properties area of the Surface View 2 module.
• Select *Clip using Ortho Slice* from the drop-down list.

• Move the mouse cursor over the newly created keyframe in the timeline and wait until the user interface for this keyframe has become visible.

• In the keyframe's user interface, select the radiobox *on* to enable *clipping using Ortho Slice*.

In order to make the outer surface visible, we finally must animate the *Ortho Slice* towards the bottom of the scene:

• Set the master time slider to 00:12.

• Select the *Ortho Slice* module in the *Project View*.

• Click on the small stopwatch icon of the port *Slice Number* to set a new keyframe in the timeline.

• Move the master time slider to the time where you want the animation to be finished, e.g., 00:22.

• Move the *Slice Number* value to the value 294.

• Click again on the small stopwatch icon of the *Slice Number* port.

Start the animation either from the beginning or from 00:14 and watch the result.

*Figure 9.10: Viewer and Network with an Ortho Slice and two Surface Views*
As a last step, you might want to rotate the view again while the outer surface is appearing. You can simply reuse the old camera rotation during a second time range:

- Set the master time slider to the time where you started to make the outer surface visible, e.g., 00:14.
- Select the Camera-Orbit module.
- Click on the stopwatch icon of the port Time and select Time: value. This will insert a new keyframe to the timeline.
- Move the master time slider to the time where you want the camera rotation to be finished e.g., 00:22.
- Set the time value of the port Time to 0.
- Click again in the stopwatch icon of the Time port and select Time: value.

To avoid the Ortho Slice to hide the surface view when displaying the slice 294, you can change its Transparency mode during the animation.

- Move the master time slider to the time where you want to change the Transparency value, e.g., 00:12.
- Set the Transparency port of Ortho Slice to Binary, then click on the stopwatch icon of Transparency port. This will insert a new keyframe to the timeline. The Transparency port is in the Display Options port of Ortho Slice.
- Move the master time slider to 00:00, and set the Ortho Slice Transparency to ”None” (See Figure 9.12).

Start the animation either from the beginning or from 00:14 and watch the result.

Figure 9.11: Selecting Clip using Ortho Slice and enabling the clipping in the timeline
9.1.8 More comments on clipping

Clipping can sometimes be a little bit more complicated than in our example, because clipping can be applied to a plane in two different orientations. This means that you can either clip away everything above the plane, or below the plane. Unfortunately, it is not always obvious which of the two cases you are in.

However, you can simply invert the orientation of the clipping in Animation Director. In our example, you would simply set the master time slider to a time prior to the actual clipping. Next, you need to select the module that will do the clipping, the Ortho Slice module in our case. Now, click on the topmost stopwatch icon in the Ortho Slice properties area and select Invert clipping orientation from the drop-down list.

You do not need to use an Ortho Slice module to do clipping. As you may have observed, the Ortho Slice might occlude parts of what you want to show. In that case, it is better to create an empty Clipping Plane module by selecting Other / Clipping Plane from the Project / Create Object... menu. Attach the module to the data set you want to clip (e.g., to chocolate-bar.surf in our example), and then use the Clipping Plane for clipping just as you used the Ortho Slice before.
9.1.9 Breaks and function keys

The animation sequence that we have created in this tutorial automatically runs through the complete time range that we defined, one minute by default. Sometimes it may be desirable to split the animation into several segments, so that the animation will stop at designated points and can be continued when you desire.

To take this into account, you can insert breaks in the Animation Director timeline. Let us insert one such break right after the inside model appears:

- Set the master time slider to the time when the Surface View appears, e.g., 00:12.
- In the left panel of the Animation Director click on the + Add special event button.
- Select Add Break from the drop-down list. A new keyframe is created on top of the timeline indicating the Break.

![Figure 9.14: Add break in a Animation Director](image)

This way the animation will stop at time 00:12, which is right when the model is switched on. When you play the animation from the start, you will notice that after the inner structure is switched on, the animation will stop.

Let us insert a second break at time step 00:14, which is right before the outer surface is starting to show. Proceed as above, using a trigger time of 00:14 instead of 00:12.

If you run the animation from the very beginning, it will stop after the inside surfaces are displayed. Click on the Play Forward button or press [F4] to continue the animation.

Try this by pressing the function key [F4]. The demo continues.

Likewise, the animation will stop just before showing the outer surface. Again, you can continue the demo by pressing [F4]. In general, at any point while the animation is running, you can press the [F3] key to stop it manually. Pressing [F4] will continue from the point where the animation stopped.
If you have defined breaks as we did above, there are two additional function keys that in a sense allow you to navigate through the animation segments: pressing [F9] will jump back to the previous break or to the very beginning of the animation, and [F10] will jump to the next break, or to the very end of the animation.

Note: If you use [F9/F10], it will just jump, and you need to press [F4] to start playing it from the new time step.

Please note that you can disable the breaks by checking the Skip Break toggle in the More Options panel of the Animation Director module. You may even disable the definition of function keys by checking the No toggle in the Activate Function Keys port:

![Figure 9.15: Disabling Breaks and Function Keys](image)

9.1.10 Loops and Goto

One more feature that might be required for certain kinds of animation is the definition of loops. If you just want the whole demo to run in a loop, you can do this easily using the built-in features of the Animation Director module:

You can toggle the appropriate button ➔ Play Once, ⌚ Play Loop, or ⓘ Play Swing located right between the main VCR button like Play, and the main time control:

Now if you play the animation, it will play from beginning to end once (Play Once), start over from the beginning (Play Loop), or play forwards, backwards, and so on (Play Swing).

However, you may want to define some part of the demo to run in a loop, and then stop the loop
and continue with the animation upon key press. You can easily do this with the *Goto* feature of the *Animation Director* module:

- In the *Animation Director* module adjust the main time control to the time 00:11:950.
- Click on the *+ Add special event* button.
- Select *Add Goto* from the drop-down list. A new keyframe is created on top of the timeline.
- Move the mouse cursor right over the new created keyframe icon and a user interface for this *Goto* will appear.
- In the *Time To Jump To* field enter the time where you want to go from here, e.g., 00:04:000 in this case.

When you run the animation sequence now, it will loop in the segment between time 00:04 and 00:12, only showing the *Ortho Slice* move up, jump down, move up again and so on... You can stop this by clicking on the stop button of the *Animation Director* control panel or by pressing [F3]. To continue after the loop, you need to jump to the next segment by pressing [F10], and then start playing again by pressing [F4].
9.1.11 Storing and replaying the animation sequence

As you may have noticed by now, storing an animation sequence once you have defined it is quite easy: simply save the whole Amira project by selecting File/Save Project from the menu. The Animation Director module will be saved along with the project, and so will be the animation sequence you have defined.

When you load the project back into Amira, the state of the project will be the same as it was when you saved it. This means that you should be careful to reset the Animation Director master time slider to 00:00 before saving the project if you want the demo to start from the beginning.

After loading the project, you can start the demo by clicking on the play button of the Animation Director module, or by pressing [F4]. If you want to run the demo automatically right after the project is loaded, you can use the auto start feature that you find when you check Activate Auto Start in the More Options panel.

![Figure 9.18: Enable auto start mode](image)

Just activate the Activate Auto Start functionality by checking the Yes radio button and save the project. When you load it again, the demo will start running automatically.

9.2 Creating movie files

In this tutorial, you will learn how to record a self-created animated sequence into a movie file using the Movie Maker module.
In our first example, we will just use a camera path to animate the scene, whereas in our second example, we will rely on the animated demonstration created in Section 9.1.

### 9.2.1 Attaching Movie Maker to a Camera-Path

If you have created a visualization of your data and want to create a movie showing this visualization from all sides or from certain interesting viewpoints, you can create an appropriate camera path and record a movie by following the camera along that path.

Let us create a simple example. Load the *chocolate-bar.am* data set from the *tutorial* subdirectory and attach an *Isosurface* module to it. Choose an isosurface threshold of 410 and press the *Apply* button.

![Image](image.png)

**Figure 9.19:** Visualize chocolate-bar.am with an *Isosurface*

The easiest way to create a simple camera path is to use the *Camera Orbit* module. From the *Project / Create Object...* menu, select *Animations And Scripts / Camera Orbit* and press the play button of the newly created module. You can watch the scene rotate in the viewer while the time slider is playing.

To record an animated scene into a movie file, you need to attach a *Movie Maker* module to a module that possesses a *time slider port*. The movie is recorded by going through the individual time steps and taking snapshots of the viewer along the way.
In our example, the Camera Orbit module has a time slider, so we can attach a Movie Maker module to it by right-clicking on the Camera Orbit icon in the Project View and selecting Movie Maker from the popup menu.

![Figure 9.20: Attach a Movie Maker to Camera Orbit](image)

![Figure 9.21: Parameters of Movie Maker module](image)

In the Movie Maker module, first click on the Browse button in the Filename port and enter a movie file name like C:/tmp/test.mpg. The .mpg suffix suggests that the movie file format will be MPEG, which is a widely accepted standard format for digital movies achieving a good compression ratio.

Next, adjust the parameters of the Movie Maker module to your liking, e.g., change the number of frames, the image size, or the compression quality. Please refer to the Movie Maker documentation for details.

In our example, let us choose 180 frames and leave all other parameters untouched. Since the Camera Orbit module does a full rotation of 360 degrees, each of the 180 frames will represent a rotation of two degrees with respect to the previous frame. Press the Apply button to start recording.

Wait for some time while the Movie Maker module drives the Camera Orbit module and accumulates the snapshots. Please note that the speed during the recording process is different than the play-
back speed of the movie. Now view the resulting movie file test.mpg with a movie player of your choice (e.g., Windows Media Player or a similar tool). Experiment with the recording parameters until you get the desired result (e.g., control the file size and image quality by changing the Compression quality value, choose different image sizes to see up to which image size your computer is capable of smoothly displaying the movie, and change the number of frames to control the speed of the rotation).

9.2.2 Creating a movie from an animated demonstration

Now we try to record a movie of a more complex animated scene. To this end, we load one of the projects that we have created in in Section 9.1 (Creating animated demonstrations).

As you might remember, the basic idea of the Animation Director module was that you define a set of events to be executed on a certain time line. Check this out by clicking the play button of the Animation Director module. You should see a nicely animated demonstration.

To create a movie from an animation defined with the Animation Director, simply click on the Movie Creation button of the Animation Director panel. The following panel will appear:

![Figure 9.22: Movie creation parameters of the Animation Director module](image-url)

The Animation Director module internally uses a Movie Maker module to create movies. This module is already pre-configured to create a movie that respects the animation settings (duration, frame rate, filename...) that are defined by the Animation Director module. However, you can adjust these
parameters, if needed. Just click on the *Create Movie* button to generate the movie.
Chapter 10

User Interface Components, General Concepts, Start-Up

This chapter contains a description of Amira interface components, data types, general concepts and start-up options. No in-depth knowledge of Amira is required to understand the following sections, but it is a good idea to have a look at one of the tutorials contained in Chapter 1.7 (First steps in Amira), particularly the very first one described in Section 2 (Getting Started).

10.1 User Interface Components

The following interface components are described in this section:

- File Menu, Edit Menu, Project Menu, View Menu, Window Menu, Help Menu
- Standard Toolbar, Workrooms Toolbar
- Project View, Properties Area, Progress Bar, Viewer Window, Console Window, Online Help, Histogram Panel, Correlation Panel
- File Dialog, Job Dialog, Preferences Dialog, Snapshot Dialog, System Information
- Object Popup, Create Object Popup

10.1.1 File Menu

The file menu lets you load and save data objects as well as Amira Project scripts. In addition, it gives you access to recent files and projects and allows you to quit the program. In the following text, all menu entries are discussed separately.
10.1.1.1 Open Data

The *Open Data* button activates Amira’s *file dialog* and lets you import data sets stored in a file. Most file formats supported by Amira will be recognized automatically via the file header or the file name extension. If you try to load a file for which the format couldn’t be detected automatically, an additional dialog pops up asking you to select the format manually.

A list of all *supported file formats* is contained in the reference manual. Hints on how to import your own data sets are given in Section 2.6.

If you select multiple files in the file dialog, all of them will be loaded, provided all of them are stored in the same format. 2D images stored in separate files usually will be combined into a single 3D data object. On the other hand, there are some file formats for which multiple data objects will be created. Finally, you can also import and execute Amira project scripts using the *Open* button.

10.1.1.2 Open Data As

The format of input data can be forced using *Open Data As*. A format selection dialog will be opened, allowing you to choose between all of the supported Amira file formats. All selected files will be treated as being in the specified format.

10.1.1.3 Open Time Series Data

This button also activates the *file dialog*, but in contrast to the ordinary *Open* option it is assumed that all selected files represent different time steps of a single data object. When loading such a time series, an instance of a *Time Series Control* module is created. This module provides a time slider allowing you to adjust the current time step. Whenever a new time step is selected, the corresponding data file is read, and data objects associated with a previous time step are replaced. The module also provides a cache so that the data files only need to be read once, provided the cache is large enough.

10.1.1.4 Open Time Series Data As

This menu entry works the same way as *Open Time Series Data* except that the format of the input data can be forced (same as *Open Data As*). A format selection dialog will be opened, allowing you to choose between all supported Amira file formats. All selected files will be treated as being in the specified format.

10.1.1.5 Save Data

The *Save Data* button allows you to save a single modified data object again using the same filename previously chosen under *Save Data As*. The button will only be active if the data object to be saved is selected and if this data object has already been saved using *Save Data As*. A common application of the *Save* button is to store intermediate results during manual segmentation in Amira’s *Segmentation Editor*.
10.1.6  Save Data As

This button allows you to write a data object into a file with a native file format. To do so you must first select the data object (click on the corresponding green data icon). Then choose Save Data As to activate Amira’s file dialog. The file dialog presents a list of all native file formats suitable for saving that data object. Choose the one you like and press OK. Note that you must specify the complete file name including the suffix. Amira will not automatically add a suffix to the file name. However, it will update the suffix whenever you select a new format from the file format list. Also, Amira will ask you before it overwrites an existing file.

If no native file format has been registered at all for a certain type of data object, the Save Data As button will be disabled. It will also be disabled if more than one data object is selected in the Project View.

A native file format is a file format that can save all data properties in Amira. Actually, there are only two native file formats: Amira Data Format and HxSurface.

10.1.7  Export Data As

This button does the same thing as the Save Data As button, however, the file dialog presents a list of all file formats suitable for saving that data object, native or not.

Some file formats create multiple files for a single data object. For example, each slice of a 3D image data set might be saved as a separate raster file. In this case, you can add to the file name a sequence of hashmarks (for instance `<filename>####.jpg`). This sequence will be replaced by consecutive numbers formatted with leading zeros.

If no file format has been registered at all for a certain type of data object, the Export Data As button will be disabled. It will also be disabled if more than one data object is selected in the Project View.

10.1.8  Convert to Large Data Format

When selecting this menu entry, a Convert to Large Data Format object will be instantiated and added to the Project View. This module allows you to convert large image data to LDA file format.

10.1.9  New Project

This button does a Remove all objects so that you can start building a new project in the Project View. It also sets the new project name to “Untitled.hx”.

10.1.10 Open Project

The Open Project button activates Amira’s file dialog and lets you load a project stored in a file. Project files show up in the dialog as being in the format “Amira Project”. A Remove all objects will be done before the new project is loaded so that effectively the new project replaces the old project in the Project View. Currently, only files with extension .hx can be opened.
10.1.1.11  Save Project

This button allows you to save the complete project of icons and connections shown in the Project View. The first time a project is saved in Amira, a Save Project policy dialog box is displayed (see Figure 10.1). This dialog box suggests different policies and a short description of each of them. More details about the related choices can be found in the General Tab section. The chosen policy will apply for the project being saved only, unless the checkbox is selected. If the checkbox is selected, the policy applying to the project being saved will apply to all future projects. This setting can be modified later in the General Tab of the Preferences dialog box.

![Save Project policy dialog](image)

Figure 10.1: Save Project policy dialog

If the project has not been saved previously, you will need to specify the name of an Amira Project script in the file dialog box. When executed, the project script restores all data objects and modules as well as the current object transformations and camera settings. This feature is useful for resuming work from a point where you left off previously.

Note that usually all data objects must have been stored in a file to be able to save the project. If this is not the case, a dialog box is shown listing all the data objects that still need to be saved. In the dialog box, you can specify that all required data objects should be saved automatically in a separate subdirectory.

Instead of selecting the option *Amira Project*, you can also choose *Amira Project and data files (pack & go)* from the file dialog box’s format menu. In this situation all data objects currently loaded will be saved in a separate directory. More options affecting the export of project scripts can be adjusted in the Preferences dialog box.

10.1.1.12  Save Project As

This button works like the *Save Project* button except that, in this case, you will always need to specify the name of an Amira Project script in the file dialog.
10.1.1.13 Recent Files

This button can be used to load recently used files. When choosing this menu entry a submenu appears listing the five most recent files. If multiple 2D images have been loaded this is indicated with the name of the first file followed by an ellipsis (...). The number of files displayed in the most recent files list can be modified in the General tab of the Preferences Dialog.

10.1.1.14 Recent Projects

This button can be used to load recently used project scripts. When choosing this menu entry, a submenu appears listing the five most recent project scripts. The number of projects displayed in the most recent projects list can be modified in the General tab of the Preferences Dialog.

10.1.1.15 Quit

This button terminates Amira and prompts you to save the current project configuration, if there are unsaved changes.

10.1.2 Edit Menu

The Edit menu provides access to the standard cut/copy/paste/delete commands, as well as to Amira’s dialogs: Preferences Dialog, Job Dialog and an extended version of the Parameter Editor.

10.1.2.1 Cut

In the Console, this command cuts selected text and copies it to the clipboard. In the Project View, this command removes the selected objects.

10.1.2.2 Copy

In the Console, this command copies the selected text to the clipboard. In the Project View, this command copies the selected objects.

10.1.2.3 Paste

In the Console, this command pastes the text in the clipboard to the current text insertion point. In the Project View, this command creates cut or copied objects.

10.1.2.4 Delete

In the Console, this command deletes the selected text. In the Project View, this command deletes the selected objects.
10.1.2.5 Select All

In the Console, this command selects all the text. In the Project View, this command selects all objects.

10.1.2.6 Preferences

This option opens the Amira Preferences Dialog. This dialog allows you to adjust certain global settings of Amira like the Project View options, the user interface layout, how project scripts are exported, segmentation, rendering and performance options...

10.1.2.7 Dialogs

This menu item comprises the dialogs Database and Jobs.

Database

The Database button activates an extended version of the Data Parameter Editor, allowing you to manipulate Amira’s global parameter database. Among others, the parameter database contains a set of predefined materials (to be used for image segmentation and surface reconstruction) and of predefined boundary ids (to be used for surface editing and FEM pre-processing). For example, for each material and for each boundary id, a default color can be defined in the database.

Modification, insertion, and removal of parameters is performed in the same way as in the ordinary parameter editor. In addition, the extended parameter dialog provides a menu bar allowing you to load, import, save, or search the global parameter database. Amira’s default database is stored in the file share/materials/database.hm located in the directory where Amira was installed. Use the Database menu option Set default file to specify that a different database file be used instead. This change is permanent, i.e., it takes effect also if Amira is restarted. To switch back to the system default, use the Database menu option Use system default file.

Jobs

This button brings up Amira’s Job Dialog which is used to control the execution of batch jobs running in the background. For example, tetrahedral grids can be generated in a batch job (see module Generate Tetra Grid). However, for most users the batch queue will be of minor interest.

10.1.3 Project Menu

The Project menu provides control over the visibility of object icons and lets you delete or duplicate objects. Depending on how many icons are selected in the Project View, some menu options might be disabled.

Note: in “Tree View” mode, the Project menu is identical except that the Show Object, Show All Objects, and Hide Object items are not available.
10.1.3.1 Graph View

This toggle allows you to select the Graph View as current Project View.

10.1.3.2 Tree View

This toggle allows you to select the Tree View as current Project View.

10.1.3.3 Hide Object

The Hide Object button hides all currently selected objects. The object’s icons are removed from the Project View but the objects themselves are retained. You get the same effect by pressing the Ctrl-H key. Hidden objects can be made visible again using Show Object or Show All Objects. This option will be unavailable if the current Project View is the Tree View.

10.1.3.4 Remove Object

The Remove Object button deletes all selected objects and removes the corresponding icons from the Project View. You can get the same effect by pressing the Delete key. If you want to reuse a data object later on, be sure to save it in a file before deleting it. If a data object has been modified but has not yet been saved to a file, it is marked by a little asterisk in the object icon. In the Preferences Dialog, you can choose whether a warning dialog should be printed if you try to delete unsaved data objects which cannot be recomputed by an up-stream compute module. If you delete a data object, all connected modules will be deleted as well. However, if you delete a module, connected data objects (e.g., the results of a compute module) will be retained.

10.1.3.5 Duplicate Object

The Duplicate Object button creates copies of all selected data objects. For each copy, a new data icon is put in the Project View. The name of a duplicated data object differs from the original one by one or more appended digits. The duplicate option is not available if you have selected icons that do not represent data objects (e.g., display or compute modules).

10.1.3.6 Rename Object

This button allows you to change the name of a selected object. In Graph View, a small dialog box will be popped up when the button is pressed. In Tree View, you can directly edit the object item in the view. The button is disabled if no object is selected or if multiple objects are selected. Note that two objects in Amira can’t have the same name. Therefore, the name entered in the dialog may be modified by appending digits to it, if necessary. You can also rename an object by pressing the F2 key when it is selected or by double clicking on the item in Tree View mode.
10.1.3.7 Hide All From Viewer But This

This button allows you to keep visible in the viewer only the display modules of the selected objects.

10.1.3.8 Create Object...

This button allows you to display the Create Object popup in order to create modules or data objects that cannot be accessed via the popup menu of any other object. Please refer to the Create Object popup documentation for more details.

10.1.3.9 Show Object

The Show button allows you to make hidden objects visible, so that their icons are displayed in the Project View. Among the hidden objects there are usually some colormaps which are loaded at start-up. This option will be unavailable if there are no hidden objects or if the current Project View is the Tree View.

10.1.3.10 Show All Objects

The Show All button makes all currently hidden objects visible, so that their icons are displayed in the Project View. This option will be unavailable if there are no hidden objects or if the current Project View is the Tree View.

10.1.3.11 Remove All Objects

The Remove All Objects button deletes all currently visible icons and the associated objects from the Project View. A pre-loaded colormap that is currently visible is also deleted, but all hidden objects are retained. If you select the option check if data objects need to be saved in the Preferences dialog, a warning dialog is popped up if there are data objects which have not yet been saved to a file.

10.1.3.12 Make All Display Modules Pickable

This button makes all display modules in the Project View pickable. A display module is pickable if the associated 3D object can be picked.

10.1.3.13 Make All Display Modules Unpickable

This button makes all display modules in the Project View unpickable. So, the associated 3D object of all the display modules in the Project View can’t be picked.
10.1.3.14 Duplicate Mode

This mode is applicable when multiple modules of the same type will be attached to a single data object. If the toggle is on, the port values of the first module will be used to initialize the port values of subsequently attached modules. This can be convenient if you want the modules to have the same initial port values.

Example: Attach an Ortho Slice to your data object and set the Mapping type to ”Colormap” and the colormap range to 0-3. If you attach another Ortho Slice to the same data object, its Mapping type will be ”Colormap” and its colormap range will be 0-3.

10.1.3.15 Auto adjust range of colormaps

This option specifies the default behavior of colormap ports. If this option is checked, the auto adjust range option of colormap ports will be on.

Note: For some modules, the auto adjust range option of their colormap ports is always checked by default, independently of the global value.

10.1.4 View Menu

The View menu provides control over several Viewer options which affect the display independent of the Viewer input.

10.1.4.1 Layout

The Layout button lets you select between one, two, or four 3D viewers. All viewers will be placed inside a common window using a default layout. If you want to create an additional viewer in a separate window, choose Extra Viewer. You may create even more viewers using the Tcl command viewer <n> show. Starting from n=4, viewers will be placed in separate windows.

10.1.4.2 Background

The Background button opens the background dialog, allowing you to switch between the uniform and gradient background styles. In addition, the dialog allows you to adjust the two colors used by these styles. Note that the checkerboard style is deprecated.

In order to change the background color via the command interface, use the viewer commands viewer <n> setBackgroundColor and viewer <n> setBackgroundColor2. The command interface also allows you to place an arbitrary raster image into the viewer background (see Section 11.5.4.1 Viewer command options).
10.1.4.3 Transparency

The Transparency button controls the way of calculating pixel values with respect to object transparencies during the rendering process.

- **Screen Door**: Transparent surfaces are approximated using a stipple pattern.
- **Add**: Additive alpha blending.
- **Add Delayed**: Additive alpha blending with two rendering passes. Opaque objects come first and transparent objects come second.
- **Add Sorted**: Like Add Delayed, but transparent objects are sorted by distances of bounding box centers from the camera and are rendered in back-to-front order.
- **Blend**: Multiplicative alpha blending.
- **Blend Delayed**: Multiplicative alpha blending with two rendering passes. Opaque objects come first and transparent objects come second.
- **Blend Sorted**: Like Blend Delayed, but transparent objects are sorted by distances of bounding box centers from the camera and are rendered in back-to-front order.
- **Sorted Layers**: Uses a fragment-level depth sorting technique, which gives better results for complex transparent objects. Multi-Texture, Texture Environment Combine, Depth texture, and Shadow OpenGL extensions must be supported by your graphics board. If the graphics board does not support these extensions, behaves as if Blend Sorted was set.
- **Sorted Layers Delayed**: Like Sorted Layers, but rendering all transparent objects after opaque ones.

**Note**: Antialiasing is not supported by Sorted Layers and Sorted Layers Delayed mode.

10.1.4.4 Lights

The Lights menu lets you activate different light settings for the 3D viewer. By default, the viewer uses a single headlight, i.e., a directional light pointing in almost the same direction as the camera is looking. The headlight can be switched on or off in each viewer via the viewer’s popup menu. Alternatively, the headlight can be switched on or off for all viewers using the headlight toggle in this Lights menu. This standard light settings can be restored using the Standard button. More light settings can be defined by creating an appropriate file in $AMIRA_ROOT/share/lights.

At any time, additional lights can be created via the Create light option. Except for the viewer’s default headlight, all lights are represented by little blue icons in the Project View, just like ordinary data objects or modules. In order to make all hidden light icons visible, use the Show all icons option. Hide all icons hides the icons of all light objects. For more information about lights, please refer to the Reference Section of this manual.
10.1.4.5 Fog

The Fog button introduces a fog effect into the displayed scene and controls how opacity increases with the distance from the camera. The fog effect will only be seen on a uniform background. More fine tuning is provided by the fogRange Viewer command.

- None: No fog effect (default).
- Haze: Linear increase in opacity with distance.
- Fog: Exponential increase in opacity with distance.
- Smoke: Exponential squared increase in opacity with distance.

10.1.4.6 Antialiasing

The Antialiasing... button opens a dialog with which the antialiasing quality values of all active viewers can be modified. Antialiasing is the process of smoothing jagged edges on graphic images by using intermediate shades.

The dialog provides several different interface components: a checkable group box, a quality slider, and three buttons.

The checkable group box allows you to turn antialiasing on or off for all viewers. The slider and corresponding text field let you set antialiasing quality with a value ranging from 0 to 1, 1 being the best. The buttons are used to apply, save or reset changes and to quit the dialog. A detailed description of the interface components is given below.

Antialiasing group box: The group box is composed of a slider and a checkbox. When checked, antialiasing is applied with the quality value given. Otherwise, antialiasing is disabled.

Quality slider: The antialiasing quality slider presents the quality range. If the slider value changes, the corresponding antialiasing is applied. This slider is accompanied by a text edit field to view the exact value of the current antialiasing and to set its numerical value. The component values are always in the range of 0 to 1.

Antialiasing can be done in two different ways. If full-scene antialiasing is supported via the ARB_multisample and ARB_pixel_format OpenGL extensions, it is used for rendering. Note that the number of samples used in the antialiasing computation depends on your graphics hardware and on your video driver. NVidia graphics hardware can support number of samples * 2 levels of quality (assuming the NV_multisample_filter_hint OpenGL extension is available). If it is not supported, smoothing and multipass antialiasing will be used instead.

Buttons: The three buttons named OK, Save and Cancel are for closing the dialog and applying the changes to the antialiasing (OK), saving the status and the quality in preferences (Save) and closing the dialog without applying the changes (Cancel).

Note: Antialiasing is not supported by Sorted Layers and Sorted Layers Delayed transparency modes.
10.1.4.7 Enable Shadows

This toggle allows you to activate/deactivate the shadowing for display modules. For more information about shadow casting, please refer to the Shadowing documentation.

10.1.4.8 Axis

The Global Axes button creates a Global Axes module which immediately displays a coordinate frame in the viewer window. This button is a toggle, so clicking on it again deletes the Global Axes module and removes the coordinate frame from the viewer window. The axes will be centered at the origin of the world coordinate system. You may also create local axes by selecting the appropriate entry from a data object’s popup menu.

10.1.4.9 Measuring

The Measuring button creates an instance of a Measurement module that lets you measure distances and angles on objects within the viewer.

10.1.4.10 Frame Counter

The Frame Counter toggle lets you switch on a frames-per-second counter that will be displayed in the first viewer (viewer 0).

10.1.5 Window Menu

The Window menu allows you to manage the visibility of some interface components like the Console or the Help panels. These panels are, in fact, dockable windows which can be docked in any part of the Amira main window.

Note that, when workrooms are defined, the different workrooms will be listed within this menu.

The Window menu is different in each workroom and lists the panels available in the current workroom only. For instance, when the active workroom is Project View, the Window menu will contain:

10.1.5.1 Hide Panels

This toggle allows you to show/hide all the panels of Amira except the viewers.

10.1.5.2 Colormap

This toggle allows you to show/hide the Colormap Editor panel of Amira.
10.1.5.3 Console
This toggle allows you to show/hide the Console panel of Amira.

10.1.5.4 Tables
This toggle allows you to show/hide the Tables panel of Amira, i.e., the one containing the tables of a spreadsheet data.

10.1.5.5 Project View
This toggle allows you to show/hide the Project View panel of Amira, i.e., the one containing the Project View (Graph View or Tree View).

10.1.5.6 Properties
This toggle allows you to show/hide the Properties panel of Amira.

10.1.5.7 Help
This toggle allows you to show/hide the Help panel of Amira.

10.1.5.8 Correlation
This toggle allows you to show/hide the Correlation panel of Amira.

10.1.5.9 Histogram
This toggle allows you to show/hide the Histogram panel of Amira.

10.1.5.10 Toolbars
In addition of these panels, you can also manage the visibility of some Amira toolbars via the Toolbars submenu.

10.1.5.11 Restore default layout
This toggle is used to restore Amira to its default layout.
10.1.6 Help Menu

The Help menu gives you access to documentation like the Amira’s User’s Guide or Programmer’s Guide but also to other information like the License Manager, the News or the System Information dialog.

10.1.6.1 User’s Guide

This button shows the Help dialog on the Amira documentation home page. You will have access to the entire Amira documentation.

10.1.6.2 Examples

This button shows the Help dialog on the Amira documentation demos page. You will have access to the Amira provided Examples.

10.1.6.3 Programmer’s Guide

This button shows the Help dialog on the Amira documentation Programmer’s Guide page. You will have access to the programmer’s documentation which is useful if you have an Amira XPand Extension license.

10.1.6.4 Programmer’s Reference

This button launches the Amira Programmer’s Reference document ($AMIRA_ROOT/share/devrefAmira/Amira.chm) which gives you information about Amira classes and allows you to navigate into the Amira class list, hierarchy and members. This documentation is useful if you have an Amira XPand Extension license.

10.1.6.5 License Manager

This button launches the Amira License Manager which displays the status of your Amira licenses.

10.1.6.6 Show Available Extensions

This button launches a dialog which displays the activated licenses on your computer.

10.1.6.7 System Information

This button launches the Amira System Information Dialog which displays some information about your system. This information allows you and the Amira support team to better analyze software problems.
10.1.6.8 Online Support

This button launches an external web browser on the Technical Support contacts web page of Amira.

10.1.6.9 About

This button launches a dialog containing Amira build and copyrights information.

10.1.7 Standard Toolbar

This toolbar provides quick access to some important actions in Amira (also accessible from the menus in Amira) like opening/saving data or a Project or opening the Preferences Dialog.

The following actions have a shortcut in the Standard Toolbar:

- Open Data, Save Data
- New Project, Open Project, Save Project
- Preferences

Note: by default, this toolbar is hidden, it can be shown via the Window / Toolbars menu.

10.1.8 Workrooms Toolbar

This toolbar provides quick access to some important workrooms and is available in the upper part of the main window.

You can use the following shortcuts to navigate through the workrooms:

- Ctrl + Tab: Open next workroom.
- Ctrl + Shift + Tab: Open previous workroom.

To learn more about workrooms concept, please refer to the following documentation.

10.1.9 Project View

The Project View of Amira contains the Project View (Graph View or Tree View). By default, the Project View is displayed on top of the Properties Area but you can easily move it where you want in the Amira main window since the Project View is a dock widget.

Figure 10.2: The Workroom Toolbar.
The Project View represents data objects and modules currently in use as well as connections indicating dependencies between objects and modules. You can easily switch between 2 different views:

- the Graph View where objects are represented with icons and dependencies between objects are indicated with connection lines,
- the Tree View where objects are arranged in a tree in which objects are displayed underneath those objects on which they depend.

To change the current Project View, you can click on the Graph View or Tree View buttons in the Project Menu.

Note: Other than when attention is being specifically called to highlight the differences between the Project Graph View and the Project Tree View, Project View will be used throughout the Amira documentation to refer generically to the pane of the Amira main window containing the collection of objects and modules that define the visualization project.

10.1.9.1 Project Graph View

Concepts
The Project Graph View is displayed if Graph View is selected. This selection is made by clicking the Graph View button in the Project Menu.

Once a data object has been loaded or a module has been created, it will be represented by an icon in the Project Graph View. Some objects, especially initially loaded colormaps, may not be visible here. Such hidden objects are listed in the Project > Show Object menu of the Amira main window. Selecting an object from this menu causes the corresponding icon to be made visible in the Project Graph View.

Icon colors are used to indicate different types of objects. Data objects are shown in green and are the only objects which can be saved to disk using File > Save Data, File > Save Data As or File > Export Data As menu entries. Computational modules are shown in red, visualization modules are yellow, and visualization modules of slicing type are orange. These modules, Ortho Slice for example, may be used to clip the graphical output of any other module.

Connections between data objects and processing modules, shown as blue lines, represent the flow of data. For display modules, these connections show the data used to generate the display. You may connect or disconnect objects by picking and dragging a blue line between object icons.

As you might expect, not all types of processing modules are applicable to all kinds of data objects. If you click on a data object icon with the right mouse button, a menu pops up that shows all types of modules that can be connected to that object (alternatively, you can click on the small white triangle on the right side of the icon with the left, right, or middle button or press [Ctrl]+[Space]). For more details about this menu, please refer to the Object Popup documentation. Selecting one of the modules will automatically create an instance of that module type and connect it to the data object. A new icon and a connecting line will appear in response. This way you can set up a more or less complex project that represents the computational steps required to carry out a specific visualization task and is used to
trigger them. Note that modules used will appear as shortcut (or macro) buttons in the upper part of the window.

If you look closer at an object’s icon you will notice two small squares on its left, one white and one orange. If you click on the white square with the left (or right, or middle) mouse button, a menu pops up that shows all connection ports of that object.

If the white square has a "-" or a "+" inside, you can click it with the left (or right, or middle) mouse button to hide ("collapse") or unhide ("expand") the objects connected to that object. The collapse feature is helpful if there are too many objects in the Project Graph View to easily view them all at once. The hidden objects will be visible in the Project > Show Object menu.

The orange square controls the object’s visibility in the viewers. It shows the current viewer layout (1 viewer, 2 viewers, etc.). Click inside the region of the square corresponding to a specific viewer to toggle the visibility of the object in that viewer. The region turns gray when the module is set to invisible. If you are using more than 4 viewers, each additional viewer will have its own orange square on the object’s icon. You can also control an object’s visibility by clicking on its visibility toggle in the Properties Area.

Figure 10.3: The Project Graph View contains data objects and module icons.

As mentioned above, for most objects the required connections are established automatically on creation. However, in order to set up optional connections, you must use the connection popup menu. For
example, you may attach an optional scalar field to an *Isosurface* module’s *Colorfield* port in order to color the surface using the values in the *Colorfield*.

Once you have selected an entry from the connection popup menu of the object icon, you can choose a new input object for that port. In order to do so, click on the input object’s icon in the *Project Graph View*. The blue connection line will become lighter blue if the connection port can be connected to the chosen object. Reasons for not being able to connect an input to a port can include the following: incompatible data type (use *Convert Image Type* to change), incompatible dimensionality of the input (use *Channel Works* to change), incompatible grid type of the data (for example, use *Arithmetic* to sample a regular grid), or simply that the connection does not make sense, for example, connecting a display module for surfaces to a volume data set.

In order to disconnect an input object, click on the icon of the module to which the port belongs. Data objects possess a special connection port called *Master*. This port refers to a computational module or editor to which the data object is attached. It indicates that the computational module or editor controls the data object, i.e., that it may modify its contents.

Each object has an associated control panel containing buttons and sliders for setting or changing additional parameters of the object. The control panel becomes visible once the object has been selected, i.e., by clicking on its icon with the left mouse button. In order to select multiple objects, you can shift-click the corresponding icons or select them by using the rectangular selection tool (press and hold down the left mouse button over the *Project Graph View* background, then sweep out a rectangle). Clicking on the icon of a selected object deselects it again. Clicking somewhere on the background of the *Project Graph View* causes all selected objects to be deselected. One or more selected icons may be dragged around in the *Project Graph View* by clicking on them and moving the mouse pointer while holding down the mouse button.

**Interface**

At the right of the *Project View* banner are the *Auto-Display activator*, *Project View Select Mode*, *Project View Pan Mode*, *Reorder Project View* and the *Switch To Project Tree View* buttons. In *Project View Select Mode*, the mouse is used for selecting, positioning, connecting, and disconnecting objects in the *Project Graph View*. In *Project View Pan Mode*, moving the mouse pans the *Project Graph View* workspace. In case your current *Project* is not well organized, i.e., contains a lot of objects and you are not able to easily find an object icon among others or visualize dependencies between objects, you can click on the *Reorder Project View* button. In this case, the *Project Graph View* will be reorganized with object icons reordered according to the following rule: data objects are on the left, compute objects in the middle and visualization modules on the right. The last button switches the Project View to *Project Tree View*.

At the top of the *Project Graph View* is a region containing shortcut (or macro) buttons. The *Open Data* button is a shortcut to the *File > Open Data* menu item. Up to 4 additional buttons are automatically displayed depending on the currently selected object(s). They provide easy access to the modules that are most commonly used and/or that have been recently used with the currently selected object.

The trashcan at the bottom right of the *Project Graph View* provides a convenient shortcut for removing an object. Drag the object to the trashcan. When the cursor turns into an ”X”, release the...
mouse button and the object will be removed from the Project View. If you remove a data object, all modules downstream from that module will be deleted as well. Alternatively, you can use the Remove Object item from the Project menu, or you can use the [Delete] key to remove selected object(s).

10.1.9.2 Project Tree View

The Project Tree View is displayed if Tree View is selected. This selection is made by clicking on the Tree View button in the Project Menu.

![Project Tree View](image)

**Figure 10.4**: The Project Tree View contains data objects and module icons organized in a tree view.

Once a data object has been loaded or a module has been created, it will be represented by a new entry in the tree view.

Each object has an associated control panel containing buttons and sliders for setting or changing additional parameters of the object. The control panel becomes visible in the Properties Area once the object has been selected, i.e., by clicking on its icon with the left mouse button. In order to select multiple objects, you can shift-click the corresponding icons. Clicking on the icon of a selected object deselects it again. Clicking somewhere off of the tree view, e.g., beyond the bottom of the tree view, causes all selected objects to be deselected.

At the top of the Project Tree View is a region containing shortcut (or macro) buttons. The Open Data button is a shortcut to the File > Open Data menu item. Up to 4 additional buttons are automatically
displayed depending on the currently selected object(s). They provide easy access to the modules that are most commonly used and/or that have been recently used with the currently selected object.

The tree view display has 5 columns:

- **Column 1**: Contains the actual tree view.

- **Organization**: The tree is organized into folders containing different kinds of objects: *Data, Display, Compute*, etc. Most of the folders are predefined and cannot be modified. A few, however, such as the *Data* folder, can have more folders added beneath.

- **Connections**: If you right-click on a data object icon, a menu pops up that shows all types of modules that can be connected to that object (alternatively, you can press `[Ctrl]+[Space]`). For more details about this menu, please refer to the *Object Popup* documentation. Selecting one of the modules will automatically create an instance of that module type and connect it to the data object. A new item in the tree view will appear in response. In this way you can set up a more or less complex project that represents the computational steps required to carry out a specific visualization task and is used to trigger them. Note that modules used will appear as shortcut (also known as ”macro”) buttons in the upper part of the window.

For most objects, the required connections are automatically established on creation. The connection is shown in the connected object’s input port in its control panel in the *Properties Area*. For example, when you attach an *Ortho Slice* to `my_data.am`, in the ”Data” port of the *Ortho Slice* control panel, you will see ”my_data.am” in the pulldown list. If other objects in the *Project Tree View* can be connected to the *Ortho Slice*, they will be in the list as well. To switch the connection, simply select a different item from the list. The tree view (and possibly the viewer display) will be updated accordingly. Selecting ”NO SOURCE” from the list disconnects the module from any object.

Reasons for not being able to connect an input to a port can include the following: incompatible data type (use *Convert Image Type* to change), incompatible dimensionality of the input (use *Channel Works* to change), incompatible grid type of the data (for example, use *Arithmetic* to sample on a regular grid), or simply that the connection does not make sense, for example, connecting a display module for surfaces to a volume data set.

Data objects possess a special connection port called *Master*. This port refers to the computational module or editor to which the data object is attached. It indicates that the computational module or editor controls the data object, i.e., that it may modify its contents.

- **Expand/Collapse**: You can click on the *arrow* icons at the left to expand or collapse portions of the tree.

- ** Drag-and-Drop**: You can use drag-and-drop to move items in the tree view. For example, to connect an existing visualization module to a different data set, you can drag and drop it from its current location onto a compatible data set. Drag-and-drop does not work for disconnecting objects. You must use the connection ports for this.
• **Viewer Toggle:** The check boxes control the visibility of the object in the *currently active* viewer. If there are multiple viewers, e.g., a 4-viewer layout, you can select a viewer, set the object’s visibility in that viewer, then repeat as often as necessary to set the desired visibility options for each viewer. However, it will probably be more convenient to control the visibility in individual viewers by using the viewer toggle button in the object’s control panel in the Properties Area. The viewer toggle button is the orange square just to the right of the module name in its control panel. The button is divided into regions corresponding to the current viewer layout. Click on the region to toggle visibility of the object on/off in the corresponding viewer. If there are more than 4 viewers, each additional viewer will have its own toggle button.

• **Adding a Folder:** At the right of the Project Tree View banner are the *New Folder* and the *Switch To Project Graph View* buttons. The *New Folder* button is used for adding a new folder directly below the currently selected folder. You can also add a folder by right-clicking on an existing folder and selecting *New Folder* from the context menu. At some positions in the tree, it may not be possible to add a new folder. The last button switches the Project View to Project Graph View.

• **Removing an Object:** To remove one or more objects from the Project Tree View, first select the object(s) to be removed. You can then use the *Remove Object* item from the Project context menu, or you can press the [Delete] key to remove selected object(s). If you remove a data object, all modules downstream from that module will be deleted as well.

• **Hovering:** Hovering the mouse over an item in the tree view displays information about that item, usually its type, e.g., HxUniformScalarField3.

**Column 2:** Shows, for certain objects, the current value of a port of interest. Currently, the *slice number* is shown for slice modules (Ortho Slice, Inline, etc.) and the *time scale factor* is shown for the Seismic Settings module.

**Column 3:** Shows the current colormap, if any, associated with the module or object. You can right-click on it to show the standard colormap context menu. Or you can left-click on it to bring up the Colormap Editor.

**Column 4:** Displays the icon of the editor, if any, currently operating on the object. For example, the Crop Editor, the Parameter Editor, etc.

**Column 5:** Displays a color-coded marker indicating the kind of object or module, as follows:

- **Red:** computational modules
- **Orange:** visualization modules of *slicing* type. These modules may be used to clip the graphical output of any other module.
- **Yellow:** visualization modules
- **Green:** data objects. These are the only objects which can be saved to disk using *File > Save*.
• Blue: script objects
• Purple: settings modules, e.g., Seismic Settings, XScreen Settings, etc.

10.1.10 Properties Area

The Properties Area is the place where the user interface of selected objects is displayed. Typically, the interface consists of buttons and sliders arranged in Groups and Ports. Ports are objects that allow the user to pass information to a module through them. A group is an object that contains several ports associated to a common theme. They can be collapsed or expanded. As an example, on the Figure 10.5, ports regarding resampling and optimizations options are respectively gathered in Resampling Options and Optimizer Options groups. Two others groups that are collapsed are Metric and Localizers. Some ports are advanced ports, which means they will only be visible if the Advanced toggle at the top right corner of the Properties Area panel is ON. Otherwise, these ports will be hidden and set to a default value. You can distinguish advanced ports by the darker color indicator on the left of the Properties Area.

![Figure 10.5: The Properties Area of Register Images module.](image)

Once an object has been selected, its input controls will be displayed in the Properties Area. By default, the Properties Area is displayed under the AmiraProject View, but you can easily move it

User Interface Components
where you want in the Amira main window since the Properties Area panel is a dock widget. You can also quickly show/hide the Properties Area panel by clicking Properties in the Standard Toolbar or in the Window Menu.

Each object has a specific set of controllable parameters or options. These are described in detail for each module in the modules index section of the reference manual. Objects (modules, data...) also provide a question mark button that lets you access the documentation of that object directly.

Apply is active (green) for modules that require you to explicitly initiate their action. Typically, this is true for modules whose actions may take a significant amount of time like some of the compute modules.

Check the auto-refresh check box to automatically force an apply for any change in the project.

An object’s name is displayed at the top of its control panel along with various control buttons. All data objects and display modules have one or more orange viewer buttons for each 3D viewer. These buttons control whether any graphical output of an object is displayed in a particular viewer or not. For example, if you have two viewers and two Isosurface modules you may want to display one Isosurface in each viewer.

Display modules of slicing type (orange ones like Ortho Slice) provide a clip button. Clicking this button will cause the graphical output of any other module to be clipped by that slice. Clipping does not affect modules with hidden geometry, or modules that are created after the clip button has been pressed.

Data objects provide a number of additional editor buttons. Editors are used to modify the contents of a data object interactively. For example, you can perform manual segmentation of 3D image data by editing Label Fields using the Segmentation Editor. Some editors display their controls in the Properties Area like all other objects, while others use a separate dialog box that allows you to perform object manipulations.

As mentioned, specific input controls of an object or a module are organized into Ports. Each port has a pin button on its left. If a port is pinned, it will still be visible even when the object is deselected. The ports are composed of widgets that can be used to set the parameters pertaining to various operations (e.g., a value is entered by a slider, a state is set by radio buttons, a binary choice is presented as a toggle button). The control elements have a uniform layout and are divided into several basic types. A description of the basic port types is contained in the ports Index Section of the User’s Reference Manual.

Ports whose labels are displayed in italics are special since they are input connection ports. They are used for connecting data objects and modules into a project that represents the computational steps required to carry out a specific visualization task. Each connection port contains the list of objects to which it can be possibly connected, plus a ”NO SOURCE” item, which means it should not connect to anything.

In Graph View mode, a display of these connection ports can be toggled on and off via the Layout tab of the Edit / Preferences menu. They are displayed by default to help beginners understand the Project View architecture.

User Interface Components

444
In *Tree View* mode, these connection ports are always displayed, because this is the only mechanism in this mode for defining projects. When an object is completely disconnected from all others, it will be moved in the tree to an appropriate folder. For example, to *Display* for a display module, to *Compute* for a compute module, and so on.

If the shadowing effect is switched on in the *Rendering* tab of the *Edit / Preferences* menu, some visualization modules will display the *Shadow* button (See Figure 10.6). Clicking *Shadow* will change the following modes:

- *Cast Shadow*: the object will cast shadows
- *Receive Shadow*: the object will only receive shadows
- *Cast & Receive Shadow*: the object will cast and receive shadows
- *No Shadow*: no shadows will be visualized

![Figure 10.6: Shadow Button Example](image)

Only display modules have *pickable* toggles (See Figure 10.7). When the pickable toggle of a display module is off, the user cannot pick it in the viewer.

![Figure 10.7: Pickable Toggles in Display Modules.](image)

### 10.1.11 Progress Bar

The *Progress Bar* is located in the lower part of the Amira main window. It is used when computational operations have been started to indicate the percentage of computation which is complete and provide information on what task is currently being performed.

It provides a *Stop* button which, when red, allows you to interrupt the current action. This button is grayed out when there is no current action or when the current action cannot be interrupted.

You can refer to the *Progress bar command options* for the set of Tcl commands available for the *Progress Bar*.
Figure 10.8: Default state of the Progress Bar: "Ready" is displayed and the Stop button is disabled.

Figure 10.9: State of the Progress Bar during a resampling operation (Resample module): current computational action is "Resampling" and the Stop button is red and enabled.

10.1.12 Viewer Window

The 3D viewer plays a central role in Amira. Here all geometric objects are shown in 3D space. The 3D viewer offers powerful and fast interaction techniques. It can be regarded as a virtual camera which can be moved to an arbitrary position within the 3D scene. The left mouse button is used to change the view direction by means of a virtual trackball. The middle mouse button is used for panning, while the left and the middle mouse button pressed together allow you to zoom in and out on objects.

The following controls can be used:

- hold down the left mouse button and move the mouse to rotate the camera around its current focal point (the focal point can be changed by doing a seek operation), hold down the left mouse button + [SHIFT] to constrain this rotation around the X or Y axis, and the left mouse button + [CTRL] for the Z axis.

- Hold down the middle mouse button to pan.

- Hold down the left + middle mouse buttons to zoom / dolly, or [CTRL] + the middle mouse button, or [CTRL] + [SHIFT] + the left mouse button

- Click the right mouse button to open the popup menu (see Viewer popup description for more details).

- Press the [S] key, then click on an object with the left mouse button to "seek" to that position.

- Press the [P] key, then click the left mouse button to pick a 3D Object in the viewer. The corresponding module will be selected.

- Press the [Space] key to view the entire 3D scene.

- Press the [ESC] key to switch between "interaction" mode and "trackball" mode.
The virtual trackball, controlled by the left mouse button, allows for free rotation of the camera.

Some *viewer gadgets* may be displayed in one of the corners of the display:

- **camera trackball**: used for constrained rotation of the camera about the screen-aligned X, Y, or Z axes. Click on the vertical wheel (it becomes red when you select it) and move the mouse up/down (while the left mouse button is pressed) to rotate about the X axis. Click on the horizontal wheel (it becomes green when you select it) and move the mouse left/right (while the left mouse button is pressed) to rotate about the Y axis. Click on the third wheel (it becomes blue) and move the mouse up/down (while the left mouse button is pressed) to rotate about the Z axis.

- **3D compass**: indicates the current camera viewing direction. It is an indicator only; you cannot use it to control the viewing direction.

The *Edit > Preferences > Layout* dialog can be used to control the visibility, auto-hide option, and position of the trackball and the compass. Refer to the *Viewer gadgets* section for more details.

Sometimes you need to manipulate objects directly in the 3D viewer. For example, this technique, called 3D interaction, is used by the *Transform Editor*. You can switch on this editor with the transform editor button in the properties of a data object. The editor provides special draggers that can be picked and translated or rotated in order to specify the transformation of a data object. Before you can interact with these draggers, you must switch the viewer into *interaction mode*. This is done by clicking on the arrow button in the upper left corner. If the viewer is in interaction mode, the mouse cursor will be an arrow instead of a hand symbol. You can use the [ESC] key in order to quickly switch between interaction mode and viewing mode. If the viewer is in interaction mode, use the [Alt] key to temporarily switch to viewing mode.

More than one viewer can be active at a time. Standard screen layouts with one, two, or four viewers can be selected via the *View menu*. Additional viewers can be created using the Tcl command *viewer <n> show*, where `<n>` is an integer number between 0 and 15. While viewers 0 to 3 will be placed in a common panel window, viewers 4 to 15 will create their own top-level window. For more specific control, the viewer provides an extensive command set, which is documented in Section 11.5.4.1 *Viewer command options*.

### 10.1.12.1 Viewer toolbar description

The toolbar of the main viewer window provides several buttons and controls, allowing you, for example, to switch between viewing mode and interaction mode, to choose certain orientations, or to take snapshots. The precise meaning of these controls is described below.

**Interact:**

- Switches the viewer into interaction mode. You can also use the [ESC] key to toggle between viewing mode and interaction mode.
**Figure 10.10:** Amira’s viewer window provides a virtual trackball for easy navigation, as well as optional viewer gadgets: camera trackball (lower right) for constrained rotation and 3D compass (lower left) for camera viewing direction indication.

**Trackball:**

Switches the viewer into viewing mode. You can also use the `[ESC]` key to toggle between interaction mode and viewing mode. The left mouse button is used to change the view direction by means of a virtual trackball.

**Translate:**

Same as *Trackball* except that the left mouse button is used for panning (translation).

**Zoom:**

Same as *Trackball* except that, in this mode, vertical motion of the left mouse button controls zooming.
Rotate:

Rotates the camera around the current view direction. By default, a clockwise rotation of one degree is performed. If the [SHIFT] key is pressed while clicking, a 90 degree rotation is done. If the [CTRL] key is pressed, the rotation will be counterclockwise.

Seek:

Pressing the seek button and then clicking on an arbitrary object in the scene causes the object to be moved into the center of the viewer window. Moreover, the camera will be oriented parallel to the normal direction at the selected point. Seek mode may also be activated by pressing the [S] key in the viewer window.

Important note: When using front face culling mode on an object, Seek will work on the hidden faces unless you move the camera “through” front hidden faces. This limitation will be solved in the future Amira releases.

Home:

 Resets the camera to the home position.

Set Home:

 Sets the current position as the new home position.

View All:

 Repositions the camera so that all objects become visible. The orientation of the camera will not be changed.

XY-, XZ- and YZ-Views:

Adjusts the camera according to the specified viewing direction. The viewing direction is parallel to the coordinate axis perpendicular to the specified coordinate plane. The opposite view direction is used if the [SHIFT] key is pressed.

Note: In the some Editions, these buttons will be replaced by the geographic view orientation buttons.

Geographic View Orientation:

Adjusts the camera according to the specified viewing direction: from top, from bottom, from west, from east, from south, from north.

Note: In some Editions, these buttons replace the XYZ view buttons.

Perspective/Ortho:


Toggles between a perspective and an orthographic camera. By default, a perspective camera is used. Orthographic camera may be used in order to measure distances or to exactly align objects in 3D space.

**Note:** Only one of these buttons will be visible at a time, the button indicating the currently active camera type.

**Stereo:**

Allows you to enable or disable stereo viewing, as well as specify various stereo viewing parameters via the *Stereo Preferences* dialog.

**Pick:**

Pressing the pick button and then clicking on an arbitrary object in the scene causes the corresponding module to be selected. Picking mode may also be activated by pressing the `[P]` key in the viewer window.

**Measuring:**

Pressing this button creates an instance of a *Measurement* module that lets you measure distances and angles on objects within the viewer. Clicking on the down arrow will display a menu of measuring tools from which to choose: 3D Length, 3D Angle, 3D Annotation, 3D Box, 3D Circle. Only one of these buttons will be visible on the toolbar at a time, the button of the measuring tool most recently accessed from the viewer toolbar.

**Quick Probe:**

This button allows you to choose the probing mode available in *Interaction mode*. By default, Quick Probe is move sensitive, i.e., voxel value and coordinates under the mouse cursor are displayed in the progress bar.

With click on this button you can disable the quick probe mode, make it move sensitive or click sensitive. Click sensitive behavior displays coordinates and value if `[SHIFT]` key is pressed and left mouse is clicked on some visualization in the viewer.

**Note:** If `[SHIFT]` key is pressed, no other interaction is possible in the viewer except clicking to probe.

**Display unit:**

The button specifies the currently selected display unit.

Clicking on the down arrow of this button will display a menu of all possible display units.

**Note:** This button is visible only if unit management is activated and display units are modifiable, i.e.,
"Lock display units on working units" is unchecked on preference options.

**Snapshot:**

Takes a snapshot of the current rendering area and saves it to a file. The filename as well as the desired output format must be entered through the *Snapshot dialog*. Snapshots may also be taken using the `viewer command` `snapshot`.

**Layout:**

Selects the viewer layout: a single view, two viewers side-by-side, two viewers stacked, or four viewers.

**Fullscreen:**

Selects fullscreen mode. In this mode, the viewer occupies the entire screen and no other windows will be visible. To exit fullscreen mode, click the right mouse button and uncheck *Fullscreen* in the popup menu.

**Link objects visibility:**

Links the visibility of objects between all viewers. When checked, it means that changing the visibility (viewer mask) of an object in one viewer will change it in all viewers.

In addition to these buttons, the Amira viewers provide an extensive set of Tcl commands, which are listed in Section 11.5.4.1 Viewer command options.

### 10.1.12.2 Viewer popup description

All viewers include a popup menu that allows you to configure various options. A right mouse button click opens this popup menu. The following menu options are available:

**Functions:**

Contains a sub-menu with items which are respectively shortcuts to *Home*, *Set Home*, *View All* and *Seek* icons.

**Viewing:**

Switches between viewing mode and interaction mode (see *Interact* and *Trackball* icons for more details). Same as pressing the `[ESC]` key.

**Fullscreen:**

Shortcut to the *Fullscreen* icon.

**Headlight:**

Activates and deactivates the headlight (see *Lights* section for more details).
Preferences:
Contains the following menu items:

- **Seek to point**: When activated, the Seek tool will focus on the clicked point, else it will focus on the object’s origin.
- **Auto clip planes**: Adjusts the camera near and far plane at each camera move.
- **Automatic interactive mode**: This option allows to get better performance when viewer is in Interact mode.
- **Stereo**: Shortcut to the Stereo icon.
- **Spin animation**: When spin animation is enabled, if the mouse is moving while you release it, the trackball will continue to spin afterwards. By default, spin animation is disabled.
- **Rotation axes**: Displays rotation axes at the center of the viewer.

Show trackball:
Shows/hides the camera trackball (see Viewer gadgets section for more details).

Show compass:
Shows/hides the compass (see Viewer gadgets section for more details).

Link camera to:
This menu option creates a camera link from the current viewer to the one you select (by clicking it after you select the menu option); pressing the [ESC] key before selecting a viewer aborts the link operation. When the cameras of two viewers are linked, they view both scenes from the same 3D point and looking in the same direction. The section Unlink camera below explains how to remove a camera link.

Unlink camera:
This menu option removes a camera link between two viewers by selecting the viewer to unlink.

Show objects in extra viewer:
This menu option allows showing objects from the current viewer in the extra viewer using the same viewer masks.

Object visibility:
This sub-menu controls the object visibility in the viewer.
The following options are available:

- **Hide All**: Hide all objects for the viewer.
- **Show All**: Show all objects for the viewer.
- **Visible objects**: Sub menu to control the visibility of all display modules in the current viewer. When checked, it means that the module is visible.
- **Link to all viewers**: Link the visibility of objects between all viewers. When checked, it means that changing the visibility (viewer mask) of an object in one viewer will change it in all viewers.
- **Same as viewer 0, Same as viewer 1,...,Same as extra viewer**: Copy the object visibilities of the
viewer i.

**Identify:**
This menu option briefly displays the viewer identifier in the viewer.

**Identify all viewers:**
This menu option causes each viewer to briefly display its viewer identifier.

### 10.1.13 Consoles Panel

The *Consoles Panel* provides command shells allowing access to Amira’s advanced control features.

By default, the *Consoles Panel* is hidden, but you can easily display it by clicking on the *Consoles* button in the *Standard Toolbar*, in the *Window Menu* or at the right of the *Progress Bar*, or using the CTRL+ALT+A shortcut. In this case, the *Consoles Panel* will be displayed under the viewer, but you can easily move it where you want into the Amira main window since the *Consoles Panel* is a dock widget.

![Figure 10.11: The Consoles Panel for Info Messages and Scripting Commands](image)

Two command shells are available: one based on the *Tcl* script language (*Tool Command Language*), one based on *Python* script language.

#### 10.1.13.1 Tcl Console

The default shell of Amira serves two purposes. First, it gives you some feedback on what is currently going on. Such feedback messages include warnings, error indications and notes on problems as well as information on results. Second, it provides a command line interface where Amira commands can be entered using the *Tcl* script language. Examples are:

```
load C:/MyData/something.am
viewer 0 setSize 200 200
viewer 0 snapshot C:/snapshot.tif
```
The Tcl scripting syntax and the specific commands are described in the chapter *Scripting*. To execute a single command, just type in its name and arguments and press *Enter*. If you select an object and then press the **TAB** key on the empty command line, then the name of the object will be automatically inserted.

You can also type the beginning of a command word and type the **TAB** key to complete the word. This only works if the beginning is unique. Pressing **TAB** a second time will show the possible completions. Often, this saves a lot of typing. Commands provided by data objects and modules are documented in the reference section of the users guide. Pressing the **F1** key for such a command without any arguments pops up the help text for this command. This is also true for commands provided by the *ports* of an object.

Additionally, the *Tcl Console* provides a command history mechanism. Use *up arrow* and *down arrow* to scroll up and down in the history list.

To execute a file containing many Tcl commands, use `source <filename>` or load the script file via Amira’s file dialog from the file menu. Amira script files are usually identified by the extension `.hx`. For advanced script examples, take a look at Amira’s demo files located in `$AMIRA_ROOT/share/demo`.

### 10.1.13.2 Python Console

An alternative script shell is available, based on *Python* language. For more information, go to the *Python* section.

### 10.1.14 Online Help

Amira user’s documentation is available online. You can access it via the *User’s Guide* entry of the main window’s *Help* menu. The user’s guide contains some introductory chapters, as well as a reference section containing documentation for specific

- modules,
- data types,
- editors,
- file formats,
- and other components.

You can access the documentation of any such object via a separate index page accessible from the home page of the online help browser. Amira modules also provide a question mark button in the Properties Area. Pressing this button directly pops up the help browser for the particular module.

By default, the help browser is displayed in its own top-level window, but you can easily integrate it where you want into the Amira main window since the help browser is a dock widget.
Going through the online documents is similar to text handling within any other hypertext browser. In fact, the documentation is stored in HTML format and can be read with a standard web browser as well. Use the Backward and Forward buttons to scroll in the document history and Home to move to the first page.

**Searching the online documentation**

The online help browser provides a very simple interface for a content and full text search. If you want to search through the complete documentation, enter the desired text into the text field. Pressing `CTRL-SHIFT-F` moves the focus to this text field and marks all text in this field for quick access. The search will be performed upon pressing the Enter key.

The search is done by using the complete search phrase. For example, suppose you are looking for information about the *Surface Editor*. The output shows the page title where the phrase is contained and a small text surrounding the search phrase.

Searching in a help document is done by entering text in the *Find pane*. You can open it by clicking on the *Show find pane* icon or by pressing `CTRL-F`. This function searches the content and looks for the occurrence of the complete phrase you type into the text edit field. Pressing Enter, F3 or clicking on next will mark the searched phrase in the text. Another click/keypress takes you to the next occurrence of this phrase. You can search backwards by pressing `SHIFT-F3` or clicking on prev to find the previous occurrence of the phrase. If the search reaches the beginning or end of the document, it starts over continuing in the same search direction. The searched phrase is colored with a yellow background wherever it is found in the text. The *Find pane* can be closed by clicking the red X on the pane or by unchecking the *Show find pane* icon.

All searches are case insensitive!

**Running demo scripts**

In the demo section of the on-line manual, you can easily start any demonstration just by clicking on the marked text. The script will be loaded and executed immediately. You may interrupt running demo scripts by using the stop button in the lower right of the Amira main window.

**Commands**

- **help**
  Makes the help dialog appear and loads the home page of the online help.

- **help getZoomFactor**
  Returns the zoom factor of the browser.

- **help setZoomFactor <ZoomFactor>**
  Sets the zoom factor of the browser.

- **help load file.html**
  Loads the specified hypertext document in the file browser. Note that only a subset of HTML is supported.
Figure 10.12: Amira’s help window.
help reload
Reloads the current document.

help invalidateCache
Destroys the search cache. In order the search function in Amira’s help to be more responsive, the help files are parsed and cached. If for any reason there is a need to invalidate this cache, it could be performed by typing this Tcl command.

10.1.15 Histogram Panel

The histogram panel lets you display the distribution of a given measure. The entire range of values is divided into a series of intervals (bins), and the histogram panel displays how many values fall into each interval. The Amira histogram panel allows the display of multiple measures in the same window. And multiple histogram windows can be created. Typical inputs include:
- Images
- Spreadsheets
- Label analysis
- Spatial graph
- Pore network models

Here is an example of use:

- Load data/tutorials/motor.am and data/tutorials/motor.labels.am
- Select the Histogram Panel
- In the histogram panel, select motor.am in the pool down menu of the new input option
- A new menu will appear next to the first input, if the input data is not an image (grayscale data, label data), listing the list of measures that can be selected. Otherwise, an input mask can be used. This mask is the label data. A material can be defined as a mask to do the histogram.
• Press the + button

• Pixel distribution is displayed

• In the histogram panel, select motor.labels.am in the input Mask.
• A new menu will appear next to the mask input, listing the list of materials that can be selected.
Choose a material and press the + button. Two histograms are now displayed next to each other.
The second histogram shows the pixel distribution which correspond to the selected material at the step before.

**Note:** When a first histogram has been displayed, only histogram from the same data type can be overlayed. If you load a 3D image data, it will not be present in the new input drop down list, if an histogram has already been displayed. You will need to remove the histogram to get this option or create a new tab (see below).

Multiple tabbed histograms can be created:
• **Load** data/tutorials/chocolate-bar.am
• **Click the Add New Histogram tab button:**

![Image](https://via.placeholder.com/150)

**Figure 10.19:** Histogram tab

• **New histogram tab can also be renamed using the Rename Tab button:**

![Image](https://via.placeholder.com/150)

**Figure 10.20:** Rename tab

• In the histogram panel, select chocolate-bar.am in the pool down menu of the new input option.
• Select and click the Add Histogram:
As you see in the last image, it is possible to set the range in which the histogram should be displayed. The number of bins can also be set to increase or decrease the histogram resolution.

**Figure 10.21**: New renamed image histogram tab
- New tabs can be removed: Hover the mouse on the tab to see the Close button.

![Options](image)

**Figure 10.22:** Options

- It is also possible to restrict the histogram of an image within a region of interest defined by a box (ROI). This ability is a way of extracting a subvolume representative of the larger one. Multiple ROI can be created and set, and then the histogram of each can be calculated and displayed to see which one fits best the full volume.

- Load `data/tutorials/chocolat-bar.am`
- Attach a ROI Box to the data.
- Attach another ROI Box to the data.
- Select the Histogram Panel
- In the histogram panel, select `chocolat-bar.am` in the pool down menu of the new input option
- In the histogram panel, select ROI Box in the pool down of the ROI input.
- Press the + button.
- In the histogram panel, select ROI Box 2 in the pool down of the ROI input.
- Press the + button.

![Close histogram tab](image)

**Figure 10.23:** Close histogram tab
10.1.16 Correlation Panel

The correlation panel lets you plot a given measure against another one. Typical inputs include:
- Spreadsheets
- Label analysis
- Spatial graph
- Pore network models

Here is an example of use:

- Load the spatial graph data/tutorials/neuron/Neuron-SpatialGraph.am.
- Attach a Spatial Graph Statistics module to Neuron-SpatialGraph.am.
- Select the output Spatial Graph in the Spatial Graph Statistics module and click on Apply.
- The data Neuron-SpatialGraph.attributgraph is created.
- Select the Correlation Panel.
- In the correlation panel, select Neuron-SpatialGraph.attributgraph in the pool down menu of the X axis option.
- A new menu will appear next to the X axis input, listing the list of measure that can be selected, as well as a new source input below the first X axis input. This new input is for the Y axis.
- Select Segments/ChordLength in the menu next to X axis input.
• Select `data/tutorials/neuron/Neuron-SpatialGraph.attributgraph` in the pool down menu of the Y axis.
• Select `Segment/CurvedLength` in the menu next to Y axis input.
• Click on + in the Correlation Panel.
• The Correlation Panel plots CurvedLength spatial graph at a given ChordLength for each segment of Neuron-SpatialGraph.attributgraph.

• In this example, the Correlation Panel helps to conclude majority data/tutorials/neuron/Neuron-SpatialGraph.attributgraph segments are straight lines because the repartition is overall linear.
10.1.17 File Dialog

The File Dialog is the user interface component for importing and exporting data into and out of Amira. It is used in several places in Amira, most prominently by the Open Data, Save Data As, Export Data As, and Save Project items of the main window’s File Menu.

Most file formats supported by Amira will be recognized automatically, either by analyzing the file header or by looking at the file name extension. A list of all supported file formats is contained in the reference section of this manual. You may manually set the format of a file by means of the dialog’s popup menu (see below).

Platform considerations
The dialog uses native dialogs under Microsoft Windows operating systems while it uses specific dialogs under Linux and Mac OS X. Those specific dialogs may differ from the system native dialogs. On Mac OS X, to open a folder, choose an item in the "Look in" combo box. If the desired folder does not appear in the list (/Volumes for ex.), type the path directly in the "File name" field and press [Enter].

![Figure 10.27: The Amira File dialog on Mac OS X.](image)

10.1.18 Job Dialog

Certain time-consuming operations in Amira can be performed in batch mode. For this purpose, Amira provides a job queue, where jobs like generation of a tetrahedral grid can be submitted. You can inspect the current status of the job queue, start and delete jobs from the queue by selecting Dialogs > Jobs from Amira’s Edit Menu. This will bring up the Job Dialog.

The current list of jobs of a user is shown in the upper part of the Job Dialog. For each job, a short description is displayed, as well as the time when the job has been submitted and the current state of the job. A job may be waiting for execution, running, finished, or it may have been killed.
Figure 10.28: The Job Dialog lets you start, stop, examine, and delete batch jobs.
Note that Amira uses a network interface to communicate with a batch job, which may be blocked by your firewall.

The job directory

For each job, a temporary directory is created containing any required input data, scripts, state information, and log files. On Unix systems, this directory is created at the location specified by the environment variable `TMPDIR`. If no such variable exists, `/tmp` is used. On Windows systems, the default temporary directory is used. Typically, this will be `C:/TEMP` or `%USERPROFILE%/AppData/Local/Temp`.

Controlling the job queue

A job’s state may be manipulated using the action buttons shown above the job list. In order to start the job queue, select the first job waiting for execution and then press the Start button. Note that only one job can be executed at a time. In order to kill a running job, select it in the job list and press the Kill button. You may delete a job from the job queue using the Delete button. When deleting a job, the temporary job directory will be removed as well.

Information about a job

Once you have selected a job in the job queue, more detailed information about it will be displayed in the lower part of the dialog window, notably the state of the job, the temporary job directory, the submit time, the time when the job has been started, the run time, and the name of the command to be executed. Any console output of a running job will be redirected to a log file located in the temporary job directory. Once such a log file exists and has non-zero size, you may inspect it by pushing the View output button.

network issues

Job success and failure notifications require that Amira open a TCP/IP port. Depending on your network configuration, it is possible that you will not be able to receive these notifications. In these cases, contact your system administrator or change your firewall settings, if you have sufficient permissions.

Commands

```
job submit cmd info [tmpdir]
```

Submits a new job to the job queue. `cmd` specifies the command to be executed. `info` specifies the info string displayed in the Job Dialog. `tmpdir` specifies the temporary job directory. If this argument is omitted a temporary job directory is created by Amira itself. In any case, the directory will be automatically deleted when the job is removed from the job queue. Example: `job submit "clock.exe" "Test job"`
job run
Starts the first job in job queue pending for execution. When a job is finished, execution of the next job in the queue starts automatically, thus all jobs in the queue will be executed consecutively by job run.

10.1.19 Preferences Dialog

The Preferences Dialog allows you to adjust certain global settings of Amira. The preferences are stored in a permanent fashion on a per-user basis. The dialog contains a tab bar with several tabs.

The first tab, General, is dedicated to general preferences like Project View customization and saving options, web news activation/deactivation, the number of recent files or projects displayed, etc.

The second tab, Layout, affects the layout of the user interface.

The third, On Exit, controls what conditions Amira checks in the projects when it exits.

The Molecules tab allows you to specify options for handling molecular data.

The LDA tab allows you to specify options for out-of-core data.

The Segmentation tab allows you to specify options for the Segmentation Editor.

You can set the rendering options in the Rendering tab.

You can specify the number of CPU threads for compute modules in the Performance tab.

You can set the network options in the Network tab.

The Units tab provides options related to unit management and customization of the way the units will be used in Amira.

The automatic computation of Intensity Range Partitioning can be activated from the Range Partitioning tab.

Note that this last tab will be only available if you have an Amira XImagePAQ Extension license.

In the Recipes tab, you can configure some parameters used in the Recipes Workroom.

In the Auto-Display tab, you can configure the Automatic Display feature in Amira. The aim of this feature is to automatically connect a display module when a new data is added in Amira.

10.1.19.1 The General Tab

Project Modules and Data Objects

2-pass firing algorithm
If set, a slightly more complex firing algorithm is used which ensures that down-stream modules connected to an up-stream object via multiple paths are only fired once if the up-stream object changes. The default is on.
Auto-select new objects
If set, a new object selected from the popup menu of its parent object is shown automatically in the Properties Area. The default is on.

Deselect previously selected objects
This option can only be set if auto-selection is turned on. If set, all objects are deselected before selecting the new object. Otherwise, the new object will be appended at the end of the Properties Area. The default is on.

Use Legacy Demo Maker
When checked, this option allows to retrieve the legacy module Demo Maker which has been replaced by the Animation Director. The Demo Maker is available by doing a right-click in the Project View, then Create Object... and Animations and Scripts / Demo Maker.

Draw viewer toggles on icons
If set, small viewer mask toggles are drawn on the icons of data objects and display modules. This allows you to show or hide a module in a viewer without selecting it first. The default is on.

Draw compute indicator
If set, a small red rectangle is drawn inside the icon of a module to indicate that the module is currently working. The default is on.

Save Project

Include unused data objects
If set, all data objects including hidden colormaps are stored in project scripts. When executing such a script, all existing objects are removed first. If not set, only visible data objects and objects which are referenced by others are stored in a project script. When executing the script, hidden data objects are not removed. The default is off.

Include window sizes and positions
If set, window sizes and positions are stored in project scripts. Be careful using this option if you want to send your script to a machine with a different screen resolution. The default is off.

Include background settings
If set, viewer background settings are stored in project scripts.

Overwrite existing files in auto-save
If set, no overwrite check is performed for data objects that need to be saved automatically to create a project script. Otherwise, a unique file name will be chosen. Details about the auto-save feature are described in Section 10.1.1.11. The default is on.

Policy:
The default setting applying to the save project policy can be modified using the combo box with the following choices:

- Minimize project size: Only necessary data to restore the project is saved to disk. Data that can be computed will be computed at project loading. Some data that could not be recomputed may be saved to disk if needed. This is the legacy and default behavior.
• Minimize project computation: All of the data of the project are saved to disk. No computation will be done at project loading, unless that data cannot be saved in its current state.
• Always ask: Always ask what policy to use when saving a new project.

Language

Set program language to
As mentioned, this option allows selecting the language that will be used inside the program.

Online Documentation

Display only available features
Only the available features are displayed in the online documentation.

Preferences and Settings

The first button allows you to restore default preferences and/or default layout and/or to clear the recent documents lists. The second and third buttons allow you to load or save predefined sets of preferences.

Maximum Number of Recent Documents
Set here the number of available recent files and projects.

10.1.19.2 The Layout Tab

Windows

These items allow you to configure the layout of the Amira windows.

Save window layout on exit
The window layout is saved when Amira is closed. The default is on.

Show viewer in top-level window
The main Viewer window will be displayed in a top-level window. This gives you additional flexibility in managing the "real-estate" of your graphics display. For example, on a dual-head display, it can be interesting to display the Viewer window on one display and the rest of the Amira interface on the other. The default is off.

Show DoIt buttons
Some modules have a button, usually labeled "DoIt", to initiate the action of the module. By convenience, these ports are not displayed in the Properties Area. This last provides green Apply button which is used to initiate the action of all selected objects. If this box is checked, the DoIt button will be displayed in the Properties Area. The green Apply button will still be available for use as well.

Show projection buttons
This option gives you the possibility to view or not the projection buttons displayed in the module header in the Properties Area. The default is off.

Enable docking "Help" panel
This option gives you the possibility to dock "Help" panel. The default is on.

User Interface Components
Tools buttons style
This option allows you to change the way tools buttons are displayed in the Standard Toolbar. There are 5 different choices:

- Tool button icon only: only the tool button icon is displayed
- Tool button text only: only the tool button text is displayed
- Tool button text beside icon: the tool button text is displayed beside its icon
- Tool button text under icon: the tool button text is displayed under its icon
- Tool button follow style: the tool button is styled according to the style of your platform

The default tools buttons style is Tool button text under icon for Mac and Tool button text beside icon for other platforms.

Finally, you have the choice to Restore current layout, and Save current layout.

Viewer gadgets
There are two viewer gadgets, a camera trackball and a compass.

The camera trackball, used for constrained rotation of the camera about the screen-aligned X, Y, or Z axes, is described in Section 10.1.12.

The 3D compass indicates the direction from which the camera is viewing the scene. See Section 10.1.12 for more details on the compass.

Click on the tab of the gadget whose attributes you wish to control, then set its attributes as described below.

Show the camera trackball / Show the compass
This toggle controls the visibility of the trackball/compass. The default is off.

Auto-hide the camera trackball / Auto-hide the compass
When this box is checked, the trackball/compass is only displayed while the mouse is within the trackball/compass display area. It is hidden as soon as the mouse moves outside the trackball/compass display area. The default is on for the trackball and off for the compass. This item is not active if the Show the trackball/compass item is off.

Camera trackball position / Compass position
This menu allows you to specify which corner of the viewer window in which to display the trackball/compass. The default is Lower right for the trackball, and Lower left for the compass. This item is not active if the Show the trackball/compass item is off.

Project View
These preferences allow you to customize some options linked to the Project View.

Group by display/compute/data in tree view
This option allows the user to change the way objects are organized in the Tree View. By default, objects are organized according to their dependencies/connections to other objects. For example, a
Bounding Box module will be displayed under the data object to which it is connected. By checking this option, objects will be organized by type. With the previous example, the Bounding Box module will be displayed under the Display category.

Show port interconnection in Project Graph View
When checked, the interconnection between objects and ports will be displayed as white lines connecting objects in the Graph View. The default is off.

Show colormaps connected to objects
When checked, Colormap objects will be automatically shown in the Graph View when objects are connected to these lasts. By default, Colormap objects are always hidden in Graph View. The default is off.

Show histogram in background
When checked, the data’s histogram is displayed in the colormap editor’s background and in the background of some ports. The default is off.

Glue attached display modules to data object
If you enable this functionality, all created display modules will be tight with their associated data.

Advanced mode of modules in Properties Area by default
When checked, advanced properties of modules are shown by default.

Preview
Allow to hide or to change the size of the data preview displayed in the Properties Area.

10.1.19.3 The On Exit Tab

These options allow you to control what conditions are checked for in the projects when Amira exits.

10.1.19.4 The Molecules Tab

Color Schemes
These check boxes allow you to chose alternate color schemes: CPK for atoms, and RasMol for amino acids.

Selection Info
These items control how much information is printed into the console when parts of a molecule are selected. Activate Molecule name if the name of the molecule should be printed. Activate Group name if the name of the selected group should be printed. If you activate Group attributes, all attributes of the selected group are printed. If Explicit attributes is activated, the printed attributes are restricted to those explicitly named in the corresponding text field.

Atom Expressions

ID case sensitive
Specifies if atom identifiers are case sensitive or not.
10.1.19.5 The LDA Tab

Conversion
This process has low performances, and may take a long time to compute.

Out-of-core threshold
Specifies the size above which data sets will be treated as out-of-core data.

Compression
Specifies the type of data compression. It enables generation of smaller LDA files, however it could be a little bit slower at the loading stage because of the decompression process.

Sampling
Specifies the algorithm of data sampling. Available options are:

- Sharp to use decimation algorithm (one voxel out of two).
- Average to use weighted average algorithm: voxels of tile of resolution N+1 are built from the average of the 6 neighbors from resolution N and the current voxel value weighted by n.

Tile Size
Sets the size of the tiles to be compressed.

- Voxels (Volumes) option sets the tile size in voxel for volume data.
- Pixels (Images) option sets the tile size in pixel for slice data.

Rendering Quality

Main Memory Amount
Sets the maximum main memory allowed in MB (megabytes) for all the out-of-core and in memory data sets. Increasing this value enables the use of higher resolutions when loading very large files.

Video Memory for Slice Amount
Sets the maximum texture memory allowed in MB (megabytes) for out-of-core and in memory slice data sets. Increasing this value allows visualization at higher resolutions for very large slices.

Video Memory for Volume Amount
Sets the maximum texture memory allowed in MB (megabytes) for all the out-of-core and in memory volume data sets. Increasing this value allows visualization at higher resolutions for very large volumes.

Loading Priority
Specifies whether Amira should load slices before volumes when running out of memory (Tcl command thePrefDialog setLDAGeometryPriority and thePrefDialog enableLDAGeometryPriority). Move the slider on the left to increase the resolution of the slices (it will decrease the volume rendering resolution) and move the slider on the right to increase the resolution of the volume rendering (it will decrease the slice rendering resolution).

Options

User Interface Components
**Viewpoint Refinement**  
If set, refinement depends on the viewpoint.

**View Culling**  
If set, refinement takes place only in the view frustum. Note that View Culling setting is ignored with XScreen immersive configurations because of incompatibilities.

**Screen Resolution Culling**  
If set, only tiles for which the projection of a voxel is greater than or equal to 1 pixel will be loaded. It avoids unnecessary loading of high resolution data for large volumes.

**Loading policy**  
Sets loading behavior. If *No Interaction* is selected, the asynchronous loading thread will only load when the user does not interact with the scene. If *Always* is selected, loading occurs as long as there is something to load. If *Never* is selected, no loading occurs. The default is *No Interaction*.

### 10.1.19.6 The Segmentation Tab

**3D Draw Style**  
This option lets you choose the material draw style used in the 3D viewer.

**Selection Draw Style**  
This option lets you choose the draw style used to highlight the voxels selection.

**Labels Draw Style**  
This option lets you choose the default draw style used to render a material in the material list. Note that you can also individually change the draw style for a particular material in the Segmentation Editor.

**Undo Memory Limit (MB)**  
This numeric field allows you to define the maximum amount of memory in Megabytes that the Undo system is allowed to use.

See the Segmentation Editor documentation for more details.

### 10.1.19.7 The Rendering Tab

**Quality**  

**Simplified rendering during interaction**  
This option activates a set of rendering techniques to speed the interactions. This option has some effect only with a small set of display modules (e.g., *Isosurface*).

**Raycasted spheres**  
This rendering option brings a huge improvement in terms of quality and performance in the rendering of spheres, such as in point clouds. This option has, for example, effect on the *Point Cloud View* module used with the *Plates* option activated.
Limitations: this option is not activated by default because of two limitations that should be solved in a next release:

- picking is not available for spheres in this mode
- under some specific circumstances, the rendering can be slow

Note: This option is not available on a Mac OS X platform.

**Shadowing**

If enabled, shadows will be generated. You can also select the default behavior, the intensity, and the quality of the shadows. If this option is enabled, some visualization modules show the Shadow button, through which you can directly specify the object behavior.

**Misc**

*Size of handles for ROI draggers*

This option allows specifying the size of the displayed handles when a ROI Box is used.

### 10.1.19.8 The Performance Tab

**CPU**

Here you can decide to specify the maximum number of threads for compute modules or to let Amira automatically choose the number of threads.

### 10.1.19.9 The Network Tab

**Connections**

By checking *Open listening port*, a socket will be opened at the port indicated by *Port*.

In the *Outgoing Connections* section, the *Host* and *Port* are the default host and port used by the *app send* command. See section *Application Commands*.

**Email Notification**

By selecting the *Email Notification* option, an email will be sent when an Amira Module terminates a long computation. The following settings must be defined:

- Sender Address: The sender address displayed in your email client.
- Receiver Address: The address the email will be sent to.
- Email Server: The SMTP server that will be used to send the email. It should not require an authentification.
- Email Server Port: The port used by SMTP on the Email Server (usually 25).
- Notification Minimum Time: The email will be sent when computation time exceeds the duration defined here (expressed in minutes).
**Web News**

*Do not show news*

Web News will not be displayed at Amira startup, if checked. The default is off. Web News are displayed in the middle of the welcome workroom.

**10.1.19.10 The Units Tab**

**Unit Management**

Select *None* to deactivate the unit management or *Spatial information* to activate it and use coordinates and angle units information.

*Show units dialog when loading data*

This checkbox activates the units editor dialog when loading spatial data objects.

*Automatically determine working units*

When this checkbox is selected, Amira automatically determines the working coordinate units.

*Lock display units on working units*

Setting this checkbox ensures that the units displayed in the interface components are the same as the one used internally by Amira.

*When the coordinate units are unknown at data loading*

Thanks to a radio box, this option allows selecting a behavior when a data with unknown units are loaded. Available options are:

- *Show Units Editor dialog*
- *Use "unit" as default coordinate units* where an unit can be selected as default coordinate units.

See the description of *available options linked with unit management*, the *Units* chapter and the *Units Editor* documentation for more details.

**10.1.19.11 The Range Partitioning Tab**

Note that this tab will be only available if you have an Amira XImagePAQ Extension license.

*Automatic Intensity Range Partitioning at load*

When enabled, activates automatic Intensity Range Partitioning on data loaded and generated by Amira. Then you can choose to impose the number of regions that must be found or to let the Intensity Range Partitioning algorithm detect it automatically.

*Use only for 3D boundaries displays and segmentation thresholds*

When enabled, the data window computed by the Intensity Range Partitioning will only be applied for initializing the colormap range of 3D display modules such as Volume Rendering and for intensity related ports such as threshold. Any other display will be initialized with the data min-max range. When disabled, all display modules will use the data window computed by the Intensity Range Partitioning to set the initial range of the display module.

*User Interface Components*
See the *Intensity Range Partitioning editor* documentation for more details.

10.1.19.12 The Recipes Tab

Directories
These parameters control the default directories when looking for existing recipes and saving the recipes results.
Note: The recipes results directory is automatically determined from the recipes directory.

10.1.19.13 The Auto-Display Tab

Automatic Display
Check the box to activate the Automatic Display, uncheck to deactivate it.

*Automatically connect a display module:*
These three buttons allow you to adapt the automatic display behavior to your working habits.

*Select the display module to auto-connect to:*
Allows you to customize each association between data type and their associated display module.

See the chapter *Automatic Display* for more details.

10.1.20 Snapshot Dialog

The *Snapshot Dialog* provides the user interface of the viewer’s snapshot facility. You get the dialog by clicking on the camera icon in the *Viewer window* toolbar.

- **Output:** Specifies the output device. With *to file*, the grabbed image is saved to a file, with *to printer*, the image is sent directly to the printer, and with *to clipboard*, it is sent to the clipboard. In the *to printer* mode, you must first select and configure a printer by pressing the *Configure printer* button. In addition, you may enter an arbitrary text string which is printed as an annotation text below the snapshot image.

- **Offscreen:** Lets you grab images larger than the actual screen size. When this option is checked, the output dimensions can be specified in the *width* and *height* text fields. If one of the offscreen dimension is bigger than 4096, the tiles algorithm is automatically used. Notice that the offscreen option overwrites the tiles option.

- **Render tiles:** Use this option to render snapshots of virtually unlimited resolution (e.g., for high quality printouts). In this mode, the scene is divided into n x m tiles where n and m can be entered into the adjacent text fields. Then the camera position is set such that each tile fills the current viewer and a snapshot is taken. Finally, the tiles are internally merged to a single image and sent to the device specified in the *Output* port. Note that *Annotations—Colormap*
Figure 10.29: The Snapshot Dialog allows you to save or print the contents of a Viewer window.

displays—Plot Viewer—SpreadSheet Viewer—Scale] will change their size when using tiling with snapshots.

- **Antialias**: Use this option to render snapshots with antialiasing enabled. In this mode, the antialiasing is performed by using the tiling rendering followed by a downscale. The Antialias factor determines the degree of antialiasing.

- **Capture all viewers**: This option cancels the Render tiles option and allows creating one snapshot of all viewers when several viewers are used.

- **Filename**: Lets you specify the filename, if the to file option is set. The Browse button allows you to browse to a desired location within the filesystem.
• **Format:** The format option lets you select the file format to be produced for file output. The following formats are supported: TIFF (.tif, .tiff), SGI (.rgb, .sgi, .bw), JPG (.jpg, .jpeg), PPM (.pgm, .ppm), BMP (.bmp), PNG (.png), DCM (.dcm), Encapsulated PostScript (.eps), JPEG2000 (.jp2) and PDF (.pdf). In addition, this port offers three radio buttons to choose between *grayscale*, *rgb*, and *rgb alpha* type of raster images. If *rgb alpha* option is set, images are produced such that the viewer background is assigned to the alpha channel. This option is not available for file formats that do not support an alpha channel.

• **Auto-save project:** Use this option to save the project in addition to the snapshot. If the option is checked, the project will be saved at the same location as the snapshot specified by filename, and ending with .hx. (i.e snapshot.jpg.hx)

**Warning:** it is not possible to generate a snapshot bigger than 2GB. The picture size depends on:

- *Width, Height* and *Antialias* if *Offscreen* is selected
- *Render tiles x, Render tiles y* and *Antialias* otherwise.

If the snapshot size exceeds 2GB, a warning tooltip is displayed and the value leading to the bigger size is not validated.

**Commands**

```
snapshot [options] [filename] [filename2 (for stereo mode only)]
```

Options:

- `-stereo`
  If this option is used, the stereo mode image is created. In this case, *filename2* file can be used to specify where the second image of the stereo image is stored.
- `-alpha`
  If this option is used, the snapshot image is created with a transparent background.
- `-tiled nx ny`
  If this option is used tiled rendering is used with *nx* number of tiles in the horizontal direction, and *ny* number of tiles in the vertical direction.
- `-offscreen [width height]`
  If this option is used offscreen rendering is used where *width* and *height* are width and height of rendered image.

### 10.1.21 System Information Dialog

The system information dialog provides diagnostics information allowing the user or the Amira support team to better analyze software problems. The dialog contains a tab bar with two pages. The first page
lists information about the current CPU. The second page lists information about the current OpenGL graphics driver.

In the lower left part of the dialog, you will find a button Save Report. With this button, all information can be written into a text file. In case of a support call, you may be asked to send this text file to the hotline.

10.1.21.1 The CPU Tab

This page displays information about the system on which you are running Amira. This information can be useful when reporting problems to technical support.

10.1.21.2 The OpenGL Tab

This page displays information about the current OpenGL graphics driver. In particular, a list of available OpenGL extensions is printed. This list allows it to check if certain rendering techniques, like direct volume rendering via 3D textures, are supported on a particular hardware platform or not.

10.1.22 Object Popup

This popup menu lets you attach modules to a specific object. This popup menu contains:

- An explorer used to browse the different categories of modules and data objects.
- A preview panel displaying information about the selected module or data object.
- A search field used to search an item within the categories tree.
- An options button used to perform specific actions on the object (rename, remove...).
- A save button (only on data objects) used to save (or save as, or export as) the data object.
To create an object like a *Bounding Box*, select the *Annotate* category and, then, double-click (or press `[Enter]`) on the *Bounding Box* item.

For a quicker access, it is also possible to use the search field and start to enter the "Bounding Box" string. A search will be done on the categories tree to find the modules and data objects whose names begin with the entered string and the search results are automatically displayed within a completion popup. You can instantiate the requested object by clicking on the associated completion result.

### 10.1.22.1 Explorer

This component is used to browse the categories of modules which can be attached to the object. The categories tree is represented using cascading panels allowing you to navigate through the categories, visualizing the modules hierarchy.
Once a category is selected (items with a folder icon), the next panel is automatically updated with the category contents (note that a horizontal scrollbar can be displayed when the sub-categories level exceeds three). Specific categories are listed before the other:

- **Favorites**: lists the modules which have been set as favorites (using the star button within the preview panel). This category contains default favorites modules at the first start of Amira.
- **Recents**: lists the modules which have recently been created on the object. By default, this category is empty but its contents are saved from one Amira execution to another, allowing you to retrieve the modules created during the last session.
- **Editors**: lists the editors which can be attached on the object. Note that this category is not displayed when no editor is available.
- **Templates**: lists the template modules which can be attached on the object. Note that this category is not displayed when no template module is available.

Once an object item is selected, the preview panel is displayed on the right, displaying information about the selected object. To create the selected object, double-click (or press [Enter]) on the item, or click on the button within the preview panel.

### 10.1.22.2 Preview Panel

This component is displayed when an object item is selected within the categories explorer. It provides information about the selected object such as a short description, the object’s type and its former name(s).
Thanks to the preview panel, it is possible to:

- Create the object by clicking on the button.
- Display the entire object’s documentation within the AmiraHelp dialog by clicking on the button.
- Set/unset the object as favorite by clicking on the star button.

10.1.22.3 Search Field

This component is used to search a specific object without navigating through the categories explorer. When entering a search string, the objects whose names contain the entered string will be displayed within a completion popup, allowing you to quickly create an object. Note that, when the search string exceeds 3 characters, an item is displayed at the end of the list of completion results to search the entered string within the Amira documentation (the results will be displayed within the AmiraHelp dialog).
Once the completion popup is displayed, you can create the requested object by double-clicking on it or pressing \[Enter\] after selecting it.

By default, the search is performed on:

- The name of the objects.
- The former name(s) of the objects.
- The name of the categories within the explorer.
- The name of the editors.

It is possible to filter the completion results by selecting the search filters via a menu displayed when clicking on the search field arrow \(\Rightarrow\) button.
10.1.22.4 **Options Button**

When clicking on the object’s name, a menu is shown providing different actions on the object:

- *Hide Object*: to hide the object from the Project View (only in Graph View mode).
- *Remove Object*: to delete the object.
- *Duplicate Object*: to create a copy of an object and add it to the Project View.
- *Rename Object...*: to rename the object (will pop up a renaming dialog).
- *Hide All From Viewer But This*: to keep visible in the viewer only the display modules of the selected objects.
10.1.22.5 Save/Export Buttons

The first button allows saving the data, the second button allows exporting the data.
10.1.23 Create Object Popup

The Create Object popup menu lets you create modules or data objects that cannot be accessed via the popup menu of any other object. The Create Object popup menu contains:

- An explorer used to browse the different categories of modules and data objects.
- A preview panel displaying information about the selected module or data object.
- A search field used to search an item within the categories tree.

![Figure 10.37: The Create Object popup menu.](image)

This popup menu looks and works like the popup menu of objects within the Project View. For more details about the popup menu components, please refer to the Object Popup documentation.

To create an object like a Caption, select the Annotations category and, then, double-click (or press [Enter]) on the Caption item.

For a quicker access, it is also possible to use the search field and start to enter the "Caption" string. A search will be done on the categories tree to find the modules and data objects whose names contains the entered string and the search results are automatically displayed within a completion popup. You can instantiate the requested object by clicking on the associated completion result.

The icon of a newly created object usually will not be connected to any other object in the Project View. In order to establish connections later on, use the popup menu over the small white square on the left side of the object's icon.

You can also put in links to scripts in the Create Object popup menu. Details are defined in Section 11.5.6 (Configuring popup menus).
10.2 General Concepts

This section contains some general comments on how data objects are organized, classified and managed in Amira. In particular, the following topics are discussed:

- Amira Class Structure
- Scalar and Vector Fields
- Coordinates and Grids
- Surface Data
- Vertex Set
- Transformations
- Data parameters
- Shadowing
- Units in Amira
- Automatic Display in Amira
- Workroom Concept

10.2.1 Class Structure

In this section we discuss the object-oriented design of Amira in a little more detail. You already know that data objects, e.g., gray level image data or vector field sets, appear as separate icons in the Project View. You also know that there are certain display modules which can be used to visualize the data objects. While some modules can be connected to many different data objects, e.g., the Bounding Box module, others cannot, e.g., the Ortho Slice module. The latter can only be connected to voxel data or to scalar distributions on voxel grids. The reason is that internally both are represented as a scalar field with uniform Cartesian coordinates. Consequently, the same visualization methods can be applied to both. On the other hand, for example, a volumetric tetrahedral grid model of the object of interest usually looks completely different. But since it is also a 3D data object, the same Bounding Box module can be connected to it.

In summary, there are Amira data objects that might be conceived of different type, but with respect to mathematical structure, applicability of viewing and other processing modules, as well as programming interface design, have many common properties. Obeying principles of object-oriented design, the data types of Amira are organized in class hierarchies where common properties are attributed to 'higher up' classes and inherited to 'derived' classes, as sub-classes of a class are commonly referred to. Conceptually, each object occurring in Amira is an instance of a class and each of its predecessors in the hierarchy that the class belongs to. The classes and their hierarchies are defined within Amira. As the user, you normally deal with instances of classes only. For instance, there is a class called "HxObject" with sub-classes "HxData" and "HxModule". "HxData" comprises the types of data associated with data objects used for modeling the objects of interest, e.g., volumetric tetrahedral grids or surfaces. "HxModule" comprises data types that have been assigned to display and other process-
ing modules, again in accordance with principles of object-oriented design. This is why Amira’s data objects and processing modules are commonly referred to as ”objects”.

There are also classes in Amira that are not derived from ”HxObject” and constitute other data types, and there are several independent class hierarchies. e.g., there is a class called ”HxPort” from which all classes supporting the operation and display of interface control elements are derived (see section Properties Area and the List of Ports in the index section of the User’s Guide).

A single class hierarchy is usually figured as an upside-down tree, i.e., with the root at the top. Thus the data class tree is the one to which the information as to which processing module is applicable to which data object is hooked. Its classes reflect the mathematical structure of the object models supported by Amira. For example, scalar fields and vector fields are such structures and derived from a common ”field” class which represents a mapping $\mathbb{R}^3 \rightarrow \mathbb{R}^n$. Deriving a sub-class from this base class requires a value to be specified for $n$.

At the same time, fields defined on Cartesian grids are distinguished from fields defined on tetrahedral grids, i.e., this distinction is part of the classification scheme that gives rise to branches in the data class subtree. You will learn more about the data class hierarchy in the next section of this chapter. In the second section, we discuss how some data types frequently used for various visualization tasks fit into it.

Internally, all class names begin with a prefix $Hx$. However, you don’t have to remember these names unless you want to use the command shell to create objects. For example, a bounding box is usually created by choosing the Bounding Box item from the popup menu of a data object that is to be visualized, but you may also create it by typing create HxBoundingBox in the command window.

### 10.2.2 Scalar Field and Vector Fields

The most important fields in Amira are three-dimensional ones. These fields are defined on a certain domain $\subseteq \mathbb{R}^3$. A field can be evaluated at any point inside its domain. If the field is defined on a discrete grid, this usually involves some kind of interpolation.

#### 10.2.2.1 Scalar Fields

A 3D scalar field is a mapping $\mathbb{R}^3 \rightarrow \mathbb{R}$. The base class of all 3D scalar fields in Amira is $HxScalarField3$. Various sub-classes represent different ways of defining a scalar field. There are a number of visualization methods for them, for example pseudo-coloring on cutting planes, iso-surfacing, or volume rendering. However, many visualization modules in Amira rely on a special field representation. Therefore, they can only operate on sub-classes of a general scalar field. Whenever a given geometry is to be pseudo-colored, any kind of scalar field can be used (cf. Color Wash, Tetra Grid View, Isosurface).

The class $HxTetraScalarField3$ represents a field which is defined on a tetrahedral grid. On each grid vertex, a scalar value, e.g., a temperature, is defined. Values associated with points inside a tetrahedron are obtained from the four vertex values by linear interpolation. This class does not provide a copy of
the grid itself, instead a reference to the grid is provided. This is indicated in the Project View by a line which connects the grid icon and the field icon. As a consequence, a field defined on a tetrahedral grid cannot be loaded into the system if the grid itself is not already present.

The class HxRegScalarField3 represents a field which is defined on a regular Cartesian grid. Such a grid is organized as a three-dimensional array of nodes. In the most simple case, these nodes are axis-aligned and have equal spacings. The coordinates of such a uniform grid can be obtained from a simple bounding box containing the origin vector and increments for all directions. Stacked coordinates are another example. Here the spacing in z-direction between subsequent slices may be different. In any case, scalar values inside a hexahedral grid cell are obtained from the eight vertex values using trilinear interpolation. While the Ortho Slice module can only be used to visualize scalar fields with uniform or stacked coordinates, other modules like Slice or Isosurface work for all scalar fields with regular coordinates.

Yet another example of a scalar field is the class HxAnnaScalarField3. It represents an analytically defined scalar field. To create such a field, select Images And Fields / Analytic Scalar Field from the Project > Create Object... menu of Amira’s main window. You have to specify a mathematical expression which is used to evaluate the field at each requested position. Up to three other fields can be connected to the object. These can be combined to a new scalar field, even if they are defined on different grids.

10.2.2 Vector Fields

As for scalar fields Amira provides a number of vector field classes, derived from the base classes HxVectorField3 and HxComplexVectorField3. While ordinary vector fields return a three-component vector at each position, complex vector fields return a six-component vector. Complex vector fields are used for encoding stationary electromagnetic wave pattern as required by some applications. Usually complex vector fields are visualized by projecting them into the space of reals using different phase offsets. The Vectors Slice module even allows you to animate the phase offset. In this way, a nice impression of the oscillating wave pattern is obtained.

10.2.3 Coordinates and Grids

Amira currently supports two important grid types, namely grids with hexahedral structure (regular grids), and unstructured tetrahedral grids.

10.2.3.1 Regular Grids

A regular grid consists of a three-dimensional array of nodes. Each node may be addressed by an index triple \((i,j,k)\). Regular grids are further distinguished according to the kind of coordinates being used. The most simple case comprises uniform coordinates, where all cells are assumed to be rectangular and axis-aligned. Moreover, the grid spacing is constant along each axis. A grid with stacked coordinates may be imagined as a stack of uniform 2D slices. However, the distance between neighboring slices...
in \(z\)-direction may vary. In case of \textit{rectilinear} coordinates, the cells are still aligned to the axes, but the grid spacing may vary from cell to cell. Finally, in the case of \textit{curvilinear} coordinates each, node of the grid may have arbitrary coordinates. Grids with curvilinear coordinates are often used in fluid dynamics because they have a simple structure but still allow for accurate modeling of complex shapes like rotor blades or airfoils.

\subsection*{10.2.3.2 Tetrahedral Grids}

The \textit{Tetra Grid} class represents a volumetric grid composed of many tetrahedrons. Such grids can generally be used to perform finite-element simulations, e.g., E-field simulations.

A considerable amount of information is maintained in a \textit{Tetra Grid}. For each vertex, a 3D coordinate vector is stored. For each tetrahedron, the indices of its four vertices are stored as well as a number indicating the segment the tetrahedron belongs to as obtained by a segmentation procedure. Beside this fundamental information, a number of additional variables are stored in order for the grid being displayed quickly. In particular, all triangles or faces are stored separately together with six face indices for each tetrahedron. In addition, for each face, pointers to the two tetrahedrons it belongs to are stored. This way the neighborhood information can be obtained efficiently.

When simulating E-fields using the finite-element method, the edges of a grid need to be stored explicitly, because vector or Whitney elements are used. These elements and their corresponding coefficients are defined on a per-edge basis. When a grid is selected, information on the number of its vertices, edges, faces, and tetrahedrons is displayed.

\subsection*{10.2.4 Surface Data}

\textit{Amira} provides a special-purpose data class for representing triangular surfaces, called \textit{Surface}. This class is documented in more detail in the index section of the user’s guide. For the moment, we only mention that the class maintains connectivity information and that it may represent manifold as well as non-manifold topologies.

The surface class provides a rich set of Tcl commands. It is a good example of an \textit{Amira} data class that does not simply store information, but allows the user to query and manipulate the data by means of special-purpose methods and interfaces.

\subsection*{10.2.5 Vertex Set}

Another example of data abstraction and inheritance is the \textit{Vertex Set} class. Many data objects in \textit{Amira} are derived from this class, e.g., landmark sets, molecules, surfaces, or tetrahedral grids. All these objects provide a list of points with \(x\)-, \(y\)-, and \(z\)-coordinates. Other modules which require a list of points as input only need to access the \textit{Vertex Set} base class, but don’t need to know the actual type of the data object.

One such example of a generic module operating on \textit{Vertex Set} objects is the \textit{Vertex View} module. This module allows you to visualize vertex positions by drawing dots or little spheres at each point.

\textit{General Concepts}
10.2.6 Transformations

Data objects in Amira can be modified using an arbitrary affine transformation. For example, this makes it possible to align two different data objects so that they roughly match each other. Internally, affine transformations are represented by a 4x4 transformation matrix. In particular, a uniform scalar field remains a uniform scalar field, even if it is rotated or sheared. Display modules like Ortho Slice still can exploit the simple structure of the uniform field. The possible transformation is automatically applied to any geometry shown in the 3D viewer.

In order to interactively manipulate the transformation matrix, use the Transform Editor (documentation is contained in the index section of the user’s guide).

Be careful when saving transformed data sets! Most file formats do not allow you to store affine transformations. In this case, you have to apply the current transformation to the data. This can be done using the applyTransform Tcl command. In the case of vertex set objects, the transformation is applied to all vertices. Old coordinates are replaced by new ones, and the transformation matrix is reset to identity afterwards. After a transformation has been applied to a data set, it cannot easily be unset.

If a transformation is applied to uniform fields, e.g., to 3D image data, the coordinate structure is not changed, i.e., the field remains a uniform one. Instead, the data values are resampled, i.e., the transformed field is evaluated at every vertex of the final regular grid. The bounding box of the resulting grid is modified so that it completely encloses the transformed original box.

10.2.7 Data parameters

An arbitrary number of additional parameters or attributes may be defined for any data object. Data parameters can be interactively added, deleted, or edited using the Data Parameter Editor. Parameters are useful, for example, to store certain parameters of a simulation or of an experiment. In this way, the history of a data object can be followed.

There are certain parameters which are interpreted by several Amira modules. The meaning of these parameters is summarized in the following list:

- **Colormap name**
  This specifies the name of the default colormap used to visualize the data. Some modules automatically search the Project View for this colormap and, for example, use it for pseudocoloring.

- **DataWindow minVal maxVal**
  This indicates the preferred data range used for visualizing the data. The Ortho Slice module automatically maps values below \( \text{minVal} \) to black and values above \( \text{maxVal} \) to white.

- **LoadCmd cmd**
  This parameter is usually set by import filters when a data object is read. It is used when saving the current project into a file and it allows the object to be restored automatically. Internal use
Note that there are many file formats which do not allow parameters to be stored. Therefore, information might get lost when you export the data set in such a format. If in doubt, use the specific Amira Format.

10.2.8 Shadowing

Real time shadow casting is enabled through the Rendering tab of the Preferences Dialog (accessible via the Preferences button in the Standard Toolbar or the Edit > Preferences menu entry).

Once enabled, most of display modules can cast or receive shadows.

Different modes are available, and switching from one to another is possible by clicking on the shadow icon of a display module:

- **No Shadows**: the displayed shape neither casts or receives shadows

- **Cast Shadows**: the displayed shape only casts shadows

- **Receive shadows**: the displayed shape only receives shadows

- **Cast & Receive shadows**: the displayed shape both casts and receives shadows

**Restrictions:**

At least the Multi-Texture and Texture Environment Combine OpenGL® extensions must be supported by your graphics board. Otherwise, no shadows will be computed. These extensions are now standard in OpenGL® 1.3 and later.

The Shadow and Depth Texture OpenGL® extensions (standard in OpenGL® 1.4) are used, if they are available, and generally improve performance.

Some aliasing artifacts can appear if you zoom in very close to the scene. You can then increase the quality in the Preferences Dialog.

Transparent objects are treated as follows, depending on the transparency type:
• **Screen door:** fully compatible
• **Add, Blend:** transparent objects cast a shadow and are shadowed but the shadow intensity doesn’t depend on the transparency value (the same shadow is displayed for full transparent shapes and opaque shapes).
• **All other modes:** incompatible with shadowing.

Shadowing may impact performance and is only fully supported by some display modules/modes (such as *Volume Rendering*). Setting the environment variable `AMIRA_FORCE_SHADOW_MAP` enables activating a less restrictive shadowing mode (i.e. more modules supports it but not the *Volume Rendering*).

### 10.2.9 Units in Amira

This chapter contains a description of how Amira can be configured to work with spatial data objects with associated coordinate unit information.

This chapter is organized as follows:

- **Presentation:**
  this section describes globally the unit management in the entire product.

- **How to associate a coordinate unit with a spatial data object:**
  this section describes how you can set a coordinate unit to any spatial data object.

- **How to modify the coordinate unit used for displaying information:**
  this section describes how you can change the coordinate unit which is displayed in the Amira user interface (ports values, info tags...) and 3D viewers (measuring tools...).

- **Available options linked with unit management:**
  this section describes all the different preferences and options you will be able to modify in order to customize the unit management.

- **Amira components working with the unit management:**
  this section describes all the Amira components for which the unit management has been implemented.

#### 10.2.9.1 Presentation

When activating the unit management in Amira, you will be able to:

- associate a coordinate unit with each spatial data object, retrieving it directly from the data files (depends on readers and file formats) or setting it manually with a *Units Editor*. 
• store coordinates values of all loaded spatial data object with the same coordinate units (e.g.,
meters). The coordinate units storage in Amira and used internally is called **working units**.
Working units could be specified by the user or automatically determined (see **Automatically
determine or manually set the working coordinate units**).

• display values related to coordinates information in the Amira user interface (such as bounding
box, length...) in the coordinate units you want.
The units used to display values in the Amira user interface are called **display units**.

To know how to activate/deactivate the unit management in Amira, you can refer to the following
section: **Activate/desactivate unit management in Amira**.

**10.2.9.2 How to associate a coordinate unit to a spatial data object**

When the unit management is activated in Amira, a coordinate unit will be assigned to each spatial
data object.
This can be done in 2 different ways:

- by the reader used to load the data
- or by a specific **Units Editor**

In the most possible cases, Amira readers will try to extract the coordinate unit directly from the
information stored in the data file. This is the case, for instance, with **Amira** or MCAD readers (like
**IGES**).

If the coordinate unit can’t be determined by the reader (the information is missing or not supported
by the file format), it will be specified via the **Units Editor**. This editor is launched at data loading but
is also accessible after the data has been registered into the Project View, in the same way as the other
editors.

Once a coordinate unit has been assigned to the spatial data object, its coordinates values can possibly
be converted. This will happen if the specified coordinate unit for this data is not the same as the one
used internally by Amira to store coordinates values for all spatial data objects (i.e., named working
units). In this case, the coordinates values will be converted from the specified coordinate unit to the
working one.

**Note:**
Manually setting a coordinate unit to a spatial data object (via the editor) will mark the object as
modified. Indeed, this implies that the original file format of the data does not support coordinate
unit information. After associating it a coordinate unit, the data has to be saved in a file format that
can support this information. For convenience, you can easily save data in the **Amira data file format**
which saves the coordinate unit in the Parameters section and can be used to store many different data
objects.

The information about coordinate units associated with a spatial data is accessible in several places:
• in the *Units Editor*, where you can see and modify the original coordinate unit of a spatial data (i.e., the one specified ad data loading) after that the data has been loaded

• in the *Parameter Editor* on the spatial data where the coordinate unit of the spatial data is specified under a *Units* bundle. In fact, under this bundle are displayed 2 informations:
  • the current (working) coordinate unit of the spatial data stored in the *Coordinates* parameter (the one in which are currently stored the coordinates in memory),
  • the original coordinate unit of the spatial data stored in the *OriginalCoordinates* parameter (the one specified via the *Units Editor* at data loading or edited furtherly).

10.2.9.3 **How to modify the coordinate unit used for displaying information**

Even if the coordinate unit used to internally store spatial data objects coordinates (i.e., named working unit) is fixed, values related to coordinates information that are displayed in the product user interface can be expressed in any coordinate units.

For example, you can load a spatial data object with coordinates stored in meters (i.e., working unit), connect it a *Bounding Box* module and freely modify the coordinate unit used to display the coordinates (i.e., named display unit) of the corners in the info tags of this module (by selecting millimeters, for instance).

In this case, the displayed coordinates values will be converted from the working unit (in which are internally stored coordinates values) to the display unit (in which are displayed these values in the Amira user interface).

To specify what coordinate unit is used for displaying coordinates values in the user interface:

- Launch the **Preferences dialog** (menu **Edit > Preferences...**)
- Select the **Units** tab
- Select the **Display units** tab
- In the *Spatial information* section, select the display unit you want for coordinates information

The quickest way to modify this display unit is accessible on the main viewer toolbar between Measure button and snapshot button (see **Viewer toolbar description**). The Display unit button is enable if the option ”Lock display units on working units” is unchecked. With this button, you can select the display unit you want for coordinates information not only for the active viewer but for all units displayed in Amira.

10.2.9.4 **Available options linked with unit management**

Several options linked with unit management are available and allow you to customize the way you are using units in the product.

These options are the following:
Activate/deactivate the unit management in Amira
Activate/deactivate the units editor dialog when loading spatial data objects
Automatically determine or manually set the working coordinate unit
Lock the display coordinate unit on the working one

All these options can be modified via the Amira Preferences dialog.

To access the preferences linked with unit management:

- Launch the Preferences dialog (menu Edit > Preferences...)
- Select the Units tab

Activate/deactivate unit management in Amira

In order to be compatible with older versions of Amira, you are not forced to use/set units information in spatial data objects so it’s possible to deactivate the unit management in the entire product. In this case, spatial data objects won’t contain any unit information and no conversion linked with units will be performed: Amira will work as in its previous versions, in the same way you are used to.

To activate/deactivate the unit management in the entire product:

- In the Unit management section, select None to deactivate the unit management or Spatial information to activate it and use coordinates and angle units information

Automatically determine or manually set the working coordinate units

When the unit management is activated, some units conversions could occur if you are loading data whose coordinate unit is different from the working unit, used by Amira to internally store coordinates values.

To limit as much as possible these conversions, we recommand you let Amira automatically determine the working coordinate units.

In this case, when spatial data is loaded, the working coordinate unit will be automatically set to the data one.

As you have understood, this behavior prevents the conversion of the coordinate unit of the first loaded spatial data object but conversions will still occur if the following loaded spatial data don’t have the same coordinate unit. By contrast, no conversion will be done if you load only data with the same coordinate unit (i.e., equal to the current working unit).

Of course, you are free to activate/deactivate this behavior. If you deactivate it, you can specify yourself the working coordinate unit in which Amira will store coordinates values. In this case, pay particular attention to units conversion especially when loading data.

Note:
If spatial data has been already loaded, you won’t be able to select another working coordinate unit: selecting a custom working coordinate unit is possible only when the Project View does not contain any spatial data.

To automatically determine the working coordinate units:

- Select the **Options** tab
- Toggle on/off the **Automatically determine working units** checkbox

To specify a custom working unit:

- Select the **Working units** tab
- In the **Spatial information** section, select the working unit you want for coordinates or angle information

**Lock the display coordinate unit on the working one**

In some cases, it could be interesting to always display information related to coordinates values in the Amira user interface in the same unit as the one used internally to store these coordinates values. This behavior ensures that values that are displayed in the interface components are the same as the ones manipulated internally by Amira.

To lock the display coordinate unit on the working one:

- Select the **Options** tab
- Toggle on/off the **Lock display units on working units** checkbox

**Activate/deactivate the units editor dialog when loading spatial data objects**

As explained before, when the unit management is activated, some readers can launch a specific dialog used to specify the coordinate unit of the loaded spatial data.

This dialog will be launched only if the reader has failed to automatically retrieve the coordinate unit from the information stored in the data file.

Note that you have the option to prevent the dialog from being displayed. In this case, the loaded spatial data object will be assumed to have the default coordinate unit specified in preferences.

**Note:**
Even if you choose to not automatically display this dialog when data are loading, you still have the possibility to specify the coordinate units thanks to the units editor available when selecting the spatial data object in the Project View.

To activate the units editor dialog when loading spatial data objects:

- Select the **Options** tab
- Go to **When the coordinate units are unknown at data loading** groupbox
• Toggle on the **Show Units Editor dialog** checkbox

To deactivate the units editor dialog when loading spatial data objects:

• Select the **Options** tab
• Go to **When the coordinate units are unknown at data loading** groupbox
• Select your preferred coordinate units in **Use XXX as default coordinate units**
• Check the associated checkbox if it is not toggle on.

### 10.2.9.5 Amira components working with the unit management

Unit management is not yet available for all the components of Amira. The components (data types, files formats, modules) for which the unit management has been implemented are listed here.

**Data types**

When unit management is activated in the product, it is possible to assign coordinate units and potentially make units conversion on coordinate values for all data objects for which the type is listed in table 10.1 below.

For all other data types, coordinate values can’t be converted so these are always stored internally using original values. In this case, the coordinate units are set to the working coordinate units.

**Note:**

Data fields (Hexa*Field, Tetra*Field, Reg*Field and Surface*Field) have coordinate units but they are assumed to always be the same as the one specified on the associated data (HexaGrid, TetraGrid, Lattice, Surface). Consequently, it’s not possible to explicitly specify the coordinate units of such field data thanks to the **Units Editor**. However, setting or modifying the coordinate units of a data field will automatically update the coordinate units of all attached fields.

**Files formats**

Some file formats can provide information about the coordinate units of stored data. The following table lists all the file formats for which Amira readers and writers have been updated to be able to retrieve/save coordinate unit information when reading/writing a file:

<table>
<thead>
<tr>
<th>File format</th>
<th>Coordinate units retrieved by reader</th>
<th>Coordinate units saved by writer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amira data</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Surface</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>CATIA5</td>
<td>Y</td>
<td>N/A (no CATIA5 writer available)</td>
</tr>
<tr>
<td>IGES</td>
<td>Y</td>
<td>N/A (no IGES writer available)</td>
</tr>
<tr>
<td>STEP</td>
<td>Y</td>
<td>N/A (no STEP writer available)</td>
</tr>
</tbody>
</table>

For all other file formats, Amira readers and writers currently don’t retrieve/save any coordinate unit information when reading/writing a file.
<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hexa Grid</strong></td>
<td>Unstructured finite-element hexahedral grid and associated fields</td>
</tr>
<tr>
<td>. HexaField3</td>
<td></td>
</tr>
<tr>
<td>. HexaScalarField3</td>
<td></td>
</tr>
<tr>
<td>. HexaVectorField3</td>
<td></td>
</tr>
<tr>
<td>. HexaComplexScalarField3</td>
<td></td>
</tr>
<tr>
<td>. HexaComplexVectorField3</td>
<td></td>
</tr>
<tr>
<td><strong>Tetra Grid</strong></td>
<td>Unstructured finite-element tetrahedral grid and associated fields</td>
</tr>
<tr>
<td>. TetraField3</td>
<td></td>
</tr>
<tr>
<td>. TetraScalarField3</td>
<td></td>
</tr>
<tr>
<td>. TetraVectorField3</td>
<td></td>
</tr>
<tr>
<td>. TetraComplexScalarField3</td>
<td></td>
</tr>
<tr>
<td>. TetraComplexVectorField3</td>
<td></td>
</tr>
<tr>
<td><strong>Lattice, LabelLattice3</strong></td>
<td>Regular 3D data array and associated fields</td>
</tr>
<tr>
<td>. RegField3</td>
<td></td>
</tr>
<tr>
<td>. RegScalarField3</td>
<td></td>
</tr>
<tr>
<td>. RegVectorField3</td>
<td></td>
</tr>
<tr>
<td>. RegSym2TensorField3</td>
<td></td>
</tr>
<tr>
<td>. RegComplexScalarField3</td>
<td></td>
</tr>
<tr>
<td>. RegComplexVectorField3</td>
<td></td>
</tr>
<tr>
<td>. RegColorField3</td>
<td></td>
</tr>
<tr>
<td><strong>Surface</strong></td>
<td>Surface data and associated fields</td>
</tr>
<tr>
<td>. SurfaceField</td>
<td></td>
</tr>
<tr>
<td>. SurfaceScalarField</td>
<td></td>
</tr>
<tr>
<td>. SurfaceVectorField</td>
<td></td>
</tr>
<tr>
<td>. SurfaceComplexScalarField</td>
<td></td>
</tr>
<tr>
<td>. SurfaceComplexVectorField</td>
<td></td>
</tr>
<tr>
<td><strong>Iv Data</strong></td>
<td>Open Inventor scene graph</td>
</tr>
</tbody>
</table>

Table 10.1: Data Types List
However, for all file formats that generate data of which type supports the unit management (refer to the Data Types section), it’s possible to associate coordinate units to loaded data via the Units Editor. Refer to the How to associate coordinate units with a spatial data object section for more information about how to set and save a coordinate unit information.

Modules

The following modules have been modified to support unit management in case it has been activated:

<table>
<thead>
<tr>
<th>Module</th>
<th>Unit management support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Axes</td>
<td>axis tick values and labels</td>
</tr>
<tr>
<td>Bounding Box</td>
<td>coordinates of the lower left front and upper right back corners of the box</td>
</tr>
<tr>
<td>ROI Box</td>
<td>minimum and maximum port values</td>
</tr>
<tr>
<td>Spline Probe</td>
<td>point coordinates, length value and plot window</td>
</tr>
<tr>
<td>Line Probe</td>
<td>point coordinates, length value and plot window</td>
</tr>
<tr>
<td>Measurement</td>
<td>length and angle values</td>
</tr>
<tr>
<td>Scalebars</td>
<td>axis tick values and labels</td>
</tr>
</tbody>
</table>

10.2.10 Automatic Display in Amira

This section describes the way to configure and to use the Automatic Display feature in Amira. The aim of this feature is to automatically connect a display module when a new data is added in Amira. For example, you can specify that an Ortho Slice is automatically connected to all new images and a Surface View to all new surfaces.

10.2.10.1 Manage and configure Automatic Display in Preferences

Several options linked with automatic display are available and allow you to customize the way you are using it in Amira. These options are the following:

- Activate/deactivate the automatic display in Amira
- Select the behavior of automatic display for loaded data and computed ones
- Choose the associations between data type and display module associated with

To reach the automatic display preferences:

- Launch the Preferences dialog (menu Edit > Preferences...)
- Select the Auto-Display tab

The contents of this preference tab looks like the following figure:

Activate/deactivate the automatic display in Amira
The first available option is a global one that allows you to enable (if you check the box) or disable (if you uncheck the box) the automatic display mechanism in Amira.

**Select the functional mode for automatic display mechanism**

Three functional modes are available allowing you to adapt the automatic display behavior to your working habits.

You can activate automatic display to:

- All data added to the project view, i.e., the loaded ones and the computed ones
- Loaded data only, i.e., computed data will never be automatically connected to a display module
First loaded data only, i.e., only the first data loaded after the Amira opening will be connected automatically to a display module

Association management

The last section of the Automatic Display preference tab is the associations between data types and display modules to auto-connect with. Currently, the four main data types used in Amira are available:

- Image
- Label Image
- Surface
- Other, i.e., all spatial data different from images, label images or surfaces.

To modify the predefined associations, you can click on the associated module to drop down a menu as follows:

This menu lets you choose between four options:

- A custom module: This user defined module is selected by the Change Custom... entry.
- A recommended module: This module is selected by default. It has been chosen as the answer to the most frequently usages and because of its low computation time.
- Nothing: This option allows you to use the automatic display, but not with all data type.
- A way to change the custom choice: Click on this menu entry to open the object explorer allowing you to change the custom choice.

10.2.10.2 Activate/Deactivate Automatic Display in the Project View

An easy way to enable/disable the automatic display mechanism is also available in the Project View. It consists in a toggle button with two states. If the button is down, automatic connection is enabled, disabled otherwise.
10.2.11 Workroom Concept

Beside visualization modules, the user interface enable an easier and faster swap between application areas. With the user-friendly "workroom" concept, several dedicated components are accessible as independent applications assembled together into the general Amira platform. Each component provides its own specific interface, its dedicated tools and visualization options. Since switching between different components takes place through a simple toolbar, the user can explore and approach complex data sets using dedicated tools in the workrooms, and keep a clear overview in the general purpose framework. To access a workroom, a toolbar bar is available in the upper part of the main window.

The following components are currently workrooms:

- **Start Page**: Start a project, load data, learn about Amira.
- **Project View**: Open data, connect modules, open and save projects. Pressing "Home" key directly opens this workroom.
- **Segmentation Editor**: Interactively segment 3D image data.
- **Filament Editor**: Automatically and interactively extract, analyze, and quantify filamentous structures in 3D image data (see tutorial: Filament Editor).
- **Multiplanar Viewer**: Visualize, explore, and register pairs of image data sets.
- **Animation Director**: Create animations from the current project and record a movie file (see tutorial: The Animation Director).
- **Recipes**: Recipes creation, customizable workflow automation.
Chapter 11

Automating, Customizing, Extending

11.1 Template Projects

This section describes the usage of Template Projects

11.1.1 Template Projects Description

Template projects can be used to ease repetitive tasks on sets of similar data. A template project is a copy of an original project that can be re-applied on other data of the same type.

11.1.1.1 How to save a template project

To create a template project, choose Save Project As Template from the File menu. An input selection dialog appears and lists all the possible template inputs (all the current data objects). A template input stands for a data set that must be supplied when the template is executed. You can change the label for each selected template input. This label should be general and meaningful since it will be displayed during template execution. The default label is the original data object name. Note: Unused data objects are filtered by default, but you can include them in the template project by selecting the Include unused data option.

If the template contains exactly one input, a dialog will ask if you wish to associate the template with data of this type. If you click OK, then the template will be available in the right-click menu (Templates submenu) for all data objects of the same data type.

Finally, a file dialog will appear to name the output file. The file name is also the name of the template, i.e., the name that will appear in the Templates menu. Built-in template projects are stored in the folder share/templates, but you may not have sufficient privileges to create new files in that directory.
You can save custom templates in any directory. They will be automatically reloaded on each Amira start-up.

11.1.1.2 How to use a template project

Built-in template projects and known custom user template projects are loaded automatically on Amira start-up. Loading a template does not mean instantiating the template project. Template projects are only created on user demand, for example, using the Project > Create Object... menu. One exception: if user loads a template file via the Open Data dialog, the template resource is loaded, and then executed. If the template is associated with a data type, you can create an instance using the right-click menu for a data object of that type. In this case, the template will be immediately created using the selected data object.

For other templates, you can create an instance from the Templates submenu of the Project > Create Object... menu. The template may also appear in the macro buttons list. If this case, the following
dialog appears on template execution:

![Template Project Run Dialog](image)

Figure 11.3: The template project run dialog.

Each template input is shown with its template input name and a combo box to select the data set to be used for that input. The candidates listed in each combo box are filtered according to their data type. You can disable this filter and display all data present in the Project View by unselecting the *Check input type* option. If there are no appropriate data objects, the combo box will be empty. You can always select the "*<load file...>*" item to display a file open dialog and choose a data file.

A special treatment for colormaps: by default, colormaps that are already in the Project View are re-used as is. This means, for instance, that objects in the template project may be affected by range changes. You can also choose not to share colormaps with existing objects by selecting the *Independent colormaps* option.

### 11.2 Recipes

Amira allows for the creation of user-defined *recipes* for automating a complex scenario, making use of multiple tools, and workspaces. These recipes define high-level workflows, such as extracting user-defined statistics from an image. For more information, refer to Chapter 5 Creating recipes to automate workflow execution.

### 11.3 Amira Start-Up

This section describes some options available for Amira start-up:
11.3.1 Command Line Options

This section describes the command line options understood by Amira. In general, on Unix systems, Amira is started via the start script located in the subdirectory bin. Usually, this script will be linked to /usr/local/bin/Amira or something similar. Alternatively, the user may define an alias Amira pointing to bin/start.

On Windows systems, Amira is usually started via the start menu or via a desktop icon. Nevertheless, the Amira executable may also be invoked directly by calling bin/arch-Win64VC12-Optimize/Amira.exe. In this case, the same command line options as on a Unix system are understood.

The syntax of Amira is as follows:

Amira [options] [files ...]

Data files specified in the command line will be loaded automatically. In addition to data files, script files can also be specified. These scripts will be executed when the program starts.

The following options are supported:

- -help
  Prints a short summary of command line options.

- -version
  Prints the version string of Amira.

- -no_stencils
  Tells Amira not to ask for a stencil buffer in its 3D graphics windows. This option can be set to exploit hardware acceleration on some low-end PC graphics boards.

- -no_overlays
  Tells Amira not to use overlay planes in its 3D graphics windows. Use this option if you experience problems when redirecting Amira on a remote display.

- -no_gui
  Starts up Amira without opening any windows. This option is useful for executing a script in batch mode.

- -logfile filename
  Causes any messages printed in the console window also to be written into the specified log file. Useful especially in conjunction with the -no_gui option.

- -depth number
  This option is only supported on Linux systems. It specifies the preferred depth of the depth buffer. The default on Linux systems is 16-bit.
-style={windows | motif | cde}
This option sets the display style of Amira’s Qt user interface.

-debug
This option applies to the developer version only. It causes local packages to be executed in debug version. By default, optimized code will be used.

-cmd command [-host hostname] [-port port]
Send Tcl command to a running Amira application. Optionally the host name and the port number can be specified. You must type app -listen in the console window of Amira before commands can be received.

-clusterdaemon
Start as VR daemon, on a cluster slave node (Amira XScreen Extension). This may be replaced by a service. See the online documentation for more information.

-tclcmd command
Executes the Tcl command in the starting application.

11.3.2 Environment Variables

No special environment settings are required in order to execute Amira. On Unix systems, some environment variables like the shared library path or the AMIRA_ROOT directory are set automatically by the Amira start script. Other environment variables may be set by the user in order to control certain features. These variables are listed below. On Unix systems, environment variables can be set using the shell commands setenv (csh or tcsh) or export (sh, bash, or ksh). On Windows, environment variables can be defined in the system properties dialog (Microsoft Windows).

- AMIRA_DATADIR
  A data directory path. This directory will be used as the default directory of the file dialog. Note that for quick access to several directories, one can use operating system, for instance, by adding directories to the list of Favorites places in the file dialog or by using a directory containing shortcuts or links to other directories.

- AMIRA_TEXMEM
  Specifies the amount of texture memory in megabytes. If this variable is not set, some heuristics are applied to determine the amount of texture memory available on a system. However, these heuristics may not always yield a correct value. In such cases, the performance of the Volume Rendering module might be improved using this variable.

- AMIRA_MULTISAMPLE
  On high-end graphics systems, a multi-sample visual is used by default. In this way, efficient scene anti-aliasing is achieved. If you want to disable this feature, set the environment variable AMIRA_MULTISAMPLE to 0. Note that on other systems, especially on PCs, anti-aliasing cannot be controlled by the application but has to be activated directly in the graphics driver.

- AMIRA_NO_LICENSE_MESSAGE
  By default, Amira issues warning messages to the console when your Amira license is about
to expire. This allows you to take timely action so that your use of Amira is not interrupted unexpectedly when the license expires. To disable these messages, set this variable to 1.

- **AMIRA_NO_OVERLAYS**
  If this variable is set, Amira will not use overlay planes in its 3D graphics windows. The same effect can be obtained by means of the `-no_overlays` command line option. Turn off overlays if you experience problems with redirecting Amira on a remote display, or if your X server does not support overlay visuals.

- **AMIRA_NO_SPLASHSCREEN**
  If this variable is set, Amira will not display a splash screen while it is initializing.

- **AMIRA_LOCAL**
  Specifies the location of the local Amira directory containing user-defined modules. IO routines or modules defined in this directory replace the ones defined in the main Amira directory. This environment variable overwrites the local Amira directory set in the development wizard (see Amira programmer’s guide for details).

- **AMIRA_SMALLFONT**
  Unix systems only. If this variable is set, a small font will be used in all ports being displayed in the Properties Area even if the screen resolution is 1280x1024 or bigger. By default, the small font will be used only in case of smaller resolutions.

- **AMIRA_XSHM**
  Unix systems only. Set this variable to 0 if you want to suppress the use of the X shared memory extension in Amira’s Segmentation Editor.

- **AMIRA_SPACEMOUSE** (deprecated)
  This feature is deprecated.
  Spacemouse support is available by default if Amira finds a connected device (see [http://www.3dconnexion.com](http://www.3dconnexion.com)). If the driver is installed, a message is printed in the console window. With the spacemouse, you can navigate in the 3D viewer window. Two modes are supported, a rotate mode and a fly mode. You can switch between the two modes by pressing the spacemouse buttons 1 or 2. Further configuration options might be available in the Amira.init file.

  **3Dconnexion Spacemouse limitations:**
  
  - Spacemouse support is not available on Mac OS X.
  - Spacemouse is recognized by Amira applications.
  - *Six degrees of freedom* motion is not fully supported yet.
  - Spacemouse can only control the first viewer.
  - It is not possible to translate the camera or move up and down in rotate mode.
  - It is not possible to rotate around the object or move up and down in fly mode.
  - By default, button 1 is used to open the ”menu” and it must be reconfigured to ”Button 1” function. Press this button to set rotate mode.
  - By default, button 2 is not set to ”Button 2” function. Press this button to set fly mode.
• **AMIRA_STEREO_ON_DEFAULT**
  If this variable is set, the 3D viewer will be opened in OpenGL raw stereo mode by default. In this way, some screen flicker can be avoided which otherwise occurs when switching from mono to stereo mode. Currently, the variable is supported on Unix systems only.

• **TMPDIR**
  This variable specifies in which directory temporary data should be stored. If not set, such data will be created under /tmp. Among others, this variable is interpreted by Amira’s job queue.

### 11.3.3 User-defined start-up script

Amira may be customized in certain ways by providing a user-defined start-up script. The default start-up script, called `Amira.init`, is located in the subdirectory `share/resources/Amira` of the Amira installation directory. This script is read each time the program is started. Among other things, the start-up script is responsible for registering file formats, modules, and editors and for loading the default colormaps.

If a file called `Amira.init` is found in the current working directory, this file is read instead of the default start-up script. If no such file is found, on Unix systems it is checked if there exists a start-up script called `.Amira` in the user’s home directory. Below an example of a user-defined start-up script is shown:

```bash
# Execute the default start-up script
source $AMIRA_ROOT/share/resources/Amira/Amira.init 0

# Set up a uniform black background
viewer 0 setBackgroundMode 0
viewer 0 setBackgroundColor black

# Choose non-default font size for the help browser
help setFontSize 12

# Restore camera setting by hitting [F3] key
proc onKeyF3 {} {
    viewer setCameraOrientation 1 0 0 3.14159
    viewer setCameraPosition 0 0 -2.50585
    viewer setCameraFocalDistance 2.50585
}
```

In this example, the system’s default start-up script is executed first. This ensures that all Amira objects are registered properly. Then some special settings are made. Finally, a hot-key procedure is defined for the function key [F3]. You can define such a procedure for any other function key as well. In addition, procedures like `onKeyShiftF3` or `onKeyCtrlF3` can be defined. These procedures are
executed when a function key is pressed with the [SHIFT] or the [CTRL] modifier key being pressed down.

11.4  Image Stack Processing Recipes

The Image Stack Processing module allows the creation and execution of image processing recipes in a 2D workroom. Refer to *Image Stack Processing* chapter for more information.

11.5  TCL Scripting

This section describes how to use *TCL Scripting* in Amira.

11.5.1  Scripting Introduction

This chapter is intended for advanced Amira users only. If you do not know what scripting is, it is very likely that you will not need the features described in this chapter.

Beside the interactive control via the graphical user interface, most of the Amira functionality can also be accessed using specific commands. This allows you to automate certain processes and to create scripts for managing routine tasks or for presenting demos. Amira’s scripting commands are based on Tcl, the *Tool Command Language*. This means you can write command scripts using Tcl with Amira-specific extensions.

Amira commands can be typed into the Amira console window, as described in Section 10.1.13. Commands typed directly into the console window will be executed immediately. Alternatively, commands can be written into a text file, which can then be executed as a whole.

This chapter is organized as follows:
Section 11.5.2 (Introduction to Tcl) gives a short introduction to the Tcl scripting language. This section is not very Amira specific.

Section 11.5.3 (Amira Script Interface) explains Amira-specific commands and concepts related to scripting. This includes a *reference of global commands*.

Section 11.5.5 (Amira Script Files) explains the different ways of writing and executing script files including references to script objects, resource files, and function-key bound Tcl procedures.

Section 11.5.6 (Configuring Popup Menus) describes how the popup menu of an object can be configured using script commands, and how new entries causing a script to be executed can be created.

Section 11.5.7 (Registering pick callbacks) describes how script callbacks can be attached to objects or viewers and be invoked on user pick events.

Section 11.5.8 (File readers in Tcl) describes how to register a custom file reader implemented in Tcl.
Section 11.5.9 (Creating recipe-compliant script-object) describes how to create a script-object that can be used to create recipe.

Section 11.5.10 (Versioning of Script Objects and backward compatibility) describes backward compatibility considerations and lists all modules with deprecated ports.

### 11.5.2 Introduction to Tcl

This chapter gives a brief introduction to the Tcl scripting language. If you are familiar with Tcl you can skip this section. However, please notice that instead of the `puts` command, you should use `echo` for output to the Amira console.

This chapter is not intended to cover all details of the language. For a complete documentation or reference manual of the Tcl language, refer to a text book like *Tcl and the Tk Toolkit* by John K. Ousterhout, the creator of Tcl. Like many other books about Tcl, this also covers the Tk GUI toolkit. Note that Tk is not used in Amira.

Alternatively, you can easily find Tcl documentation and reference manuals on the internet, e.g., at [http://www.scriptics.com](http://www.scriptics.com), or looking up keywords like `Tcl tutorial` or `Tcl documentation` with a search engine.

When you type Tcl commands into the Amira console, they will be executed as soon as the return key is pressed. Use the completion and history functions provided by the Amira console, as described in Section 10.1.13 (console window).

#### 11.5.2.1 Tcl Lists, Commands, Comments

First, please note that Tcl is case sensitive: `set` and `Set` are not the same.

A Tcl command is a space-separated list of words. The first word represents the command name, all further words are treated as arguments to that command. As an example, try the Amira-specific command `echo`, which will print all its arguments to the Amira console. Try typing

```tcl
echo Hello World
```

This will output the string *Hello World*. Note that Tcl commands can be separated by a semi-colon (;) or a newline character. If you want to execute two successive `echo` commands, you can do it this way:

```tcl
echo Hello World ; echo Hello World2
```

or like this:

```tcl
echo Hello World
echo Hello World2
```
Instead of a command, you can also place a comment in Tcl code. A comment starts with a hash character (#) and is ended by the next line break:

```
# this is a comment
echo Hello World
```

### 11.5.2.2 Tcl Variables

Variables can be used in Tcl. A variable represents a certain state or value. Using Tcl code, the value of the placeholder can be queried, defined, and modified. To define a variable use the command

```
set name value
```
e.g.,
```
set i 1
set myVar foobar
```

Note that in Tcl, internally all variables are of string type. Since the set command requires exactly one argument as the variable value, you have to quote values that contain spaces:
```
set Output "Hello World"
```
or
```
set Output {Hello World}
```

In order to substitute the value of a variable with name `varname`, a $ sign has to be put in front of that name. The expression $varname will be replaced by the value of the variable. After the above definitions,
```
echo $Output
```
would print
```
Hello World
```
in the console window, and
```
echo "$i.) $Output"
```
would yield the output 1.) Hello World. Note that variable substitution is performed for strings quoted in "", while it is not done for strings enclosed in braces {}. Even newline characters are allowed in a { } enclosed string. Note however, that it is not possible to type in multi-line commands into the Amira console.
11.5.2.3 Tcl Command Substitution

To do mathematical computations in Tcl, you can use the command `expr` which will evaluate its arguments and return the value of the expression. Examples are:

```tcl
eval expr 5 / ( 7 + 3)
eval expr $i + 1
```

In order to use the result of a command like `expr` for further commands, an important Tcl mechanism has to be used: command substitution, denoted by brackets `[ ]`. Any list enclosed in brackets `[ ]` will be executed as a separate command first, and the `[ ... ]` construct will be replaced with the result of the command. This is similar to the `...'` construct in Unix command shells. For example, in order to increase the value of the variable `i` by one you can use:

```tcl
set i [expr $i + 1]
```

Of course, command expressions can be arbitrarily nested. The order of execution is always from the innermost bracket pair to the outermost one:

```tcl
echo [expr 5 * [expr 7 + [expr 3+3]]]
```

11.5.2.4 Tcl Control Structures

Further important language elements are `if-else` constructs, `for` loops and `while` loops. These constructs typically are multi-line constructs and therefore can not be typed conveniently into the Amira console. If you want to try the examples shown below, write them into a file like `C:\test.txt` by using a text editor of your choice, and execute the file by typing

```tcl
source C:\test.txt
```

We start with the `if-then` mechanism. It is used to execute some code conditionally, only if a certain expression evaluates to "true" (meaning a value different from 0):

```tcl
set a 7
set b 8
if {($a < $b)} {
    echo "$a is smaller than $b"
} elseif {($a == $b)} {
    echo "$a equals $b"
} else {
    echo "$a is greater than $b"
}
```
The `elseif` and `else` parts are optional. Multiple `elseif` parts can be used, but only a single `if` and `else` part.

Another important construct is the conditional loop. Like the `if` command, it is based on checking a conditional expression. In contrast to `if`, the conditional code is executed multiple times, as long as the expression evaluates to true:

```tcl
for {set i 1} {$i < 100} {set i [expr $i*2]} {
    echo $i
}
```

In fact this code is identical to:

```tcl
set i 1
while {$i < 100} {
    echo $i
    set i [expr $i * 2]
}
```

Both loops would produce the output `1, 2, 4, 8, 16, 32, 64`.

If you want to execute a loop for all elements of a list, there is another very convenient command for that:

```tcl
foreach x {1 2 4 8 16 32 64} {
    echo $x
}
```

This will generate the same output as the previous example. Note that the expression enclosed in braces is a space-separated list of words.

### 11.5.2.5 User-Defined Tcl Procedures

A new function or procedure is defined in Tcl using the `proc` command. Proc takes two arguments: a list of argument names and the Tcl code to be executed. Once a procedure is defined, it can be used just like any other Tcl command:

```tcl
proc computeAverageA {a b} {
    return [expr ($a+$b)/2.0]
}
proc computeAverageB {a b c} {
    return [expr ($a+$b+$c)/3.0]
}
echo "average of 2 and 3: [computeAverageA 2 3]"
echo "average of 2,3,4: [computeAverageB 2 3 4]"
```
As you can see in the example, the argument list defines the names for local variables that can be used in the body of the procedure (e.g. $a$). The return command is used to define the result of the procedure. This result is the value that is used in the command bracket substitution [].

If you want to define a procedure with a flexible number of arguments, you must use the special argument name args. If the argument list contains just this word, the newly defined command will accept an arbitrary number of arguments, and these arguments are passed as a list called args:

```tcl
proc computeAverage args {
    set result 0
    foreach x $args {
        set result [expr $result + $x]
    }
    return [expr $result / [llength $args]]
}
```

In this example, the llength command returns the number of elements contained in the args list.

Note that the variable result defined in the procedure has local scope, meaning that it will not be known outside the body of the procedure. Also, the value of globally defined variables is not known within a procedure unless that global variable is declared using the keyword global:

```tcl
set x 3
proc printX {} {
    global x
    echo "the value of x is $x"
}
```

There is much more to be said about procedures, e.g., concerning argument passing, evaluation of commands in the context outside of the procedure, and so on. Please refer to a Tcl reference book for these advanced topics.

### 11.5.2.6 List and String Manipulation

Finally, at the end of this brief Tcl introduction, we come back to the concept of lists. Basically everything in Tcl is constructed using lists, so it is very important to know the most important list manipulation commands as well as to understand some subtle details.

Here is an example of how to take an input list of numbers and construct an output list in which each element is twice as big as the corresponding element in the input list:

```tcl
set input [list 1 2 3 4 5]
set output [list]
```
foreach element $input {
    lappend output [expr $element * 2]
}

You can think of lists as simple strings in which the list elements are separated by spaces. This means that you can achieve the same result as in the previous example without using the list commands:

```
set input "1 2 3 4 5"
set output ""
foreach element $input {
    append output "[expr $element * 2] "
}
```

The *append* command is similar to *lappend*, but it just adds a string at the end of an existing string. List manipulation becomes much more involved when you start nesting lists. Nested lists are represented using nested pairs of braces, e.g.

```
set input {1 2 {3 4 5 {6 7} 8 } 9}
foreach x $input {
    echo $x
}
```

The result of this command will be

```
1
2
3 4 5 {6 7} 8
9
```

Please note that Tcl will automatically *quote* strings that are not single words when constructing a list. Here is an example:

```
set i [list 1 2 3]
lappend i "4 5 6"
echo $i
```

will yield the output

```
1 2 3 {4 5 6}
```

You can use the *lindex* command to access a single element of a list. *lindex* takes two arguments: the list and the index number of the desired element, starting with 0:
set i [list a b c d e]
echo [lindex $i 2]

will yield the result c.

11.5.3 Amira Script Interface

Although the Tcl language is not intrinsically object oriented, the Amira script interface is. There is one command for each object in the Amira Project View. In addition there are several global commands associated with global objects in Amira such as the viewer or the Amira main window.

A command associated with an object in the Project View (e.g., an "Ortho Slice" module or an "Isosurface" module) only exists while the object exists. These commands are identical to the name of the object as displayed in the Project View. Typically the script interface of a specific object contains many different functions. The general syntax for an Amira object-related command is

<object-name> <command-word> <optional-arguments> ...

For example, if an object called "Global Axes" exists (choose View/Axis from the Amira menu) then you can use commands like

"GlobalAxes" deselect
"GlobalAxes" select
"GlobalAxes" setIconPosition 100 100

Note: Modules are renamed in camel case. These three words are possible in commands: "Global Axes", "GlobalAxes" or GlobalAxes.

Remember to use the completion and history functions provided by the Amira console, as described in Section 10.1.13 (console window) to save typing.

If you have already used Amira, you have noticed that the parameters and the behavior of an Amira module are controlled via its ports. The ports provide a user interface to change their values when the module is selected. All ports can also be controlled via the command interface. The general syntax for that is

<object-name> <port-name> <port-command> <optional-arguments> ...

For example, for the "Global Axes" you can type

"GlobalAxes" options setValue 1 1
"GlobalAxes" thickness setValue 1.5
"GlobalAxes" fire
When you type in these commands, you will notice that the values in the user interface change immediately. However, the module’s compute method is not called until explicitly firing the module using the `fire` command. This allows you to first set values for multiple ports without a recomputation after each command. However, note that some modules automatically reset some of their ports, for example, when a new input object is connected. In such cases, you may need to call `fire` after setting the value of every single port.

Usually the name of a port is identical to the text label displayed in the graphical user interface, except that white spaces are removed and command names start with a lower case letter. To find out the names of all ports of a specific module, use the command

```
<object-name> allPorts
```

Almost all ports provide a `setValue` and a `getValue` command. The number of parameters and the syntax, of course, depend on the ports.

Commands of the type `<object-name> <port-name> setValue ...` make up more than 90% of a typical Amira script. However, besides the port commands, many Amira objects provide additional specific commands. The command interface for a particular tool can be quickly accessed by clicking the corresponding ? button in the Properties Area when the module has been selected.

As a quick help, entering an object’s name without further options will display all commands available for that object. Note that this will also show undocumented, unreleased, and experimental commands. In order to get more information about a particular module or port command, you can type it into the console window without any arguments and then press the F1 key. This opens the help browser with a command description.

Amira objects are part of a class hierarchy. Similar to the C++ programming interface, script commands are also inherited by derived classes from its base classes. This means that a particular object like the axis object will, beside its own specific commands, also provide all the commands available in its base classes. Links to the base class commands are given in a module’s documentation.

### 11.5.3.1 Predefined Variables

Some variables in Amira Tcl exist that are predefined and have a special meaning. These are

- **AMIRA_ROOT**: Amira installation directory.
- **AMIRA_LOCAL**: Personal Amira development directory (Amira XPand Extension only).
- **SCRIPTFILE**: Tcl script file currently executed.
- **SCRIPTDIR**: Directory in which currently executed script resides.
- **hideNewModules**: If set to 1, icons of newly created modules will initially be hidden. Be careful to set this variable only when strictly necessary and restore it immediately after, in order to avoid to keep hiding accidentally created modules, for instance, in case of script interruption.
11.5.3.2 Object commands

The basic command interface of Amira modules and data objects is described in the data type chapter of the reference part of the user’s guide in the Object section. The basic syntax of object commands is

\[
<\text{object}> \ <\text{command}> \ <\text{arguments}> \ ...
\]

where \(<\text{object}>\) refers to the name of the object and \(<\text{command}>\) denotes the command to be executed. Each module or data object may define its own set of commands in addition to the commands defined by its base classes. The commands described in the Object section are provided by all modules and data objects.

Global commands are described in the following section.

11.5.3.3 Performance enhancement

Performance issues can occur in a script which creates/applies modules many times. This may be due to the History Logging, used to create Recipes from moduleresults.

To improve performance in such script, the History Logging can be deactivated (resp. activated) using \(\text{startLogInhibitor}\) (resp. \(\text{stopLogInhibitor}\)) command. In this case, it won’t be possible to create recipe from the script result. See Creating recipe-compliant script-object section for more information.

11.5.4 Global Commands

This section lists Amira-specific global Tcl commands. Some of these commands are associated with certain global objects in Amira, such as the console window, the main window, or the viewer window. Other commands such as \text{load} or \text{echo} are not. These commands are described in one common subsection. In summary, the following command sections are provided:

- viewer command options (viewer)
- main window command options (theMain)
- console command options (theMsg)
- common commands for top-level windows
- progress bar command options (workArea)
- application command options (app)
- other global commands

11.5.4.1 Viewer command options

Commands to a viewer can be entered in the console window. The syntax is
viewer [<number>] command,

where <number> specifies the viewer being addressed. The value 0 refers to the main viewer and may be omitted for convenience.

**Commands**


This command takes a snapshot of the current scene and saves it under the specific filename. The image format will be automatically determined by the extension of the file name. The list of available formats includes: TIFF (.tif,.tiff), SGI-RGB (.rgb,.sgi,.bw), JPEG (.jpg,.jpeg), PNM (.pgm,.ppm), BMP (.bmp), PNG (.png), and Encapsulated PostScript (.eps). If the viewer number is not given, the snapshot is taken from all viewers, if you have selected the 2 or 4 viewer layout from the View menu.

If the -offscreen option is specified, offscreen rendering with a maximum size of 2048x2048 is used. In this case, the viewer number is required even if viewer 0 is addressed. If the width and height is not specified explicitly, the size of the image is the current size of the viewer.

**Caution:** If you have more than one transparent object visible in the viewer and you want to use offscreen rendering, set the transparency mode to Blend Delayed and check to see if all objects are rendered properly prior to taking a snapshot.

If -stereo option is used, the stereo mode image is created. In this case, filename2 file can be used to specify where the second image of the stereo image is stored.

If -alpha option is used, the snapshot image is created with transparent background.

If -tiled nx ny option is used, tiled rendering is used with nx number of tiles in horizontal direction, and ny number of tiles in vertical direction.

viewer [<number>] setPosition <x> <y>

(in top-level mode only) Sets the position of the viewer window relative to the upper left corner of the screen. If more than one viewer is shown in the same window, the position of the toplevel window is set.

viewer [<number>] getPosition

Returns the position of the viewer window. If more than one viewer is shown in the same window, the position of the toplevel window is returned.

viewer [<number>] setSize <width> <height>

(in top-level mode only) Sets the size of the viewer window. Width and height specify the size of the actual graphics area. The window size might be a little bit larger because of the viewer decoration and the window frame.

**Caution:** A warning message is printed in the console when a viewer is not resized with the requested size. When setting a new size to a viewer, it can happen that the new viewer size is not the requested one. This case can happen when:
• the viewer is in top level and the given size is too small (ex: (10, 10))
• the viewer is not in top level and the main window can’t be resized to a smaller size (Example: a widget is blocking the main window resize like the unified title and tool bar on Mac or a dock widget with a minimal width).

viewer [<number>] getSize
Returns the size of the viewer window without decoration and window frame.

viewer [<number>] setCamera <camera-string>
Restores all camera settings. The camera string should be the output of a getCamera command.

viewer [<number>] getCamera
This command returns the current camera settings, i.e., position, orientation, focal distance, type, and height angle (for perspective cameras) or height (for orthographic cameras). The values are returned as Amira commands, which can be executed in order to restore the camera settings. The complete command string may also be passed to setCamera at once.

viewer [<number>] setCameraPosition <x> <y> <z>
Defines the position of the camera in world coordinates.

viewer [<number>] getCameraPosition <x> <y> <z>
Returns the position of the camera in world coordinates.

viewer [<number>] setCameraNearDistance <value>
Defines the distance from the camera viewpoint to the near clipping plane.

viewer [<number>] setCameraFarDistance <value>
Defines the distance from the camera viewpoint to the far clipping plane.

viewer [<number>] setCameraOrientation <x> <y> <z> <a>
Defines the orientation of the camera. By default, the camera looks in negative z-direction with the y-axis pointing upwards. Any other orientation may be specified as a rotation relative to the default direction. The rotation is specified by a rotation axis x y z followed by a rotation angle a (in radians).

viewer [<number>] getCameraOrientation
Returns the current orientation of the camera in the same format used by setCameraOrientation.

viewer [<number>] setCameraFocalDistance <value>
Defines the camera’s focal distance. The focal distance is used to compute the center around which the scene is rotated in interactive viewing mode.

viewer [<number>] getCameraFocalDistance
Returns the current focal distance of the camera.

viewer [<number>] setCameraHeightAngle <degrees>
Sets the height angle of a perspective camera in degrees. Making the angle smaller makes the field
of view smaller, effectively "zooming in", as with a telephoto lens. Unless you specifically want to change the camera field of view, it is normally better to move the camera closer to an object (sometimes called "dolly in") to make the object appear larger. The command has no effect if the current camera is an orthographic one.

viewer [<number>] getCameraHeightAngle
Returns the height angle of a perspective camera.

viewer [<number>] setCameraHeight <height>
Sets the height of the view volume of an orthographic camera. The command has no effect if the camera is an perspective one.

viewer [<number>] getCameraHeight
Returns the height of an orthographic camera.

viewer [<number>] setCameraType <perspective|orthographic>
Sets the camera type.

viewer [<number>] getCameraType
Returns the camera type.

viewer [<number>] setTransparencyType <type>
This command defines the strategy used for rendering transparent objects. The argument type may be a number between 0 and 8, corresponding to the entries Screen Door, Add, Add Delay, Add Sorted, Blend, Blend Delay, Blend Sorted, Sorted Layers and Sorted Layers Delayed as described for the View menu.

Most accurate results are obtained using mode 8. Default is mode 6. In the default mode, some objects may not be recognized correctly as being transparent. In this case, you may switch them off and on again in order to force them to be rendered last. Also, problems may occur if lines are to be rendered on a transparent background. In this case, you may use transparency mode 4 and ensure the correct rendering order manually.

viewer [<number>] getTransparencyType
This command returns the current transparency type as a number, the meaning of this number is the same as in setTransparencyType.

viewer [<number>] setSortedLayersNumPasses <value>
Sets the number of rendering passes used when transparency type is Sorted Layers or Sorted Layers Delayed. Use more passes for more correct transparency. Usually four passes (which is the default value) gives good results.

viewer [<number>] getSortedLayersNumPasses
Returns the number of rendering passes used when transparency type is Sorted Layers or Sorted Layers Delayed.
viewer [<number>] setBackgroundColor <r> <g> <b>
This command sets the color of the background to a specific value. The color may be specified either as a triple of integer RGB values in the range 0...255, as a triple of rational RGB values in the range 0.0...1.0, or simply as plain text, e.g., white, where the list of allowed color names is defined in /usr/lib/X11/rgb.txt.

viewer [<number>] getBackgroundColor
Returns the primary background color as an RGB triple with values between 0 and 1.

viewer [<number>] setBackgroundColor2 <r> <g> <b>
Sets the secondary background color which is used by non-uniform background modes.

viewer [<number>] getBackgroundColor2
Returns the secondary background color as an RGB triple with values between 0 and 1.

viewer setBackgroundMode <mode>
Allows you to specify different background patterns. If mode is set to 0, a uniform background will be displayed. Mode 1 denotes a gradient background. Mode 2 which corresponds to checkerboard pattern has been removed. Finally, mode 3 draws an image previously defined with setBackgroundImage on the background.

viewer getBackgroundMode
Returns the current background mode.

viewer setBackgroundImage <imagefile> [<imagefile2>] [-stereo]
This command allows you to place an arbitrary raster image into the center of the viewer’s background. The image must not be larger than the viewer window itself. Otherwise, it will be clipped. The format of the image file will be detected automatically by looking at the file name extension. All formats mentioned for the snapshot command are supported except for Encapsulated PostScript. If a second image file is specified, this file will be used as the right eye image in case of active stereo rendering. If the options -stereo is specified and only one image file is given, it it assumed that this file contains a left eye view and a right eye view composited side by side. These views then will be separated automatically.

viewer getBackgroundImage
This command returns the file name of the last background image file defined with setBackgroundImage. If a pair of stereo images was specified, two file names are returned. If the option -stereo was used in setBackgroundImage, this option will be returned too.

viewer [<number>] setAutoRedraw <state>
If state is 0, the auto redraw mode is switched off. In this case, the image displayed in the viewer window will not be updated, unless a redraw command is sent. If state is 1, the auto redraw mode is switched on again. In a script, it might be useful to disable the auto redraw mode temporarily.

viewer [<number>] isAutoRedraw
Returns true if auto redraw mode is on.
viewer [<number>] redraw
This command forces the current scene to be redrawn. An explicit *redraw* is only necessary if the auto redraw mode has been disabled.

viewer [<number>] rotate <degrees> [x|y|z|m|u|v]
Rotates the camera around an axis. The axis to be taken is specified by the second argument. The following choices are available:

- **x**: the x-axis (1,0,0)
- **y**: the y-axis (0,1,0)
- **z**: the z-axis (0,0,1)
- **m**: the most vertical axis of x, y, or z
- **u**: the viewer’s up direction
- **v**: the view direction

The last option does the same as the rotate button of the user interface. In most cases the *m* option is most adequate. For backward-compatibility the default is *u*.

viewer [<number>] setDecoration <state>
Deprecated.

viewer [<number>] saveScene [-b] [-r] [-z] <filename>
Saves all of the geometry displayed in a viewer in Open Inventor 3D graphics format. Warning: Since many Amira modules use custom Open Inventor nodes, the scene usually can not be displayed correctly in external programs like *ivview*. The following options are available:

- **-b**: The Open Inventor file is saved in binary format.
- **-r**: The geometry displayed in a viewer but also additional properties are saved in the Open Inventor file.
- **-z**: The Open Inventor file is be saved in compressed format (zip compression is used).

viewer [<number>] viewAll
Resets the camera so that the whole scene becomes visible. This method is called automatically for the first object being displayed in a viewer.

viewer [<number>] show
This command opens the specified viewer and ensures that the viewer window is displayed on top of all other windows on the screen.

viewer [<number>] hide
This command closes the specified viewer.

viewer [<number>] isVisible
This command indicates if the specified viewer is visible.
viewer [<number>] fogRange <min> <max>
Sets a range of attenuation for the fog affect that can be introduced into a viewer scene by the View menu. The default range is $[0, 1]$. Values within this range correspond to distances of scene points from the camera, such that points nearest to the camera have value zero and those farthest away have value one. Restricting the range of attenuation means that attenuation will start at points where the specified minimum is attained and reach its maximum at points where the specified maximum is attained. Maximum attenuation by fog is equivalent to invisibility, thus all points beyond that maximum will appear as background.

viewer [<number>] setVideoFormat pal|ntsc
Sets the size of the viewer window according to PAL 601 or NTSC 601 resolution, i.e., 720x576 pixels or 720x486 pixels. The current setting of the decoration is taken into account.

viewer [<number>] setVideoFrame <state>
If state is 1, a frame is displayed in the overlay plane of the viewer. This frame depicts the area where images recorded to video are safely shown on video players. Sets the viewing state: 0 switches the frame off. Note: Objects displayed in the overlay planes are not saved to file with the snapshot command (see above).

viewer [<number>] getViewerSpinAnimation
Return 1 if viewer spin animation is turned on, otherwise return 0.

viewer [<number>] setViewerSpinAnimation <state>
If state is 1, a viewer spin animation is turned on. Otherwise, passing 0 as state will turn off viewer spin animation. Note: State of the viewer spin animation is saved as preference, so it will remain the same upon restartin Amira.

viewer [<number>] setViewing <state>
Sets the viewing state: 0 switches the viewer to interaction mode, 1 switches it to viewing mode.

viewer [<number>] get Viewing
Indicates the viewing state: 0 for interaction mode and 1 for viewing mode.

viewer [<number>] linkViewer [<ID>...] This command is used for linking viewers. This command works exactly the same as the appropriate GUI action.

viewer [<number>] unlinkViewer [<ID>...] [all] This command is used to unlink linked viewers.

11.5.4.2 Main window command options

The command theMain allows you to access and control the Amira main window. Besides the specific command options listed below, all sub-commands listed in Section 11.5.4.4 (Common commands for top-level windows) can also be used.
Commands

theMain snapshot filename
Creates and saves a snapshot image of the main window. The format of the image file is determined from the file name extension. Any standard image file format supported by Amira can be used, e.g., .jpg, .tif, .png, or .bmp.

theMain setViewerTogglesOnIcons {0|1}
Enables or disables the display of the orange viewer toggles on object icons in the Amira Project View.

theMain ignoreShow [0|1]
Enables or disables the special purpose no show flag. If this flag is set, subsequent mainWindow show commands are ignored. This can be useful to run standard Amira scripts in an Amira XScreen Extension environment. Calling the command without an argument just returns the current value of the flag.

theMain showConsole [0|1]
Enables or disables display of console window in Amira.

11.5.4.3 Console command options

The command theMsg allows you to access and control the Amira console window. Besides the specific command options listed below, all sub-commands listed in Section 11.5.4.4 (Common commands for top-level windows) can also be used.

Commands

theMsg error <message> [btn0-text] [btn1-text] [btn2-text]
Pops up an error dialog with the specified message. The dialog can be configured with up to three different buttons. The command blocks until the user presses a button. The id of the pressed button is returned.

theMsg warning <message> [btn0-text] [btn1-text] [btn2-text]
Pops up a warning dialog with the specified message. The dialog can be configured with up to three different buttons. The command blocks until the user presses a button. The id of the pressed button is returned.

theMsg question <message> [btn0-text] [btn1-text] [btn2-text]
Pops up a question dialog with the specified message. The dialog can be configured with up to three different buttons. The command blocks until the user presses a button. The id of the pressed button is returned.
theMsg overwrite <filename>
Pops up a dialog asking the user if it is ok to overwrite the specified file. If the user clicks Ok, 1 is returned, otherwise 0.

11.5.4.4 Common commands for top-level windows

These commands are available for all Amira objects which open a separate top-level window. In particular, these are the Amira main window (theMain), the console window (theMsg), and the viewer window (viewer 0). For example, you can set or get the position of these windows using the corresponding global command followed by setPosition or getPosition.

Commands

getFrameGeometry
Returns the position and size of the window including the window frame. In total, four numbers are returned. The first two numbers indicate the position of the upper left corner of the window frame relative to the upper left corner of the desktop. The last two numbers indicate the window size in pixels.

getGeometry
Returns the position and size of the window without the window frame. In total, four numbers are returned. The first two numbers indicate the position of the upper left corner of the window relative to the upper left corner of the desktop. The last two numbers indicate the window size in pixels.

getAddress
Returns the position of the upper left corner of the window including the window frame. This is the same as the first two numbers returned by getFrameGeometry.

getRelativeGeometry
Returns the position and size of the window including the window frame in relative coordinates. The size of the desktop is (1,1). The position and size of the window is specified by fractional numbers between 0 and 1.

getSize
Returns the size of the window without the window frame. This is the same as the last two numbers returned by getGeometry.

hide
Hides the window.

setCaption <text>
Sets the window title displayed in the window frame.

setFrameGeometry <x y width height>
Sets the position and size of the window including the window frame. Four numbers need to be specified, the x- and y-positions, the window width and the window height.
setGeometry <x y width height>
Sets the position and size of the window without the window frame. Four numbers need to be specified, the x- and y-positions, the window width and the window height.

setPosition <x y>
Sets the position of the upper left corner of the window frame.

setRelativeGeometry <x y width height>
Sets the position and size of the window including the window frame in relative coordinates. The size of the desktop is (1,1). The position and size of the window is specified by fractional numbers between 0 and 1.

setSize <width height>
Sets the size of the window without the window frame.

show
Makes the window visible in normal state. Also raises the window.

showMinimized
Makes the window visible in iconified state.

showMaximized
Makes the window visible in maximized state.

11.5.4.5 Progress bar command options
The command workArea allows you to access the progress bar located in the lower part of the Amira main window. You can print messages or check if the stop button was pressed.

Commands

workArea setProgressInfo <text>
Sets an info text to be displayed in the progress bar. The text can be used to describe the status during some computation.

workArea setProgressValue <value>
Sets the value of the progress bar. The argument must be a floating point number between 0 and 1. For example, a value of 0.8 indicates that 80% of the current task has been done.

workArea startWorking [<message>]
Activates the stop button. After calling this command, the Amira stop button becomes active. In your script, you can check if the stop button was hit by calling workArea wasInterrupted. When the stop button is active, you can’t interact with any other widget unless you call workArea stopWorking in your script. Therefore, you must not enter this command directly in the console window, but you should only use it in a script file or in a Tcl procedure.
workArea stopWorking
Deactivates the stop button. Call this command when the compute task started with workArea startWorking is done or if the user pressed the stop button. This command also restores the progress info text which was shown before calling startWorking.

workArea wasInterrupted
Checks if the user pressed the stop button. You should only use this command between workArea startWorking and workArea stopWorking. If there are multiple nested compute tasks and the user presses the stop button, all subsequent calls to wasInterrupted return true until the first level is reached.

11.5.4.6 Application command options
The app command provides several options not related to a particular object or component in Amira, but related to Amira itself.

Commands

app version
Returns the current Amira version.

app uname
Returns simplified name of operating system.

app arch
Returns Amira architecture string, e.g., arch-Win32VC8-Optimize, arch-LinuxAMD64-Optimize.

app hostid
Returns host id needed to create an Amira license key.

app listen [port]
Opens a socket to which Tcl commands can be sent. The TCP/IP port can be specified optionally. WARNING: This can create security holes. Do not use this unless behind a firewall and if you know what you are doing. In the Network Preferences, the port can be set and the listening port can be opened or closed.

app close
Closes the Amira Tcl port.

app port
Returns port number of Amira Tcl port. Returns -1 if socket has not been opened.

app send <command> [<host> [<port>]]
Sends a Tcl command to a listening Amira. If no host or port are specified, the Amira instance will send the command to host and port specified in the preferences. See section Network Preferences.
app opengl
Retrieves information about the used OpenGL driver including version number and supported extensions. This is useful information to send to the hotline if reporting rendering problems.

app cluster
Returns the current node status which can be "master" or "slave" if some cluster mode is active or simply "single" if is not the case.

app memTotal [-k | -m | -g]
Returns the physical memory of the system in bytes. Optional switches -k, -m, -g convert the output to kilo-, mega-, or gigabytes, respectively.

app memAvail [-k | -m | -g]
Returns the available memory of the system in bytes. Optional switches -k, -m, -g convert the output to kilo-, mega-, or gigabytes, respectively. Note that depending on the operating system, the output can deviate from that reported by other tools.

app config <key> [<val>]
Provides access to custom configuration settings that are permanently stored. app config <key> returns the current configuration value for <key>. app config <key> <val> sets a new value.

11.5.4.7 Other global commands

Commands

addTimeout msec procedure [arg]
Schedules a Tcl procedure for being called after msec milliseconds. If arg is specified, it will be passed to the procedure. The specified procedure will be called only once. If necessary, you can schedule it again in the time-out procedure. Example: addTimeout 10000 echo {10 seconds are over.}

all [-selected | -visible | -hidden] [type]
Returns a list of all Amira objects currently in the Project View. If type is specified, only objects with that C++ class type (or derived objects) are returned. Search can be limited to selected, visible, or hidden objects, respectively. Example: all -hidden HxColormap.

aminfo [-a outfile|-b outfile] Amira-File
If used with only a file name as argument, this command will open the file which has to be in Amira data format and print header information. If used with the -a or -b option, the outputfile specified as argument outfile will be written in ASCII (-a) or binary (-b) format, respectively. Thus, aminfo can be used to convert binary Amira data into ASCII and vice versa.

clear
Clears console window.
create class name  [instance name]
Creates an instance of an Amira object like a module or data object. Returns the instance name.
Note that data objects are normally not created this way but by loading them from a file. Example:
create HxOrthoSlice MySlice.

dso  options
Controls loading of dynamic libraries (“dynamic shared objects”). The following options are provided:

- addPath path . . . : Adds a path to the list of directories to be searched when loading a
dynamic library.
- verbose 0|1: Switches on and off debug information related to dynamic libraries.
- open <package>: Trys to load the specified dynamic library. It is enough to specify the
package name, e.g., hxfi eld. This name will be automatically converted into the platform
dependent name, e.g., libhxfi eld.so on Linux or hxfi eld.dll on Windows.
- unloadPackage <package>: Unloads (if possible) the specified dynamic library.
- execute <package> <function>: Executes the function defined in the specified dy-
namic library.

echo args
Prints its arguments to the Amira console. Use this rather than the native Tcl command puts which
prints to stdout.

help arguments
Without arguments this opens the Amira help browser.

httpd [port]
Start a built-in httpd server. The http server will deliver any document requested. If a requested
document ends with .hx, Amira will instead of delivering it execute the file as a Tcl script. This
can be used to control Amira from a web browser. WARNING: This command can create security
holes. Do not use this unless behind a firewall and if you know what you are doing.

limit {datasize | stacksize | coredumpsize} size
Change process limits. Available on Unix platforms only. Use "unlimited" as size for no limit. The
size has to be specified in bytes. Alternatively, you can use for example 1000k for 1000 kilobytes
or 1m for one megabyte.

load [fileformat] options files
Load data from one or more files. Optionally a file format can be specified to override Amira’s
automatic file format recognition. The file format is specified by the same label which is displayed
in the file format combo box in the Amira file dialog. The list of all file formats supported by Amira
can be obtained using the global command fileFormats. Remote files can be read by using FTP or
HTTP protocol.

Additional options are:
• **-browse:** *Open Data* window is shown.
• **-amirascript:** open Amira script files.
• **-amira:** Amira’s native general-purpose file format. It is used to load many different data objects like fields defined on regular or tetrahedral grids, segmentation results, colormaps, or vertex sets such as landmarks.
• **-dataOnly:** prevents importer from creating display modules, useful in hx files.
• **-unit <Unit>:** forces the unit of the data.

```mem```
Prints out some memory statistics.

```quit```
Immediately quits Amira.

```remove {objectname | -all | -selected}```
Removes objects from Project View.

• **objectname:** the specified Amira object.
• **-all:** all objects.
• **-selected:** selected objects.

```removeTimeout procedure [arg]```
Unschedules a Tcl procedure previously scheduled with addTimeout.

```rename objectname newname```
Changes instance name of an object. Identical to ```objectname setLabel newname```, except that it returns 1 if successful, and nothing if unsuccessful.

```sleep sec```
Waits for ```sec``` seconds. Amira will not process events in that time.

```source filename```
Loads and executes Tcl commands from the specified file. If the script file contains the extension .hx, the ```load``` command may be used as well.

```system command```
Executes an external program. Do not use this unless you know what you are doing.

```saveProject```
Saves current project. If the project is not previously saved, then the project will be saved in the Amira root dir as ```Untitled.hx```. 

```saveProjectAs [-forceAutoSave | -packAndGo] arg```
A copy of the current project will be saved as ```arg``` in Amira root dir. (e.g., ```saveProjectAs```
myProject). When using a path, a full path needs to be specified and a .hx extension needs to be added on the project name (e.g., saveProjectAs c:/work/myProject.hx). Optionally, a forceAutoSave parameter can be specified to force auto saving of modified data without displaying a warning dialog. If parameter packAndGo is specified, in the same folder where the project file is saved, a new folder will be created and it will contain all data necessary for loading the saved project. Note: If a file exists it will not be overwritten.

theObjectPool setSelectionOrder {first object} {second object}...
This command reorders the selection so that it matches the given object order. Selected objects not contained inside this list will be moved at the end of the selection (their relative order will not be changed though).

thePreferences [save | load] filename
This command saves or loads preferences to/from the file specified as filename.

theProperties [show | hide]
This command shows or hides the Properties panel in Amira.

theProjectView [show | hide]
This command shows or hides the Project View panel in Amira.

fileFormats
Shows all file formats which can be used in Amira.

11.5.5 Amira Script Files

It is worth noticing that an Amira project is simply a Tcl script that will regenerate the current Amira state. Therefore, it is often efficient to interactively create an Amira project, save it with ”Save Project”, and use this as a starting point for scripting.

The simplest way to execute Tcl commands in Amira is to type them into the Amira console window. This, however, is not practical for multi-line constructs, like loops or procedures. In this case, it is recommended to write the Tcl code into a file and execute the file with the command source filename. You can also use the source command inside a file in order to include the contents of a file into another file.

Alternatively one can also use the command load filename or the Open Project... menu entry from the File menu and the file browser. Then, however, in order to let Amira recognize the file format, either the file name must end with .hx, or the file contents must start with the header line

# Amira Script

There are some Tcl files that are loaded automatically when Amira starts. At startup, the program looks for a file called .Amira in the current directory or in the home directory (see Section 11.3.3 (Start-up script) for details). If no such user-defined start-up script is found, the default initialization
script `Amira.init` is loaded from the directory `$AMIRA_LOCAL/share/resources/Amira` or `$AMIRA_ROOT/share/resources/Amira`. This script then reads in all files ending with `.rc` from the `share/resources` subdirectory. The `.rc` files are needed to register modules and data types. Therefore, one can customize the startup behavior of Amira by simply adding a new `.rc` file to that directory or by modifying the `Amira.init` file.

**Note:**
These script files must be encoded in utf-8 in order to work with non ascii characters.

Another way of executing Tcl code is to define procedures that are associated with function keys. If predefined procedures with the names `onKeyF2`, `onKeyF3`, ..., `onKeyShiftF2`, ..., `onKeyCtrlF2`, ..., `onKeyCtrlShiftF2`, ... exist, these procedures will be automatically called when the respective key is pressed in the Amira main window, console window, or viewer window. To define these procedures, write them into a file and `source` it or write them into `Amira.init` or in one of the `.rc` files. An example is

```tcl
proc onKeyF2 { } {
    echo "Key F2 was hit"
    viewer 0 viewAll
}
```

**Note:**
Some of these functions can be reserved for Amira specific actions. For example, `[F1]` is always reserved for help and `[F2]` is reserved for object renaming when pressed in the Project View or the Tree View.

Finally, Tcl scripts can also be represented in the GUI and be combined with a user interface. In Amira this is called a *Script Module*.

### 11.5.6 Configuring Popup Menus

In Amira, all of the modules that can be attached to a data object are listed in the object’s popup menu, which is activated by right-clicking on the object’s icon. For some applications, it makes sense to customize new modules using Tcl commands after they have been created. Sometimes it also makes sense to add new entries to an object’s popup menu, causing a particular script to be executed. This sections describes how to achieve these goals by modifying Amira resource files or creating new ones.

Amira resource files are located in the directory `$AMIRA_ROOT/share/resources`, where `$AMIRA_ROOT` denotes the directory where Amira has been installed. Resource files are just ordinary script files, although they are identified by the suffix `.rc`. When Amira is started, all resource files in the resources directory are read. In a resource file, modules, editors, and IO routines are registered using special Tcl commands. Registering a module means to specify its name as it should appear in the popup menu, the type of objects to which it can be attached, the name of the shared library or DLL in which the module is define, and so on. For example, the *Multi-Thresholding* module is registered by the following command in the file `hxlattice.rc`:

```tcl
TCL Scripting 537```
module -name "Multi-Thresholding" \
-check { ![${PRIMARY hasInterface HxLabelLattice3}] && \ 
  ([${PRIMARY primType}]<3 || \ 
   [${PRIMARY primType}]==7 || \ 
   [${PRIMARY primType}]==8) } \
-primary "HxUniformScalarField3 HxStackedScalarField3" \
-category "{Image Segmentation}" \
-class "HxLabelVoxel" \
-package "hxlattice"

The different options of this command have the following meaning:

- The option \-name specifies the name or label of the module as it will be printed in the popup menu.
- The option \-primary says that this module can be attached to data objects of type HxUniformScalarField3 or HxStackedScalarField3. This means that Multi-Thresholding will be included in the popup menu of such objects only.
- With \-check, an additional Tcl expression is specified which is evaluated at run-time just before the menu is popped up. If the expression fails, the module is removed from the menu. In the case of the Multi-Thresholding module, it is checked if the input object provides a HxLabelLattice3 interface, i.e., if the input itself is a label field. Although a label image can be regarded as a 3D image, it makes no sense to perform a threshold segmentation on it. Therefore, Multi-Thresholding is only provided for raw 3D images, but not for label fields. There is also a check on the primitive data type of the input (signed/unsigned integer, float, signed/unsigned short...). Here, the Multi-Thresholding module does not support float or double label images input.
- The option \-category says that Multi-Thresholding should appear in the Image Segmentation submenu of the main popup menu. If a module should appear not in a submenu but in the popup menu itself, the category Main must be used.
- The option \-class specifies the internal class name of the module. The internal class name of an object can be retrieved using the command getTypeId. It is this class name which has to be used for the \-primary option described above, not the object’s label defined by \-name.
- Finally, the option \-dso specifies in which shared library or DLL the module is defined. The option \-package can be used instead, specifying in which package the module is defined (ex: \-package "hxlattice").

Besides these standard options, additional Tcl commands to be executed after the module has been created can be specified using the additional option \-proc. For example, imagine you are working in a medical project where you have to identify stereotactic markers in CT images of the head. Then it might be a good idea to add a customized version of the Multi-Thresholding module to the popup menu, which already defines appropriate material names and thresholds. This could be done by adding the following command either in a new resource file in $AMIRA_ROOT/share/resources or directly...
in hxlattice.rc:

module -name "Stereotaxy" \  
-primary "HxUniformScalarField3 HxStackedScalarField3" \  
-check { ![($PRIMARY hasInterface HxLabelLattice3] } \  
-category "{Image Segmentation}" \  
-class "HxLabelVoxel" \  
-package "hxlattice" \  
-proc { $this regions setValue "Exterior Bone Markers";  
$this fire;  
$this boundary01 setValue 150;  
$this boundary12 setValue 300 }

The variable $this used in the Tcl code above refers to the newly created module, i.e., to the Multi-Thresholding module. Note that the commands are executed before the module is connected to the source object for which the popup menu was invoked. Some modules do some special initialization when they are connected to a new input object. These initializations may overwrite values set using Tcl commands defined by a custom -proc option. In such a case, you can explicitly connect the module to the input object via the command sequence

```
ṭhis data connect $PRIMARY;  
this fire;
```

Here the Tcl variable $PRIMARY refers to the input object. The same variable is also used in Tcl expressions defined by a -check option, as described above.

Besides creating custom popup menu entries based on existing modules, it is also possible to define completely new entries which do nothing but execute Tcl commands. For example, we could add a new submenu Edit to the popup menu of every Amira object and put in the Hide, Remove, and Duplicate commands here which are normally contained in the Edit menu of the Amira main window. This can be achieved in the following way:

```
module -name "Remove" \  
-primary "HxObject" \  
-proc { remove $PRIMARY } \  
-category "Edit"
```

```
module -name "Hide" \  
-primary "HxObject" \  
-proc { $PRIMARY hideIcon } \  
-category "Edit"
```
module -name "Duplicate" \ 
-primary "HxData" \ 
-proc { $PRIMARY duplicate } \ 
-category "Edit"

Of course, it is also possible to execute an ordinary Amira script or even an Amira script object with a 
-proc command.

### 11.5.7 Registering pick callbacks

A pick callback is a Tcl procedure attached to a module or a viewer. When a pick event occurs on this target, the callback is invoked. Such a callback can be registered by using the Tcl command

```tcl
setPickCallback
```

on modules and viewers:

```
<module> setPickCallback <proc> [ <EventType> ]
viewer <n> setPickCallback <proc> [ <EventType> ]
```

Only one callback can be attached to a given module or viewer. In order to detach the callback, just call the register command with no parameter:

```
<module> setPickCallback
viewer <n> setPickCallback
```

The optional argument `<EventType>` refers to the kind of event that will invoke the callback. Other events will be ignored. This argument can take the following values:

- `MouseButtonPress`, `MouseButtonRelease` (any mouse button),
- `VRButtonPress`, `VRButtonRelease` (any 3D button),
- `MouseButton1Press`, `MouseButton1Release`, etc. (a specific mouse button),
- `VRButton0Press`, `VRButton0Release`, etc. (a specific 3D button).

The default value is `MouseButton1Press`. The actual callback procedure `<proc>` is expected to take one argument, which is to be interpreted as an associative array and which encodes all the picking information. The following elements are defined in the argument array:

- `object`, the name of Amira object the picked geometry belongs to,
- `x`, the x coordinate of picked point,
- `y`, the y coordinate of picked point,
- `z`, the z coordinate of picked point,
• *idx*, the index of picked element,
• *stateBefore*, the modifier state just before event occurs,
• *stateAfter*, the modifier state just after event occurs.

The procedure should return 0 if the picking event was not handled, in which case other callback procedures could be invoked. Here is an example:

```tcl
proc pickCallback arg {
    array set a $arg
    echo "$a(object): picked element $a(idx)"
    return 1
}
```

Note that any module is free to add specific information to this argument array. All elements can be displayed with:

```tcl
proc pickCallback arg {
    echo "arg = { $arg }"
    return 1
}
```

Thus, some Amira modules append additional data:

• **Vertex View**: *idx* is the picked point index.
• **Point Cloud View**: *idx* is the picked point index.
• **Line Set View**: *idx* is the picked line index, *pt0* and *pt1* the two points of the picked segment.
• **Surface View**: *idx* is the picked triangle index.
• **Hexa/Tetra Grid View**: *idx* is the picked triangle index, *tetra0* and *tetra1* the adjacent tetrahedra.
• **Grid Boundary**: *idx* is the picked triangle index, *originalIdx* the index in the grid, *tetra0* and *tetra1* the adjacent tetrahedra.

### 11.5.8 File readers in Tcl

This section describes how to register a custom file reader implemented in Tcl.

First the Tcl reader function must be declared in the global scope. It must accept a list as input parameters which will contain the list of files to load. The reader is expected to return the number of files successfully read.

```tcl
proc myReaderInTcl {args} { echo "myReaderInTcl $args" ; ... ; return 1 }
```
Then, the Tcl reader function must be registered into the wanted file format declaration with the following template:

```
dataFile -name "MyFormat" ... -package hxcore -load hxReadByTcl
         -loadArgs "-cmd myReaderInTcl"
```

You indicate the custom Tcl reader function with `-loadArgs`. The arguments `-package hxcore -load hxReadByTcl` must be filed as is, without change. This sets the internal wrapper that will call the Tcl interpreter.

You can declare your custom reader in a Tcl script, or include it in a resource file to be loaded when the application starts up.

### 11.5.9 How to Create Recipe-Compliant Script-Object

The Scripting Workroom allows for the creation of script-objects, which can be considered to be custom tools since they can take input data to produce results.

Usually, script-objects are not compliant with the recipe system since the recipe cannot be created from a result of a workflow using a script-object. Some rules need to be respected to create a script that can be used in the recipes.

**Note:** You can also create a custom module using the *Tcl Command* module. This module should be recipe-compliant unless you are in one of the advanced rules use cases described below, or if you need more than one input.

The script object should apply the following rules:

- **Having an Apply button**
- **Creating a result**

Some other rules should be applied if you create non-standard scripts:

- **Using inhibitors**
- **Modifying the input**

#### 11.5.9.1 Having an Apply button

The script-object should have an Apply (i.e., portDoIt) button. The computation should be launched only if this button has been clicked.

In terms of code:

- Create the Apply (i.e., doIt) port in the script-object constructor
- At the beginning of compute method: abort if the Apply button has not been clicked.
"$this" proc constructor {} {
    "$this" select
    "$this" script hide

    # Apply button, mandatory to have a recipe-compliant script
    "$this" newPortDoIt doIt
}

"$this" proc compute {} {
    # If "Apply" button wasn’t hit: nothing is done
    if { !["$this" doIt wasHit] } {
        return
    }
    ...
    ...
}

11.5.9.2 Creating a Result

The recipe system is based into the HistoryLog of a data. The HistoryLog is a record of each step or tool that has been applied to produce the data.

The script-object should create a result dataset, and set it as result by using the setResult command. The setResult command will correctly record the HistoryLog of the data.

In terms of code:

- Use "$this" setResult <resultName>" at the end of the compute method.

$this proc compute {} {

    # If "Apply" button wasn’t hit: nothing is done
    if { !["$this" doIt wasHit] } {
        return
    }

    # If nothing is connected to the tool: nothing is done
    if { "$this" data source == "" } {
        return;
    }

    # Do some things, and store the result into ‘result’ var.
    ...
    ...

    # set the result
    "$this" setResult $result
}

The sections below describe how to handle some particular scripts, which modify the script connections or the input data.
11.5.9.3 Advanced Use: Inhibit Internal Tools

In some particular case, the recipe created from the script result contains "internal steps" since the internal tools used in the script-object appear in the recipe. This appends when the connection port of the script-object is modified by the script. If such a use case occurs, and if there is no reason these tools should appear in the recipe, the internal tool recording should be inhibited using the `startLogInhibitor` and `stopLogInhibitor` TCL commands. The script `setResult` command should be called after the `stopLogInhibitor` command.

In terms of code:

- Start the inhibitor in the compute method before creating any other tool.
- Stop the inhibitor before setting the result.

```tcl
$this proc compute {} {

  # If "Apply" button wasn't hit: nothing is done
  if { !["$this" doIt wasHit] } {
    return
  }

  # If nothing is connected to the tool: nothing is done
  if { ["$this" data source] == "" } {
    return;
  }

  # Make the script recipe-compliant: start the inhibitor
  startLogInhibitor

  # Do some things using internal tool, including modifying the data
  # connected to your script, then store the result into 'result' var.
  ...

  # Make the script recipe-compliant: stop the inhibitor
  stopLogInhibitor

  # set the result
  "$this" setResult $result
}
```

This can also be used to improve performance in script using a lot of modules.

11.5.9.4 Advanced Use: Script Modifying the Data

If you want to modify the input of the script-object (e.g., by changing its transformation), the `setResult` rule cannot be applied since the result of a tool cannot be connected as an input.
In this use case, to make the script-object recipe-compliant, we need to manually record the recipe step, by using the `recordInputUpdateInHistoryLog` command.

In terms of code:

```tcl
$This proc compute {} {

    # If "Apply" button wasn’t hit: nothing is done
    if { !"$this" doIt wasHit} {
        return
    }

    # If nothing is connected to the tool: nothing is done
    if { "$this" data source == "" } {
        return;
    }

    # Do some things which modify the input data
    ...

    # Make the script recipe-compliant: record the step
    "$this" recordInputUpdateInHistoryLog data
}
```

### 11.5.10 Versioning of Script Objects and backward compatibility

With the release of Amira 6.2 many modules have been reworked with respect to their user interface which required changing names and types of ports. As a consequence, scripts and script objects written for earlier versions of Amira than 6.2 would in many cases no longer work. To account for this a backward compatibility mode has been implemented that requires the script objects to have a version number. For script objects before 6.2 the version string was V3.0. Beginning with 6.2 a 3 digit number composed from the program version without separating dots will tell Amira whether or not to use the backward compatibility mode. Script objects with the line # Amira-Script-Object 670 in the first line will use the new interface while those with # Amira-Script-Object V3.0 will use the compatibility mode for some modules. For recent port list consult the module documentation. The modules using the compatibility mode are given in the table:
<table>
<thead>
<tr>
<th>Module Name</th>
<th>Type ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D Mesh</td>
<td>Hx2DMesh</td>
</tr>
<tr>
<td>Align Molecules</td>
<td>HxAlignMolecules</td>
</tr>
<tr>
<td>Align Principal Axes</td>
<td>HxAlignPrincipalAxes</td>
</tr>
<tr>
<td>Atomic Molecular Density</td>
<td>HxCompMolecularDensity</td>
</tr>
<tr>
<td>Auto Skeleton</td>
<td>HxExtAutoSkeleton</td>
</tr>
<tr>
<td>Bar Chart Slice</td>
<td>HxCityPlot</td>
</tr>
<tr>
<td>Bond Angle View</td>
<td>HxBondAngle</td>
</tr>
<tr>
<td>Boundary Conditions</td>
<td>HxHexaBoundaryIds</td>
</tr>
<tr>
<td>Boundary View</td>
<td>HxUnstructuredBoundariesView</td>
</tr>
<tr>
<td>Centerline Tree</td>
<td>HxTEASAR</td>
</tr>
<tr>
<td>Clipping Plane</td>
<td>HxArbitraryCut</td>
</tr>
<tr>
<td>Compute Tensor</td>
<td>HxComputeTensor</td>
</tr>
<tr>
<td>Configuration Density</td>
<td>HxConfDensity</td>
</tr>
<tr>
<td>Cross Section</td>
<td>HxUnstructuredMeshCrossSection</td>
</tr>
<tr>
<td>Curved Slice</td>
<td>HxCurvedSlice</td>
</tr>
<tr>
<td>Cylinder Correlation</td>
<td>HxCylinderCorrelation</td>
</tr>
<tr>
<td>Cylinder Slice</td>
<td>HxCylinderSlice</td>
</tr>
<tr>
<td>Elastic Registration</td>
<td>HxElasticRegistration</td>
</tr>
<tr>
<td>Export to VRML</td>
<td>HxSurfaceToVRML</td>
</tr>
<tr>
<td>Fiber Tracking</td>
<td>HxFiberTracking</td>
</tr>
<tr>
<td>Generate Molecular Interface</td>
<td>HxCompMolInterface</td>
</tr>
<tr>
<td>Generate Surface</td>
<td>HxGMC</td>
</tr>
<tr>
<td>Grid Volume</td>
<td>HxPoMeshSkin</td>
</tr>
<tr>
<td>H Bond View</td>
<td>HxHBondView</td>
</tr>
<tr>
<td>Height Map Slice</td>
<td>HxHeightField</td>
</tr>
<tr>
<td>Hexa Grid View</td>
<td>HxHexaView</td>
</tr>
<tr>
<td>Isocontour Slice</td>
<td>HxIsolines</td>
</tr>
<tr>
<td>Isosurface</td>
<td>HxIsosurface</td>
</tr>
<tr>
<td>Isosurface (hexa)</td>
<td>HxIsoHexa</td>
</tr>
<tr>
<td>Isosurface (tetra)</td>
<td>HxIsoTetra</td>
</tr>
<tr>
<td>Line Probe</td>
<td>HxLineProbe</td>
</tr>
<tr>
<td>Line Set Probe</td>
<td>HxLineSetProbe</td>
</tr>
<tr>
<td>Local Axis, Global Axis</td>
<td>HxAxis</td>
</tr>
<tr>
<td>Merge Mosaic</td>
<td>HxMergeMosaic</td>
</tr>
<tr>
<td>Molecule Electrostatics</td>
<td>HxMolElectrostatics</td>
</tr>
<tr>
<td>Molecule Label</td>
<td>HxMolLabel</td>
</tr>
<tr>
<td>Molecule Surface View</td>
<td>HxMolSurfaceView</td>
</tr>
<tr>
<td>Molecule View</td>
<td>HxMolView</td>
</tr>
<tr>
<td>Observables</td>
<td>HxMolObservables</td>
</tr>
</tbody>
</table>

TCL Scripting
<table>
<thead>
<tr>
<th>Option</th>
<th>HxCommand</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ortho Slice</td>
<td>HxOrthoSlice</td>
</tr>
<tr>
<td>Ortho Slice (lattice)</td>
<td>HxLatticeOrthoSlice</td>
</tr>
<tr>
<td>Ortho Slice (LDM)</td>
<td>HxOrthoSliceLDM</td>
</tr>
<tr>
<td>Parametric Surface</td>
<td>HxParametricSurface</td>
</tr>
<tr>
<td>Perfusion Analysis</td>
<td>HxComputePerfusion</td>
</tr>
<tr>
<td>Plot in Viewer</td>
<td>HxPlot2Viewer</td>
</tr>
<tr>
<td>Point Cloud View</td>
<td>HxClusterView</td>
</tr>
<tr>
<td>Pseudo Electron Density</td>
<td>HxPseudoElectronDensity</td>
</tr>
<tr>
<td>Register Images</td>
<td>HxAffineRegistration</td>
</tr>
<tr>
<td>Remesh Surface</td>
<td>HxRemeshSurface</td>
</tr>
<tr>
<td>Scalebars</td>
<td>HxScale</td>
</tr>
<tr>
<td>Secondary Structure View</td>
<td>HxSecStructure</td>
</tr>
<tr>
<td>Slice</td>
<td>HxFilteredObliqueSlice</td>
</tr>
<tr>
<td>Slice (LDM)</td>
<td>HxObliqueSliceLDM</td>
</tr>
<tr>
<td>Spatial Graph View</td>
<td>HxSpatialGraphView</td>
</tr>
<tr>
<td>Spline Probe</td>
<td>HxSplineProbe</td>
</tr>
<tr>
<td>Surface Cross Contour</td>
<td>HxGeometryCutter</td>
</tr>
<tr>
<td>Surface Path Editor</td>
<td>SurfacePathEditor</td>
</tr>
<tr>
<td>Surface View</td>
<td>HxDisplaySurface</td>
</tr>
<tr>
<td>Tetra Grid to Surface</td>
<td>HxTetraToSurface</td>
</tr>
<tr>
<td>Tetra Grid View</td>
<td>HxGridVolume</td>
</tr>
<tr>
<td>Transform Sequence</td>
<td>HxObjectTransformAnimation</td>
</tr>
<tr>
<td>Thinner</td>
<td>HxExtThinner</td>
</tr>
<tr>
<td>Trace Correlation Lines</td>
<td>HxTraceCorrelationLines</td>
</tr>
<tr>
<td>Tube View</td>
<td>HxTubeView</td>
</tr>
<tr>
<td>Vector Field</td>
<td>HxUnstructuredMeshVectors</td>
</tr>
<tr>
<td>Vector Plane</td>
<td>HxUnstructuredMeshPlaneVectors</td>
</tr>
<tr>
<td>Vertex View</td>
<td>HxDisplayVertices</td>
</tr>
<tr>
<td>Volren</td>
<td>HxVolren</td>
</tr>
<tr>
<td>Volume Rendering Settings</td>
<td>HxVolumeRenderingSettings</td>
</tr>
<tr>
<td>Vortex Corelines</td>
<td>HxVortexCoreline</td>
</tr>
</tbody>
</table>
11.6 Python Scripting

This section describes how to use *Python Scripting* in Amira.

11.6.1 Python Documentation

This chapter is organized as follows:
Section 11.6.1.1 Introduction to Python
Section 11.6.1.2 Embedded Python Usage
Section 11.6.1.3 Common Global Commands
Section 11.6.1.4 Modules Management
Section 11.6.1.5 Script Objects
Section 11.6.1.6 Python Environment and Package Manager
Section 11.6.1.7 List of Python Packages

The Amira Python API Documentation is available [here](#).

11.6.1.1 Introduction to Python

**What is Python**

Python is a high-level, object-oriented, interpreted language first implemented in 1989. ([https://www.python.org/dev/peps/pep-0020/](https://www.python.org/dev/peps/pep-0020/))

- Beautiful is better than ugly
- Explicit is better than implicit
- Simple is better than complex
- Complex is better than complicated
- Readability counts

**What is Included**

Amira utilizes Python 3.5.2. Detailed information on how to use Python 3.X can be found here: [https://docs.python.org/3.5/tutorial/index.html](https://docs.python.org/3.5/tutorial/index.html). Many packages are included in the Python installation (See the List of Python Packages [here](#)). Numpy and Scipy are two of the most popular Python packages included in this installation.

Numpy is an extension for handling multi-dimensional array, which allows for elementwise operations, comparisons, logical operations, and statistics among others. The numpy array is implemented in C allowing for faster computation. More information can be found here: [http://www.numpy.org/](http://www.numpy.org/).

Scipy is an extension that provides a toolbox for scientific computing such as interpolation,
integration, image processing, linear algebra, signal processing, and statistics. Creating additional GUIs for viewing plots is not currently supported. More information can be found here: http://www.scipy.org/.

**Porting from Python 2 to Python 3**
There are some compatibility breaks between Python 2 and Python 3. The Python official documentation concerning porting to Python 3 could be found here: https://docs.python.org/3.5/howto/pyporting.html.

11.6.1.1.1 Using Python

This section is not meant to cover all applications and details of the Python language. See the links in the previous section to learn more about Python, Scipy, and Numpy. To learn more about how Python interacts with Amira, continue to chapter 11.6.1.2 Embedded Python Usage.

**Python Console**
The console can be accessed by going to Windows > Consoles (see Figure 11.4). The consoles panel has a tabbed interface with several different tools available (see Figures 11.5 and 11.6).
Figure 11.4: Accessing the Consoles

Figure 11.5: Main Python Console Interface
The console acts as a Python interpreter, so any written commands will be immediately executed after pressing Enter. The assignment, or return value, will be displayed after execution.

**Hotkeys and Useful Commands**

**TAB**
When nothing is written in the console, **TAB** will auto-complete the following command `hx_project.get(module)`, which will create a Python handle for the object. When text exists in the console, **TAB** will attempt to auto-complete the current string from a list of available methods, attributes, and modules. The highlighted choice from the pulldown list will be completed.

**UP or DOWN**
These buttons cycle through your recent history. **UP** retrieves your previous command, while **DOWN** retrieves the subsequent command.

**11.6.1.1.2 Notes on Python**

**Packages**
Python is an object-oriented language, meaning that code is typically broken down into classes in which variables and methods can be inherited by objects at instantiation.
This allows you to avoid re-coding functionality that you use often. More information about OOP in the context of Python can be found here: [http://www.tutorialspoint.com/python/python_classes_objects.htm](http://www.tutorialspoint.com/python/python_classes_objects.htm)

Packages are collections of classes, methods, and variables that can be imported to a namespace in Python. For example, if the user wants to calculate $\sin(\pi/2)$, they first need to import the Numpy package into the namespace:

```python
>>> import numpy
```

The Numpy package contains a $\sin(x)$ method that can then be accessed to calculate $\sin(\pi/2)$:

```python
>>> numpy.sin(3.1415/2)
0.99999999892691405
```

Numpy already contains a global variable defining $\pi$ that you can access in the same way:

```python
>>> numpy.pi
3.141592653589793
>>> numpy.sin(numpy.pi/2)
1.0
```

Packages can be assigned to variables when imported to the namespace to simplify code:

```python
>>> import numpy as np
>>> np.sin(np.pi/2)
1.0
```

**Syntax**

Python supports several different object types:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Integers, floats, complex, booleans</td>
<td>1, 1.05, 3j+2, 3&gt;2 is True</td>
</tr>
<tr>
<td>String</td>
<td>Sequence of characters</td>
<td>&quot;String of charaters&quot;</td>
</tr>
<tr>
<td>List</td>
<td>Container to group items that can be changed</td>
<td>[1, 5, &quot;Dragon&quot;, 948.5]</td>
</tr>
<tr>
<td>Tuple</td>
<td>Container to group items that cannot be changed</td>
<td>(948.5, &quot;Dragon&quot;, 5, 1)</td>
</tr>
<tr>
<td>Dictionary</td>
<td>Associated arrays with unique keys</td>
<td>{'a':99, 'b':'red', 'c':'balloons'}</td>
</tr>
<tr>
<td>Array</td>
<td>Vectorized numeric array optimized for C</td>
<td>numpy.ones ((10,5))</td>
</tr>
</tbody>
</table>

Some types are denoted using specific characters. For example, single or double quotes are used to create strings:
>>> a = 'This is a string.'
>>> b = "This is also a string."

While lists are assigned using brackets:

>>> c = [1, 5, "Dragon", 948.5]

Operations can be performed between objects using standard syntax:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>addition</td>
</tr>
<tr>
<td>-</td>
<td>subtraction</td>
</tr>
<tr>
<td>*</td>
<td>multiplication</td>
</tr>
<tr>
<td>/</td>
<td>division</td>
</tr>
<tr>
<td>**</td>
<td>exponent</td>
</tr>
<tr>
<td>%</td>
<td>modulus</td>
</tr>
<tr>
<td>==</td>
<td>equal</td>
</tr>
<tr>
<td>!=</td>
<td>not equal</td>
</tr>
<tr>
<td>&gt;</td>
<td>greater than</td>
</tr>
<tr>
<td>&lt;</td>
<td>less than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>less than or equal to</td>
</tr>
<tr>
<td>&gt;=</td>
<td>greater than or equal to</td>
</tr>
</tbody>
</table>

Some keywords are reserved for global variables or perform specific functions. Overwriting these keywords as variables should be avoided at all costs.

And
Class
elif
finally
if
lambda
print
while
assert
def
except
from
in
or
return
yield
break
del
exec
global
is
pass
try

A more thorough discourse on Python syntax and object types can be found in the official tutorial: https://docs.python.org/3.5/tutorial/index.html

11.6.1.2 Embedded Python Usage

11.6.1.2.1 Overview
Similar to TCL, Python has been implemented in Amira using a Pythonic API. Commands specific to Amira allow you to access information and functionalities contained within Amira modules. There are two main ways to interact with Amira using Python. The first way to use Python is through the Python console, which is separate from the TCL console. This is an interpreter. The basic functionality of this console, such as tab completion, is described in chapter 11.6.1.1 Introduction to Python.

The second way to use Python in Amira is through script modules. Python script modules allow you to inherit properties from the pre-defined PyScriptObject class before you override them to create their own integrated extensions to Amira. Script modules act like regular modules in Amira and can be accessed in the Object Popup menu when accompanied by a resource file. The resource file still must be written in TCL. There are four methods included in the PyScriptObject class for your convenience:
• **init**( ): This constructor method can contain code that is run when the script object is created in the Project View.

• **update**( ): The update method can be invoked to update the script object’s GUI in the **Properties Panel**.

• **compute**( ): The compute method usually contains the bulk of your code and should be invoked when computation must occur.

• **del**( ): This destructor method can contain code that helps clean up the namespace at module deletion.

### 11.6.1.2.2 Example: Interacting with Modules

Here we will go through an example of how the console can be used to interact with modules in the Project view by creating an Ortho Slice and changing its properties.

1. Ensure that the *Python Console* is shown in the workspace
2. Open $AMIRA_ROOT/data/tutorials/chocolate-bar.am

   • If Auto-View is enabled, an Ortho Slice is automatically created. Delete it.

3. To create an Ortho Slice, access the **create**( ) method in the HxProject class. The **create**( ) method requires us to pass the type ID of the object we want to create as a string argument.

   • If you are unsure what an object’s type ID is, you can create the object in the GUI then use the <module> getTypeID command in the TCL console to learn its type.

     ```python
     >>>hx_project.create('HxOrthoSlice')
     ```

4. Now we need to connect Ortho Slice to chocolate-bar.am, but we will first assign the Ortho Slice to a variable using the **get**( ) method to make it easier to access in the future. We will do the same for chocolate-bar.am:

     ```python
     >>>ortho = hx_project.get('Ortho Slice')
     >>>input_data = hx_project.get('chocolate-bar.am')
     ```

5. To connect the Ortho Slice to chocolate-bar.am, we will need to see how to access the Data port of Ortho Slice. Expose a list of possible ports to interact with by printing the results of the portnames command to the console:

     ```python
     >>>ortho.portnames
     ['data', 'origin', 'normal', 'frameSettings', ...
     ```

*Python Scripting* 554
6. From the `portnames` command we see that the ‘data’ port likely coincides with the "Data" connection exposed in the Ortho Slice’s properties. Connect `chocolate-bar.am` to this port using the `connect()` method at the `ports` level, then apply the change with the `fire()` method:

```python
>>> ortho.ports.data.connect(input_data)
>>> ortho.fire()
```

7. We can also change the slice location by setting the `sliceNumber` port’s value:

```python
>>> ortho.ports.sliceNumber.value = 100
>>> ortho.fire()
```

8. Experiment with the other ports in Ortho Slice to see if you are able to change the slice orientation and the colormap. For help accessing these ports, pass the access command to the `help()` method:

```python
>>> help(ortho.ports.sliceOrientation)
```

9. Read further on the methods and classes available for your manipulation by passing them to the `help()` method:

```python
>>> help(ortho.fire)
```

### 11.6.1.2.3 Example: Developing a Script

In this example, we will write a simple script to calculate the total volume of the bounding box of a dataset. This can be typed directly in the Python console in Amira. You can also type the commands in a text editor and copy them to the Python console for execution.

1. Load `$AMIRA_ROOT/data/tutorials/chocolate-bar.am`.
2. Assign `chocolate-bar.am` to a variable to quickly refer to it in subsequent code.

```python
>>> data = hx_project.get('chocolate-bar.am')
```

3. Create a Bounding Box and attach it to `chocolate-bar.am`.
   - You can assign the Bounding Box to a variable at the same time you create it, instead of creating it then using the `get()` method in a separate command later.

```python
>>> bbox = hx_project.create('HxBoundingBox')
```
4. Retrieve the extents of the bounding box in X, Y, and Z to calculate its volume. There is already a bounding_box command you can use to get this information, which is stored as a tuple defined as ((xmin, ymin, zmin),(xmax, ymax, zmax)).

```python
>>> type(data.bounding_box)
<class 'tuple'>
>>> data.bounding_box
((0.0, 0.0, 0.0),
 (0.02807999961078167,
  0.020880000665783882,
  0.035280000418424606))
```

5. Python also makes it easy to extract two variables at once from this two-list tuple.

```python
>>> min_bounds, max_bounds = data.bounding_box
```

6. Access each of the indices from the minimum and maximum boundary lists using brackets [] and plug this information into a formula to calculate the box’s volume.

```python
>>> x_extent = max_bounds[0] - min_bounds[0]
>>> y_extent = max_bounds[1] - min_bounds[1]
>>> volume = x_extent * y_extent * z_extent
```

7. Finally, print the information to the console in a refined format.

```python
>>> print('The volume of %s is %.g. ' % (data.name, volume))
```

### 11.6.1.2.4 Example: Creating a Function

In this example, we wrap the bounding box volume calculator into a function that accepts our input data as an argument and prints our answer back into the console. A few notes about functions and Python syntax:

- If you do this directly in the Amira console, press **SHIFT+ENTER** to enter a line break in your code without executing it.
- Python requires consistent indentation within the body of a function. The best practices convention is to indent the body of code by four spaces (not a tab).
The Python console in Amira does not indent lines for the user, and the user must control indentation themselves.

1. Load `AMIRA_ROOT/data/tutorials/chocolate-bar.am`
2. Use the `def` keyword to define a function called `bbVol` that takes a single input dataset as an argument.
   ```python
   >>> def bbVol(data_arg): # Remember to SHIFT+ENTER here!
   ...  
   3. An ellipses is shown in the interpreter to show that it is waiting for more code before executing the current input. Manually type four spaces, then assign the minimum and maximum bounding box lists to variables as before.
   ```python
   ... min_bounds, max_bounds = data_arg.bounding_box
   ```
   4. Pressing `SHIFT+ENTER` to make a new line, enter another four spaces, and proceed with the rest of the volume calculator.
   ```python
   ... x_extent = max_bounds[0] - min_bounds[0]
   ... y_extent = max_bounds[1] - min_bounds[1]
   ... z_extent = max_bounds[2] - min_bounds[2]
   ... volume = x_extent * y_extent * z_extent
   ... print('The volume of %s is %.3f. ' % (data_arg.name, volume))
   ```
   5. Finally, include a `return` statement to send the volume variable back to the console. This allows you to set the result of the calculation to a variable.
   ```python
   ... return volume
   ```
   6. Execute the function definition by pressing `ENTER`, then test the code with chocolate-bar.am. Test your ability to assign the calculation result to a variable as well.
   ```python
   >>> bbVol(hx_project.get('chocolate-bar.am'))
   The volume of chocolate-bar.am is 2e-05.
   2e-05
   >>> chocolatebar_volume = bbVol(hx_project.get('chocolate-bar.am'))
   ```

### 11.6.1.3 Common Global Commands

There are two mains functions that greatly help the user to explore the structure of Python within Amira. The `dir()` function allows the user to see a list of attributes and methods that are available for a given object.

```python
>>> ortho = hx_project.get('Ortho Slice')
>>> dir(ortho)
['__class__', '__delattr__', '__dir__', '__dir__', '__doc__'],
```
This information is also available in a pulldown list when you begin typing a command (See Figure 11.7).

```
>>> help(ortho)
Help on HxPlanarModBase object:

class HxPlanarModBase(HxModule):
 | This is the first class of HxBase hierarchy which represents items that
```

Figure 11.7: Pulldown List of Commands
Method resolution order:
   HxPlanarModBase
   HxModule
   HxObject
   HxBase
   McInterface
   builtins.object

Methods defined here:
...
...
...

all_interfaces
   Attribute that contains all admissible interfaces as sub-members.

Examples
       -------

   Retrieve an 'HxBase' interface on an orthoslice:
   >>> ortho = hx_project.create('HxOrthoSlice')
   >>> base = ortho.all_interfaces.HxBase

A list of some more specific global commands is provided below.

- `print()` is a native Python command that prints results to the Python console in Amira.
  >>>x = 3
  >>>y = 2
  >>>print('The sum of %i + %i is %i.' % (x,y,x+y))
  The sum of 3 + 2 is 5.

- `import` is a native Python command that adds extended functionality to Python by loading extra packages.
  >>>x = 3
  >>>y = 2
  >>>import numpy
  >>>numpy.add(x,y)
  5
Some useful global functions for interacting with the Project view are contained in the `hx_project` method.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>hx_project.create()</code></td>
<td>Creates an instance of a certain Amira class and adds it to the Project view</td>
</tr>
<tr>
<td><code>hx_project.remove()</code></td>
<td>Removes an object from the Project view</td>
</tr>
<tr>
<td><code>hx_project.add()</code></td>
<td>Adds an object to the Project view</td>
</tr>
<tr>
<td><code>hx_project.load()</code></td>
<td>Loads data of a defined format when a filename is specified</td>
</tr>
</tbody>
</table>

Variables containing directory paths are also provided as attributes accessible via the `hx_paths` method.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>hx_paths.install_dir</code></td>
<td>Installation directory, also known as <code>&lt;$AMIRA_ROOT&gt;</code></td>
</tr>
<tr>
<td><code>hx_paths.tutorials_dir</code></td>
<td>Tutorials data directory</td>
</tr>
<tr>
<td><code>hx_paths.python_modules_dir</code></td>
<td>Python modules directory that contains extra packages</td>
</tr>
<tr>
<td><code>hx_paths.python_script_objects_dir</code></td>
<td>Python script objects directory that contains user-created custom Python scripts</td>
</tr>
<tr>
<td><code>hx_paths.executable_dir</code></td>
<td>Directory containing Amira.exe</td>
</tr>
</tbody>
</table>

```python
>>> hx_paths.install_dir
'C:/Program Files/<INSTALL_DIR>'
>>> hx_paths.tutorials_dir
'C:/Program Files/<INSTALL_DIR>/data/tutorials'
>>> hx_paths.python_modules_dir
'C:/Program Files/<INSTALL_DIR>/share/python_modules'
>>> hx_paths.python_script_objects_dir
'C:/Program Files/<INSTALL_DIR>/share/python_script_objects'
>>> hx_paths.executable_dir
'C:\\Program Files\\<INSTALL_DIR\\bin\\arch-Win64VC12-Optimize\\Amira.exe'
```

### 11.6.1.4 Modules Management

A complete reference manual with many code snippets explaining how to configure all ports and modules, is accessible from the Python Reference Help menu item

#### 11.6.1.4.1 Module Attributes

**What is an Attribute**

An attribute is a data field contained within a class. Some attributes may be read-only.
List of Common attributes
Here the variable ‘a’ refers to the python handle for your object.

a.name:
This is a string property that refers to the name of your Amira object. A string may be assigned to change the display name of the object.

a.portnames:
This is a read-only list of all the port names that belong to the Amira object.

a.viewer_mask:
This is an integer property that triggers the visibility in the viewer. There are 16 configurations that can be set from [0, 15]. If a number outside of that range is used, the number will be evaluated after the modulo 16 operation.

a.bounding_box:
This stores a pair of tuples that describe the spatial dimensions of your object. New dimensions could be assigned in the format of \((x_{\text{min}}, y_{\text{min}}, z_{\text{min}}), (x_{\text{max}}, y_{\text{max}}, z_{\text{max}})\).

a.downstream_connections[x]:
This stores a read-only sequence of all objects that refer to it. Each connection is assigned an index ‘x’ which is an integer. To find the name of the object from the pointer, use the command a.downstream_connections[x].get_owner().name

a.range:
This stores a read-only tuple showing the intensity range of the data in the form (min, max).

a.transform:
This stores a tuple showing the 4x4 transformation matrix. A new transformation can be assigned.

11.6.1.4.2 Module Methods

What is a Method
A method is a function contained within a class. Many methods do not need an argument.

List of Common Methods
Here the variable ‘a’ refers to the python handle for your object.

a.compute():
This method performs the computation of the object if a.ports.doIt.was_hit = True. This simulates clicking Apply of the object when conditions permit.

a.update():
This method updates the object GUI for the properties window.

a.fire():
This method calls a.update() and a.compute().
.execute():
This method combines all of the above methods to simulate a click of **Apply** and a refresh of the GUI.

`.get_array()`:
This method accesses the NumPy array of your object. Accessing the array will prevent deletion of the object.

`.set_array(...)`:
This method assigns a NumPy array to your object. Ownership of the array is not passed, so future changes to the array do not propagate unless reassigned.

### 11.6.1.5 Script Objects

#### 11.6.1.5.1 What is a Python Script Object

A python script object is a compute module whose behavior is hardcoded in a Python class inherited from PyScriptObject. Python script objects are useful for creating custom tools whose functionality is accessed the same way that Amira compute modules are accessed.

**Script Structure**

The following class methods are useful when defining your python script object as a class, but it is not required to define it in such a way. Any script will run just as if it was typed into the console. The variable `self` refers to its own class identity.

**def __init__(self):**
This method is called when the object is created. It is a useful area to define the structure of your script and setup the GUI.

**def __del__(self):**
This method is called when the object is restarted or deleted. This is a good place to cleanup any connections.

**def update(self):**
This method is called when the GUI needs to be refreshed.

**def compute(self):**
This method is called when **Apply** is clicked.

**Note:** The execution of a Python Script Object is done on a separate Python interpreter and has its own Python console. However, please note that in some particular circumstances, for example a message print coming from a PyQt slot, the streaming could be redirected to the Main Python interpreter.

#### Creating Ports

The user interfaces with the object through ports. The ports can be initialized through simple assignment, and they belong to the `HxPort` class. A few useful ports are below:

- **HxConnection**
  This port class allows the user to connect modules. The type of module can also be restricted.

*Python Scripting* 562
• **HxPortFilename**
  This port class allows the user to load or save files. The function of the port is defined with the **mode** attribute. The filename can either be input as text or accessed through a file browser.

• **HxPortIntSlider**
  This port class holds a range of integer values that can be accessed through a sliding scale. This port is used to define the slice number of the "Ortho Slice" module.

• **HxPortDoIt**
  This port class controls the auto-refresh box and handles the **Apply** button.

• **HxPortInfo**
  This port class is useful to provide instructions, notes, or warnings to the user. The text can be found in the module properties.

**Bounding Box Script Example**

In this example, we wrap the bounding box volume calculator (described in chapter: *Embedded Python Usage*) into a script module that can be loaded into the Amira GUI via the Object Popup menu.

1. Open a text editor and create a new file with the following structure. Name the object **BoundingBoxVolume**.

   • Alternatively, you can start with a template in $AMIRA_ROOT/share/python_script_objects/PythonScriptObjectTemplate.pyscro

   ```python
class BoundingBoxVolume(PyScriptObject):
    def __init__(self):
        # Initialization code will go here

    def update(self):
        # Update code will go here

    def compute(self):
        # Computation code will go here

2. The script object needs to be able to connect to a data object to know which bounding box needs the volume calculated. By default, Python script objects inherit a data connection from the PyScriptObject class. Make sure it is visible in the `__init__()` method.

   ```python
   def __init__(self):
       self.data.visible = True
   ```

*Python Scripting* 563
3. In this example, use the pass keyword to skip updating the GUI in the `update()` method since there will be no ports to update.

```python
def update(self):
    pass
```

4. In the `compute` method, we want to halt the volume computation if there is no data object connected to the script module. Add an `if` statement that checks if the data connection is empty. If the data connection is empty, use a `return` statement to exit the `compute()` method.

   - Python makes this easy with the None keyword (i.e., `if <expression> is None`)

```python
def compute(self):
    # Check if input data is connected
    if self.input.source() is None:
        return
```

5. Finally, if the logic check fails because a data object is attached, calculate the volume using the `bbVol` script. Get the name of the connected data object using the `source()` method.

```python
def compute(self):
    # Check if input data is connected
    if self.input.source() is None:
        return

    data = self.input.source()
    min_bounds, max_bounds = data.bounding_box
    x_extent = max_bounds[0] - min_bounds[0]
    y_extent = max_bounds[1] - min_bounds[1]
    volume = x_extent * y_extent * z_extent
    print('The volume of %s is %.g.' % (dataArg.name, volume))
```

6. Once your module is complete, create a resource file in TCL that displays this module in the Object Popup menu as an option to attach to all data objects.

   - Refer to Configuring Popup Menus to learn more about creating resource files.
11.6.1.5.2 Resource File

A resource file is a TCL script that is read and executed during the Amira startup process. You can configure a resource file, so that your Python script object appears in the pulldown menu or as a macro button. The resource files are located in the $AMIRA_ROOT/share/resources directory.

Structure Pulldown Resource File

The script begins with the TCL command `<module>` followed by the following flags for a simple case. In the example below, $PRIMARY refers to the object that you originally right-clicked.

```
-module -name "Bounding Box Volume" \ 
-primary "HxUniformScalarField3" \ 
-package "py_core" \ 
-category "{Measure And Analyze}" \ 
-proc {
  set this [[create HxPythonScriptObject] \ 
    setLabel "Bounding Box Volume"]
  "$this" startStop hideMaskIncrease
  "$this" filename hideMaskIncrease
  "$this" filename setValue \ 
    <PRODUCT_PATH>/share/python_script_objects \ 
    /PythonBoundingBoxVolume.pyScript
  "$this" startStop hit 0
  "$this" fire
  if { [exists $PRIMARY] } {
    $this data connect $PRIMARY
    $this fire
  }
}
```

- `module`: This is the name of your module in the menu.

- `primary`: This defines the package of your object.

- `primary`: This restricts the data type that is required for your script to appear.
-category
This defines which folder in the menu that your script will appear.

-proc
This is the body of the resource file where you can identify while .pyscro loads along with connecting your script to the object that you originally right-clicked.

Structure Macro Resource File
The script begins with the TCL command <macroButton> followed by the following flags for a simple case.

-add
This creates a name for your button.

-color
This controls the color of your button.

-proc
This is the body of the resource file where you can identify while .pyscro loads or the procedure runs.

11.6.1.6 Python Environment and Package Manager

Context
This section explains how to list/install/update a new Python package for Amira using a command prompt for Windows and a terminal for Linux/Mac. The package manager allows the user to create multiple self-contained Python environments with their own Python executable (e.g. python.exe on Windows) and set of packages. Each self-contained environment can then be used by Amira.

Description
The EDM (Enthought Deployment Manager) package manager can be used to install, remove, or upgrade Python packages available in two repositories:

- official ThermoScientific/3dSoftware
- enthought/free

This tool should be used to find available Python packages and install new ones. It allows viewing, updating and removing installed packages. Moreover, it allows reverting to previous states and restoration of the original Amira Python environment.

How to install and configure EDM
Note: The EDM installer may need to restart your computer.
The EDM installer can be found on the Enthought website: https://www.enthought.com/product/enthought-deployment-manager/

The installer extracts EDM (e.g., edm.bat on Windows) in a default folder (e.g., C:\Enthought\edm. on Windows).

To create a new Python environment named hxEnv, execute the following command line in a command prompt for Windows (go to the EDM installation directory) and a terminal for Linux/Mac (use the .json file corresponding to the correct architecture):
edm envs import -f $AMIRA_ROOT/python/bundles/3dSoftware_win64.json hxEnv

If this command fails (e.g., with the following error message: The packages repository 'ThermoScientific/3dSoftware' does not exist or is not available under your the configuration file $HOME/.edm.yaml file is either incomplete or missing. Open the folder $HOME (the $HOME environment variable contains the absolute pathname of a user’s home directory) and search for the .edm.yaml file. If it is present, please remove it and restart Amira which will should re-create it. If the file is still missing, please contact support.
The newly created Python environment is stored in $HOME/.edm/envs/hxEnv.

To use the new created Python environment named hxEnv in Amira, you have to set the environment variable HX_FORCE_PYTHON_PATH to $HOME/.edm/envs/hxEnv.

It is possible to get list of available environments as follows:
edm environments list

**How to search for and install a package**
First, search for the requested package as follows:
edm search <package_name> -e hxEnv

If the package is available, install it as follows:
edm install <package_name> -e hxEnv

**How to list the current installed packages**
To list all the current installed packages in Amira, type:
edm list -e hxEnv

**How to reinitialize the Amira packages**
To reinitialize Python packages to their original state, create a new environment using the json file or unset the HX_FORCE_PYTHON_PATH environment variable. Unsetting the variable will make Amira use its embedded version.
This may be useful if the Python distribution becomes non-functional (for instance after installing unsupported packages) with Amira.

To show all available options, use the following line:

```
edm help
```

### 11.6.1.7 List of Python Packages

List of packages already included in Thermo Scientific Python:

- alabaster 0.7.10-1
- appdirs 1.4.3-1
- babel 2.4.0-2
- backports.abc 0.5-1
- backports.abc_remove 0.4-2
- certifi 2017.7.27.1-1
- chardet 3.0.4-1
- colorama 0.3.7-1
- configobj 5.0.6-2
- cycler 0.10.0-1
- cython 0.25.2-1
- decorator 4.1.2-1
- distribute_remove 1.0.0-4
- docutils 0.13.1-1
- h5py 2.7.0-2
- idna 2.5-1
- imagesize 0.7.1-1
- intel_runtime 15.0.6.285-2
- jdcal 1.2-1
- jinja2 2.9.6-1
- lxml 3.7.3-2
- markupsafe 0.23-2
- matplotlib 2.0.0-5
mkl 2017.0.3-1
networkx 1.11-7
nose 1.3.7-3
numexpr 2.6.2-3
numpy 1.13.3-3
numpydoc 0.6.0-4
opencv 3.2.0-3
openpyxl 2.4.1-2
packaging 16.8-2
pandas 0.20.3-3
patsy 0.4.1-4
pillow 4.0.0-1
pip 10.0.1-1
py 1.4.34-1
pydicom 0.9.9-1
pygments 2.2.0-1
pyparsing 2.2.0-1
pyqt5 5.8.2-3
pytables 3.3.0-5
pytest 3.1.2-1
python_dateutil 2.6.0-1
pytz 2017.3-1
pywavelets 0.5.2-2
requests 2.18.4-1
scikit_learn 0.19.1-2
scikits.image 0.13.0-5
scipy 1.0.0-2
seaborn 0.8.1-2
setuptools 38.2.5-1
 singledispatch 3.4.0.3-1

Python Scripting
11.6.2 Python Tutorials

11.6.2.1 Python Tutorial - Using Tools from the Python Eco-System within Amira

One of the advantages of integrating Python into Amira is that Python tools can now be used to extend Amira functionality. This extension allows writing script objects that encapsulate Python functions to make them available as modules in the Amira graphical user interface. These Python tools can then be controlled through standard Amira ports.

This tutorial demonstrates how to integrate the Fast Fourier Transform (FFT) from scipy as an alternative to the FFT used in Amira. You can follow it using the step by step explanations or have a look to the resulting files (ScipyFFT.pyscro and ScipyFFT.rc) within the $AMIRA_ROOT/share/python_script_objects directory.

Copy PythonScriptObjectTemplate.pyscro from the $AMIRA_ROOT/share/python_script_objects directory to a location of your choice and rename it to ScipyFFT.pyscro.

1. Open the file in a text editor and give your new module a name by changing the first line to:

   class ScipyFFT(PyScriptObject):

2. In the initialization function, the default data input port will be used for the data connection to your module and the allowed connection types will be defined:

   self.data.valid_types = [‘HxUniformScalarField3’]

3. The final initialization function definition will look like this:

   def __init__(self):

Python Scripting
self.data.valid_types = ['HxUniformScalarField3']

# Create an 'Apply' button.
self.do_it = HxPortDoIt(self, 'apply', 'Apply')

4. Leave the update function as is:
   
def update(self):
      pass

5. The computation of the FFT will be done in the compute function. After checking if Apply was clicked and if an input dataset was selected, import a few packages from Python. In this case, we need the fftpack from scipy, numpy for some mathematical functions, and the time package to measure execution time:

   from scipy import fftpack
   import numpy
   import time

6. As a first step in the computation, create a variable to store the result from the FFT computation as a 3D uniform scalar field.

   result = hx_project.create('HxUniformScalarField3')

7. To measure execution time, you first need to take a time stamp at the beginning of the computation:

   start_time = time.time()

8. Create a Python variable for the input data:

   input = self.data.source()

9. To compute the absolute value of the FFT of our input data, execute the following three commands:

   # Compute the discrete Fourier transform
   F1 = fftpack.fftn(input.get_array())

   # Shift the zero-frequency component to the center of the spectrum
   F2 = fftpack.fftshift(F1)
# Take the magnitude of all coefficient
F3 = numpy.abs(F2)

10. After the computation has finished, assign the result array to the result variable that you created earlier:

    result.set_array(F3)

11. Print out the total execution time of the FFT:

    print("--- %s seconds ---" % (time.time() - start_time))

12. The entire compute function should look as follows:

    def compute(self):
        # Check if module’s apply button has been touched by the user
        if not self.do_it.was_hit:
            return

        # Check if input data is connected to a valid object
        if self.data.source() is None:
            return

        # Import scipy package to perform fft
        from scipy import fftpack
        import numpy
        import time

        # Create the output field
        result = hx_project.create('HxUniformScalarField3')

        start_time = time.time()

        # Retrieve the input data
        input = self.data.source()

        # Compute the discrete Fourier transform
        F1 = fftpack.fftn(input.get_array())

        # Shift the zero-frequency component
        # to the center of the spectrum
        F2 = fftpack.fftshift(F1)
# Take the magnitude of all coefficient
F3 = numpy.abs(F2)

# Affect to the output scalar field the resulting numpy array
result.set_array(F3)

# Show in console computation time
print("--- %s seconds ---" % (time.time() - start_time))

13. To make this module available in the graphical user interface of Amira, you will also need to write a resource file. Create a new file with your text editor and save it as ScipyFFT.rc. Resource files typically start with a comment line:

# .rc for pyscro Scipy FFT

14. Name the module:

    module -name "Scipy FFT" \n
15. Specify the data type we would like to be able to attach it to:

    -primary "HxUniformScalarField3" \n
16. Declare it as a Python script object:

    -package "py_core" \n
17. The next line defines the location where it will appear in Amira’s Object Popup menu:

    -category "{Python Scripts}" \n
18. Run a few TCL commands to initialize the module in Amira’s graphical user interface. The first command will create the script object and set a label for the module:

    -proc {
        set this [[create HxPythonScriptObject] setLabel "Python FFT"]
    }

19. Set the file name to find the Python script location for this module, where the

"Python Scripting"
20. The script will run for the changes to take effect:

"$this" startStop hit 0
"$this" fire

21. Connect the dataset to the default input data port on which you right-clicked to create the module:

```python
if { [exists $PRIMARY] } {
    $this data connect $PRIMARY
    $this fire
}
```

22. The entire resource file will look like this at the end, where the `<PRODUCT_PATH>` is `$AMIRA_ROOT`:

```python
# .rc for pycro ScipyFFT

module -name "Scipy FFT" \
    -primary "HxUniformScalarField3" \
    -package "py_core" \
    -category "{Python Scripts}" \
    -proc {
        set this [[create HxPythonScriptObject] \ 
            setLabel "Python FFT"]
        "$this" startStop hideMaskIncrease
        "$this" filename hideMaskIncrease
        "$this" filename setValue \ 
        <PRODUCT_PATH>/share/python_script_objects/ScipyFFT.pyscro
        "$this" startStop hit 0
        "$this" fire
        if { [exists $PRIMARY] } {
```
23. To make this Python script object available to Amira, you need to copy both files (overwrite existing files) to $AMIRA_ROOT/share/python_script_objects/ and restart Amira after changing the resource file if you followed the above steps.

If you want to re-use the embedded Python FFT example, edit the $AMIRA_ROOT/share/python_script_objects/ScipyFFT.rc file and change the -category value from "None" to "{Python Scripts}".

24. To test this module, do the following:

1. Start Amira.
2. Load $AMIRA_ROOT/data/tutorials/chocolate-bar.am
3. Right-click on the data object and select Python Scripts/Scipy FFT from the Object popup.
4. Click Apply and a new data object with the resulting FFT will display in the Project View.

11.7 Using MATLAB with Amira

This section describes how to use MATLAB Scripts in Amira.

11.7.1 Using MATLAB Scripts

In this tutorial, you will learn how to integrate complex calculus into Amira using MATLAB (The MathWorks, Inc.) by the means of the Calculus MATLAB module.

In order to use the Calculus MATLAB module, MATLAB must be correctly installed on your computer. In addition, in order to allow this module to establish a connection with the MATLAB computational engine, you may need to register the MATLAB engine (on Windows), and to set environment variables for including MATLAB libraries or programs in search paths, depending on your system. See the documentation of the Calculus MATLAB module for installation details and limitations.

This tutorial, available in the online documentation, covers the following topics through various examples:

- Loading and executing a MATLAB script.
- Passing various data types from Amira to MATLAB and exporting them back.
- Using the field structures.
- Controlling the script variables with time sliders.
• Calling user MATLAB functions from a script.
Part II

Chapter 12

Amira Cell Biology Edition Tutorials

Amira Cell Biology Edition is a complete solution for cell biologists. Based on Amira and through the integration of the *Amira XBioFormats Extension*, it enables researchers to import almost any file format used in cell biology applications including all meta data. Data can then be processed with advanced segmentation and analysis tools from the *Amira XImagePAQ Extension* and *Amira XTracing Extension*. This allows researchers to customize a segmentation/detection workflow to their needs. Segmentation workflows can then be applied to entire time series data. The detected objects in these time series can then be tracked using the *Amira XObjectTracking Extension*, the most powerful and automated tracking solution in the market (powered by u-track 3D, under submission for peer-review from the Danuser Lab). The combination of customizable segmentation tools and powerful tracking makes Amira Cell Biology Edition the most flexible image analysis and tracking solution available to today’s cell biologists.

12.1 Processing of Time Series Data Tutorial

This Amira tutorial demonstrates how to create and apply a segmentation workflow to an entire time series. It uses the marker-based watershed workflow popular from the *Segmentation Editor* as an example to segment cell nuclei in dynamic TLS-SPIM data of a dividing c.elegans embryo. The data was collected with a TLS-SPIM by Liang Gao at Stony Brook University. To keep the processing time and download reasonable, the images have been cropped and resampled in all four dimensions.

To load a time series of images, use the *Open Time Series Data*... dialog box accessible through the *File* menu in the menu bar. Navigate with the file browser to the AMIRA_ROOT/data/tutorials/tracking/gray/ directory and open all files in the folder by pressing Ctrl-A and then clicking *Open*. The data is now visualized via an *Ortho Slice* module. Figure 12.1 shows slice number 53 of the first time step in the time series with colormap range set to 0-62.
For the convenience of working with time series data, pin down the Time port of the Time Series Control module by clicking on the push pin next to the port. This allows quick access for changing the current time step. Similarly, the Slice Number port can be pinned for quick access of the slicing functionality.

Next, binarize the image data using the Multi-Thresholding compute module and attach it to the image data. Fill the region names: Exterior and Nuclei into the Regions port. Set the Exterior-Nuclei threshold to 20 and click Apply. Attach a Color Wash module to the Ortho Slice module and connect the Data input port with the generated label field C-elegans.0000.labels to visualize the result. After adjusting the Colormap port in Ortho Slice to 0-62 and changing the Colormap port for Color Wash to labels256.am, you will get the following visualization in the 3D Viewer and network in the Project View (see Figure 12.2).
To apply changes immediately and to avoid clicking Apply multiple times, enable the auto-refresh feature associated with the compute modules. If you do this for the entire workflow, parameter changes propagate automatically.

To confirm that the segmented nuclei consist of a single-connected region, apply the following standard workflow that is aimed to connect any individual local regions within the nuclei. Perform this action by first applying a Dilation with parameters Type: Ball and Size: 3 followed by a Fill Holes operation with parameters Interpretation: 3D and Neighborhood: 26. Add an Erosion module with parameters Type: Ball and Size: 3 to finalize the sub-workflow. The various results can be visualized by dragging the connector between the Color Wash module and C-elegans.labels to any of the other created label fields (e.g., C-elegans.eroded). This is a useful technique to quickly visualize intermediate segmentation results (see Figure 12.3).
Now that you have markers in all the nuclei, mark the image background to improve the results from the marker-based watershed segmentation. For this, invert the image after marker dilation and further erode the inverted image to confirm that we have only the background selected. This can be done by attaching an Invert compute module to the dilated image $C$-elegans.dilated followed by Erosion with the parameters Type: Ball and Size: 5. Next, combine the two images with an OR Image operation (see Figure 12.4).
As a result of this last step, you have a label image with markers in each nuclei and the image background. You can now execute the marker-based watershed workflow on this data. First, confirm that every marker has a unique label attaching the Labeling module to the label field and setting the parameters Interpretation: 3D and Neighborhood: 26. Again, you can set auto-refresh or click Apply to execute the operation. Furthermore, you need a gradient image for the watershed algorithm. Compute this from the image data using the Image Gradient module with the parameters: Interpretation: 3D, Gradient Type: Canny Deriche. Then attach a Marker-Based Watershed computational module to the gradient image and connect the Input Label Image to the result of the labeling operation. Use the parameters Type: Catchment Basins, Interpretation: 3D, and Neighborhood: 26 (see Figure 12.5).
To improve visualization, remove the background label using a simple arithmetic operation. In this case, the background label is 1, thus a simple expression of $A-L$ in an Arithmetic module adds the background label to the exterior. The exterior has a label of 0 and at the same time relabels all labels to ensure consecutive indices. Upon visual inspection, some imperfections are detected. Use the Remove Small Spots module with parameters set to: Interpretation: 3D and Size: 20 to remove them. Use the Voxelized Rendering to visualize the results (see Figure 12.6).
To apply the workflow to the entire time series, confirm that the Auto-Refresh option is selected on every computational module. Next, attach a Process Time Series module to the initial Time Series Control module and connect its Workflow Result input port to the final result of your workflow. In this case, it is the data object resulting from the Remove Small Spots module. To confirm that we are writing the results to a destination directory of our choosing, change the path in the Result Directory port (e.g., C:/Users/Me/Desktop/Result Data). Read and write access rights must be granted.
to this directory, otherwise Amira will not be able to store the time series and the workflow will fail. Click **Apply** on the *Process Time Series* module. Amira will now apply the workflow to the entire time series. As a result, another *Time Series Control* object will appear in the Project View to access the resulting time series of label images (see Figure 12.7).
Figure 12.7: Processed Time Series Result Visualization
This concludes the tutorial on how to process a time series in Amira. The flexibility of this mechanism allows you to apply any type of workflow created in the Project View to image data. As a result, you can create custom segmentation workflows that best fit your needs for segmenting the desired structures or biological processes in the data. The resulting time series of label fields can then be used as an input to our *Object Tracking Tutorial*. 
12.2 Object Tracking Tutorial

In this tutorial, we will demonstrate how to use the object tracking tools in Amira. Currently, these tools only work in the Amira release for Microsoft Windows. The object tracking tools support the modular approach of Amira and are designed to be applied to any type of image data and objects. This modular approach to object segmentation/detection allows you to customize workflows to segment and detect any type of objects in your time series data. From the resulting time series of label images, a data object is created that serves as an input for the tracking algorithm. The resulting tracks can then be visualized, analyzed, and quantified. For the purpose of this tutorial, we will use the results from our Time Series Processing Tutorial.

Load the time series of label images resulting from the Time Series Processing Tutorial, or from the AMIRA_ROOT/data/tutorials/tracking/labels/ directory through the Load Time Series Data... entry in the File menu. In addition, load the corresponding image data. For convenience and quick access, pin the Time port of the time series of label images. To synchronize the two time series, also link the Time port of the image data with the time port of the label images by enabling the Connection Editor and dragging the link icon from the time port to the other Time Series Control object (see Figure 12.8).
Next, attach a *Localize Objects* module to the time series of label images, and connect its *Intensity Image Series* connection port to the corresponding intensity image *Time Series Control*. Click **Apply** on the *Localize Objects* compute module. This will generate a point cloud object that can be visualized using *Point Cloud View*. The points in the cloud can be colorized using associated data values. In the Figure 12.9, the frame count in combination with the *physics* colormap was used for colorization.
Once the point cloud has been successfully created, it can be used as an input data object to generate the tracks. For this, connect a Generate Tracks computational module to the point cloud. Initial creation of this module can take some time due to internal processes. Most of the default parameters are sufficient for this dataset, but in some instances, the travel distance of an object from one frame to the next is larger than the default, thus, set a Max. Radius of 25 in the Frame-to-frame linking and Gap Closing groups. Since this dataset shows a time series of dividing cells, we also need to enable Consider Only Splitting in the port Merge/Split Allowed located in the Gap Closing section. Computed tracks can then be visualized using Track View. This module also allows for colorizing parts of the visualization using computed values during track generation. Figure 12.10 shows how to colorize the segments and events using the Time Step.
Finally, the module Analyze Tracks will need to be attached to the Tracks data object to analyze and quantify the tracks. In addition to analyzing track related values such as velocity and direction, Analyze Tracks also allows measuring shape and intensity values for each individual tracked object at each time step. For this, the time series of intensity and label images will need to be attached to the Intensity Image Series and Label Image Series connections, respectively. The port Measures Group then allows picking of a group of measures that will analyze each objects. These groups can be customized similar to the module Label Analysis. The port Measures Type allows to disable/enable the desired track related measures from lists for each of the three track elements, e.g. Steps, Segments, and Tracks. After selecting the desired measures, click Apply to create another tracks data object with
additional measurements on the *Events*, *Steps*, *Segments*, and *Tracks* in which the following applies:

- **Events**: These can be events such as *Appearance*, *Disappearance*, *Merge*, or *Split*.
- **Steps**: These are the measured time points between events that do not classify as one of the events. All object related measures like intensity and shape will also appear here.
- **Segments**: A segment is the connected time points (e.g., a path between two events).
- **Tracks**: Can be either single- or multiple-connected segments that have an appearance event on one end and a disappearance event on the other end.

You can export a spreadsheet from the *Tracks* data object to Microsofts XML Spreadsheet 2003 format for further analysis in third-party tools (see Figure 12.11).

![Spreadsheet Result of Object Tracking](image)

**Figure 12.11**: Spreadsheet Result of Object Tracking

This modular approach to object tracking and the clear definition of a data object acting as an interface between segmentation/detection and tracking, enables you to design workflows for the segmentation/detection of any type of objects and track such objects over time.
Part III

Amira XNeuro Extension User’s Guide
Chapter 13

Overview

The Amira XNeuro Extension is an Amira extension dedicated to users in the area of neuroscience. The option provides a set of modules designed to analyze images of the human (or vertebrate) brain.

The Amira XNeuro Extension license enables the following modules:

- ComputePerfusion
- ComputeTensor
- ComputeTensorOutOfCore
- CreateGradientImage
- EigenvectorToColor
- ExtractEigenvalues
- FiberTracking
- TensorDisplay

13.1 Example Images

The following images were created with modules available in the Amira XNeuro Extension.
Figure 13.1: Using module *EigenvectorToColor* the eigenvectors of a diffusion weighted tensor image can be converted to a color image where the colors encode the first principal direction of the tensor field, where red refers to X-direction, green to Y-direction, and blue to Z-direction.

Figure 13.2: Tensor image from a DTI experiment visualized using module *TensorDisplay*. The parameters of the symmetric tensor are mapped onto the parameters of ellipsoids.
**Figure 13.3**: Visualizing tensors from a DTI experiment. Here the tensor is evaluated at a fixed distance from a surface and displayed as ellipsoids.

**Figure 13.4**: To identify fiber tracts the tensor image has been integrated and converted to a Line Set. The `SelectLines` module can then be used to select a subset of lines with user-defined source and destination areas.
Chapter 14

Convert to Talairach Coordinates

The Talairach or stereotaxic coordinate system of the human brain is used to describe the location of brain structures independent from individual differences in size and overall shape of the brain. The Convert to Talairach Coordinates tutorial explains how to use the ConvertTalairach script object to semi-automatically align the brain with the Talairach coordinate system. The module asks the user to define three landmarks:

- Anterior commissure
- Posterior commissure
- Superior part of midsagittal plane

These three landmarks are then used to transform the data object into the Talairach coordinate system, where the right hemisphere has positive X values, the anterior part has positive Y values, and the superior part has positive Z values; with the anterior commissure being at the origin of the coordinate system.

14.1 Convert to Talairach Coordinates Tutorial

In brain research it is often desired to describe the locations of brain structures independent from individual differences in the size and overall shape of the brain. In the Talairach coordinate system the anterior commissure and posterior commissure lie on a straight line along the y-axis. This coordinate system is completely defined by requiring the midsagittal plane to be vertical and the superior part of the brain having positive Z values. When specifying a location in the structure in 3D space, the anterior commissure is used as a reference point and origin of the coordinate system. The transformation of brain data into Talairach coordinates simplifies registration and spatial warping of image data from the brain.
The tutorial will cover the following topics:

- Load DICOM image data
- Browse through brain data using the sagittal plane
- Position landmarks on anterior and posterior commissure and on the superior part of the mid-sagittal plane
- Visualize landmark positioning
- Perform the transformation
- Resample transformed image data

### 14.1.1 Load and visualize data

- Click on Open Data... and navigate to /data/tutorials/DTI/T1-BrainOnly.
- Select all files in the T1-BrainOnly folder and click on Open.
- Start the data loading by pressing OK in the DICOM Loader dialog (Fig. 14.1).

- If an Ortho Slice module is automatically connected to your data, suppress it (left-click mouse button on module and "Suppr" key)
• Verify that the data has no unapplied transformations by making sure that the data object icon uses a non-italic font.

• Remove unapplied transformations before proceeding:
  • Select data object and open Transform Editor from the Properties area of the data object.
  • Click on the All button in the Reset port.
  • Close the Transform Editor.

• Once the data is completely loaded into the Project View, right-click on the icon labeled T1-BrainOnly and select Geometry Transforms/Talairach Alignment.

• Select the Talairach Alignment module from the Project View to show the properties of the script object.

• The slider in the Slice Number port lets you browse through the yz-slices as visualized in the 3D viewer.

• Alternatively, in interactive mode, you can pick the rendered slice and move it with the mouse to the desired location (Fig. 14.2).

14.1.2 Marking the locations of the anterior and posterior commissure and superior part of the midsagittal plane

• Using the Slice Number port position the yz-slice to show the anterior commissure.

• If not done already, switch the 3D Viewer into interactive mode.

Figure 14.2: Amira main window with the brain data loaded and visualized using the Talairach Alignment script object. The Properties area shows the ports of the selected Talairach Alignment module, and the 3D Viewer visualizes the selected yz-slice.
• Click on the button labeled AC followed by a click on the anterior commissure in the yz-slice.
• Using the Slice Number port position the yz-slice to show the posterior commissure.
• Click on the button labeled PC followed by a click on the posterior commissure in the yz-slice.
• Using the Slice Number port position the yz-slice to show a slice through the center of the superior midsagittal sinus.
• Click on the button labeled MP followed by a click on the superior midsagittal sinus in the yz-slice.
• The selected locations will be shown in the Properties area of the Talairach Alignment script object.

14.1.3 Verifying and moving landmarks

• Visualization of landmark locations for the anterior and posterior commissure or superior midsagittal plane is enabled by checking the Landmarks option in the Show port. Here, the visualization of the Slice can also be controlled.
• When enabled, the position of the landmarks is indicated by three golden spheres.
• If unsatisfied with one of the positions, just switch the 3D Viewer into interactive mode.
• Click on one of the landmark buttons in the Select port of the Convert Talairach Properties and make a new selection on the slices through the brain (Fig. 14.3).
14.1.4 Transformation into Talairach Coordinates

- Transformation into *Talairach Coordinates* is initiated by a click on the green *Apply* button of *Talairach Alignment*.
- The success of the transformation can be verified by enabling the global axis in the *Amiratopmenu*; select *View/Global Axes*.
- The sphere for the anterior commissure should be located at the origin of the coordinate system.
- The sphere for the posterior commissure should be located on the negative y-axis (green axis).
- The sphere in the superior midsagittal sinus, should be located on the positive yz-plane (blue/green axis).

14.1.5 Applying transformation and resampling data

- Once satisfied with the result, you can apply the transformation and resample data by pressing the *Apply Transform* button in the *Properties* area of *Talairach Alignment*.
- The resampled data will appear in the *Project View* with the ending *transformed*.
- It can be visualized with an *OrthoSlice* or *Volren* module for verification.
Figure 14.5: Rendering of the transformed and resampled data set using an OrthoSlice to indicate the midsagittal plane and a Volren for global orientation.
Chapter 15

Brain Mapping

15.1 Brain-to-Brain Mapping Tutorial

In brain research it is often required to report the locations of structures or lesions in terms of a standardized reference frame. In this tutorial, we want to demonstrate the steps involved in registering a patient’s brain to a reference brain. The latter will be a simulated T1 MR volume from the MNI BrainWeb page, henceforth the Reference, and the former will be an arbitrary MRI scan of a human head, henceforth the Patient. The result of the procedure is a patient brain that is registered with the reference and has the same resolution, voxel size and position in space. Each of the steps in this tutorial can be adapted to a different part of the body, another modality or species and can be easily applied to a larger number of studies.

The tutorial will cover the following topics:

- Loading raw and DICOM image data
- Manual and automatic registration in the Multiplanar Viewer
- Using the Segmentation Editor to create a brain mask
- Extracting brains from image volumes (skull stripping) with Arithmetic
- Reformatting transformed image and label data

Only one data set used in this tutorial is part of the tutorial data found in data/tutorials/BrainMap. A second data set used as reference has to be downloaded from an external web page.
15.1.1 Download reference brain data

- Navigate with your web browser to http://brainweb.bic.mni.mcgill.ca/brainweb/. Select the Normal Brain Database link, leave the default settings there and click Download. On the download page request file format "raw short (12 bit)" and no compression. Save the volume to disk.
- Write down the "MINC volume info" printed on the download page.

15.1.2 Load and visualize data

- Navigate the Amira file browser to the directory where the reference brain data set has been saved to. Select t1_icbm_normal_1mm_pn3_rf20.raws and click Open. Choose Raw Data from the dialog and enter the parameters from the "MINC volume info": Data type: 16-bit signed; Dimensions: 181, 217, 181; Endianess: little endian; Min coord: -90, -126, -72. finally, click OK (Fig. 15.1).

- In order to make the settings permanent, save the data set to disk as Amira data file.
- Load the patient data set from data/tutorials/BrainMap/DICOM. To do so, highlight all slices in the file browser, click Open and finally confirm the Dicom Loader Dialog by clicking OK.
- Launch the Multiplanar Viewer from the workroom task bar.
- Set up the reference image as Primary Data and the patient image as Overlay Data. In the 2D Settings panel use the grayScale colormap for the primary and physics.icol for the secondary data, in the 3D Settings panel use the Glow.am and volrenGreen.col colormaps, respectively. For min/max settings and rendering types refer to Fig. 15.2.

The Multiplanar Viewer workroom is designed to visualize one or two image volumes at the same time in a set of three MPR (multi planar reformat) viewers and one 3D volume rendering viewer. Please refer to the Multiplanar Viewer help page for a detailed description of the functionality of the viewer.

Here we will use the cross-hair (red, green and blue scout lines) to browse through the slices. Use the Primary/Overlay slider to blend the display from the reference to the patient image. Doing so, you will note that the patient data needs to be rotated from a prone to a supine orientation. This, and a rough alignment, will be done using the manual registration tool of the Multiplanar Viewer.

15.1.3 Manual registration in the Multiplanar Viewer

- Invoke the Registration Tool from the viewer tool bar. This draws a manipulator in the shape of a crossed double arrow in each MPR viewer.
- In the XY [Axial] viewer, move the mouse pointer over the outer third of the manipulator until the pointer turns into the rotate symbol (see Fig. 15.3).
- Rotate the image by 180 degrees.
Figure 15.1: Raw Data Parameters dialog showing the parameters to be entered to load the reference data set. With a voxel size of 1 (mm) in each direction and minimum coordinates of [-90, -126, -72] scaling and position of the reference are fixed.

Figure 15.2: Screen shot of the Multiplanar Viewer showing reference and patient data in image fusion.
Still in the XY [Axial] viewer, grab the manipulator in a more central region and translate the image for a better fit.

In the YZ [Sagittal] viewer use the rotate functionality of the manipulator to tilt the patient image by a few degrees clock-wise. Finally, use the translate functionality to center the (smaller) patient brain within the (larger) reference brain. The manually registered images should look similar to Fig. 15.4.

In general, manual registration is subjective and tedious. Thus we would like to use the automatic registration tool of the Multiplanar Viewer. However, since automatic registration uses all intensity information in an image the result of the automatic registration might be biased by non-brain tissue such as skull, fat and skin. Therefore, it is favorable to mask out non-brain regions in each image. In the next section we will extract the brain from both the reference and the patient image. This will provide us with two new data sets that we can use during automatic registration.

### 15.1.4 Creating a brain mask

The following steps demonstrate an interactive method for quickly obtaining the brain mask. Users with a valid Amira XNeuro Extension license may want to perform this automatically using module *Automatic Brain Segmentation*. They can skip this section and proceed with section 15.1.4.1.

The mask need not be absolutely correct in that it follows all gyri and sulci of the brain surface. Rather, the mask should provide a rough separation of brain and non-brain tissue.

- Clear workspace by calling *Project/Remove All Objects*.
- Load the saved copy of the reference data (voxel size and position are assumed to be correct.

---

**Figure 15.3:** Rotate tool of the manual registration tool in the *Multiplanar Viewer*
See section 15.1.2)

- Invoke the *Segmentation Editor* from the workroom task bar. The *Image Data* drop down list should display the name of the reference data. If not, select the reference data set in that drop down list.
- Click the *New* button next to the *Label Data* drop down list.
- Select a central axial slice (e.g., slice #90) and enable masking in the *Display and Masking* group of controls.
- Adjust the range slider in the *Display and Masking* group of controls such that the brain tissue represents an isolated area (e.g., 604 4095).
- Select the *Magic Wand Tool* from the Tool Box on the lower left of the application window and make sure that its *Current slice* option is checked.
- Click somewhere on the brain to select the region belonging to brain, press the f key to fill small holes and finally Ctrl+m to smooth the border of the selection.
- Proceed to slice 70 and repeat this procedure.
- Proceed to slice 50. Here you will note that the selection ”bleeds out” (selects non-brain voxels). Use the *Draw limit line* tool (shortcut ’l’) and draw lines similar as shown in Fig. 15.5. Also here, use ‘f’ to fill and Ctrl+m to smooth.
- Make a selection in one of the described methods for slices 157, 150, 130, 110, 60, 30, 20 and 13.
- Call *Interpolate* from the *Selection* menu or press Ctrl+i.
Figure 15.5: To prevent the Magic Wand tool to select non-brain voxels draw limit lines as shown in this Figure

- Make sure that the All slices radio button in the Selection group of controls is selected and click the Grow Selection button two or three times.
- Rename material "Inside" to "Brain" (double-click the name to edit) and click ‘+’ in the Selection group of controls to assign all selected voxels to material Brain. Leave material Exterior as is.
- Exit the Segmentation Editor by selecting Project workroom from the workroom task bar and save the *.Labels object as t1_icbm_normal_1mm_pn3_rf20-BrainLabels.am.
- Create also a mask for the patient data set. This time you could choose a coronal (XZ) orientation of the viewer (click the Single Viewer button once). Save the result label image as Patient-BrainLabels.am.

15.1.4.1 Creating a brain mask automatically

The following steps show how to obtain the brain mask automatically using module Automatic Brain Segmentation. Users without a valid Amira XNeuro Extension license are referred to the preceding section.

- Clear workspace by calling Project/Remove All Objects.
- Load the saved copy of the reference data (voxel size and position are assumed to be correct. See section 15.1.2)
- Right-click the green data icon in the Project View and select from Image Segmentation → Automatic Brain Segmentation.
- In the Properties of Automatic Brain Segmentation set Smoothing to 20. Click Apply.
Repeat the above steps for the patient data set that you can load from data/tutorials/BrainMap/DICOM.

As result you will have two additional data objects with the suffix *.BrainLabels in the Project View.

### 15.1.5 Extracting brain-only images

- Attach Compute→Arithmetic to the reference data set icon. Connect the InputB connection port with the *.BrainLabels object.
- In the Expr.: field of Arithmetic enter $A \times (B > 0)$ and click Apply. Attach an OrthoSlice to the Result object. The display should look similar to Fig. 15.6.
- Save Result as t1_icbm_normal_1mm_pn3_rf20-BrainOnly.am.
- Repeat the above procedure with the patient data set and save the result object to Patient-BrainOnly.am.

---

**Figure 15.6:** Central axial slice of the skull stripped reference data set
15.1.6 Automatic affine registration of the brain-only images

- Launch the Multiplanar Viewer again by selecting its icon in the workroom task bar.
- Set up Primary/Overlay Data as well as 2D/3D Settings as shown in Fig. 15.7. The colormaps used in this example are GrayScale.am / physics.icol for 2D Settings and Glow.col / volren-Green.col for the 3D Settings.
- Select the automatic registration tool from the Tool Box.
- Click the Align centers button first and then the Align principal axes button to get a rough alignment.

The Align centers and Align principal axes buttons can be used to pre-align images prior to the affine registration. Pre-alignment is crucial to a successful registration. Most failure to get a reasonable co-registration are due to a bad pre-alignment. If pre-alignment fails (e.g., the principal axis alignment selects the wrong axis) use the manual registration tool as described in Section 15.1.3.

- In addition to the Rigid check box also enable the Iso, and Aniso scale options of the registration tool. Leave the Monitor box checked to watch the registration tool while it is working.
- Press the Register button and enjoy!

15.1.7 Reformatting the patient data set to the dimensions of the reference brain

The final step in our small tutorial consists of reformatting the patient data to match the reference data set in terms of dimensions.

- Switch back to Project View by selecting the Project icon of the workroom task bar.

You will note that the label of the Patient-BrainOnly.am data icon is printed with an italic type face. This indicates that the data is transformed. Transformations in Amira actually do not alter the dimensions or voxel values of the data but only affect their display within the scene (viewer). To apply a given transformation onto the data requires resampling of the transformed data onto an axis-aligned lattice. In the case of our brain it is favorable (but not mandatory) to resample the transformed brain onto the same lattice as that of our reference data set.

- Attach module Compute→ApplyTransform to the patient brain-only data set.
- Connect the Reference connection port with your reference data set (click white square of ApplyTransform icon) and select Lanczos in port Interpolation.
- Click Apply.

The result is a new image volume that matches the reference image in terms of dimensions as well as position in space.
Figure 15.7: Data and window level settings of the *Multiplanar Viewer* for the automatic registration
15.1.8 Reformatting patient labels to the dimensions of the reference brain

If you need to report the location of some lesion or interesting structure in terms of the coordinates of the reference brain you will need to transform and reformat the label image coordinately. Since the label image was derived from the patient data set we just need to copy the registration transformation onto it to get it perfectly co-registered with the patient data set. An `ApplyTransform` will then reformat the label image to the reference coordinate system.

- Load file `data/Patient-VentriclesLabels.am`. This is a label image where the ventricles of the patient data set have been segmented.
- Open the `Transform Editor` of the transformed patient data set and click the `Copy` button. Close the `Transform Editor`.
- Open the `Transform Editor` of the label image. Click the `Paste` button. Close the `Transform Editor`.
- Attach an `ApplyTransform` module to the label image.
- Connect the `Reference` connection port of `ApplyTransform` with your reference data set.
- Click `Apply`.
- Attach a `Measure→MaterialStatistics` module to the result object and click Apply. A new data object `Patient-VentriclesLabels.MaterialStatistics` will be in the `Project View`. Press the `Show` button in the Properties of this object and read out the coordinates of the ventricles. The numbers in columns `CenterX`, `CenterY` and `CenterZ` columns should be similar to those shown in Fig. 15.8.
Chapter 16

Diffusion Tensor Imaging

Diffusion Weighted Imaging (DWI) and Diffusion Tensor Imaging (DTI) are relatively new imaging techniques that aim at identifying and visualizing structures like fiber tracts, tumors, or stroke areas in living tissue that are invisible to other image techniques. Amira provides a set of modules and scripts that let the user perform a thorough DTI analysis. The following sections explain the usage of those modules by means of tutorials using clinical data. The data sets have been kindly provided by Prof. A. Brawanski and Dr. C. Doenitz, University of Regensburg, Germany. We would like to express our gratitude for their guidance regarding the design of the Amira XNeuro Extension as well as the use of Amira in neuroscience research.

16.1 Data Preprocessing Tutorial

Diffusion weighted imaging is a relatively new imaging technique. Therefore, no standard has yet been established regarding the way image data and metainformation are stored. In this section we give advice on how to deal with certain special cases.

In general, the data in question consists of multiple volumes obtained from an MR scanner. An anatomical stack helps with identifying areas of interest like tumors, white matter, or lesions whereas gradient weighted image stacks contain information about water diffusion in the tissue.

Some of the image stacks will have a noticeably larger data range and contrast. These images are the B0 volumes generated without an additional magnetic gradient in the scanner. They are used for normalization during the process of tensor creation. In general it is advisable to use several scans for each B0 and gradient volume. All duplicate gradient files should be registered with each other and averaged, which reduces the influence of noise.

This tutorial will cover the following topics:

- Common file formats for DTI processing.
• How to convert DICOM mosaic images.
• Registering DTI data to an anatomical reference image.
• Averaging multiple images to reduce noise.
• Resampling to anatomical data resolution.

16.1.1 Automated registration and averaging

For registration and averaging Amira provides a script object that can be used to automatically process a large number of files. The script works well for the data in this tutorial but other data sets might require adjustments. Due to the amount of registration and alignment the script requires a substantial amount of processing time (about 20 minutes). The workflow performed by the script is described in detail below. If you wish to avoid the long processing time, load the resulting volume data from the data/tutorials/DTI/gradients-am/ directory.

Here are the steps in order to run the script on the DICOM data provided with this tutorial:

• Load the script share/script-objects/ AverageRegisterGradientsHighRes.scro.
• Use the Browse button of port DICOM and add the files in data/tutorials/DTI/gradients-dcm/* to the list.
• Use the Browse button in port Gradient list and point it to the gradient file in data/tutorials/DTI/gradients.txt. This file contains in each line three numbers that are the components of the gradient direction vector. The B0 volumes are encoded with three zeros.
• Use the Browse button in port Anatomical and add the 160 files in data/tutorials/DTI/T1-BrainOnly/.
• Press the Apply button. The script will identify the files by the gradients listed in gradients.txt and sort them into groups that share the same gradient. In each group the volumes are first registered with the T1 and afterwards resampled to its resolution. For each group one volume is produced in the Project View that represents the registered and resampled gradient weighted image.

The following sections explain the reasoning behind the above script but they are not essential to the general workflow of this tutorial. Readers can advance to section Diffusion Tensor Tutorial.

16.1.2 Common file formats

DICOM is a standard for medical images that describes how data and meta-information is stored and exchanged between DICOM-aware entities. Amira supports the slice-based DICOM format (uncompressed) and DICOM Send protocol.

Alternatives to the DICOM file format for DTI image analysis are Nifti, Analyze (restricted, since it does not support transformations), and Amira. But in general any image format that correctly stores
voxel size, bounding box information, and the transformation of image data will work.

16.1.3 Registration using the MPR viewer

If multiple volumes have been acquired for B0 and for each gradient direction, it is advantageous to average them in order to reduce image noise. Since images are acquired over time and with different gradients, MR reconstruction artifacts are likely to occur. Registration helps to lessen the impact of these artifacts and improves the quality of the diffusion weighted image analysis. Amira supports the automatic affine registration of multiple modalities.

The gradient weighted images can be either registered to a B0 image or to an anatomical image stack. The B0 images are usually stored together with the gradient weighted images and are obtained without an additional magnetic gradient. They are therefore less susceptible to the distortions caused by strong gradients. B0 images can be identified by a zero gradient direction and are characterized by a data range that is typically much larger than that of their counterpart gradient images.

Anatomical image data, such as a T1 and T2 volumes, have a higher spatial resolution, less distortion, and show structures that are not visible in the diffusion weighted images. The diffusion weighted images in turn show structures not visible in the anatomical scans. Fusing the data of the anatomical image and the diffusion weighted images combines the strength of both image modalities and results in a superior analysis. Note, however, that if you decide to use a T1 scan as reference you should make sure that both T1 (T2) and DWI scans have been performed in the same scanner and that the patient has not changed its position. Otherwise, the gradient directions will no longer be correct.

The strategy for the registration should be as follows: select a master volume and register all volumes to the master volume. We will continue this tutorial with the T1 volume in the role of the master volume.

Automatic registration will only work if the T1 volume shows similar structures compared to the B0 and gradient weighted volumes. Therefore, the T1 volume, which shows the complete head and neck of the patient, has to be processed to only contain the brain (skull stripping). For this tutorial this has been done already and the images in data/tutorials/DTI/T1-BrainOnly/ contain only the brain without the skull. To repeat the process please see the section about brain stripping in the Brain-to-Brain Mapping tutorial.

A convenient tool in Amira that supports affine registration is the Multiplanar Viewer. All B0 and gradient scans need to be present in the Project View for this step.

- Load the data from data/tutorials/DTI/gradients-dcm/.

This should result in 39 new objects in the Project View corresponding to 39 image stacks of 128 x 128 x 49 voxels. If you select their icons in the Project View and read out the values of port Info, you will note that three of them have a considerable larger data range (0 ... 4095) than the others (0 ... 1000). A deeper investigation of the data will reveal that the former correspond to 3 separate scans of a B0 image (no gradientfiled present) while the remaining 36 stacks correspond to 3 repetitions of measurements with 12 different gradient fields superimposed.
• Load the T1 image data from data/tutorials/DTI/T1-BrainOnly/ and remember its icon name (T1-BrainOnly).
• Open the Multiplanar Viewer by clicking the icon in the workroom task bar.
• Select the master volume in the Primary Data drop down menu and choose a second volume in the Overlay Data drop down menu.
• Select the Automatic Registration tool from the Tool Box at the bottom of the project view and press Align centers. This should provide an initial registration based on the bounding box centers of the two volumes.
• In the Tool Box at the bottom of the project view check the Rigid, Iso, Aniso-Scale, and Shear check boxes in the Transform port. The correction for shear is especially important if gradient weighted images are to be registered. Keep the default setting for the metric (Euclidean) and perform the registration using the button Register.
• Check the result for a sufficient overlap. If automatic registration fails, manual registration can be performed using the manual registration tool from the viewer tool bar.
• Repeat the above process with the next gradient weighted image as Overlay image until all volumes have been registered.

![Multi Planar Viewer showing anatomical data set and the B0 image in fusion mode. Both data sets are registered using the parameters as displayed.](image)

Figure 16.1: Multi Planar Viewer showing anatomical data set and the B0 image in fusion mode. Both data sets are registered using the parameters as displayed.

At the end of this procedure all images should be registered with the master volume. The registration for each volume is stored as a $4 \times 4$ transformation matrix. After the registration, any two data sets can be displayed as primary and overlay data in the MPR viewer and be displayed correctly relative to each other.
16.1.4 Averaging multiple images to reduce noise

The images generated in the above section are registered to the master volume – usually the anatomical volume – and should therefore also be registered with each other. Averaging volumes obtained with the same gradient direction will now be performed to reduce noise in the data.

- Connect Compute → Arithmetic to the first volume.
- Connect the second and third volume to the input ports InputB and InputC of Arithmetic.
- Enter as expression into the Expr port of Arithmetic (A+B+C)/3, which computes the average intensity for each voxel and stores the results as a new volume.

If more than three volumes need to be averaged, the procedure must be done in several steps because Arithmetic only provides a maximum of three input ports. Merge two data fields using Arithmetic with the expression A+B. Attach a new Arithmetic module to the result and connect as second input the third data set. Again use the expression A+B and repeat the procedure with more data sets to sum the intensities for each voxel. It is important to use a data type like short or integer for this summation if many volumes need to be averaged. This will ensure that the sum of all intensities per voxel is still a number that can be represented with the data type. The last step is to use another Arithmetic module and to divide the intensities of the last result data set by the number of volumes used during averaging.

16.1.5 Resampling to anatomical data resolution

As a last step the data can be resampled to the resolution of the anatomical scan. The resolution is the number of voxel in each of the three spatial directions. This is done to allow a segmentation to be shared between the anatomical and the gradient weighted images and switching between the final
images in the Segmentation Editor will not change the label image. This procedure will also increase
the density of generated line sets during fiber tracking and therefore produce denser fiber bundles.

We will assume that the volumes are already registered with each other.

- Identify the lower resolution volume that needs to be resampled.
- Connect a Compute→Resample module to the lower resolution volume.
- Identify the volume that is used as a master volume, usually the anatomical volume with the
  highest resolution.
- Connect the anatomical volume to the Reference port of Resample.
- In the Mode port of Resample, select the Reference option to produce a new data set that matches
  in dimensions and bounding box the anatomical volume. Keep the default filter setting (Lanczos)
  and press Apply.

The resulting data set should now match the anatomical volume in voxel size and dimension.

16.2 Diffusion Tensor Tutorial

The tutorial will cover the following topics:

- Loading image data.
- Tensor calculation using ComputeTensor.
- Computing derived measures such as directionally encoded colors (DEC) and fractional
  anisotropy (FA).

Note that the tutorial is rather demanding with respect to memory usage so that some steps may fail
or become slow on 32-bit systems. It is recommended, therefore, to conduct this tutorial on a 64-bit
workstation with sufficient physical memory installed.

16.2.1 Loading image data

The image data used in this tutorial has been pre-processed using the techniques described in the Data
Preprocessing tutorial which includes registration to an anatomical master volume and averaging of
scans sharing the same magnetic diffusion gradient for noise reduction.

All diffusion derived measures such as directionally encoded colors and fiber tracking are derived from
the tensor field, which in turn is computed from the set of gradient weighted images. These images
are produced by the MR scanner and can be imported into Amira using the DICOM file format. The
minimum number of volumes for a diffusion analysis is 7 (one B0 volume and 6 gradient volumes)
but Amira supports an arbitrary number of diffusion weighted gradient volumes. A larger number of
gradients will result in less noise and better angular resolution of the resulting tensor field.

Diffusion Tensor Tutorial
• Load all Amira data files from the directory data/tutorials/DTI/gradients-am/. There will be one object B0.am in the Project View and 12 objects labeled gradient.*.

If you encounter the Out-of-Core Data dialog box during import, select the option Read complete volume into memory.

16.2.2 Tensor computation

• Connect a Compute→Compute Tensor module to the B0 data.
• Select all gradient data objects in the Project View (use the Ctrl+a keyboard shortcut) and click the Attach selected data button of ComputeTensor. This will attach all gradient images with the ComputeTensor module. Since the gradient vectors have been stored within the image files, ports G1 through G12 will have their text fields automatically filled with the correct gradient directions.
• Set the diffusion weighting factor to 1000. This value will scale the diffusivity of the tensor field in a linear way that does not influence the shape of the tensors generated.
• Pressing the Apply button creates a new data object in the Project View labeled B0.t tensor.

The correct gradient directions are essential for the computation of a valid tensor field. ComputeTensor can automatically extract gradient directions from some DICOM tags but many vendors do not store gradient directions in the header or Amira is not able to extract them correctly. In this case, the gradient directions for ComputeTensor need to be provided as a text file. In the case of one B0 volume and 12 gradient weighted images the file should contain 12 lines and for each line the three components of the gradient direction. Here an example:

```
0.35671 -0.360555 -0.85557
0.35671 -0.363318 0.85790
...
```

ComputeTensor will assume that the first connected volume is the B0 volume for which no gradient direction needs to be supplied.

In order to check if a set of gradient directions are correct both the directionally encoded color images created by Compute→Eigenvector to Color and the fiber tracts in a major bundle need to be checked. An example visualization for this check is provided in figure 16.3. In order to re-create this visualization follow this tutorial and the tutorial on fiber tracking.

It is common that gradient directions have to be corrected by the patient position in the scanner. This is done by changing the sign of one or more of the three components of the gradient vector, e.g., the y-component of the vector needs to point in the opposite direction. If the fibers do not follow the major tracts visible in the DEC image, use the interface of ComputeTensor to edit the components one-by-one or change the text file that stores the gradient directions and read them back into ComputeTensor.
Figure 16.3: Fiber tracking performed to check the correctness of the gradient directions. The image on the left panel shows fibers correctly curving up in the frontal part of the brain, while in the image on the right panel they do not reach out to the forebrain area. The right image has been created by deliberately inverting the y-component of all gradient directions. While the DEC image of both tensors is identical the resulting putative fiber tracts can be incorrect.

The generated tensor field has six components that encode the upper triangular part of the symmetric second order tensor field (indices are stored in row order 11, 12, 13, 22, 23, 33). Such a tensor field can be created from a number of imported scalar or vector fields using the *Compute→Arithmetic* module. In the simplest configuration six scalar fields need to be combined into two vector fields by using two Arithmetic modules. The resulting two vector fields can be combined into a symmetric second order tensor field by using a third Arithmetic module connected to both vector fields. In order to clean up the *Project View*, the gradient images can be removed after creating the tensor field.

- Select all gradient (gradient.*) data objects in the *Project View* and select *Project→Remove Object* from the main menu. Alternatively select *Project→Hide Object* to hide them.

The B0 volume should remain in the *Project View* as it is needed in the following step.

### 16.2.3 Tensor visualization

In order to focus on brain areas of interest it is necessary to create a brain mask. The mask is a label image with brain voxels assigned to a foreground material (i.e., value greater than 0) while non-brain voxels are assigned to the Exterior material (value 0). The mask can be created with a simple threshold operation in the Segmentation Editor. Because all the data sets are registered and resampled to the same frame of reference as defined by the anatomical scan (see *Data Preprocessing* tutorial) we can use any of our data sets to create the mask. Using the B0 volume for this step renders the operation trivial as the brain is greatly enhanced in this type of scan.

- Right-click *B0.am* and select *Image Segmentation→Edit New Label Field*. This creates a label image object and automatically opens the *Segmentation Editor*.

- From the Tool Box in the lower part of the project view select the *threshold tool*. This automatically turns on *Masking*, a semi-transparent blue overlay in the viewer that serves as a visual guide.
control for the current settings in the range slider control right underneath.

- Set minimum and maximum of the range sliders to 124 and 4034, respectively, and press the Select button of the threshold tool. Make sure the All slices option is checked.

- From the main menu call Selection→Smooth→All slices. This operation will remove isolated pixels representing background noise from the selection.

- Select Inside from the Materials list and click add (+) from the Selection group of controls.

- Save the label image as B0-BrainLabels.am to your hard drive. This will change the name of the object in the Project View accordingly.

16.2.3.1 TensorDisplay

It has shown convenient to visualize tensor fields using glyphs. Glyphs are simple parametreizable shapes that allow mapping the components of the tensor in a direct way and thus provide a visualization of the information contained in the local tensor. Glyphs like ellipsoids are elongated in directions where the measured diffusion is large compared to other directions. If the glyph is shaped like a sphere, the diffusion is isotropic, as, for example, in the water-filled ventricles. Small glyphs represent low overall diffusion.

- Right-click the tensor field icon and select Display→Tensor View.

- Connect the Mask input port with the B0-BrainLabels.am object.

- Set u and v of port Resolution to 128. Using a larger resolution or a larger scale value will produce a larger density of the glyphs.

- Click Apply.

The generated display shows the water diffusion in the non-Exterior regions of the data set for a single axial slice. The connected Clipping Plane module can be selected and used to adjust the displayed image plane. The module also contains a rotate checkbox that allows for arbitrary rotations of the image plane. After selecting Apply TensorDisplay will sample the tensor field at regular intervals and display the tensor information based on a trilinear interpolation of the components of the underlying tensor field.

TensorDisplay provides a rich interface to select different glyph types and to adjust the size and complexity of the glyphs. By default, the glyphs are scaled by the fractional anisotropy, which will enlarge ellipsoids and scale down spheres, i.e., areas with no directional preference. Due to the amount of geometry generated the visualization can quickly become demanding on the resources of the machine. Work with reduced complexity settings and a lower number of glyphs to improve the performance.

16.2.3.2 TensorDisplay on surface

TensorDisplay can also be connected to a surface to visualize the diffusion close to some structure. An offset value is used to define the distance away from the surface in positive and negative direction of the local surface normal at which the tensors are sampled.
• Load file `data/tutorials/DTI/tumor.surf` into the Project View.
• Connect the Surface input port of Tensor View with the `tumor.surf` object.
• Set the Offset port of Tensor View to a value of 1.0. Click Apply.

The generated display shows the ellipsoids in the vicinity of the tumor.

16.2.3.3 Visualize tensors as directionally encoded colors (DEC)

Directionally encoded colors provide an efficient method to visualize the directions of the major fiber bundles in the brain. With this technique voxels are assigned a red color if the major direction of diffusion is along the X-axis, green if it is along the Y-axis, and blue if it is along Z-axis. In Amira the colorization is weighted by the fractional anisotropy (FA) in order to emphasize fiber bundles over noisy regions. In order to arrive at a DEC image we need to first compute an eigenvalue decomposition of the tensor field, which produces the eigenvalues and eigenvectors required to compute the DEC image.

• Connect the module Compute→ExtractEigenvalues to the tensor field.
• Connect the Mask connection port of ExtractEigenvalues with the `B0-Brainlabels.am` object. This will prevent eigenvalues from being computed in areas that are outside the brain and defined by noise only.
• Press the Apply button and four new volumes are created. Three volumes (`B0._evec1`, `B0._evec2`, and `B0._evec3`) are vector fields that represent the first, or principal eigenvector direction, and the second and third eigenvectors. The fourth field (`B0._evals`) contains the eigenvalues for each of the three eigenvectors sorted by size.
• Connect a Compute→ Eigenvector to Color module to the `B0._evec1` object. The module will automatically create a second connection to the eigenvalues field.
• Connect the Mask input port of Eigenvector to Color with the `B0-Brainlabels.am object and click Apply.
• The resulting color field data object can be visualized using Display→OrthoSlice and should look similar to figure 16.3 left but without the fiber bundles.

The Eigenvector to Color module will scale the brightness of the colors generated by the fractional anisotropy. This will make major fiber bundles stand out more in the generated image. The Exposure setting can be used to enhance the overall brightness of the generated colors.

16.2.3.4 Apparent Diffusion Coefficient (ADC) and other scalar measures

The apparent diffusion coefficient is a scalar measure that indicates areas where the diffusion is directed. These regions usually correspond to major fiber bundles.

• Connect a Compute→Arithmetic module to the `B0._evals` field.
• Set Result channels to 1 value (scalar).
• Enable the check box *ignore errors* to allow the computation even if some voxel result in an error due to division by zero.

• Use the following expression to compute the ADC values as the sum of the eigenvalues for each voxel: \( Ax + Ay + Az \).

• Press *Apply*.

Many more scalar values useful for the evaluation of diffusion weighted images can be computed from the eigenvalues in a similar fashion. Here is a list of the expressions that need to be entered in the *Expr* port of *Arithmetic*. For all these computations *Arithmetic* needs to be connected to the B0.evals field.

• **Relative anisotropy:** \( \frac{1}{\sqrt{2}} \sqrt{\frac{(Ax-Ay) \cdot (Ax-Ay) + (Ay-Az) \cdot (Ay-Az) + (Ax-Az) \cdot (Ax-Az)}{(Ax+Ay+Az)}} \).

• **Fractional anisotropy:** \( \frac{1}{\sqrt{2}} \sqrt{\frac{(Ax-Ay) \cdot (Ax-Ay) + (Ay-Az) \cdot (Ay-Az) + (Ax-Az) \cdot (Ax-Az)}{(Ax \cdot Ax) + (Ay \cdot Ay) + (Az \cdot Az)}} \).

• **Deviation from sphericity:** \( \frac{(Ax+Ay-2*Az)}{(Ax+Ay+Az)} \).

• **Linear measure:** \( \frac{(Ax-Ay)}{\sqrt{(Ax \cdot Ax) + (Ay \cdot Ay) + (Az \cdot Az)}} \).

• **Planar measure:** \( \frac{2*(Ay-Az)}{\sqrt{(Ax \cdot Ax) + (Ay \cdot Ay) + (Az \cdot Az)}} \).

• **Spherical measure:** \( \frac{3*Az}{\sqrt{(Ax \cdot Ax) + (Ay \cdot Ay) + (Az \cdot Az)}} \).

The relative and fractional anisotropy values can also be computed directly from the tensor field without an eigenvalue decomposition. In this case, the expressions for Arithmetic are:

• **Relative anisotropy:** \( \sqrt{(Arx \cdot Arx + 2*Arz \cdot Arz + Aix \cdot Aix + 2*Aiy \cdot Aiy + Aiz \cdot Aiz)} \).

• **Fractional anisotropy:** \( Arx + Aiy + Aiz \).

In order to visualize the resulting scalar fields attach a *Display→OrthoSlice* module to the output of *Arithmetic*.

### 16.3 Fiber Tracking Tutorial

This tutorial gives step-by-step instructions on fiber tracking in Amira. The tutorial assumes that the user is familiar with generating a tensor field (see tutorials on *data pre-processing* and *tensor computation*). Alternatively, an analytic tensor field generated by *AnalyticTensorField* can be sampled by *ArithmeticTensor* and used for large parts of this tutorial.

**Note** that the tutorial is rather demanding with respect to memory usage so that some steps may fail or become slow on 32-bit systems. It is recommended, therefore, to conduct this tutorial on a 64-bit workstation with sufficient physical memory installed.

The tutorial will cover the following topics:

• Perform fiber tracking,
Separate fibers into fiber bundles.

16.3.1 Perform fiber tracking

Fiber tracking visualizes restricted water diffusion and correlates well with axonal fiber tracts in the white matter. Instead of displaying glyphs or color values for each voxel, an integration starting at seed voxel locations provides a more direct comparison with tracts seen in the brain. It has to be stressed that there is no direct comparison of the fibers generated by fiber tracking with the axonal fiber bundles in the brain. The measurement resolution of the MR scans is much too low to allow any direct display of single fibers. Also, we do not measure the tracts directly but just an effect that these structures have on water diffusion. Nevertheless, fiber tracking has proven to be a valuable tool for accessing the major connection pathways in the brain. Note, however, that especially in cases with tumors like the one provided with this tutorial, care has to be taken in interpreting the data. This is because tumor oedema might disturb diffusion and thus might erroneously indicate fiber-free regions.

We start by generating the tensor with a script:

- Load the script data/tutorials/DTI/FiberTracking_start.hx.

This creates the tensor field from the existing files in the tutorial directory. A detailed tutorial on how to create the tensor from the gradient weighted images is given in Tensor Computation.

- Connect the module ExtractEigenvalues to the tensor field.
- Load the brain mask that comes with the tutorial data from data/tutorials/DTI/T1-BrainLabels.am.
- To prevent eigenvalues from being computed in areas that are outside the brain and defined by noise only, connect the Mask connection port of ExtractEigenvalues with the T1-BrainLabels.am object.
- Press the Apply button and four new volumes are created. Three volumes (B0.evec1, B0.evec2 and B0.evec3) are vector fields that represent the first, or principal eigenvector direction, the second and third eigenvectors, respectively. The fourth field (B0.evals) contains the eigenvalues for each of the three eigenvectors sorted by size.

The eigenvalue decomposition is a step that converts the tensor information into a more manageable format. The vector of the first eigenvector points in the direction of largest elongation of the tensor as displayed by TensorDisplay. The corresponding first eigenvalue encodes the strength of the diffusion in that direction.

The process of fiber tracking is done in two parts. First a set of fibers is created, usually at a density high enough so that regions of interest are represented sufficiently well. In a second step the fibers are pruned. In this way a single fiber tract like the pyramidal tract can be followed through the brain and is not obstructed by competing fiber bundles.

Fiber tracking is performed by module FiberTacking that needs to be connected to the first princi-
pal eigenvector generated from the tensor field ($B0_{-evec1}$) by ExtractEigenvalues. The module will connect on its own to the field which contains the eigenvalues based on the name of the connected eigenvector field. In order to work, FiberTracking needs an additional input label image.

The connection to the Mask connection port is required and ensures that no fibers are generated outside the brain. The mask also directs the generation of seed point which are the voxels at which fiber lines start.

- Connect the Fibertracking module to the principal eigenvector field ($B0_{-evec1}$).
- Connect the mask image B0-Brainlabels.am to the Mask connection port of the Fibertracking module.

Module FiberTracking provides three algorithms that can improve the tracking in case of noise in the data. The optional fiber tracking algorithm tensor deflection is used, if together with the eigenvectors and eigenvalues also a tensor field is connected to FiberTracking (connection port Tensor). The two ports Tensor weight g and Tensor weight f control the influence of streamline fiber tracking and tensor deflection on the resulting fibers.

This type of fiber tracking provides a smoothing effect that can degrade high curvature fiber tracts and has therefore to be used with care. In areas with crossing or touching fiber bundles, tensor deflection can be used as a means of supporting continuation of the fiber direction. In general, simple streamline fiber tracking is sufficient to extract a representation of major fiber tracts.

- Change the default F A Seed threshold of FiberTracking to a value of 0.2. The fractional anisotropy is a measure of the directional specificity, which is larger inside fiber bundles. Small fiber tracts will have lower values due to partial volume effects so a reduction in the threshold value will allow more seed points and therefore more fibers to be placed in the areas of interest.
- Change the default F A Step threshold to a value of 0.1. Fibers are traced from their seed point located in the start region until a voxel is reached with a fractional anisotropy that is smaller than this threshold.
- Press the Apply button.
- Select No in the dialog box presented to prevent the Brain label from being used as a seed area. Fibers for smaller regions of interest are computed automatically and put into the Project View.

For larger areas the fiber tracking module will present a dialog box and ask the user if the region should be used as a seed region. Small regions like the corpus callosum or seed regions in the brain stem will automatically result in one line set per material. Fibers are started in their seed regions but traced in all non-Exterior regions, which makes it essential that the brain mask contain the whole brain.

FiberTracking will create LineSet objects for each label in the connected Mask data set. They represent fiber bundles for the materials BS1 and BS2. These regions are close to the brain stem and contain ascending fibers. Some of them reach up through the pyramidal tract into the motor cortex.

Each line contains additional data values for each vertex. The first value is the local fractional anisotropy, the next values are the three local eigenvalues and a time stamp generated during the
integration in the tensor field.

The line sets can be displayed using LineSetView or DisplayISL (the latter requires an Amira XMESH Extension license). These modules are fast enough to render larger numbers of fibers.

### 16.3.2 Separate Fibers into Fiber Bundles

In order to remove fibers that are not required, the SelectLines module is used. But before we start using the module, we need to create a display that shows the structures that we are interested in. This will help with the navigation required to extract individual fiber bundles.

- Load the surface representation of the mask label image from data/tutorials/DTI/T1-BrainLabels.surf.
- Connect a SurfaceView module to the surface object and select in the Materials port All All. Press the Add button. Now also inside triangles are displayed.
- Set the Draw Style port of SurfaceView to transparent.
- Connect a LineSetView module to the LineSet_BS2 object.

The brain surface, the tumor, the corpus callosum, and the two brainstem areas are visible together with line sets that represent the fibers initiating from the right side of the brainstem.

- Connect SelectLines to the LineSet_BS2. A SelectROI module will be automatically connected to the line set and to the SelectLines module.
- Adjust the location of the SelectROI dragger box by selecting the green handles in the viewer in interactive (arrow) mode.
- Press the Apply button and a new line set object is created which contains only fibers that touch the defined region of interest.

SelectROI is used to adjust the location of the end region. A second or third SelectROI can be created for the line set and connected to the additional input connections of SelectLines. The filtering is provided by SelectLines in a way that its output will only display fibers that have vertices that are inside all of the regions of interest. By adjusting the position and size of the regions of interest a subset of fibers is created as output line set. It is convenient to use the auto-refresh checkbox of SelectLines to be able to visualize fibers while moving the SelectROI.

SelectLines also allows the user to mask lines based on the values attached to the vertices or by an additional label image.

### 16.3.3 Create a label image from a line set

In some cases, it is beneficial to be able to create a label image from the generated line sets. The label image can be used to create a surface representation of the fiber bundle or to export a data set that
overlays the fiber bundle with the anatomical data. The FiberTracking module contains a convenient Tcl command that generates such a label image.

- Make sure that a FiberTracking module is available in the Project View together with the line set that needs to be converted into a label image.
- Enter the following command into the Amira console window:  
  \[ \text{FiberTracking createLabelField LineSet BS2 100 100 100} \]

This will create a new label image with the dimensions $100 \times 100 \times 100$ that contains for each vertex of the line set object the value 1 against a uniform background with the value 0.
Chapter 17

Brain Perfusion

17.1 Brain Perfusion

Another type of imaging analysis provided in the Amira XNeuro Extension is perfusion weighted MRI or CT image analysis. The modules provided compute the mean transit time (MTT), cerebral blood flow (CBF), and cerebral blood volume (CBV) from a user-supplied perfusion weighted time series. The time series captures the volume of the tissue for about 1 minute providing a view on the arrival, distribution, and wash-out of a blood contrast agent administered during the scan.

The algorithm provided by Amira computes the quantitative flow and volume values from the time series based on a block-circular singular value decomposition. The algorithms provides a correction for differences in arrival times of the contrast agent.
17.2 Brain Perfusion Tutorial

This tutorial describes how to perform a brain perfusion analysis with Amira. Brain perfusion is a standard diagnostic method to obtain quantitative measures of the blood flow in the brain. This technique is usually applied to detect strokes but can be equally applied to time dependent scans of other tissue.

Blood arrives in the brain by major arteries carrying oxygen, glucose, and other substances important for the functioning of brain tissue. The blood reaches the cells through a dense capillary network and leaves the brain again via large veins. Any disturbance of the blood flow can lead to neurological dysfunction or, in extreme cases like a stroke, to cell death. Brain perfusion imaging is used to help answer questions about when to intervene with a surgical procedure and what tissue is at risk.

This tutorial will cover the following steps:

- Load the perfusion time series and create a mask.
- Extract an arterial input function and a venous output function.
- Compute the mean transit time, the cerebral blood volume, and the cerebral blood flow.

17.2.1 Load the perfusion time series

During a perfusion scan the patient brain is continuously imaged for about 1 minute using either a CT or MR scanner. A contrast agent is administered and after a couple of seconds, the arrival of the contrast agent in the brain is visible by a change in contrast.
- From the Amira main menu select File/Open Time Series Data.
- In the *Load Time Series Data* dialog select all files in directory `data/tutorials/Perfusion`. Select the *Open* button to load them into the Amira workspace.

The first volume of the time series is loaded together with a *TimeSeriesControl* module. The *TimeSeriesControl* module lets the user select a particular time step using its *Time* slider.

Each volume consists of two slices only. This is considered normal for a CT perfusion scan because, due to the slow speed of the scanner, a continued scan of the patient brain can only be done for a small number of slices.

- Attach a *Display→OrthoSlice* module to the green data icon if auto-display feature doesn’t make it for you (see preferences).
- Move the *Time* slider in *TimeSeriesControl* and observe how the image intensity in the middle cerebral artery reaches a maximum at time step 18. Afterwards the contrast agent is washed out of the brain again and the image intensity drops to its initial level.

### 17.2.2 Create a mask

The area of interest for the analysis is the brain tissue that is supplied by the capillary network. Together with the major blood vessels its brightness first increases and later decreases over time. Perfusion analysis will help us to obtain qualitative and quantitative measurements for this process.

In order to restrict the analysis to the brain region of interest a brain mask needs to be created.

- Select the first time step by setting the *Time* slider in *TimeSeriesControl* to 0.
- Right-click the *LEWIS-ANON-TOOD-1.am* data icon and select from *Image Segmentation→Edit New Label Field*. This opens the Segmentation Editor.
- In the *Display and Masking* histogram slider set a range of 0 to 120. This range selects the soft-tissue for a CT data scaled in Hounsfield units.
- Use the Magic Wand tool to select the brain tissue in slice 1 and 2.
- Assign the selections to the *Inside* material by clicking the (+) button in the *Selection* section on the left side of the Segmentation Editor interface.
- Exit the Segmentation Editor by clicking the *Project* button of the workroom task bar.

### 17.2.3 Extract an arterial and a venous output function

The perfusion analysis is performed by the compute module *Perfusion Analysis* that can be accessed through the right-click menu of a *TimeSeriesControl*.

- Right-click the *TimeSeriesControl* module and select *Compute→Perfusion Analysis*. 

*Brain Perfusion Tutorial* 630
• Connect the Mask connection port of Perfusion Analysis with the generated label image. Perfusion Analysis needs to know how much blood arrives in the brain over time. An approximation of the total inflow of blood can be obtained from the time-intensity function of one of the feeding arteries of the brain. A common choice for this is the middle cerebral artery (MCA), which is visible in the medial frontal part of the slice displayed by OrthoSlice.

• Set the Time slider in TimeSeriesControl to 18. This should display a phase with close to maximal intensity in the MCA.
• Click the Select AIF button in the Properties of Perfusion Analysis to place the location of the arterial input function.
• In the viewer, change from Trackball to Interact navigation by selecting the arrow icon in the viewer tool bar.
• With the middle mouse button click onto a point on the slice corresponding to the MCA.

Perfusion Analysis will create a spreadsheet object that is connected with a PlotSpreadSheet module. The time-intensity curve is displayed in a 2D overlay on the 3D viewer.
• Click the Select VOF button first and then click with the middle mouse button onto a point on the slice corresponding to the superior sagittal sinus which is a large vein in the back of the head.

The time-intensity function sampled at the new location is added to the plot. Since the vein is considerably larger than the artery, smaller partial volume effects result in a greater overall intensity. The shape of the curve, however, should be similar to that of the arterial input function but with delayed onset. For a correct placement of the arterial and venous functions refer to Figure 17.2.

• Click Apply in Perfusion Analysis to generate 3 maps corresponding to the mean transit time (MTT), the cerebral blood volume (CBV), and the cerebral blood flow (CBF).

The results may be visualized with an OrthoSlice module using the perfusion.cmap colormap. If necessary, load the colormap using Edit (button of port Colormap) → Options → Load colormap ... in directory data/colormaps/. The following figures demonstrate how the maps should look like.
Figure 17.3: Mean Transit Time (MTT) map
Figure 17.4: Cerebral Blood Volume (CBV) map
Figure 17.5: Cerebral Blood Flow (CBF) map
Part IV

Amira XPand Extension User’s Guide
Chapter 18

Amira XPand Extension

This document describes how to develop custom extensions for the Amira visualization system. Such extensions may include file read and write routines, new visualization modules, data objects and other components. In order to be able to develop custom extensions, you will need the developer extension for Amira, called Amira XPand Extension for short. In addition, you will need a C++ development environment like Microsoft Visual Studio on Windows (for details see subsection 18.1.2).

To understand the document, you need some basic know-how in C++ programming. Also, you should be already familiar with the standard Amira system. If you do not know Amira yet, we recommend that you go through the tutorials in the Amira User’s Guide.

Amira is based on a number of external libraries, such as Open Inventor, OpenGL, Qt, and Tcl. This document does not provide a documentation for these libraries. It merely gives some basic hints where it is needed to understand the examples. In general, this will be sufficient to write your own standard I/O routines and Amira modules. For details, we refer to the original documentation of the external libraries.

- Introduction, including a quick start guide and upgrade information
- The Development Wizard, a tool for facilitating development tasks
- File IO, describing how to write read and write routines
- Writing Modules, covering compute and display modules
- Data Classes, how to use them and how to derive from them
- Documenting Modules and integration into the user’s guide
- Documentation Markup Language, available in the online documentation, describing all commands that can be used when documenting Amira resources
- Miscellaneous, resource file summary, saving Amira projects, and more.
18.1 Introduction to Amira XPand Extension

Amira XPand Extension allows you to add to Amira new components such as file read or write routines, modules for visualizing data or modules for processing data. New module classes and new data classes can be defined as subclasses of existing ones.

Note that it is not possible (or possible only to a very limited extent) to change or modify existing modules or parts of Amira’s graphical user interface.

In the following sections we

- present an overview of Amira XPand Extension,
- discuss the system requirements for the different platforms,
- outline the structure of the Amira file tree,
- show how to compile the example package in a quick start tutorial,
- provide additional hints on compiling and debugging,
- and mention how to upgrade and maintain existing code.

Note: an Amira project is actually a set of interconnected modules and data objects. In Amira XPand Extension programming interface, the Amira project is often referred as the network or module network, or the object pool. The pool also refers to Amira Project View, more specifically the Project Graph View.

18.1.1 Overview of Amira XPand Extension

Amira XPand Extension is an extension to the ordinary Amira version. In addition to the files contained in the ordinary version, the developer version essentially provides all C++ header files needed to compile custom extensions.

18.1.1.1 Packages and Shared Objects

Amira is an object-oriented software system. Besides the core components like the graphical user interface or the 3D viewers, it contains a large number of data objects, modules, readers and writers. Data objects and modules are C++ classes, readers and writers are C++ functions.

Instead of being compiled into a single static executable, these components are grouped into packages. A package is a shared object (usually called .so or .sl on Unix or .dll on Windows) which can be dynamically loaded by Amira at runtime when needed. This concept has two advantages. On the one hand, the program remains small since only those packages are loaded which are actually needed by the user. On the other hand, it provides almost unlimited extensibility since new packages can be added any time without recompiling the main program.

Therefore, in order to add custom components to the Amira developer version, new packages or shared objects must be created and compiled. A package may contain an arbitrary number of modules and it
is left up to the developer whether he wants to organize his modules into several packages or just in one.

### 18.1.1.2 Package Resource Files

A resource file is stored along with each package. This file contains information about the components being defined in a particular package. When Amira starts, it first scans the resource files of all available packages and thus knows about all the components which may be used at runtime.

The resource files of the standard Amira packages are located under share/resources in the directory where Amira is installed. Details about registering read and write routines or different kinds of modules in a resource file are provided in sections 18.3 and 18.4.

### 18.1.1.3 The Local Amira Directory

Usually Amira will be installed by the system administrator at a location where ordinary users are not allowed to create or modify files. Therefore it is recommended that every user creates new packages in his own personal local Amira directory. The local Amira directory has essentially the same structure as the directory where Amira is installed. A new local Amira directory can most easily be created by using the Development Wizard, a special-purpose dialog box described in detail in section 18.2.

Once a local Amira directory has been set up, resource files located in it will also be scanned by Amira when started. In this way, new components can be added or existing ones redefined.

### 18.1.1.4 External Libraries

Amira is based on a number of industry standard libraries. The most important ones are Open Inventor, OpenGL, Qt, and Tcl.

Amira’s 3D graphics is based on OpenGL and Open Inventor. OpenGL is the industry standard for professional 3D graphics. Open Inventor is a C++ library using OpenGL which provides an object-oriented scene description layer. Writing new visualization modules for Amira essentially means creating an Open Inventor scene from the input data. If you already have code doing this, it will be straightforward to turn it into an Amira module. While the Open Inventor headers are included in Amira XPand Extension, OpenGL must already be installed on your system.

Qt is a platform-independent C++ library for building graphical user interfaces (GUIs). Amira is built with Qt. However, the user interface elements used in standard Amira modules are encapsulated by special Amira classes called ports. Therefore, you can develop your own modules without knowing Qt. You only need Qt if you plan to add completely new user interface components such as special purpose dialogs. Note also, that in this case Qt headers and libraries are included in Amira XPand Extension under LGPL licensing. Amira 6.7 is linked against Qt 5.6 on all supported platforms.

Finally, Tcl is a C library providing an extensible scripting language used by Amira. All required header files are included in Amira XPand Extension. Amira programmers usually need not know details of the Tcl API but merely derive their code from existing examples.
18.1.2 System Requirements

In order to develop new Amira components as described in this document, you need the developer extension for Amira (called Amira XPand Extension) and the debugging files for Amira. Both can be installed with the Amira installer.

![Figure 18.1: Prerequisites in Amira installer.](image)

You also need the appropriate C++ development environment. C++ compilers are generally not compatible, therefore the compilers and compiler versions listed in section System Requirements should be used. Other compiler versions may work too, but this is not guaranteed. In particular, it is not possible to use the GNU gcc compiler except on Linux.

On all Unix platforms, the GNU make utility (gmake) is needed in order to use the GNUmakefiles provided with Amira XPand Extension. To proceed, you should create a link in a directory already listed in your path, e.g., in /usr/bin.

On Mac OS X platforms, the GNU make utility (gmake) is basically needed in order to use the GNUmakefiles provided with Amira XPand Extension. You can also modify and build your code by using other development tools based on GNU gcc compilers as Xcode.

More general hardware requirements such as installed memory or special graphics adapters are listed in the Amira User’s Guide. On all systems, an OpenGL library together with the OpenGL header files must be installed.

18.1.3 Structure of the Amira File Tree

Like the ordinary version, the developer version of Amira (with Amira XPand Extension) is installed in a single directory called the AmiraRoot Directory. This directory contains all the binaries, shared objects, and resource files required to run Amira, as well as all the C++ header files required to compile new components. Note that the installation of debug binaries must be enabled during Amira installation to compile new components in debug. New components themselves are stored independently in the AmiraLocal Directory. Every user may define his/her own local Amira directory. The local Amira directory has a structure very similar to the AmiraRoot Directory. The structure of these two directories is described in more detail in the following two sections.
18.1.3.1 The Amira Root Directory

The contents of the Amira root directory may differ slightly from platform to platform. For example, on Windows, there will be no subdirectory lib. Instead, the compiled shared objects are located under bin/arch-*-Optimize. The online documentation directory (share/devref/oiv) of Open Inventor C++ classes. The online documentation directory (share/devrefAmira/) of Amira C++ classes does not exist on Windows. Instead, a compressed archive file Amira.chm is provided and is accessible by shortcut. This is how a typical Amira installation directory looks like:

AmiraRoot/.................................Amira installation directory
| bin/..................................................Amira debug binaries (Windows only)
|  arch-*-Debug/.............................Amira debug executable (Windows only)
|  Amira.exe......................Amira executables (Windows)
|  arch-*-Optimize/......................Amira executables (Windows)
|  start........................................Amira start script (Unix)
| include/...............................C++ header files
| make/..................................Make environment for Unix systems
| share/...........................................
|  resources/..........................Resource files of all standard packages
|  devref/............................Documentation of Open Inventor C++ classes
|  devrefAmira/.....................Documentation of Amira C++ classes
| doc/.................................Amira documentation

18.1.3.2 The Local Amira Directory

The local Amira directory contains the source code and object files of custom modules, the resource files of custom packages, and the compiled custom packages themselves. The packages can be compiled either in a debug version or in an optimized version. The corresponding object files and compiled shared objects reside in different subdirectories called arch-*-Debug and arch-*-Optimize, respectively. Here the asterisk denotes the particular architecture, e.g., Win64VC12 for Windows systems or Linux, LinuxAMD64 for Linux platforms.

The Development Wizard should be used to create a new local Amira directory. For details please refer to section 18.2. Subdirectories like AmiraLocal/lib or AmiraLocal/share/resources are created automatically the first time a custom package is compiled. Again, the contents of the local Amira directory may differ slightly from platform to platform. For example, on Windows compiled shared objects are located under bin instead of lib.

AmiraLocal/
| AmiraLocal.vc120.sln..................Visual Studio solution file (Windows)
| GNUmakefile.............................Global makefile (Unix)
| src/......................................Directory containing source code of custom packages
|  mypackage/..........................Directory containing source code of one particular package
|  Package................................Configuration file used to generate make / project files
|  GNUmakefile..........................Unix makefile
18.1.4 Quick Start Tutorial

This section contains a short tutorial on how to compile and execute the example package provided with Amira XPand Extension. The example package contains the source code of the example modules and IO routines described elsewhere in this manual. At this point, you should just get a rough idea about the basic process required to develop your own modules and IO routines. Details will be discussed in the following sections.

For the development of custom Amira packages, a dedicated directory, the local Amira directory, is required. Initially, this directory should be created using the Development Wizard. Let's see how this is done:

- Start Amira and choose the Development Wizard from the XPand menu of the Amira main window.
- Make sure that the item Set local Amira directory is selected in the wizard’s dialog window.
- Press the Next button.

You can now enter a directory name for the local Amira directory. For example, you may choose AmiraLocal in your home directory. The directory must be different from the directory where Amira has been installed.

- Enter the name for the local Amira directory.
- Select the button copy example package.
- Press the OK button.
If the directory did not yet exist, Amira asks you if it should be created. The name of the directory is stored in the Windows registry or in the .AmiraRegistry file in the Unix or MacOS home directory, so that the next time Amira is started, all modules or IO routines defined in this directory will be available.

The next step is to create the Visual Studio project files for Windows or the GNUmakefiles for Unix and MacOS. These files will be generated from a Package file which must be present in each custom package directory. The syntax of the Package file is described in section 18.2.10. The example package already contains a Package file, so there is no need to create one here.

- Select Create build system on the main page of the Development Wizard.
- Press the Next button.
- Choose all local packages as target.
- Choose which kind of build system you want to create.
- Press the OK button.

The files for the selected build system will now be created automatically. The advantage of the automatic generation is that the include and library paths are always set correctly. Also, any dependencies between local packages are taken into account.

Once the build system has been created, you can close the Development Wizard and exit Amira. We are now ready to compile the example package. Yet, as a reminder, you will not be able to compile in debug if you have not installed the ”debug binaries” during Amira installation. The compilation procedure is different for each platform:

**Windows Visual Studio**

- Start Visual Studio and load the solution file AmiraLocal.vc120.sln from the local Amira directory. If your local Amira directory is not called AmiraLocal, the solution file also has some other name.
- Build all local packages in debug mode by choosing Build Solution from the Build menu.

**Unix GNUmakefile system**

- Change into the local Amira directory in a shell.
- Type in gmake to build all local packages in debug mode. If gmake is not already installed on your system, you can find it in the subdirectory bin in the Amira root directory. Either add this directory in your path variable or create a link in a directory already listed in your path, e.g., /usr/bin.

**Mac GNUmakefile system**

- Open a Terminal window and change into the local Amira directory you created before.
- Type in gmake to build all local packages.

**Important note:** please refer to system requirements for Mac OSX if an error message like ld: framework not found CUDA is displayed by the compiler.

We are now ready to start Amira in order to test the example package. However, because we have
compiled the example package in debug mode, we also need to start Amira in debug mode. Otherwise, Amira would not find the correct DLLs or shared libraries. For Linux, start Amira with the command line option `-debug`. On Windows, use the **Amira (debug)** shortcut in the Start menu. On Mac systems, you can start the application immediately, the new path will be automatically recognized.

In order to check if the example package has been successfully compiled and can be loaded by Amira, you can, for example, choose the entry *Other / Dynamic Colormap* from the Project > *Create Object...* menu of the Amira main window. Then a new colormap object should be created. You can find the source code of this new object in the local Amira directory under `src/mypackage/MyDynamicColormap.cpp`. In the same directory, there is also the header file for this class.

If you want to compile the example package in release mode, you must change the active configuration in Visual Studio and recompile the code. On Unix, you have to call `gmake MAKE_CFG=Optimize`. You can also define `MAKE_CFG` as an environment variable.

### 18.1.5 Compiling and Debugging

This section provides additional information not covered by the *quick start guide* on how to compile and debug custom Amira packages. You may skip it the first time you are reading this manual. The information will not become relevant until you are actually developing your own code.

It has already been mentioned that the development of custom Amira packages should take place in a local Amira directory. Initially, such a directory should be created using the Development Wizard described in section 18.2. The name of the local Amira directory is stored in the Windows registry or in the file `.AmiraRegistry` in your Unix home directory. On both Windows and Unix, the name of the local Amira directory can be overridden by defining the environment variable `AMIRA_LOCAL`. This might be useful if you want to switch between different local Amira directories. However, in general it is recommended not to set this variable.

For each local package, there is a resource file stored in the subdirectory `share/resources` in the local Amira directory. This file contains information about all modules and IO routines provided by that package. A local package can be compiled in debug mode suitable for debugging or in release mode with compiler optimization turned on. In the first case, the DLLs or shared libraries are stored under `bin/arch-**-Debug` on Windows and `lib/arch-**-Debug` on Unix, provided you have installed "debug binaries" during Amira installation. In the second case, they are stored under `bin/arch-**-Optimize` or `lib/arch-**-Optimize`. Here the '**' indicates the actual architecture name. In the following, it will be describe how to compile local packages in both modes on the different platforms and how to debug the code using a debugger.

#### 18.1.5.1 Windows Visual Studio

Note: Mixing code generated with different versions of Visual Studio (Visual Studio 2008, 2010, 2012, etc.) is not officially supported. So, generally you need the same Visual Studio version with which Amira was compiled (see *system requirements*). However, compiling your own modules using another version of Visual Studio might work if you install the corresponding Visual Studio runtime together with Amira on any Windows PC that makes use of your custom modules. Be aware this is
not a recommended usage.

The workspace and project files for Visual Studio are generated automatically from the Amira Package files by the Development Wizard. There should be no need to change the project settings manually. By default, Visual Studio will compile in debug mode. In order to generate optimized code, you need to change the active configuration. This is done by choosing Configuration Manager... from the Build menu. In the Active Solution Configuration pulldown menu, select Release.

In order to execute the debug mode version of your local packages, you must start Amira with the debug Amira.exe located in the bin/arch-*-Debug folder. For convenience, a link Amira (Debug) is provided in the start menu. However, if you want to debug your code, you need to start Amira from Visual Studio. Thus, you need to specify the correct executable in the project properties dialog. You can bring up the project properties dialog by choosing Properties from the Project menu. Select Debugging from the left pane. In the field Command, choose the file bin/arch-<version>-Debug/Amira.exe located in the Amira root directory (see Figure 18.2). Replace <version> with the version of Amira you have (see system requirements).

![Figure 18.2: Specifying the name of the executable in Visual Studio.](image)

You can now start Amira from Visual Studio by pressing F5 or by choosing Start from the Debug menu. In order to debug your code, you may set breakpoints at arbitrary locations in your code. For example, if you want to debug a read routine, set a breakpoint at the beginning of the routine, execute Amira and invoke the read routine by loading some file.
18.1.5.2 Linux

In order to compile a local package under Linux, you need to change into the package directory and execute `gmake` in a shell. The `gmake` utility is provided in the `bin` subdirectory of the Amira root directory. Either add this directory to your path or create a link in a directory already listed in your path, e.g., in `/usr/bin`.

The required GNUmakefiles will be generated automatically from the Amira Package files by the Development Wizard. There should be no need to edit the GNUmakefiles manually. Depending on the contents of the Package file, all source files in a package directory will be compiled, or a subset only. By default, all files will be compiled. The Development Wizard will put the name of the Amira root directory into the file `GNUmakefile.setroot`. You may overwrite the name by defining the environment variable `AMIRA_ROOT`. For example, this might be useful when working simultaneously with two different Amira versions.

By default, `gmake` will compile debug code. In order to compile optimized code, invoke `gmake MAKE_CFG=Optimize`. Alternatively, you may set the environment variable `MAKE_CFG` to `Optimize`.

If you have a multi-processor machine, you may compile multiple files at once by invoking `gmake` with the option `-j<n>`. Here `<n>` denotes the number of compile jobs to be run in parallel. Usually twice the number of processors is a good choice.

If you have compiled debug code, you must invoke Amira with the command line option `-debug`. Otherwise, the optimized version will be executed. If no such version exists, an error occurs. Instead of specifying `-debug` at the command line, you may also set the environment variable `MAKE_CFG` to `Debug`.

In order to run Amira in a debugger, invoke the Amira start script with the `-gdb` or `-ddd` command line option.

Note that usually you cannot set a breakpoint in a local package right after starting the debugger. This is because the package’s shared object file will not be linked to Amira until the first module or read or write routine defined in the package is invoked. In order to force the shared object to be loaded without invoking any module or read or write routine, you may use the command `dso open lib<name>.so`, where `<name>` denotes the name of the local package. Once the shared object has been successfully loaded, breakpoints may be set. It depends on the debugger whether these breakpoints are still active when the program is started the next time.

18.1.6 Maintaining Existing Code

This section is directed to programmers who have already developed custom modules using a previous version of Amira XPand Extension. In particular, we describe

- how to upgrade to Amira XPand Extension 6, and
- how to rename an existing package.

18.1.6.1 Upgrading to Latest Version of Amira XPand Extension

Amira is an evolving interactive software product. The Amira XPand Extension API is subject to change. While we do our best to maintain compatibility, some incompatible changes may be intro-
duced and require adaptation of your existing code, such as code relating to modules and the user interface.

The *XPand Reference Manual* contains all classes and methods that you can safely use since the source compatibility will be ensured between versions. We do our best to maintain compatibility between versions, however, to improve our API it is sometimes necessary to break compatibility. We do not guarantee any compatibility if you use internal classes or methods, and if used, you will get a compatibility warning at the compilation step. A Porting Guide tab that indicates the compatibility breaks in Amira 6.7 is accessible in the *Amira Programmer’s Reference* document ($AMIRA_ROOT/share/devrefAmira/Amira.chm).

Moreover, you may use headers and libraries for Open Inventor and Qt provided by the Amira XPand Extension. Those APIs follow themselves via their own path and may introduce specific incompatibilities. Please refer to their respective release notes for more details.

### 18.1.6.2 Renaming an Existing Package

Sometimes you may want to rename an existing Amira package, for example when using an existing package as a template for a new custom package. In order to do so, the following changes are required:

- Rename the package directory:
  
  AmiraLocal/src/oldname becomes AmiraLocal/src/newname

- Rename the following files in the package directory:
  
  oldnameAPI.h becomes newnameAPI.h
  share/resources/oldname.rc becomes share/resources/newname.rc

- In the package resource file share/resources/newname.rc and in the Package file, replace oldname by newname.

- In the file newnameAPI.h, replace OLDNAME_API by NEWNAME_API.

- In all header and source files of the package, adjust the included directives, if necessary, i.e., instead of
  
  #include <oldname/SomeClass.h>
  
  now write #include <newname/SomeClass.h>

All replacements can be performed using an arbitrary text editor. After all files have been modified as necessary, a new Visual Studio project file or a new GNUmakefile should be created using the Amira development wizard.

### 18.2 The Development Wizard

The development wizard is a special tool which helps you to set up a local Amira directory tree so that you can write custom extensions for Amira. In addition, the development wizard can be used to create templates of Amira modules or read or write routines. The details of developing such components are treated in other sections. At this point, we want to give a short overview about the functionality of the development wizard.

In particular, we discuss
how to invoke the development wizard
how to set or create the local Amira directory
how to add a package to the local Amira directory
how to add components to an existing package
how to create the files for the build system

Finally, a section describing the Package file syntax is provided.

18.2.1 Starting the Development Wizard
In order to invoke the development wizard, first start Amira. Then select Development Wizard from the main window’s XPand menu. Note that this menu option will only be available if you are running the developer version of Amira (with Amira XPand Extension installed).
The layout of the development wizard is shown in Figure 18.3. Initially, the wizard informs you about the local Amira directory currently being used. If no local Amira directory is defined, this is indicated too. Furthermore, the wizard lets you select between four different tasks to be performed. These are

- setting the local Amira directory (or creating a new one)
- adding a new package to the local Amira directory
- adding a component to an existing package
- creating the files for the build system

The first option is always available. A new package can only be added if a valid local Amira directory has been specified. For the local Amira directory to be valid, among others, it must contain a subdirectory called src. If at least one package exists in the src directory of the local Amira directory, a new component, i.e., a module or a read or write routine, can be added to a package. Finally, the last option allows you to create all files required by the build system, i.e., Visual Studio project files or GNUmakefiles for Unix platforms.

18.2.2 Setting Up the Local Amira Directory
The local Amira directory contains your source code and the binaries of all your custom extensions. You can easily specify the name of this directory using the development wizard (see Figure 18.4). Since all users can write his/her own extensions for Amira, it is recommended that you create the local Amira directory in your home directory.

If the specified directory does not exist, the development wizard asks you whether it should be created. If you confirm, the directory and its subdirectories will be created. You may also specify an existing empty directory in the text field. Then the subdirectories will be created in that location.

Finally, you may choose the existing directory previously created by the development wizard. In this case, a simple check validates the specified directory.
To unset the local Amira directory, clear the text field and click OK. The directory will not be deleted, but the next time Amira is started, modules and IO routines defined in the local Amira directory will
Once you have set up the local Amira directory, the name of the directory is stored permanently. This means that the next time Amira is started the .rc-files located in the subdirectory `share/resources` of the local Amira directory can be read. In this way, custom components are made known to Amira. On Windows, the name of the local Amira directory is stored in the Windows registry. On Unix systems, it is stored in the file `.AmiraRegistry` in your home directory. In both cases, these settings can be overridden by defining the environment variable `AMIRA_LOCAL`.

The development wizard provides a toggle for copying an example package to the local Amira directory. You will get a warning if this button is activated and an existing local Amira directory already containing the example package has been specified. The example package is copied to the
subdirectory `src/mypackage` in the local Amira directory. It contains all read and write routines plus modules presented as examples in this guide.

You can select toggle *Copy GPU example package* to provide another example package. To build this package, install the CUDA toolkit first. This example is copied in the local Amira directory in the subdirectory `src/gaussianfiltercudac`.

### 18.2.3 Adding a New Package

All Amira components are organized in *packages*. Each package will be compiled into a separate shared object (or DLL file on Windows). Therefore, before any components can be defined, at least one package must be created in the local Amira directory. In order to do so, choose *add package to local Amira directory* on the first page of the wizard and press *Next*. On the next page you can enter the name of the new package (see Figure 18.5).

![Figure 18.5: Adding a new package to the local Amira directory.](image)

The name of a package must not contain any white spaces or punctuation characters. When a package is added, a subdirectory of the same name is created under `src` in the local Amira directory. In this directory, the source code and header files of all the modules and IO routines of the package are stored. In addition, in each package directory, there must be a *Package* file from which the build system files can be generated.

Initially, a default *Package* file will be copied into a new package directory. This default file adds the most common Amira libraries for linking. It also selects all C++ source files in the package directory to be compiled. In order to generate the build system from the *Package* file, please refer to subsection 18.2.9.

In addition to the *Package* file, the file `version.cpp` will also be copied into a new package directory. This file allows you to put version information into your package, which can later be viewed in the Amira system information dialog. Finally, an empty file `package.rc` will also be copied into `share/resources`. Later modules and IO routines will be registered in this file.
18.2.4 Adding a New Component

If you choose the *add component* option on the first page of the development wizard, you will be asked what kind of component should be added to which package. Remember that the *add component* option will only be available if a valid local Amira directory with at least one existing package is found. In particular, templates

- of an ordinary module,
- of a compute module,
- of a read routine,
- or of a write routine

may be created (see Figure 18.6). The option menu in the lower part of the dialog box lets you specify the package to which the component should be added. After you press the *Next* button, you will be asked to enter more specific information about the particular component you want to add. Up to this point no real operation has been performed, i.e., no files have been created or modified.

![Figure 18.6: Adding a new component to an existing package.](image)

18.2.5 Adding an Ordinary Module

An ordinary module in Amira directly visualizes the data object to which it is attached. Examples include the *Isosurface* module, the *Volume Render* module, and the *Surface View* module. Such modules, sometimes also called *display modules*, are represented by yellow icons in the Project View.

To create the template for an ordinary module using the development wizard, you must enter the C++ class name of the module, the name to be shown in the popup menu of possible input data objects, the C++ class name of possible input data objects, and the package where the input class is defined (see Figure 18.7).
Once you click **OK**, two files are created in the package directory: a header file and a source code file for the new module. In addition, a new module statement is added to the package resource file located under `share/resources` in the package directory. After you have added a new module to a package, you need to recreate the build system files before you can compile the module. Details are described in subsection 18.2.9.

### 18.2.6 Adding a Compute Module

A *compute module* in Amira usually takes one or more input data objects, performs some kind of computation, and puts back a resulting data object in the Project View. Compute modules are represented by red icons in the Project View.

The only difference between an ordinary module and a compute module is that the former is directly derived from `HxModule` while the latter is derived from `HxCompModule`. When creating a template for a compute module using the development wizard, the same input fields must be filled in as for an ordinary module. The meaning of these input fields is described in subsection 18.2.5.

### 18.2.7 Adding a Read Routine

As will be explained in more detail in subsection 18.3.2, read routines are global C++ functions used to create one or more Amira data objects from the contents of a file stored in a certain file format. To create the template of a new read routine, first the name of the routine must be specified (see Figure 18.8). The name must be a valid C++ name. It must not contain blanks or any other special characters.

Moreover, the name of the file format and the preferred file name extension must be specified. The extension will be used by the file browser in order to identify the file format. The format name will be displayed next to any matching file.

Finally, a toggle can be set in order to create the template of a read routine supporting the input of multiple files. Such a routine will have a slightly different signature. It allows you to create a single
data object from multiple input files. For example, multiple 2D image files can be combined in a single 3D image volume. Details are provided in subsection 18.3.2.3.

After you press OK a new file <name>.cpp will be created in the package directory, where <name> denotes the name of the read routine. In addition, the read routine will be registered in the package resource file. Some file formats can be identified by a unique file header, not just by the file name extension. In such a case, you may want to modify the resource file entry as described in subsection 18.3.2.1.

Remember, that after you have added a new read routine to a package, you need to recreate the build system files before you can compile it. Details are described in subsection 18.2.9.

18.2.8 Adding a Write Routine

A write routine is a global C++ function which takes a pointer to some data object and writes the data to a file in a certain file format. The details are explained in subsection 18.3.3. In order to create the template of a new write routine, the name of the routine must first be specified (see Figure 18.9). The name must be a valid C++ name. It must not contain blanks or any other special characters. In addition, the name of the file format and the preferred file name extension must be specified. Before saving a data object, both the name and the extension will be displayed in the file format menu of the Amira file browser.

Finally, the C++ class name of the data object to be saved must be chosen as well as the package in which this class is defined. Some important data objects such as a HxUniformScalarField3 or a HxSurface are already listed in the corresponding combo box. However, any other class, including custom classes, may be specified here. Instead of the name of a data class, even the name of an interface class such as HxLattice3 may be used (see subsection 18.5.2.1).

After you press OK, a new file <name>.cpp will be created in the package directory, where <name> denotes the name of the write routine. In addition, the write routine will be registered in the package resource file.
Remember, that after you have added a new write routine to a package, you need to recreate the build system files before you can compile it. Details are described in subsection 18.2.9.

18.2.9 Creating the Build System Files

Before you can actually compile your own packages, you need to create project files for Microsoft Visual Studio on Windows or GNUmakefiles for Unix. These files contain information such as the source code files to be compiled, or the correct include and library paths. Since it is not trivial to set up and edit these files manually, Amira provides a mechanism to create them automatically. In order to do this, a so-called Package file must exist in each package. The Package files contain the name of the package and a list of dependent packages. It may also contain additional tags to customize the build process. The syntax of the package file is described in subsection 18.2.10. However, usually there is no need to modify the default Package file created by the development wizard.

While the automatic generation of the build system files is a very helpful feature, it also means that you should not modify the resulting project or GNUmakefiles manually, because they might be easily overwritten by Amira.

If you select Create build system on the main page of the development wizard and then press the Next button, the controls shown in Figure 18.10 will be activated. You can choose if you want to create the build system files for all local packages or just for a particular one.

18.2.10 The Package File Syntax

The Package file contains information about a local package. From this file, Visual Studio project files or GNUmakefiles can be generated. The Package file is a Tcl file. It defines a set of Tcl variables indicating things like the name of the package, dependent libraries, or additional files to be copied when building the package. The default Package file created by the Development Wizard looks as follows:

```
... (Tcl code for the Package file) ...
```
In most cases, the default file works well and do not need to be modified. However, in order to accomplish special tasks, the default values of the variables can be changed or additional variables can be defined. Here is a detailed list describing the meaning of the different variables:

**PACKAGE**

The variable `PACKAGE` indicates the name of the package. This should be the same as the name of the package directory. The package name must not contain any characters other than letters or digits.

**LIBS**

Lists all libraries on which the package depends. By default, the most common Amira packages are inserted here. You can modify this list as needed. For example, if you want to link against a library called `foo.lib` on Windows or `libfoo.so` on Unix, you should add `foo` to `LIBS`. In addition to a real library name, you may use the following aliases in the `LIBS` variable:

- `oiv` - for the Open Inventor libraries
- `tcl` - for the Tcl library
opengl - for the OpenGL library
qt - for the Qt library

If you want to link against a library only on a particular platform, you can set a dedicated variable
LIBS-arch, where arch denotes the platform. You may further distinguish between the debug and
release version of the code. Here is an example:

```
set LIBS {mclib amiramesh schedule hxz qt oiv opengl tcl}
set LIBS-Unix {hxgfxinit}
set LIBS-Win {hxgfxinit}
set LIBS-Win-Debug {msvcrtd mpr}
set LIBS-Win-Optimize {msvcrt mpr}
```

**SHARE**

Lists all files which should be copied from the package directory into the local Amira directory. By
default, only the package resource file will be copied. However, you may add additional files here, if necessary. Instead of explicit file names, you may use wildcards. These will be resolved using the
standard Tcl command `glob`. For example, if you have some demo scripts in your package, you could
copy them in the following way:

```
set SHARE {
    share/resources/mypackage.rc
    share/demo/mydemos/*.hx
}
```

As for the LIBS variable, you may append an arch string here, i.e., SHARE-arch. The files then will
only be copied on the specified platforms.

**INCLUDES**

This variable may contain a list of additional include paths. These paths are used by the com-
piler to locate header files. By default, the include path is set to $AMIRA_ROOT/include, $AMIRA_ROOT/include/oiv, $AMIRA_LOCAL/src, and the local package directory.

**COPY**

This may contain a list of files which are copied from a location other than the local package directory. You need to specify the name of the target file followed by the name of the destination file relative to the local Amira directory. For example, you may want to copy certain data files from some archive into the Amira directory. This can be achieved in the following way.

```
set COPY {
    D:/depot/data/28523763.dcm data/test
    D:/depot/data/28578320.dcm data/test
    D:/depot/data/28590591.dcm data/test
}
```
As for the **LIBS** variable, you may append an arch string here, i.e., `COPY-arch`. The files then will only be copied on the specified platforms. A common application is to copy external libraries required on a particular platform into the Amira directory.

**SRC**
This variable specifies the source code files to be compiled for the package. The default value of this variable is

```plaintext
set SRC {*.cpp *.c}
```

This means, that by default, all .cpp and .c files in the local package directory will be compiled. Sometimes you may want to replace this default by an explicit list of source files.
Again, you may append an arch string to the **SRC** variable, so that certain files will only be compiled on a particular platform.

**INCSRC**
This variable specifies the header files to be included into the Visual Studio package project file. The default value of this variable is

```plaintext
set INCSRC {*.h *.hpp}
```

This means that, by default, all .h and .hpp files in the local package directory will be considered.
Again, you may append an arch string to the **INCSRC** variable, so that certain header files will only be considered on a particular platform.

### 18.3 File I/O

This section describes how user-defined read and write routines can be added to Amira. The purpose of custom read and write routines is to add support for file formats not available in Amira.

First, some general hints on **file formats** are given. Then we discuss how **read routines** are expected to look in Amira. **Write routines** are treated subsequently. Finally, the **AmiraMesh API** is discussed. Using this API, file I/O for new custom data objects can be implemented rather easily.

#### 18.3.1 On file formats

Before going into detail, let us clarify some general concepts. In Amira, all data loaded into the system are encapsulated in C++ **data classes**. Section 18.5 provides more information about the standard data classes. For example, there is a class to represent tetrahedral grids (**HxTetraGrid**), a separate one for scalar fields defined on tetrahedral grids (**HxTetraScalarField3**), and another one for 3D image data (**HxUniformScalarField3**). Every instance of a data class is represented by a green icon in the Amira Project View.
The way in which data are stored in a disk file is called a **file format**. Although there is a relationship between data classes and file formats, these are two different things. It is especially important to understand that there is no one-to-one correspondence between them.
Typically, a specific data class (like 3D image data) can be stored in many different file formats (3D TIFF, DICOM, a set of 2D JPEG files, and so on). On the other hand, a specific file format does not necessarily correspond to exactly one data class. For example, a simple data file in Fluent UNS format can contain hexahedral grids (HxHexaGrid) or tetrahedral grids (HxTetraGrid).

Note that there is also no one-to-one correspondence between the instance of a data class (a green icon in Amira) and the instance of a file format (the actual file). Often multiple files correspond to a single data object, for example, 2D images forming a single 3D image volume. On the other hand, a single file can contain the data of multiple data objects. For example, an AVS UCD file can contain a tetrahedral grid as well as multiple scalar fields defined on it.

Finally, note that information may get lost when saving a data object to a file in a specific format. For example, when saving a 3D image volume to a set of 2D JPEG images, the bounding box information will be lost. Likewise, there are user-defined parameters or attributes in Amira that cannot be encoded in most standard file formats. On the other hand, a file reader often does not interpret all information provided by a specific file format.

### 18.3.2 Read Routines

As already mentioned in the previous section, a read routine is a C++ function that reads a disk file, interprets the data, creates an instance of an Amira data class, and fills that instance with the data read from the file.

In order to write a read routine, obviously two things are needed, namely a specification of the file format to be read as well as the information for which of Amira’s data classes is able to represent the data and how this class is used. More information about the standard Amira data classes is given in section 18.5. The C++ interface of these classes is described in the online reference documentation. A read routine may either be a static member function of a class or a global function. In addition to the function itself, an entry in the package resource file is needed. In this way Amira is informed about the existence of the read routine and about the type of files that can be handled by the reader.

In the following discussion, the implementation of a user-defined read routine will be illustrated by two concrete examples, namely a simple read routine for scalar fields and a read routine for surfaces and surface fields. Some more details about read routines will be discussed subsequently.

#### 18.3.2.1 A Reader for Scalar Fields

In this section, we present a simple read routine designed for reading image volumes, i.e., 3D scalar fields, from a very simple file format, which we have invented for this example. The file format is called PPM3D (because it is similar to the ppm 2D image format). The PPM3D format will be an ASCII file format containing a header, three integer numbers specifying the size of the 3D image volume, and the pixel data as integer numbers in the range 0 to 255. An example file could look like this:

```plaintext
# PPM3D
4 4 3
43 44 213 9 23 234 3 3 3 44 213 9 23 234 36 63
44 213 9 23 234 35 3 5 44 213 9 23 234 31 13 12
44 213 9 23 234 35 3 5 44 213 9 23 234 31 13 12
```

File I/O
The full source code of the read routine is contained in the example package provided with Amira XPand Extension. In order to follow the example below, first create a local Amira directory using the Development Wizard. Be sure that the toggle *copy example package* is activated, as described in subsection 18.2.2. The read routine can then be found in the local Amira directory under `src/mypackage/readppm3d.cpp`.

Let us first take a look at the commented source code of the reader. Some general remarks follow below.
```c++
#include "api.h" // storage-class specification
#include <hxcore/HxMessage.h> // for output in console
#include <hxfield/HxUniformScalarField3.h> // class representing 3D images

MYPACKAGE_API int readppm3d(const QString& filename)
{
    FILE* f = fopen(filename.toLocal8Bit(), "r"); // open the file
    if (!f)
    {
        theMsg->ioError(filename);
        return 0; // indicate error
    }

    // Skip header (first line). We could do some checking here:
    char buf[80];
    fgets(buf, 80, f);

    // Read size of volume:
    int dims[3];
    fscanf(f, "%d %d %d", &dims[0], &dims[1], &dims[2]);

    // Do some consistency checking.
    {
        theMsg->printf(QString("Error in file %1.").arg(filename));
        fclose(f);
        return 0;
    }

    // Now create 3D image data object. The constructor takes the
    // dimensions and the primary data type. In this case we create
    // a field containing unsigned bytes (8 bit).
    HxUniformScalarField3* field =
        new HxUniformScalarField3(dims, McPrimType::MC_UINT8);

    // The HxUniformScalarField3 stores its data in a member variable
    // called lattice. We know, that the data is unsigned 8 bit,
    // because we specified this in the constructor.
    unsigned char* data = (unsigned char*)field->lattice().dataPtr();

    // Now we have to read dims[0]*dims[1]*dims[2] data values
    for (int i = 0; i < dims[0] * dims[1] * dims[2]; i++)
    {
        int val = 0;
```
The source file starts with some includes. First, the file `api.h` is included. This file provides import and export storage-class specifiers for Windows systems. These are encoded in the macro `MYPACKAGE_API`. On Unix systems this macro is empty and can be omitted. Next, the file `HxMessage.h` is included. This header file provides the global pointer `theMsg` which allows us to print out text messages in the Amira console window. In our read routine, we use `theMsg` to print out error messages if a read error occurred. Finally, the header file containing the declaration of the data class to be created is included, i.e., `HxUniformScalarField3.h`. As a general rule, every class in Amira is declared in a separate header file. The name of the header file is identical to the name of the C++ class.

The read routine itself takes one argument, the name of the data file to be read. It should return 1 on success, or 0 if an error occurred and no data object could be created. The body of the read routine is rather straightforward. The file is opened for reading. The size of the image volume is read. A new data object of type `HxUniformScalarField3` is created and the rest of the data is written into the data object. Finally, the file is closed again and the data object is put into the Project View by calling `HxData::registerData`. In principle, all read routines look like this example. Of course, the type of data object being created and the way that this object is initialized may differ.

In order to make the new read routine known to Amira, an entry must be added to the package resource file, i.e., to the file `mypackage/share/resources/mypackage.rc`. In our case, this entry looks as follows:

```
dataFile -name "PPM3D Demo Format" \ 
   -header "PPM3D" \ 
   -load "readppm3d" \ 
   -package "mypackage"
```

The `dataFile` command registers a new file format called `PPM3D Demo Format`. The option `-header` specifies a regular expression which is used for automatic file format detection. If the first 64 bytes of a file match this expression, the file will be automatically loaded using this read routine. Of course, some data formats do not have a unique file header. In this case, the format may also be detected from a standard file name extension. Such an extension may be specified using the `-ext` option of the `dataFile` command. Multiple extensions can be specified as a comma-separated list.
The actual C++ name of the read routine is specified via `-load`. Finally, the package containing the read routine must be specified using the `-package` option.

If you have compiled the example in the mypackage example package, you can try to load the example file `mypackage/data/test.ppm3d`. As you will see, the file browser automatically detects the file format and displays *PPM3D Demo Format* in its file list.

### 18.3.2.2 A Reader for Surfaces and Surface Fields

Now that you know what a read routine looks like in principle, let us consider a more complex example. In this section, we discuss a read routine which creates more than one data object. In particular, we want to read a triangular surface mesh from a file. In addition to the surface description, the file may also contain data values for each vertex of the surface. Data defined on a surface mesh are represented by separate classes in Amira. Therefore, the reader must first create a data object representing the surface only. Then appropriate data objects must be created for each surface field.

Again, the file format is quite simple and has been invented for the purpose of this example. We call it the *Trimesh* format. It is a simple ASCII format without any header. The first line contains the number of points and the number of triangles. Then the x-, y-, and z-coordinates of the points are listed. This section is followed by triangle specifications consisting of three point indices for each triangle, point count starts at one. The next section is for vertex data, starting with a line that contains an arbitrary number of integers. Each integer indicates that there is a data field with a certain number of variables defined on the surface’s vertices, e.g., 1 for a scalar field or 3 for a vector field. The data values for each vertex follow in separate lines. Here is a small example containing a single scalar surface field:

```
4 2
0.0 0.0 0.0
1.0 0.0 0.0
0.0 1.0 0.0
1.0 1.0 0.0
1 2 4
1 4 3
1
0.0
0.0
1.0
1.0
```

You can find the full source code of the reader in the local Amira directory under `src/mypackage/readtrimesh.cpp`. Remember that the example package must have been copied into the local Amira directory before compiling. For details, refer to subsection 18.2.2. Let us now look at the complete read routine before discussing the details:

```cpp
///////////////////////////////////////////////////////////////////////
// Read routine for the trimesh file format
///////////////////////////////////////////////////////////////////////
#include "api.h"
```

*File I/O*
#include <hxcore/HxMessage.h>
#include <hxqt/QxStringUtils.h>
#include <hxsurface/HxSurface.h>
#include <hxsurface/HxSurfaceField.h>

MYPACKAGE_API int readtrimesh(const QString& filename)
{
    FILE* fp = fopen(filename.toLocal8Bit(), "r");
    if (!fp)
    {
        theMsg->ioError(filename);
        return 0;
    }

    // 1. Read the surface itself

    char buffer[256];
    fgets(buffer, 256, fp); // read first line
    int i, j, k, nPoints = 0, nTriangles = 0;
    sscanf(buffer, "%d %d", &nPoints, &nTriangles); // get numbers
    if (nPoints < 0 || nTriangles < 0)
    {
        theMsg->printf("Illegal number of points or triangles.");
        fclose(fp);
        return 0;
    }

    HxSurface* surface = HxSurface::createInstance(); // create new surface
    surface->addMaterial("Inside", 0); // add some materials
    surface->addMaterial("Outside", 1);

    HxSurface::Patch* patch = new HxSurface::Patch; // create surface patch
    surface->patches.append(patch); // add patch to surface
    patch->innerRegion = 0;
    patch->outerRegion = 1;

    surface->points().resize(nPoints);
    surface->triangles().resize(nTriangles);

    for (i = 0; i < nPoints; i++)
    { // read point coordinates
        McVec3f& p = surface->points()[i];
        fgets(buffer, 256, fp);
        sscanf(buffer, "%g %g %g", &p[0], &p[1], &p[2]);
    }

    for (i = 0; i < nTriangles; i++)
    { // read triangles
        int idx[3];
fgets(buffer, 256, fp);
sscanf(buffer, "%d %d %d", &idx[0], &idx[1], &idx[2]);

Surface::Triangle& tri = surface->triangles()[i];
tri.points[0] = idx[0] - 1; // indices should start at zero
tri.patch = 0;
}

patch->triangles.resize(nTriangles);
for (i = 0; i < nTriangles; i++)
    patch->triangles[i] = i; // add all triangles to one patch

HxData::registerData(surface, filename); // add surface to object pool

// 2. Check if file also contains data fields
fgets(buffer, 256, fp);
QStringList stringList = toQString(buffer).split(' ');
McDArray<HxSurfaceField*> fields;
foreach (QString string, stringList)
{ // are there any numbers here ?
    bool intValid = false;
    int n = string.toInt(&intValid);
    if (intValid)
    { // Create appropriate field, e.g. HxSurfaceScalarField if n==1
        HxSurfaceField* field =
            HxSurfaceField::create(surface,
                                  HxSurfaceField::ON_NODES,
                                  n);
        fields.append(field);
    }
}

if (fields.size())
{
    for (i = 0; i < nPoints; i++)
    { // read data values of all fields
        fgets(buffer, 256, fp);
        QStringList stringList = toQString(buffer).split(' ');
        int indice = 0;
        for (j = 0; j < fields.size(); j++)
        { // read data values of all fields
            int n = fields[j]->nDataVar();
            float* v = &fields[j]->dataPtr()[i * n];
            for (k = 0; k < n; k++)
            { // read data values of all fields
                if (indice < stringList.size())
                {
                    v[k] = stringList[indice].toFloat();
                }
            }
        }
    }
}
The first part of the read routine is very similar to the PPM3D reader outlined in the previous section. Required header files are included, the file is opened, the number of points and triangles are read, and a consistency check is performed. Then an Amira surface object of type \texttt{HxSurface} is created. The class \texttt{HxSurface} has been devised to represent an arbitrary set of triangles. The triangles are organized into patches. A patch can be thought of as the boundary between two volumetric regions, an ”inner” and an ”outer” region. Therefore, for each patch, an inner region and an outer region should be defined. In our case, all triangles will be inserted into a single patch. After this patch has been created and initialized, the number of points and triangles is set, i.e., the dynamic arrays \texttt{points} and \texttt{triangles} are resized appropriately. Next, the point coordinates and the triangles are read. Each triangle is defined by the three points of which it consists. The point indices start at one in the file but should start at zero in the \texttt{HxSurface} class. Therefore, all indices are decremented by one. Once all triangles have been read, they are inserted into the patch we have created before. The surface is now fully initialized and can be added to the Project View by calling \texttt{HxData::registerData}.

The second part of the read routine is reading the data values. First, we check how many data fields are defined and how many data variables each field has. For each group of data variables, a corresponding surface field is created. The fields are temporarily stored in the dynamic array \texttt{fields}. Instead of directly calling the constructor of the class \texttt{HxSur-
faceField, the static method HxSurfaceField::create is used. This method checks the number of data variables and automatically creates an instance of a subclass such as HxSurfaceScalarField or HxSurfaceVectorField, if this is possible. In principle, surface fields may store data on a per-node or a per-triangle basis. Here we are dealing with vertex data, so we specify the encoding to be HxSurfaceField::ON_NODES in HxSurfaceField::create.

Finally, the data values are read into the surface fields created before. Afterwards, all the fields are added to the Project View by calling HxData::registerData again. In order to define a useful name for the surface fields, we call the method composeLabel. This method takes a reference name, in this case, the name of the surface, and replaces the suffix by some other string, in this case “data”. Amira automatically modifies the name so that it is unique. Therefore, we can perform the same replacement for all surface fields.

Like any other read routine, our Trimesh reader must be registered in the package resource file before it can be used. This is done by the following statement in mypackage/share/resources/mypackage.rc:

```bash
dataFile -name "Trimesh Demo Format" \\
-ext "trimesh,tm" \\
-load "readtrimesh" \\
-package "mypackage"
```

Most of the options of the dataFile command have already been explained in the previous section. However, in contrast to the PPM3D format, the Trimesh format cannot be identified by its file header. Therefore, we use the -ext option to tell Amira that all files with file name extensions trimesh or tm should be opened using the Trimesh reader.

18.3.2.3 More About Read Routines

The basic structure of a read routine should be clear from the examples presented in the previous two sections. Nevertheless, there are a few more things that might be of interest in some situations. These will be discussed in the following.

Reading Multiple Images At Once The Amira file browser allows you to select multiple files at once. Usually, all these files are opened one after the other by first determining the file format and then calling the appropriate read routine. However, in some cases the data of a single Amira data object are distributed among multiple files. The most prominent example is 3D images where every slice is stored in a separate 2D image file. In order to be able to create a full 3D image, the file names of all the individual 2D images must be available to a read routine. To facilitate this, read routines in Amira can have two different signatures. Besides the ordinary form

```c++
int myreader(const char* filename);
```

read routines can also be defined as follows:

```c++
int myreader(int n, const char** filenames);
```
In both cases exactly the same dataFile command can be used in the package resource file. Amira automatically detects whether a read routine takes a single file name as an argument or multiple ones. In the latter case, the read routine is called with the names of all files selected in the file browser, provided all these files have the same file format (if multiple files with different formats are selected, the read routine for each format is called with the matching files only). You can create the template of a multiple files read routine by selecting the toggle create reader for multiple files in the Development Wizard (see subsection 18.2.7).

The Load Command The current state of the Amira project with all its data objects and modules can be stored in a script file. When executed, the script should restore the Amira project again. Of course, this is a difficult task especially if data objects have been modified since they have been loaded from files. However, even if this is not the case, Amira must know how to reload the data later on. For this purpose, a special parameter called LoadCmd should be defined for the data object. This parameter should contain a Tcl command sequence which restores the data object on execution. Usually, the load command is simply set to load <filename> when calling HxData::registerData. However, this approach fails if the format of the file cannot be detected automatically, or if multiple data objects are created from a single file, e.g., as in our Trimesh example. In such cases, the load command should be set manually. In case of the Trimesh reader, this could be done by adding the following lines of code at the very end of the routine just before the method’s returning point:

```cpp
QString loadCmd = QString("set TMPIO [load -trimesh "%1"]\n" "lindex $TMPIO 0"");
.loadCmd = loadCmd.arg(filename);
surface->setLoadCmd(loadCmd, 1);
for (i = 0; i < fields.size(); i++)
{
    loadCmd = QString("lindex $TMPIO %1").arg(i + 1);
    fields[i]->setLoadCmd(loadCmd, 1);
}
```

This code requires some explanation. The file is loaded and all data objects are created when the first line of the load command is executed. Note that we specified the -trimesh option as an argument of load. This ensures that the Trimesh reader will always be used. The format of the file to be loaded will not be determined automatically. The Tcl command load returns a list with the names of all data objects which have been created. This list is stored in the variable TMPIO. Later the names of the individual objects can be obtained by extracting the corresponding elements from this list. This is done using the Tcl command lindex.

Using Dialog Boxes in a Read Routine In some cases, a file cannot be read successfully unless certain parameters are interactively specified by the user. Usually this means that a special-purpose dialog must be popped up within the read routine. This is done, for example, when raw data are read in Amira. In order to write your own dialogs, you must use Qt, a platform-independent toolkit
for designing graphical user interfaces. Qt is included with Amira XPad and Extension under LGPL licensing, so that you can easily use it to create custom dialogs in Amira.

If you don’t want to use Qt, you may consider implementing your read routine within an ordinary module. Although this somewhat breaks Amira’s data import concept, it will work too, of course. You then can utilize ordinary ports to let the user specify required import parameters.

18.3.3 Write Routines

Like read routines, write routines in Amira are C++ functions, either global ones or static member functions of an arbitrary class. In the following discussion, we present write routines for the same two formats for which reader codes have been explained in the previous section. First, a writer for scalar fields will be discussed, then a writer for surfaces and surface fields.

18.3.3.1 A Writer for Scalar Fields

In this section, we explain how to implement a routine for writing 3D images, i.e., instances of the class \texttt{HxUniformScalarField3}, to a file using the PPM3D format introduced in subsection 18.3.2.1. The writer is even simpler than the reader. Again, the source code is contained in the example package of Amira XPad and Extension. Once you have created a local Amira directory using the Development Wizard and copied the example package into that directory, you will find the write routine in the local Amira directory under \texttt{src/mypackage/writeppm3d.cpp}. Here it is:

```cpp
#include "api.h" // storage-class specification
#include <hxcore/HxMessage.h> // for output in console
#include <hxfield/HxUniformScalarField3.h> // class representing 3D images
#include <hxqt/QxStringUtils.h> // String conversion functions

MYPACKAGE_API
int
writeppm3d(HxUniformScalarField3* field, const char* filename)
{
    // For the moment we only want to support byte data
    if (field->primType() != McPrimType::MC_UINT8)
    {
        theMsg->printf("This format only supports byte data.");
        return 0; // indicate error
    }

    FILE* f = fopen(filename, "w"); // open the file
    if (!f)
    {
        theMsg->ioError(toQString(filename));
        return 0; // indicate error
    }
```

File I/O
At the beginning, the same header files are included as in the reader.

`api.h` provides import and export storage-class specifiers for Windows systems. These are encoded in the macro `MYPACKAGE_API`. On Unix systems, this macro is empty and can be omitted.

`HxMessage.h` provides the global pointer `theMsg`, which allows us to print out text messages in the Amira console window.

Finally, `HxUniformScalarField3.h` contains the declaration of the data class to be written to the file.

The signature of a write routine differs from that of a read routine. It takes two arguments, namely a pointer to the data object to be written to a file, as well as the name of the file. Before a write routine is called, Amira always checks if the specified file already exists. If this is the case, the user is asked if the existing file should be overwritten. Therefore, such a check need not to be coded again in each write routine. Like a read routine, a write routine should return 1 on success, or 0 if an error occurred and the data object could not be saved.

The body of the write routine is almost self-explanatory. At the beginning, a check is made whether the 3D image really consists of byte data. In general, the type of data values of such an image can be 8-bit bytes, 16-bit shorts, 32-bit integers, floats, or doubles. If the image does contain bytes, a file is opened and the image contents are written into it. However, note that the data object also contains information which cannot be stored using our simple PPM3D file format. First of all, this applies to the bounding box of the image volume, i.e., the position of the center of the first and the last voxel in world coordinates. Also, all parameters of the object (defined in the member variable `parameters` of type `HxParamBundle`) will be lost if the image is written into a PPM3D file and read again.

Like a read routine, a write routine must be registered in the package resource file, i.e., in `mypackage/share/resources/mypackage.rc`. This is done by the following statement:
The option -save specifies the name of the write routine. The option -type specifies the C++ class name of the data objects which can be saved using this format. Note that an export format may be registered for multiple C++ objects of different type. In this case, multiple -type options should be specified. However, for each type there must be a separate write routine with a different signature (polymorphism). For example, if we additionally want to register the PPM3D format for objects of type HxStackedScalarField3, we must additionally implement the following routine:

```cpp
int writeppm3d(HxStackedScalarField3* field, const char* fname);
```

Besides the standard data classes, there are so-called interface classes that may be specified with the -type option. For example, in this way it is possible to implement a generic writer for n-component regular 3D fields. Such data is encapsulated by the interface HxLattice3. For more information about interfaces, refer to section 18.5.

At this point, you may try to compile and execute the write routine by following the instructions given in subsection 18.1.5 (Compiling and Debugging).

### 18.3.3.2 A Writer for Surfaces and Surface Fields

For the sake of completeness, a writer for the Trimesh format introduced in subsection 18.3.2.2 is described in this subsection. Remember that the Trimesh format is suitable for storing a triangular mesh as well as an arbitrary number of data values defined on the vertices of the surface. In Amira, surfaces and data fields defined on surfaces are represented by different objects. This also has some implications when designing a write routine.

In our example, we actually implement two different write routines, one for the surface and one for the surface field. If the user selects the surface and exports it using the Trimesh writer, the surface mesh as well as all attached data fields will be written to file. On the other hand, if the user selects a particular surface field, the corresponding surface and just the selected field will be written.

The source code of the writer can be found in the local Amira directory under src/mypackage/writetrimesh.cpp. Remember that the example package must be copied into the local Amira directory before compiling. For details, refer to subsection 18.2.2. Again, let us start by looking at the code:

```cpp
#include "api.h"
#include <hxcore/HxMessage.h>
#include <hxsurface/HxSurface.h>
#include <hxsurface/HxSurfaceField.h>
```

File I/O
#include <hxqt/QxStringUtils.h>

static int
writetrimesh(HxSurface* surface,
    McDArray<HxSurfaceField*> fields,
    const char* filename)
{
    FILE* f = fopen(filename, "w");

    if (!f)
    {
        theMsg->ioError(toQString(filename));
        return 0;
    }

    int i, j, k;
    McDArray<McVec3f>& points = surface->points();
    McDArray<Surface::Triangle>& triangles = surface->triangles();

    // Write number of points and number of triangles
    fprintf(f, "%ld %ld\n", points.size(), triangles.size());

    // Write point coordinates
    for (i = 0; i < points.size(); i++)
    {
        McVec3f& v = points[i];
        fprintf(f, "%g %g %g\n", v[0], v[1], v[2]);
    }

    // Write point indices of all triangles
    for (i = 0; i < triangles.size(); i++)
    {
        int* idx = triangles[i].points;
        fprintf(f, "%d %d %d\n", idx[0] + 1, idx[1] + 1, idx[2] + 1);
    }

    // If there are data fields write them out, too.
    if (fields.size())
    {
        for (j = 0; j < fields.size(); j++)
        {
            fprintf(f, "%d", fields[j]->nDataVar());
            fprintf(f, "\n");
        }

        for (i = 0; i < points.size(); i++)
        {
            for (j = 0; j < fields.size(); j++)
            {
                int n = fields[j]->nDataVar();
                float* v = &fields[j]->dataPtr()[i * n];
                for (k = 0; k < n; k++)
                    fprintf(f, "%g ", v[k]);
            }
            fprintf(f, "\n");
        }
    }
}
In the upper part of the code, first a static utility method is defined which takes three arguments: a pointer to a surface, a dynamic array of pointers to surface fields, and a file name. This is the function that actually writes the data to a file. Once you have understood the *Trimesh* reader presented in subsection 18.3.2.2, it should be no problem to follow the writer code too. In the lower part of the code, two write routines mentioned above are defined, one for surfaces and the other one for surface fields. Since these routines are to be exported for external use, we need to apply
the package macro `MYPACKAGE_API`, at least on Windows.

Let us now look more closely at the surface writer. This routine first collects all surface fields attached to the surface in a dynamic array. This is done by scanning `surface->downStreamConnections` which provides a list of all objects attached to the surface. The class type of each object is checked using the method `isOfType`. This sort of dynamic type-checking is the same as in Open Inventor. If a surface field has been found and if it contains data defined on its nodes, it is appended to the temporary array `fields`. The surface itself, as well as the collected fields, are then written to file by calling the utility method defined in the upper part of the writer code.

The second write routine, the one adapted to surface fields, is simpler. Here a dynamic array of fields is used too, but this array is filled with data representing the original surface field only. Once this has been done, the same utility method can be called as in the first case.

Although actually two write routines have been defined, only one entry in the package resource file is required. This entry looks as follows (see `mypackage/share/resources/mypackage.rc`):

```plaintext
dataFile -name "Trimesh Demo Format" \
    -ext "trimesh" \
    -type "HxSurface" \
    -type "HxSurfaceField" \
    -save "writetrimesh" \
    -package "mypackage"
```

In order to compile and execute the write, please follow the instructions given in subsection 18.1.5 (Compiling and Debugging).

### 18.3.4 Use the AmiraMesh API to read and write files in Amira data format

Besides many standard file formats, Amira also provides its own native format called Amira data format. The Amira data file format is very flexible. It can be used to save many different data objects including image data, finite-element grids, and solution data defined on such grids. Among other features, it supports ASCII or binary data encoding, data compression, and storage of arbitrary parameters. The format itself is described in more detail in the reference section of the users guide. In this section, we want to discuss how to save custom data objects in Amira format. For this purpose, a special C++ utility class called `AmiraMesh` is provided. Using this class, reading and writing files in Amira format becomes very easy.

Below we will first provide an overview of the AmiraMesh API. After that, we present two simple examples. In the first one, we show how colormaps are written in Amira format. In the second one, we show how such colormaps are read back again.

#### 18.3.4.1 Overview

The AmiraMesh API consists of a single C++ class. This class is called `AmiraMesh`. It is defined in the header file `include/amiramesh/AmiraMesh.h` located in the Amira root directory. The class is designed to completely represent the information stored in an Amira file in memory. When reading a file, first an instance of an `AmiraMesh` class is created. This instance can then be interpreted and the data contained in it can be copied into a matching Amira data object. Likewise, when writing
a file, first an instance of an AmiraMesh class is created and initialized with all required information. Then this instance is written to file simply by calling a member method.

If you look at the header file or at the AmiraMesh class documentation, you will notice that there are four public methods called setParameters, setLocationList, setDataList, and setFieldList. These methods completely store the information contained in a file. The first method store the parameter bundle (with a HxParamBundle parameter). Like in an Amira data object, it is used to store an arbitrary hierarchy of parameters. The other three methods manipulate dynamic arrays of pointers to locally defined classes. The most important local classes are Location and Data, which are stored in locationList and dataList, respectively. Four accessors getLocationList, setLocationList, getDataList and setDataList are created to manipulate these two lists.

A Location defines the name of a single- or multi-dimensional array. It does not store any data by itself. This is done by a Data class. Every Data class must refer to some Location. For example, when writing a tetrahedral grid, we may define two different one-dimensional locations, one called Nodes and the other one called Tetrahedra. On the nodes, we define a Data instance for storing the x-, y-, and z-coordinates of the nodes. Likewise, on the tetrahedra we define a Data instance for storing the indices of the four points of a tetrahedron.

As stated in the AmiraMesh class documentation, the Data class can take a pointer to some already existing block of memory. In this way, it is prevented the copy of all data before it is written to file. In order to write compressed data, the member method setCodec has to be called. Currently, two different compression schemes are supported. The first one, called HxByteRLE, implements simple run-length encoding on a per-byte basis. The second one, called HxZip, uses a more sophisticated compression technique provided by the external zlib library. In any case, the data will be automatically uncompressed when reading an Amira data file.

It should be pointed out that the Amira data file format itself merely provides a method for storing arbitrary data organized in single- or multi-dimensional arrays in a file. It does not specify anything about the semantics of the data. Therefore, when reading an Amira data file, it is not clear what kind of data object should be created from it. To facilitate file I/O of custom data objects, the actual contents of an Amira data file are indicated by a special parameter called ContentType. For each such type, a special read routine is registered. Like an ordinary read routine, an Amira data reader is a global function or a static member method of a C++ class. It has the following signature:

```cpp
int readMyAmiraFile(AmiraMesh* m, const char* filename);
```

This method is called whenever the ContentType parameter matches the one for which the read method is registered. The reader should create an Amira data object from the contents of the AmiraMesh class. The filename can be used to define the name of the resulting data object. In order to register an Amira read routine, a statement similar to the following one must be put into the package resource file:

```bash
AmiraFormat -ContentType "MyType" \
   -load "readMyAmiraFile" \
   -package "mypackage"
```
18.3.4.2 Writing an Amira Data File

As a concrete example, in this section, we want to show how a colormap is written in Amira data format. In particular, we consider colormaps of type HxColormap256, consisting of N discrete RGBA tuples. Like most other write methods, the Amira data writer is a global C++ function. Let us first look at the code before discussing the details.

```
HXCOLOR_API
int write(HxColormap256* map, const char* filename)
{
    float minmax[2];
    minmax[0] = map->minCoord();
    minmax[1] = map->maxCoord();
    int size = map->getSize();

    AmiraMesh m;
    m.parameters = map->parameters;
    m.parameters.set("MinMax", 2, minmax);
    m.parameters.set("ContentType", "Colormap");

    AmiraMesh::Location* loc =
        new AmiraMesh::Location("Lattice", 1, &size);
    m.insert(loc);

    AmiraMesh::Data* data = new AmiraMesh::Data("Data", loc,
        McPrimType::mc_float, 4, (void*) map->getDataPtr());
    m.insert(data);

    if ( !m.write(filename,1) ) {
        theMsg->ioError(filename);
        return 0;
    }

    setLoadCmd(filename);
    return 1;
}
```

In the first part of the routine, a variable m of type AmiraMesh is defined. The parameters of the colormap are copied into m. In addition, two more parameters are set. The first one, called MinMax, describes the coordinate range of the colormap. The second one indicates the content type of the Amira data file. This parameter ensures that the colormap can be read back again by a matching Amira data read routine (see subsection 18.3.4.3).

Before the RGBA data values can be stored, a Location of the right size must be created and inserted into the AmiraMesh class. Afterwards, an instance of a Data class is created and inserted. The constructor of the Data class takes a pointer to the Location as an argument. Moreover, a pointer to the RGBA data values is specified. Each RGBA tuple consists of four numbers of type float.

18.3.4.3 Reading an Amira Data File

In the previous section, we presented a simple Amira data write routine for colormaps. We now want to read back such files again. For this reason, we define a static Amira data read function in class
HxColormap256. Of course, a global C++ function could be used as well. The read function is registered in the package resource file hxcolor.rc in the following way:

```c
AmiraFormat -ContentType "Colormap" \
    -load "HxColormap256::readAmiraMesh" \
    -package "hxcolor"
```

This statement indicates that the static member method readAmiraMesh of the class HxColormap256 defined in package hxcolor should be called if the Amira data file contains a parameter ContentType equal to Colormap. The source code of the read routine looks as follows:

```c
int HxColormap256::readAmiraMesh(AmiraMesh* m, const char* filename) 
{
    int count = 0;

    for (int i = 0; i < m->dataList.size(); i++)
    {
        AmiraMesh::Data* data = m->dataList[i];

        if (data->getLocation()->getNumberOfDimensions() != 1)
            continue;

        if (data->getDimension() < 3 || data->getDimension() > 4)
            continue;

        int dim = data->getDimension();
        int size = data->getLocation()->getDimensions()[0];

        HxColormap256* colormap =
            (HxColormap256*)HxResource::createObject("HxColormap256");

        if (!colormap)
            return 0;

        colormap->resize(size);
        colormap->parameters = m->parameters;
        colormap->historyLog = m->historyLog;

        switch (data->getPrimitiveType().getType())
        {
            case McPrimType::MC_UINT8:
            {
                unsigned char* src = (unsigned char*)data->getDataPtr();
                for (int k = 0; k < size; k++, src += dim)
                {
                    float a = (dim > 3) ? (src[3]) / 255.0 : 1;
                    colormap->setRGBA(k,
                            src[0] / 255.,
                            src[1] / 255.,
                            a);
                }
            }
        }
    }
```
break;

case McPrimType::MC_INT16:
{
    short* src = (short*)data->getDataPtr();
    for (int k = 0; k < size; k++, src += dim)
    {
        float a = (dim > 3) ? (src[3]) / 255.0: 1;
        colormap->setRGBA(k, 
            src[0] / 255.,
            src[1] / 255.,
            a);
    }
}
break;

case McPrimType::MC_UINT16:
{
    unsigned short* src = (unsigned short*)data->getDataPtr();
    for (int k = 0; k < size; k++, src += dim)
    {
        float a = (dim > 3) ? (src[3]) / 255.0: 1;
        colormap->setRGBA(k, 
            src[0] / 255.,
            src[1] / 255.,
            a);
    }
}
break;

case McPrimType::MC_INT32:
{
    int* src = (int*)data->getDataPtr();
    for (int k = 0; k < size; k++, src += dim)
    {
        float a = (dim > 3) ? (src[3]) / 255.0: 1;
        colormap->setRGBA(k, 
            src[0] / 255.,
            src[1] / 255.,
            a);
    }
}
break;

case McPrimType::MC_FLOAT:
{
    float* src = (float*)data->getDataPtr();
    for (int k = 0; k < size; k++, src += dim)
    {
        float a = (dim > 3) ? src[3]: 1;
        colormap->setRGBA(k, src[0], src[1], src[2], a);
    }
}
case McPrimType::MC_DOUBLE:
{
    double* src = (double*)data->getDataPtr();
    for (int k = 0; k < size; k++, src += dim)
    {
        float a = (dim > 3) ? src[3] : 1;
        colormap->setRGBA(k, src[0], src[1], src[2], a);
    }
    break;
}

float minmax[2] = { 0, 1 }; m->parameters.findReal("MinMax", 2, minmax);
colormap->HxColormap::setMinMax(minmax[0], minmax[1]);
{
    int localInterpolate;
    if (m->parameters.findNum("Interpolate", localInterpolate))
    {
        colormap->setInterpolate(localInterpolate ? true : false);
    }
    QString outOfBoundsBehavior;
    if (m->parameters.findString("OutOfBoundsBehavior", outOfBoundsBehavior))
    {
        // i.e = 0
        OutOfBoundsBehavior behavior = HxColormap256::DEFAULT_CLAMP;
        if (outOfBoundsBehavior.contains("CycleLeft"))
            *(int*)&behavior |= CYCLE_BEFORE_MIN;
        if (outOfBoundsBehavior.contains("CycleRight"))
            *(int*)&behavior |= CYCLE_AFTER_MAX;
        colormap->setOutOfBoundsBehavior(behavior);
    }
    int isLabelField;
    if (m->parameters.findNum("LabelField", isLabelField))
    {
        colormap->setLabelField(isLabelField);
        colormap->editMinMax.setMinMaxEnabled(!isLabelField);
    }
}

// Set the default alpha curve if the file does not provide an alpha channel.
if (dim != 4)
{
    colormap->setAlphaCurve(AC_SOFT_RAMP);
}
Compared to the write routine, the read routine is a little bit more complex since some consistency checks are performed. First, the member data_list of the AmiraMesh structure is searched for a one-dimensional array containing vectors of three or four elements of type byte or float. This array should contain the RGB or RGBA values of the colormap. If a matching Data structure is found, a new instance of type HxColormap256 is created. The parameters are copied from the AmiraMesh class into the new colormap. Afterwards, the actual color values are copied. Although the write routine only exports RGBA tuples of type float, the read routine also supports byte data. For this reason, two different cases are distinguished in a switch statement. If the file only contains 3-component data, the opacity value of each colormap entry is set to 1. Finally, the coordinate range of the colormap is set by evaluating the 2-component parameter MinMax, and the new colormap is added to the Project View by calling HxData::registerData.

18.4 Writing Modules

Besides the data classes, modules are the core of Amira. They contain the actual algorithms for visualization and data processing. Modules are instances of C++ classes derived from the common base class HxModule.

There are two major groups of modules: compute modules and display modules. The first group usually performs some sort of operation on input data, creates some resulting data object, and deposits the latter in the Project View. In contrast, display modules usually directly visualize their input data. In this section, both types of modules will be covered in separate sections. For each case, a concrete example will be presented and discussed in detail.

In addition, we also discuss the AmiraPlot API in this section. This API makes it possible to create simple line plots or bar charts within a module. Moreover, Amira allows you to create compute module on GPU in CUDA. For each case a concrete example will be presented and discussed in detail.

18.4.1 A Compute Module

As already mentioned, compute modules usually take one or more input data objects and calculate a new resulting data object from these. The resulting data object is deposited in the Project View. Compute modules are represented by red icons in the Project View. They are derived from the base class HxCompModule.

In order to learn how to implement a new compute module, we will take a look at a concrete example. In particular, we want to write a compute module which performs a threshold operation on a 3D image, i.e., on an input object of type HxUniformScalarField3. The module produces another 3D image as output. In the resulting image, all voxels with a value below a user-specified minimum value or above a maximum value should be set to zero.
For easier understanding, we start with a very simple and limited version of the module. Then we iteratively improve the code. In particular, we proceed in three steps:

- **Version 1**: merely scans the input image, does not yet produce a result
- **Version 2**: creates an output object as result, uses the progress bar
- **Version 3**: adds an Apply button, overwrites the existing result if possible

You can find the source code of all three versions in the example package provided with Amira XPand Extension, i.e., under `src/mypackage` in the local Amira directory. For each version, there are two files: a header file called `MyComputeThresholdN.h` and a source code file called `MyComputeThresholdN.cpp` (where N is either 1, 2, or 3). Since the names are different, you can compile and execute all three versions in parallel.

Afterwards we describe how to implement an **ITK image to image filter compute module**.

In order to create a new local Amira directory, please follow the instructions given in subsection 18.2.2. In order to compile the example package, please refer to subsection 18.1.5 (Compiling and Debugging).

### 18.4.1.1 Version 1: Skeleton of a Compute Module

The first version of our module does not yet produce any output. It simply scans the input image and prints the number of voxels above and below the threshold.

Like most other modules, our compute module consists of a header file containing the class declaration as well as a source file containing the actual code (or the class definition). Let us look at the header file `MyComputeThreshold1.h` first:

```cpp
#ifndef MY_COMPUTE_THRESHOLD1_H
#define MY_COMPUTE_THRESHOLD1_H

#include "api.h" // storage-class specification
#include <hxcore/HxCompModule.h> // include declaration of base class
#include <hxcore/HxPortFloatTextN.h> // provides float text input

class MYPACKAGE_API MyComputeThreshold1: public HxCompModule
{
    HX_HEADER(MyComputeThreshold1); // required for all base classes

    public:
        // This virtual method will be called when the port changes.
        virtual void compute();

        // A port providing float text input fields.
        HxPortFloatTextN portRange;
};
#endif
```

---

**Writing Modules** 680
As usual in C++ code, the file starts with a define statement that prevents the contents of the file from being included multiple times. Then three header files are included.

The package header file api.h is included. This file provides import and export storage-class specifiers for Windows systems. These are encoded in the macro MYPACKAGE_API. A class declared without this macro will not be accessible from outside the DLL it is defined in.

Following api.h, HxCompModule.h contains the definition of the base class of our compute tool. The last file, HxPortFloatTextN.h, contains the definition of a port we want to use in our class. A port represents an input parameter of a tool. In our case, we use a port of type HxPortFloatTextN. This port provides one or more text fields where the user can enter floating point numbers. The required text fields and labels are created automatically within the port constructor. As a programmer, you simply put some ports into your tool, specifying their types and labels, and do not have to bother creating a user interface for it.

In the rest of the header file, nothing more is done than deriving a new class from HxCompModule. The macro HX_HEADER is mandatory. This macro defines especially the default constructor and destructor of the class. A member function is defined, namely an overloaded virtual method called compute. The compute method is called when the module has been created and whenever a change of state occurs on one of the module’s input data objects or ports. In fact, a connection to an input data object is also established by a port, as we shall see later on. In this example, we just declare one port in our class, specifically an instance of type HxPortFloatTextN.

The corresponding source file looks like this:

```c++
// Example of a compute module (version 1)

#include <QApplication>
#include "MyComputeThreshold1.h"  // declaration of this class
#include <hxcore/HxMessage.h>     // for output in console
#include <hxfield/HxUniformScalarField3.h>  // class representing 3D images

HX_INIT_CLASS(MyComputeThreshold1, HxCompModule)  // required macro

MyComputeThreshold1::MyComputeThreshold1()
    : HxCompModule(HxUniformScalarField3::getClassTypeId()),
      portRange(this, "range",
                 QApplication::translate("MyComputeThreshold1", "Range"),
                 2)  // we want to have two float fields
{}

MyComputeThreshold1::~MyComputeThreshold1()
{
}

void
```

Writing Modules

681
MyComputeThreshold1::compute()
{
    // Access the input data object. The member portData (which is of
type HxConnection) is inherited from the base class HxModule.
HxUniformScalarField3* field = (HxUniformScalarField3*)portData.getSource();

    // Check whether the input port is connected
if (!field)
    return;

    // Get the input parameters from the user interface:
float minValue = portRange.getValue(0);
float maxValue = portRange.getValue(1);

    // Access size of data volume:
const McDim3l& dims = field->lattice().getDims();

    // Now loop through the whole field and count the pixels.
int belowCnt = 0, aboveCnt = 0;
for (int k = 0; k < dims[2]; k++)
{
    for (int j = 0; j < dims[1]; j++)
    {
        for (int i = 0; i < dims[0]; i++)
        {
            // This function returns the value at this specific grid node.
            // It implicitly casts the result to float if necessary.
            float value = field->evalReg(i, j, k);
            if (value < minValue)
                belowCnt++;
            else if (value > maxValue)
                aboveCnt++;
        }
    }
}

    // Finally print the result.
theMsg->printf("%d voxels < %g, %d voxels > %g\n", 
          belowCnt,
          minValue,
          aboveCnt,
          maxValue);
}

Following the include statements and the obligatory HX_INIT_CLASS macro, the constructor is defined. The usual C++ syntax must be used in order to call the constructors of the base class and the class members. The constructor of the base class HxCompModule takes the class type of the input data object to which this module can be connected. Amira uses a special run-time type information system that is independent of the rtti feature provided by ANSI C++ compilers.
The second method to define is the destructor.
The third method we have to implement is the compute method. We first retrieve a pointer to our input data object through a member called portData. This port is inherited from the base class

Writing Modules 682
HxModule, i.e., every module has this member. The port is of type HxConnection and it is represented as a blue line in the user interface (if connected). The rest of the compute method is rather straightforward. The way the actual data are accessed and how the computation is performed, of course, is highly specific to the input data class and the task the module performs. In this case, we simply loop over all voxels of the input image and count the number of voxels below the minimum value and above the maximum value. In order to access a voxel’s value, we use the evalReg method. This method is provided by any scalar field with regular coordinates, i.e., by any instance of class HxRegScalarField3. Regardless of the primitive data type of the field, the result will always be cast to float.

Compile the mypackage example package and restart Amira. Instructions for compiling local packages are provided in subsection 18.1.5 (Compiling and Debugging). Load the file chocolate-bar.am from Amira’s data/tutorials directory. Open the Create Object popup menu and click on ComputeThreshold1 inside the Local category to attach the new module. Type in different threshold values in the range port of ComputeThreshold1, and look at the different results that appear in the Console window while you change range values:

0 voxels < 0, 8882137 voxels > 0
0 voxels < 0, 8845776 voxels > 1
0 voxels < 0, 8809669 voxels > 2

18.4.1.2 Version 2: Creating a Result Object

Now that we have a first working version of the module, we can add more functionality. First, we want to create a real output data object. Then we further want to improve the module by using Amira’s progress bar and by providing better default values for the range port. The header file of our module will not be affected by all these changes. We merely need to add some code in the source file MyComputeThreshold2.cpp.

Let us start with the output data object. In the compute method, just before the for-loop, we insert the following statements:

```cpp
// Create output with the same primitive data type as input:
HxUniformScalarField3* output =
    new HxUniformScalarField3(dims, field->primType());

// Output shall have same bounding box as input:
output->coords()->setBoundingBox(field->getBoundingBox());
```

This creates a new instance of type HxUniformScalarField3 with the same dimensions and the same primitive data type as the input data object. Since the output has the same bounding box, i.e., the same voxel size as the input, we copy the bounding box. Note that this approach will only work for fields with uniform coordinates. For other regular coordinate types, such as stacked or curvilinear coordinates, we refer to subsection 18.5.2.

After the output object has been created, its voxel values are not yet initialized. This is done in the inner part of the nested for-loops. The method set, used for this purpose, automatically performs a cast from float to the primitive data type of the output field. In summary, the inner part of the for-loop now looks as follows:
float value = field->evalReg(i,j,k);
float newValue = 0;

if (value<minValue)
    belowCnt++;
else if (value>maxValue)
    aboveCnt++;
else newValue = value;

output->set(i,j,k,newValue);

Creating a new data object using the new operator will not automatically make it appear in the Project View. Instead, we must explicitly register it. In a compute module, this can be done by calling the method setResult:

    setResult(output); // register result

This method adds a data object to the Project View, if it is not already present there. In addition, it connects the object’s master port to the compute module itself. Like any other connection, this link will be represented by a black line in the Project View. The master port of a data object may be connected to a compute module or to an editor. Such a master connection indicates that the data object is controlled by an ’upstream’ component, i.e., that its contents may be overridden by the object to which it is connected.

Now that we have created an output object, let us address the progress bar. Although, for the test data set chocolate-bar.am, our threshold operation does not take very long, it is good practice to indicate that the application is busy when computations are performed that could take a long time on large input data. Even better is to show a progress bar, which is not difficult. Before the time-consuming part of the compute routine, i.e., before the nested for-loops, we add the following line:

    // Turn the application into busy state,
    // don't activate Stop button.
    theProgress->startWorkingNoStop(QApplication::translate("MyComputeThreshold2",
    "Computing threshold"));

We use the global instance theProgress of class HxApplication here. The corresponding header file must be included at the beginning of the source file. The method turns the application into the ‘busy’ state and displays a working message in the status line. As opposed to the method startWorking, this variant does not activate the stop button. See subsection 18.7.2 for details. When the computation is done, we must call

    theProgress->stopWorking(); // stop progress bar

in order to switch off the ‘busy’ state again. Inside the nested for-loops, we update the progress bar just before a new 2D slice is processed. This is done by the following line of code:

    // Set progress bar, the argument ranges between 0 and 1.
    theProgress->setProgressValue((float)(k+1)/dims[2]);
The value of \( (\text{float})(k+1)/\text{dims}[2] \) progressively increases from zero to one during computation. Note that you should not call \texttt{setProgressValue} in the inner of the three loops. Each call involves an update of the graphical user interface and therefore is relatively expensive. It is perfectly okay to update the progress bar several hundred times during a computation, but not several hundred thousand times.

Another slight improvement we have incorporated into the second version of our compute module concerns the range port. In the constructor, we have set new initial values for the minimum and maximum fields. While both values are 0 by default, we now set them to 410 and 950, respectively:

```cpp
// Set default value for the range port:
portRange.setValue(0,410); // min value is 410
portRange.setValue(1,950); // max value is 950
```

You may now test this second version of the compute module by loading the test data set \\texttt{chocolate-bar.am} from Amira's data/tutorials directory. Attach the \texttt{ComputeThreshold2} module from the Local category inside the data popup menu. Open the Console window to watch results as you change the port range values. You can also see new output objects created in the Project View on each change. To better appreciate the progress bar, try to resample the input data, for example to 512x512x100, and connect the compute module to the resampled data set. However, be sure that you have enough main memory installed on your system.

**18.4.1.3 Version 3: Reusing the Result Object**

Testing the first two versions of our module, we saw that the module's compute method is triggered automatically when the module is created and whenever the range port is changed. Each time a new result output data object is created. This quickly fills up the computer's main memory as well as Amira’s graphical user interface. Therefore, we now change this behavior: A new result object is to be created only the first time. Whenever the range port is changed afterwards, the existing result object should be overridden. In order to achieve this, we modify the middle part of the compute method in the following way:

```cpp
// Access size of data volume:
const McDim3l& dims = field->lattice().getDims();

// Check if there is a result which we can reuse.
HxUniformScalarField3* output = (HxUniformScalarField3*) getResult();

// Check for proper type.
if (output && !output->isOfType(HxUniformScalarField3::getClassTypeId()))
    output = 0;

// Check if size and primType still match the current input:
if (output) {
    const McDim3l& outdims = output->lattice().getDims();
    if ( dims != outdims ||
        field->primType() != output->primType())
        output=0;
}
```
// If necessary, create a new result data set.
if (!output) {
    output = new HxUniformScalarField3(dims, field->primType());
    output->composeLabel(toQString(field->getName()), "masked");
}

The getResult method checks whether there is a data set whose master port is connected to the compute module. This typically is the object set by a previous call to setResult. However, it also may be any other object. Therefore, a run-time type check must be performed by calling the isOfType member method of the output object. If the output object is not of type HxUniformScalarField3, the variable output will be set to null. Then a check is made whether the output object has the same dimensions and the same primitive data type as the input object. If this test fails, output will also be set to null. At the end, a new result object will only be created if no result exists already or if the existing result does not match the input. It is possible to interactively try different range values without creating a bunch of new results.

However, when one of the numbers of the range port is changed, computation starts immediately. Sometimes this may be desired, but in this case, we prefer to add an Apply button as present in many other compute modules. The user must explicitly push this button in order to start computation. In order to use the Apply button, the following line of code must be added in the public section of the module’s header file:

    // Start computation when this button is clicked.
    HxPortDoIt portDoIt;

Of course, the corresponding include file hxcore/HxPortDoIt.h must be included as well. As for the other port, we must initialize portDoIt in the constructor of our module in the source file:

MyComputeThreshold3::MyComputeThreshold3() :
    HxCompModule(HxUniformScalarField3::getClassTypeId()),
    portRange(this, "range", QApplication::translate("MyComputeThreshold3", "Range"), 2), // we want to have two float fields
    portDoIt(this, "action", QApplication::translate("MyComputeThreshold3", "Action")) {
    ...

    // Set text of doIt button
    portDoIt.setLabel(0, QApplication::translate("MyComputeThreshold3", "DoIt"));
}

To achieve the desired behavior, we finally change our compute method so that it immediately returns unless the Apply button was pressed. This can be done by adding the following piece of code at the beginning of the compute method:

    // Check whether doIt button was hit
    if (!portDoIt.wasHit()) return;

With these changes, the module is already quite usable. Load the test data set chocolate-bar.am from Amira’s data/tutorials directory. Attach the ComputeThreshold3 module from the
Local category inside the data popup menu. Press the Apply button, change the range and press Apply again. Open the Console window to view results. You may have notice, that only one output object has been created in the Project View. Attach an Ortho Slice module to the result while experimenting with the range (use the histogram mapping in the Ortho Slice in order to see small changes). Try to detach the connection between the result and the module and press Apply again: a new output is created.

Note: By default, the HxPortDoIt port is not visible in the control panel of its associated module. Rather, the fact that a module has an HxPortDoIt activates (makes green) the Apply button at the bottom of the Properties Area. To request display of the DoIt port in the module control panel, check the Show DoIt buttons box in the Layout tab of the Edit/Preferences dialog.

Finally, some remarks on performance. Although it is probably not critical in this simple example, performance typically becomes an issue in real-world applications. In the inner-most loop, calling the methods field->evalReg and output->set is convenient but rather expensive. For example, if the input consists of 16-bit signed integers like in chocolate-bar.am, these methods involve a cast from 16-bit signed to float and back to 16-bit signed.

The performance can be improved by writing code which explicitly handles a particular primitive data type. A pointer to the actual data values of a HxUniformScalarField3 can be obtained by calling field->lattice().dataPtr(). The value returned by this method is of type void*. It must be explicitly cast to the data type to which the field actually belongs. The voxel values itself are arranged without any padding. This means that the index of voxel (i, j, k) is given by \((k \times \text{dims}[1] + j) \times \text{dims}[0] + i\), where \text{dims}[0] and \text{dims}[1] denote the number of voxels in the x and y directions, respectively.

18.4.1.4 Implement an ITK image to image filter

At this point basic understanding of Amira’s compute module architecture is assumed. This example will show how to write an Amira compute module implementing an ITK image to image filter. In a step-by-step manner we will show how to

- use Amira’s ports to specify parameters needed by ITK filters,
- import an Amira image data object into the ITK filter pipeline and export the ITK result image data object, respectively,
- monitor the progress of ITK image filters within Amira’s global progress bar,
- update the ITK filter pipeline by the Amira compute module.

In our example an ITK mean image filter with a variable kernel size will be implemented. You will find the source code within the ITK demo package provided with the Amira XPand Extension, i.e. under packages/myitkpackage in the local Amira directory. There will be two files: a header file called MyITKFilter.h and a source code file called MyITKFilter.cpp. Let us look at the header file MyITKFilter.h first.

```c++

// Example of an ITK compute module

```
As usual in C++ code, the file starts with a define statement that prevents the contents of the file from being included multiple times. Then four header files are included. HxCompModule.h contains the definition of the base class of our compute module. The next two files, HxPortIntSlider.h and HxPortDoIt.h, contain the definitions of two ports we want to use in our class. In our example we use the HxPortIntSlider to specify the kernel size of the filter and the HxPortDoIt port in order to apply the computation. The api.h header file is included to provide import export storage-class specifiers for Windows systems. These are encoded in the macro MYITKPACKAGE_API. A class declared without this macro will not be accessible from outside the DLL it is defined in. On Unix systems the macro is empty and can be omitted. In the rest of the header file nothing more is done than deriving a new class from HxCompModule and defining three member functions, namely the constructor, destructor and an overloaded virtual method called compute. The compute method is called when the module has been created and whenever a change of state occurs on one of the module’s input data objects or ports. Let’s look at some code snippets of the source code file MyITKFilter.cpp in order to clarify important parts of the implementation. In our example the following headers from Amira’s hxitk package are included, providing convenience functionality for wrapping ITK image data objects and monitoring the progress of ITK process objects. Note that ITK headers have to be included without specifying a path in front of the header file name.

```c++
#include <hxitk/HxItkImageImporter.h>
#include <hxitk/HxItkImageExporter.h>
```
As usual the module’s compute method will be triggered automatically if the module is created and whenever the kernel size port or the data respectively have changed. However, our compute method should return immediately unless the Apply button has been pressed. This will be done by the following piece of code at the beginning of the compute method:

```cpp
...  // Check whether doIt button was hit
  if (!portDoIt.wasHit()) return;
...
```

The getResult method checks whether there is a data set whose master port is connected to the compute module. This typically is the object set by a previous call to setResult. However, it also may be any other object. Therefore, a run-time type check will be performed by casting the result returned by getResult via a mcinterface_cast. If the result returned by getResult cannot be cast to the type of a HxUniformScalarField3, the variable resultField will be set to null. Then a check is made whether the output object has the same dimensions and the same primitive data type as the input object. If this test fails, resultField will also be set to null. Note, that only if the variable resultField is null a new output object of type HxUniformScalarField3 will be created later on.

```cpp
void MyITKFilter::compute()
{
...  // Access the input data object. The member portData
  // (which is of type HxConnection) is inherited from
  // the base class HxModule.
  HxUniformScalarField3* inField =
      hxconnection_cast<HxUniformScalarField3>( portData );

  // Check whether the input port is connected
  if (!inField) return;

  // Access size of data volume:
  const int* dims = inField->lattice.dims();

  // Check if there is a result which we can reuse.
  McHandle<HxUniformScalarField3> resultField =
      mcinterface_cast<HxUniformScalarField3>( getResult() );

  // Check for proper type.
  if (resultField &&
      !resultField->isOfType(  
        HxUniformScalarField3::getClassTypeId() )
  )
    resultField = 0;
```
// Check if size and primType still match the current input:
if (resultField) {
    const int* outdims = resultField->lattice.dims();
    if (dims[0]!=outdims[0] ||
        dims[1]!=outdims[1] ||
        dims[2]!=outdims[2] ||
        resultField->primType() != resultField->primType())
        resultField=0;
}

...  

Due to the fact, that ITK is a template library we have to translate the implicitly encoded type information of Amira’s data objects into template code. This is achieved by instantiating different versions of a function template `meanImageFilter` where the actual ITK filtering is implemented.

```cpp
...  
    switch (inField->lattice.primType()) {
        case McPrimType::mc_uint8:
            meanImageFilter<unsigned char>(inField,
                resultField, kernelSize);
            break;
        case McPrimType::mc_uint16:
            meanImageFilter<unsigned short>(inField,
                resultField, kernelSize);
            break;
        case McPrimType::mc_int16:
            meanImageFilter<short>(inField,
                resultField, kernelSize);
            ....
    }
...  
```

The following steps implement the ITK image to image filter pipeline within the `meanImageFilter` function template.

- Create the ITK filter pipeline by defining certain ITK type definitions of input and output images and filters with respect to the template type `Type`. In our example we create a single ITK process object e.g., a mean image filter.

```cpp
...  
    typedef itk::Image< Type, 3 > ImageType;
    typedef itk::MeanImageFilter<ImageType,
        ImageType > FilterType;
    typename FilterType::Pointer filter = FilterType::New();
    ...
```

- Wrap the Amira input data object of type `HxUniformScalarField3` into an ITK image object with the help of the `HxItkImageImporter` template class. The result of `HxItkImageImporter::getOutput()` has to be passed as input image to the first process object of the filtering pipeline. Note that the `HxItkImageImporter` only maps the data
of the HxUniformScalarField3 into the ITK image data object. Meaning that no additional memory will be allocated, but the ITK image data object will use the memory allocated by the Amira data object.

```cpp
... 
HxItkImageImporter<Type> importer(inField);
filter->SetInput(importer.GetOutput());
...
```

- Provide an Amira data object of type HxUniformScalarField3 where the result image of the ITK filter pipeline should be written. Therefore, the output image of the last ITK process object of the filter pipeline has to be wrapped by the HxItkImageExporter template class. If an existing resultField has been passed to the constructor the data of the HxUniformScalarField3 will be mapped into the ITK image data object. Again, the ITK output image will not allocate memory, but use the data allocated by the Amira data object. If no valid pointer of type HxUniformScalarField3 has been provided via the constructor ITK will allocate the memory. Later on, a new Amira data object of type HxUniformScalarField3 will be created by HxItkImageExporter::getResult(), which afterward takes over the buffer allocated by the ITK image (see below).

```cpp
... 
HxItkImageExporter<ImageType> exporter(
    filter->GetOutput(),
    resultField.ptr());
...
```

- Observe the ITK process object’s progress and visualize it within Amira’s global progress bar. Therefore, an instance of HxItkProgressObserver needs to be instantiated. In order to monitor the progress of an ITK process object it has to be registered via the HxItkProgressObserver::startObservingProcessObject() member function.

```cpp
... 
/// Display filter progress within global progress bar
HxItkProgressObserver progress;
progress.startObservingProcessObject(filter);
progress.setProgressMessage(
    QApplication::translate("MyITKFilter", "Applying mean filter..."));
... 
```

- Update the ITK filter pipeline and get the result. If a null pointer has been passed to the constructor of HxItkImageExporter, HxItkImageExporter::getResult() will create a new Amira data object, which takes over the buffer allocated by the ITK image. To avoid memory leaks HxItkImageExporter holds a handle (see McHandle) on the newly created Amira data object of type HxUniformScalarField3. Thus a variable of type McHandle<HxUniformScalarField3> has to be used in order to store the result.
and increase the reference count of the Amira data object. Otherwise, the newly created result data object will be deleted within the exporter’s destructor.

If an existing result field of type `HxUniformScalarField3` has been passed to the constructor of `HxItkImageExporter`, calling `HxItkImageExporter::getResult()` isn’t necessary because the pointer to the reused Amira data object won’t change.

```cpp
...  
// Execute the filter
filter->Update();

resultField = exporter.getResult();
```

### 18.4.2 A Display Module

Our next example is a module which displays some geometry in Amira’s 3D viewer. The module takes a surface model as input and draws a little cube at every vertex that belongs to \( n \) triangles, where \( n \) is a user-adjustable parameter.

From the previous section, we already know the basic idea: we derive a new class from the base class `HxModule`. Since this time our module does not produce a new data set, we directly use `HxModule` as base class instead of `HxCompModule`. As input, the module should accept data of class `HxSurface`. We need one additional port allowing the user to specify the parameter \( n \). As in the previous section, we develop different versions of our module, thereby introducing new concepts step by step:

- **Version 1:**
  creates an Open Inventor scene graph and displays it in the viewer.
- **Version 2:**
  adds a colormap port, provides a parse method for Tcl commands.
- **Version 3:**
  implements a new display mode, dynamically shows or hides a port.

You can find the source code of all three versions of the module in the example package provided with Amira XPand Extension, i.e., under `src/mypackage` in the local Amira directory. For each version there are two files, a header file called `MyDisplayVerticesN.h` and a source code file called `MyDisplayVerticesN.cpp` (where \( N \) is either 1, 2, or 3). Since the names are different, you can compile and execute all three version in parallel.

In order to create a new local Amira directory, please follow the instructions given in subsection 18.2.2. In order to compile the example package, please refer to subsection 18.1.5 (Compiling and Debugging).

#### 18.4.2.1 Version 1: Displaying Geometry

The first version of our module, called `MyDisplayVertices1`, merely detects the vertices of interest and displays them using little cubes. In order to understand the code, we first need to look more closely at the class `HxSurface`. As we can see in the reference documentation, a surface essentially contains an array of 3D points and an array of triangles. Each triangle has three indices pointing into the list...
of points. In order to count the triangles per vertex, we simply walk through the list of triangles and increment a counter for each vertex.

Once we have detected all interesting vertices, we are going to display them using small cubes. This is done by creating an Open Inventor scene graph. If you want to learn more about Open Inventor, you probably should look at *The Inventor Mentor*, an excellent book about Open Inventor published by Addison-Wesley. In brief, an Open Inventor scene graph is a tree-like structure of C++ objects which describes a 3D scene. Our scene is quite simple. It consists of one separator node containing several cubes, i.e., instances of class SoCube. Since an SoCube is always located at the origin, we put an additional node of type SoTranslation right before each SoCube. We adjust the size of the cubes so that each side is 0.01 times the length of the diagonal of the bounding box of the input surface.

After this short overview, we now look at the header file of the module. It is called MyDisplayVertices1.h:

```cpp
#ifndef MY_DISPLAY_VERTICES1_H
#define MY_DISPLAY_VERTICES1_H

#include "api.h"    // storage-class specification
#include <hxcore/HxModule.h>    // include declaration of base class
#include <hxcore/HxPortIntSlider.h> // provides integer slider
#include <mclib/McHandle.h>  // smart pointer template class
#include <Inventor/nodes/SoSeparator.h>

class MYPACKAGE_API MyDisplayVertices1: public HxModule
{
    HX_HEADER(MyDisplayVertices1);

public:
    // Input parameter.
    HxPortIntSlider portNumTriangles;

    // This is called when an input port changes.
    virtual void compute();

protected:
    McHandle<SoSeparator> scene;
};
#endif
```

The header file can be understood quite easily. First, some other header files are included. Then the new module is declared as a child class of HxModule. As usual, the macros MYPACKAGE_API and HX_HEADER are mandatory, the last one including the definition of the default constructor and destructor. Our module implements a compute method. In addition, it has a port of type HxPortIntSlider which allows the user to specify the number of triangles of the vertices to be displayed.

A pointer to the actual Open Inventor scene is stored in the member variable scene of type McHandle<SoSeparator>. A McHandle is a so-called smart pointer. It can be used like an ordinary C pointer. However, each time a value is assigned to it, the reference counter of the referenced object is automatically increased or decreased. This is done by calling the ref or unref
method of the object. If the reference counter becomes zero or less, the object is deleted automatically. We recommend using smart pointers instead of C pointers because they are safer. The actual implementation of the module is contained in the file `MyDisplayVertices1.cpp`. This file looks as follows:

```cpp
///////////////////////////////////////////////////////////////////////
// // Example of a compute module (version 1) // /////////////////////////////////////////////////////////////////////////

#include <QApplication>
#include "MyDisplayVertices1.h" // header of this class
#include <hxcore/HxMessage.h> // for output in console
#include <hxsurface/HxSurface.h> // class representing a surface
#include <Inventor/nodes/SoCube.h>
#include <Inventor/nodes/SoTranslation.h>

HX_INIT_CLASS(MyDisplayVertices1, HxModule)

MyDisplayVertices1::MyDisplayVertices1()
  : HxModule(HxSurface::getClassTypeId())
    , portNumTriangles(this,
      "numTriangles",
      QApplication::translate("MyDisplayVertices1", "Num Triangles"))
{
  portNumTriangles.setMinMax(1, 12);
  portNumTriangles.setValue(6);
  scene = new SoSeparator;
}

MyDisplayVertices1::~MyDisplayVertices1()
{
  hideGeom(scene);
}

void
MyDisplayVertices1::compute()
{
  int i;

  // Access input object (portData is inherited from HxModule):
  HxSurface* surface = (HxSurface*)portData.getSource();

  if (!surface)
    // Check if input object is available
    hideGeom(scene);
    return;
}

  // Get value from input port, query size of surface:
```

*Writing Modules* 694
int numTriPerVertex = portNumTriangles.getValue();
int nVertices = surface->points().size();
int nTriangles = surface->triangles().size();

// We need a triangle counter for every vertex:
McDArray<unsigned short> triCount(nVertices);
triCount.fill(0);

// Loop through all triangles and increase counter of the vertices:
for (i = 0; i < nTriangles; i++)
    for (int j = 0; j < 3; j++)
        triCount[surface->triangles()[i].points[j]]++;

// Now create the scene graph. First remove all previous childs:
scene->removeAllChildren();

// Cube size should be 1% of the diagonal of the bounding box.
float size = surface->getBoundingBox().getSize().length() * 0.01;

// Pointer to surface coordinates casted from McVec3f to SbVec3f.
SbVec3f* p = (SbVec3f*)surface->points().dataPtr();
SbVec3f q(0, 0, 0); // position of last point
int count = 0; // vertex counter
for (i = 0; i < nVertices; i++)
{
    if (triCount[i] == numTriPerVertex)
    {
        SoTranslation* trans = new SoTranslation;
        trans->translation.setValue(p[i] - q);

        SoCube* cube = new SoCube;
        cube->width = cube->height = cube->depth = size;
        scene->addChild(trans);
        scene->addChild(cube);

        count++;
        q = p[i];
    }
}

theMsg->printf("Found %d vertices belonging to %d triangles",
    count,
    numTriPerVertex);

showGeom(scene); // finally show scene in viewer
}

A lot of things are happening here. Let us point out some of these in more detail now. The constructor initializes the base class with the type returned by HxSurface::getClassTypeId. This ensures that the module can only be attached to data objects of type HxSurface. The constructor also ini-
tializes the member variable portNumTriangles. The range of the slider is set from 1 to 12. The initial value is set to 6. Finally, a new Open Inventor separator node is created and stored in scene. The destructor contains only one call, hideGeom(scene). This causes the Open Inventor scene to be removed from all viewers (provided it is visible). The scene itself is deleted automatically when the destructor of McHandle is called.

The actual computation is performed in the compute method. The method returns immediately if no input surface is present. If an input surface exists, the numbers of triangles per point are counted. For this purpose, a dynamic array triCount is defined. The array provides a counter for each vertex. Initially it is filled with zeros. The counters are increased in a loop over the vertices of all triangles. In the second part of the compute method, the Open Inventor scene graph is created. First, all previous children of scene are removed. Then the length of the diagonal of the input surface is determined. The size of the cubes will be set proportional to this length. For convenience, the pointer to the coordinates of the surface is stored in a local variable p. Actually, the coordinates are of type McVec3<float>. However, this class is fully compatible with the Open Inventor vector class SbVec3f. Therefore, the pointer to the coordinates can be cast as shown in the code.

After everything has been set up, every element of the array triCount is checked in a for-loop. If the value of an element matches the selected number of triangles per vertex, two new Inventor nodes of type SoTranslation and SoCube are created, initialized, and inserted into scene. Since the SoTranslation also affects all subsequent translation nodes, we must remember the position of the last point in q and subtract this position from the one of the current point. Alternatively, we could have encapsulated the SoTranslation and the SoCube in an additional SoSeparator node. However, this would have resulted in a more complex scene graph. At the very end of the compute method, the new scene graph is made visible in the viewer by calling showGeom. This method automatically checks if a node has already been visible. Therefore, it may be called multiple times with the same argument.

The module is registered in the usual way in the package resource file, i.e., in mypackage/share/resource/mypackage.rc. Once you have compiled the example package, you may test the module by loading the surface mypackage/data/test.surf located in the local Amira directory. Attach the module DisplayVertices1 from the Local category inside the popup menu of the data.

18.4.2.2 Version 2: Adding Color and a Parse Method

In this section, we want to add two more features to our module. First, we want to use a colormap port which allows us to specify the color of the cubes. Second, we want to add a parse method which allows us to specify additional Tcl commands for the module.

A colormap port is used to establish a connection to a colormap, i.e., to a class of type HxColormap. It is derived from HxConnection but, in contrast to the base class, it provides a graphical user interface showing the contents of the colormap and letting the user change its coordinate range. If no colormap is connected to the port, a default color is displayed. The default color can be edited by the user by double-clicking the color bar.

In order to provide our module with a colormap port, we must insert the following line into the module's header file:
Of course, we must also include the header file of the class `HxPortColormap`. This file is located in package `hxcolor`. Note that the order in which ports are displayed on the screen depends on the order in which the ports are declared in the header file. If we declare `portColormap` before `portNumTriangles`, the colormap port will be displayed before the integer slider.

In the compute method of our module, we add the following piece of code just after the previous children of the scene graph have been removed:

```cpp
SoMaterial* material = new SoMaterial;
material->diffuseColor =
    portColormap.getColor(numTriPerVertex);
scene->addChild(material);
```

With these lines, we insert a material node right before all the translation and cube nodes into the separator. The material node causes the cubes to be displayed in a certain color. We call the `getColor` method of the colormap port in order to determine this color. If the port is not connected to a colormap, this method simply returns the default color. However, if it is connected, the color is taken from the colormap. As an argument, we specify `numTriPerVertex`, the number of triangles of the selected vertices. Depending on the value of `portNumTriangles`, the cubes, therefore, will be displayed in different colors. Of course, this requires that the range of the colormap extend from something like 1 to 10 or 12.

Besides the colormap port, we also want to add a Tcl command interface to our module. This is done by overloading the virtual method `parse` of `HxModule`. We, therefore, insert the following line into the module’s class declaration:

```cpp
virtual int parse(Tcl_Interp* t, int argc, char **argv);
```

In a parse method, special commands can be defined which allow us to control the module in a more sophisticated way. A typical application is to set special parameters which should not be represented by a separate port in the user interface. As an example, we want to provide a method which allows us to change the size of the cubes. In the initial version of the module, the cubes were adjusted so that each side was 0.01 times the length of the diagonal of the bounding box of the input surface. The value of the scale factor shall now be stored in the member variable `scale`. In order to set and get this variable, two Tcl commands `setScale` and `setScale` shall be provided. The implementation of the parse method looks as follows:

```cpp
int MyDisplayVertices2::parse(Tcl_Interp* t, int argc, char **argv)
{
    if (argc < 2)
        return TCL_OK;
    QString cmd = QString::fromUtf8(argv[1]);

    if (cmdCheck(cmd, "setScale"))
    {
```
Commands are defined in a sequence of if-else statements. For each command, the method `cmdCheck` should be used. At the end of the if-else sequence the parse method of the base class should be called. Note that after a command is issued, the compute method of the module will not be called automatically by default. This is in contrast to interactive changes of ports. However, we may explicitly call `fire` in a command like shown above. In this case, the size of the cubes then will be adjusted immediately. You may test the parse method by loading the file `mypackage/data/test.surf`, attaching `DisplayVertices2` to it, and then typing something like `DisplayVertices2.setScale 0.03` into the Amira console window.

### 18.4.2.3 Version 3: Adding an Update Method

Besides a compute method, modules may also define an *update* method. This method is called just before the compute method and also whenever a module is selected. In the update method, the user-interface of the module can be configured, i.e., ports can be shown or hidden dynamically if this is required, the sensitivity of ports can be adjusted, or the number of entries of an option menu can be modified dynamically.

In order to illustrate how an update method might work, we implement an alternate display mode in our module. In this mode, all vertices of a surface should be displayed, not only the ones with a certain number of neighboring triangles. In this second mode, the slider `portNumTriangles` is not meaningful anymore. We, therefore, hide it by defining an appropriate update method. The following lines are added in the header file `MyDisplayVertices3.h`:

```cpp
// Mode: 0=selected vertices, 1=all vertices
HxPortRadioBox portMode;

// Shows or hides required ports.
virtual void update();
```

The new radio box port lets the user switch between the two display modes. Like the compute method, the update method takes no argument and also has no return value.

If you look into the source code file `MyDisplayVertices3.cpp`, you will notice that the radio box port is initialized in the constructor of the module and that the text labels are set properly. The update method itself is quite simple:
void MyDisplayVertices3::update()
{
    if (portMode.getValue() == 0)
        portNumTriangles.show();
    else
        portNumTriangles.hide();
}

The slider portNumTriangles is shown or hidden depending on the value of the radio box port. Note that before the update method is called, all ports are marked to be shown. Therefore, you must hide them every time update is called. For example, the show and hide calls should not be encapsulated by an if statement which checks if some input port is new.

In order to support the new all-vertices display style, we slightly modify the way the Open Inventor scene graph is created. Instead of a single SoMaterial node, we insert a new one whenever the color of a cube needs to be changed, i.e., whenever the number of triangles of a vertex differs from the previous one. The new for-loop looks as follows:

```cpp
int lastNumTriPerVertex = -1;
int allVertices = portMode.getValue();

for (i = 0; i < nVertices; i++)
{
    if (allVertices || triCount[i] == numTriPerVertex)
    {
        if (triCount[i] != lastNumTriPerVertex)
        {
            SoMaterial* material = new SoMaterial;
            material->diffuseColor = portColormap.getColor(triCount[i]);
            scene->addChild(material);
            lastNumTriPerVertex = triCount[i];
        }

        SoTranslation* trans = new SoTranslation;
        trans->translation.setValue(p[i] - q);

        SoCube* cube = new SoCube;
        cube->width = cube->height = cube->depth = size;

        scene->addChild(trans);
        scene->addChild(cube);

        count++;
        q = p[i];
    }
}
```

Again, you can test the module by loading the file mypackage/data/test.surf and attaching DisplayVertices3 to it. If you connect the physics.icol colormap to the colormap port, adjust the colormap range to 1...9, and select the all-vertices display style, you should get an image similar to the one shown in Figure 18.11.
18.4.3 A Module With Plot Output

In some cases, you may want to show a simple 2D plot in an Amira module, for example a histogram or some bar chart. To facilitate this task Amira provides a special-purpose *Plot API* which can be used in any Amira object, regardless of whether it is a compute module or a display module. The class *PzEasyPlot* provides the necessary methods to open a plot window and to draw in that window. In the following, we illustrate how to use this class, again by means of an example. In particular, we are going to write a module which plots the number of voxels per slice for all materials defined in a label image. A label image usually represents the results of an image segmentation operation. For each voxel, there is a label indicating to which material the voxel belongs. Further features of the *plot API* will be described in a separate section.

18.4.3.1 A Simple Plot Example

In this section, we show how to plot some simple curves using the class *PzEasyPlot*. As mentioned above, the curves represent the number of voxels per slice for the materials of a label image. For this purpose, we define a new module called *MyPlotAreaPerSlice*. Like the other examples, this module is contained in the Amira example package. In order to check out the example package, you must create a local Amira directory as described in subsection 18.2.2. In order to compile the example package, please refer to subsection 18.1.5 (Compiling and Debugging). Let us first look at the header file *MyPlotAreaPerSlice.h*:

```
/////////////////////////////////////////////////////////////////////
//
// Example of a plot module (header file)
//
/////////////////////////////////////////////////////////////////////
```
#ifndef MY_PLOT_AREA_PER_SLICE_H
#define MY_PLOT_AREA_PER_SLICE_H

#include "api.h" // storage-class specification
#include <hxcore/HxModule.h> // include declaration of base class
#include <hxcore/HxPortButtonList.h> // provides a push button
#include <hxplot/PzEasyPlot.h> // simple plot window

class MYPACKAGE_API MyPlotAreaPerSlice: public HxModule
{
    HX_HEADER(MyPlotAreaPerSlice);

public:
    // Shows the plot window.
    HxPortButtonList portAction;

    // Performs the actual computation.
    virtual void compute();

protected:
    McHandle<PzEasyPlot> plot;
};
#endif

The class declaration is very simple. The module is derived directly from HxModule. It provides a compute method and a port of type HxPortButtonList. In fact, we will only use a single push button in order to let the user pop up the plot window. The plot window class PzEasyPlot itself is referenced by a smart pointer, i.e., by a variable of type McHandle<PzEasyPlot>. We have already used smart pointers in subsection 18.4.2.1, for details see there.

Now let us take a look at the source file MyPlotAreaPerSlice.cpp:

Thông số: 

The class declaration is very simple. The module is derived directly from HxModule. It provides a compute method and a port of type HxPortButtonList. In fact, we will only use a single push button in order to let the user pop up the plot window. The plot window class PzEasyPlot itself is referenced by a smart pointer, i.e., by a variable of type McHandle<PzEasyPlot>. We have already used smart pointers in subsection 18.4.2.1, for details see there.

Now let us take a look at the source file MyPlotAreaPerSlice.cpp:

```cpp
#include "MyPlotAreaPerSlice.h" // declaration of this module
#include <QApplication>
#include <hxcore/HxApplication.h>
#include <hxcore/HxProgressInterface.h>
#include <hxfield/HxLabelLattice3.h> // represents segmentation results

HX_INIT_CLASS(MyPlotAreaPerSlice, HxModule)

MyPlotAreaPerSlice::MyPlotAreaPerSlice()
    : HxModule(HxLabelLattice3::getClassTypeId())
    , portAction(this,
        "action",
        QApplication::translate("MyPlotAreaPerSlice", "Action"),
        1)
```
portAction.setLabel(0, 
    QApplication::translate("MyPlotAreaPerSlice", "Show Plot");
plot = new PzEasyPlot("Area per slice");
plot->autoUpdate(0);
}

MyPlotAreaPerSlice::~MyPlotAreaPerSlice()
{
}

void MyPlotAreaPerSlice::compute()
{
    HxLabelLattice3* lattice = 
        (HxLabelLattice3*)portData.getSource(HxLabelLattice3::getClassTypeId());

    // Check if valid input is available.
    if (!lattice)
    {
        plot->hide();
        return;
    }

    // Return if plot window is invisible and show button wasn’t hit
    if (!plot->isVisible() && !portAction.isNew())
        return;

    theProgress->busy(); // activate busy cursor

    int i, k, n;
    const McDim3& dims = lattice->getDims();
    unsigned char* data = lattice->getLabels<unsigned char>();
    int nMaterials = lattice->materials()->getNumberOfBundles();

    // One counter per material and slice
    McDArray<McDArray<float> > count(nMaterials);

    for (n = 0; n < nMaterials; n++)
    {
        count[n].resize(dims[2]);
        count[n].fill(0);
    }

    // Count number of voxels per material and slice
    for (k = 0; k < dims[2]; k++)
    {
        for (i = 0; i < dims[1] * dims[0]; i++)
        {
            int label = data[k * dims[0] * dims[1] + i];
            if (label < nMaterials)
                count[label][k]++;
        }
    }

Writing Modules
plot->remData(); // remove old curves

for (n = 0; n < nMaterials; n++) // add new curves
    plot->putData(
        lattice->materials()->getBundle(n)->getName().toLatin1().constData(),
        dims[2],
        count[n].dataPtr());

plot->update(); // refresh display
plot->show(); // show or raise plot window

theProgress->notBusy(); // deactivate busy cursor
}

In the constructor, the base class HxModule is initialized with the class type ID of the class HxLabelLattice3. This class is not a data class derived from HxData but a so-called interface. Interfaces are used to provide a common API for objects not directly related by inheritance. In our case, MyPlotAreaPerSlice can be connected to any data object providing a HxLabelLattice3 interface. This might be a HxUniformLabelField3 but also a HxStackedLabelField3 or something else.

Also in the constructor, a new plot window of type PzEasyPlot is created and stored in plot. Then the method plot->autoUpdate(0) is called. This means that we must explicitly call the update method of PzEasyPlot after the contents of the plot window are changed. Auto-update should be disabled when more than one curve is being changed at once.

As usual, the actual work is performed by the compute method. First, we retrieve a pointer to the label lattice. Since we want to use an interface instead of a data object itself, we must specify the class type ID of the interface as an argument of the source method of portData. Otherwise, we would get a pointer to the object providing the interface, but we can’t be sure about the type of this object.

The method returns if no label lattice is present or if the plot window is not visible and the show button has not been pressed. Otherwise, the contents of the plot window are recomputed from scratch. For this purpose, a dynamic array of arrays called count is defined. The array provides a counter for each material and for each slice of the label lattice. Initially, all counters are set to zero. Afterwards, they are incremented while the voxels are traversed in a nested for-loop.

The actual initialization of the plot window happens subsequently. First, old curves are removed by calling plot->remData. Then, for each material, a new curve is added by calling plot->putData. Afterwards, plot->update is called. If we had not disabled ‘auto update’ in the constructor, the plot window would have been updated automatically in each call of putData. The putData method creates a curve with the given name and sets the values. If a curve of the given name exists, the old values are overridden. The method returns a pointer to the curve which in turn can be used to set attributes for the curve individually (see below). Finally, the plot window is popped up and the ‘busy’ cursor we have activated before is switched off again.

To test the module, first compile the example package. For instructions, see subsection 18.1.5 (Compiling and Debugging). Then load the file data/tutorials/chocolate-bar-labels.am from the Amira root directory. Attach PlotAreaPerSlice to it and press the show button. You
then should get a result like that shown in Figure 18.12.

Figure 18.12: Plot produced by sample module PlotAreaPerSlice.

18.4.3.2 Additional Features of the Plot API

The ‘pointer to curve’ objects returned by the putData call can be used to access the curve directly, i.e., to manipulate its attributes. The most important attributes of curve objects are:

- Color, represented by a RGB values between 0 and 1. Can be set by calling:
  ```cpp
  curve->setAttr("color", r, g, b);
  ```

- Line width, represented by an integer number. Can be set by calling:
  ```cpp
  curve->setAttr("linewidth", linewidth);
  ```

- Line type, represented by an integer number. Available line types are 0=no line, 1=line, 2=dashed, 3=dash-dotted, and 4=dotted. Can be set by calling:
  ```cpp
  curve->setAttr("linetype", type);
  ```

- Curve type, represented by an integer number. Available curve types are 0=line curve, 1=histogram, 2=marked line, 3=marker. Can be set by calling:
  ```cpp
  curve->setAttr("curvetype", type);
  ```

For each attribute corresponding getAttr methods are available. In order to access the axis of the 'easy plot' window, you must call

```cpp
PzAxis* axis = plot->getTheAxis();
```

Don’t forget to include the corresponding header file PzAxis.h.
The color, line width, and line type attributes of the curves apply to axes as well. Besides this, there are some more methods to change the appearance of axes:

```cpp
// Set the range of the axes
float xmin = 0.0, xmax = 1.0;
float ymin = 0.0, ymax = 1.0;
axis->setMinMax(xmin, xmax, ymin, ymax);

// Set the label of an axis
axis->setAxisLabel(0, "X Axis");
axis->setAxisLabel(1, "Y Axis");
```

If you are not satisfied with the size of the plot window and you don’t want to change it using the mouse every time, just call `setSize` right after creating the plot window:

```cpp
plot->setSize(width, height);
```

As you would expect, the methods `getMinMax`, `getAxisLabel` and `getSize` are also available with the same parameter list as their `set` counterparts.

Finally, it is also possible to have a legend or a grid in the plot. In this case, more arguments must be specified in the constructor of `PzEasyPlot`:

```cpp
int withLegend = 1;
int withGrid = 0;
plot = new PzEasyPlot("Area per slice",
                     withLegend, withGrid);
```

Like the axis, the legend and the grid are internally represented by separate objects of type `PzLegend` and `PzGrid`. You can access these objects by calling the methods `getTheLegend` and `getTheGrid`. Details about the member methods of these objects are listed in the class reference documentation.

### 18.4.4 A Compute Module on GPU

Amira contains everything necessary for execution of GPU programming in CUDA. Unfortunately, a specialized toolkit needs to be installed to develop new modules with GPU compute capabilities. To follow the next steps of this guide, installing CUDA toolkit is necessary. Please note that this tutorial is supported on Windows only.

The latest CUDA Toolkit can be downloaded from this URL: [CUDA Toolkit Download page](#). However, it is more reliable to download the version used by Amira. This version can be found here: [CUDA 6.5](#)

Once downloaded, run the installation instructions of the toolkit. The installers usually provide CUDA Toolkit, CUDA Samples and the minimal driver version for CUDA. Please carefully follow the instructions given with the installers and check that CUDA works on the system.

Once the installation is successfully finished, an environment variable must be set so that Amira knows where to find the CUDA toolkit. This environment variable must be called `CUDA_PATH` and contain the path to the CUDA Toolkit (Location validated during the installation).

For CUDA programming, you must have a CUDA compatible GPU with an up-to-date driver. Yet, GPU programming is complex and could be tricky. This tutorial does not intend to be a GPU
programming tutorial. This tutorial purpose is to demonstrate how to interface a GPU program within Amira and requires minimal knowledges in the domain of GPU programming.

In order to learn how to implement a module using GPU programming, we will take a look at a concrete example. In particular, we want to write a module which applies a 2D Gaussian filter on a 3D image, i.e., on an input object of type \textit{HxUniformScalarField3}. The module produces another 3D image as output which is placed in the Project View.

We present you one implementation:

- **Version 1**: a version using CUDA C

You can find the source code of both versions in the example package provided with Amira XPand Extension, i.e., under `src/gaussianfiltercudac` in the local Amira directory. For each version, there are three files: a header file, a source code CPU file and a source code GPU file. Since the names are different, you can compile and execute both versions in parallel.

These modules present how to integrate GPU filters in Amira. They are as simple as possible to be didactic, so they are not able to treat large amount of data.

Once you have compiled the example module, you can load the file `lobus.am` from Amira's data/tutorials directory and attach the module to it. These modules can be found in the Local category of the data popup menu. Instructions for compiling local packages are provided in subsection 18.1.5 (Compiling and Debugging). If you encounter any error while attaching one of the module or executing it (ex: a dialog complaining about CUDA version, or unknown symbols that prevent a lib to be loaded...), update your graphics driver.

For each module, you can evaluate performance with the TCL command `time`. For the GaussianFilterCudaC module, check the auto-refresh box and execute the following command in Amira console:

```
time \{GaussianFilterCudaC fire\} 5
```

It will apply 5 times the filter on your data and print the average amount of time required per iteration, in microseconds.

In order to create a new local Amira directory, please follow the instructions given in subsection 18.2.2. In order to compile the example package, please refer to subsection 18.1.5 (Compiling and Debugging). When a compute module using CUDA API calls is added to an existing package, the \texttt{LIBS} entry of the Package file must be completed depending on the used API. The keyword to add in the list of libraries to link with is:

- **CUDA C API**: \texttt{cudac};

For example, if the targeted API is CUDA C, the Package file should contain something like:

```
set LIBS {
    hxplot hxtime hxsurface hxcolor hxfield
    hxcore amiramesh mclib oiv tcl qt cudac
}
```

\textit{Writing Modules}
18.4.4.1 Version 1: Gaussian filter in CUDA C

The main interface currently supported to write CUDA programs is CUDA C. CUDA driver API is not exposed in Amira.

CUDA C exposes the CUDA programming model as a minimal set of extensions to the C language. These extensions allow programmers to define a kernel as a C function and use some new syntax to specify the grid and block dimension each time the function is called. The first filter is implemented at this level.

The source is divided in two separated parts:

- a CPU part with a header file and a C++ file: GaussianFilterCudaC.h and GaussianFilterCudaC.cpp
- a GPU part with a CUDA file: Convolve2DCudaC.cu

In order to be didactic, this version is not the optimal implementation for this filter. The GaussianFilterCudaCOptimized module is another CUDA C implementation of this Gaussian filter which gives better performance. This implementation is not detailed in this document but it is implemented in the three files called GaussianFilterCudaCOptimized.h, GaussianFilterCudaCOptimized.cpp and Convolve2DCudaCOptimized.cu.

18.4.4.1.1 CPU part

Like most other modules, our compute module consists of a header file containing the class declaration as well as a source file containing the actual code (or the class definition). Let us look at the header file GaussianFilterCudaC.h first:

```c
//------------------------------------------------------------------------------
// Example of a convolution filter in CUDA C
//------------------------------------------------------------------------------

#ifndef GAUSSIANFILTERCUDAC_H
#define GAUSSIANFILTERCUDAC_H

#include <hxcore/HxCompModule.h>
#include <hxcore/HxPortDoIt.h>
#include "api.h"

// Defined in Convolve2DCudaC.cu
extern "C" cudaError
applyFilter(const unsigned char* h_src,
           unsigned char* h_dst,
           const float* h_filter,
           const int* h_dims,
           const int sizeFilter);

class GAUSSIANFILTERCUDAC_API GaussianFilterCudaC: public HxCompModule
{
    // This macro is required for all modules and data objects
    HX_HEADER(GaussianFilterCudaC);
```
As usual in C++ code, the file starts with a define statement that prevents the contents of the file from being included multiple times. Then two header files are included. HxCompModule.h contains the definition of the base class of our compute module. The other file, HxPortDoIt.h, allows the use of the Apply button.

The package header file api.h is included. This file provides import and export storage-class specifications for Windows systems. These are encoded in the macro GAUSSIANFILTERCUDAC_API. A class declared without this macro will not be accessible from outside the DLL in which it is defined. On Unix systems, the macro is empty and can be omitted.

The applyFilter function is declared with the extern "C" qualifier. This function is defined in the Convolve2DCudaC.cu file and will be explained in the GPU section.

In the rest of the header file, the only tasks that remain are to derive a new class from HxCompModule and define one member function, namely the overloaded virtual method called compute. The compute method is called when the module has been created and whenever a change of state occurs on one of the module’s input data objects or ports.

The corresponding source file looks like this:

```cpp
#include <QApplication>
#include <hxcore/HxApplication.h>
#include <hxcore/HxMessage.h>
#include <hxcore/HxProgressInterface.h>
#include <hxfield/HxUniformScalarField3.h>
#include <mclib/McPrimType.h>

#include "CudaCUtils.h"
#include "GaussianFilterCudaC.h"

HX_INIT_CLASS(GaussianFilterCudaC, HxCompModule)

GaussianFilterCudaC::GaussianFilterCudaC()
    : HxCompModule(HxUniformScalarField3::getClassTypeId()),
     portAction(this, "action",
                QApplication::translate("GaussianFilterCudaC", "Action"))
```
GaussianFilterCudaC::~GaussianFilterCudaC()
{
}

void
GaussianFilterCudaC::compute()
{
    // Check whether Apply button was hit
    if (!portAction.wasHit())
        return;

    // Access the input data object
    HxUniformScalarField3* input = (HxUniformScalarField3*)portData.getSource();

    // Check whether the input port is connected
    if (!input)
        return;

    // Check data type
    if (input->primType() != McPrimType::MC_UINT8)
        return;

    // Turn into busy state, don’t activate the Stop button
    theProgress->startWorkingNoStop(QApplication::translate("GaussianFilterCudaC", "Filtering"));

    // Access size of data volume
    const McDim3l& dims = input->lattice().getDims();

    // Check if there is a result which we can reuse
    HxUniformScalarField3* output = (HxUniformScalarField3*)getResult();

    // Check for proper type
    if (output && !output->isOfType(HxUniformScalarField3::getClassTypeId()))
        output = 0;

    // Check if size and primType still match the current input
    if (output)
    {
        const McDim3l& outdims = output->lattice().getDims();
        if (dims != outdims ||
            input->primType() != output->primType())
            output = 0;
    }

    // If necessary, create a new result data set
    if (!output)
    {
        output = new HxUniformScalarField3(dims, input->primType());
    }
}
Following the include statements, there is the required HX_INIT_CLASS macro for class initialization. Next is the constructor definition which calls the constructor of the base class. There are no special macros for this, so the usual C++ syntax is used to call the base class constructor and to initialize the class members. The constructor of the base class HxCompModule takes the class type of the input data object to which this module can be connected.

The second method we have to implement is the compute method. We first retrieve a pointer to our input data object through a member called portData. This port is inherited from the base class HxModule, i.e., every module has this member. The port is of type HxConnection and it is represented as a blue line in the user interface (if connected). This filter only accepts unsigned char images, so we must check the data type.

A new result object is to be created. Whenever the range port is changed afterwards, the existing result object should be overridden. The output file is of type HxUniformScalarField3. The getResult method checks whether there is a data set whose master port is connected to the compute module. However, it also may be any other object. Therefore, a run-time type check must be performed by calling the isOfType member method of the output object. If the output object is not of type HxUniformScalarField3, the variable output will be set to null. Then a check is made whether
the output object has the same dimensions and the same primitive data type as the input object. If this test fails, output will also be set to null. At the end, a new result object will only be created if no result exists already or if the existing result does not match the input.

Then the Gaussian filter is defined and the applyFilter function is called. The calls to input->lattice.dataPtr() and output->lattice.dataPtr() allow us to get a pointer to the data values of the input and output objects. The returned value of this dataPtr method is of type void*. It must be explicitly cast to the data type to which the field actually belongs. The voxel values itself are arranged without any padding. This means that the index of voxel (i, j, k) is given by \( k \times \text{dims}[1] + j \times \text{dims}[0] + i \), where \( \text{dims}[0] \) and \( \text{dims}[1] \) denote the number of voxels in the x and y directions, respectively.

After the device computation, the cleanupNoFailure function is called in order to correctly clean up device memory, if there is a CUDA error.

Finally, creating a new data object using the new operator will not automatically make it appear in the Project View. Instead, we must explicitly register it. In a compute module, this can be done by calling the method setResult. This method adds a data object to the Project View if it is not already present there. In addition, it connects the object’s master port to the compute module itself. Like any other connection, this link will be represented by a blue line in the Project View. The master port of a data object may be connected to a compute module or to an editor. Such a master connection indicates that the data object is controlled by an ‘upstream’ component, i.e., that its contents may be overridden by the object to which it is connected.

18.4.4.1.2 GPU part In GPU programming, it is important to know where a variable is located in memory (specifically, which section of memory). To make it easier to keep track of this, variable names are prefixed in the CUDA file with an identifier indicating their memory location:

- h_ if the variable is in host memory
- d_ if the variable is in device global memory
- c_ if the variable is in device constant memory
- s_ if the variable is in device shared memory

The CUDA file Convolve2DCudaC.cu is the following:

---

**Writing Modules**

711
// Example of a convolution filter in CUDA

#define BLOCK_SIZE 16
#define BORDER_SIZE 1

// In constant memory
__constant__ float c_filter[9]; // Convolution filter
__constant__ int c_dims[3]; // Size of data volume

// Compute 2D convolution product with a 3x3 filter
// __device__: callable form the device, executed on the device
__device__ unsigned char
convolve2DDrv( int i,
    int j,
    unsigned char s_imageBlock[BLOCK_SIZE + 2 * BORDER_SIZE][BLOCK_SIZE + 2 * BORDER_SIZE],
    int imageBlockSize )
{
    int idxFilter = 0;
    float convolutionProduct = 0;
    for ( int ii = - BORDER_SIZE; ii <= BORDER_SIZE; ii++)
    {
        for ( int jj = - BORDER_SIZE; jj <= BORDER_SIZE; jj++)
        {
            convolutionProduct += s_imageBlock[i + ii][j + jj] * c_filter[idxFilter];
            idxFilter++;
        }
    }
    return convolutionProduct;
}

// Return the voxel’s value (i, j) of the buffer d_slice
// __device__: callable form the device, executed on the device
int
__device__ getValueDrv( int i, int j, const unsigned char* d_slice )
{
    unsigned char value;
    if ( (i >= 0) && (i < c_dims[0]) && (j >= 0) && (j < c_dims[1]) )
    {
        value = d_slice[j * c_dims[0] + i];
    }
    else
    {
        value = 0;
    }
    return value;
}

// Fill in a variable in shared memory and call convolve2D
// __global__: callable form the host, executed on the device
__global__ void
applyFilterKernel( unsigned char* d_src, unsigned char* d_dst )
{
    // The threadIdx variable indicates the thread position in the block.
    // The blockIdx variable indicates the block position in the grid.
    // The blockDim variable indicates the dimension of thread block.
    // (i, j, k) repairs the top left corner of the slice in d_src
    int k = blockIdx.y * blockDim.y / c_dims[1];
    int i = blockIdx.x * blockDim.x;
    int j = (blockIdx.y - k * c_dims[1] / blockDim.y) * blockDim.y;

    // In shared memory
    __shared__ unsigned char s_imageBlock[BLOCK_SIZE + 2][BLOCK_SIZE + 2];
    int imageBlockSize = BLOCK_SIZE + 2 * BORDER_SIZE;

    // Pointer to the top left corner of the current slice
    const unsigned char* d_slice = d_src + k * c_dims[1] * c_dims[0];

    int iBlock = threadIdx.x + BORDER_SIZE;
    int jBlock = threadIdx.y + BORDER_SIZE;

    // Fill in imageBlock
    // Main data
    s_imageBlock[iBlock][jBlock] = getValueDrv(i + threadIdx.x, j + threadIdx.y, d_slice);
    if (iBlock == 1)
    {
        // Left border
        s_imageBlock[0][jBlock] = getValueDrv(blockIdx.x * blockDim.x - 1, j + threadIdx.y, d_slice);
        s_imageBlock[0][jBlock - 1] = getValueDrv(blockIdx.x * blockDim.x - 1, j + threadIdx.y - 1, d_slice);
    }
    else if (iBlock == BLOCK_SIZE)
    {
        // Right border
        s_imageBlock[imageBlockSize - 1][jBlock] = getValueDrv(blockIdx.x * blockDim.x + imageBlockSize - 1, j + threadIdx.y, d_slice);
        s_imageBlock[imageBlockSize - 1][jBlock + 1] = getValueDrv(blockIdx.x * blockDim.x + imageBlockSize - 1, j + threadIdx.y + 1, d_slice);
    }
    if (jBlock == 1)
    {
        // Top border
        s_imageBlock[iBlock][0] = getValueDrv(i + threadIdx.x, j - 1, d_slice);
        s_imageBlock[iBlock + 1][0] = getValueDrv(i + threadIdx.x + 1, j - 1, d_slice);
    }
}
else if ( jBlock == BLOCK_SIZE )
{
    // Bottom border
    s_imageBlock[iBlock][imageBlockSize - 1] =
        getValueDrv( i + threadIdx.x, j + imageBlockSize - 1, d_slice );
    s_imageBlock[iBlock - 1][imageBlockSize - 1] =
        getValueDrv( i + threadIdx.x - 1, j + imageBlockSize - 1, d_slice );
}

// All threads should have finished to fill in s_imageBlock
// before begin computation of convolution product
__syncthreads();

// Compute convolution product
int idx = k * c_dims[1] * c_dims[0];
idx += ( j + threadIdx.y ) * c_dims[0];
idx += i + threadIdx.x;
d_dst[idx] = convolve2DDrv( iBlock, jBlock, s_imageBlock, imageBlockSize );

// Call the kernel
extern "C" cudaError
applyFilter( const unsigned char* h_src,
             unsigned char* h_dst,
             const float* h_filter,
             const int* h_dims,
             const int sizeFilter )
{
    int dimsTotal = h_dims[0] * h_dims[1] * h_dims[2];
    // Clear error state
    cudaGetLastError();

    // Allocate device memory
    void* d_src = NULL;
    void* d_dst = NULL;
cudaMalloc( &d_src, dimsTotal * sizeof(unsigned char) );
cudaMalloc( &d_dst, dimsTotal * sizeof(unsigned char) );

    // Copy host memory to device
cudaMemcpy( d_src, h_src, dimsTotal * sizeof(unsigned char) ,
              cudaMemcpyHostToDevice);
cudaMemcpyToSymbol( c_filter, h_filter, 9 * sizeof(float) );
cudaMemcpyToSymbol( c_dims, h_dims, 3 * sizeof(int) );

    // Execute GPU kernel
dim3 nThreadsPerBlock( BLOCK_SIZE, BLOCK_SIZE );
dim3 nBlocks( h_dims[0] / BLOCK_SIZE, h_dims[1] * h_dims[2] / BLOCK_SIZE );
applyFilterKernel<<<nBlocks, nThreadsPerBlock>>>(
    static_cast<unsigned char*>(d_src),
    static_cast<unsigned char*>(d_dst) );

Writing Modules 714
This file begins with a definition of two global variables: BLOCK_SIZE will be used to size the grid and blocks and BORDER_SIZE. Then, two variables are declared with the __constant__ qualifier, and they will be placed in constant memory. A variable in constant memory must be initialized by the CPU and it is visible from all threads in read-only. The c_filter will contain the convolution filter and the c_dims variable the size of data volume.

Following these declarations, the convolution product is defined in the convolve2D function. This is a __device__ function, i.e., it must be called from GPU and it is executed on the device. This function computes the 2D convolution product at the point \((i,j)\) with a 3 * 3 filter.

The getValue function returns the voxel’s value \((i,j)\) of a buffer.

The applyFilterKernel function is called for each voxel. It is defined using the __global__ qualifier. This means that the function is called from the host and executed on the device. It is a kernel function, so it must have the void return type.

The initial 3D image is divided in several blocks of size BLOCK_SIZE * BLOCK_SIZE. Three indexes \(i, j, \text{ and } k\) are declared to repair the top left corner of the current slice in \(d_{src}\) and to define \(d_{slice}\).

The \(s_{imageBlock}\) buffer is created and placed in shared memory. Then this buffer is filled in and represents a part of the initial image. The size of this buffer is \((\text{BLOCK}_{\text{SIZE}} + 2) \times (\text{BLOCK}_{\text{SIZE}} + 2)\) in order to correctly treat the borders (1 size border around the image because the convolution filter is a 3 * 3 filter).

The two indexes \(i_{Block}\) and \(j_{Block}\) allow filling in the \(s_{imageBlock}\) buffer.

Before using \(s_{imageBlock}\) for calculation, we must be sure that this buffer is full, so we use the __syncthreads() function. This function acts as a barrier at which all threads in the block must wait before any is allowed to proceed. After this, each thread computes one convolution product using \(imageBlock\).

The last function in this file is the applyFilter function which handles the interaction between the CPU and GPU.

In order to manage CUDA errors, we first call the cudaMemcpy function which returns the last error that has been produced by any of the runtime calls in the same host thread and resets it to CUDA_SUCCESS. Several pointers are declared in order to be allocated in GPU memory. They are allocated in global memory using the cudaMemcpy function. The cudaMemcpy function is used to initialized the \(d_{src}\) buffer from host memory. The direction of the transfer is indicated by the
cudaMemcpyHostToDevice flag.
The d_filter, which was declared at the beginning of this file, is in constant memory, so it is initialized with the cudaMemcpyToSymbol function.
The host initiates the execution of the kernel function, applyFilterKernel, on the CUDA device. A CUDA device contains individual processing elements, each of which can execute a thread. A number of the processing elements are grouped together to form a block, and a group of blocks constitute a grid. The dimensions of grids and blocks are defined in variables nThreadsPerBlock and nBlocks. The number of blocks and the number of threads in each block are indicated between <<<...>>> following the kernel name. This information is picked up by the Nvidia compiler, nvcc, and is used when generating the instructions that start the kernel on the CUDA device. Following that, a list of arguments is passed to kernel function. The applyFilterKernel function fills in the d_dst buffer. After calculation, we must copy this buffer to host memory. This is done using the cudaMemcpy function with the cudaMemcpyDeviceToHost flag.
Finally, the global memory is freed using the cudaFree function and all runtime-related resources associated with the calling host thread are cleaned up by calling the cudaThreadExit function. The last CUDA error is returned using the cudaGetLastError function.

18.5 Data Classes

This section provides an overview of the structure of Amira data classes. Important classes are discussed in more detail. In particular, the following topics will be covered:

- an introduction to data classes, including the hierarchy of data classes
- data on regular grids, e.g., 3D images with uniform or stacked coords
- tetrahedral grids, including data fields defined on such grids
- hexahedral grids, including data fields defined on such grids
- unstructured mixed models, including data fields defined on such models
- other issues related to data classes, including transparent data access

18.5.1 Introduction

A profound knowledge of the Amira data objects is essential to developers. Data objects occur as input of write routines and almost all modules, and as output of read routines and compute modules. In the previous sections, we already encountered several examples of Amira data objects such as 3D image data (represented by the class HxUniformScalarField3), triangular surfaces (represented by the class HxSurface), or colormaps (represented by the class HxColormap). Like modules, data objects are instances of C++ classes. All data objects are derived from the common base class HxData. Data objects are represented by green icons in Amira’s Project View.
In the following, let us first present an overview of the hierarchy of data classes. Afterwards, we will discuss some of the general concepts behind it.
18.5.1.1 The Hierarchy of Data Classes

The hierarchy of Amira data classes roughly looks as follows (derived classes are indented, auxiliary base classes are ignored):

- **HxData**  
  base class of all data objects
- **HxSpreadSheet**  
  spreadsheet containing an arbitrary number of rows and columns
- **HxColormap**  
  base class of colormaps
  - **HxColormap256**  
    colormap consisting of discrete RGBA tuples
- **HxSpatialData**  
  data objects embedded in 3D space
- **HxFIELD3**  
  base class representing fields in 3D space
  - **HxScalarField3**  
    scalar field (1 component)
    - **HxRegScalarField3**  
      scalar field with regular coordinates
    - **HxUniformScalarField3**  
      scalar field with uniform coordinates
    - **HxAnnaScalarField3**  
      scalar field defined by an analytic expression
    - **HxTetraScalarField3**  
      scalar field defined on a tetrahedral grid
    - **HxHexaScalarField3**  
      scalar field defined on a hexahedral grid
  - **HxVectorField3**  
    vector field (3 components)
    - **HxRegVectorField3**  
      vector field with regular coordinates
    - **HxUniformVectorField3**  
      vector field with uniform coordinates
    - **HxAnnaVectorField3**  
      vector field defined by an analytic expression
    - **HxTetraVectorField3**  
      vector field defined on a tetrahedral grid
    - **HxHexaVectorField3**  
      vector field defined on a hexahedral grid
  - **HxColorField3**  
    color field consisting of RGBA-tuples
    - **HxRegColorField3**  
      color field with regular coordinates
    - **HxUniformColorField3**  
      color field with uniform coordinates
  - **HxRegField3**  
    other n-component field with regular coordinates
  - **HxTetraField3**  
    other n-component field defined on a tetrahedral grid
  - **HxHexaField3**  
    other n-component field defined on a hexahedral grid
- **HxVertexSet**  
  data objects providing a set of discrete vertices
- **HxSurface**  
  represents a triangular surface
- **HxTetraGrid**  
  represents a tetrahedral grid
- **HxHexaGrid**  
  represents a hexahedral grid
- **HxSurfaceField**  
  base class for fields defined on triangular surfaces
  - **HxSurfaceScalarField**  
    scalar field defined on a surface (1 component)
  - **HxSurfaceVectorField**  
    vector field defined on a surface (3 components)
  - **HxSurfaceField**  
    other n-component field defined on a surface

Note that you can find an in-depth description of every class in the online reference documentation: share/devrefAmira/Amira.chm or share/devrefAmira/index.html in the Amira root directory. The reference documentation not only covers data objects, but all classes provided with Amira XPAand Extension. As you already know, these classes are arranged in packages. For example, all data classes derived from HxFIELD3 are located in package hxfield, and all classes
related to triangular surfaces are located in package hxsurface.

18.5.1.2 Remarks About the Class Hierarchy

All data classes are derived from the base class HxData. This class in turn is derived from HXObject, the base class of all objects that can be put into the Amira Project View. The class HxData adds support for reading and writing data objects, and it provides the variable parameters of type HxParamBundle. This variable can be used to annotate a data object by an arbitrary number of nested parameters. The parameters of any data object can be edited interactively using the parameter editor described in the User’s Guide.

We observe that the majority of data classes are derived from HxSpatialData. This is the base class of all data objects which are embedded in 3D space as opposed to color maps. HxSpatialData adds support for user-defined affine transformations, i.e., translations, rotations, and scaling. For details refer to subsection 18.5.6.2. It also provides the virtual method getBoundingBox which is redefined by all derived classes. Two important child classes of HxSpatialData are HxField3 and HxVertexSet. HxVertexSet is the base class of all data objects that are defined on an unstructured set of vertices in 3D space, like surfaces or tetrahedral grids. The class provides methods to apply a user-defined affine transformation to all vertices of the object, or modify the point coordinates in some other way. HxField3 is the base class of data fields defined on a 3D-domain, like 3D scalar fields or 3D vector fields. HxField3 defines an efficient procedural interface to evaluate the field at an arbitrary 3D point within the domain, independent of whether the latter is a regular grid, a tetrahedral grid, or something else. The procedural interface is described in more detail in subsection 18.5.6.1.

Looking at the inheritance hierarchy again, we observe that a high level distinction is made between fields returning a different number of data values. For example, all 3D scalar fields are derived from a common base class HxScalarField3, and all 3D vector fields are derived from a common base class HxVectorField3. The reason for this structure is that many modules depend on the data dimensionality of a field only, not on the internal representation of the data. For example, a module for visualizing a flow field by means of particle tracing can be written to accept any object of type HxVectorField3 as input. It then automatically operates on all derived vector fields, regardless of the type of grid they are defined on.

On the other hand, it is often useful to treat the number of data variables of a field as a dynamic quantity and to distinguish between the type of grid a field is defined on. For example, we may wish to have a common base class of fields defined on a regular grid and derived classes for regular scalar or vector fields. Since this structure and the one sketched above are very hard to incorporate into a common class graph, even if multiple inheritance were used, another concept has been chosen in Amira, namely interfaces. Interfaces were first introduced by the Java programming language. They allow the programmer to take advantage of common properties of classes that are not related by inheritance.

In Amira, interfaces can be implemented as class members, or as additional base classes. In the first case, a data class contains an interface class, while in the second case, it is derived from HxInterface. Important interface classes are HxLattice3, HxTetraData, and HxHexaData, which are members of fields defined on regular, tetrahedral, and hexa-
hedral grids, respectively. Another example is HxLabelLattice3, which is a member of HxUniformLabelField3, as well as HxStackedLabelField3. In subsection 18.4.3.1, we have already presented an example of how to use this interface in order to write a module which operates on any label image, regardless of the actual coordinate type.

18.5.2 Data on Regular Grids

Fields defined on a regular grid occur in many different applications. For example, 3D image volumes fall into this category. The term ‘regular’ means that the nodes of the grid are arranged as a regular 3D array, i.e., every node can be addressed by an index triple (i,j,k). A regular field can be characterized by three major properties: the coordinate type, the number of data components, and the primitive component data type (for example short or float).

In the class hierarchy, a major distinction is made between the number of data components of a field. For example, there is a class HxRegScalarField3 representing (one-component) scalar fields defined on a regular grid. This class is derived from the general base class HxScalarField3. Similar classes exist for (three-component) vector fields, complex scalar field, and complex vector fields defined on regular grids. Fields not falling into one of these categories, i.e., fields defined on regular grids with a different number of data components, are represented by the class HxRegField3 which is directly derived from HxField3. Moreover, there are separate subclasses for the most relevant combinations of the number of data components and the coordinates type, like HxStackedScalarField3 or HxUniformVectorField3. All regular data classes provide a member variable lattice of type HxLattice3. This variable is an interface. It can be used to access data fields with a different number of components in a transparent way.

The lattice interface is discussed in more detail below. We then present an overview of all supported coordinate types. Afterwards, two more types of data fields defined on regular coordinates are discussed, namely label images and color fields.

Note that all these fields can be evaluated without regard to the actual coordinate type or the primitive data type by means of Amira’s procedural interface for 3D fields (see subsection 18.5.6.1).

18.5.2.1 The Lattice Interface

The actual data of any regular 3D field is stored in a member variable lattice of type HxLattice3. This variable essentially represents a dynamic 3D array of n-component vectors. The number of vector components as well as the primitive data type are subject to change, i.e., a data object of type HxLattice3 can be re-initialized to hold a different number of components of different primitive data type. However, a lattice contained in an object of type HxRegScalarField3 always consists of 1-component vectors, while a lattice contained in an object of type HxRegVectorField3 always consists of 3-component vectors. In addition, the coordinates of the field are stored in a separate coordinate object that is also referenced by the lattice.

Accessing the Data  To learn what kind of methods are provided by the lattice class, please refer to the online reference documentation or directly inspect the header file HxLattice3.h located in package hxfield. At this point, we just present a short example which shows how the dimensionality of the lattice, the number of data components, and the primitive data type can be queried. The primitive
data type is encoded by the class McPrimType defined in package mclib. In particular, here are some of the following data types supported by Amira:

- McPrimType::mc_uint8 (8-bit unsigned bytes)
- McPrimType::mc_int16 (16-bit signed shorts)
- McPrimType::mc_uint16 (16-bit unsigned shorts)
- McPrimType::mc_int32 (32-bit signed integers)
- McPrimType::mc_float (32-bit floats)
- McPrimType::mc_double (64-bit doubles)
- ...

Regardless of the actual type of the lattice data values, the pointer to the data array is returned as void*. The return value must be explicitly cast to a pointer of the correct type. This is illustrated in the following example where we compute the maximum value of all data components of a lattice. Note that the data values are stored one after another without any padding. The first index runs fastest.

```cpp
HxLattice3& lattice = field->lattice();
const int* dims = lattice.dims();
int nDataVar = lattice.nDataVar();

switch (lattice.primType()) {
  case McPrimType::mc_uint8: {
    unsigned char* data = (unsigned char*) lattice.dataPtr();
    unsigned char max = data[0];
    for (int k=0; k<dims[2]; k++)
      for (int j=0; j<dims[1]; j++)
        for (int i=0; i<dims[0]; i++)
          for (int n=0; n<nDataVar; n++) {
            int idx = nDataVar*((k*dims[1]+j)*dims[0]+i)+n;
            if (data[idx]>max)
              max = data[idx];
          }
    theMsg->printf("Max value is %d", max);
  } break;
  case McPrimType::mc_int16: {
    short* data = (short*) lattice.dataPtr();
    short max = data[0];
    for (int k=0; k<dims[2]; k++)
      for (int j=0; j<dims[1]; j++)
        for (int i=0; i<dims[0]; i++)
          for (int n=0; n<nDataVar; n++) {
            int idx = nDataVar*((k*dims[1]+j)*dims[0]+i)+n;
            if (data[idx]>max)
              max = data[idx];
          }
    theMsg->printf("Max value is %d", max);
  } break;
  ...
}
```

Data Classes
As a tip, note that the processing of different primitive data types can often be simplified by defining appropriate template functions locally. In the case of our example, such a template function may look like this:

```c++
template<class T>
void getmax(T* data, const int* dims, int nDataVar)
{
    T max = data[0];
    for (int k=0; k<dims[2]; k++)
        for (int j=0; j<dims[1]; j++)
            for (int i=0; i<dims[0]; i++)
                for (int n=0; n<nDataVar; n++) {
                    int idx = nDataVar*((k*dims[1]+j)*dims[0]+i)+n;
                    if (data[idx]>max)
                        max = data[idx];
                }
    theMsg->printf("Max value is %d", max);
}
```

Using this template function, the above switch statement looks as follows:

```c++
switch (lattice.primType()) {
    case McPrimType::mc_uint8:
        getmax((unsigned char*)lattice.dataPtr(),dims,nDataVar);
        break;
    case McPrimType::mc_int16:
        getmax((short*)lattice.dataPtr(),dims,nDataVar);
        break;
    ...
}
```

Though less efficient, another possibility for handling different primitive data types is to use one of the methods `eval`, `set`, `getData`, or `putData`. These methods always involve a cast to `float`, if the primitive data type of the field requires it.

**Accessing the Lattice Interface** Imagine you want to write a module which operates on any kind of regular field, i.e., on objects of type `HxRegScalarField3`, `HxRegVectorField3`, and so on. One way to achieve this would be to configure the input port of the module so that it can be connected to all possible regular field input objects. This can be done by calling the method `portData.addType()` in the module’s constructor multiple times with the required class type IDs. In addition, all input types must be listed in the package resource file. This can be done by specifying a blank-separated list of types as the argument of the `-primary` option of the module.
command. In the compute method of the module, the actual type of the input must be queried, then the input pointer must be cast to the required type before a pointer to the lattice member of the object can be stored.

Of course, this approach is very tedious. A much simpler approach is to make use of the fact that the lattice member of a regular field is an interface. Instead of the name of a real data class, the class type ID of HxLattice3 may be used to specify to what kind of input object a module may be connected to. In fact, if this is done, any data object providing the lattice interface will be considered as a valid input. In order to access the lattice interface of the input object, the following statement must be used in the module’s compute method (also check subsection 18.4.3.1 for an example of how to deal with interfaces):

```cpp
HxLattice3* lattice = (HxLattice3*)
portData.source(HxLattice3::getClassTypeId());
```

Creating a Field From an Existing Lattice When working with lattices, we may want to deposit a new lattice in the Project View, for example, as the result of a compute module. However, since HxLattice3 is not an Amira data class, this is not possible. Instead we must create a suitable field object of which the lattice is a member. For this purpose, the class HxLattice3 provides a static method create which creates a regular field and puts an existing lattice into it. If the lattice contains one data component, a scalar field will be created; if it contains three components, a vector field will be created, and so on. The resulting field may then be used as the result of a compute module. Note that the lattice must not be deleted once it has been put into a field object. The concept is illustrated by the following example:

```cpp
HxLattice3* lattice = new HxLattice3(dims, nDataVar,
primType, otherLattice->coords()->duplicate());
...

HxField3* field = HxLattice3::create(lattice);
theObjectPool->addObject(field);
```

18.5.2.2 Regular Coordinate Types

Currently four different coordinate types are supported for regular fields, namely uniform coordinates, stacked coordinates, rectilinear coordinates, and curvilinear coordinates. The coordinate types are distinguished by way of the enumeration data type HxCoordType. The coordinates themselves are stored in a separate utility class of type HxCoord3 which is referenced by the lattice member of a regular field. For each coordinate type, there is a corresponding subclass of HxCoord3. As already mentioned in the introduction, for some important cases, there are special subclasses of a regular field dedicated to a particular coordinate type. Examples are HxStackedScalarField3 (derived from HxRegScalarField3) or HxUniformVectorField3 (derived from HxRegVectorField3). If such special classes do not exist, the regular base class should be used instead. In this case, the coordinate type must be checked dynamically and the pointer to the coordinate object has to be down-cast explicitly before it can be used. This is illustrated in the following example:
HxCoord3* coord = field->lattice.coords();

if (coord->coordType() == c_rectilinear) {
    HxRectilinearCoord3* rectcoord =
        (HxRectilinearCoord3*) coord;
    ...
}

**Uniform Coordinates**  Uniform coordinates are the simplest form of regular coordinates. All grid cells are axis-aligned and of equal size. In order to compute the position of a particular grid node, it is sufficient to know the number of cells in each direction as well as the bounding box of the grid. Uniform coordinates are represented by the class HxUniformCoord3. This class provides a method bbox which returns a pointer to an array of six floats describing the bounding box of the grid. The six numbers represent the minimum x-value, the maximum x-value, the minimum y-value, the maximum y-value, the minimum z-value, and the maximum z-value in that order. Note that the values refer to grid nodes, i.e., to the corner of a grid cell or to the center of a voxel. In order to compute the width of a voxel, you should use code like this:

```c
    const int* dims = uniformcoords->dims();
    const float* bbox = uniformcoords->bbox();
    float width = (dims[0]>1) ? (bbox[1]-bbox[0])/(dims[0]-1):0;
```

**Stacked Coordinates**  Stacked coordinates are used to describe a stack of uniform 2D slices with variable slice distance. They are represented by the class HxStackedCoord3. This class provides a method bboxXY which returns a pointer to an array of four floats describing the bounding box of a 2D slice. In addition, the method coordZ returns a pointer to an array containing the z-coordinate of each 2D slice.

**Rectilinear Coordinates**  Same as for uniform or stacked coordinates, in the case of rectilinear coordinates the grid cells are aligned to the axes, but the grid spacing may vary from cell to cell in each direction. Rectilinear coordinates are represented by the class HxRectilinearCoord3. This class provides three methods, coordX, coordY, and coordZ, returning pointers to the arrays of x-, y-, and z-coordinates, respectively.

**Curvilinear Coordinates**  In the case of curvilinear coordinates, the position of each grid node is stored explicitly as a 3D vector of floats. A single grid cell need not to be axis-aligned anymore. An example of a 2D curvilinear grid is shown in Figure 18.13. Curvilinear coordinates are represented by the class HxCurvilinearCoord3. This class provides a method pos which can be used to query the position of a grid node indicated by an index triple (i,j,k). Alternatively, a pointer to the coordinate values may be obtained by calling the method coords. The coordinate vectors are stored one after another without padding and with index i running fastest. Here is an example:

```c
    const int* dims = curvilinearcoords->dims();
```

**Data Classes**
const float* coords = curvilinearcoords->coords();

// Position of grid node (i,j,k)
float x = coords[3*((k*dims[1]+j)*dims[0]+i)];
float y = coords[3*((k*dims[1]+j)*dims[0]+i)+1];
float z = coords[3*((k*dims[1]+j)*dims[0]+i)+2];

Figure 18.13: Example of a 2D grid with curvilinear coordinates.

18.5.2.3 Label Images and the Label Lattice Interface
Label fields are used to store the results of an image segmentation process. Essentially, at each voxel, a number is stored indicating to which material the voxel belongs. Consequently, label images can be considered scalar fields. In fact, currently there are two different types of label images, one for uniform coordinates (represented by class HxUniformLabelField3 derived from HxUniformScalarField3) and one for stacked coordinates (represented by class HxStackedLabelField3 derived from class HxStackedScalarField3). Since the two types are not derived from a common base class, a special-purpose interface called HxLabelLattice3 is provided. In fact, this interface is in turn derived from HxLattice3. It replaces the standard lattice variable of ordinary regular fields (see subsection 18.5.2.1).

The primitive data type of a label image can be McPrimType::mc_uint8, McPrimType::mc_uint16 or McPrimType::mc_int32. In addition to the standard lattice interface, the label lattice interface also provides access to the label field’s materials. Materials are stored in a special parameter subdirectory of the underlying data object. While discussing the plot API, we already encountered an example of how to interpret the materials of a label image (see subsection 18.4.3.1). Note that whenever a new label is introduced, a new entry should also be put into the material list. Existing materials are marked so that they can not be removed from the material list (this would corrupt the labeling). In order to remove obsolete materials, call the method removeEmptyMaterials of HxLabelLattice3.

In addition to the labels, special weights can be stored in a label lattice. These weights are used to achieve sub-voxel accuracy when reconstructing 3D surfaces from the segmentation results. A pointer
to the weights can be obtained by calling `getWeights` or `getWeights2` of the label lattice. For more details about `HxLabelLattice3`, please refer to the online class documentation.

### 18.5.2.4 Color Fields

Color fields are yet another type of regular fields. They consist of 4-component RGBA-byte-tuples and are represented by the class `HxRegColorField3` derived from `HxColorField3`. The latter class is closely related to `HxScalarField3` or `HxVectorField3`, see the overview on data class inheritance presented in subsection 18.5.1.1. For color fields with uniform coordinates, there is a special subclass `HxUniformColorField3`. Like any other regular fields, color fields provide a member `lattice` which can be used to access the data in a transparent way.

### 18.5.3 Unstructured Tetrahedral Data

Another important type of data refers to fields defined on unstructured tetrahedral grids. Such grids are often used in finite element simulations (FEM). In Amira, tetrahedral grids and data fields defined on such grids are implemented by two different classes or groups of classes and are also distinguished in the user interface by different icons. The reason is that by separating grid and data there is no need for replicating the grid in case many fields are defined on the same grid, a case that occurs frequently in practice.

In the following two sections, we introduce the grid class `HxTetraGrid` before discussing the corresponding field classes and the interface `HxTetraData`.

#### 18.5.3.1 Tetrahedral Grids

Tetrahedral grids in Amira are implemented by the class `HxTetraGrid` and its base class `Tetra Grid`. Looking at the reference documentation of `Tetra Grid`, we observe that a tetrahedral grid essentially consists of a number of dynamic arrays such as `points`, `tetras`, or `materialIds`.

- The `points` array is a list of all 3D points contained in the grid. A single point is stored as an element of type `McVec3<float>`. This class has the same layout as the Open Inventor class `SbVec3f`. Thus, a pointer to `McVec3<float>` can be cast to a pointer to `SbVec3f` and vice versa.

- The `tetras` array describes the actual tetrahedra. For each tetrahedron, the indices of the four points and the indices of the four triangles it consists of are stored. The numbering of the points and triangles is shown in Figure 18.14. In particular, the fourth point is located above of the triangle defined by the first three points. Triangle number $i$ is located opposite to point number $i$.

- The `materialIds` array contains 8-bit labels that assign a `material` identifier to every tetrahedron. For example, this is used in tetrahedral grids generated from segmented image data to distinguish between different image segments corresponding to different material components of physical objects represented by the (3D) image data. Like in the case of label images or surfaces, the set of possible material values is stored in the parameter list of the grid data object.
The three arrays, `points`, `tetras`, and `materialIds`, must be provided by the 'user'. The triangles of the grid are stored in an additional array called `triangles`. This array can be constructed automatically by calling the member method `createTriangles2`. This method computes the triangles from scratch and sets the triangle indices of all tetrahedra defined in `tetras`. The `triangles` array also provides a way for accessing neighboring tetrahedra. Among other information (see reference documentation) stored for each triangle, the indices of the two tetrahedra it belongs to are available. In the case of boundary triangles, one of these indices is -1. Therefore, in order to get the index of a neighboring tetrahedron you can use the following code:

```cpp
// Find tetra adjacent to tetra n at face 0:
int triangle = grid->tetras[n].triangles[0];
otherTetra = grid->triangles[triangle].tetras[0];
if (otherTetra == n)
    otherTetra = grid->triangles[triangle].tetras[1];
if (otherTetra == -1) {
    // No neighboring tetra, boundary face
    ...
}
```

Note that it is possible to define a grid with duplicated vertices, i.e., with vertices having exactly the same coordinates. This is useful to represent discontinuous data fields. The method `createTriangles2` checks for such duplicated nodes and correctly creates a single triangle between two geometrically adjacent tetrahedra, even if these tetrahedra refer to duplicated points.

Optionally, the edges of a grid can be computed in addition to its points, triangles, and tetrahedra by calling `createEdges`. The edges are stored in an array called `edges` and another array `edgesPerTetra` is used in order to store the indices of the six edges of a tetrahedron.

Moreover, the class `Tetra Grid` provides additional optional arrays, for example to store a dynamic list of the indices of all tetrahedra adjacent to a particular point (`tetrasPerPoint`). This and other information is primarily used for internal purposes, for example to facilitate editing and smoothing of tetrahedral grids.

Data Classes
18.5.3.2 Data Defined on Tetrahedral Grids

In most applications, you will not only have to deal with a single tetrahedral grid, but also with data fields defined on it, for example scalar fields (e.g., temperature) or vector fields (e.g., flow velocity). Amira provides special classes for these data modalities, namely HxTetraScalarField3, HxTetraVectorField3, HxTetraComplexScalarField3, HxTetraComplexVectorField3, and HxTetraField3 (see class hierarchy in subsection 18.5.1.1).

Like in the case of regular data fields, the actual information is stored a private member and accessible with the `tetraData()` method, which is of type HxTetraData. Like the corresponding member type HxLattice3 for regular data, HxTetraData is an interface, i.e., derived from HxInterface. The `tetraData()` method provides transparent access to data fields defined on tetrahedral grids regardless of the actual number of data components of the field. In order to access that interface without knowing the actual type of input object within a module, you may use the following statement:

```cpp
HxTetraData* data = (HxTetraData*)portData.source(HxTetraData::getClassTypeId());
if (!data) return;
```

Data on tetrahedral grids must always be of type `float`. The data values may be stored in three different ways, indicated by the encoding type as defined in HxTetraData:

- **PER_TETRA**: One data vector is stored for each tetrahedron. The data are assumed to be constant inside the tetrahedron.
- **PER_VERTEX**: One data vector is stored for each vertex of the grid. The data are interpolated linearly inside a tetrahedron.
- **PER_TETRA_VERTEX**: Four separate data vectors are stored for each tetrahedron. The data are also interpolated linearly.
- **PER_VERTEX_AND_EDGE**: One data vector is stored for each vertex and edge of the grid.

This last encoding scheme is useful for modeling discontinuous fields. In order to evaluate a field at an arbitrary location in a transparent way, Amira’s procedural data interface should be used. This interface is described in subsection 18.5.6.1.

Like HxLattice3, the class HxTetraData provides a static method `create` which can be used to create a matching data field, e.g., an object of type HxTetraScalarField3, from an existing instance of HxTetraData. The HxTetraData object will not be copied but will be directly put into the field object. Therefore, it may not be deleted afterwards. Also see subsection 18.5.2.1.

18.5.4 Unstructured Hexahedral Data

In an unstructured hexahedral grid, the grid cells are defined explicitly by specifying all the points in the cell. This is in contrast to regular hexahedral grids where the grid cells are arranged in a regular 3D array and thus are defined implicitly. The implementation of hexahedral grids is very similar to tetrahedral grids as described in the previous section. There are separate classes for the grid itself and for data fields defined on a hexahedral grid.
In the following two sections, we introduce the grid class `HxHexaGrid` before discussing the corresponding field classes and the interface `HxHexaData`.

### 18.5.4.1 Hexahedral Grids

Hexahedral grids in Amira are implemented by the class `HxHexaGrid` and its base class `Hexa Grid`. Looking at the reference documentation of `Hexa Grid`, we observe that a hexahedral grid essentially consists of a number of dynamic arrays such as `points`, `hexas`, or `materialIds`.

- The `points` array is a list of all 3D points contained in the grid. A single point is stored as an element of type `McVec3<float>`. This class has the same layout as the Open Inventor class `SbVec3f`. Thus, a pointer to `McVec3<float>` can be cast to a pointer to `SbVec3f` and vice versa.

- The `hexas` array describes the actual hexahedra. For each hexahedron, the indices of the eight points and the indices of the six faces it consists of are stored. The numbering of the points is shown in Figure 18.15. Degenerate cells such as prisms or tetrahedra may be defined by choosing the same index for neighboring points.

- The `materialIds` array contains 8-bit labels, which assign a material identifier to every hexahedron. Like the case of label images or surfaces, the set of possible material identifiers is stored in the parameter list of the grid data object.

![Figure 18.15: Numbering of points in a hexahedron with positive volume.](image)

The three arrays, `points`, `hexas`, and `materialIds`, must be provided by the user. The faces of the grid are stored in an additional array called `faces`. This array can be constructed automatically by calling the member method `createFaces`. This method computes the faces from scratch and sets the face indices of all hexahedra defined in `hexas`.

Note that, in contrast to tetrahedral grids, in a hexahedral grid degenerate cells are allowed, i.e., cells where neighboring corners in a cell coincide. In this way, grids with mixed cell types can be defined. The faces of a hexahedron are stored in a small dynamic array called `faces`. For a degenerate cell, this array contains less than six faces.
Also note that, although non-conformal grids are allowed, i.e., grids with hanging nodes on edges and faces, currently the method createFaces does not detect the connectivity between neighboring hexahedra sharing less than four points. Thus, faces between such cells are considered to be external cells.

18.5.4.2 Data Defined on Hexahedral Grids

In most applications, you will not only have to deal with a single hexahedral grid, but also with data fields defined on it, for example scalar fields (e.g., temperature) or vector fields (e.g., flow velocity). Amira provides special classes for these data modalities, namely HxHexaScalarField3, HxHexaVectorField3, HxHexaComplexScalarField3, HxHexaComplexVectorField3, and HxHexaField3 (see class hierarchy in subsection 18.5.1.1).

As for fields defined on tetrahedral grids, the actual information is stored in a private member and accessible with the hexaData() method, which is of type HxHexaData. HxHexaData is a so-called interface, i.e., derived from HxInterface. The hexaData() method provides transparent access to data fields defined on hexahedral grids regardless of the actual number of data components the field has. In order to access the interface without knowing the actual type of input object within a module, you may use the following statement:

```cpp
HxHexaData* data = (HxHexaData*)portData.source(HxHexaData::getClassTypeId());
if (!data) return;
```

Data on hexahedral grids must always be of type float. The data values may be stored in three different ways, indicated by the encoding type defined in HxHexaData:

- PER_HEX: One data vector is stored for each hexahedron. The data are assumed to be constant inside the hexahedron.
- PER_VERTEX: One data vector is stored for each vertex of the grid. The data are interpolated trilinearly inside a hexahedron.
- PER_HEX_VERTEX: Eight separate data vectors are stored for each hexahedron. The data are also interpolated trilinearly.

The last encoding scheme is useful for modeling discontinuous fields. In order to evaluate a field at an arbitrary location in a transparent way, Amira’s procedural data interface should be used. This interface is described in subsection 18.5.6.1.

Like HxLattice3, the class HxHexaData provides a static method create which can be used to create a matching data field, e.g., an object of type HxHexaScalarField3, from an existing instance of HxHexaData. The HxHexaData object will not be copied but will be directly put into the field object. Therefore, it may not be deleted afterwards. Also see subsection 18.5.2.1.

18.5.5 Unstructured Mixed Models

Most CAE and CFD simulations are done on unstructured grids. Amira XWind Extension is the software suite including the Amira feature-set and all its extensions for analyzing, visualizing, and
presenting numerical solutions from CAE and CFD simulations. Amira XWind Extension has its own support for unstructured mixed meshes made up of tetrahedra, hexahedra, pyramids and wedges. In the following two sections, we introduce the **model class** HxUnstructuredModel before discussing the corresponding **field classes** HxUnstructuredDataSet.

### 18.5.5.1 Unstructured Models

Unstructured models are only available in Amira XWind Extension and are implemented by the class HxUnstructuredModel and its base class Unstructured Model. A model contains:

- the mesh of the domain under study, with 2D or 3D cells depending on the dimension of the model,
- the boundaries of the domain,
- the different regions the domain might be composed of,
- the different materials the domain might be made of.

Depending whether the dimension of the model is 2D or 3D, the **Type** of the model will be VOLUME or SURFACE. As a consequence, the mesh associated with the model should be a HxUnstructuredVolumeMesh or a HxUnstructuredSurfaceMesh. The mesh has to be associated with the model through the **setMesh** method.

The unstructured mesh is characterized by its geometry and its topology. The geometry (HxUnstructuredGeometry) contains the coordinates of the mesh nodes, stored as elements of type MbVec3d. The topology (HxUnstructuredVolumeTopology or HxUnstructuredSurfaceTopology) contains the mesh cells, defined by the list of their nodes index (as stored in the geometry). In case the model is 3D, the cells are elements of type HxVolumeCell. Supported cell types are tetrahedron (HxTetrahedronCell), pyramid (HxPyramidCell), wedge (HxWedgeCell) and hexahedron (HxHexahedronCell). In case the model is 2D, the cells are elements of type HxSurfaceCell. Supported cell types are triangle (HxTriangleCell) and quadrangle (HxQuadrangleCell).

In the 3D case, the mesh might contain 2D cells. This set of cells is called **boundaries**, referring to the CFD field but can as well define shell or membrane elements in the CAE field. HxUnstructuredSurfaceBoundary inherits from HxUnstructuredSurfaceMesh and so is as well defined by its geometry and topology.

If the model is composed of several regions, those regions can be identified by a name, an index and a color (see HxModelParts) and assigned to each cell of the mesh through the assignCellParts method. The same is true for the materials (HxCellMaterials, assignCellMaterials).

### 18.5.5.2 Data Defined on Unstructured Models

Data defined on unstructured models are implemented by the class HxUnstructuredModelDataSet. The fields can be of type SCALARSET, VECTORSET, TENSORSET or SYMTENSORSET (symmetric tensor set). Depending on the type, data are stored as HxUnstructuredScalarSet, HxUnstructuredVectorSet, HxUnstructuredTensorSet or HxUnstructuredSymTensorSet, all inheriting from

---

*Data Classes*
HxUnstructuredDataSet. The data has to be associated with the model data set through the setDataSet method.

Two data bindings are supported: PER_NODE (the data field values are stored at the mesh nodes) and PER_CELL (the data field values are stored at the mesh cells). Set the binding of the HxUnstructuredDataSet with the setBinding method.

In the 3D case, if boundaries exist, data can be stored in the same way and associated with the model data set using the getBoundaries method. The two bindings are available on boundaries. Finally, the model data set is connected to the unstructured model it is defined on.

```cpp
HxUnstructuredModel* model = new HxUnstructuredModel;
// Define the unstructured model
...
HxUnstructuredModelDataSet* modelDataSet = new HxUnstructuredModelDataSet;
HxUnstructuredScalarSet* scalarSet = new HxUnstructuredScalarSet;
// Assign the scalar set
...
scalarSet->setBinding(HxUnstructuredDataSet::PER_NODE);
modelDataSet->setDataSet(scalarSet);
...
modelDataSet->portGrid.connect(model);
...
```

18.5.6 Other Issues Related to Data Classes

The following topics will be covered in this section:

- **Amira’s procedural interface for evaluating 3D fields**
- **coordinate systems and transformations of spatial data objects**
- **defining parameters and materials in data objects**

18.5.6.1 Procedural Interface for 3D Fields

The internal representation of a data field depends largely on whether the field is defined on a regular, tetrahedral, or hexahedral grid. There are even data types such as HxAnnaScalarField3 or HxAnnaVectorField3 for fields that are defined by an analytical mathematical expression. To allow for writing a module which operates on any scalar field without having to bother about the particular data representation, a transparent interface is needed. One could think of a function like

```cpp
float value = field->evaluate(x,y,z);
```

For the sake of efficiency, a slightly different interface is used in Amira. Evaluating a field defined on tetrahedral grid at an arbitrary location usually involves a global search to detect the tetrahedron, which contains that point. The situation is similar for other grid types. In most algorithms, however, the field is typically evaluated at points not far from each other, e.g., when integrating a field line. To take advantage of this fact, the concept of an abstract Location class has been introduced. A Location describes a point in 3D space. Depending on the underlying grid, Location may keep track of additional information such as the current grid cell number. The Location class provides
two different search strategies, a global one and a local one. In this way performance can be improved significantly. Here is an example of how to use a Location class:

```c++
float pos[3];
float value;
...
HxLocation3* location = field->createLocation();
if (location->set(pos))
    field->eval(location, &value);
...
if (location->move(pos))
    field->eval(location, &value);
...
delete location;
```

First a location is created by calling the virtual method `createLocation` of the field to be evaluated. The two methods, `location->set(pos)` and `location->move(pos)`, both take an array of three floats as argument, which describe a point in 3D space. The `set` method always performs a global search in order to locate the point. In contrast, `move` first tries to locate the new point using a local search strategy starting from the previous position. You should call `move` when the new position differs only slightly from the previous one. Both `set` and `move` may return 0 in order to indicate that the requested point could not be located, i.e., that it is not contained in any grid cell.

In order to locate the field at a particular location, `field->eval( location, &value)` is called. The result is written to the variable pointed to by the second argument. Internally the `eval` method does two things. First it interpolates the field values, for example, using the values at the corners of the cell in which the current point is contained. Secondly, it converts the result to a float value, if the field is represented internally by a different primitive data type.

### 18.5.6.2 Transformations of Spatial Data Objects

In Amira, all data objects which are embedded in 3D space are derived from the class `HxSpatialData` defined in the subdirectory `hxcore` (see class hierarchy in subsection 18.5.1.1). On the one hand, this class provides a virtual method `getBoundingBox` which derived classes should redefine. On the other hand, it allows the user to transform the data object using an arbitrary geometric transformation. The transformation is stored in an Open Inventor `SoTransform` node. This node is applied automatically to any display module attached to a transformed data object.

In total there are three different coordinate systems:

- The **world coordinate system** is the system where camera of the 3D viewer is defined in.
- The **table coordinate system** is usually the same as the world coordinate system. However, it might be different if special modules displaying, for example, the geometry of a radiotherapy device is used. These modules should call the method `HxBase::useWorldCoords` with a non-zero argument in their constructor. Later they may then call the method `HxController::setWorldToTableTransform` of the global object `theController`. In this way they can cause all other objects to be transformed simultaneously.
Finally, the local coordinate system is defined by the transformation node stored for objects of type HxSpatialData. This transformation can be modified interactively using the transformation editor. Transformations can be shared between multiple data objects using the method HxBase::setControllingData. Typically, all display modules attached to a data object will share its transformation matrix, so that the geometry generated by these modules is transformed automatically when the data itself is transformed.

The transformation node of a spatial data object may be accessed using the SoTransform* HxSpatialData::getTransform() method, which may return a NULL pointer when the data object is not transformed. Often it is easier to use HxSpatialData::getTransform(SbMatrix& matrix) instead, which returns the current transformation matrix or the identity matrix when there is no transformation. This matrix is to be applied by multiplying it to a vector from the right-hand side. It transforms vectors from the local coordinate system to the table or world coordinate system.

If you want to transform table or world coordinates to local coordinates, use HxSpatialData::getInverseTransform(SbMatrix& matrix). For example, consider the following code which transforms the lower left front corner of object A into the local coordinate system of a second object B:

```c
float bbox[6];
SbVec3f originWorld,originB;
SbMatrix matrixA, inverseMatrixB;

// Get origin in local coordinates of A
fieldA->getBoundingBox(bbox);
SbVec3f origin(bbox[0],bbox[1],bbox[2]);

// Transform origin to world coordinates:
fieldA->getTransform(matrixA);
matrixA.multVecMatrix(origin,originWorld);

// Transform origin from world coords to local coords of B
fieldB->getInverseTransform(inverseMatrixB);
inverseMatrixB.multVecMatrix(originWorld,originB);
```

Instead of this two-step approach, the two matrices could also be combined:

```c
SbMatrix allInOne = matrixA;
allInOne.multRight(inverseMatrixB);
allInOne.multVecMatrix(origin,originB);
```

Note that the same result is obtained in the following way:

```c
SbMatrix allInOne = inverseMatrixB;
allInOne.multLeft(matrixA);
allInOne.multVecMatrix(origin,originB);
```
Since the transformation could contain a translational part, special attention should be paid when directional vectors are transformed. In this case the method `HxSpatialData::getTransformNoTranslation(SbMatrix& matrix)` should be used.

**18.5.6.3 Data Parameters and Materials**

An arbitrary number of attributes or parameters can be defined for every data object. The parameters are stored in a member variable `parameters` of type `HxParamBundle`. The header file of the class `HxParamBundle` is located in the subdirectory `include/amiramesh`. `HxParamBundle` is derived from the base class `HxParamBase`. Another class derived from `HxParamBase` is `HxParameter`. This class is used to actually store a parameter value. A parameter value may be a string or an n-component vector of any primitive data type supported in Amira (byte, short, int, float, or double). The bundle class `HxParamBundle` may hold an arbitrary number of `HxParamBase` objects, i.e., parameters or other bundles. In this way, parameters may be ordered hierarchically.

Many data objects such as label images, surfaces, or unstructured finite element grids make use of the concept of a material list. Material parameters are stored in a special sub-bundle of the object’s parameter bundle called *Materials*. In order to access all material parameters of such an object, the following code may be used:

```cpp
HxParamBundle* materials = field->parameters.materials();
int nMaterials = materials->nBundles();
for (int i=0; i<nMaterials; i++) {
    HxParamBundle* material = materials->bundle(i);
    const char* name = material->name();
    theMsg->printf("Material[%d] = %s\n", name);
}
```

The class `HxParamBundle` provides several methods for looking up parameter values. All these `find`-methods return 0 if the requested parameter could not be found. For example, in order to retrieve the value of a one-component floating point parameter called *Transparency*, the following code may be used:

```cpp
float transparency = 0;
if (!material->findReal("Transparency",transparency))
    theMsg->printf("Transparency not defined, using default");
```

In order to add a new parameter or to overwrite the value of an existing one, you may use one of several different `set`-methods, for example:

```cpp
material->set("Transparency",transparency);
```

Many modules check whether a color is associated with a particular ‘material’ in the material list of a data object. If this is not the case, the color or some other value is looked up in the global material database Amira provides. This database is represented by the class `HxMatDatabase` defined in

*Data Classes*
hxicore. It can be accessed via the global pointer theDatabase. Like an ordinary data object, the
database has a member variable parameters of type HxParamBundle in order to store parameters
and materials. In addition, it provides some convenience methods, for example getColor(const
char* name), which returns the color of a material, defining a new one if the material is not yet
contained in the database.

18.6  Documentation of Modules in Amira XPand Extension

Amira XPand Extension allows the user to write the documentation for his own modules and integrate
it into the user’s guide.
The documentation must be written in Amira’s native documentation style. The syntax is bor-
rowed from the \textit{Latex} text processing language. Documentation files can easily be created by the
\texttt{createDocFile} command. To create a documentation template for \texttt{MyModule}, type
\texttt{MyModule createDocFile}
in the Amira console. This will generate a template for the documentation file as well as snapshots of
all ports in the directory \texttt{AMIRA_LOCAL/src/mypackage/doc}.
The file \texttt{MyModule.doc} already provides the skeleton for the module description and includes the
port snapshots.
The command \texttt{createPortSnaps} only creates the snapshots of the module ports. This is useful
when the ports have changed and their snapshots must be updated in the user’s guide.

18.6.1  The documentation file

Here, the basic elements of a documentation file are presented.

\begin{hxmodule}{MyModule}
This command indicates the begin of a description file. \texttt{MyModule}
is the module name.
\end{hxmodule}

\begin{hxdescription}
This block contains a general module description.
All beginning blocks must have an end.
\end{hxdescription}

\begin{hxconnections}
\texttt{hxlabel}{MyModule_data}
This command sets a label such that this
connection can be referenced in the documentation.
\texttt{hxport}{Data}{\tt [required]}\}
Here the required master connection is described.
\end{hxconnections}

\begin{hxports}
The module ports are listed here.
\end{hxports}
Anywhere in the documentation a label can be referenced:
\link{MyModule_data}{Text for reference}

\end{hxmodule}

This file describes the documentation of a module and starts with
\begin{hxmodule}{name}
This is a hxmodule description. Others are also available:
\begin{hxmodule2}{name}{short description to appear in the table of modules}
\begin{fileformat}{name}
\begin{fileformat2}{name}{short description to appear in the table of file formats}
\begin{data}{name}
\begin{data2}{name}{short description to appear in the table of data types}
The file always must be closed by the corresponding end command.

More commands Other formats allow formatting and structure the documentation:

- \begin{itemize}
  \item This is an enumeration,
  and each item starts with the key word item
  \end{itemize}
- (\bf This will be set in bold face)
- (\it This will be set in italics)
- (\tt This will be set in Courier)

Formulas can be included by means of the text processor LaTeX. They must be written in the Latex syntax. This requires that LaTeX and Ghostscript be installed on the user’s system. The following environment variables need to be set:

- DOC2HTML_LATEX points to the LaTeX executable
- DOC2HTML_DVIPS points to the dvi to PostScript converter (dvips)
- DOC2HTML_GS points to Ghostscript

18.6.2 Generating the documentation
All documentation files must be converted to HTML files and copied into the user’s guide. For this purpose, the program doc2html is provided. Run this program from a command shell with the following option:

doc2html -A -skin AmiraSkin -d AMIRA_ROOT/share/doc/html -local AMIRA_LOCAL

This converts the documentation and copies the HTML files to the appropriate places in the AMIRA_ROOT/share/doc/html directory. Call ”doc2html -help” to get a complete list of options.
18.7 Miscellaneous

This section covers a number of additional issues of interest for the Amira developer. In particular, the following topics are included:

- Import of time-dependent data, including the use of HxPortTime
- Important global objects, such as theMsg and theProgress
- Save-project issues, making save Amira project work for custom modules
- Troubleshooting, providing a list of common errors and solutions

18.7.1 Time-Dependent Data And Animations

This section covers some more advanced topics of Amira XPand Extension, namely the handling of dynamic data sets and the implementation of animated compute tasks. Before reading the section, you should at least know how to write ordinary IO routines and modules.

18.7.1.1 Time Series Control Modules

In general, the processing of time-dependent data sets is a challenging task in 3D visualization. Usually not all time steps of a dynamic data series can be loaded at once because of insufficient main memory. Even if all time steps would fit into memory, it is usually not a good idea to load every time step as a separate object in Amira. This would result in a large number of icons in the Project View. The selection between different time steps would become difficult.

A better solution comprise special-purpose control modules. An example is the Time Series Control module described in the user’s guide. This module is created if a time series of data objects each stored in a separate file is imported via the Load time series... option of the main window’s file menu. Instead of loading all time steps together, the control module loads only one time step at a time. The current time step can be adjusted via a time slider. When a new time step is selected, the data objects associated with the previous one are replaced.

If you want to support a file format where multiple time steps are stored in a common file, you can write a special time series control module for that format. For each format, a special control module is needed because seeking for a particular time step inside the file, of course, is different for each format. For convenience, you may derive a control module for a new format from the class HxDynamicDataControl contained in the package hxtime. This base class provides a time slider and a virtual method newTimeStep(int k) which is called whenever a new new time step is to be loaded. In contrast to the standard time series control module, in most other control modules, data objects should be created only once. If a new time step is selected, existing objects should be updated and reused instead of replacing them by new objects. In this way, the burden of disconnecting and reconnecting down-stream objects is avoided.

18.7.1.2 The Class HxPortTime

In principal, an ordinary float slider (HxPortFloatSlider) can be used to adjust the time of a time series control module or of some other time-dependent data object. However, in many cases, the special-purpose class HxPortTime defined in the package hxtime is more appropriate. This class can be used
like an ordinary float slider but it provides many additional features. The most prominent one is the possibility to auto-animate the slider. In addition, \textit{HxPortTime} can be connected to a global time object of type \textit{Time}. In this way, multiple time-dependent modules can be synchronized. In order to create a global \textit{Time} object, select \textit{Animations And Scripts / Time} from the main window’s \textit{Project >Create Object...} menu.

Another feature of \textit{HxPortTime} is that the class is also an interface, i.e., it is derived from \textit{HxInterface} (compare subsection 18.5.1.2). In this way, it is possible to write modules which can be connected to any object containing an instance of \textit{HxPortTime}. An example is the \textit{Display Time} module. In order to access the time port of a source object, the following C++ dynamic cast construct should be used:

\begin{verbatim}
HxPortTime* time = dynamic_cast<HxPortTime*>(
    portData.source(HxPortTime::getClassTypeid()));
\end{verbatim}

In the previous section, we discussed how time-dependent data could be imported using special-purpose control modules. Another alternative is to derive a time-dependent data object from an existing static one. An example of this is the class \textit{MyDynamicColormap} contained in the example package of Amira XPand Extension. Looking at the header file \textit{src/mypackage/MyDynamicColormap.h} in the local Amira directory, you notice that this class is essentially an ordinary colormap with an additional time port. Here is the class declaration:

\begin{verbatim}
class MYPACKAGE_API MyDynamicColormap: public HxColormap
{
    HX_HEADER(MyDynamicColormap);

public:
    // Constructor.
    MyDynamicColormap();

    // This will be called when an input port changes.
    virtual void compute();

    // The time slider
    HxPortTime portTime;

    // Implements the colormap
    virtual void getRGBA1(float u, float rgba[4]) const;
};
\end{verbatim}

The implementation of the dynamic colormap is very simple too (see the file \textit{MyDynamicColormap.cpp}). First, in the constructor the time slider is initialized:

\begin{verbatim}
portTime.setMinMax(0,1);
portTime.setIncrement(0.1);
portTime.setDiscrete(0);
portTime.setRealTimeFactor(0.5*0.001);
\end{verbatim}

The first line indicates that the slider should go from 0 to 1. The increment set in the next line defines by what amount the time value should be changed if the backward or the forward button of the slider is pressed. The next line unsets the discrete flag. If this flag is on, the slider value always would be
an integer multiple of the increment. Finally, the so-called real-time factor is set. Setting this factor to a non-zero value implies that the slider is associated with physical time in animation mode. More precisely, the number of microseconds elapsed since the last animation update is multiplied with the real-time factor. Then the result is added to the current time value.

In order to see the module in action compile, the example package, start Amira (use the -debug option or the debug executable, if you compiled in debug mode), and choose Other / DynamicColormap from the main window’s Project > Create Object... menu. Attach a Colormap Legend module to the colormap and change the value of the colormap’s time slider. Animate the slider. The speed of the animation can be adjusted by resetting the value of the real-time factor using the Tcl command DynamicColormap time setRealTimeFactor.

18.7.1.3 Animation Via Time-Out Methods

In some cases, you might want certain methods to be called in regular intervals without using a time port. There are several ways to do this. First, you could use the Open Inventor class SbTimerSensor or related classes. Another possibility would be to use the Qt class QTimer. However, both methods have the disadvantage that the application can get stuck if too many timer events are emitted at once. In same cases, it could even be impossible to press the stop button or some other button for turning off user-defined animation. For this reason, Amira provides its own way off registering time-out methods. The relevant methods are implemented by the class HxController. Suppose you have written a module with a member method called timeOut. If you want this method to be called automatically once in a second, you can use the following statement:

```c
theController->addTimeOutMethod(
    this, (HxTimeOutMethod)timeOut, 1000);
```

In order to stop the animation again, use

```c
theController->removeTimeOutMethod(
    this, (HxTimeOutMethod)timeOut);
```

Instead of using a member method of an Amira object class, you can also register an arbitrary static function using the method addTimeOutFunction of class HxController. The corresponding remove method is called removeTimeOutFunction. For more information, see the reference documentation of HxController.

The Amira XPand Extension example package contains the module MyAnimateColormap which makes use of the above time-out mechanism. The source code of the module again is quite easy to understand. After compiling the example package, you can attach to module under the name DoAnimate to an existing colormap. The colormap then is modified and copied. After pressing the animate toggle of the module, the output colormap is shifted automatically at regular intervals. Note that in this example the fire method of the module is used as time-out method. fire invokes the modules compute method and also updates all down-stream objects.

18.7.2 Important Global Objects

Beside the base classes of modules and data objects, there are some more classes in the Amira kernel that are important to the developer. Many of these classes have exactly one global in-
stance. A short summary of these global objects is presented here. For details, please refer to the online reference documentation by looking at the file share/devrefAmira/index.html or share/devrefAmira/Amira.chm in the Amira root directory.

**HxMessage:** This class corresponds to the Amira console window in the lower right part of the screen. There is only one global instance of this class, which can be accessed by theMsg. All text output should go to this object. Text can be printed using the function theMsg->printf("...",...), which supports common C-style printf syntax. HxMessage also provides static methods for popping up error and warning messages or simple question dialogs.

**HxObjectPool:** This class maintains the list of all currently existing data objects and modules. In the graphical user interface, this area is called the Project View and contains the modules and data objects icons. There is only one global instance of this class, which can be accessed by the pointer theObjectPool.

**HxProgressInterface:** This class displays the ports of selected objects in the Properties Area and provides the progress bar and busy-state functionality. Important functions are startWorking, stopWorking, wasInterrupted as well as busy and notBusy. There is only one global instance of this class, which can be accessed by the pointer theProgress.

**HxFileDialog:** This class represents the file browser used for loading and saving data. Normally the developer does not need to use this class since the standard I/O mechanism is completely implemented in the Amira kernel. However, for special purpose modules, a separate file browser might be useful. There is a global instance of this class, which can be accessed by the pointer theFileDialog.

**HxResource:** This class maintains the list of all registered file formats and modules as defined in the package resource files. It also provides information about the Amira root directory, the local Amira directory, the version number, and so on. Normally there is no need for the developer to use this class directly. There is no instance of this class, since all its members are static.

**HxViewer:** This class represents an Amira 3D viewer. There can be multiple instances which are accessed via the method viewer of the global object theController. Normally you will not need to use this class. Instead, you should use the member functions showGeom and hideGeom which every module and data object provides in order to display geometry.

**HxController:** This class controls all 3D viewers and Open Inventor geometry. In order to access a viewer, you may use the following statement:

```c
HxViewer* v0 = theController->viewer(0,0);
```

The first argument indicates the ID number of the viewer to be retrieved. In total, there may be up to 16 different viewers. The second argument specifies whether the viewer should be created or not if it does not already exist.

**HxColorEditor:** Amira’s color editor. Used, for example, to define the background color of the viewer. In a standard module, you should use a port such as HxPortColorList or HxPortColorMap instead of directly accessing the color editor. There is a global instance of this class, which can be accessed by the pointer theColorEditor.

**HxHTML:** A window used to display HTML files. This class is used for Amira’s online help. The global instance used for displaying the online user’s guide and the online programmer’s guide can be accessed by the pointer theBrowser.

**HxMatDatabase:** This class represents Amira’s global data parameter and material database. The
database can be accessed by the global pointer theDatabase. Details about the material database are discussed in subsection 18.5.6.3.

18.7.3 Save-Project Issues

This section describes the mechanism used in Amira to save projects. For most modules, this is done transparently for the developer.

The menu command ”Save Project” dumps a Tcl script that should reconstruct the current Amira project. Essentially this is done by writing a load ... command for each data object, a create ... command for each module and setValue ... commands for each port of a module.

This suffices to reconstruct the Amira project correctly if all information about a module’s state is kept in the module’s ports only. If this is not the case, e.g., if the developer uses extra member variables that are important for the modules current state, those values are not restored automatically. If you cannot avoid this, you must extend the ”Save Project” functionality of your module. In order to do so, you can override the virtual function savePorts so that it writes additional Tcl commands. For example, let us take a look at the HxArbitraryCut class, which is the base class e.g., for the Slice module and which has to save its current slice orientation:

```cpp
void HxArbitraryCut::savePorts(FILE* fp)
{
HxModule::savePorts(fp);

...  
fprintf(fp, "%s setPlane %g %g %g %g %g %g %g %g\n",
    getName(),
    origin()[0], origin()[1], origin()[2],
    uVec()[0], uVec()[1], uVec()[2],
    vVec()[0], vVec()[1], vVec()[2]);
}
```

Note that this method requires that HxArbitraryCut or some of its parent classes implement the Tcl command setPlane. Hints about implementing new Tcl commands are given in subsection 18.4.2.2.

Some remarks about how to generate the load command for data objects are given in subsection 18.3.2.

![Figure 18.16: When loading this Amira project, the Resample module recreates the chocolate-bar.Resampled data object on the fly.](image)

There is a special optimization for data objects created by computational modules. Amira automatically determines whether data objects which are created by other modules are not yet saved and asks
the user to do so, if necessary. Amira proposes also two policies for saving projects: "Minimize project size" and "Minimize project computation". If the user selects "Minimize project size" then the data objects will not be saved at project saving and they will be computed at project loading, otherwise they will be saved at project saving and they will not be computed at project loading. As an example, consider the Amira project in Figure 18.16. In this case, if the user selects "Minimize project size" as policy, the resample module can automatically recompute the chocolate-bar.Resampled data object when the Amira project is loaded. An algorithm must determine whether the compute module can create the data object.

Determining whether a compute module can create a data object may be tricky. Typically, it must be assured that in the time between the actual creation of the data object by the computational module and the execution of the save Amira project command, neither the parameters nor the input has changed, and that the resulting data object had not been edited.

This behavior is completely handled by HxCompModule while the method HxCompModule::setResult is used to register the output data object.

18.7.4 Troubleshooting

This section describes some frequently occurring problems and some general problem solving approaches related to Amira development.

The section is divided into two parts: Problems which may occur when compiling a new package, and problems which may occur when executing it.

18.7.4.1 Compile-Time Problems

Unknown identifier, strange errors: A very common problem occurring in C++ programming is the omission of necessary include statements. In Amira, most classes have their own header file (.h file) containing the class declaration. You must include the class declaration for each class that you are using in your code. When you get strange error messages that you do not understand, check whether all classes used in the neighborhood of the line that the compiler complains about have their corresponding include statement.

Unresolved symbols: If the linker complains about unresolved symbols, you probably are missing a library on your link line. The Amira development wizard makes sure that the Amira kernel library and important system libraries are linked. If you are using Amira data classes, you will need to link with the corresponding package library hxfield, hxcolor, hxsurface, and so on. To add libraries, edit the Package file, find the line starting with LIBS, append the name of the package you want to add and regenerate the build system files with the Development Wizard of Amira. Details are given in subsection 18.2.10 and in subsection 18.2.9.

18.7.4.2 Run-Time Problems

The module does not show up in the popup menu: If your module did compile, but is not visible in the popup menu of a corresponding data object, there is probably a problem with the resource file. The resource file will be copied from your package’s share/resources directory to the directory share/resources in your local Amira directory during compilation. Launch a new build each time the resource file is modified.

Miscellaneous 742
If the resource file is present, the next step is to check whether it is really parsed. Add a line
```bash
echo "hello mypackage"
```
to the resource file. Verify that the message appears in the Amira console when Amira starts. If not, probably the Local Amira directory is not set correctly. Reset it with the Development Wizard in Amira. Details are given in subsection 18.2.2

If the file is parsed, but the module still does not show up, the syntax of the rc file entry might be wrong or you specified a wrong primary data type, so that the module will appear in the menu of a different data class.

**There is an entry in the popup menu, but the module is not created:** Probably something is wrong with the shared library (the .so or .dll file). In the Amira console, type `dso verbose 1` and try to create the module again. You will see some error messages, indicating that either the dll is not found, or that it cannot be loaded (and why) or that some symbol is missing. Check whether your building mode (debug/optimize) and execution mode are the same. In particular, if you have compiled debug code you must start Amira using the `-debug` command line option or the debug executable (see subsection 18.1.5).

**A read or write routine does not work:** The procedure for such problems is the same. First check whether the load function is registered. Then verify that your save-file format shows up in the file format list when saving the corresponding data object. For a load method, right-click on a filename in the load-file dialog. Choose format and check whether your format appears in the list. If that is the case, you probably have a dll problem. Follow the steps above. If the library can be loaded, but the symbol cannot be found, your method may have either a wrong signature (wrong argument types) or on Windows you might have forgotten the `<PACKAGE>_API` macro. This macro indicates that the routine should be exported by the DLL.

In general, if you have problems with **unresolved** and/or **missing symbols**, you should take a look at the symbols in your library. On Unix, type `nm lib/arch-*/Debug/libmypackage.so`.


### 18.7.4.3 Debugging Problems

**Setting breakpoints does not work:** Since Amira uses shared libraries, the code of an individual package is not loaded even after the program has started. Therefore, some debuggers refuse to set breakpoints in such packages or disable previously set breakpoints. To overcome this problem, first create your module and then set the breakpoint. If you want to debug a module’s constructor or a read or write routine, of course, this does not work. In these cases, load the library by hand, by typing into the Amira console `dso open libmypackage.so` (if your package is called mypackage). Then set the breakpoint and create your module or load your data file.

**Miscellaneous**
Part V

Amira XMolecular Extension User’s Guide
Chapter 19

Amira XMolecular Extension

Introduction

Amira XMolecular Extension is an Amira extension providing support for the visualization as well as the analysis of molecules and dynamic molecular data. The Amira XMolecular Extension documentation is organized into the following sections:

- Getting started with molecular visualization
- Structure and interdependence of the molecular data structures
- Essentials for displaying a molecule
- Alignment facilities in Amira XMolecular Extension
- Visualizing dynamic data
- Atom expressions

19.1 First Steps with Molecular Visualization in Amira

This chapter gives you an overview of the visualization of molecular data sets. Amira is not just able to display a 3D image of the molecule but also provides tools to investigate its distinct parts and properties. After reading the ”getting started” introduction you may continue with any of the following tutorials.

- Getting Started - first steps
- Selection, Labeling, and Masking - exploring a molecule
- Alignment of Molecules - visualizing dynamical data
- Molecular surfaces - wrapping a molecule
- Sequential and Structural Alignment - comparing molecules
- Molecule Editor - interactive manipulation of the molecule
• Molecular Interface - computing intersection surfaces
• Measurement - measuring distances and angles within a molecule

Note: If you want to visualize your own data, please refer to the section about data import in the Amira User’s Guide. That section contains some general hints on how to import data sets into Amira.

19.1.1 Getting Started with Molecular Visualization

In this section, you will learn how to

1. load a molecular demo data set into Amira,
2. view the molecule with the Molecule View display module,
3. try out various color schemes,
4. select atoms in the viewer using the draw tool,
5. overwrite color scheme colors for selected atoms.

19.1.1.1 Loading Data into the System

In the following introduction we will consider a simple example to explain the basic functions of the Molecule View module. Our example will be a small PDB (Protein Data Bank) structure consisting of 932 atoms in 213 residues.

• Start a new Project File > New Project
• Load the file 2RNT.pdb into the Project View from the directory data/molecules/pdb.

A green icon labeled 2RNT.pdb will appear in the Project View. The green icon represents an object of type Molecule. Click on the green data icon with the left mouse button. In the Properties Area below the Project View information about the molecule, such as the number of atoms etc., will be shown. In addition, other ports named Transformation, Selection Browser, and Transform, can be seen; they will be explained in a later tutorials. An additional yellow box named Bounding Box will automatically be added to the molecule, this is a display module (see explanation below).

19.1.1.2 Displaying the Molecule with the Molecule View module

The Molecule View module is the basic display module for visualizing molecules. It allows you to display atoms as plates or balls and bonds as lines or cylinders.

• Click again on the green data icon in the Project View, this time using the right mouse button.

A menu, containing several entries and submenus, will appear.

• Select the entry Molecule View.

A new yellow icon labeled Molecule View appears in the Project View. Yellow icons, in general, represent display modules, i.e., modules that visualize objects in the viewer. The black line between the icons indicates a connection between the objects. In this case, the MoleculeView module reads data from the object represented by the green icon and visualizes it.
The molecule is now displayed in the viewer as a wireframe. Using the left mouse button you can rotate the object; using the left and middle mouse buttons simultaneously you can zoom in and out. For these mouse operations to work, the viewer must be in viewing mode, in which case the mouse cursor is displayed as a hand.

Whenever the Molecule View module is active, the little square on the yellow Molecule View icon is orange. You can deactivate the module by clicking on the square with the left mouse button.

We will explore some basic ports of the Molecule View module.

- **Mode** port: Choose another mode to see both atoms and bonds of the molecule, or just atoms. If atoms are shown, use the Atom Radius port to adjust the size of the atoms as desired.
- **Quality** port: If you choose the option correct, you can display a correct, i.e., three-dimensional, image of the balls and sticks. Consider the trade-off between correct representation and slower rendering performance. Use the fast mode if you want to display a large molecule. If your graphics hardware is fast enough, you can use the correct mode even for large molecules.
- **Complexity** port: In order to allow interactive rendering, the default complexity of the scene is rather low. In most cases this will be sufficient. However, if you want to make screen shots or if you have small molecules, you might want to increase the complexity. The Complexity port is displayed only if correct quality is selected.

### 19.1.1.3 Changing the Color Scheme

The Molecule View module allows the user to color the molecule according to levels, for example, atom level, residue level, secondary structure level, chain level, or user-defined levels. Each level has a number of attributes, the simplest of which is the index attribute. The default color scheme is to color the molecule according to the atom level’s attribute atomic number, i.e., the atom’s type.

- Click the Legend button of the Color port to display a small window decoding the colors you see in the viewer window.
- Choose residues from the first pull-down menu and type from the second menu to color the molecule according to the residue type, here the amino acid type.

The default colormap contains a constant color. Thus, currently all residues of the molecule have the same color.

- To change the colormap, right-click on the color bar of the Discrete CM port which has appeared below the Color port and select any other colormap.
- Try out different colormaps to find a map that suits your purposes.

Some people prefer the CPK color scheme for atoms and the amino acid colors as they are used in the RasMol program.

- You can set your preferences in the AmiraEdit menu by selecting the entry Preferences.
- Press the Molecules tab and set your preferences. Pressing the OK button saves your preferences permanently.

First Steps with Molecular Visualization in Amira
Currently only amino acid colors are predefined. Thus, if the molecule contains residues other than the standard amino acids, those residues will be colored with the default color (black).

19.1.1.4 Using the Draw Tool

The draw tool appears in Amira in several modules. It enables you to select objects or parts of an object by drawing a line in the viewer.

- Press the Draw button of the Highlighting port and draw a line in the viewer window around the group of atoms you want to select.

The atoms that were enclosed by the line will be highlighted. If the viewer is the active window, pressing the `d` key is equivalent to pressing the Draw button of the Highlighting port.

- To unhighlight all atoms, press the Clear button of the Highlighting port.
- Also try using the keys Ctrl and Shift while drawing a line.

19.1.1.5 Setting Colors for Selected Parts

The Define Colors port allows you to overwrite colors of the color scheme.

- Select some atoms using the draw tool.
- Press the Set button of the Define Color port.
- Change the current color of the Color Dialog and press OK.

The previously highlighted atoms should now have the color selected in the color dialog. This setting will be preserved even if the color scheme is changed. Unfortunately, the new setting will currently not appear in the color legend.

19.1.2 Selection, Labeling, and Masking

You already know how to load files and how to display molecules with the Molecule View module. This tutorial will focus on exploring the structure of a loaded molecule. The tutorial consists of three subsections, in which you will:

1. Explore the possibilities for selecting within a molecule using the Molecule View module.
2. Learn how to use the Molecule Label module.
3. Get to know the Molecule Selection Browser.

For this tutorial, we will use the molecule 1IGM.pdb.

- Start a New Project File > New Project
- Load the file 1IGM.pdb into the Project View from the directory data/molecules/pdb.
- Attach a Molecule View module to the green object that has appeared,
- Set the Mode port to balls and sticks.
19.1.2.1 Interactive Selection with the Molecule View Module

In the first tutorial, you learned how to use the draw tool to select atoms within a molecule. The simplest way to select atoms, however, is to click on the atom of interest. In order to do so, the viewer must be in interaction mode. If the mouse cursor in the viewing window is depicted as a hand, you are in viewing mode. To change to interaction mode, you can either

- click on the arrow button in the upper left corner of the viewing window or press the Esc button while the viewing window is active.

The mouse cursor will change to an arrow.

- Now click one of the atoms.

The atom you selected should now be highlighted by a red frame around it. If you select another atom, the first atom will be unhighlighted. In order to select more than one atom

- press the Ctrl key and keep it pressed while clicking additional atoms.

Ctrl-clicking a highlighted atom a second time unhighlights it.

- Now change the Mode port of the Molecule View back to sticks.
- Select residues from the first menu of the Molecule View’s Color port.
- Choose a suitable colormap from the list of pre-loaded colormaps as described in the first tutorial.

The residues should now be colored according to their type.

- Now select an atom.

As result the whole residue should now be highlighted. The reason for this is that picking is bound to the coloring, by default. For example, if the color scheme is atoms, a click on an atom will only influence the selection for this atom; if the scheme is residues, the atom’s residue will be selected; if it is chains, the atom’s chain will be selected, and so on. However, since this is very restrictive you can easily change the selection mode to the most common levels, i.e., atoms, residues, secondary structures, and chains. In order to choose a certain level for the selection you need to press certain keys in advance. Ctrl-Alt-Shift-a chooses the atoms level, a click on an atom will only influence the selection for this atom. Ctrl-Alt-Shift-r, Ctrl-Alt-Shift-c and Ctrl-Alt-Shift-s choose residues, chains and secondary_structure level respectively. To switch back to the default behavior, where coloring determines selection, press Ctrl-Alt-Shift-d.

If you select a group and afterwards select a second one from the same level holding down the Shift-key all groups between the two will also be selected. Holding the Ctrl-key pressed while selecting groups allows you to select multiple groups and also to toggle a group when selecting it a second time. If you do any selection by clicking in the viewer there will be some output in the console window informing you about what you have selected, the amount of output can be customized via the Preferences dialog:

- You can set your preferences in the AmiraEdit menu by selecting the entry Preferences.
• Press the Molecules tab and take a look on the options in chapter Selection Info:

• **Molecule name** determines that the name of the molecule, to which a selected group belongs, will be printed.

• **Group name** determines that the name of the selected group will be printed.

• **Group attributes** determines that not only the selected group’s name but also all attribute values of the group will be printed in the console window.

• **Explicit attributes** restricts the output of attribute values to those attributes that are explicitly named in the text field.

• Pressing the OK button saves your preferences permanently.

### 19.1.2.2 Using the Molecule Label Module

So far you have seen that you can select atoms and groups of atoms by clicking on the molecule. The result of the picking is always printed in the console window. This might suffice in some cases. In other cases, however, it is necessary to label the molecule in the viewer so that you can easily track certain groups you are interested in. If you want to use this tool, here is how you do it.

1. Click again on the icon `11GM.pdb` with the right mouse button.
2. Select Molecule Label from the Display submenu.

A second yellow icon labeled **Molecule Label** should have appeared in the Project View. In order that the Molecule Label module handles mouse clicks, check the handle clicks option. This means that instead of highlighting groups when clicking on them they will now get labeled.

1. Type `Ctrl-Alt-Shift-r` while the viewing window is active.
2. Click on the molecule in the 3D viewer.

This action should cause the residue of the selected atom to get labeled. Pressing `Ctrl-Alt-Shift-a` and clicking the same atom will result in the selected atom being labeled. The `Ctrl-` and `Shift-` keys have the same effect as when selecting groups.

1. Label a few residues and atoms.
2. Click on the Molecule Label icon to view its ports in the Properties Area.
3. Change the color of the atom labels by pressing the color button of the Color port and selecting a different color in the color editor.
4. Now select residues in the Levels port. The Attributes, Level Option, Buttons, Font Size, and Color ports now affect the residue labels.
5. Increase the font size (which only increases the font size of the current level, i.e., residues).
6. Select the name entry in the second menu of the Attributes port.

The selected residues will now be labeled by their types and names. In order to understand the Options port of the Molecule Label module:

1. Deselect the last option, replace attributes,
• Set the entry of the second Attributes menu back to disabled.
• Now select a new residue, holding the Ctrl- key down.

The new residue will only be labeled by its type. In contrast, the old residues are still labeled with type and name.
If the first option of the last port, handle clicks, is deselected, mouse clicks will be handled just as if the module Molecule Label did not exist.

• Deselect the handle clicks option.
• Select any residue.

The residue is selected, not labeled.

19.1.2.3 Molecule Selection Browser

In this section, you will learn the basics about the molecule selection browser, which is a very important feature for the investigation of a molecule. The selection browser is a flexible tool for selecting those parts of the molecule that you are interested in. Moreover, it allows you to easily combine different viewing modules into one viewer.

• Select the green icon 1IGM.pdb by clicking on it.
• Press the Show browser button of the Selection port to open the browser.

The scroll view of the browser currently contains three columns, one with the heading level/name, the second with the heading type, and the third with the heading Molecule View. In the first column, all residues of the molecule are displayed. The second column shows the residue type.

• Connect a Bond Angle View to 1IGM.pdb by right-clicking the icon and choosing Bond Angle View from the Display submenu.

You will observe a new column in the selection browser, representing the Bond Angle View (BAV) (see Figure 19.1).

Changing the Appearance of Molecule View and Bond Angle View

In order to get an image similar to Figure 19.2, we first need to set the ports in the Molecule View and the Bond Angle View modules correctly. We begin with the Molecule View module.

• Set the Mode port to balls.
• Set the Quality port to correct.
• Set the Atom Radius port to 1.0.

For the Bond Angle View continue as follows:

• Select the residues entry from the first menu of the Color port.
• From the second menu of Color port, select the index entry.
• Right-click on the color bar of the Discrete CM port and select the colormap physics.icol, if this colormap is pre-loaded. Otherwise, load it from the directory data/colormaps.
Figure 19.1: On the left, Molecule View and Bond Angle View displaying the molecule simultaneously. On the right, the Selection browser after connecting two viewing modules to the molecule.
Figure 19.2: Setting the ports in the viewing modules.
We now only see the Molecule View, since the triangles of the Bond Angle View are hidden by the van der Waals spheres. In order to combine the two viewing modules into one image, continue with the next section.

**Highlighting and Masking with the Selection Browser**

We now want to use the selection browser to display parts of the molecule with the Molecule View module and the rest with the Bond Angle View module. In this section we will only use the selection browser, so all menu names etc. refer to this window.

- Select chains as new master level from the MasterLevel menu.

You will now see three entries in the first column: chains/L, chains/H, and chains/W. This means that the level chains contains three groups, named L, H, and W.

In order to view the group chains/L with the Molecule View and the other two groups with the Bond Angle View,

- remove the check marks for chains/H and chains/W from the column with heading Molecule View by clicking on them.

To deselect the group chains/L for the Bond Angle View,

- click on the respective box in the column Bond Angle View.

Now you should see an image that is pretty close to that in Figure 19.3. However, the Bond Angle View displays more triangles than in the figure. The Bond Angle View in Figure 19.3 only displays backbone atoms. In order to achieve this

- Right-click on the heading labeled Bond Angle View.

A popup menu as in Figure 19.3 should appear.

- Select Backbone from the Restrict to submenu.

The side-chain atoms should not be visible anymore. Next, you should explore the group chains/L a bit further.

- Click on the little icon left to it.

After this action the residues contained in chain L will have appeared.

- Click on the little icon left to the residue L1.

- Type atoms/L4–L33 in the text field labeled Expression, below the scroll window, and press the Replace button.

Atoms L4 to L8 and residues L2, L3, and L4 are highlighted in red. The residue L1 and the chain L are highlighted in green. The color red means that the whole group is selected, i.e., all its elements. Green denotes that the group is partially selected. See Figure 19.4.

To get familiar with the browser, play around with it. If you need further information, just press the F1 button in the browser window or see the description of the Selection Browser.
Figure 19.3: Displaying parts of the molecule with the Molecule View module and the rest with the Bond Angle View module.
19.1.3 Alignment of Molecules

In this section, you will learn how to

1. align molecules by considering selected atoms,
2. compute a Mean Molecule,
3. compute a Configuration Density,
4. compare metastable molecular conformations.

19.1.3.1 Comparing two Molecules

In this section we will compare two different three-dimensional structures of the same molecule.

- Start a New Project File > New Project
- Load the data file alkane.zmf from the directory data/molecules/alkane.
- Select Molecule Trajectory from the popup menu of the alkane.zmf icon.
- Select Molecule from the popup menu of the Molecule Trajectory icon.
- Attach a Molecule View module to the molecule.
- Repeat the last two steps, creating two new objects, Molecule 2 and Molecule View 2

The alkane.zmf icon represents a bundle of molecular trajectories, in this case butane, pentane, and hexane. By attaching a Molecule Trajectory to it, we extract a single trajectory. By default, the first trajectory, which is butane, is selected. We can now extract single time steps from the trajectory by attaching a Molecule object to the trajectory. We have done this twice since we want to compare two time steps with each other. Currently, both molecules extract the same time step. This is the reason for only seeing a single molecule. In order to get more information about the data structures, go to the section on molecular data structures.

- Select the Molecule View icon and change the Mode port to balls and sticks and the Quality port to correct.
• Repeat this action for the *Molecule View 2*.
• Select the *Molecule 2* icon and change the value of the *Time* port to 2.

You should now see two butane molecules in the viewer, slightly displaced.

• Right-click on the white square at the far left side of the *Molecule 2* icon and select *Align Master* from the popup menu.
• Connect the black line to the *Molecule* icon.
• Select the *Molecule 2* icon.
• Press the *all* button of Molecule 2’s *Select* port.

You have now aligned the molecules *Molecule* and *Molecule2* using a least squares fitting of all atoms. This only works for molecules with the same number of atoms. In the following we will align the two molecules by considering only three carbon atoms.

• Deactivate the *Molecule View* by clicking on the orange square of the *Molecule View* icon.
• *Ctrl*-click on three consecutive carbon atoms.

The frame of a red cube should appear around each of them.

• Activate the *Molecule View* by clicking on the gray square on the *Molecule View* icon.
• Select the *Molecule2* icon and press the *in slave* button of the *Select* port.

The three selected atoms should now fit better onto the corresponding atoms of the object labeled *Molecule*.

### 19.1.3.2 Computing a Mean Molecule

In this section we will compute a mean molecule of a metastable molecular conformation of butane.

• Remove the objects *Molecule* and *Molecule2*.
• Select the *Molecule Trajectory* icon.
• Load the data file *but_cluster_3_1.idx* from the directory *data/molecules/alkane*.

*bout_cluster_3_1.idx* is a subtrajectory of *Molecule Trajectory*, i.e., a subset of all configurations in the trajectory.

• Attach a *Molecule* to the icon *but_cluster_3_1.idx*.
• Select the *Mean Molecule* entry from the *Compute* submenu of *but_cluster_3_1.idx*’s popup menu.
• Right-click with the mouse on the white square at the far left side of the *Mean Molecule* icon and select *Align Master*.
• Connect the *Align Master* port to the *Molecule* icon by attaching the black line to it.
• Select the *Mean Molecule* icon and press the *all* button of the *Select* port of the *Mean Molecule* module.
• Press the *Apply* button to compute the mean molecule.
• Visualize the mean molecule `but_cluster_3_1.mean` by attaching a Molecule View to it.
• Connect the AlignMaster port of the module Mean Molecule to the `but_cluster_3_1.mean` icon.
• Press the Apply button of the Mean Molecule module two or three times.

You have now computed a mean molecule of the subtrajectory `but_cluster_3_1.idx`. The AlignMaster is used to align all time steps before accumulating the atom positions. Changing the AlignMaster to the previously computed mean molecule and repeating the computation of the mean molecule will improve it. This procedure should converge.

A better way to compute a mean molecule is to use the module Precompute Alignment, using the Multiple Alignment option of the Mode port. This module creates an object containing a transformation for each structure in the trajectory. This object can then get connected to the Precompute Alignment connection port of the Mean Molecule module.

### 19.1.3.3 Computing and Visualizing a Configuration Density

For the subset of configurations contained in the subtrajectory `but_cluster_3_1.idx`, we will now compute a Configuration Density and visualize it with the Isosurface display module.

• Select the entry Configuration Density from the Compute submenu of `but_cluster_3_1.idx`’s popup menu.
• Connect the AlignMaster port of the Configuration Density icon to the `but_cluster_3_1.mean` icon.
• Select the Configuration Density icon.
• Press the all button of the Select port.
• Press the Field button of the Compute port to compute the density.
• Visualize the created scalar field `but_cluster_3_1.scalar` with an isosurface by first selecting the Isosurface entry from the Display submenu of the icon’s popup menu,
• second, setting the Isosurface’s Threshold value to 0.1,
• and third, pressing the Apply button.
• Try different Threshold values.

### 19.1.3.4 Comparing Metastable Molecular Conformations

The set of configurations in the subtrajectory `but_cluster_3_1.idx` belongs to a metastable conformation of butane. In this section we will compute the density of a second metastable conformation and compare the two with each other.

• Select the Molecule Trajectory icon.
• Load the data file `but_cluster_3_2.idx` from the directory `data/molecules/alkane`.
• Compute the mean molecule of the subtrajectory `but_cluster_3_2.idx` by repeating the steps described above for the subtrajectory `but_cluster_3_1.idx`.
• Visualize the second mean molecule with the Molecule View module.
• Select three consecutive carbon atoms in the second mean molecule as was done in the first tutorial.
• Attach the AlignMaster of the object but_cluster_3_2.mean to the first mean molecule but_cluster_3_1.mean.
• Select the but_cluster_3_2.mean icon and press the in slave button of the mean molecule’s Select port.

The two mean molecules should now be aligned to each other, i.e., the three selected carbon atoms should superimpose.

• Compute the density for the second subtrajectory using the but_cluster_3_2.mean molecule as AlignMaster.
• Visualize the computed density with an Isosurface module.
• Double-click on the colormap of the Isosurface2 module and select a different color to better distinguish the two isosurfaces from each other.

You should now clearly see how the two conformations of butane differ. For larger molecules it might be interesting to color the isosurface according to the atom’s colors. This can be done using the same Configuration Density modules by selecting the Color Field option of the Field port. Attach the computed color field to the ColorField connection port of the Isosurface module.

Notice that you can also visualize the densities with the Volume Render module of the Display submenu.

19.1.4 Molecular Surfaces
In section 19.1.1 of this tutorial, you have seen how to visualize molecules with the Molecule View module. Section 19.1.2, on selection, labeling and masking, showed you how to use Amira’s facilities to select, mask, and label certain parts of the molecule. In this tutorial, we will

1. compute a molecular surface with the Generate Molecular Surfaces module,
2. compute the molecular surface for a restricted set of atoms,
3. compute partial surfaces,
4. explore the Molecule Surface View module,
5. get to know the picking facilities of the Molecule Surface View.

19.1.4.1 Compute Molecular Surfaces
In this section, you will learn how to use the Generate Molecular Surfaces module to compute molecular surfaces with different resolutions. You will also become familiar with some of the module’s basic ports.

• Start a New Project File > New Project
• Load the data file 2RNT.pdb from the directory data/molecules/pdb.
• Attach the Generate Molecular Surfaces module to the green icon by selecting the corresponding entry from the Compute submenu of 2RNT.pdb’s popup menu.
• Select the Generate Molecular Surfaces icon.
• Press the Apply button.
• Attach the Molecule Surface View module to the newly created green icon, 2RNT-surf.

You should now see a gray solvent excluded surface which is still pretty coarse. If you want a surface with better resolution,

• increase the number of points per Å\(^2\) in the Generate Molecular Surfaces module.
• Press the Apply button again.
• Try different resolutions.
• Now select the no duplicate points option in the Options port.
• Press the Apply button.

Due to the last action, some sharp edges will have disappeared. If there are no duplicate points at sharp edges, the surface normals of the adjacent triangles will be interpolated, thus leading to a smoothing, which in this case might be undesired. However, this option is important if it is necessary to have a completely closed surface.

• Change the Quality port to faster.
• Press the Apply button.

You should observe that some atoms disappear. This is due to the fact that now only one surface component will be computed. If the molecular surface consists of only one component, the whole surface will be computed. Since the underlying algorithm does not need to touch every single atom, but approximately only every second atom, the algorithm is much faster. If performance is an issue, you might consider using this option.

19.1.4.2 Compute Partial Surfaces

In order to compute partial surfaces we need to select the atoms for which we want to compute their surface contribution.

• Open the selection browser. If you do not know how to do this, take a look at the second tutorial.
• Type within(residues/HET105, 5) in the browser’s Expression command line.
• Press the selection browser’s Replace button.

All atoms within a distance of 5 Å of the HET105 residue will now be selected.

• Reset the Generate Molecular Surfaces’s Quality port back to correct.
• Select partial surface from the Options port of Generate Molecular Surfaces.
• Press the Apply button.
• Select adjacent patches from the Options port of Generate Molecular Surfaces.
• Press the Apply button.

The last action causes the partial surface to be expanded by the toroidal patches adjacent to the partial surface.
19.1.4.3 Molecular Surface of a Restricted Set of Atoms

The molecule 2RNT.pdb contains some water molecules, which are in most cases not desired when computing the molecular surface. In order to exclude the water molecule from the surface computation

- open the selection browser again.
- In the selection browser scroll to the end of the list of residues.
- Click on one of the strings HOH in the type column.

All residues of type HOH should now be highlighted.

- In the browser, right-click on the heading Generate Molecular Surfaces and select the entry Remove.
- Deselect partial surface in the Generate Molecular Surfaces module.
- Press the Apply button.

For the new surface only those residues that have a check mark in the selection browser were considered. You may combine this procedure with the partial surface computation described above.

19.1.4.4 Exploring the MolSurfaceView

The Molecule Surface View module is already attached to the molecular surface. A second connection exists to the molecule 2RNT.pdb, from which data is read to enhance the visualization.

- Compute the whole molecular surface with a resolution of 2 points per Å².
- Click on the Molecule Surface View icon to see its user interface in the Properties Area.
- Select Molecule for the Color Mode.
- Change the Color port’s first menu entry to residues.
- Select an appropriate colormap for the Discrete CM port by right-clicking on the color bar.
- Switch to interaction mode by clicking on the arrow button in the upper right corner of the viewing window.
- Click on the surface in the viewing window.

All triangles belonging to the picked triangle’s residue will be highlighted. If the triangle belongs to two or even three (maximum) residues, all of those residues will be highlighted.

Clicking on the surface with the middle mouse button displays information about the atom you clicked on in the upper left corner of the viewing window as long as you keep the mouse button pressed. If you Ctrl-click, the information will remain displayed even after releasing the mouse button until the next mouse click on the surface.

- Press the Highlighting port’s Clear button to remove the selection.
- Change the Pick Action port to clipping.
- Pick any triangle of the surface.

All triangles further away from the picked triangle than the distance given by the Selection Distance port will be cut off. All triangles within this distance will remain, however, only if they are connected.
to the picked triangle without leaving the sphere around the picked point.

- Press the All button of the Buffer port to display the whole surface.
- Change the Pick Action port to Surface.
- Shift-click on the surface in the viewing window.

All clicks on the surface will now be handled as you might be familiar with from the Surface View module.

### 19.1.5 Sequential and Structural Alignment

In this tutorial, you will become familiar with the Align Sequences and Align Molecules modules. The Align Sequences tool facilitates the comparison of two sequences. It can be applied to both proteins and nucleic acids except for t-rna molecules containing modified bases. The Align Sequences module is not highly advanced, but it might suffice for some purposes.

Having done the sequential alignment, you can use the correspondence produced by the sequence alignment to do a structural alignment of the molecules.

- Start a New Project File > New Project
- Load the files 1IGM.pdb and 2JEL.pdb from the directory data/molecules/pdb/ and connect a Molecule View to each of them.

You should know how to do this from the first tutorial. For both Molecule View modules:

- select residues from the first menu of the Color port.

A colormap (Discrete CM) with constant color will appear. To distinguish the molecules, choose a different color for one of them. In order to do so

- double-click on the colorbar (the Color Dialog should appear) and
- change the current color by dragging and dropping any of the custom colors.
- Press the OK button of the color editor.

#### 19.1.5.1 Sequence Alignment

We will now use the Align Sequences module to align the sequences of the two molecules. In the next section we will use the associated amino acid pairs for a structural alignment.

- Right-click on the 1IGM.pdb icon and select AlignSequences from the Alignment submenu.
- Right-click the white square on the far left side of the Align Sequences icon.

A popup menu displaying all connection ports opens.

- Select Molecule B from it and connect the port to the 2JEL.pdb icon by clicking on it.

There should now be two black lines connecting the AlignSequences icon with the 1IGM.pdb and 2JEL.pdb icons, respectively.

- Select the module Align Sequences by clicking on its icon in the Project View.
• Choose *semiglobal* from the second menu of the *Align Type* port.
• Press the *Apply* button.

If the alignment has been successful, a window displaying several slightly different alignments will appear.
• Press the *AcceptAll* button. Then press the *Close* button.

This action results in the alignments being written to the molecules as new levels. In order to check this,
• type *1IGM.pdb list* in the Amira console window (available in *Window > Console*).

In addition to levels such as *atoms, bonds, residues,* etc. you will also see levels named *semiGlobalSeqAlign1* to *semiGlobalSeqAlign10.* *2JEL.pdb* has the same levels with an equal number of groups.

### 19.1.5.2 Align Molecules by using the Mean Distance Criteria

We can now use the levels *semiGlobalSeqAlign* for a structural alignment. In order to do so,
• Right-click the icon *1IGM.pdb* and select *Align Molecules* from the *Alignment* submenu.
• Right-click the white square at the far left side of the *Align Molecules* icon, select the *Molecule B* entry, and connect the module to *2JEL.pdb."
• Select the *Align Molecules* icon to make it appear in the Properties Area.
• Select any of the levels named *semiGlobalSeqAlign* in the *Align Level* port and press the *Apply* button.

If you want to follow the alignment process,
• click the *show alignment* option before pressing the *Apply* button (available with the mean dist
 Align Mode).

Compare your result to the online demo.

### 19.1.6 Editing of molecules

An essential tool for manipulating the molecular data structure from Amira XMolecular Extension is the *Molecule Editor.* It allows adding new bonds or changing the overall topology of the molecule as well as manipulating Cartesian or internal coordinates.

For each of these tasks, there is an example in the following section to give you an easy "learn by doing" introduction to the available features. Each action performed with the editor affects all currently selected atoms. Thus, it is necessary for you to be familiar with the functions of the *SelectionBrowser* beforehand (see section 19.1.2 on selection, labeling, and masking).

• Start a New Project *File > New Project*
• Load the file *1HVRm.pdb* from the directory *data/molecules/pdb/* and connect a *Molecule View* module to it.
• Select the balls and sticks representation for the MoleculeView.

The data structure loaded is an enzyme of HIV in complex with the inhibitor XK263.

19.1.6.1 Invoking the Molecule Editor

To start the editor

• select the 1HVRm.pdb object in the Project View and press the Molecule Editor button (pencil icon) in its user interface.

The molecule editor interface is now visible. However, for the tasks we want to perform, we also need the selection browser, which is opened by

• pressing the Show Browser button of the Selection port of 1HVRm.pdb.

19.1.6.2 Adding Bonds to a Part of a Molecule

The inhibitor XK263 is currently without bonds. To add bonds, carry out the following steps:

• Open the selection browser and select the residue with the type XK2 (it is at the end of the list).
• Switch to the Tools tab in the molecule editor and press the bond-length table button in the Mode section. Then, press the add button in the Action section.

Adding bonds in the bond length table mode will create new bonds in the selected part of the molecule by comparing the distances between the atoms with a table of average bond lengths. The result should now look like Figure 19.5.

19.1.6.3 Splitting the Molecule

We now want to split the molecule into inhibitor and protein.

• If it is not currently selected, reselect the XK2 residue in the selection browser.
• Press the Split button on the Tools tab of the molecule editor.

You will notice that the atoms of the inhibitor are no longer displayed by the Molecule View and that a new object, 1HVRm2.pdb, has appeared in the Project View. This object contains the previously selected atoms of the ligand.

19.1.6.4 Adding another molecule

The protein of the 1HVR entry is a protease which uses up one water molecule to split a polypeptide. We now want to add the water to the active site of the enzyme.

• Load the file h2o.pdb from the directory data/molecules/pdb.
• Go to the molecule editor and press the Add button in the Change Topology section.
• In the window that opens, all other molecules in the Project View will be shown. Select the h2o.pdb molecule and press OK.

The atoms of the water molecule have now been copied to the 1HVRm.pdb object.

First Steps with Molecular Visualization in Amira
19.1.6.5 Moving Parts of the Molecule

To concentrate our view on the region of interest we will reduce the molecular view to amino acids A25 and B25 between which the water molecule should be placed.

- Type "r/name=?25 OR r/type=H2O" into the selection browser and press the Add button.
- Now move your mouse on the Molecular View heading, press the right mouse button, and activate the Replace option.

With only the residues A25 and B25 and the water molecule displayed, all that is left to do is to drag the water molecule to its correct location.

- Select the water molecule in the selection browser (the residue at the end of the list).
- Switch to the Transform tab of the molecule editor.
- Show the position of the transform dragger by pressing the button in the Position section of the Transform tab.
- Left-click on the dragger and hold the mouse button down. You can now translate the dragger in different planes depending on the side you clicked on. Move the water molecule between the two amino acids as shown in Figure 19.6.
- To reorient the water molecule, click on the green knobs of the dragger. They allow the dragger to rotate in different planes.

Repeat the steps described above until you are satisfied with the result.

To apply the changes that you made to the edited molecule, you must press the Apply button or end the editing by using the OK button.

19.1.7 Molecular Interfaces

This tool is particularly interesting for visualizing contact areas between parts of a single molecule or between different molecules, e.g., enzymes and their ligands. In this example we will consider the second case.

- Start a New Project File > New Project
- Load the file 2RNT.pdb from the directory data/molecules/pdb.

19.1.7.1 Defining groups

In this section we will create a new level, called interface, for the molecule and define two groups of the level, substrate and receptor, respectively.

- Select the 2RNT.pdb icon in the Project View by clicking on it.
- Now click in the console window to activate it, and press the TAB key.

The name of the selected icon, 2RNT.pdb, should appear in the console window. If it does not,

- please type 2RNT.pdb.
- On the same line, type define interface/substrate residues/HET105

First Steps with Molecular Visualization in Amira 765
The following text should now be written in the console window

2RNT.pdb define interface/substrate residues/HET105

- Press the ENTER key.

You have now defined the group substrate in the level interface. The group consists of the residue HET105. We will now define the group receptor.

- Press the TAB key again, then type defregexp interface/receptor NOT residues/HET105 AND NOT residues/type=HOH

With NOT residues/HET105 we exclude the substrate and with NOT residues/type=HOH we exclude all water molecules. Thus, the receptor is defined as consisting of all atoms not belonging to either the substrate or any water molecule.

If you now list all levels by typing

- 2RNT.pdb list

you will see an interface level containing two groups.

- Type 2RNT.pdb list interface

and all groups of the interface level will be printed in the console window.

19.1.7.2 Computing the Interface

We will now compute the interface between the receptor and the substrate. The interface between two molecules is defined as the surface equidistant to both molecules. For the approximation we compute, this might not be exactly true for all points on the surface. The module to compute the interface is called Generate Molecular Interface.

Now, to compute the interface,

- Right-click the icon 2RNT.pdb and select Generate Molecular Interface from the Compute submenu.
- Select the icon labeled Generate Molecular Interface in the Project View.
- Choose interface from the Levels menu of the Generate Molecular Interface module.
- Press the Apply button.

Two objects result from this action, an interface object of type Mol Surface, 2RNT-interface.surf, and a distance field of type Uniform Scalar Field, 2RNT-distance.field.

19.1.7.3 Visualizing the interface

Finally, we will view the computed interface in the viewing window with the Molecule Surface View module.

- Right-click on the 2RNT-interface.surf icon and select Molecule Surface View.
- Right-click on the white square at the far left side of the Molecule Surface View icon and connect the Color Field port with the distance field 2RNT-distance.field.
The user interface of the *Molecule Surface View* module should be visible in the Properties Area.

- Choose the *field* option from the *Color Mode* port, resulting in a new port, *Colormap*, appearing in the user interface.
- Right-click on the colormap bar and choose any colormap.
- Play around with the coloring by changing the colormap range. The full range of values can be seen when you select the *2RNT-distance.field*, i.e., click on it.
- Also, change the *Cutoff distance* in the *Generate Molecular Interface* module, e.g., to 1.0, and the *Voxel size*, e.g., to 0.5.
- See what happens when you press the *Apply* button of the *Generate Molecular Interface* module.

**Warning:** If you choose a very small voxel size, the computation might take very long. Also, there might not be enough memory to store such a large distance field. Usually, 1.0 or 0.5 are good values. After having done the steps described above, what you see should be similar to the Nuclease demo on the demo pages. The interface here, however, has been generated from two separate files.

### 19.1.8 Measurement

In this tutorial, you will learn how to measure distances and angles between atoms in a molecule. For this tutorial it is necessary for you to have already done the tutorial 19.1.1.

- Start a New Project *File > New Project*
- Load any molecule from the directory *data/molecules/* and connect a *Molecule View* to it.
- Select the *Molecule View* by clicking on its icon in the Project View.
- Select *balls and sticks Mode* and *fast Quality*.
- Next, right-click on the loaded molecule name icon, and select *Measurement* from the submenu *Display*.

The user interface of the *Molecule Measurement* tool should now be visible in the Properties Area. An *Info* port tells you that you need to select 2, 3, or 4 atoms. In order to do so, switch to interaction mode by

- pressing the *ESC* key or by pressing the arrow button in the upper right corner of the viewing window.

You can now select single atoms in the viewer by clicking on them. If you click on one atom, the previously selected atom will be deselected. By using the *Ctrl*-key, you can select more than one atom.

- Select 2, 3, or 4 atoms and observe what is being displayed in the user interface of the *Measurement* module.

The *Ctrl*-key is also used to deselect atoms.
Figure 19.5: Adding bonds to the ligand
Figure 19.6: Moving the water molecule to the desired location
19.2 Molecular Data Structures

Several molecular file formats including, for example, PDB, Tripos, and UniChem, can be read and written by Amira XMolecular Extension, other file formats, such as CHARMM, can only be read. The information read from the data files will be stored in different types of objects: Molecule, Molecule Trajectory, and Molecule Trajectory Bundle.

**Molecule.** Single molecular configurations are represented as data objects of type Molecule. This kind of object can either be created by loading a file containing a single molecular structure or by attaching it to an object of type Molecule Trajectory, in which case it will act as a projector, extracting one of the trajectory’s ‘time steps’, i.e., a single structure.

**Trajectory.** The Molecule Trajectory data structure represents a series of molecular configurations of the same molecule. Again two cases are possible. Either the trajectory is loaded directly from a file. Or it can be attached to an object of type Molecule Trajectory Bundle, extracting one of the trajectories contained in that bundle.

**Bundle of trajectories.** A trajectory bundle reflects the case of a file containing more than one molecular trajectory. If such a file is loaded into Amira, an object of type Molecule Trajectory Bundle will be created. A single trajectory can be accessed by attaching a Molecule Trajectory object.

19.2.1 Internal Structure of Molecules

An object of data type Molecule contains information about the structure of a molecule and the atomic coordinates of one of its configurations. The mandatory part of structural information concerns the number and types of all atoms contained in the molecule. All the topological information is organized in levels which are cliques of groups. Each group contains other groups or atoms. The simplest example is the level bonds, which consists of groups of two atoms.

Some levels can build hierarchies. For example, a residue consists of a number of atoms, and a couple of residues may form a secondary structure. These levels and groups can be defined by file readers or interactively via Tcl commands.

19.3 Displaying Molecules

Molecules can be visualized with the Molecule View, Bond Angle View, Secondary Structure View, or Tube View modules. A sample output of the first two modules is shown in Figure 19.7.

In addition, there are two modules for generating molecular surfaces. The Generate Molecular Surfaces module enables you to generate the solvent accessible, solvent excluded, and van der Waals surfaces of a molecule. The Generate Molecular Interface module can be used to generate intra- and intermolecular interfaces, such as between single atoms or residues, or between two molecules, respectively.

19.3.1 Coloring Molecules

The atom-oriented modules Molecule View, Bond Angle View, Configuration Density, and Molecule Surface View allow a coloring on a per-atom basis, i.e., each atom is assigned a color. Balls in the Molecule View will have the corresponding colors. Sticks will be split into halves colored according
Figure 19.7: Molecule View (left and middle) and Bond Angle View (right) display the molecule simultaneously.

to their attached atoms. In the Bond Angle View, atom colors are assigned to the vertices and color is interpolated over the triangles.
To determine the coloring you can choose a level, e.g., atoms, residues, secondary structures, or chains. Furthermore, you can choose one of the level’s attributes. The coloring will then be done according to the group’s attributes such that all atoms of the same group will have the same color.

Color

A molecule may be colored according to various schemes. For example, each atom of a specific type may have the same color. Another possibility is to give all atoms belonging to a certain group the same color. The first menu of the Color port specifies the group level, e.g., atoms, residues, secondary structures, or chains. The second menu allows you to decide which attribute of the specified level should be considered to color its groups.
If you press the Legend button, a separate window will be opened, which displays a legend of the coloring, i.e., a table associating colors with attribute values according to the current coloring. Clicking on the text to the right of a color will select all atoms with this color.

Continuous CM

This colormap is used to map values of float attributes to colors. For optimal mapping, the colormap range must be set correctly. By default, the range is set to the minimum and maximum values that occur using the chosen color scheme, if the button in front of the first text field displays a capital ”L”. The ”L” means that the colormap uses a local range which allows you to modify the range without affecting the range of the same colormap used in other modules. By pressing the button you can toggle between local and global range.
The default colormap has a constant color over the whole range. By leaving it constant you give all atoms the same color, which may be useful if you want to compare different molecules. For more information, see the section on colormaps.
Discrete CM

This colormap is used to map values of discrete attributes, like integers and strings, to colors.

Define Color

This port can be used to overwrite the standard colors of the selected color scheme. With the All button you can set a new color for all atoms. The Clear button unset the user-defined colors for all atoms. The Set and Unset buttons operate on the set of highlighted atoms. These buttons can be used to set and unset the colors of those atoms, respectively.

19.3.2 Selecting and Filtering atoms

Various tasks require the selection of atoms in a molecule. The most prominent are the alignment of molecules and the selective display of molecule parts. Amira offers two selection methods. You can select atoms visually via any of the viewing modules. Alternatively, selection can be done via the molecule’s selection browser, which can be opened by pressing the Show button of the molecule.

19.3.2.1 Selection of Atoms with a Viewing Module

The selection of atoms with a viewing module can be done in two ways. The first way is by clicking on certain displayed parts of the molecule. In general, this will highlight the selected parts. By default, the number of atoms that will be affected by a click depends on the selected group level of the color port. For example, if the atoms in the viewing module are colored according to the residues level, all atoms belonging to the same residue as the picked atom will get selected. However, since this is very restrictive, you can easily change the selection mode to the most common levels, i.e., atoms, residues, secondary structures, and chains. In order to choose a certain level for the selection you need to press certain keys in advance. Ctrl-a chooses the atoms level, a click on an atom will only influence the selection for this atom. Ctrl-r, Ctrl-c and Ctrl-s choose residues, chains and secondary_structure levels, respectively. To switch back to the default behavior, where coloring determines selection, press Ctrl-d.

If you pick another part, the previously highlighted atoms will be unhighlighted and the newly selected atoms are highlighted. Ctrl-clicking a part of the molecule leaves the existing selection state of all atoms unchanged except for the newly selected atoms. If the selected atoms had been selected before, they will get deselected, otherwise they will get selected. On the one hand, this allows you to add atoms to the selection, on the other hand it also allows you to deselect atoms.

If you select some group and afterwards select a second one from the same level holding down the Shift-key all groups between the two will also be selected. The Shift-key can also be used in conjunction with the Ctrl-key.

If you do any selection by clicking in the viewer there will be some output in the console window informing you about what you have selected, the amount of output can be customized via the Preferences dialog, which is opened by choosing the Preferences entry from the Edit menu. The preferences concerning Amira XMolecular Extension are found on the Molecules tab.

Displaying Molecules 772
Highlighting

The second way to select parts of the molecule is by using the functionality of the *Highlighting* port.

- If you press the *Box* button, the molecule’s bounding box will be displayed. All atoms contained in the box will be highlighted. You can change the size of the box in *interaction mode* by clicking on the highlighted handles (usually in a light green) of the box. Keep the mouse button pressed and drag in the desired direction. Notice that the box will not exceed the molecule’s bounding box. You can also move the box within the bounding box by clicking on one of the box’s sides. Pressing the *box* button a second time hides the box.

- After pressing the *Draw* button, you can draw a line in the viewer window which selects all atoms that are inside the line. Pressing the Ctrl-key while drawing inverts the selection. With the Shift-key you can remove atoms from the selection.

- The *Clear*-key deselects all atoms and hides the box if it is visible.

19.3.2.2 Filtering atoms

Filtering atoms gives us the ability to hide parts of the molecule for a certain module. All viewing modules and some computational modules, such as the *Generate Molecular Surfaces* module, contain a filter that keeps track of all atoms of a molecule which are currently *in use*. The term *in use* means that the module will only see the *in use* atoms and regard all other atoms as non-existing. Thus, a viewing module will only display the *in use* atoms, and the computational module *Generate Molecular Surfaces* will compute the molecular surface ignoring the *not in use* atoms. Each filter will register itself at the molecule’s selection browser, so that you can easily determine the *in use* atoms of a module. For more information about how to do this, see the description of the selection browser.

In most modules, the filter’s *Buffer* port will be visible, which adds to the convenience. The functionality of the *Buffer* port is described below.

**Buffer**

Pressing *Add* will append the selected atoms to the *in use* atoms. The *Remove* button will delete the selected atoms from the *in use* list. *Replace* will first clear the *in use* list and then add the selected atoms to it. Finally, the *All* and *Clear* buttons are shortcuts to delete or add all atoms from or to the *in use* list, respectively.

The buffer can also be accessed via Tcl commands. Each visualization module using a buffer offers the following set of commands:

- *showAll*
  All atoms are shown.
- *hideAll*
  All atoms are hidden.
setVisible
All selected atoms will be hidden.
addVisible
All selected atoms will be hidden.
removeVisible
Only selected atoms are shown.

19.4 Aligning Molecules

To compare the structures of several molecules it is necessary to bring them into a suitable geometric arrangement relative to each other, because their absolute positions in the common coordinate system are generally meaningless. By arranging the molecules in various different ways, you can investigate various aspects.

19.4.1 Alignment of Trajectories

Amira XMolecular Extension offers a reusable component for the alignment of molecules. It appears in several modules, e.g., Molecule, Configuration Density and Mean Molecule. Here, we will give an overview of the available functionality.

Two connection ports are supplied:

**AlignMaster** [optional]
To compute an alignment relative to a reference molecule, this port must be connected to the reference.

**PrecomputedAlignment** [optional]
This port can be connected to an alignment precomputed by using the module Precompute Alignment. The control of the alignment is done via three ports, as described below:

**Transformation**

This port allows you to specify how the molecule should be aligned. The possible options are:

- **none**: Atom coordinates are left as they are.

- **center of gravity**: The molecule is positioned to the coordinate center (center of gravity) by applying a translation.

- **align to master**: This mode requires a master molecule to be connected to the AlignMaster port which is used as a reference to which other molecules, the slaves, are aligned. We consider correspondences between atoms from the reference molecule, i.e., master, and atoms from the molecule to be aligned, i.e., slave. The alignment is done by minimizing the sum of squared distances between all corresponding atoms.
**precomputed**: This option is only enabled if the PrecomputedAlignment connection port is connected to an alignment object that has been previously computed. If precomputed is chosen, the transformation will be taken directly from this object.

**external**: This option indicates that the molecule’s global transform has been explicitly set, e.g., via the Tcl command *setTransform* or by using the Transform Editor.

**Select**

| Select: | all | in slave | in master | in both | Set |

This port becomes important if *align to master* is selected. It gives control over the atoms in the slave and the master that are used for the alignment. In the general case master and slave molecules are different, i.e., their numbers of atoms differ, and an alignment requires an explicit specification of pairs of atoms. This can be done by highlighting atoms in both molecules via the Molecule View module and then pressing the *in both* button. Depending on whether the option menu is set to *Set* or *Add*, the highlighted atoms will either replace an existing list of selected atoms or otherwise will be appended to it. The matching between atoms in the two molecules is defined by their order of selection. The buttons *all*, *in slave*, and *in master* offer shortcuts for the frequent case of slave and master having the same number of atoms including the assumption that their order defines a natural matching. The easiest way is to use all atoms by pressing *all*. Selection of a subset can be done by highlighting in either the slave or the master and then pressing *in slave*, or *in master*, which will use the selected atoms in the respective molecule for the other molecule, too.

**Selection**

| Selection: empty |

If *align to master* is selected, this port displays the existing state of selection that is used to compute the alignment. Possible forms are:

**empty**: No atoms are selected. At least three are necessary for an alignment.

**all atoms**: Master and slave have the same number of atoms and all are used for the alignment.

**0, 5, 6**: A list of indices implies that master and slave have the same number of atoms and identical subsets have been selected.

**0 → 7, 5 → 6, 6 → 5**: A list of index pairs (master index → slave index) indicates a matching resulting from individual selections in master and slave.

### 19.4.2 Mean Distance Alignment

Apart from the above mentioned alignment procedure, there exists a module that allows you to align two molecules by using the *mean distance* criterion instead of the *mean squared distance*. See Align
Molecules for more information.

19.4.3 Sequence alignment
Amira XMolecular Extension allows you to align sequences of two molecules (see Align Sequences). Three algorithms are available for use depending on the kind of data and your needs: local, semi-global, and global alignment. The algorithms work both for proteins and ribonucleic acids, whereas t-RNA molecules are currently not supported because they contain modified bases. This module can be very helpful when used in conjunction with the Align Molecules module.

19.5 Visualizing Molecular Trajectories and Metastable Conformations
A Molecule Trajectory can be visualized via animation of single time steps by attaching a Molecule module to the Molecule Trajectory and then attaching a Molecule View or Bond Angle View to the Molecule. The animation is controlled via the Molecule’s Time port.
For MolTrajectories that represent metastable conformations, the modules Mean Molecule, Precompute Alignment, and Configuration Density can be used. The Mean Molecule module aligns all steps of a trajectory and computes a mean molecule by averaging every atomic coordinate over all time steps. Instead of computing the mean molecule to a reference, as with the Mean Molecule module, the Precompute Alignment module allows you to find the optimal transformation of each time step to minimize the overall sum of squared distances. With the Rank Time Steps module you can search in a trajectory for a desired time step, using different criteria, such as the rmsd value to a given reference.
The Configuration Density module gives an impression of the fuzziness of the conformation by computing a probability density for the positions of atoms and bonds within a molecular trajectory. This density can then be visualized with the Isosurface and Volume Render modules.

19.6 Atom Expressions
19.6.1 Overview
Atom expressions are a query language to find and select atoms of certain properties in the molecule for further action. The most important application of atom expressions in Amira is the highlighting section of the Selection Browser.
In Amira, a molecule is separated into groups of different levels. Each group contains a set of attributes. (More details of this concept can be found in the description of the Attribute Editor). Atom expressions are a simple form of a relational query language which accesses these attributes.
The simplest form of an atom expression is an atom specifier. This is a literal defining a level, one of its attributes, and a condition for this attribute. For example, atoms/atomic_number=8 defines all atoms whose atomic number attribute equals 8 (i.e., all oxygens).
Such atom specifiers can be combined with logical operators like AND, OR and NOT. For example, atoms/atomic_number=8 AND NOT atoms/charge=0 will select all charged oxygen atoms.
There are additional operators like WITHIN, BONDED and SMARTS which apply certain conditions to coordinates or bond structure. These are explained in section on operators.

19.6.2 Grammar

All possible syntaxes of atom expressions are shown in the following grammar. The different literals and operators are further explained in the following sections.

\[
\text{atomExpr} \rightarrow \begin{cases} 
( \text{atomExpr} ) \\
\text{NOT} \text{atomExpr} \\
\text{atomExpr AND atomExpr} \\
\text{atomExpr OR atomExpr} \\
\text{WITHIN} (\text{atomExpr}, \text{radius}) \\
\text{WITHIN} (x,y,z,\text{radius}) \\
\text{BONDED} (\text{atomExpr},[\text{depth}]) \\
\text{SMARTS} (\text{smartsExpr}) \\
\text{CS} \\
\text{atomSpecifier} \\
\text{dataSpecifier}
\end{cases}
\]

\[
\text{atomSpecifier} \rightarrow \text{hierName}[/\text{attrName=}\text{ID}]
\]

19.6.3 Literals

As mentioned in the overview, the simplest form of an atom expression is an atom specifier. An atom specifier consists of three literals: \textit{hierName}, the optional \textit{attrName}, and \textit{ID}.

\textbf{hierName} stands for a name of a hierarchy level (e.g., residues). The following abbreviations can be used for the most common levels:

\texttt{a=atoms, r=residues, b=bonds, s=secondary structure, c=chains}

\textbf{attrName} is optional and specifies the name of an attribute (e.g., temperature, occupancy, type, ...) of the given level. If it is omitted, the ID is assumed to specify the attribute name or index as shown by the list command. If an attribute name is given, the ID is assumed to stand for values of the attribute.

To see which hierarchy levels and respective attributes are defined for a given molecule, take a look at the \textit{Color port} which is used in several modules. The right pull-down menu will show all available attributes for the level chosen in the left pull-down menu.

\textbf{ID} specifies an identifier of a member of the given level. If an attribute name is given, ID specifies a value of this attribute. It may contain wildcards such as * (any substring will match) and ? (any single character will match). Several values may be separated with a ; (example: atoms/index=3;7). For integer and float attributes ranges can be used by delimiting the boundaries with a colon (i.e. atoms/index=5:10 selects all atoms with an index within this range). If no attribute name is given, the name attribute is used as a default. In this case, specifying a range will select all atoms whose index is between the index of the selected boundaries. (as an example, for a molecule imported form PDB the residue name is the chain identifier plus the residue index, thus r/L1:L5 selects residues 1 to 5 on the L chain). An exception to this is the atoms level. Molecules in Amira contain an atomic number attribute instead of an element symbol attribute. To select atoms via their element symbol you can...
simply type \textit{a/element}. Thus the atom specifier for all oxygen atoms \textit{a/O} is equivalent to the atom specifier \textit{a/atomic\_number=8}.

Instead of the '=' comparison you can also use the comparison operators '<', '>', '<=', and '>='.

\section*{19.6.4 Operators}

\subsection*{Logical Operators}

Several \textit{atomSpecifier} combinations can be used in one expression by linking them logically via the operators AND, OR, and NOT (\texttt{&}, \texttt{|}, and \texttt{!}). Priorities can be specified using usual parentheses ( and ).

\texttt{WITHIN(atomExpr, radius)}

This operator selects all atoms which are nearer than \textit{float} Å to any of the atoms specified by \textit{atomExpr}.

\texttt{WITHIN(x, y, z, radius)}

This operator selects all atoms which are nearer than \textit{radius} Å to the specified \textit{x,y,z} coordinate.

\texttt{BONDED(atomExpr[, depth])}

With this operator, all atoms that are recursively connected to any atoms specified by \textit{atomExpr} will be chosen. You can optionally specify an integer value defining the maximal bond steps. If this is omitted, there will be no limit.

\texttt{CS}

\texttt{CS} specifies all currently selected (highlighted) atoms.

\texttt{SMARTS(smartsExpr)}

The smarts operator allows you to select a chemical pattern within the molecule with a SMARTS expression \cite{1}. If you want to include the hydrogen atoms connected to the specified heavy atoms use \texttt{SMARTSH} instead of \texttt{SMARTS}.

Example: \texttt{SMARTSH(C=O)} selects all carbonyl groups (including potential explicit hydrogens on the carbon).

If you want to include only parts of the matched pattern in the selection you can specify map indices in the smarts pattern. If any atom in the string contains a map index all atoms without a map index will not be used for the matching.

Example: \texttt{SMARTS(C=[O:1])} will match the oxygen in a carbonyl.

\section*{19.6.5 Data specifiers}

A data specifier allows you to match a certain data value of the molecule. If the data entry in the molecule matches the specifier, all atoms are matched, else no atom is matched. This is useful when searching through several trajectories in a \textit{Molecule Trajectory Bundle} with the match command.

A data specifier consists of the data name, the comparison operator, and the value. The same rules apply like for atom specifiers (i.e., a list can be specified with ';' and ranges with ':').

Example: \texttt{SMARTS(C=O) AND logP>4} selects all carbonyl groups, but only if the logP data value in the molecule is greater than 4.
### 19.6.6 Shortcuts

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>acidic</td>
<td>acidic amino acids</td>
</tr>
<tr>
<td>acyclic</td>
<td>acyclic amino acids</td>
</tr>
<tr>
<td>aliphatic</td>
<td>aliphatic amino acids</td>
</tr>
<tr>
<td>alkali</td>
<td>atoms which are alkali metals</td>
</tr>
<tr>
<td>alkaliearth</td>
<td>atoms which are alkali earth metals</td>
</tr>
<tr>
<td>all</td>
<td>selects everything</td>
</tr>
<tr>
<td>amino</td>
<td>amino acids</td>
</tr>
<tr>
<td>aromatic</td>
<td>aromatic amino acids</td>
</tr>
<tr>
<td>at</td>
<td>adenine or thymine</td>
</tr>
<tr>
<td>backbone</td>
<td>atoms of protein or DNA/RNA</td>
</tr>
<tr>
<td>basic</td>
<td>basic amino acids</td>
</tr>
<tr>
<td>buried</td>
<td>amino acids usually found inside the protein</td>
</tr>
<tr>
<td>cg</td>
<td>cytosine or guanine</td>
</tr>
<tr>
<td>charged</td>
<td>charged amino acids</td>
</tr>
<tr>
<td>cyclic</td>
<td>cyclic amino acids</td>
</tr>
<tr>
<td>h2o</td>
<td>water molecules</td>
</tr>
<tr>
<td>helix</td>
<td>helices</td>
</tr>
<tr>
<td>halfmetallic</td>
<td>atoms which have half metallic properties</td>
</tr>
<tr>
<td>halogens</td>
<td>halogenic atoms</td>
</tr>
<tr>
<td>hetero</td>
<td>heterogenic atoms</td>
</tr>
<tr>
<td>hydrophobic</td>
<td>hydrophobic amino acids</td>
</tr>
<tr>
<td>ions</td>
<td>charged heterogenic atoms</td>
</tr>
<tr>
<td>metallic</td>
<td>atoms which have metallic properties</td>
</tr>
<tr>
<td>neutral</td>
<td>neutral amino acids</td>
</tr>
<tr>
<td>noblegas</td>
<td>atoms which have noble gas properties</td>
</tr>
<tr>
<td>nonmetallic</td>
<td>atoms which have nonmetallic properties</td>
</tr>
<tr>
<td>nucleic</td>
<td>nucleic acids</td>
</tr>
<tr>
<td>nucleicbackbone</td>
<td>backbone atoms of RNA/DNA</td>
</tr>
<tr>
<td>polar</td>
<td>polar amino acids</td>
</tr>
<tr>
<td>proteinbackbone</td>
<td>backbone of a polypeptide</td>
</tr>
<tr>
<td>purine</td>
<td>adenine or guanine</td>
</tr>
<tr>
<td>pyrimidine</td>
<td>cytosine or thymine</td>
</tr>
<tr>
<td>sheet</td>
<td>sheets</td>
</tr>
<tr>
<td>sidechain</td>
<td>atoms not belonging to the backbone</td>
</tr>
<tr>
<td>site</td>
<td></td>
</tr>
<tr>
<td>surface</td>
<td>amino acids usually to be found on the surface</td>
</tr>
<tr>
<td>turn</td>
<td></td>
</tr>
</tbody>
</table>

Amira XMolecular Extension also provides pre-defined shortcuts that have been assembled using the previously mentioned syntactical elements. The shortcuts can be found in your local Amira directory in `share/molecules/atomExpr.cfg`, and can be edited and supplemented. The standard aliases included in the current Amira release are listed in the table.
19.6.7 Further Examples

- `all`
  selects all atoms.
- `atoms/5:8`
  all atoms whose index is in the range 5 to 8.
- `atoms/atomic_number>1`
  all atoms, except hydrogens
- `s/type=helix AND NOT (a/C;N)`
  all atoms which belong to helices, except C and N atoms.
- `r/type=A*`
  all atoms which belong to residues whose type name begins with the letter A.
- `BONDED(a/4;100,6)`
  all atoms which are connected via at most 6 steps to the two specified atoms
- `WITHIN(r/pdb_index=11,3.8) AND a/C`
  all carbon atoms which are not away further than 3.8 angstroms from atoms of residue 11.
- `SMARTS(C1CCCCC1)`
  A cycle consisting of 6 non aromatic carbons (i.e., cyclohexane).
- `acidic AND helix`
  all atoms of acidic amino acids which belong to helices

References

Part VI

Amira XWind Extension User’s Guide
Chapter 20

Amira XWind Extension

The Amira XWind Extension provides tools for creating, analyzing, visualizing, and presenting numerical solutions from CAE and CFD simulations.

The Amira XWind Extension provides advanced support for the following:

- Defining simulation inputs
  - 3D mesh generation for numerical simulation applications such as flow, stress, or thermal analysis
  - Boundary conditions
  - Export of surfaces or 3D meshes to numerical solvers
- post-processing of result data coming from solvers
  - Powerful visualization and analysis of scalar, vector, and tensor fields coming from either simulation or measurements
  - Import from major CAE file formats with low memory footprint and fast management of model data
  - Flexible probing and measurements
  - Extensive computation of derived variables and statistics on simulation results
  - Advanced feature extraction tools such as vortex core lines or critical points

The Amira XWind Extension applies to the following:

- exploration, analysis, and comparison of data coming from simulation or measurements
- modeling from 3D images for Finite Element Analysis (FEA), Computational Fluid Dynamics (CFD), Computer Aided Design (CAD), and Rapid Prototyping
- high-quality presentation and communication, from movie generation to remote collaboration, immersive displays, or virtual reality (requires Amira XScreen Extension)

The Amira provides base post-processing support limited mostly to visualization. Amira XWind Ex-
tension extends the Amira feature set by adding advanced Delaunay-based mesh generation and post-processing computation, and analysis of derived variables, statistics and feature extraction. Amira XWind Extension brings also the robust support for unstructured mixed meshes made up of tetrahedra, hexahedra, pyramids, and wedges. Most CAE file formats are supported in Amira XWind Extension only. See the *File Formats Index* of the User’s Guide for a complete list of supported file formats. By following the provided tutorials, you will learn how to use these modules on your own datasets. To start you do not have to read the *tips* sections.

The data used for this tutorial is normally installed in the directory `data/tutorials/cfd-fia-advanced` under your `AMIRA_ROOT` directory.

Defining simulation inputs:

- Amira XWind Extension Meshing Workroom
- Amira XWind Extension Meshing Tutorial

Post-processing solvers’ results:

- Getting Started with Reading and Visualizing CAE/CFD Data
- Amira XWind Extension Model Information and Display
- Amira XWind Extension Scalar Field Display
- Amira XWind Extension Vector Field Display
- Amira XWind Extension Statistical and Arithmetic Computations
- Amira XWind Extension Vorticity Identification
- Amira XWind Extension Measurements

## 20.1 Meshing Workroom

*This Workroom is only available on Microsoft Windows platform.*

The Meshing Workroom is a pre-processing tool for creating simulation inputs. It allows computing a *tetrahedral* mesh with boundary conditions. The mesh can then be exported to various solvers’ file formats such as Fluent, COMSOL Multiphysics (c), etc. see *XWind file formats*.

The Meshing Workroom does not use the legacy meshing engine available in Amira, which is based on advancing front technique. The meshing engine used in the Workroom is based on Delaunay refinement and is available with the Amira XWind Extension license. Currently, the Meshing Workroom is only available on the Windows platform.

The Meshing Workroom takes a *label field* (currently, only 8-bit Label Fields are supported) as input to generate a mesh. A *label field* may be created with the *Segmentation Workroom* or other tools such as *Interactive Thresholding*, *Auto Threshold*, etc.

No other inputs are required. Optionally, various *uniform scalar fields* may be used to control the mesh density (see *Advanced mode* (Meshing Tab)).
For a complete workflow description, please refer to the *Meshing Workroom Tutorial*. The documentation of the Meshing Workroom is separated into the following parts:

- **First steps**
- **Inspecting the generated mesh**
- **Fast meshing versus precise meshing**
- **Controlling the refinement of the mesh**
- **Advanced meshing mode**
- **Troubleshooting**
- **Assigning boundary conditions to the mesh**
- **Exporting the mesh**
- **Scripting the room: TCL command list**
- **Progress bar indications**

All illustrations using the corn kernel dataset are courtesy of, Pawan S Takhar, University of Illinois at Urbana-Champaign.

### 20.1.1 First Steps

To activate the Meshing Workroom, press the Meshing Workroom icon in the Workroom toolbar. The main parts of this Workroom include:

- **A general area**: This area of the Workroom lets you see or select the mesh currently set in the Workroom. It also lets you select the solver type that is targeted in the workflow. An Export button is available whenever a mesh is created. It will export the mesh in the format selected from the type field (Figure 20.1).

  ![Figure 20.1: The General Area](image)

- **A Meshing tab**: This is where you build the mesh. A label input can be set using the label data field. Once you set the Create button so that it becomes accessible, you may generated a mesh (Figure 20.2).

- **A Boundary tab**: This is where boundary conditions are assigned to the mesh. Various tools let you select the elements (triangles) which are part of a given boundary condition group (given name and ID). This tab is available only if the selected file format allows exporting boundary conditions (Figure 20.3).

The very basic workflow consists of the following:
1. Create a label field (see for example Segmentation Workroom) with as little noise (small dots, misalignment, etc.) as possible.

2. Set the export format in the general section located above the tabs. The Boundary tab will be available if the export format allows it.

3. Set the label into the Meshing tab’s label data input of the Meshing Workroom.

4. Set the meshing options and create the mesh by clicking Create. Once created, the mesh will be displayed in the main viewer of the room.

5. (Option) Assign the boundary conditions to the mesh if the export format allows it.

6. Finally, export the mesh into the selected format by clicking Export in the general section located above the tabs.

Various mesh quality and optimization settings are available and are described in the next sections of the Meshing Workroom documentation. You can either create a new version of a mesh for a given label field using Create, or override the current mesh set in the Mesh input using Replace.

After the mesh creation, the mesh is automatically visualized in the main viewer (Figure 20.4). The generated mesh is automatically set in the Mesh input of the Meshing Workroom. The mesh properties (number of nodes, triangles, tetrahedra) are available from the Project tab in the

Meshing Workroom
Figure 20.3: The Boundary Tab

Figure 20.4: View of the Mesh
Properties area (Figure 20.5) when selecting the green module corresponding to the mesh:

![Figure 20.5: Mesh Properties](image)

The console outputs some statistics about the mesh generation.

### 20.1.2 Inspecting the Generated Mesh

The materials’ visibility of the generated mesh can be turned on and off to inspect the different parts of the grid. The visibility of each individual material can be accessed from the Meshing tab in the materials section (Figures 20.6 and 20.7).

![Figure 20.6: Material Visibility](image)

To inspect interior elements, a clipping plane dedicated to the visualization of tetrahedral meshes is available from the main toolbar. To activate clipping, switch **Clip** button on in the main toolbar. See result on Figure 20.8.

The clipping plane automatically clips any tetrahedron that does not intersect the plane and is on the clipped side. Various options are available to manipulate the clipping planes:

- Select the plane with the left mouse button and move the mouse while keeping the left button pressed. This will translate the plane along its normal.
- Set the plane perpendicular to the main axis (X, Y, Z) by clicking **XY**, **XZ**, or **YZ** in the main toolbar.
- Click **Rotate** in order to show a dedicated manipulator located at the center of the plane (Figure 20.9). Select the manipulator with the left mouse button and rotate by moving the mouse...
while keeping the left mouse button pressed.
• Click **Clipping plane side selector** in main toolbar in order to change clipping side.
• Turn **Interactive Mode** off if the interaction with the clipping plane is slow
  In this case, the clipping is not enabled while you interact with the software, and is only applied when the left mouse button is released.

### 20.1.3 Fast Meshing versus Precise Meshing

By default, the fast meshing mode is activated in the Meshing tab. This mode allows for fast prototyping the meshing of a given label. It is fast, because the meshing is not constrained by any geometry. The resulting mesh is fast to build, but it is missing precision at the boundaries between labels. Select the **Fast Meshing** checkbox to disable the resulting mesh.

When the fast meshing option is not used, the meshing engine is constrained to respective interfaces at boundaries between labels. Those interfaces are defined by surfaces that are generated using the *Generate Surface* module. The module is used with the constrained mode and the *Fit To Edge* option. Unless the label has weights (assigned from the Segmentation Editor or other methods), in which case the module uses the *Existing Weight Smoothing* option.

It is recommended that you input a smoothed label with weights, so there is no or little staircase areas that would need to be topologically preserved by the mesher (those areas will need to be very refined). The label should also be as clean as possible, with all unnecessary small materials areas cleaned out because such areas might create unnecessary over refinement. For example, in the Figure 20.10, the small orange material dot in the middle of the brown material will be preserved so the mesher will over refine around that area:

It is possible to specify a different surface than the one generated internally, using a hidden port.
To unhide it, you can type "\texttt{theMeshingTabController} enableSurfaceSelection 1" in the console. A \textit{Surface Data} port appears in the tab. Set your surface there.

This port allows you to use a custom surface (e.g., smoothed or simplified by the user).

Using its own surface might have several advantages:

- First, if you set a surface to the port, the internal surface generation will not happen so you can generate your surface and then test various settings with fast meshing mode deactivated. Otherwise at each create or replace, the surface will be generated internally.
- Second, if the internal surface is dense, the meshing might take a long time. You can control the size of your surface (through simplification) to speed up the meshing. However, the input surface must respect the following criteria:
  - Watertight surface
  - No autointersection between the different materials (this can be checked with the autointersection test of the surface editor)

\section*{20.1.4 Optimization}

In both modes (fast meshing or not), it is possible to optimize the tetrahedron node locations to reduce the amount of slivers in the mesh. A sliver tetrahedron is formed by placing its four vertices near the equator of its circumsphere (e.g., flat tetrahedron). Slivers may slow down the convergence of numerical simulations. The less sliver the better.

The \textbf{Optimize Mesh} option aims at reducing the amount of sliver by perturbing them through random vertex relocation. The mesh generation may be a bit longer if the option is activated.

More optimization options are available in the \textit{tetra mesh module}.

\section*{20.1.5 Controlling the Refinement of the Mesh}

Many options are available to fine tune the refinement of your mesh.
20.1.6 Slider Quality and Grouping

The Mesh Quality slider provides five quality levels to mesh the input label field, from low to high. Each quality level automatically sets a number of meshing options. You can check the effect of the different quality levels on the meshing engine settings by looking how the values within the Parameters Group are set in the greyed out area (Figure 20.11).

![Figure 20.11: Parameters Group](image)

Changing the quality will affect the constant there. Each quality level sets a factor that is multiplied by the voxel size (for isotropic voxel): the higher the quality, the lower the factor. The average voxel size along X, Y and Z is used for anisotropic voxels. Note that the mesh quality does not ensure that every cell size will have the same dimension, because the highest constraint of the mesher is to preserve the topology of the input label. It will, however, try to fit a given area with the indicated parameters if possible. By default, the quality set by the slider is applied on the default group. The selected group is written in the meshing tab.

New groups may be added to assign various qualities to various materials. A new group is created by clicking Add Group. It is then possible to simply drag and drop any material in the newly created group. When selecting the group or any material in the group, the mesh quality slider is then applied to this specific group. It is possible to create multiple groups with various qualities assigned. When a group is removed, all materials which were present in the group go back to the default one that cannot be removed. See an example in Figure 20.12.

20.1.7 Preserve Thin Structures

The Preserve Thin Structures option makes sure that thin structures are preserved: despite the mesh quality, which is set from the Mesh Quality slider. Practically, this option automatically sets the facet distance (approximation error of boundary and subdivision surfaces) to 0.25x voxel size. This ensures that even the smallest structures are preserved. It will generate fine elements on boundaries, but still will try to respect the cell size internally. In addition, with Fast Meshing mode deactivated, the surface is internally generated with no smoothing to make sure no element is lost by smoothing operations. This mode is only available in non-advanced mode. If you need to get similar results in the advanced mode, you will need to use your own unsmoothed surface (with Fast Meshing mode deactivated)

Figure 20.13 and 20.14 show the difference between using this mode or not using it: Figure 20.13
shows mesh with Preserve Thin Structures option deactivated. A structure (pointed by the left arrow) is lost. Activating the mode will preserve the structures.

### 20.1.8 Boundary Layer

The **Boundary Layer** option is set to have smaller tetrahedra on the boundary of the regions. The parameters are set by groups. The parameter thickness defines the thickness of the layer. Then the cell size defines the maximum size of the cells inside this layer.
20.1.9 Advanced Meshing Mode

By default, advanced parameters are not accessible. They are greyed out, and you can see how they are set when the Mesh Quality slider is changed (see Slider Quality and Grouping for more information).

To be able to customize the mesh quality (i.e., not using the presets of the Mesh Quality slider), enable the advanced mode of the Meshing Workroom:

This will grey out the Mesh Quality slider and enable the advanced parameters (Figure 20.16). The following parameters are available:

- **Facet Size**: This parameter controls the size of surface facets (size of the triangles of surface facet). It provides an upper bound for the radii of a ball circumscribing the surface facet and centered on the surface patch.
- **Facet distance**: This parameter controls the approximation error of boundary and subdivision surfaces. The meshing engine will create small elements close to curved surfaces and large
elements away from the surfaces.

- **Cell size**: This parameter controls the size of tetrahedral mesh. It provides an upper bound on the circumradii of the tetrahedra mesh.

When the advanced mode is turned on, optional scalar field inputs also become available (Figure 20.17).

![Figure 20.16: Mesh Quality Customization](image)

Each individual advanced parameter can be set as a constant value or as a varying scalar field. If set as a scalar field, the advanced parameter constant is not available anymore and is reported as being managed by a varying field (Figure 20.18).

![Figure 20.17: Field Parameters](image)

![Figure 20.18: Field Selected](image)

See the **Meshing WorkroomTutorial** to know how to create a scalar field that can control an advanced parameter. When a scalar field is used, it controls the parameter globally for the whole mesh, and not...
for a given group. You can mix scalar field that control a parameter globally and constant values that control other parameters individually per group.

### 20.1.10 Troubleshooting

With parameters between low and medium, you might get a mesh containing holes, like the following example created by meshing data/tutorials/motor.labels.am in fast meshing mode and medium quality.

![Figure 20.19: Mesh containing Holes](image)

This is because the object is thin and the approximation error tolerated by such parameters does not ensure its full preservation. In this case, you should select the thin structures option or lower the facet-distance setting in advanced mode. Check out the *Thin Structures section* for deeper understanding of this issue.

Sometimes you may get an inhomogeneous quality with some elongated triangles such as the following example created by meshing data/tutorials/motor.labels.am with a low quality, fast-meshing disabled and with thin structures ON:

![Figure 20.20: Inhomogeneous Mesh](image)

This occurs because of a parametrization issue where the facet size parameter set by the user is not
consistent with the facet size imposed by the engine to respect the geometry constraints: In some areas the mesh engine is forced to refine the facet to a smaller size than the specified facet size (typically when needing to respect thin structure). To fix the varying quality, from the project Workroom, display the mesh using a Tetra Grid View module, and measure the size of the facet outside the bad quality area using Measure Tools.

![Figure 20.21: Facet Measure](image)

In the meshing Workroom in advanced mode, set the facet size parameter to the measured parameter (here, 0.005). Mesh again by hitting the create button.

![Figure 20.22: Homogeneous Mesh](image)

### 20.1.11 Assigning Boundary Conditions to the Mesh

Boundaries may be assigned to the generated mesh from the Boundary tab. The Boundary tab allows you to select triangle elements using three methods that can be enabled from the selection mode (Figure 20.23).
Selected triangles will be highlighted in red on top of the mesh in the main viewer (Figure 20.24).

- **Plan**: This mode allows you to select the triangles of a given material which lie close to the bounding box plan. The plan can be selected from the plan combo box. The material is selected from the materials list (Figure 20.25). When the elements are not exactly in the bounding box plan, or follow a curved wall, it is possible to select them using a tolerance through a dedicated slider, that increases the area of selection away from the selected plan.
• **Contact**: The contact mode allows selecting interfaces between two materials. Select the two materials from the materials list (Figure 20.26).

![Contact Mode](image)

**Figure 20.26**: Contact Mode

• **Equation**: The equation mode lets you select any element of a given material based on a given equation (Figure 20.27). The vertex components are accessed through X, Y, and Z variables. A triangle is selected if all three vertex positions match the equation condition. For example, the ”x < 5” will select all triangles in which the X component of all three vertices is less than 5.

![Equation Mode](image)

**Figure 20.27**: Equation Mode

Once a selection is made, the boundary condition is added by selecting an identifier and a name. Once you click **Add**, the corresponding boundary condition is added in the results section (Figure 20.28).

![Results Section](image)

**Figure 20.28**: Results Section
Note that some characters are forbidden in the boundary name. If one of those characters are part of
the name, **Add** will have no effect. Allowed characters include: a-z, A-Z, 0-9, - and _.
Selecting a boundary from the results section will result in the highlighting of the elements in green in
the main viewer (Figure 20.29).

![Figure 20.29: Result Section](image)

Highlight of a boundary condition can be disabled by clicking again on it in result section.

The names that are valid will be available from the Name combo box. It allows you to edit an existing
boundary to add more elements.

### 20.1.12 Exporting the Mesh

When a mesh is generated, it is possible to save it to the target format by clicking **Export** in the general
section of the meshing room.

### 20.1.13 Scripting the Room: TCL Command List

The following TCL commands are available to access the room from the command line or within a
script:

- ”theMeshingTabController” followed by the commands below can be used to script the meshing
  of the label data

  - `setLabelData <labelName>`
    set the label data into the meshing tab
• create
  create the mesh
• update
  replace the current mesh
• setMeshOptimizationEnabled <0|1>
  activate/deactivate optimization
• isMeshOptimizationEnabled
  optimization state
• setAdvancedMode <0|1>
  activate/deactivate advanced mode of the meshing tab
• isAdvancedMode
  advanced mode state
• setMeshQuality <groupId> <0|1|2|3|4>
  set the mesh quality on a given group. Default group ID is -1.
• getMeshQuality <groupId>
  return the mesh quality of the given group ID
• setParameterValue <groupId> <0|1|2|3> <value>
  set the parameter value on a given group. (0 = edge size, 1 facet size, 2 facet distance, 3 cell size)
• getParameterValue <groupId> <0|1|2|3>
  get the parameter value of a given group. (0 = edge size, 1 facet size, 2 facet distance, 3 cell size)
• setParameterField <0|1|2|3> <scalarField>
  set the field for a parameter (0 = edge size, 1 facet size, 2 facet distance, 3 cell size)
• getParameterField <groupId> <0|1|2|3>
  get the name of the field of a parameter (0 = edge size, 1 facet size, 2 facet distance, 3 cell size)
• setSurfaceData <surface data name>
  set the surface to mesh if the fast meshing is not activated
• enableSurfaceSelection <0: disabled | 1: enabled>
  show/hide the port surface.
• setLayerThickness <groupId> <value>
  set the layer thickness value for a given group for the boundary layer
• setLayerCellSize <groupId> <value>
  set the cell size value for the boundary layer for a given group
• `getLayerThickness <groupId>`
  get the value of the boundary layer thickness for a given group

• `getLayerCellSize <groupId>`
  get the cell size of the boundary layer for a given group

• `preserveThinStructure <groupId> <0|1>`
  activate/deactivate the thin structure for a given group

• `setFastMeshingState <0: disabled | 1: enabled>`
  activate/deactivate the fast meshing

• "theBoundaryController" followed by the commands below to set boundary conditions

  • `getAvailableBoundaryIds`
    get the available boundary IDs for the selected software;

  • `getCurrentBoundaryId`
    get the selected boundary ID

  • `getBoundaryMethod`
    get the current boundary method

  • `setBoundaryMethod <0: Plan | 1: Material | 2: Equation>`
    set the boundary method

  • `createBoundaryPlan <bcName> <bcType> <0: XMIN, 1: XMAX, 2: YMIN, 3: YMAX, 4: ZMIN, 5: ZMAX> <materialName> <double:[0-100]>`
    create a boundary condition with plan method. The arguments are: the boundary name, the boundary condition type, the plane of bounding box, the material to apply the boundary condition, and the tolerance.

  • `createBoundaryContact <bcName> <bcType> <materialName> <materialName>`
    create a boundary condition with the material contact method. The arguments are: the boundary name, the boundary type, the first material and the second material

  • `createBoundaryEquation <bcName> <bcType> <materialName> <equation>`
    create a boundary condition with equation method. The arguments are: the boundary name, the boundary type, the material and the equation.

• "theDisplayController" followed by the commands below to configure the display:

  • `setDrawStyle <drawyStyle>`
    draw style selection
• enableClippingPlane <enable>
  activate/deactivate the clipping plane
• setClippingPlaneOrigin <posX> <posY> <posZ>
  set the origin of the plane
• setClippingPlaneNormal <vecX> <vecY> <vecZ>
  set the normal of the plane

• ”theMeshExporter” followed by the commands below to configure the export of the mesh:
  • setMesh <mesh>
    select the mesh
  • setSoftware <software id>
    select export format
  • getMesh
    get the name of the selected mesh
  • getAvailableSoftwares
    get the list of softwares

20.1.14  Progress Bar Indications

The progress bar outputs various messages during the generation of the mesh. Some of those steps may require a long time. You may encounter long delays with the following:

• Initialization triangulation: meshing engine initialization followed by protecting balls settings. This step might take a long time if you have a topologically complex mesh. Complex topology will be preserved by setting a high number of protecting balls.
• Meshing: Actual meshing/refinement.
• Optimization: optimization of the mesh points
• Creating output: converting internal mesh structure to HxTetraGrid

When fast meshing is disabled:

• The first messages come from the internal surface generation based on the Generate Surface module (Smoothing labels, Computing triangulation). If those messages take a long time, the internal surface used for constraining the meshing will be very large. You can alternatively generate your own simplified surface (making sure that it is watertight, and that there is no auto-intersection between the different materials) and pass it on to the meshing room via TCL command ("theMeshingTabController” enableSurfaceSelection 1 or ”theMeshingTabController” setSurfaceData yourSurface).
• Computing: Converting Amira surface to internal structure for meshing
• Generating Meshing Domain: Building constraints based on input surface
20.2 Meshing Workroom Tutorial

The following tutorial, like the Meshing Workroom, it demonstrates, requires an Amira XWind license and is only available on Microsoft Windows.

In this step-by-step tutorial, you will learn how to use Meshing Workroom high-end pre-processing capabilities to create simulation inputs. The Meshing Workroom allows you to compute a tetrahedral mesh, assign boundary conditions to it, and export it to various CFD or FEA solver’s file formats such as Fluent, COMSOL Multiphysics (c), etc. The meshing engine used in the workroom is based on Delaunay refinement (while Amira legacy meshing engine is based on advancing front technique).

The tutorial illustrates this typical workflow with the following sections:

- First mesh generation and inspection
- Global mesh refinement
- Mesh refinement of groups of materials
- Advanced mesh refinement
- Boundary layer refinement
- Optimization of mesh quality
- Color mapping of material properties
- Boundary conditions and export to CFD/FEA solvers

To follow this tutorial, you should be familiar with the basic concepts of Amira such as data import, interaction with the 3D viewer, etc. All these topics are discussed in Amira Getting Started chapter. You should also be familiar with the workflow of generating label images, which are detailed in the Visualizing and Processing 2D and 3D Images chapter, and more specifically:

- Prepare data for segmentation: About Image Filtering
- Segment data: Segmentation of 3D Images
- Edit segmented data: Volume Edit, Segmentation Workroom

All illustrations using the corn kernel dataset are with the kind courtesy of, Pawan S Takhar, University of Illinois at Urbana-Champaign.

Note: In the following tutorial, units are not activated. All parameter sizes (i.e., measurement, cell size, ...) should be given within the current unit if units are activated.

20.2.1 First Mesh Generation and Inspection

In the Project Workroom, click Open Data and choose to load data/tutorials/meshing/KernelCorn.labels.am. Activate the Meshing Workroom by clicking the Meshing tab (Figure 20.30) in the workroom toolbar.

Set Label Data to KernelCorn.labels.am.
Click **CREATE** at the lower left of the Workroom to launch mesh generation with the default parameters.

A first mesh is generated and automatically set in the **Mesh** input field. **Note:** Once you have created a first mesh for a given label field, you can either create a new mesh for this label field by clicking **CREATE**, or replace (overwrite) the current mesh by clicking **REPLACE**. The generated mesh has been automatically displayed in the main viewer.

![Figure 20.30: Meshing Tab](image)

You can go back to the Project Workroom at any time to visualize and customize the display of the mesh. The generated mesh **KernelCorn.labels.tetra** has been created in the **Project View** and is tight to the label input. Use **Tetra Grid View** module to display the mesh. You can also find information about the size of the mesh in terms of nodes, triangles, and tetrahedra in the **Properties Area** of the mesh object.

Go back to the **Meshing Workroom**.

By default the **Fast Meshing** mode is activated in the **Meshing** tab. This mode allows for fast prototyping the meshing of a given label. It is fast, because the meshing is not constrained by geometry. The resulting mesh is fast to build, but is missing precision at boundaries between materials. Uncheck the **Fast Meshing** option and click **CREATE**.

When the **Fast Meshing** option is not used, the meshing engine is constrained to respect interfaces at boundaries between labels. Those interfaces are defined by surfaces that are automatically generated.
using an underlying *Generate Surface* module with the constrained mode and the fit to edge options turned on.

The generated mesh `KernelCorn.labels2.tetra` has been set in the *Mesh* input field (Figure 20.31).

You can compare the two generated meshes by switching from one to the other in the *Mesh* combo list.

![Figure 20.31: Mesh Selection](image)

You will notice how the contours of the second mesh (`KernelCorn.labels2.tetra`) are clearer than the contours of the first one (`KernelCorn.labels.tetra`).

![Figure 20.32: Fast Meshing Option turned On (left) and turned Off (right)](image)

To push further the visual inspection of the mesh, the visibility of its materials can be turned on and off to inspect the different parts, and more specifically, the interior elements of the mesh. The visibility of each individual material can be accessed from the Meshing tab in the *Materials* section.

In the *Materials* section, hide the Germ material by unchecking it (Figure 20.33).

![Figure 20.33: Hide Germ Material](image)

In the viewer, compare the contours of the Germ (Figure 20.34).
20.2.2 Global Mesh Refinement

The Mesh Quality slider provides five quality levels to mesh the input label field from low to high. Each quality level automatically sets a number of meshing options. You can check the effect of the different quality levels on the meshing engine settings by looking how the values are set in the greyed out area below the slider (Figure 20.35).

We will come back to these parameters later in the tutorial. You can also refer to the Meshing Workroom documentation for details about the parameters.

Select KernelCorn.labels.tetra in the Mesh field.
Move the Mesh Quality slider to Low and click REPLACE.
KernelCorn.labels.tetra is replaced with a coarse mesh.
Select KernelCorn.labels2.tetra in the Mesh field.
Move the Mesh Quality slider to High and click REPLACE.
KernelCorn.labels2.tetra is replaced with a refined mesh.
Use the Mesh field for a first comparison of the two generated meshes (Figure 20.36).

To inspect interior elements, a clipping plane dedicated to the visualization of tetrahedral mesh is...
available from the main toolbar. The clipping plane automatically clips any tetrahedron that does not intersect the plane and is on the clipped side. To activate clipping, turn on Clip (Figure 20.37).

Again, use the Mesh field to switch from one mesh to the other and compare the refinement inside the meshes (Figure 20.38).
In Interaction mode (press Esc), pick the plane with the left button of the mouse and move the mouse while keeping the left button pressed. This will translate the plane along its normal. Various options are available to manipulate the clipping planes. See more details manipulating the clipping plane in the Meshing Workroom help section.

20.2.3 Mesh Refinement of Groups of Materials

By default the quality settings are applied to all the materials, which are gathered in the Default group of the Materials section.

New groups can be added to assign different quality settings to the different materials. When selecting a group or any material in a group, the mesh quality settings are then applied to this specific group.

Select KernelCorn.labels2.tetra in the Mesh field and set the Mesh Quality to the Medium value.

Click Add Group.

Drag and drop the SoftEndosperm material in the newly created group (Figure 20.39).

![Figure 20.39: Add a Material to a Group](image)

Set the Mesh Quality to High.

Click Add Group again and drag and drop the Germ material in the newly created group group2.

Remove group2 by hovering the mouse on its line and clicking the garbage icon. You will notice that the material it contained goes back to the default group. Materials, as well as the default group, cannot be removed.

Click REPLACE.

Click YZ button of the clipping plane toolbar and move the camera to get a different view inside the mesh. Notice the different mesh qualities upon the materials used as shown in Figure 20.40.

20.2.4 Advanced Mesh Refinement

Switch to the Advanced mode of the Meshing tab.

Switching to Advanced mode makes advanced parameters available for edition.

The combo boxes in the Scalar Fields section of the Meshing tab are now enabled, as well as the advanced parameters located in the Materials section. The Mesh Quality slider is disabled.

Each of the three following parameters can be set to a constant value or to a varying scalar field:

- The Facet Size parameter controls the size of surface facets (i.e., the size of the triangles of surface facets). It provides an upper boundary for the radii of a ball circumscribing the surface.
facet and centered on the surface patch.

- The *Facet Distance* parameter controls the approximation error of boundary and subdivision surfaces. The meshing engine will create small elements close to curved surfaces and large elements away from the surfaces.
- The *Cell Size* parameter controls the size of mesh tetrahedra. It provides an upper bound on the circumradii of the tetrahedra.

Select the **SoftEndosperm** material or its group.
Change the *Cell Size* to 0.1.
Click **CREATE**. A new mesh KernelCorn.labels3.tetra is generated.
With the *Mesh* list, switch from **KernelCorn.labels2.tetra** to **KernelCorn.labels3.tetra** and observe how the cell size of the SoftEndosperm material has been divided by two (Figure 20.41).

![Figure 20.41: SoftEndosperm (red) with Cell Size 0.2 (left) and 0.1 (right)](image)

Go to the Project Workroom and remove all three tetra meshes attached to the label field. Go back to the *Meshing Workroom*.
Disable the *Advanced* mode. Set the *Mesh quality* of all groups to **High** and click **CREATE**.
Switch back to *Advanced* mode and set the *Facet distance* for the **SoftEndosperm** group to 0.005.
Click **CREATE**.

*Meshing WorkroomTutorial* 809
With the Mesh list, switch from KernelCorn.labels.tetra to KernelCorn.labels2.tetra back and forth and observe how the mesh is more refined where the SoftEndosperm surface is curved (Figure 20.42).

Scalar fields can also be used to customize the refinement of a specific area by controlling the value of an advanced parameter. The scalar field will control the parameter globally (i.e., for the whole mesh) and not for a given group. You can, however, mix scalar field controlling on the whole mesh for a given parameter, and set constant values per group for another parameter. Be aware that the scalar field must have the same dimension as the label field.

Here is an example of how you can create such a scalar field. You can skip this part and retrieve the scalar field in the tutorial folder: data/tutorials/meshing/KernelCornField.am.

Go back to the Project Workroom. Connect a Distance Map module to the label field KernelCorn.labels.am. The Distance Map module assigns to each voxel a value depending on the distance to the nearest object boundary. The boundary voxels of the object are assigned a value of zero and the value increases in the object as the distance increases.

Click Apply.

Attach an Interactive Thresholding module to the Distance Map result. Set the Intensity Range to 1-15. Click Apply. A layer of voxels is isolated on the boundary of the whole label field (i.e., regardless of the materials).

Attach a second Interactive Thresholding module to the Distance Map result. Set the Intensity Range to 15-70. Click Apply. This isolates the rest of the voxels belonging to the label field.

Attach an Arithmetic module to the result of the first Interactive Thresholding module. Connect the Input B of the Arithmetic module to the result of the second Interactive Thresholding module. Select 1 value (scalar) in the Result Channels field. Enter the expression 0.05*(1+A+39*B) in the Expression field. In Result Type, select Input A. Click Apply and see result in Figure 20.43 which uses the temperature.icol colormap.
The resulting scalar field takes value 0.05 outside of the object (0.0 would also be correct), 0.1 in a layer of voxels close to the boundary inside the object, and 2 in the rest of the voxels inside the object. In case of any problems or uncertainties you can find the network generating the scalar field in the tutorial folder: data/tutorials/meshing/CreateKernelCornField hx.
Go back to the Meshing Workroom.
Set the Facet Distance back to 0.01. Set the cell size scalar field to Result in the Scalar Fields section.
Notice that in the Materials section, the cell size port has been greyed out and replaced with Managed by scalar field.
Click REPLACE and see result in Figure 20.44.

You can observe how the mesh is refined in a boundary layer for the whole object regardless of the material.

**20.2.5 Boundary Layer Refinement**
The option allows defining, by group, a boundary layer where the mesh can be refined.
Go back to the Project Workroom and remove all tetra meshes attached to the label field. Go back to the *Meshing Workroom*.

Uncheck **Advanced** to switch back to the non-advanced mode.

Create a mesh with *Mesh Quality* set to *Medium* for all materials.

Visualize the clipped mesh in YZ plan.

Create a group containing only the HardEndosperm material. Set the *Mesh Quality* to *Medium* for this group, disable the *Fast Meshing* in *Global Parameters*, and in the *Boundary layer* field, set the *Layer Thickness* to 0.4 and the *Layer Cell Size* to 0.2.

**Note:** to measure the layer thickness which is suitable for your data, you may go back to the the Project Workroom, attach an orthoslice to your label field and measure a given thickness using a *line measure*.

Press *REPLACE*. *KernelCorn.labels.tetra* is updated.

Set the same boundary layer parameters for all groups of materials.

Press *CREATE*. *KernelCorn.labels2.tetra* is created.

Observe the mesh refinement in the two meshes that have just been generated.

![Figure 20.45: Boundary Layer Refinement for HardEndosperm Material only](image)

![Figure 20.46: Boundary Layer Refinement for all Materials](image)
20.2.6 Optimization of Mesh Quality

You can optimize the tetrahedron nodes location to reduce the amount of slivers in the mesh. A sliver tetrahedron is formed by placing its four vertices near the equator of its circumsphere (e.g., flat tetrahedron). Slivers may slow down the convergence of numerical simulations. This means that the less slivers in a mesh, the better it is.

The optimize mesh option aims at reducing the amount of slivers by perturbing them through random vertex relocation. The mesh generation may be a bit longer if the option is activated. The option is available whether the Fast Meshing option is on or not.

Keep the previous settings and in the Global Parameters Section, select the Optimize Mesh checkbox. Select KernelCorn.labels.tetra in the Mesh field and click REPLACE.

Now, KernelCorn.labels.tetra and KernelCorn.labels2.tetra are the optimized and non-optimized versions of a mesh generated with the same parameters. You can now compare their quality in terms of number of slivers.

1. Go to the the Project Workroom

2. Attach a Tetra Grid View module to each mesh.

3. For both, click Show/Hide then Remove in the Buffer port to select all tetrahedra and then hide them all in the viewer.

4. Select KernelCorn.labels2.tetra (non-optimized mesh) and click the Grid Editor button in the properties area. In the Selector port, Tetra Quality is selected. Click Select. This selects tetrahedra according to the quality measure defined in the next port: \( R < 0.02 \) where \( R \) is the ratio of the radii of the inscribed and circumscribed spheres. \( R \) reaches its optimal (i.e., maximal) value 1/3 for an equilateral tetrahedron. Slivers are detected by a small value of \( R \).

The viewer now displays the slivers in the non-optimized mesh (Figure 20.47). You can also retrieve their number from the Console (click the application’s lower-right corner button).

![Figure 20.47: Slivers for the Non-optimized Mesh](image)
Toggle off the visibility of the *Tetra Grid View* attached to `KernelCorn.labels2.tetra`. Repeat the previous actions on the *Grid Editor* of the optimized mesh `KernelCorn.labels.tetra`. You can see in the viewer that there are less slivers in the optimized mesh. The Console displays the number: you can observe that there are much less selected tetra.

It is possible to further improve the quality of the mesh using the *Grid Editor*. In the Modifier port, select *Repair Bad Tetras*. Click *Modify*. Press *Select* again in the *Selector* port. In the Console, you will notice that the number of slivers has further decreased.

For the purpose of next section, remove both Tetra Grid View modules.

### 20.2.7 Color Mapping of Material Properties

Scalar fields can be color mapped on the mesh to visualize material properties. For example, you will now visualize curvature information.

In the Project Workroom, attach an *Image Curvature* module to the label field. In the *Interpretation* port, select **3D** and click *Apply*.

Attach a *Tetra Grid View* module to `KernelCorn.labels.tetra`. Set the maximal local curvature `KernelCorn.labels.curvature` as color field of the *Tetra Grid View*. Set the *Colormap* to `physics.icol` and the range to `[-0.8, 1]`. Set the *draw style* to outlined.

To discretize a scalar field per cell or per node of a tetrahedral mesh, you can use the *Arithmetic* module connected to both the mesh and the scalar field.

Attach an *Arithmetic* module to the mesh `KernelCorn.labels.tetra`. Connect the *Input B* of the *Arithmetic* module to the curvature field. Set the *Expression* to `B`.

*Result Location* field can be set to on *Nodes* or on *Cell Center*. Try both.

Attach the *Tetra Grid View* color field to the results of the *Arithmetic* module in order to map curvature field to the mesh (Figure 20.48).

![Curvature Field Interpolated on Nodes (left) and on Cells (right)](image)

**Figure 20.48**: Curvature Field Interpolated on Nodes (left) and on Cells (right)
20.2.8 Boundary Conditions and Export to CFD/FEA Solvers

Go back to the *Meshing Workroom*.

The formats supported for export to CFD/FEA solvers are listed at the top of the Workroom in the *Type* list (Figure 20.49).

Select *FLUENT* format.

Open the *BOUNDARY* tab to set boundary conditions.

Three modes are available to set boundary conditions:

- Using plans, for example to define a flow rate input on a whole face of the bounding box of a sample,
- Using the contact surface between two materials,
- Defining a surface by its equation.

Select *Contact* mode.

In the left material list, select HardEndosperm and in the right material list, select Germ (Figure 20.50).

You can visualize the contact surface by toggling off the visibility of the SoftEndosperm and Germ materials (Figure 20.51).

The contact triangles are highlighted in red. You can also visualize it by enabling a clipping plane (Figure 20.52).
Set the Type to Interface and name it HardEndo-Germ-contact.
Click Add.
The contact boundary is added to the results list. The boundary type, as well as the number of triangle elements, is displayed. It is possible to highlight the boundaries from the result list at any time: simply select it from the list. It will be highlighted in green in the viewer. It is also possible to add elements to an existing boundary: select its name from the name combo box and press add, once new elements are selected using one of the three methods above.
Once you have finished defining the boundary conditions you want to assign to the mesh, press the Export button. The Export dialog will pop up. Set the file name and location and press Save.

### 20.3 Amira XWind Extension Measurements

This section will give you an overview of the measurement features provided in the Amira XWind Extension.

- Open aircraft_mach.cas from the tutorials/cfd-fea-advanced folder.
- Load the Pressure scalar field.
- Connect a Boundary View to the model.
- Unselect everything except Wall in the Boundary types port.
- Set the coloring to Data Mapping and use Pressure as the colorfield.
- Select node values in the Value Mapping port.
- Hide the Bounding Box.
20.3.1 3D measurements

You can access measuring tools via the View / Measuring menu or via the measuring tool button (and its pulldown menu - click on the little arrow) at the top of the viewer.

- Select Line in the pulldown menu of the measuring tool button.
- Select Measuring in the View menu.

You now have a Measurement object in the Display folder of the Project View. This module provides access to two-dimensional and three-dimensional measuring tools.

**Line measurement**

We will measure the leading edge of the wing. A line measurement (Line) is already selected.

- In the 3D viewer, click on one end of the leading edge of the wing. Notice that cursor changes to indicate when a valid object can be selected.
- Click on the other end of the wing edge.
- To adjust the position of a measurement line, select it in the Properties area, then click on one of its red handles and drag it to a new location or use the text ports **Point 0** and **Point 1** to change the position.
- Do the same on the side edge of the wing.

*Tip:* You may need to reposition the camera to select measurement points. As usual you can press the [ESC] key to toggle between interactive mode and trackball mode or hold down the [Alt] key to temporarily switch to trackball mode.

You can measure that the wing has a leading edge of approximately 4.44 meters and a side edge of approximately 1.55 meters.

**3D angle measurement**

- In the Properties area of the Measurement module, click on the "eye" icons of the two lines to hide them in the 3D viewer.
- In the Add port, click the Angle button.
- In the 3D viewer, click on the intersection of the attack edge of the wing and the fuselage.
- Click on the other end of the attack edge (intersection with the side edge).
- Click on the other end of the side edge.

You can measure that the angle is approximately 116 degrees.

20.3.2 Histograms

The Histogram module computes the histogram of a scalar field in 3D cells. We will use it on the Pressure scalar field.

- Right-click on the Pressure and select Histogram in the Measure And Analyze menu.
- Click Apply in the Histogram Properties area.
Figure 20.53: Measuring the wing size of the YF-17 aircraft.

Figure 20.54: Angle measurement.
A window pops up, that contains a histogram in logarithmic scaling. The mean value (approx. 1849 Pa) and the standard deviation (approx. 23187 Pa) of the Pressure field are displayed in the Properties area.

- Set the **Range** minimum value to 0.
- Activate the **Threshold** and set it to 100000.
- Activate the **Tindex** and set it to 50.
- Click Apply.

![Histogram of pressure distribution](image)

**Figure 20.55**: Histogram of pressure distribution.

What we can learn is that:

- for all cells where the pressure is in the new range, the mean value is approximately 10647 Pa and the standard deviation is approximately 26442 Pa,
- in this same range, 2.44 percent of the cells have a pressure greater than 100000 Pa,
- in this same range, 50 percent of the cells have a pressure lower than 1784 Pa (and 50 percent greater).

The histogram has been updated.

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fea-advanced/wind_histo.hx.

### 20.3.3 Data probing

The three data probing modules *Point Probe*, *Line Probe*, and *Spline Probe* are used to inspect scalar or vector data fields. The probes are taken at a point (*Point Probe*) or along a line (*Line Probe* and *Spline Probe*) which may be arbitrarily placed.

**Probing along a spline**

We will use the *Spline Probe* to plot the pressure around the wing of the aircraft. First we have to position properly the four control points of the spline.

- Right-click on **Pressure**.
• In the Measure And Analyze menu, select Spline Probe.

To position the control points within the bounding box of the given geometry you can either type in the coordinates in the Points port (see below) or you can move the points dragger interactively with the mouse. (You may have to zoom out to see the points dragger.)

• In the Points port, the coordinates of the first control point are displayed. Change them to 4, 2, 0.
• In the Points port, use the spin box to select the second point and set its coordinates to 0, 2, 0.
• Select the third point and set its coordinates to 0, 2, 0.3.
• Select the fourth point and set its coordinates to 4, 2, 0.3.
• You might want to hide the points and the dragger using the options submenu of the Points port.
• Click the Show button in the Plot port.

![Spline Probe](image)

**Figure 20.56**: Pressure values against the spline probe line length.

A plot window appears where the sampled pressure values are plotted against the length of the probe line. In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fem-advanced/wind_splineprobe.hx.

**Probing along a surface path**

For probing purposes, it is often useful to have tools to define specific lines on a surface. The Surface Path Editor and the Surface Intersector module are designed to this end.

The Surface Path Editor allows creating paths on surfaces. Paths can be useful to cut surfaces, define regions or features of a surface, probe, etc. The editor can be accessed from the Properties area of a Surface Path Set by clicking on the editor button. Two types of editor are then provided:

• the Generic Path Editor allows defining paths arbitrarily across the surface mesh,
• the Vertex Path Editor allows defining paths only along the surface mesh edges.

Note that the Vertex Path Editor can be accessed directly from the Measure And Analyze submenu of a surface (entry named Create Surface Vertex Path).

The Surface Intersector module intersects two surfaces, computes a path along the intersection and
attaches it to each of the surfaces.

- Remove all objects from the Project View (use [Ctrl+N] or right click in the Project View and select *Remove All Objects*).
- Open `fan-0070.cas` from the tutorials/cfd-fea-advanced/fan folder.
- Load the Pressure scalar field.
- Hide the *Bounding Box*.
- Connect a *Boundary View* to the model.
- Unselect everything except `wall-1` in the *Boundaries* port and create the surface from the *Create surface* port.

We will plot the Pressure along a radial line section of the fan surface. We have to create a cylindrical surface first, in order to intersect it with the fan and then get the intersection line.

- Right click on the surface `fan-0070.surf` and create a *Surface Intersector* from the *Compute* submenu.

In the *Surface Intersector* Properties area, the second surface still has to be set. We will use the *Parametric Surface* module to create the intersecting surface we need, available from *Project / Create Object...* (*Surfaces And Grids* submenu).

- Create a *Parametric Surface*. A default plane is created.
- For U, set min to -0.02, step to 0.0005, max to 0.01.
- For V, set min to 1, step to 0.0005, max to 2.
- Set X to u, Y to 0.12*sin(v) and Z to 0.12*cos(v).
- Click on the *more options* button in the *Draw style* port and select *Create surface*. `Parametric-Surface.surf` is added to the Project View.
- Set `Parametric-Surface.surf` as the second surface of the *Surface Intersector* and press *Apply*.

Two paths along the intersection are created, one attached to each of the surfaces.

- Hide the *Parametric Surface* and connect a *Line Set View* display module to `IntersectionPath2`. The path is displayed on the fan surface.
- In the *Measure And Analyze* submenu of *Pressure*, select *Line Set Probe*.
- Attach the *Line Set Probe* to `IntersectionPath2` in the *Line set* port and press the *Show* button.

A window displaying the Pressure along the line probe appears. We will improve the display.

- For X-Axis, choose the z coordinate.
- In the *Edit* menu, select *Edit Objects*.
- In the *axis* section, deselect the *Auto* option that adjusts the range to the X range and set it to [-0.025, 0.04].
• Change the Y label to ”Pressure”.
• In the LineSetProbe_001 section, change the Draw style to Marker.
• Change the markers shape (e.g. to dots) and color.
• Change the label to ”Radial section: 0.12m”.
• Press OK.

Figure 20.57: Pressure values along the radial 0.12m line section of the fan surface.

20.4 Getting Started with reading and visualizing CAE/CFD data

By following this step-by-step tutorial, you will learn the basics of reading and visualizing CAE/CFD data with Amira XWind Extension.

Note: This tutorial shows the results on a voluntary small and lightweight sub-sampled case study. The artifacts may be visible on some rendering methods due to this low-quality model and not due to Amira XWind Extension capabilities.

20.4.1 User interface short overview

Amira user interface is divided into three major regions: The Project View (1) contains folders where data and modules will appear. The Properties area (2) displays interface elements (ports) associated with Amira objects. The 3D viewer window (3) displays visualization results (see Figure 20.59).

Note: If your Project View is displayed as a graph, you can switch to the Project Tree View by clicking on the Project Tree View button. You can easily go back to the Project Graph View whenever you want (see Figure 20.58). These buttons are also available in the Project Menu.
If you click on Help, you can browse the *User’s Guide*. When an object (data, module...) is selected in the *Project Tree View*, information about it is displayed in the *Properties* area. A click on the question tag ’?’ in the upper right side of the area will take you to the contextual help page for the active object. For more information about the user interface and especially the *Viewer* window, please refer to the *Program Description* and to its *Viewer Window* subsection.

**The Project Tree View**

In the following tutorials, we will use the *Project Tree View* to manipulate objects. The results of your CFD/CAE simulations and computations are stored in the *Data* folder. These results are composed of one or more models and data sets (see Figure 20.60).
A model contains:

- the mesh of the domain under study, with 2D or 3D cells depending on the dimension of the model,
- the different regions the domain might be composed of (e.g. the rotor and the stator of a pump),
- the boundaries which are the physical limits of the domain,
- the material the domain is made of.

A data set attached to a model contains one or more scalar, vector or tensor fields defined on the mesh and/or the boundaries of the model. These are the physical quantities that have been computed during the simulation and need to be visualized and analyzed.

Display modules will be listed in the *Display* folder and compute modules in the *Compute* folder. Shortcuts to the input and output data of a module appear below the module, with green and red arrows indicating inputs and outputs respectively.

In the *Colormaps* folder you will find the default colormaps and also any colormaps you have loaded. To get the same project tree view organization than in the tutorial screenshots, go to *Edit / Preferences / Layout* and select *Group by display/compute/data in tree view*. You can alternatively use the Amira version of the *Project Tree View* (without the “Group by display/compute/data in tree view” option) or switch to the *Project Graph View* from the *Project Menu*.

In the remaining of the tutorial, the *Project Tree View* will be named only *Project View* for easing the reading.

### 20.4.2 Reading data

Amira XWind Extension reads a wide range of CFD/CAE formats, including:

- *Abaqus*
- *ANSYS*
- *CGNS*
- *Ensight*
Please refer to the file formats index of the User’s Guide for details.

We will start this tutorial by loading a Fluent data set:

- Click on Open Data in the Project View.
- Open aircraft_mach.cas from the tutorials/cfd-fea-advanced folder (do not select the .dat file, Amira XWind Extension will retrieve the .dat in the folder or will ask you in which folder to find it).

The Datasets selector pops up. Many scalar and vector fields can be attached to a given model and it might be very memory-consuming to load them all. It can also be space-consuming in the project tree view and make it difficult to read. The Datasets selector allows you to load only a part of the solution and, if necessary, to unload some data and load additional data later (see Figure 20.61).

Select Pressure in the data column and click Add→ then OK. The Pressure now appears in the Project View under the model it is attached to and its colormap is displayed.
In the 3D viewer you can see the Bounding Box of the model. This display module is connected by default to the model when you load it.

- Remove the bounding box by right-clicking on the module in the Project View and selecting Bounding Box / Remove Object (or press on [Del]).
We do this because the bounding box encloses the entire data set and we will initially focus on a specific region of the model. Removing (or simply hidding) the bounding box makes it more convenient to "zoom in" on this smaller region.

If you want to load other data from the same model, you can access the Datasets selector at any time by clicking on its button in the Properties area of the model (aircraft_mach.cas).

### 20.4.3 Getting started

We will now make our first visualization.

- In the *Project View*, select the model `data/tutorials/cfd-fea-advanced/aircraft_mach.cas`.
- Right-click on the model and select *Boundary View* in the *Display* submenu.

  *Tip:* You could also have accessed the *Boundary View* module by clicking on its macro button in the upper part of the Project View, after selecting the model. Macro buttons provide easy access to the modules that are most commonly used and/or that have been recently used with the currently selected object.

The *Boundary View* module now appears in the *Display* folder of the Project View and the green arrow shows its input is the aircraft model. Its properties are displayed in the Properties area. You now see the boundaries of the model in the 3D viewer. Remember that boundaries are the limits of the domain under study, here they delimit the air flow. In Amira XWind Extension, boundaries are classified according to their *type*, which is the physical condition imposed on a boundary for the simulation (boundary condition). The types of boundaries are listed in the Properties area of the module in the multi-selection port *Boundary types*.

- In the *Boundary types* port, deselect the items: *Symmetry* and *Pressure Far Field*.

Only the boundaries of type *Wall* remain and they delimit half of a YF-17 Cobra aircraft.

- Click in the 3D viewer window and press the `[SPACE]` key to enlarge the aircraft view (this does a View All operation).
- You can also zoom in and out more accurately by using your mouse wheel, moving your mouse while simultaneously pressing the left and middle buttons, or by clicking the zoom mode button and moving your mouse up and down. If necessary, go back to viewing mode by clicking on the trackball button.
- Rotate the aircraft to see it the right way up.
  - To do this, press the left mouse button in the 3D viewer and move the mouse until you reach the desired orientation.
- Select *Pressure* in the *Colorfield* port of *Boundary View*.
- Select *Data Mapping* in the *Coloring* port.
- Select *node values* in the *Value Mapping* port.
Figure 20.62: Pressure field on the boundaries of a YF-17 Cobra aircraft.

You can make a snapshot by selecting the camera in the toolbar of the 3D viewer. Please refer to Snapshot Dialog description for more details.

If you want to display a compass on your viewer, like in Figure 20.62:

- Go to Amira Preferences (Edit / Preferences...);
- In Layout tab, click on the Compass tab of Viewer gadgets group;
- Check Show the compass and select ”axis.iv”;
- You can choose the position of the compass using Compass position option (Upper right in the figures).

20.4.4 Units and legends

To complete this visualization, we can add a legend that displays the color scale as well as the name and units of the data set displayed.

- Select Pressure in the Project View.
  You can select Pressure where it appears under the model or where it appears under the Boundary View module, whichever is more convenient.
- Notice that when a data set is selected, the Properties area gives you some information about it, for example the units and range.
- You can change or adjust the colormap if needed.
- Click the create legend button in the Options port in the Properties area.
The legend is displayed in the 3D viewer and a Data Legend module is created under the Pressure data in the Project View. Use the Properties area of the module to set the legend properties (position, size...) as desired.

20.4.5 Saving your project

- Select Save Project As... in the File menu.
- Enter the file name getstarted.hx for example.

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fa-advanced/wind_firstvisu.hx.

20.4.6 Tip: Template projects

Template projects can be used to ease repetitive tasks on a set of similar data. A template project is a backup of an original project that can be replicated on another data set of the same type. Please refer to Section ”Template Projects Description” for a complete overview of template projects.

We will save the present project as a template project.

- Select Save Project As Template... in the File menu.
- The input selection dialog appears with a list of data sets that may be used as input to the template (data that will be replaced at run-time). Choose the model and the Pressure as template inputs.
- Change the input labels to modelFluent.cas and scalarfield.
- Click OK.
Choose a name and a destination folder for the template project.

![Input selection dialog box for template projects.](image)

**Figure 20.64**: Input selection dialog box for template projects.

In case of any problems or uncertainties you can find the same template project predefined in your tutorial folder under the file name cfd-fea-advanced/wind_templatenetwork.hxtemplate (load it by selecting *Open Data...* in the Project View).

Now that the template is saved, you can easily make the same kind of visualization on any Fluent model connected to a scalar field.

- Hide the *Boundary View* and *Data Legend* modules.
  
  To do this, uncheck the boxes next to them in the Project View.

- Load `aircraft_mach.cas` from the tutorials/cfd-fea-advanced folder again and add its Pressure data set again.
  
  They appear in the tree view under the names `aircraft_mach2.cas` and `Pressure2`.

  *Tip:* You can quickly reload a recently used file using the Project View’s popup menu. Right-click in the Project View on any line that is empty or contains a folder icon, then select the file from the *Recent Files* submenu.

- Hide the *Bounding Box* connected to the new model by unchecking the box next to the *Bounding Box* module in the *Display* folder in the Project View.

- Go to the *Project > Create Object...* menu and select the previously saved template in the *Templates* category.

The run dialog appears on template execution.

- Select the new model `aircraft_mach2.cas` and the scalar field `Pressure2`.
- Click OK.

The *Boundary View* visualization of the second model has now appeared in the 3D viewer and should be perfectly identical to the previous one (see Figure 20.63, apart from the zooming and rotation).

This project was rather simple and was reloaded on the same model, to keep the example simple, but keep in mind that template projects become very useful and will save you time if you have several modules to connect in the same way to different models and data sets.
20.4.7 Time animation

Time animation is essential for transient data analysis. We will now see how to read and visualize such data.

- Remove all objects from the Project View.
  To do this you can use \[\text{Ctrl}+\text{N}\] to start a new project (you can discard the current project) or you can right click in the Project View window and select Remove All Objects.

We will now load the time dependent data.

- In the File menu, select Open Time Series Data....
- Navigate to the tutorials/cfd-fea-advanced/fan folder.
- Select and open all 11 model files fan-0070.cas through fan-0080.cas (don’t open the .dat files).
- Choose Pressure in the Datasets selector.
- Hide the Bounding Box.

In the Compute directory of the Project View, a time Sequence Controller module has appeared.

- Create a Boundary View module as before (right-click on the model in the Project View).
- In the Boundaries port, click on the Deselect all button and then select only wall-7.
- Set the Colorfield port to Pressure.
- In the Coloring port, choose Data Mapping.
- Select Node values in the Value Mapping port.
- Rotate the display.

In case of any problems or uncertainties you can find the same project predefined in your tutorial fan folder under the file name data/tutorials/cfd-fea-advanced/fan/wind_timeseries.hx.

Use the time sequence controller module to animate the display of pressure over time. Select the controller in the Project View.
• Keep the Time mode port on time step. The physical time stands for the physical time associated with each time step.

• Move the slider in the Time step port rightwards. With the step button next to the time slider you can go through the data step-by-step. By clicking the play button you can run the whole animation. Both buttons are also available for the reverse direction.

• Clicking on the configuration button of the Time step port opens a context menu that allows you to play the animation once, play it over and over (Loop mode), or play it forward and backward alternately (Swing mode).

You might have noticed that the range of the Colormap port of the Pressure data set does not change with each time step. This is because the colormap range is set by default to the global range of the first time step data set. You can change it by setting the minimum and maximum to the values you want and the colormap range will remain set to this range during the animation.

20.5 Amira XWind Extension Models Information and Display

In this section we will learn how to load a model and its associated data, how to retrieve information about the model and how to display it.

• Open aircraft_mach.cas from the tutorials/cfd-fEA-advanced folder.
• Load the Pressure field.
20.5.1 Properties and parameters

Model
The Properties area contains basic information about the selected model or data field.

- Select the model in the Project View. Details about it appear in the Properties area (see Figure 20.67).

![Figure 20.67: Properties area of the model](image)

In the Properties area of the model you can find the grid type (volume or surface), the number of nodes of the mesh, the number of cells and their type.

- Click on the Model Colors Editor button (see Figure 20.68).

A model might be composed of regions and boundaries. Regions are parts of the domain, generally corresponding to a physical property (e.g., the rotating part of a pump is distinguished from the static part) or to the different partial meshes a global mesh is made of. Boundaries are the limits of the domain where boundary conditions are defined. A different color is associated with each region and boundary of the model. These colors are used, for example, by the Grid View, Boundary View and Isosurface display modules. We will talk more about this in a later section. Close this dialog.

- Click on the Data Parameter Editor button.

The Parameter Dialog window pops up (see Figure 20.69). In this window you will find additional information about the model, including the boundary and region names, id numbers and types, physical details about the material(s) under study and solver information about the model. Close this dialog.

Data field

- Now select the Pressure scalar field in the Project View. Details about it appear in the Properties area.

In the Properties area of the scalar field you can find (see Figure 20.70):

- The data type (Type),
- The physical quantity under study and its unit (Content and Unit),
- The global range of the data (including the mesh and the boundaries: Range),
- The range of the data inside the mesh (Dataset range),
20.5.2 Colormaps

In the Properties area of the Pressure field, you can see that a colormap is connected. For convenience a default colormap is defined for each type of data field. The colormap connected to the data field will (initially) be used by all the display modules connected to the field. And therefore modifying the data field colormap affects all the connected display modules. It is also possible to use a different...
We will now see in detail what you can do with the options of the Edit menu of the Colormap port.

- Display the Edit menu of the Colormap port.
  Do this by clicking the Edit button or by right-clicking in the color bar.

You can change the colormap:

- Select one of the default colormaps listed in the menu, or
- Go to Options→Load Colormap... to load a colormap from the directory of your choice or
- Go to Options→Edit Colormap... and use the Colormap Editor to edit your own colormap.

In case the range has been changed and you want to adjust it back to the data field range:

- Select Adjust range to in the Edit menu of the Colormap port and select the data.

Tip: The range of the colormap is set to Local and adjusted to the field global range (except for the time series data, as seen in the Time Animation section of the Getting Started chapter). You can switch between the global and local range modes by selecting and deselecting Options→Local range. In the global range mode, the coordinates used to map data values to colors are taken from the colormap itself. If the same colormap is used by two different fields and if the range is modified, both fields colormap ranges are updated. In contrast, in the local range mode the coordinates are defined by the port itself. Thus, although the same colormap is used by two different fields, the ranges can still be different. As many fields may share the same colormap in the Amira XWind Extension, we advise you to be very careful when using the global range mode.
20.5.3 Viewing the grid

- Hide the Bounding Box.
- Right-click on the model.
- Select Grid View in the main menu or in the Display submenu.
- In the Options port, select cell filtering.

Two new ports appear that allow you to select and deselect regions and/or materials. In the present case there is only one of each so this option is not useful but keep in mind that it exists for more complex geometries (e.g., a pump with a rotor and a stator).

- In the Rendering port, select Solid Outline as draw style.

In this view you can observe the mesh on the boundaries of the model (see Figure 20.72).

![Figure 20.72: Grid view: the mesh on the boundaries of the model.](image)

Model color editor

In the Rendering port, the Coloring option is set to Per Region. This means that each region of the model (here there is only one) is rendered using the color associated with it in the Model Colors Editor. We will now change this color.

- Select the model and open the Model Colors Editor (click on the button).
- Click on the color of the grid.elements part.
- The Color Dialog window pops up. Define a new color and press OK.
- Back in the Model Colors Editor, click Apply. The color is updated in the 3D viewer. Now click Close.
In case there are several regions in the model and you want them all to have the same color, you can choose a uniform coloring.

Select the Grid View module then:

- Select Uniform in the Coloring section of the Rendering port. A Uniform color port appears.
- Click on the color sample. The Color Dialog window pops up.
- Define a new color and click OK. The color is updated.

**Cell information**

- Click in the 3D viewer window (to change focus) and press the [ESC] key to switch the viewer into interaction mode. The cursor should now be an arrow.
  Alternatively, you can click on the arrow button in the 3D viewer menu bar or right-click in the 3D viewer window and unselect Viewing.
- Left click on the mesh in order to select a cell.

Information about the cell will appear in the upper left corner of the 3D viewer and a Spreadsheet in Viewer module appears in the Project View. The behavior is controlled by the On left mouse click port of the Grid View module. This way you can retrieve, for the selected cell:

- the cell topology,
- the physical type of the cell material,
- the coordinates of the picked point,
- the volume of the cell,
- the data value (if the Grid View is attached to a data field instead of a model).

Go back to viewing mode, for example by clicking in the 3D viewer window and pressing the [ESC] key.

### 20.5.4 Viewing the boundaries

- Hide the Grid View and the Spreadsheet in Viewer modules.
- Right-click on the model in the Project View.
- Select Boundary View in the main menu or in the Display submenu.

**Model color editor**

In the Coloring port of the Boundary View, the Per Boundary Type coloring is selected. This means that each boundary of the model is colored with the color associated with its type in the Model Colors Editor. To change these colors, proceed the same way you did to change the region colors. It is also possible to choose a uniform coloring, the same way as previously.

**Data mapping**

If your solution contains data fields stored on the boundaries, you might use data mapping to color them.

- Select Data Mapping in the Coloring port.
• Select Pressure in the Colorfield port.
• Select Node values in the Value Mapping port.

The pressure contour is now displayed on the boundaries of the model. The colormap that is used is the Pressure field’s colormap. If you want to modify the colormap or its range, do that in the data Properties area of the Pressure field.

**Tip1:** If the Boundary View is currently selected, you can quickly select the Pressure field by clicking the right-arrow button in the Colorfield port.

**Tip2:** For convenience you can keep the Pressure field’s Colormap port visible in the Properties area even when the Boundary View (or other display module) is selected. Select the Pressure field, then click on the pin to the left of the Colormap port. Select the Boundary View again. Results are shown in Figure 20.74.

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fa-advanced/wind_boundariesview01.hx.

**Boundaries filtering**

The previous view is not very interesting. We would rather see the pressure on the aircraft boundaries than far from it.

The boundaries of the aircraft are of type Wall. The rest of the boundaries of the model are of type Symmetry or Pressure Far Field. Select the Boundary View.

• In the Boundary types port, deselect Symmetry and Pressure Far Field types.
• Enlarge the view and rotate it in order to get a better image of the aircraft (see Figure 20.75).

You can see that in the Boundaries port, the boundaries that are of type Symmetry and Pressure...
Far Field are now deselected. So you could have achieved the same effect by deselecting non-wall boundaries one by one in this port.

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fia-advanced/wind_boundariesview02.hx.
Extracting surfaces from boundaries
We will now create a surface from the boundaries of the aircraft.

- Click the create button in the Create surface port of the Boundary View.

The surface `aircraft_mach.surf` has been created. This surface can then be used as a seed region for illuminated streamlines distribution (see Chapter 20.7).

20.6 Amira XWind Extension Scalar Fields Display

In this section we will introduce the different features you can use to display scalar fields.

- Open `aircraft_mach.cas` from the tutorials/cfd-fae-advanced folder.
- Load the Pressure field.
- Connect a Boundary View to the model and set the Coloring to Per Boundary Type, then deselect Symmetry and Pressure Far Field in the Boundary types port.
- Hide the Bounding Box.

20.6.1 Scalar field profile on a cross section

- Right-click on the Pressure scalar field in the Project View.
- Select Cross Section in the Display menu.

In the Properties area of the module you can see some ports that we have studied in Chapter 20.5.

- Value mapping port: The node values and cell values options specify if a value of the field under consideration will be affected to each node of the mesh and interpolated along the cells or if a constant value will be associated with each cell. Select node values in the Value Mapping port.
- The cell filtering option allows restricting the Cross Section to selected regions of the model.

- On left mouse click port: Display cell info allows you to left click on cells and get cell information. This option is visible in the Display Option port.
- Draw Style allows you to set different draw styles. Solid Outline and Wireframe display the intersection of the mesh with the section plane. Keep (or come back to) the Solid setting.

Several coloring modes are available in the Rendering port. The default setting is Data Mapping which means the representation of the scalar field using its colormap with local range. You have already seen the Uniform mode and the Per Region mode that colors the parts of the cross section according to the region of the model they belong to.

- Now select the Iso Contouring mode in the Coloring section of the Rendering port.
- The Uniform distribution port has appeared. Set the count value to 30.

This option virtually transforms the colormap into a colormap with 30 steps (the actual attached colormap is not modified).
In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fca-advanced/wind_crosssection01.hx.

- Set the Coloring back to Data Mapping in the Rendering port.
- Click on the xz button in the Orientation port.
- Set the slider in the Translate port to 0.
- Rotate the display and zoom in to get a better view.

Tip: Try using the viewer’s ”Seek” function. Activate Seek mode by pressing the ”S” key or clicking its button in the viewer menu bar. Now click on an interesting part of the model. The viewer automatically moves closer and sets the selected point as the center of rotation (see Figure 20.6.1).

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fca-advanced/wind_crosssection02.hx.

### 20.6.2 Scalar field isolines

We will now add isolines to the previous display.

- Right-click on the Pressure scalar field.
- Select Isocontour Slice in the Display submenu.

Two coupled objects were added to the Project View: a Clipping Plane that defines the plane in which the isolines are plotted, and the Isocontour Slice module itself. We want the Clipping Plane to coincide with our existing Cross Section plane.
In the Clipping Plane module:

- Select $xz$ as Orientation.
- Set the slider in the Translate port to 0.

In the Isocontour Slice module:

- Set $num$, the number of isolines, to 50 in the Values port.
- Improve the quality of the plot by setting the resolution to 512 in the Parameters port.
- Rotate the display in order to match the cross section lighting with a good isolines view (the isolines may be difficult to see from some angles).

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fa-advanced/wind_isolines01.hx.

20.6.3 Legend and captions

Our plot lacks some information about what is displayed.

Legend

- Right-click on the Pressure scalar field.
- Select Data Legend in the Annotate menu.
  (Alternatively, you could click create legend in the Properties area of the scalar field.)

The colormap, the range, the data name and the data unit are now displayed in the 3D viewer. You can set the size, position... of the legend in the Properties area of the module.

Caption
We will now give a title to our display.

- Go to the Project > Create Object... menu in the main menu bar.
- Select Annotations / Caption.
- Change the position of the text: Set the left and the top offset to 10 in the Offsets port.
- Change the text to "Pressure profile in the middle section of a YF-17 aircraft”.

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fea-advanced/wind_isolines02.hx.

### 20.6.4 Isosurfaces of pressure

We will now use isosurfaces to display the Mach cones close to the aircraft.

- Hide the Isocontour Slice and the Cross Section.
  (To hide the Isocontour Slice you must actually hide the Clipping Plane.)
- Right-click on the Pressure scalar field.
- Select Isosurface in the Display menu.
- Set the Isovalue port to 1000.
- Select Data Mapping as coloring mode.
- Choose the Pressure as Colorfield.
- Change the title to "Pressure isosurfaces: \( P = 1000 \text{ Pa} \)" in the Text port of the Caption.

Region of interest (ROI)
We would like to restrict the isosurface to a region close to the aircraft. To this end, we can use a region of interest which is a box that restricts the output of many visualization modules.

- Choose ROI Box in the Display menu of Pressure.
- You can expand the view to see entire the ROI by clicking on the viewer and pressing [SPACE]. The initial ROI is the extent of the entire data set, same as the bounding box.
- Switch to interactive mode (click on the viewer and press [ESC] or click on the arrow).
- In the viewer window, drag the green squares on the ROI and modify the size of the box until it includes only a small region around the aircraft.
- In the ROI port of the Isosurface module, choose ROI Box.

We would like to see the Mach cones from different points of view. In order to see the aircraft too, we will use the opacity factor of the Isosurface.

- Hide the ROI Box.
- Set the Opacity of the Isosurface to 0.15.
- Rotate and zoom in and out to get a different view.
Figure 20.80: Mach cones as isosurfaces of pressure in a region of interest.

Figure 20.81: Mach cones as isosurfaces of pressure for a YF-17 aircraft.

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fea-advanced/wind_isosurfaces.hx.
20.7 Amira XWind Extension Vector Fields Display

In this section we will introduce the different features you can use to display vector fields.

- Open wing.cas from the tutorials/cfd-fea-advanced folder.
- Load the Velocity vector field.
- Connect a Boundary View to the model and unselect everything except Wall in the Boundary Types port.
- Hide the Bounding Box.

You can see a wing in the 3D viewer. We will study the air flow around this wing.

20.7.1 Particles animation

We do not know anything about the flow around this wing. To get a quick overview of the flow and see which regions of the model we should focus on during our study, we will seed particles in the vector field and observe their behavior.

**Region of interest (ROI)**

The domain is very large compared to the wing size. We would like to focus on the flow next to the wing. To this end, we can use a region of interest (ROI) which is a box that restricts the output of many visualization modules. In this case, we will use an ROI to define the starting position of our particles.

- Right-click on the model wing.cas.
- In the Display menu, select ROI Box. A box appears in the 3D viewer, this is the ROI. Initially the ROI is identical to the bounding box of the data set.
- Change the shape of the ROI by dragging the green squares. Change the position of ROI by dragging its faces. Resize and position the ROI close to the leading edge of the wing.

Remember that you must be in interaction mode, indicated by the arrow cursor, to affect the ROI. Switch modes by pressing the [ESC] key or clicking the buttons in the viewer menu bar.

*Tip:* You often need to switch between interaction mode and trackball mode multiple times while performing tasks like resizing and positioning an ROI box. While in interaction mode, you can temporarily switch to trackball mode by holding down the [ALT] key. When the key is released, the viewer returns to interaction mode.

**Animated Particles**

- Right-click on Velocity and select Animated Particles in the Display submenu.
- In the SeedROI port, select the ROI Box ROI.
- Modify the Frequency to every 10 timestep.
- Set the step size to 0.0002 in the Animate port in order to slow down the animation.
- After a few seconds (time for some particles to have lived their life and gone "old"), select Adjust range in the Edit menu of the Colormap in order to adjust the range of the colormap to the range of the particles age.
- Select spheres in the Shape port and set their size to 0.1.
What we can learn by observing the Properties area of the Animated Particles module is that 10 particles are seeded randomly across the ROI every 10 time steps. They are colored by age, which means the longer a particle remains in the model, the more red it becomes.

The behavior of the particles indicates the presence of a region of vorticity close to the wing: indeed you can see some particles swirling and becoming red (that is to say old) close to the upper side of the wing (see Figure 20.84).

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fca-advanced/wind_animatedpart.hx.

Stop the animation:
- In the Animate port, uncheck the animate button.
- Clear all the particles from the 3D viewer using the Clear button in the Particles port.
20.7.2 Illuminated streamlines (ISL)

The ISL technique is used to compute a large number of field lines by integrating the vector field starting from random seed points. We will restrict the region where the points are seeded to the previous ROI.

- Move the ROI closer to the wing. To do so, switch to interaction mode and drag the ROI by clicking on one of the faces of the box and holding while you move the mouse.
- Right-click on Velocity and select Illuminated Streamlines in the Display menu.
- In the Seed ROI port, select the ROI Box ROI.
- Set the number of lines in Num Lines to 400.
- Set the lines Length to 100.
- Set the Step size to 0.001.
- Click Apply.
- Hide the ROI.

Using two viewers

We will use two viewers to see the recirculation of the air in two different ways.

- Click the two viewers side-by-side button in the 3D viewer menu.
- In the Properties area of ROI Box, select/unselect the display on the right viewer by clicking on the right red half of the viewer toggle. This will make the ROI appear/disappear from the
right viewer. You can do the same for the *Bounding Box* if desired.

- Rotate and zoom in and out to get two different views, something like Figure 20.85.

![Figure 20.85: Illuminated Streamlines of the velocity vector field.](image)

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name `data/tutorials/cfd-fca-advanced/wind_displayisl.hx`.

**Tip:** You might want to seed the ISLs from a given boundary (a velocity inlet for example). To do so, first extract the chosen boundary (use the *Create surface* option of the *Boundary View* module as explained at the end of Chapter 20.5). Then connect the created surface to the *Distribution* port of the *Illuminated Streamlines* module. Be aware though that a line will be seeded from each node of the surface mesh and that, therefore, the display might take a while to appear in the viewer.

Two other modules use illuminated streamlines: *Illuminated Streamlines Slice*, visualizes a surface vector field using ISLs, and *Illuminated Streamlines Surface*, intersects an arbitrary 3D vector field and visualizes its directional structure in the cutting plane using ISLs. A demonstration of these modules is given at the end of Chapter 20.9.

### 20.7.3 Line integral convolution (LIC)

This method consists of intersecting the vector field and visualizing its directional structure in the cutting plane.

- Go back to only one viewer (click on the one viewer button in the 3D viewer menu).
- Create a new ROI that contains the wing and a part of the domain behind it.
  
  **Tip:** You already know how to create a new ROI by right-clicking the model and using the *Display* sub-menu. However, this results (as before) in a ROI the same size as the bounding
box, meaning that you have to zoom out to manipulate it down to the desired size. It may be more convenient to duplicate the existing ROI that is already close to the desired size. Right-click on the ROI Box in the Project View and select Object/Duplicate Object in the popup menu.

- Right-click on Velocity and select Stream LIC Slice in the Display menu.
- Select the new ROI ROI Box 2 in the ROI port.
- If necessary, move the plane with the Translate port to position it at about two thirds of the length of the wing.
- Set the resolution, in the Lic port to 700.
- Press the Apply button.
- Hide the ROI.

Tip: You can move the plane using the Translate port in the Properties area or by dragging the plane in the Viewer window (switch to interaction mode if necessary). After moving the plane, press the Apply button in the Properties area to recompute the LIC.

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fia-advanced/wind_planarlic.hx.

20.7.4 Vectors in a plane

- Hide all display modules, except the Boundary View.
- Right-click on Velocity and select Vector Plane in the Display menu.
- Choose ROI Box 2 in the ROI port.
- Set the Scale to 0.01 and the Sampling distance to 0.08.

Figure 20.86: LIC representation of the velocity close to the wing.
• Set the **Translate** in order to see the recirculation correctly.

Now we would like the vectors to be colored in accordance with the vector’s magnitude.

• Right-click on **Velocity** in the Project View and select **Magnitude** from the **Compute** sub-menu. The **Magnitude** module appears in the Project View just under the **Velocity** Data, showing its input (green arrow) is **Velocity** and its output (red arrow) is **Velocity.Magnitude**. The new velocity magnitude data set appears in the Project View underneath the model.

• Display a legend for **Velocity.Magnitude**.

• In **Vector Plane**, set the **Rendering** coloring mode to **Data Mapping** and the **Colorfield** to **Velocity.Magnitude**.

![Velocity vector in a plane cutting the wing.](image)

**Figure 20.87**: Velocity vector in a plane cutting the wing.

Similar to the **Stream LIC Slice** you can move the plane using either the **Translate** port or direct dragging. Unlike **Stream LIC Slice** the vectors are dynamically recomputed as the plane moves. In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fea-advanced/wind_vectorplane.hx.

### 20.7.5 Stream ribbons

• Hide or delete all the display modules, except the **Boundary View**.

• Right-click on **Velocity** and select **Stream Ribbons** in the **Display** menu.

Streamlines seeded from a line appear in the 3D viewer.

• Click **Show** in the **Dragger** port of the **Stream Ribbons**.
A dragger appears for the line from which the streamlines are seeded.

- Click in the Viewer window and switch to interaction mode.
- Move the dragger and use the green spheres to rotate the dragger until the line is parallel to the upper side of the wing.

![Stream ribbons dragger](image)

**Figure 20.88**: Stream ribbons dragger.

- Select *ribbons* in the **Mode** port.
- Set the **Resolution** to 1.
- Set the **Density** to 0.8.
- Set the **Width** to 0.35.
- Set the **Length** to 3.
- Click *Hide* in the **Dragger** port.

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fda-advanced/wind_streamribbons.hx.

### 20.7.6 Find the 3D critical points

3D critical points are points around which different flow patterns can be identified. E.g. the flow behavior around a source is uniformly an inflow, while around a sink it is an outflow. The flow around a saddle point is a mixture of both.

From a mathematical point of view, a first order critical point for a 3D vector field is a point where the velocity is null and the determinant of the velocity Jacobian matrix is not. First order critical points can be classified by an eigenvalue/eigenvector analysis of the Jacobian matrix. The **Critical Points** display..."
module finds and represents critical points by icons of different shapes, depending on the critical point classification. Please refer to the documentation of Critical Points for more details.

- Hide or remove the previous display modules, keep only the Boundary View.
- Right-click on Velocity and select Critical Points in the Display menu.
- Reduce the Icons size to 0.05.
- Click Apply.
- Select the show option to display the illuminated streamlines seeded from the critical points.

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fea-advanced/wind_cp3d.hx.
20.8 Amira XWind Extension Statistical and Arithmetic Computations

- Open `aircraft_mach.cas` from the `tutorials/cfd-fae-advanced` folder.
- Load the Pressure and Density scalar fields and the Velocity vector field.
- Hide the Bounding Box.

20.8.1 Surface and volume integrals

In the Amira XWind Extension, statistical modules allow you to compute statistics on the boundaries and in the volume of an unstructured model. The output of these modules are spreadsheets and these objects are created in the Project View. You can export them as .CSV files and then import them in Microsoft Excel (c) for further work.

We will not illustrate all the possible computations with examples here, but will give short examples of some integral computations. The workflow is basically the same every time, whatever the module and the computation chosen.

The statistic modules that can be connected to a model are listed in the Measure And Analyze right-click submenu. Some of these modules can also be connected to data fields.

**Area computation**

- Right-click on the model.
- In the Measure And Analyze menu, select Surface Integrals.
- Click Apply.
The results of the computation are printed to a spreadsheet that pops up. It contains the total area of all the boundaries of the model under study.

In the **Boundaries filter** port, all the boundaries are selected, which means that the computation is done on all the boundaries. The *globally* option is selected in the **Compute** port, which means that the area that is computed is the sum of the areas of all the boundaries.

- Select *per surface* in the **Compute** port.
- Click Apply.

You can now see that the area of each boundary has been printed to the spreadsheet.

- Select *globally* in the **Compute** port.
- Unselect the boundaries of type *Symmetry* and *Pressure Far Field* in the **Boundary types** port. The only boundaries now selected are the aircraft boundaries.
- Click Apply.

You can see that the area of the half aircraft (composed of boundaries 2, 4, 5, 6, 7, 9, 10 and 11) is equal to approximately 83.61 square meters.

**Volume computation**

- Right-click on the model.
- In the **Measure And Analyze** menu, select **Volume Integrals**.
- Click Apply.

A new spreadsheet pops up and you can see that the volume of the flow domain is equal to approximately 1024215 cubic meters. In case the model is composed of several regions, you can use the **Regions filter** port to restrict your computation to some regions the same way we did for boundaries.

**Pressure force vector computation**

- Right-click on the model.

---

*Figure 20.91: Surface integrals Properties area.*
In the Measure And Analyze menu, select Force.
• Press Apply.

Note that for convenience only boundaries of type Wall are preselected in this module.
The Force module computes the pressure force vector generated on the aircraft surface and the pressure moment about the moment center which is here set to the origin. Notice that the Pressure scalar field was identified and automatically selected in the Pressure port.

Scalar Field mean value computation
Volume and surface integrals can also be computed on data fields.

- Select the *Volume Integrals* module.
- In the Properties area, change the *Data* to *Pressure*.
- Select *mean* in the *Field integral* port. We will compute the mean value of the pressure in the whole volume.
- Click Apply.

As *new if integral type is new* is checked by default in the *Table* port, a new table opens, which title is *mean* in accordance with the field integral type.

Many other types of volumetric and surfacic integrals and statistics can be computed from the *Volume Integrals* and *Surface Integrals* modules. Computations on data fields can always be restricted to regions or boundaries using the appropriate filter.

**Pressure surface integral computation on a sequence of cross sections**

Surface integrals can be computed not only on 3d unstructured grid boundaries, but also on 2d unstructured grids, on 2d unstructured surfaces and on triangulated *Surfaces*. We will study here a convenient way to use the *Surface Integrals* module to compute integrals on several parallel cuts of a 3d model.

- Connect a *Boundary View* to the model.
- Unselect everything except *Wall* in the *Boundary types* port.
- Select *Cross Section* in the *Display* menu of the *Pressure*.
- Set the *Orientation* of the *Cross Section* to $yz$.
• Right-click on the *Cross Section* and select *Animate Ports*.

An *Animate Ports* module is created in the Project View. We will use this module to animate the value of the **Translate** port of the *Cross Section*.

• Select *Translate* in the **Port** port of the *Animate Ports* module.
• Set the **Time** to 0.
• Click on the configuration button of the **Time** port.
• Select *Configure* and set the **Increment** to 10.
• Change the **Translate** equation to $0.4t + 30$.
• Go back to the *Pressure* and connect to it a new *Surface Integrals* module.

Note there is a new port **Surfaces** in the Properties area of the module. This port is displayed because a surface (the *Cross Section*) has been detected in the Project View.

• Select **surface integral** in the **Field integral** port.
• Deselect all boundaries. Only the *Cross Section* is checked.
• Set the computation mode of the module to *auto-refresh*.
• Launch the animation in the *Animate Ports* module by pressing on the play button.

![Figure 20.96: Pressure surface integral on a sequence of plane cuts orthogonal to the aircraft.](image)

The spreadsheet is updated at each step of the animation with the value of the integral computed on each new plane. This highlights the important pressure raise in the environment of the aircraft.
20.8.2 Arithmetic computation

Secondary Variables computation
With Amira XWind Extension, you can also implement your own computations, taking as inputs the variables on the unstructured model. As an example, we will now compute the momentum vector field (product of the density and velocity).

- Load the Velocity data from the Datasets selector by clicking on its button in the Properties area of the model (aircraft_mach.cas).
- Right-click on the Velocity vector field.
- Select Arithmetic in the Compute submenu.
- Select the Density as second input Input B.
- The momentum is a vector so you can keep same as input or select vector in the Output data type port.
- Enter the components of the momentum vector field: B*A_x in Expr X, B*A_y in Expr Y, B*A_z in Expr Z.
- Click Apply.
  A new data module named Result appears under the model.
- Rename this module Momentum.
  To do this, right-click the module, select Object/Rename Object and type a new name in the dialog box. Alternatively, you can select the module, press [F2] and type a new name directly in the Project View.

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fa-advanced/wind_arithmetic.hx.

Regular data field generation
You can also use the arithmetic module to generate a data field on a regular grid and then use some other Amira display modules that take only regular inputs, such as the Volume Rendering module.

- Attach an Arithmetic module to the Pressure data set.
- Choose regular in the Output grid type port.
- Enter the expression A in Expr.
- Change the Resolution to 100 by 50 by 100.
- Click Apply.
- Rename the resulting data set Pressure.Regular.

Pressure.Regular is the pressure field generated on a regular grid of size 100 per 50 per 100.

Volume rendering

- Use a Boundary View on the model to display the aircraft boundaries (display only walls).
- In the Display right-click submenu of Pressure.Regular, select Volume Rendering.
- In the Properties area of the Volume Rendering module, load and select physics_VolRend.am in the Colormap port:
• Click on the **Colormap** port "Edit" button, then "Option / Load colormap..."
• Open `data/colormaps/physics_VolRend.am`

• Set the colormap range to -5000, -1000.
• Open the **Colormap Editor** (through the Window menu or the Standard Toolbar shortcut).
• Click on the edit button for values superior to max range . The **Color Dialog** opens.
• Set alpha (A) to 0.
• Click OK.

You now have a new view of the Mach cone.

![Image of volume rendering of pressure around the YF-17 aircraft](image)

**Figure 20.97**: Volume rendering of pressure around the YF-17 aircraft.
In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-jea-advanced/wind_volrend.hx.

20.9 Amira XWind Extension Vorticity Identification

This section will give you an overall view of the vorticity detection, computation and analysis features provided by the Amira XWind Extension. Although there are a number of studies devoted to vortex identification, there is no agreement on a formal definition. In the absence of a formal characterization of vortical structures, swirling motion around some central region is used as a working definition. Depending on the chosen approach, this leads to features that are either lines (see subsection about vortex core lines), surfaces or volumes (see subsection about vorticity-related variables).

- Open wing.cas from the tutorials/cfd-fea-advanced folder.
- Load the Velocity vector field.
- Connect a Boundary View to the model and keep selected only the walls in Per Boundary Type coloring mode.
- Hide the Bounding Box.

20.9.1 Vorticity-related variables computation

- Right-click on the model.
- Select Secondary Variables in the Compute submenu.

In the Properties area of the compute module you can see the Category port that lists the main categories of the secondary variables Amira can compute.

- Select the vorticity category.

In the Variable port, several vorticity related quantities that can be computed from the velocity vector field are listed. The velocity vector field has been retrieved by Amira and set by default in the Velocity port. The vorticity related variables might be used to find vorticity regions, by plotting cross sections or by delimiting regions with isosurfaces for example.

Some examples of the most common criteria that can be computed and used to identify vortices:

- high vorticity regions,
- high enstrophy regions,
- non-zero helicity regions...
- Now select the turbulence category.

As previously, several turbulence related quantities are listed. They might also be used to find vorcticity regions.

Some examples of the most common criteria that can be computed and used to identify vortices:

- negative lambda2 regions,
• positive Q criterion regions...

**Example 1: vorticity magnitude**

• Select the *vorticity* category.
• Select the *vorticity magnitude* variable.
• Click Apply to compute.

A VorticityMagnitude scalar field is created. Visualize it with a *Cross Section*:

• Select *Cross Section* in the Display right-click submenu of VorticityMagnitude.
• Select *node values* in the Value Mapping port.
• Set the orientation to yz.
• Translate the plane to 52.
• Go back to VorticityMagnitude and set the upper value of the colormap range in its Properties area to 1000 in order to highlight the regions with high vorticity.
• Select *physics.am* colormap. Load it if it doesn’t appear in the list of colormaps (data/colormaps/physics.am).
• Display a legend.

![Figure 20.98: Vorticity magnitude close to the aircraft.](image)

**Example 2: lambda2**

• Hide the *Cross Section*.
• Attach a new *Secondary Variables* to the model.
• Select the *turbulence* category; *lambda 2* is selected by default.
• Click Apply.
• Connect an *Isosurface* to the new *LambdaTwo* object.
• Set the *Isovalue* of the *Isosurface* module to -500.
• Inside *Display Options* port, choose *Data Mapping* in the *Coloring* port.
• Inside *Optional Connections* port, set the *Colorfield* port to *VorticityMagnitude*.
• Select *node values* in the *Value Mapping* port.

![Image](image.png)

**Figure 20.99:** Lambda2 = -500 isosurface colored by vorticity magnitude.

The *Isosurface* of *LambdaTwo* isolates a region with negative lambda2 where there are likely to be vortices. Sub-regions with high vorticity are located close to the wing (see Figure 20.9.1). In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fea-advanced/wind_secondaryvariables.hx.

### 20.9.2 Vortex core lines identification

The *Vortex Corelines* module retrieves the lines around which the flow swirls.

• Hide the *Isosurface*, the *Cross Section* and the *Data Legend*.
• Plot *Illuminated Streamlines* using a *ROI Box* positioned close to the leading edge of the wing as explained in Chapter 20.7.
• Right-click on the *Velocity* vector field.
• Select *Vortex Corelines* in the *Compute* submenu.
• Click Apply.
A Line Set has been created in the Models directory, under the name VortexCorelines. We will now display the result.

- Select the VortexCorelines object and connect a Line Set View in the Display submenu.

You can see that there are some very small lines and some noisy lines. If we want to focus only on the main core line, we should filter those lines. Filtering tools are provided for this purpose in the Vortex Corelines module.

- First we will remove lines that are too small: set the minimum line size to 35.
- Click Apply.

The Line Set View is updated. All lines with less than 35 core points are deleted. There remains three lines among which one is obviously outside of the previously plotted lambda2 isosurface.

- Select the lambda 2 criterion in the Post-filtering port.
- Set the Lambda 2 threshold to -500.
- Click Apply.

Again, the Line Set View is updated. All core points where lambda2 is bigger than -500 are removed, that is to say all points outside of the volume delimited by the Isosurface previously studied. The filtering has been effective and there remain only the core line of the illuminated streamlines swirls. If you select the VortexCorelines line set, you will see in its Properties area that there are actually two lines composed of a total of 115 core points.

- Click several times on the smooth button of the Line Set port if you want the line to appear smoother.
- Select the Line Set View module.
- Choose Circle in the Shape port.
- Set the Scale Factor to 0.02.

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fea-advanced/wind_vcl.hx.

You can complete this visualization with the display of the 3D critical points (see Chapter 20.7). The illuminated streamlines seeded from them (with the show option) swirl around the core line.

20.9.3 Vortical flow visualization

Here are some more visualization modules that can be useful for highlighting some flow behaviors such as the vortical ones under study here.

Surface Illuminated Streamlines
This module sparsely seeds streamlines on a surface in order to display the surface vector field using illuminated streamlines (ISLs). If we want to display the streamlines on the wing, we first need to extract this surface.

- Hide or delete Illuminated Streamlines or Critical Points that might remain in the Project View.
Select the **Boundary View**. Only the wing should be selected in the **Boundaries** port.

Press the *create* button in the **Create surface** port. A `wing.surf` surface is created and added to the Project View.

Right-click on the new surface and select **Illuminated Streamlines Surface** in the **Display** submenu.

Select the **Illuminated Streamlines Surface** module and set the **Vector field** to `Velocity`.

Uncheck the **early termination** option in **Options** port.

Set the **Seed** port to 1.

Press Apply.

Streamlines on the wing are displayed and vortical phenomena appear pretty well. A main swirl corresponds to the starting point of the main core line and smaller swirls correspond to small core lines we noticed in the first core lines display and then filtered.

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name `data/tutorials/cfd-fea-advanced/wind_surfaceISL.hx`.

**Illuminated Streamlines Slices**

This module visualizes the directional structure of a vector field in a cutting plane using illuminated streamlines (ISLs). What would be interesting here is to visualize the ISLs in a plane orthogonal to the core line. To do so, we will use the **Trajectory** module.

- Hide or delete the **Illuminated Streamlines Surface**.
- Create a small ROI Box on the upper side of the wing, around the core line.
- Select **Illuminated Streamlines Slice** in the **Display** submenu of the `Velocity` field.
- Set the ROI Box you just created as ROI in the Clipping Plane Properties area.
- Hide the ROI.
- Right-click on the Clipping Plane and attach a Trajectory module to it.
- Select VortexCorelines as Data in the Properties area of the Trajectory module.

The Clipping Plane is now orthogonal to the core line. If you use the Position slider of the Trajectory module, the plane will slide along the core line, remaining orthogonal. As the core line is actually composed of two lines, you have to use the Line slider to slide the plane along the other part of the core line.

Tip: You could do the same with a Stream LIC Slice module for example. The LIC technique is also a good tool to visualize the swirl of the flow around the core lines.

- Select the Illuminated Streamlines Slice module.
- Uncheck the early termination option in Options port.
- Set the Resolution to 200 and the Separation distance to 15.
- Press Apply.

You can also animate the streamlines to see them swirl around the core line by selecting animate in the View options port.

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fea-advanced/wind_planarISL.hx.
20.10 Amira XWind Extension Measurements

This section will give you an overview of the measurement features provided in the Amira XWind Extension.

- Open `aircraft.mach.cas` from the `tutorials/cfd-fea-advanced` folder.
- Load the Pressure scalar field.
- Connect a Boundary View to the model.
- Unselect everything except Wall in the Boundary types port.
- Set the coloring to Data Mapping and use Pressure as the colorfield.
- Select node values in the Value Mapping port.
- Hide the Bounding Box.

20.10.1 3D measurements

You can access measuring tools via the View / Measuring menu or via the measuring tool button (and its pulldown menu - click on the little arrow) at the top of the viewer.

- Select Line in the pulldown menu of the measuring tool button.
- Select Measuring in the View menu.

You now have a Measurement object in the Display folder of the Project View. This module provides
access to two-dimensional and three-dimensional measuring tools.

**Line measurement**
We will measure the leading edge of the wing. A line measurement (Line) is already selected.

- In the 3D viewer, click on one end of the leading edge of the wing. Notice that cursor changes to indicate when a valid object can be selected.
- Click on the other end of the wing edge.
- To adjust the position of a measurement line, select it in the Properties area, then click on one of its red handles and drag it to a new location or use the text ports **Point 0** and **Point 1** to change the position.
- Do the same on the side edge of the wing.

*Tip:* You may need to reposition the camera to select measurement points. As usual you can press the `[ESC]` key to toggle between interactive mode and trackball mode or hold down the `[Alt]` key to temporarily switch to trackball mode.

You can measure that the wing has a leading edge of approximately 4.44 meters and a side edge of approximately 1.55 meters.

![Figure 20.103: Measuring the wing size of the YF-17 aircraft.](image)

**3D angle measurement**

- In the Properties area of the *Measurement* module, click on the "eye" icons of the two lines to hide them in the 3D viewer.
- In the **Add** port, click the *Angle* button.
In the 3D viewer, click on the intersection of the attack edge of the wing and the fuselage.
Click on the other end of the attack edge (intersection with the side edge).
Click on the other end of the side edge.

You can measure that the angle is approximately 116 degrees.

Figure 20.104: Angle measurement.

20.10.2 Histograms
The Histogram module computes the histogram of a scalar field in 3D cells. We will use it on the Pressure scalar field.

- Right-click on the Pressure and select Histogram in the Measure And Analyze menu.
- Click Apply in the Histogram Properties area.

A window pops up, that contains a histogram in logarithmic scaling. The mean value (approx. 1849 Pa) and the standard deviation (approx. 23187 Pa) of the Pressure field are displayed in the Properties area.

- Set the Range minimum value to 0.
- Activate the Threshold and set it to 100000.
- Activate the Tindex and set it to 50.
- Click Apply.
What we can learn is that:

- for all cells where the pressure is in the new range, the mean value is approximately 10647 Pa and the standard deviation is approximately 26442 Pa,
- in this same range, 2.44 percent of the cells have a pressure greater than 100000 Pa,
- in this same range, 50 percent of the cells have a pressure lower than 1784 Pa (and 50 percent greater).

The histogram has been updated.

In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fea-advanced/wind_histo.hx.

### 20.10.3 Data probing

The three data probing modules *Point Probe*, *Line Probe*, and *Spline Probe* are used to inspect scalar or vector data fields. The probes are taken at a point (*Point Probe*) or along a line (*Line Probe* and *Spline Probe*) which may be arbitrarily placed.

**Probing along a spline**

We will use the *Spline Probe* to plot the pressure around the wing of the aircraft. First we have to position properly the four control points of the spline.

- Right-click on *Pressure*.
- In the *Measure And Analyze* menu, select *Spline Probe*.

To position the control points within the bounding box of the given geometry you can either type in the coordinates in the *Points* port (see below) or you can move the points dragger interactively with the mouse. (You may have to zoom out to see the points dragger.)

- In the *Points* port, the coordinates of the first control point are displayed. Change them to 4, 2, 0.
- In the *Points* port, use the spin box to select the second point and set its coordinates to 0, 2, 0.
- Select the third point and set its coordinates to 0, 2, 0.3.
• Select the fourth point and set its coordinates to 4, 2, 0.3.
• You might want to hide the points and the dragger using the options submenu of the Points port.
• Click the Show button in the Plot port.

![Figure 20.106: Pressure values against the spline probe line length.](image)

A plot window appears where the sampled pressure values are plotted against the length of the probe line. In case of any problems or uncertainties you can find the same project predefined in your tutorial folder under the file name data/tutorials/cfd-fea-advanced/wind_splineprobe.hx.

Probing along a surface path
For probing purposes, it is often useful to have tools to define specific lines on a surface. The Surface Path Editor and the Surface Intersector module are designed to this end. The Surface Path Editor allows creating paths on surfaces. Paths can be useful to cut surfaces, define regions or features of a surface, probe, etc. The editor can be accessed from the Properties area of a Surface Path Set by clicking on the editor button. Two types of editor are then provided:

- the Generic Path Editor allows defining paths arbitrarily across the surface mesh,
- the Vertex Path Editor allows defining paths only along the surface mesh edges.

Note that the Vertex Path Editor can be accessed directly from the Measure And Analyze submenu of a surface (entry named Create Surface Vertex Path).

The Surface Intersector module intersects two surfaces, computes a path along the intersection and attaches it to each of the surfaces.

• Remove all objects from the Project View (use [Ctrl+N] or right click in the Project View and select Remove All Objects).
• Open fan-0070.cas from the tutorials/cfd-fea-advanced/fan folder.
• Load the Pressure scalar field.
• Hide the Bounding Box.
• Connect a Boundary View to the model.
• Unselect everything except wall-1 in the Boundaries port and create the surface from the Amira XWind Extension Measurements
Create surface port.

We will plot the Pressure along a radial line section of the fan surface. We have to create a cylindrical surface first, in order to intersect it with the fan and then get the intersection line.

- Right click on the surface fan-0070.surf and create a Surface Intersector from the Compute submenu.

In the Surface Intersector Properties area, the second surface still has to be set. We will use the Parametric Surface module to create the intersecting surface we need, available from Project / Create Object... (Surfaces And Grids submenu).

- Create a Parametric Surface. A default plane is created.
- For U, set min to -0.02, step to 0.0005, max to 0.01.
- For V, set min to 1, step to 0.0005, max to 2.
- Set X to $u$, Y to $0.12 \times \sin(v)$ and Z to $0.12 \times \cos(v)$.
- Click on the more options button in the Draw style port and select Create surface. Parametric-Surface.surf is added to the Project View.
- Set Parametric-Surface.surf as the second surface of the Surface Intersector and press Apply.

Two paths along the intersection are created, one attached to each of the surfaces.

- Hide the Parametric Surface and connect a Line Set View display module to IntersectionPath2. The path is displayed on the fan surface.
- In the Measure And Analyze submenu of Pressure, select Line Set Probe.
- Attach the Line Set Probe to IntersectionPath2 in the Line set port and press the Show button.

A window displaying the Pressure along the line probe appears. We will improve the display.

- For X-Axis, choose the z coordinate.
- In the Edit menu, select Edit Objects.
- In the axis section, deselect the Auto option that adjusts the range to the X range and set it to $[-0.025, 0.04]$.
- Change the Y label to ”Pressure”.
- In the LineSetProbe_001 section, change the Draw style to Marker.
- Change the markers shape (e.g. to dots) and color.
- Change the label to ”Radial section: 0.12m”.
- Press OK.
Figure 20.107: Pressure values along the radial 0.12m line section of the fan surface.
Part VII

Amira XDigitalVolumeCorrelation Extension User’s Guide
Chapter 21

Amira XDigitalVolumeCorrelation Extension

The Amira XDigitalVolumeCorrelation Extension is required to unlock the tutorials and features described in this chapter.

The Amira XDigitalVolumeCorrelation Extension provides Digital Volume Correlation (DVC) techniques to compute 3D full-field continuous displacement and strain maps from volume images acquired during a deformation process of an object. You will input two images and a mesh that will be used to measure the displacement and strain maps.

The extension can for instance be used to visualize and quantify deformation-induced microstructural changes during dynamic processes, such as localization phenomena induced by heterogeneities or thermal expansion mismatch between materials. Furthermore, the output displacement field can be used to enrich a numerical simulation by using measured boundary conditions, or to optimize this simulation by comparing numerical and measured data.

To learn more about the tools available in the extension, please refer to the following links:

- Digital Volume Correlation Module
- Digital Volume Correlation Analysis

Note: see section 1.4 System Requirements about system requirements and hardware platform availability.

Acknowledgements
Amira XDigitalVolumeCorrelation Extension has been developed in cooperation with the companies 3Dmagination (Didcot, UK) and Eikosim (Paris, France).
21.1 Digital Volume Correlation Analysis

This tutorial describes how to perform a DVC (Digital Volume Correlation) analysis and visualize the corresponding displacement and strain fields. A subset-based (local) approach is used to capture the large displacements on a coarse regular grid and the resulting data are used to initialize a most robust Finite-Element-based (global) DVC technique on a finer mesh. The bone-cement data used in this tutorial is a courtesy of Dr Gianluca Tozzi at University of Portsmouth and represents one of the possible configurations of interdigitated bone structures in joint fixation [1].

To follow this tutorial, you should be familiar with the basic concepts of Amira such as interaction with the 3D viewer, segmentation editor, etc. All these topics are discussed in Amira Getting Started chapter.

Note: see section 1.4 System Requirements about system requirements and hardware platform availability.

21.1.1 Preparing the Subset-Based Approach

In this section, you will compute the characteristic length scale of the microstructure to tune the subset size of the Digital Volume Correlation module with a sensible value.

- Load the file data/tutorials/xvolumecorrelation/BCI_reference.am
- Display it using an Ortho Slice module and set the Orientation port to xz.
  The microstructure consists of pure trabecular bone (white) interdigitated with cement (grey).

![Figure 21.1: Dataset Description](image)

Digital Volume Correlation Analysis
• Extract a region of interest in the bone-cement using an *Extract Subvolume* as shown in Figure 21.2

![Extract Subvolume Module Properties](image)

**Figure 21.2: Extract Subvolume Module Properties**

• Compute the length scale of the microstructure using the *Radial Autocorrelation* module. This module calculates the two-point correlation function of the tomographic image.

• Attach a *Plot Spreadsheet* module as shown in Figure 21.3

![Plot Spreadsheet Module Properties](image)

**Figure 21.3: Plot Spreadsheet Module Properties**

• Plot the autocorrelation versus distance. The autocorrelation decreases progressively until an asymptote is reached. The distance from which this asymptote reaches about 30 voxels is the range of the microstructure. A rule of thumb for an optimal subset size is to take about 3-4 times this value. We will use 110 voxels in this study (see Figure 21.4).
21.1.2 Compute a Good Initial Guess using the Subset-Based Approach

In this section, you will capture the large displacements using the subset-based (local) approach from the Digital Volume Correlation module and use these results to initialize the most robust Finite-Element-based (global) approach.

- Load the file data/tutorials/xvolumecorrelation/BCI_peak_force.am corresponding to the previous data after compression resulting in internal displacement.
- Display it using an Ortho Slice module and set the Orientation port to xz.
- Link the Ortho Slices attached to BCI_reference and BCI_peak_force using the Connection Editor (drag the Slice number port and the Orientation port of one Ortho Slice to the other on the Project View) (see Figure 21.5).
• Turn the viewer toggle of the Ortho Slice 2 ON/OFF to visualize the regions that are highly deformed. You should observe that most of the deformation is localized in the trabecular bone region (top).

• Estimate the maximum displacement in this region. To do so, ensure that the Quick Probe from the Viewer Toolbar is set to Continuous Update (Figure 21.6) then place the mouse on the 3D viewer and read the coordinates displayed in the progress bar. Be sure to be on Interact mode (if not, press ESC).

• Alternatively, you can use the Measure tool from the Viewer Toolbar. Maximum displacement occurs for the latter slices (around slice 230, xz orientation). Choose a slice, then by switching between the two ortho slices, place the measurement tool and try to measure approximately the maximum displacement.

![Figure 21.6: Quick Probe or Measure tool can be used to Estimate the Maximum Displacement](image)

• The maximum displacement should be around 10 (see Figure 21.7).

![Figure 21.7: Displacement Measurement between the two ortho slices](image)

• Attach a Digital Volume Correlation module to the data BCI.reference. Set the Deformed volume port to BCI_peak_force.am and DVC approach port to Subset-based (local). Activate the Advanced toggle switch. Set the Sub-volume size port to 110, Max displacement to 10, and Correlation Threshold to 0.7. Turn Enable Display port to ON to visualize the sub-volumes. Set the Metric port to Correlation and Transform port to Translation + Rotation. For each sub-volume, the algorithm finds iteratively the six parameters (three translations, three rotations) of a rigid transformation matrix that satisfy the best match between the grey level intensity of the
reference and deformed image (Metric = 0: no match; Metric = 1: perfect match) (see Figure 21.8). Click Apply.

![Digital Volume Correlation module with Subset-based (local) approach.](image)

**Figure 21.8**: Digital Volume Correlation module with Subset-based (local) approach.

This action creates four outputs:

1. $dvc_{\text{mesh}}_{\text{cellSize}}_{110x110x110}$: grid representing the subsets
2. $BCI_{\text{reference}}_{\text{disp}}$: displacement field
3. $BCI_{\text{reference}}_{\text{strain}}$: strain tensor
4. $BCI_{\text{reference}}_{\text{metric}}$: metric map.

- Plot the statistics of the metric map by attaching a Histogram module to $BCI_{\text{reference}}_{\text{metric}}$. On average, the metric is about 0.98 indicative of a good correlation.
- Visualize the metric map by attaching a Grid View module to $BCI_{\text{reference}}_{\text{metric}}$. In Grid View, set Colouring port to Data Mapping, Opacity port to 0.4 and Value Mapping to Cell Values. In $BCI_{\text{reference}}_{\text{metric}}$ set the Colormap port to physics and adjust the range by clicking on Adjust the range to and select $BCI_{\text{reference}}_{\text{metric}}$. Press create legend in the Options port to visualize the legend. The metric is the lowest (0.96) in the region where the displacement is high (trabecular bone region at the top).
- Visualize the displacement vectors by attaching a Vector Field module to $BCI_{\text{reference}}_{\text{disp}}$. Set the Scale port to 25 (open more options on Scale port line, and change Max value setting to 25) , Coloring port to Uniform and select the white color from the port Uniform color (see Figure 21.9).
- Attach a Magnitude module to $BCI_{\text{reference}}_{\text{disp}}$ if you want to visualize the displacement magnitude.
21.1.3 Run a Robust FE-Based DVC Technique

In this section, the displacement field obtained using the subset-based (local) approach is used to initialize a Finite-Element-based (global) DVC algorithm using a finer mesh.

- Hide all previous visualization modules except the ortho slices.
- Select again the Digital Volume Correlation module.
- Turn off the Enable Display port of the subset-based (local) approach.
- Generate a tetrahedral grid using the Mesh Generation section. Set the Cell size to 48 and turn on the Enable Display port to see the nodes of the mesh (see Figure 21.10). Click Generate Mesh to create the mesh.
• Visualize the mesh by attaching a Grid View module to the created mesh dvc_mesh_cellSize_48x48x48_. Set the Draw Style port to Solid Outline to visualize the elements (see Figure 21.11).

• Change the port DVC Approach to Finite-Element-based (global). Set the Max Iterations port to 30 and Convergence criterion to 0.001. Attach the mesh dvc_mesh_cellSize_48x48x48_ to the port Reference mesh. In the Optional Connections section, set the Initial displacement to BCI_reference.disp (displacements computed using the local approach with a sub-volume size of 110 voxels) (see Figure 21.12). Click Apply.
This action creates three outputs:

1. BCI_reference2.disp: displacement field
2. BCI_reference2.strain: strain tensor

In the global approach, the displacement field (also known as optical flow) is obtained by minimizing the correlation residuals, therefore it is recommended that you first check the correlation residuals.

- Attach an **Histogram** module to the residuals image BCI_reference.res and another to BCI_reference.am.
- Click **Apply** for both (see result on Figure 21.13).

As shown in the **In Range** port of the **Histogram** module for the residuals image, mean is about 0.74 and standard deviation is 3.81, indicative of a good correlation.

- Attach an **Ortho Slice** module to the residuals image BCI_reference.res and change the Colormap by clicking on **Edit, Adjust Range To** then **Data Histogram**.

Weak correlation zones correspond to voxels with the lowest and highest intensities and are found at the top in the bone region interface where the trabecular-like morphology is more complex and the deformation is high (see Figure 21.14).
High intensity voxels are best highlighted while showing positive values.
21.1.4 Visualize and Animate the Results of the Global Approach

In this section, we will visualize the displacement and strain fields using different methods.

21.1.4.1 Visualize the Vertical Displacement and Axial Strain over the DVC Mesh

- Attach an Arithmetic module to BCI_reference2.disp. Set Output Data Type port to scalar and Expression port to Az. Rename the output Result dataset to Uz (select Result and press F2).
- Attach an Arithmetic module to BCI_reference2.strain. Set Output Data Type port to scalar and Expression port to Akk. Rename the output Result dataset to e33 (select Result and press F2).
- Connect a Grid View module to Uz and e33 and visualize the vertical displacement and axial strain.
To visualize the displacement vectors, connect a Vector Field module to BCI_reference2.disp. Set the Scale port to 25 (open more options on Scale port line and change Max value setting to 25), Coloring port to Uniform and select the yellow color from the port Uniform color. (see Figure 21.16).

Figure 21.16: 3D visualization of the vertical displacement (left) and axial strain (right)

21.1.4.2 Visualize the Axial Strain using a Surface Mesh

The first method is to remap the displacements and strains into a regular grid (image) and visualize the axial strain over the surfaces of phases.

- Load segmented data data/tutorials/xvolumeecorrelation/BCI_reference3.labels.am
- Attach an Arithmetic module to BCI_reference2.disp with the following parameters:
  - Set Output Data Type to same as input.
  - Set Expression X port to Ax.
  - Set Expression Y port to Ay.
  - Set Expression Z port to Az.
  - Set Output grid Type to regular.
  - Set Resolution port to the reference volume dimensions (241, 241, 337).
- Press Apply and rename the output to DispVectors.RegularGrid.
- Attach an Arithmetic module to e33 dataset computed previously with the following parameters:
  - Set Output Data Type to scalar.
  - Set Expression port to A.
  - Set Output grid Type port to regular.
  - Set Resolution port to the reference volume dimensions (241, 241, 337).
• Press Apply and rename the output e33.RegularGrid.
• Attach a Generate Surface module to BCI_reference3.labels, keep all parameters and press Apply. With this action a surface model of the bone-cement phases has been generated.
• Attach a Surface View module to BCI_reference3.labels.surf with the following parameters:
  • Set Color Field port to e33.RegularGrid
  • Adjust the Colormap port to physics.
  • Using the Buffer port, click on Clear action button then select a Material of interest (bone or cement) and click on Add action button to display it. (see Figure 21.17).

![Figure 21.17: 3D Visualization of the Axial Strain in the Bone-Cement (left) and Bone phase (right)](image)

• To better reveal the internal strains, connect a Volume Edit module to BCI_reference3.labels with following parameters:
  • Set Tool port to TabBox
  • Select a quarter of the volume.
  • Click on the button Inside from the Cut port. This action will remove the quarter of volume selected.
• Repeat the previous steps on the new volume BCI_reference3.labels.modif (generate a surface by connecting a Generate Surface module and visualize it with a Surface View module).
• Connect a Vectors Slice module to DispVectors.RegularGrid with following parameters:
  • Set the Resolution to 20 (x and y).
  • Set the Colormap to Constant Color then select white.
• Set Orientation port to $yz$ on the Clipping Plane.

• See result on Figure 21.18.

![Figure 21.18](image)

**Figure 21.18**: Displacement Vectors Superimposed on the 3D Axial Strain in the Trabecular Bone (left) and Cement Phase (right)

It is observed that most of the deformation is taken by the trabecular bone with a poor strain transfer in the cement region. Other bone-cement composite formulations containing more cortical bone have been tested and proved to be more efficient in diffusing the strains in the cement [1].

To see the implant deformation:

• Attach an Apply Deformation module to the surface created with following parameters:
  
  • Set Vector Field port to DispVectors.RegularGrid.

  • Press Apply.

  • Attach a Surface View module.

  • Switch between the view modules for the reference and the deformed surfaces to see the deformation.

### 21.1.4.3 Visualize the Axial Strain using a Tetrahedral Mesh

The second method is to visualize the displacements and strains in a tetrahedral grid.

• Load tetrahedral grid data data/tutorials/xvolumecorrelation/BCI_reference3.labels.tetra.am (Figure 21.19).
• Attach an Apply Deformation module to the tetrahedral grid with following parameters:
  • Set Vector Field port to DispVectors.RegularGrid.
• Press Apply.
• Attach a Tetra Grid View module to reference tetra grid data. Set:
  • Set Color Field port to e33.RegularGrid.
  • Set Colormap to physics and adjust range to e33.RegularGrid then Data Histogram.
• Switch Data port between reference and deformed data to see the deformation.

21.1.5 Dialog between experience and simulation
The output displacement field can be used to enrich a numerical simulation by using measured boundary conditions, or to optimize this simulation by comparing numerical and measured data. The generated mesh can be exported in FE software packages (Abaqus, Ansys, etc.) to perform finite element computations at different scales: (i) continuum scale (DVC module grid output), (ii) scale of the constituents (tetrahedral grid surface). Realistic boundary conditions can be prescribed by applying the DVC displacements at the boundaries of the mesh.

21.1.6 Additionnal post processing
Additionnal variables might be computed out of the digital volume correlation strain output by using the tensor extract module: principal strains, invariants, eigenvectors, equivalent Von Mises and Tresca strains can be extracted to identify e.g. maximum shear zone or regions of high strains.
21.1.7 References

Part VIII

Amira XPoreNetworkModeling Extension User’s Guide
Chapter 22

Amira XPoreNetworkModeling Extension

Amira XImagePAQ Extension and Amira XPoreNetworkModeling Extension are required to play the tutorial and unlock the features described in this chapter.

It allows for access to different statistics from a labeled and separated pore space. The statistics include distribution of the following parameters:

- Pore volume
- Pore area
- Pore equivalent radius
- Pore center of gravity
- Pore coordination number (i.e., number of connected neighbors)
- Intersection percentage between pore network model and original pore space
- Throat area
- Throat equivalent radius
- Throat channel length
- Throat connection (i.e., Id of pore 1, Id of pore 2)

The extension also allows for pore network code reading from the *Pore Network Node-Link DATA FORMAT*.

The general workflow for accessing statistics includes the following:

- Create a binary pore space from the grayscale data (see *Segmentation Workroom*)
- If connected porosity needs to be analyzed, unconnected pores can be removed with the *Axis Connectivity* module
- Separate the pore space into a set of connected and labeled pores using the *Separate Objects* module. The extension provides a mode optimized for arbitrary pore shapes (i.e., Skeleton
- Aggressive). Spherical pores can be well separated with the default mode (i.e., Chamfer - conservative).

- Generate a pore network model via the Generate Pore Network Model to extract network code. The generated pore network model (PNM) contains the network code and can be used with the Histogram to plot the distribution of the different parameters. To learn more about the tools available in the extension, refer to the following links:

  - Pore Space Analysis Tutorial
  - Generate Pore Network Model
  - Pore Intersection
  - Pore Network Model Filter
  - Pore Network Model View
  - Separate Objects
  - Pore Network Node-Link

**Note**: It is also possible to visualize the model on top of the original data. Figure 22.1 is a setup showing the labeled and separated pore space overlaid on top of the model and the model within the grayscale data.

![Figure 22.1: PNM Displayed within Pore Space](image)

The properties of a PNM generated with the Generate Pore Network Model can optionally be provided by the same module. The Generate Pore Network Model module will then also outputs:

- The absolute permeability of the material
22.1 Pore Space Analysis

The following tutorial requires an Amira XImagePAQ Extension license and an Amira XPoreNetwork-Modeling Extension license. This tutorial describes how to analyze and characterize a pore space. The ceramic data used for this tutorial is a courtesy of Zellwerk GmbH.

22.1.1 Preparing the Data

In this section, we will prepare the data to separate the void and the solid phase of the ceramic.

1. Load the file data/tutorials/PMN/Sponceram.am and display it using the Volume Rendering module. Set the Colormap port max to 4590 to have a better rendering (see Figures 22.3 and 22.4 with colormap configured to hide the void phase).

2. Separate the void of the material using an Auto Thresholding module. Set the Type port to Auto Threshold Low. It will create two outputs Sponceram.info and Sponceram.labels (see Figure 22.5).
3. Apply an Axis Connectivity module on the Sponceram.labels. Select a Neighborhood of 26 voxels in the neighborhood port. This allows keeping only the connected porosity of the sample (see Figure 22.6).
4. Compute the connected porosity vs. total porosity using a Volume Fraction module connected to the output of the axis connectivity module (for amount of connected porosity), or connected to the output of the Auto Thresholding module (i.e., for amount of total porosity), respectively. This example reports 51% of connected porosity for a total porosity of 54%.

5. To visualize the connected porosity vs. unconnected porosity: attach a Subtract Image module to the output of the Auto Thresholding module and to the output of the Axis Connectivity module. This will create a label representing the unconnected porosity (floating void). Attach a Volume Rendering to this data, and use the seismic colormap. This colormap will colorize in blue the data at 0 (connected porosity) and in red the data at 1 (unconnected porosity) Set the opacity to 0.2: it allows better visualization of the solid phase. (see Figure 22.7).

6. Apply a Separate Objects module on the output of the Axis Connectivity module. Set the Marker Extent port value to 2 and the Output Type port to connected object. In this example, we keep the default method (Chamfer - Conservative) since the pores are mostly spherical (see Figure
Figure 22.8: Separate Objects Module Configuration

7. Display the result by creating another Volume Rendering module on the previous output (see Figures 22.9 and 22.10).

![Figure 22.9: Void Data Mixed with Original Data](image)

The project data/tutorials/PNM/1-PrepareData.hx allows jumping directly to this step.

### 22.1.2 Generating and Analyzing the Network

1. Generate a PNM using the Generate Pore Network Model module. Set the input to the separated and labeled pore space.

You can also turn on the Generate Properties switch to generate the absolute permeability, tortuosity, total flow rate per second (used to compute the absolute permeability) and flow rate...
Figure 22.10: Volume Rendering Module Configuration for Void

per second for each throat. This last one will be added in the PNM generated by the module, whereas the others will be available in a dedicated spreadsheet.

2. Create a Pore Network Model View on the new network and hide the Volume Rendering module linked to the separated data. You can now visualize the network in the original data (see Figures 22.11, 22.12, and 22.13).

Figure 22.11: Pore Network Model View

If you have experience generating the properties of the PNM as well, you can then visualize the network with Throat Scale based on the FlowRatePerSec value for instance. The purpose is to provide a view that highlights the “main roads” of the fluid passing through the material (see Figure 22.14).

3. The network code can be displayed as a spreadsheet in the table panel by clicking Show of any PNM. The PNM spreadsheet has two tabs, one for pores and one for throats (see Figure 22.15).

4. When displaying the PNM with a Pore Network Model View and displaying the spreadsheet at the same time in the table view, it is possible to highlight the pores or the throats that are selected in the table from the Pores table or the Throats table. Select pores in the table by left-clicking
on one or several lines (i.e., left click + hold on a line and move up or down the table without releasing). The corresponding pores will be highlighted in red in the 3D view (see Figure 22.16).

5. The generated PNM can be used to plot the statistics of the pore space (see Figures 22.17 and 22.18).

6. It is possible to plot the pore size distribution of the sample, using the Distribution Analysis module (i.e., equivalent radius vs. cumulated pore volume within a bin).
   - Attach a Distribution Analysis module to the generated PNM.
   - Set the parameters as shown in Figure 22.19 and click Apply.
   - The distribution curve as shown in Figure 22.20 is displayed using a Plot Spreadsheet.
module (see Figure 22.21). The plot shows that the majority of the pore space is filled by big pores, but the predominant small pores have a radius around 0.15.

7. Filter the data to keep only pores with volume greater than 0.02. Create a Pore Network Model Filter module on the generated PNM and then add Volume > 0.02 in the Filter port. You can visualize the filtered network by changing the Data port of the Pore Network Model View and setting it to the new network (see Figures 22.22 and 22.23).

8. Compute the intersection percentage of the pores for the filtered network. Create a Pore Intersection module on the last result and connect the result of the Separate Objects module to the Binary Image port. The module will output a new pore network code, including an intersection
The project data/tutorials/PNM/2-GeneratePNM.hx allows reproducing all the steps of the tutorial. Note: Further pore space analysis can be done with the Sieve Analysis module (which allows for the classification of pores based on statistics).
Figure 22.19: Distribution Analysis

Figure 22.20: Pore Size Distribution

Figure 22.21: Plot SpreadSheet
Figure 22.22: Parameters of the Pore Network Model Filter Module

Figure 22.23: Comparison before Filtering, and after Filtering

Figure 22.24: Parameters of the Pore Intersection Module

Figure 22.25: Pore Intersection Spreadsheet
Part IX

Amira XBioFormats Extension User’s Guide
Chapter 23

Amira XBioFormats Extension

About Bio-Formats
Bio-Formats is a popular Java library for handling life science image data (http://www.openmicroscopy.org/site/products/bio-formats). The Bio-Formats integration enables Amira to read image and metadata from over 140 file formats. For a list of all supported file formats and additional information, please visit: https://docs.openmicroscopy.org/bio-formats/5.5.3/supported-formats.html. To facilitate data exchange between different software packages and organizations, Bio-Formats converts data stored in proprietary file formats into an open standard called the OME Data Model, in particularly the OME-TIFF file format.

Bio-Formats Metadata
Bio-Formats categorizes metadata in three tiers:

- **Core metadata**: This is information necessary to understand the basic structure of the images including image dimension, number of focal planes, time points, channels, byte order, dimension order, color arrangement (i.e., RGB, indexed color or separate channels), and thumbnail dimensions.

- **Original metadata**: This is information specific to a particular file format. These fields are key/value pairs in the original format with no guarantee of cross-format naming consistency or compatibility. The nomenclature often differs between formats since vendors are free to use their own terminology.

- **OME metadata**: This is information from Core metadata and Original metadata converted by Bio-Formats into the OME data model. Performing this conversion is the primary task of Bio-Formats.

Bio-Formats Integration
The integration into Amira then organizes the opened image and metadata into the native Amira data structure with its well-known parameter bundles. During this process, standard image information
(e.g., voxel size, matrix dimensions etc.) is assigned to the corresponding standard Amira parameter bundles. All metadata is stored in a dedicated Bio-Formats parameter bundle. The Bio-Formats integration is able to open data as scalar-, color-, and multi-channel fields as well as tiled images and time series.

The Bio-Formats library is seamlessly integrated into Amira. Amira prioritizes its own format implementation over Bio-Formats, so if a file format is known by Amira, the native Amira reader is used for performance reasons. Reading such a file with Bio-Formats requires opening it using the Open Data As... file dialog box and selecting Bio-Formats as the preferred reader. Files that Amira does not have a native reader for are automatically loaded using Bio-Formats.

Is it also possible to directly convert large data sets that may not fit into the system memory to Amira’s LDA multi-resolution format. This direct conversion will create individual LDA files for each 3D volume, e.g. a time series with 10 time steps will result into 10 LDA files loaded as a time series into Amira. This will allow visualization and sub-volume extraction for further processing from data that is larger than the system memory. The conversion can be initiated using the Amira’s LDA dialog that opens if the data size exceeds a threshold specified in the Preferences Dialog, or using the Convert to Large Data Format module.

Note: Currently, settings for multi-channel time series such as color map & range per channel cannot be stored in Amira project files.

Commands
Caution: Bio-Formats reader is part of a separate library. When you use the TCL command directly, this will require you to use the following command to manually load the separate library:

dso open hxbioformatreader

The following TCL commands can be used to parametrize the Bio-Formats reader.


This command reads an image file <fileName> using an absolute or relative path.

- It is possible to read a specific series number using the -series option. If the -series option is not defined, the default setting is to read all the series.
- It is possible to read a specific time step using the -time option. If the -time option is not defined, the default setting is to read all the time steps.
- It is possible to read a specific channel number using the -channel option. If the -channel option is not defined, the default setting is to read all channels.
- It is possible to read a specific volume using the bounding box parameters (in pixels) -xmin, -xmax, -ymin, -ymax, -zmin and -zmax. If these optional parameters

905
are not defined, the default setting is to read the volume max of the file.

- It is possible to force to fill the RGB color channels using the -filledRGB option (status=1: Force to fill, status=0: Do not fill). If the -filledRGB option is not defined, the default setting is to do not fill RGB color channels if it is not necessary.

The command returns the labels of the data objects created in the Project View. **Note:** All the metadata that Bio-Formats reader gets from the file are copied as parameters of the created object.

```plaintext
bioFormats canRead <fileName>
```
This command checks if the image file can be read.
The command returns the value 1 if the <fileName> can be read, otherwise 0.

```plaintext
bioFormats format <fileName>
```
This command asks Bio-Formats the file format of the <fileName>.
The command returns the format (as a string) detected by Bio-Formats.

```plaintext
bioFormats info [-series <seriesId>] <fileName>
```
This command reads the image file information (all the metadata Bio-Formats gets). It is possible to get the metadata of a specific series number using the -series option. If the -series option is not defined, the default setting is to get the metadata of all the series successively.
The command returns a list of `key:value` pairs available.

```plaintext
bioFormats getInfo [-series <seriesId>] -param <parameter> <fileName>
```
This command gets the information of the <parameter> for the <seriesId> image file. If the -series option is not defined, the default setting is to read only the series 0. If the <parameter> is found several times in the meta data dictionaries (Basics, Extended), the list of values will be returned.
The command returns the information of the <parameter>.

```plaintext
bioFormats omexml <fileName>
```
This command reads the available or populated OME XML header file.
The command returns the metadata associated to presented as an XML tree. The XML format is OME-XML.

```plaintext
bioFormats getSeriesCount <fileName>
```
This command gets the series count associated with the image file.
The command returns the series count.

```plaintext
bioFormats getDims [-series <seriesId>] <fileName>
```
This command gets the data dimension \{SizeX SizeY SizeZ SizeC SizeT\} of the <seriesId>. If the -series option is not defined, the default setting is to read all the series.
The command returns the list of the data dimension.
**Environment Variables:**
The -Xms and -Xmx command line options are available to change the behaviour of JRockit JVM to better suit the needs of the Bio-Formats reader Java application.

The -Xms option sets the initial and minimum Java heap size. The default allocated memory is 256MB. To change the size, add the following environment variable and set the new size:

```
HX_JAVA_HEAP_SIZE_MIN=<size>[g|G|m|M|k|K]
```

The -Xmx option sets the maximum Java heap size. The default allocated memory is 64GB. To change the size, add the following environment variable and set the new size:

```
HX_JAVA_HEAP_SIZE_MAX=<size>[g|G|m|M|k|K]
```
Index

.Amira, 512, 536
Amira XPand Extension, 12
Amira XMolecular Extension, 12
Amira XNeuro Extension, 11
Amira XImagePAQ Extension, 12
Amira XLVolume Extension, 12
Amira XScreen Extension, 12
Amira
  class structure, 489
  data objects, 3
  extensions, 10
  local directory, 639, 641, 648
  modules, 3
  root directory, 641
Amira.init, 512, 537
AMIRA_LOCAL, 511, 521, 644
AMIRA_ROOT, 521, 646
Amira XBioFormats Extension, 12
Amira XRecipe Extension, 12
Amira XDigitalVolumeCorrelation Extension, 12
abberation, 112
affine transformations, 493
agarose gel, 112
AMD64 architecture, 13
AmiraMesh
  API, 673
  read routine, 676
  write routine, 675
apply button, 686
Atlas, 597, 603
auto-save, 470
auto-select modules, 469
axial blur, 100
batch job, 110
bead extraction, 110
beads, 112
black level, 103
border width, 106, 109
boundary artifacts, 102
Brain mapping, 597, 603
Brain Perfusion Tutorial, 629
breakpoint, 645, 646, 743
build system, 654
busy cursor, 703
check point files, 110
class hierarchy, 717
color editor, 740
Colormap, 675
colormap port, 696, 740
command line options, 509
commands, 522
compiler, 640
compiling
  Unix, 646
component, 651
compose label, 666
compression, 674
compute indicator, 470
compute method, 681
compute module
  adding new one, 652
  example, 679
confocal microscope, 101, 102
console window, 661, 669
INDEX

content type, 674
coordinate systems, 732
coordinates, 491
  curvilinear, 723
  rectilinear, 723
  stacked, 723
  uniform, 723
coverslip, 112
cpu, 17
create method, 722
Create Object Popup, 488
CT, 362
curvilinear coordinates, 723
data classes, 717
data import, 58
Data prerequisites, 613
database, 735, 741
  default, 427
  user-defined, 427
debug mode, 645, 646
debugger, 646
deconvolution
  blind, 101, 107
  non-blind, 101
  standard, 103
default directories, 510
degenerate cells, 728
dellbackupandrecoveryapplication, 22
development wizard, 648
dialog boxes, 668
display-only-available-features, 471
DLL, 638, 743
do-it button, 686
down stream connection, 673
driver, 13
dso command, 646, 743
duplicate vertices, 726
dynamic loading, 638
dynamic type checking, 673, 682

Edit Menu
  Copy, 426

Cut, 426
Database, 427
Delete, 426
Dialogs, 427
Jobs, 427
Paste, 426
Preferences, 427
Select All, 427
editors, 3
embedding medium, 112
encoding, 666, 727
environment variables, 510
error dialog, 740
eval method, 731
evalReg, 683
example package, 650
Explorer, 440
F1 key, 521
features, 4
Fiber tracking, 623
field classes, 718
file dialog, 740
file format, 653, 657
file header, 653, 662
File Menu
  Convert to Large Data Format, 424
  Export Data As, 424
  New Project, 424
  Open Data, 423
  Open Data As, 423
  Open Project, 424
  Open Time Series Data, 423
  Open Time Series Data As, 423
  Quit, 426
  Recent Files, 426
  Recent Projects, 426
  Save Data, 423
  Save Data As, 424
  Save Project, 425
  Save Project As, 425
file name extension, 652
firewall, 19
INDEX
model, 275
module
    adding new one, 651
    example, 692
MRT, 362
multi-processing, 117
multiple file input, 653

no-show-news, 477
noise, 101, 102
non-conformal grids, 729
numerical aperture, 102
Nyquist sampling, 102

Object Popup, 481
oil immersion, 112
Open Inventor, 639, 693
OpenGL, 13, 639, 640
optical sectioning microscopy, 100
osxstdinstall, 23
out-of-focus light, 100, 108
overrelaxation, 106, 109
oversampling, 102
overwrite dialog, 669

package, 638, 650
parallel flags, 646
parameters, 718, 734
parameters of data objects, 493
parse method, 697
performance, 116, 687
PET, 362
plot API, 700
polymorphism, 670
Pool, 740
Pool Menu
    Auto adjust range of colormaps, 430
    Create Object, 429
    Duplicate Mode, 430
    Duplicate Object, 428
    Graph View, 428
    Hide All From Viewer But This, 429
    Hide Object, 428
Make All Display Modules Pickable, 429
Make All Display Modules Unpickable, 429
Remove All Objects, 429
Remove Object, 428
Rename Object, 428
Show All Objects, 429
Show Object, 429
Tree View, 428
Port, 443
portData, 683
PPM3D format, 658, 668
preferences, 469
preferences-and-settings, 471
primitive data types, 720
prioritizing hardware, 14
procedural data interface, 731
processor, 13
progress, 684
Progress Bar, 445
progress bar, 684
Project Graph View, 437
PSF, 101, 103
    theoretical, 106
Python Common Global Commands, 557
Python Documentation, 548
Python In Product, 553
Python Introduction, 548
Python Modules, 560
Python Package manager, 566
Python Packages, 568
Python Script Objects, 562
Python Tutorial, 570
Python Tutorials, 570
Qt, 639, 668
question dialog, 740
read routine
    adding new one, 652
    example, 658
    multiple files, 666
    reampling, 104
INDEX

Layout, 430
Lights, 431
Measuring, 433
Transparency, 431
Viewer, 446, 740

Fullscreen, 451
Home, 449
Interact, 447
interaction mode, 447
Layout, 451
LinkObjectsVisibility, 451
Measuring, 450
Perspective/Ortho toggle, 450
Pick, 447, 450
rotate button, 449
Seek, 449
Set Home, 449
Snapshot, 451
Stereo, 450
Trackball, 448
Translate, 448
View, 448
View All, 449
viewing directions (geographic), 449
viewing directions (seismic), 449
viewing directions XY, XZ, YZ, 449
viewing mode, 447
Zoom, 448
zoom, 446
viewer toggles, 470
Visual Studio
debug code, 645
release code, 645
warning dialog, 740
wavelength, 102
widefield data, 102
Window Menu, 433
About, 436
Colormap, 433
Console, 434
Correlation, 434
Help, 434
Hide Panels, 433
Histogram, 434
Project View, 434
Properties, 434
Restore default layout, 434
Tables, 434
Toolbars, 434
Windows system, 13
winstdinstall, 22
work area, 443, 740
workroom concept, 505
workrooms-toolbar, 436
world coordinates, 732
write routine
adding new one, 653
element, 668
xpand, 20